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FOREWORD 
 
This manual is one of a series of protocols and manuals of operation for the Jackson Heart Study 
(JHS).  The complexity of the JHS requires that a sizeable number of procedures be described, thus 
this rather extensive list of materials has been organized into the set of manuals listed below.  Manual 
1 provides the background, organization, and general objectives of the JHS Study.  Manuals 2 and 4 
describe the operation of the Cohort Procedures, Blood Pressure and Events Ascertainment 
Components of the study.  Detailed Manuals of Operation for specific procedures, including those for 
Blood Pressure and Quality Assurance, make up Manuals 4 and 5.  The Data Management System is 
described in Manual 6. The Central Laboratory and Specimen Repository is described in Manual 7. 
Manual 8 is designed to provide volumetric CT image data for measuring coronary and abdominal 
aortic calcified plaque as well as measuring body composition in the abdomen. 
 
 

JHS Study Protocols and Manuals of Operation 
MANUAL TITLE 

1 General Description and Study Management 

2 Cohort Component Procedures 

3 Blood Pressure 

4 Cohort Events Ascertainment  

5 Quality Assurance 

6 Data Management 

7 Central Laboratory and Specimen Repository 
Collection and Processing 

8 CT Scan 
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1.0 SITTING BLOOD PRESSURE PROTOCOL (RANDOM ZERO SPHYGMOMANOMETER) 
 
1.1 Introduction 
 
As blood pressure rises, so does risk of ischemic heart disease and its complications.  The range of 
normal blood pressures is wide.  Even within the "normal" range, risk increases as the upper limits are 
approached.  Usually, blood pressures are expressed as systolic pressure/diastolic pressure; values 
exceeding 140/90 mmHg are considered to be hypertensive for adults.  Classification and staging of 
hypertension are more precise where systolic rather than diastolic is the principle criterion.  Both systolic 
and diastolic blood pressure elevations are associated with increasing risk for cardiovascular disease.  
Middle-aged persons with a diastolic blood pressure of 90-104 mmHg (so-called "mild" hypertension) have 
a risk of heart attack that is about 70 percent higher than that of persons with a diastolic pressure under 80 
mmHg (optimal value).  Persons with a diastolic blood pressure exceeding 104 mmHg (moderately severe 
to severe hypertension) have a risk more than twice that of those with a normal value.  Hypertension is an 
especially strong risk factor for stroke and, to a lesser extent, for peripheral vascular disease.  Most of the 
knowledge of the consequences of high blood pressure arises from studies of sitting arm blood pressure, 
as described in this section. 
 
Sitting blood pressure in the first exam (Visit 1) is measured in a resting state, using 2 measurements with 
a random zero sphygmomanometer.  The random zero machine has two advantages over the fixed zero 
manometer.  Digit preference does not appear in the data.  It may still exist in the reading itself, but it is 
"removed" from the data by the use of the randomly chosen zero point.  More importantly, it prevents the 
blood pressure technician from knowing the actual value, and therefore removes judgements about blood 
pressure levels for readings close to critical values such as 90 diastolic.  It should be noted, however, that 
the random zero machines tend to yield blood pressures which are about 1.5 mmHg less than those 
obtained when using a fixed zero machine.  Within person variation in blood pressure is substantial, even 
within a few minutes and particularly under conditions perceived as stressful.  Use of two replicate 
readings tends to reduce this short-term variation. 
 
 
1.2 Standardized Clinic Procedures 
 
Correct measurement of blood pressure is of the utmost importance to the success of this study.  It is 
essential that the procedure described below for measuring blood pressure be followed exactly.  Major 
differences in blood pressure measurement methodology among health professionals from several 
countries have been observed despite the fact that a joint committee of the American Heart Association 
and the Cardiac Society of Great Britain and Ireland established international recommendations on blood 
pressure measurement in 1939.  Precision is essential for valid comparisons of blood pressure between 
groups of people and in individuals on different occasions. 
 
 
1.3 Description of the Equipment 
 
 
1.3.1 Stethoscope 
 
A standard Littman stethoscope with a bell is used.  Korotkoff sounds, described as Phase 1 through 
Phase 5, are best heard with the bell because of their low pitch.  Stethoscope tubing should be about 10-
12 inches from the bell piece to "Y" branching.  This length provides optimal acoustical properties and 
allows the observer to read the sphygmomanometer at eye level and in a comfortable position.  Earpieces 
should fit comfortably and snugly in the ears.  Four points should be observed in using the stethoscope. 
 
The earpieces should be directed downwards and forwards into the external ear canal. 
 

1. The earpieces should be tight enough to exclude outside sound but not so tight that they 
cause discomfort. 
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2. The valve between the bell and the diaphragm should be turned in the correct direction. 

 
 
3. The bell of the stethoscope should be placed lightly on the skin overlying the brachial 

artery - immediately below the cuff and medial to the cubital fossa above the medial 
epicondyle of the radius and posterior to the biceps muscle.  Light pressure accentuates 
low-pitched sound and avoids compression murmurs.  Pressing too heavily with the 
stethoscope over the brachial artery causes turbulent flow in the artery and a murmur can 
be heard which may prolong the apparent duration of phase 4. 

 
 

1.3.2 Sphygmomanometers 
 
Standardized Hawksley random-zero instruments are used for all clinic visits.  Standard Baum 
manometers are used for determining peak inflation level. 
 
The mercury manometer consists of a screw cap, a face with numbers, a lined glass column, a 
reservoir containing mercury, rubber tubing, and a metal case.  The rubber tubing from the mercury 
manometer connects to the rubber tubing from the inflatable rubber bladder of the cuff.  As the 
inflatable rubber bladder is filled with air, the air pressure in the bladder travels through the 
connecting rubber tubing.  The pressure pushes the mercury out of the reservoir and into the lined 
glass column.  The number for each line is read when the rounded top of the mercury, the meniscus, 
is level with it.  If the meniscus is exactly between the lines, the reading is made from the line 
immediately above, i.e., rounded up to the nearest even number. 
 
 
1.3.3 Random-Zero Mercury Manometer 
 
The random-zero (R-Z) manometer has all the parts of the standard mercury manometer.  In addition, 
it has a device built into the box-shaped back that changes the level of mercury in the calibrated glass 
tube.  The device includes a second mercury reservoir the size of which can be changed to hold a 
larger or smaller amount of the mercury and therefore allow different amounts of mercury to remain in 
the calibrated glass tube and the outside reservoir.  Turning a wheel on the side of the wooden box 
changes the size of the second reservoir.  The second reservoir is opened and closed with a bellows 
control valve on the face of the manometer. 

 
 

1.3.4 Cuffs and Bulbs 
 

Proper size of the cuff is essential for accurate blood pressure measurement.  The Examination 
Center has four standardized cuffs available - small adult, adult, large adult, and thigh cuff.  The 
standardized cuffs (provided are by the Baum Company) are used for the measurement of sitting 
blood pressure. 
 
The range markings on commercial cuffs overlap from size to size and do not offer a precise 
guideline.  In the JHS Study arm size is measured, and the cuff size is selected as illustrated in Table 
1, below. 
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Table 1. Determination of Cuff Size Based on Arm Circumference 
 
 Cuff Size Arm Circumference   

 Small Adult < 24 cm   

 Adult 24 to 32 cm   

 Large Adult 33 to 41 cm   

 Thigh > 41 cm   
 
 
 
1.4 Blood Pressure Measurement Instructions 
 
Standardizing the measurement technique and the environment in which the measurement is made 
controls some of the many extraneous factors influencing blood pressure.  Uncontrolled factors 
(temperature, time of day, arm circumference, recent use of caffeine, and identity of the observer) are 
recorded, so that they can be taken into account during analysis. 
 
JHS participants are reminded during the scheduling of Visit 1 to avoid caffeine (from tea, coffee, 
chocolate, and soft drinks), eating, heavy physical activity, smoking and alcohol intake for twelve 
hours prior to the clinic visit.  Current drug intake, including medications affecting blood pressure and 
non-prescription drugs, is recorded on the day of the examination.  A detailed history of alcohol intake 
history is also recorded. 
 
 
1.5 Staff Preparation for Participant Visit 
 
In relating to the JHS participants, remember that participation in the study is voluntary.  Participants 
are given full explanation and instructions about the preparation for the blood pressure examination 
and an opportunity for questions.  The setting in which blood pressure measurements are made is 
standardized and takes place in a separate, quiet room where no other activity is taking place, and 
where temperature fluctuations are minimal.  Clinic scheduling procedures establish consistent 
appointment times to minimize as much as possible the impact of daily blood pressure variation. 
 
 
1.6 Measurement Procedures 
 
The sitting arm blood pressure is measured two times at Exam 2.  It takes approximately 10 minutes 
to make two blood pressure measurements including the initial five-minute rest. 
 
Once the participant is given instructions and explanations, and the equipment has been checked, 
blood pressure measurement begins.  The following steps must be followed precisely.  The procedure 
is described here employing the JHS paper form.  When using the JHS Direct Data Entry System, 
calculations are performed by the system. 
 
1. If the participant indicates that there is a medical or post-surgical reason for not having the blood 
pressure measured on the right arm (or if the right arm is missing), reverse chairs and proceed with 
the left arm.  Indicate on the Itinerary Form and on the Sitting Blood Pressure form Note Log that the 
left arm is used. If in doubt, or if the participant prefers not to have a blood pressure taken on either 
arm, consult with the supervisor. 
 
2. Determine the arm circumference using the following procedure. 
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The participant stands facing away from the observer with the right arm flexed at 90 degrees at the 
elbow, hand across midsection.  The observer determines and marks the tip of the olecranon (elbow). 
 
The participant straightens the arm, allowing it to hang loosely at the side.  The observer then 
determines and marks the posterior tip of the acromion process (shoulder bone).  Using a centimeter 
tape, the observer measures the length of the upper arm between the two marks and marks the 
midpoint (+). 
 
The observer wraps the tape around the arm over the midpoint mark, making sure that the tape is 
level.  The arm circumference is measured to the nearest centimeter, and is recorded. 
 
3. Seat the participant with right arm on table.  The bend at the elbow (cubital fossa) should be at 
heart level.  Legs should be uncrossed and feet comfortably flat on the floor, not dangling.  Be sure 
that the chair head support is comfortable and the participant is able to relax the neck and shoulder 
muscles as much as possible. 

 
4. Palpate the brachial artery (just medial to and above the cubital fossa), and mark this location for 
stethoscope placement.  Choose the correct cuff size and wrap the cuff on the arm with the center of 
the bladder over the artery.  If the participant seems particularly apprehensive, delay wrapping the 
cuff until after the five-minute wait. 

 
5. Record the time.  Start five-minute timer.  Allow a five-minute wait before taking the blood 
pressure.  Conversation should be limited.  However, a brief explanation of the procedure can be 
repeated at this time if necessary.  The smoking and fasting questions may be asked after timing is 
begun. 

 
6. After the 5-minute rest, check and record the 30-second heart rate.  Then, connect the cuff to a 
standard manometer and establish the pulse obliteration pressure by slowly inflating while palpating 
the radial artery until pulse is no longer felt.  Deflate and disconnect the cuff.  Record the pulse 
obliteration pressure.  Record the R-Z maximum zero number (found next to mercury column).  
Calculate and record the peak inflation level (i.e., pulse obliteration pressure + R-Z maximum zero 
number + 30). 

 
7. Measurement 1: Connect the cuff to the random-zero manometer.  Open the bellows control 
valve and wait until the mercury settles.  Using downstrokes only turn the thumbwheel two or three 
times.  Note: Do not spin the thumbwheel.  Place the bell of the stethoscope on the brachial artery.  
Inflate rapidly to the R-Z peak inflation level.  Holding the pressure constant with the bulb, wait 5 
seconds.  Close the bellows control valve.  Slowly deflate the cuff (2 mm per second) while listening.  
Record the 1st and 5th phases, reading the pressure in mmHg to the nearest even number.  The first 
sound heard in a series of at least two sounds is recorded for systolic blood pressure (phase 1).  The 
first silence in a series of at least two silences is recorded for diastolic blood pressure (phase 5), not 
the last sound heard.  Disconnect the cuff and record the zero reading. 

 
8. Measurement 2: Have the participant raise measurement arm for five seconds.  After waiting 
another 25 seconds with the participant's arm on the table, repeat the measurement as in step 7 
above and disconnect cuff. 

 
Blood pressure calculations are made for the first and second readings.  When using paper forms, 
subtract the zero value from the readings to get the actual (corrected) systolic and diastolic blood 
pressure measurement.  This is done on the worksheet at the end of the form.  Because of the 
importance of the blood pressure averages, to inform the participant and for the purpose of referral, 
all arithmetic is done with a calculator. 

 
If for any reason the observer is unable to complete, or has forgotten to complete any portion of the 

exam (and the participant is gone), draw two horizontal lines through the space(s) on the form, if using 
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paper forms.  This is the correct way to indicate missed information.  If an entire reading is missed and 
the participant is still sitting at the blood pressure workstation, completely deflate the cuff and start over 
with a replacement reading.  However, under no other circumstances may a replacement reading be 
obtained.  Always wait at least 30 seconds between readings. 

 
 
1.7 Procedure for Changing the Peak Inflation Level 
 
Occasionally the Korotkoff sounds may be heard as soon as one places the stethoscope over the brachial 
pulse.  If this happens, the peak inflation level used was too low.  The observer immediately deflates the 
cuff by releasing the thumbscrew and disconnecting the cuff tube.  Then have the participant hold the cuff-
wrapped arm vertically for five seconds.  As shown below in Table 2, draw a line through the previously 
recorded Pulse Obliteration Pressure and Peak Inflation Level.  Increase each number by ten and write the 
new number above the original one, as shown below.  When using the Direct Data Entry system, the Peak 
Inflation Level values change automatically when the Pulse Obliteration Pressure is changed.  Proceed 
with blood pressure measurement, starting at the new Peak Inflation Level. 
 
 

Figure 1. Changing the Peak Inflation Level on paper forms. 
 
    
  130  
 Pulse obliteration pressure 120  
    
 R-Z maximum Zero + 22  
  + 30  
    
    
  =182  
 Peak Inflation Level   172  
 (Random-Zero)   
    

 
 
 
1.8 Reporting the Blood Pressure Results to the Participant 
 
Using a calculator, average the first and second corrected R-Z readings and record the average on the 
form if using paper forms.  Record this average on the transmittal slip or itinerary form in the participant's 
folder, and mention the results to the participant.  State clearly the systolic and diastolic pressure, and 
indicate that the participant will receive a written report with these valves at the end of the visit. 
 
 
1.9 Stopping Rules for Elevated Blood Pressure 
 
The classification of blood pressure for adults is summarized in Table 3.  The medical care referral 
guidelines for elevated blood pressure are summarized in Table 4.  When a person has one or more sitting 
blood pressure measurements where the systolic reading exceeds 260 mm Hg or the diastolic reading 
exceeds 130 mm Hg (emergency referral), the JHS physician is consulted and the arrangements are made 
to transport the person to an emergency care facility.  The JHS physician is also consulted and the 
participant is advised to seek immediate medical care (same day) when one or more systolic blood 
pressure measurements are between 210 and 259 mm Hg or the diastolic pressure is between 120 and 
129 mm Hg (immediate referral).  In both circumstances, the remaining procedures and interviews in Visit 
1 are cancelled and Visit 1 is rescheduled as appropriate.  When one or more systolic blood pressure 
levels are between 180 and 209 mm Hg or the diastolic is between 110 and 119 (urgent referral); the JHS 
physician is notified for urgent referral unless the physician recommends otherwise. 
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Table 5.1 Classification of Blood Pressure for Adults, Based on Joint 
National Committee on Detection, Evaluation and Treatment of High Blood 
Pressure (JNC-VII, 2003) Guidelines 

 
Category* 

SBP 
(mm Hg) 

 DBP 
(mm Hg) 

Normal <120 and <80 

Pre Hypertension 120-139 or 80-89 

Stage 1 Hypertension 140-159 or 90-99 

Stage 2 Hypertension ≥160 or ≥100 

*When SBP and DBP fall into different categories, use the higher category. 
 

Table 5.2 Medical Care Referral Guidelines for Blood Pressure, Based on Joint National 
Committee on Detection, Evaluation and Treatment of High Blood Pressure  
(JNC-VII, 2003) Guidelines 

Referral 
Classification 

Examination 
Findings 

Recommendation to Participant1 Explanation 
to 

Participant 

Emergency Referral SBP > 260 

or  
DBP > 130 

Transportation to emergency care 
facility. Stop exam and reschedule 
clinic visit 

Your BP is 
very high. 

Immediate Referral SBP 210-259 
or  

DBP 120-129 

Consult with JHS MD.  Refer to 
source of care immediately (today). 
Stop exam and reschedule clinic visit 

Your BP is 
very high. 

Urgent Referral SBP 180-209 
or  

DBP 110-119 

Consult with JHS MD and proceed 
unless otherwise indicated. Refer to 
source of care within 1 week 

Your BP is 
high. 

Routine Referral SBP 160-179 
or  

DBP 100-109 

Refer to source of care within 1 month Your BP is 
elevated. 

 SBP 140-159 
or  

DBP 90-99 

Refer to source of care within 2 
months 

Your BP is 
elevated. 

 SBP 120-139 
or  

DBP 80-89 

Recheck in 1 year (no JHS referral) Your BP is in 
the pre-
hypertension 
range 

 SBP < 1202or  
DBP < 80 Recheck in 2 years (no JHS referral) Your blood 

pressure is 
normal 

1 If the systolic and diastolic categories are different, follow recommendations for the shorter time follow-up (e.g., 160/85 mm Hg should be evaluated or 
referred to source of care within 1 month).       2 Unusually low readings should be evaluated for clinical significance. 
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1.10 Sitting Blood Pressure Training and Certification 
 
At the Examination Center a minimum of five clinic staff persons are trained for measuring sitting blood 
pressure.  They need not be health professionals, but they must be trained and certified by JHS in the 
blood pressure measurement technique.  Observers should also have experience in relating to people. 
 
The first training session begins with a description and demonstration of the correct blood pressure 
measurement procedure.  Trainees listen to the 1st (training) audiocassette tape, taking the test 
sequences until they are confident they can identify 1st and 5th phase Korotkoff sounds.  Then, they use 
the 2nd tape until they have passed the test.  After passing the second test, they are given the 3rd tape 
test.  Alternated with the tapes are actual practice sessions with live subjects under the instruction and 
observation of the training supervisor.  Some live practices may be done with a standard stethoscope, but 
most employ the Y-tube stethoscope.  After the first day of training, each trainee is given a cuff and 
manometer (no stethoscope) to take home and practice control of the valve.  This is done by wrapping the 
cuff on a jar or bottle and alternately pumping up and dropping the mercury at a steady rate of 2 mm per 
second.  After two or three sessions, trainees are also given a stethoscope to practice on family or friends. 
Out-of-class practice is very important to build confidence.  Practice time allowed in class is not enough 
without outside practice time.  Once each trainee has passed the third tape test, he or she does at least 
two live readings with the training supervisor on the Y-tube stethoscope.  The readings must agree within 4 
mm and the average must agree within 3 mm.  If they do not, the trainee needs additional practice with 
tapes and live subjects.  The training supervisor also verifies that the trainee understands and follows 
proper procedures. 
 
Additional time is allowed for instruction and mastering the use of the Random-Zero device.  Trainees are 
certified after passing tape tests 2 and 3 (tape 4 is held in reserve for recertification) and at least 2 live 
readings.  Observers are recertified every six months by taking and passing tape 3 or 4 and two readings 
with the blood pressure supervisor on an Y-tube stethoscope. 
 
It is the responsibility of the Examination Center to conduct recertification procedures and report to the 
Coordinating Center when the procedures are complete. 
 
 
1.10.1 Tapes 
 
The JHS Study uses four tapes of Korotkoff sounds.  Tape 1 is a training tape.  Tape 2 is a practice tape.  
Tapes 3 and 4 are test tapes.  A new trainee listens to tape 1, goes to tape 2 and repeats it as often as 
necessary.  Tape 3 is taken as a test.  It, too, may be repeated if necessary.  Tape 4 is held in reserve for 
the six-month recertification.  Tapes 3 and 4 are alternated thereafter for recertification. 
 
 
1.10.2 Using the Cronus Stop Watch with the Prineas Blood Pressure Tapes 
 
The Cronus stopwatch, model 3-S, is an interval timer and is the preferred timing device to be used with 
the training tapes.  Of the various options, it seems to be the simplest and easiest to read.  It is generally 
available at a local sporting goods store.  The address of the manufacturer is: 
 
Cronus Precision Products, Inc. 
2895 Northwestern Parkway 
Santa Clara, CA  95051   USA 
 
If only Phase 1 and Phase 5 are learned, two ordinary stopwatches may be used.  Using one in each 
hand, both are started at the beep; one is stopped when the first Korotkoff sounds are heard and the other 
stopped at Phase 5.  The interval watch is preferred even if Phase 4 is not being recorded because it is 
much easier to change one's mind if sounds change, and it is easier to read. 
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1. Turn on the stopwatch and press the reset button. 

 
2. Start the tape, wearing headphones.  At the beginning of each tape is a timing sequence, with no 
Korotkoff sounds.  When the beep is heard, start the watch by pressing the button at the top.  Stop 
the watch with the button at the top when the second beep is heard.  Record the time elapsed to the 
nearest 10th of a second on the top of the student form. 

 
3. Press reset button.  When the tape announces sequence 1, start the watch at the beep. 

 
4. When the first Korotkoff sound is heard, stop the watch with the button at the top.  Record the 
time elapsed to the nearest 10th of a second.  The watch continues to run internally. 

 
5. When the Phase 5 (disappearance) is heard, stop the watch.  Record the time elapsed to the 
nearest 10th of a second.  Press reset.  Repeat steps 3 through 5 for each sequence.  Remember 
that the tapes were designed for a special timing device.  The answers given are double the stop 
watch values.  At the end be sure to turn off the stopwatch in order to save batteries. To score the 
tests, add all the sequences, and divide by the number of sequences.  The average should be within 
plus or minus one second. 

 
 

1.10.3 Y Tube Stethoscope Observations 
 

Y Tube stethoscope observations are made in conjunction with the blood pressure tapes during initial 
training and for biannual quality control.  The trainer has the observer-trainee go through the entire 
blood pressure measurement procedure using a quality control checklist.  The observer and trainer 
listen with the Y Tube and record the values on separate sheets.  Two measurements on one subject 
are obtained.  Measurements by the trainer and the trainee should agree within 4 mmHg on any one 
reading (systolic or diastolic) and averages should agree within 3 mmHg. 

 
 

1.11 Quality Control 
 

To ensure the accuracy of the blood pressure measurements throughout the study, quality control 
measures are developed at the Coordinating Center and applied at the Examination Center.  These 
measures include: 

 
1. recruitment of the most qualified personnel 

2. standardized training and certification 

3. retraining and recertification 

4. biannual observation of data collection by supervisors, using the checklist given in Appendix 3.  
One checklist is used for each technician and sent to the Coordinating Center each quarter. 

5. frequent staff meetings to provide feedback 

6. editing of data, both manual and by computer 

7. a quality assurance program administered by the Coordinating Center 

8. biannual simultaneous Y Tube observation of each technician by the blood pressure supervisor 

9. equipment maintenance program 
 

1.12 Technician Training and Quality Control 
 

Blood pressure technicians are trained by the clinic coordinator or their designee prior to participant 
recruitment.  New technicians hired after the start of the study are trained locally by the Study 
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Coordinator or a designated "Blood Pressure Supervisor".  Recertification occurs every six months.  
Prior to certification, each technician is required to have a clinical hearing test. 

 
The Coordinating Center directs a blood pressure quality assurance program to review six-monthly data.  
This includes quality analysis and review of blood pressure data, comparing means for each technician 
with the values for all technicians.  These statistics are adjusted for weight, age and sex of the participants.  
Digit preference is also monitored for each technician. 
 
1.13 Equipment Maintenance 
 
The Examination Center is responsible for the proper operation and maintenance of its equipment.  
Maintenance responsibility is assumed by the blood pressure supervisor and all staff are instructed to 
report any real or suspected equipment problems to that person promptly. 
 
All checks, inspections, cleanings and problems indicated are documented and recorded by date in a 
permanent log.  Problems and solutions are also recorded.  A copy of this log is given in Appendix 4. 
 
 
1.13.1 Random Zero and Standard Sphygmomanometers 
 
The Random Zero manometer is inspected once a week and the standard manometer once a month.  
These inspections include a check of: 
 

1. the zero level of the standard manometer 

2. mercury leakage 

3. manometer column for dirt or mercury oxide deposit 

4. condition of all tubing and fittings. 
 
The equipment is cleaned if inspection indicates it is needed, or at least once a year.  Specific instructions 
for the random zero device are provided in Appendix 1, and for the standard manometer in Appendix 2.  In 
addition, every two months the accuracy of the random zero instrument is checked using a standard 
manometer and an Y connection, as described in Appendix 4. 
 
 
1.14 Referral of Hypertensives 
 
As shown in Table 3, blood pressure referral levels are made based on the findings of the JHS 
examination which are consistent with the recommendations given in the seventh report of the Joint 
National Committee on Detection, Evaluation, and Treatment of High Blood Pressure (2003).  The average 
of the first and second resting blood pressure readings is used. 
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2.0 SITTING BLOOD PRESSURE (OMRON HEM-907XL) BLOOD PRESSURE PROTOCOL AND 
BLOOD PRESSURE COMPARABILITY STUDY PURPOSE 

 
This protocol is written for use with the Omron HEM907XL automated BP monitor.  Special attention 
must be placed on assessment and maintenance of the instrument’s accuracy as per the manual that 
accompanies the instrument (Appendix).  
 
The design and operation of the Omron HEM907XL are based upon the combined principles of 
compression of the brachial artery under an elastic, inflatable cuff and estimation of the systolic and 
diastolic BP levels by oscillometric methods.  All readings are to be recorded to the nearest digit.   
 
The Omron HEM907XL unit will undergo and Blood Pressure Comparability study to assure 
comparability between measures of blood pressure taken with this equipment and that taken using 
the Random Zero sphygmomanometer. The purpose of this comparability study is to assure that 
blood pressure taken by either type of equipment can be considered equivalent for data analysis 
purposes for the JHS. Once the comparability study is complete, and reliability of measurements 
determined, the Omron HEM907XL equipment will be used for all off-site examinations conducted as 
a part of Exam 2.  
 
 
2.1 Equipment  
 

The following equipment will be required for BP and 

pulse measurement: 

1. One Omron HEM907XL automated BP monitor.   

 2.   BP cuffs in four sizes: S, M, L, XL 

 3.   One Gulick II tape (or Gulick II Plus) 

4. A chair with arm support for BP measurement, or 

a chair and table (table must provide for a 

comfortable resting posture of the arm with the 

cubital fossa at the level of the 4th intercostal space at heart level) 

 5. One black pen (marking on skin) and one No. 2 pencil (completing the form) 

 
2.2 Exclusions 
 

1. Persons with rigid arteries such that an occlusion pressure cannot be reached.  If the artery 
cannot be occluded before the mercury column reaches 300 mmHg, the participant is excluded. 

2. Persons with bilateral amputations of arms. 

3. Subjects who fit any of the above categories are recorded as missing data. 

4. If a subject has undergone a mastectomy of the right breast or has other reasons to omit right 
arm pressures, the left arm will be used for measures. 

 

 

 



11 

M-3_ Version 2.0 Blood Pressure_09092005    

2.3 Set-Up Procedure 
The proper cuff size must be used to avoid under- or over-estimation of BP.  Cuff size refers to the 
cuff’s bladder, not the cloth.  A copy of the chart below should be attached to the sphygmomanometer 
for easy reference.  In addition, the cuffs must be HEM907 XL-compatible (see manual in Appendix). 
If the right arm cannot be used, the left may be used.  This change must be noted on form. 
 
Table 2. Determination of Cuff Size Based on Arm Circumference 
 

 Cuff Size Arm  Circumference  Bladder Size 

 Small Adult < 24 cm  9.0 

 Adult 24 to 32 cm  12.0 

 Large Adult 33 to 41 cm  15.0 

 Thigh > 41 cm  17.5 
 

 
Measurement of arm circumference. The participant should remove his/her upper garment, or clear 
the upper arm area so that an unencumbered measurement may be made.  The technician should: 
 

1. Have the participant stand, with the right arm hanging and bending the elbow so that the 
forearm is horizontal (parallel) to the floor. 

 
2. Measure arm length from the acromion (bony protuberance at the shoulder) to the olecranon 

(tip of the elbow), using the Gulick II anthropometric tape. 
 

3. Mark the midpoint on the dorsal surface of the arm. 
 

4. Have the participant relax arm along side of the body. 
 

5. Draw the tape snugly around the arm at the midpoint mark.   
  NOTE:  Tape should be horizontal and should not indent the skin. 
 

6. Noting the arm circumference indicated by the tape, use the criteria above for determining 
cuff size. 

 
2.4 Procedure 
 

2.5.1 Wrapping the Blood Pressure Cuff around the Arm 
 The technician should: 

1. Ensure the participant is seated, legs uncrossed, in a quiet 
room, with the elbow and forearm resting comfortably on 
the armrest of the BP measurement chair (or table), with 
the palm of the hand turned upward.  The area to which the 
cuff is to be applied must be bare (free of clothing). 

2. Locate the brachial artery by palpation and mark the skin 
with a small dot, using a black pen.  (The brachial artery is 
usually found just medial and superior to the cubital fossa, 
posterior to the biceps muscle and slightly toward the 
body).  For brachial artery palpation, fingertips or thumb 
may be used (see figures to the right). 

3. Place the appropriate cuff around the upper right arm so that: 
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i. The midpoint of the length of the bladder lies over the brachial artery. 
ii. The cubital fossa is at heart level. 
 

 NOTE:  The midpoint of the length of the bladder should be confirmed by folding the 
bladder in two.  The marking on the cuff should not be trusted. 

 
4. Place the lower edge of the cuff, with its tubing connections, about 1 inch above the natural 

crease across the inner aspect of the elbow (the cubital fossa).   
 
5. Wrap the cuff snugly about the arm, with the palm of the participant’s hand turned upward, 

making sure the long edges of the cuff lie on top of each other as the cuff is wrapped 
around.   

 
6. Secure the wrapped cuff firmly by applying 

pressure to the locking fabric fastener over 
the area where it is applied to the cuff.   

 NOTE: The cuff should not be wrapped too 
tightly around the arm.  

 
2.4.2 General Guide to Blood Pressure Readings 

 

1. Following any previous inflation, wait at 
least 30 seconds after cuff has completely 
deflated. 

2. By closing the thumb valve and squeezing 
the bulb, inflate the cuff at a rapid but 
smooth continuous rate to the maximal inflation level (30 mmHg above systolic pressure). 
This measure is described in greater detail below. 

3. The examiner’s eyes should be level with the mid-range of the manometer scale and 
focused at the level to which the pressure will be raised. 

4. By opening the thumb valve slightly, and maintaining a constant rate of deflation at 
approximately 2 mmHg per second, allow the cuff to deflate. 

5. Listen throughout the entire range of deflation, past the systolic reading (the pressure 
where the first regular sound is heard) for 10 mmHg.  Two subsequent beats should be 
heard for any valid systolic blood pressure reading. 

6. Deflate the cuff fully by opening the thumb valve. 

7. Neatly enter systolic readings in the spaces provided on the form. 
 
2.5 Blood Pressure Comparability Study Methods 
The BP Comparability Study is done with a subset of JHS participants who are willing to participate in 
this extra measurement.  Participants with an arm circumference exceeding 50 cm and requiring the 
use of a thigh cuff are ineligible to participate in the BP Comparability Study. 
 
2.5.2 Equipment 
 

1. Standard sphygmomanometer 
 
2. Standard cuffs 

 
3. Single stethoscope with bell  

 
4. Double Y-stethoscope with bell 
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5. Omron HEM907XL 

 
6. Random Zero 

 
7. Y-connector 

 
8. Omron cuffs 

 
2.5.2 Staff 
 
Two BP technicians: Each will record three measurements on the BCF form for use by the Random 
Zero (RZ) technician and the Omron technician.  Two BP measurements will be made on each BP 
Comparability Study participant.  The technicians will alternate observations using the RZ and Omron.  
Technician No. 1 will measure a participant’s BP twice with the RZ, and Technician No. 2 will 
measure the participant’s BP twice with the Omron.  The next participant would have Technician No. 
2 measure BP twice with the RZ, and Technician No. 1 measure BP twice with the Omron.  During 
the comparability study, Omron measurements are made with the setting on MANUAL.  The Omron 
technician listens with the same double stethoscope as the RZ technician. 

 
 

2.5.3 Random Zero Technician Procedures 
 
The RZ technician should: 

1.  Enter his/her Technician ID in the space provided at the bottom of the BCF form.   

2. Measure and record participant’s arm circumference with Gulick II tape.  

3.  Select and apply an appropriate sized standard cuff according to the participant’s arm 
circumference measurement. 

4.  Determine and record the Pulse Obliteration Pressure using the standard 
sphygmomanometer and a standard cuff with the technician’s hand on the participant’s 
radial pulse. 

5.  Add and record 30 mm to the Pulse Obliteration Pressure.  

6. Switch from the standard sphygmomanometer to the RZ. (Omron technician will remove 
standard cuff and apply Omron cuff.) 

7.  Record the RZ maximum value for the RZ in use.  Enter Item 15 (sum of Pulse 
obliteration, maximum zero + 30 values) to determine the peak inflation value for the 
Omron P-Set level (Q4) setting.  

8.  Attach Y-connector to the RZ, the Omron, and the Omron cuff.  The small connector on this 
cuff should be removed so that the tubing can be 
attached to a Y-connector.   

9. Turn the bellows valve dial on the RZ to OPEN, after 
the Omron technician has set up and turned on the 
Omron,. 

10.  Place the double Y-stethoscope earpieces into ears 
(at same time as other technician).  

11. Observe the other technician press the START 
button on the Omron, ensuring it inflates the cuff for 
both devices, and that the mercury column in the RZ 
rises. 
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12. Turn the RZ dial to CLOSE, when the mercury column on the RZ has dropped 20 mm from 
its highest point. 

13. Listen for the onset of the 1st sounds and 5th (disappearance) Korotkoff phase sounds. 

14. Record readings from the RZ, when the cuff is 
completely deflated, and subtract the RZ level from 
the RZ systolic and diastolic readings, recording the 
corrected measurement.   

15. Open the RZ dial and turn the thumb wheel.  

2.5.4 Omron Technician 
The Omron technician should: 

1.  Enter his/her Technician ID in the space provided at 
the bottom of the BCF form. Remove the standard 
cuff, after the RZ technician has completed the peak 
inflation level measurement, and apply the 
appropriate sized Omron cuff to the participant’s arm 
with the arrow at the brachial artery.  

2.   Turn on the Omron (It is best to have the Omron 
connected to the main power supply, rather than relying on the battery power). Turn the P-
SET dial on the Omron to the P-Set level estimated in [2.6.3(7)], above. PLEASE NOTE: If 
using Omron equipment without prior Random Zero methods, enter the P-Set level as the 
pulse obliteration level + 30. 

3. Turn the MODE on the Omron to MANUAL. 

4.  Place the double Y-stethoscope earpieces into his/her 
ears (at same time as other technician) and hold the 
bell over the participant’s artery. 

5. Press START on the Omron. The Omron will inflate the 
cuff for both devices. 

6. Watch the Omron and listen for the onset of 1st 

(sounds) and 5th (disappearance) Korotkoff phase 
sounds, noting the pressure levels.  

7. Record the systolic and diastolic BP levels from the 
Omron, when the cuff is completely deflated and the 
Omron is at “0.”  

  

2.5.5 Second Blood Pressure Measurements 
 
The above steps should be repeated, starting at Step 2.6.3.(7) 
for the RZ technician and Step 2.6.4.(5) for the Omron technician.  Each technician should take both 
measurements with the same device.   The RZ technician will continue to record the measurements 
in the Random Zero section of the BCF form and the Omron technician will continue to record 
measurements in the OMRON section of the form. 
 
2.5.6 Measurements Using Omron Only Equipment 
 
When taking measurements using ONLY the Omron equipment, follow all the instructions above for 
the Omron Technician except: 
 

1. only one technician is required 
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2. Set the P-SET value to AUTOMATIC and record the maximum inflation on the monitor before 
the monitor begins automatic deflation as the P-set value. 

3. Set the MODE to AVG. The monitor will automatically take two measurements one minute 
apart displaying the first, second, and average blood pressure readings. Record each as 
directed in the SBP QxQs for the relevant items.   

 
2.6 Quality Assurance 
 
2.6.1 Training Requirements 
 
Staff performing the ankle-arm index measurements should be research technicians or clinicians 
previously trained in taking research blood pressure measurements.  In addition, training should 
include: 
 

• Read and study manual 

• Attend Jackson Heart Study training session on techniques (or observe administration by 
experienced examiner) 

• Practice on volunteers 

• Compare measurements with those made by experienced colleagues (Goal: obtain 
measurements within ± 2 mm Hg of that observed by a trainer) 

• Discuss problems and questions with QC officer 
 
2.6.2 Certification Requirements 
 

• Complete training requirements 

• Recite exclusion criteria 

• Conduct exam on two volunteers while being observed by QC officer listening with Y 
stethoscope 
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3.0 SELF MONITORED BLOOD PRESSURE 
 
3.1 Introduction and Equipment 
 
The self monitored blood pressure component of Exam 2 includes instructing the participant in the use of 
the Omron HEM-780 Intellissence Automatic Blood Pressure Monitor and providing opportunity for the 
participant to satisfactorily measure her/his blood pressure prior to leaving the clinic. This monitor is ideal 
for self monitoring as it uses oscillometric methods of blood pressure measurement to detect blood 
movement through the brachial artery and converts these movements to a digital reading. Thus, no 
stethoscope is needed simplifying the use of this equipment.  
 
The HEM-780 comes with the following components: 
 
Monitor    ComFit Cuff 
AC Adapter   4 “AA” Batteries 
Storage Case   Instruction Manual 
 
 
3.1.1 Preparation in Advance of Clinic 
 
Clinic staff will prepare each monitor in advance of the clinic session by setting the date and time 
following the instructions in the HEM-780 Instruction Manual (Appendix). This will shorten the time 
needed for the participant’s to learn to use the equipment for blood pressure measurement. 
 

1) Press the Date / Time Setting button. The Year flashes on the display.  
2) Setting the Year. The year can be set between 2004 and 2030. If you accidentally advance to 

2030, it will return to 2004. Press the ► memory up button to advance by increments of one 
year. Press the Date / Time Setting button. The Month flashes on the display 

3) Setting the Month. Press the ► memory up button to advance by increments of one month. 
Press the Date / Time Setting button. The Day flashes on the display.  

4) Setting the Day. Press the ► memory up button to advance by increments of one day. Press the 
Date / Time Setting button. The Hour flashes on the display. 

5) Setting the Hour. The Time is set using AM or PM. Press the ► memory up button to advance 
by increments of one hour. Press the Date / Time Setting button. The Minute flashes on the 
display. 

6) Setting the Minutes. Press the ► memory up button to advance by increments of one minute. 
Press the Date / Time Setting button to set the current minute. The Year flashes on the display. 

7) Press the START / STOP button to turn the display off. 
 
 
3.2 Participant Instructions  
 
Participants will be instructed in the proper application and removal, blood pressure measurement, use of 
the memory function, care and maintenance, and trouble shooting for common error codes of the Omron 
780-HEM SMBP device during the clinic visit. Safety features will be reviewed.  Review the SMBP 
Instructions to Participants and the HEM-780 Instruction Manual with participants. 
 
Provide participants with a copy of the SBPM Participant Instructions and the JHS Blood Pressure Diary. 
Inform participants that they will be called in 2-6 weeks to assure that they are having no difficulties with 
SMBP measurement and to obtain their most recent readings from their monitor’s memory.  
 
3.2.1 Preparing to Take a Measurement 
 
Instruct participants to follow these recommendations in order to ensure a reliable blood pressure 
reading: 
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1) Avoid eating, smoking, and exercising for 30 minutes before taking a measurement. Rest for 
at least 5-15 minutes before taking the measurement 

2) Avoid taking measurements during stressful times as stress may elevate the blood pressure 
3) Take measurements in a quiet place 
4) Remove tight fitting clothing from the right upper arm (Please note with the participant that 

this is DIFFERENT from what is written in the Instructions Manual accompanying the monitor) 
5) Sit in a chair with your feet flat on the floor resting your right arm on a table so that the cuff is 

at the level of your heart 
6) Remain still and do not talk during the measurement 
7) Try to measure your blood pressure at the same time of day each time you measure it 
8) Take three measurements one or more minutes apart at one sitting 
9) Make sure to wait at least 1 minute between readings to allow arteries to return to pre-blood 

pressure measurement condition 
10) Keep a record of readings from blood pressure and pulse for your health care provider.  
11) Use the HEM-780 memory function to obtain an “average” of the last three blood pressures 

taken at one sitting 
12) Record the average on the Blood Pressure Diary 

 
Place the blood pressure main using on the table. Insert the AC Adapter into the back of the unit and 
plug it in to a 120V AC wall outlet. When disconnecting the AC Adapter, unplug it from the back of the 
monitor prior to unplugging it from the wall outlet.  
 
3.2.2 Applying the Arm Cuff 
 
The HEM-780 SMBP device is supplied with a ComFit cuff that accommodates all but the very largest 
arm sizes. Plug the air plug securely into the main monitor on the left side of the unit. The arm cuff will be 
applied to the participant’s RIGHT arm, unless there are compelling reasons to do otherwise (for 
example, amputation, mastectomy, dialysis shunt, etc). Turn the palm of the right arm upward. Holding 
the grip on the cuff securely with the left hand, apply the cuff to the right upper arm so that the blue strip 
is on the inside of the arm and aligned with the middle finger. The bottom of the cuff should be 
approximately ½ inch above the elbow. Wrap the cuff firmly in place using the Velcro strip. Be careful not 
to rest the arm on the air tube as this will restrict the flow of air to the cuff, preventing it from inflating. 
 
3.2.3 Taking a Measurement 
 
1. Initiate a reading by pressing the START/STOP button.  All display symbols will appear on the face 

of the monitor and the cuff will start to inflate automatically 
 

SPECIAL CONDITIONS: If the participants’ systolic blood pressure in known to be more than 
220 mm Hg, press and hold the START/STOP button until the monitor inflates to 30 or 40 mm 
Hg higher than the suspected systolic blood pressure, taking care not to apply more pressure 
than necessary. 

 
2. Inflation stops automatically and the measurement is started. As the cuff deflates, decreasing 

numbers appear on the display and the Heart Symbol ( ♥ ) flashes at every heart beat 
3. The arm cuff completely deflates when the measurement is complete 
4. The blood pressure and pulse are displayed 
5. Press the START/STOP button.  Rest for 1-3 minutes with feet flat on the floor and without talking or 

moving 
6. Initiate a second and third reading by pressing the START/STOP button and following steps 1-4 

above. 
7. Press the ◄ memory down button. The average value symbol will display on the screen with the 

average blood pressure reading.  
8. Record this reading in your Blood Pressure Diary 
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3.2.4 Using the Memory Function 
 
The date and time is alternately displayed with the measurement values selected. Press the ◄ memory 
down button to display the most recent measurement value on the screen. Press the ►memory up 
button to display the oldest measurement values. Continue to press the down (or up) button repeatedly to 
display the next most recent (or next oldest) values. 
 
To delete all values in the memory, hold the ◄ memory down button AND the STOP / START button at 
the same time for more than 2 seconds.  
 
 
3.2.5 Error Codes 
 
The monitor is designed to illustrate a pictorial code if there is a problem in taking a measurement.  
The following list contains a brief description of the event codes which appear on the monitor display. 
 
Table 5.  Omron 780-HEM Error Codes, Causes, and Solutions 
Symbol Cause Correction 
E Monitor did not 

detect pulse rate 
Remove the arm cuff. Refer to 13 in the Instruction Manual—
“Applying the Arm Cuff.” Wait 2-3 minutes. Take another 
measurement. 

EE Cuff under-inflated Remove the arm cuff. Read p 16 in the Instruction Manual – “Taking 
a Measurement.” Wait 2-3 minutes. Take another measurement. 

E 
E 

Cuff over-inflated Remove the arm cuff. Read p 16 in the Instruction Manual – “Taking 
a Measurement.” Wait 2-3 minutes. Take another measurement. 

 
■  

Batteries are worn Replace the 4 batteries. Refer to p 8 in the Instruction Manual for 
battery installation directions. 
 

 
Other troubleshooting tips include: 
 
Table 6. Omron 780-HEM Troubleshooting Tips 
Problem Causes and Solutions 
No power 
 
No display appears on unit 

Replace worn batteries 
 
Check the battery installation for proper placement of the battery 
polarities 
 
 

 
 
Measurements appear too 
high or too low 

Blood pressure varies constantly. 
Many factors including time of day, how you wrap the cuff, stress 
may affect your blood pressure. 
Review the sections “Before Taking a Measurement” and “Taking a 
Measurement” in your Instructions Manual 

 
 
3.2.6  Care and Maintenance of the Monitor 
 
Instruct the participant to follow the directions listed below to keep her/his blood pressure monitor in 
the best condition and to protect it from damage 
 

1) Keep the monitor in its storage case when it is not in use. Make sure that the AC Adapter is 
placed under the main unit so that it does not damage the display screen 

 
2) Do not forcefully bend the arm cuff or the air tube. Do not fold tightly 
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3) Clean the monitor with a soft dry cloth using no abrasive or volatile liquids. Do not attempt to 

clean the cuff. Never immerse the unit or any of its components in water 
 
4) Store the unit in a clean, dry place and do not subject it to extremes of heat or cold, humidity, 

or direct sunlight 
 
5) Try not to subject the unit to strong shocks, such as dropping it on the floor 
 
6) Remove the batteries if the unit is not used for 3 or more months 
 
7) Use the unit in accordance with the Instruction Manual and only use authorized parts and 

accessories 
 
 
3.2.7 Safety Information 
 
The Omron HEM-780 blood pressure monitor should be used only in accordance with the Instruction 
Manual accompanying the unit for the purpose of measuring blood pressure and pulse. The 
participant should complete the Product Registration form within 10 days of receiving the unit and 
mail it to: 
 
Omron 
PO Box 174378 
Denver, CO 80217-4378 
 
This will register the unit and enable the product warranty. Any attempt to disassemble or repair the 
unit or its components will void the user warranty.  
 
Instruct the participant to follow her/his health care provider’s recommendations regarding blood 
pressure. The unit is only intended for use in adults and should not be used with children or infants or 
persons who cannot express their intentions.  
 
Instruct the participant not to: 
 

• Use a cellular phone near the unit as it may result in operational failure 
• Plug or unplug the AC Adapter unit with wet hands 

 
3.3 Participant SMBP Follow Up 
 
The SMBP nurse will complete a telephone follow up with each participant to assure that s/he is not 
having any difficulties with using the equipment. During that call, the participant will be asked to 
provide information on the most recent readings taken with their monitor. Information regarding 
participant use of equipment, satisfaction, and blood pressure readings will be recorded on the Post 
Self Monitored Blood Pressure (ASB) form in accordance with the QxQs (Forms Appendix). 
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APPENDICES 
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Appendix 1 Check Procedures and Maintenance Instructions Random Zero 
Sphygmomanometer 

 
 
1. Check cap of manometer column to be sure it fits properly and is tight.  The 0 ring or seal must be 

seated correctly.  Clean cap of any mercury (Hg) beads or dust.  The cap should be firmly finger 
tight.  Any time the mercury seems to 'bounce' in the column of either a standard manometer or 
random zero (R-Z) manometer, it may be due to a loose cap.  Check the opening.  If it becomes 
blocked, the mercury column falls too slowly due to a vacuum effect.  This may result in false high 
readings and an erratically oscillating column.  This procedure should be carried out for both 
standard manometers and R-Z's. 

 
2. Remove back of case (two screws at top of face and two at bottom rear of case).  Swing back 

from the left around the thumbscrew on the right side.  Check for spring placement - it should be 
in line.  Tighten all screws except the one holding the bellows plate in place. 

 
3. Wrap an arm cuff around a bottle or can. 
 
4. With reservoir valve open (newer models do not have a reservoir valve) and bellows valve closed, 

pump mercury to top of column (270-290 mmHg).  If the mercury holds at a steady level for 15 
seconds or drops 2-4 mm, that system is airtight. 

 
5. With the high pressure still in the system, close the reservoir and disconnect cuff to see if that 

valve holds steady pressure.  If a leak is discovered in the reservoir valve, remove hose and 
valve (with Allen wrench).  Valve handle unscrews or lifts off.  There are two 0 rings on the valve 
stem.  Clean stem and replace 0 rings.  Use stopcock grease in 0 rings and valve. 

 
6. If the closed reservoir valve is tight, but there was a leak with it open, check the inflation 

assembly.  There may be a leak in the bulb, valve, or cuff.  To test the inflation assembly, 
immerse each section, especially valves and tubing connections in water while the pressure is 
high and watch for air bubbles.  To test the tubing of the Hg reservoir, put soapy water on it.  Most 
leaks occur at or near tubing connections or from valves.  If a valve leaks sometimes a shot of 
silicone lubricant on the thumbscrew and worked in will solve the problem.  Otherwise it may 
need to be replaced.  Tubing leaks near a connector can be repaired by removing the connector, 
cutting off 1/2 to 3/4 inches and replacing the connector.  Lubricate a sharp knife with soapy 
water to make the cut, and lubricate the cut tube to make it easier to reattach. 

 
7. Turn R-Z with back toward you.  With bellows valve open, retract mercury to just below the 

plexiglass valve chamber.  Close the bellows valve, pump mercury to top and visually check that 
leakage does not occur at that valve point.  If Hg rises into the chamber, the valve needs repair. 
Replacing 0 rings on that valve can be done locally if someone is qualified to do it.  It is a more 
difficult job than on the reservoir valve.  Otherwise it should be sent to Baum.  A serious leak in 
this valve can affect blood pressure readings.  Whenever the manometer tube seems dirty in the 
area of the 'zeros' or if the Hg seems to hang up there, the tube should be cleaned.   A dirty tube 
can affect 'zero' readings.  To clean tube, set cam at lowest zero.  Pump up, close bellows valve, 
and release pressure.  This leaves little mercury in the column.  Tilt manometer, getting rest of 
mercury out of glass and into reservoir.  Close reservoir valve.  Lean manometer at angle so that 
no mercury is in glass.  Remove the tube and clean tube and seats.  Check to be sure that the 
rubber gaskets are seated properly.  Replace tube.  Only a qualified person in a controlled setting 
should do this procedure.  The manometer is set in a catch basin so that no mercury can escape.  
There should be a rap-type vacuum pump available to pick up any small spills. 
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8. Check "maximum" and "minimum" zeros and of bellows and cam function.  (This must be done 

only if there are doubts about the values of those zeros or functions; or if Hg has been added or 
lost.) 

 
a. Release all pressure and open the bellows valve.  The large thumb wheel with the black 

rubber "tire" and the cam against which it is pressed should turn freely without binding.  If 
they do bind, bring in the R-Z. 

 
b. Inflate the system while watching the large (about 2-1/4" diameter) disc above and to the 

left of the bellows valve chamber.  (Bellows valve is still open.)  As pressure rises one 
can see the disc, a piston, pushed toward the back plate until a ring around the center of 
the disc touches the forward rim of the cam.  That rim is tapered, and thus determines 
how far the piston can move, depending on the position of the taper in relation to the ring 
at the center of the piston - a matter of change in normal operation of the R-Z.  The 
distance that the piston can move before being stopped by the cam determines the 
volume of Hg in the bellows chamber; hence the volume of Hg left in the rest of the 
manometer. 

 
c. To read "maximum" zero, release pressure with bellows valve still open.  Turn the cam so 

that the point of its taper nearest the piston will be hit by the ring of the piston.  (It may 
take an inflation and deflation or two before you find the correct cam position, which 
allows the minimum volume of Hg in the bellows chamber, hence maximum Hg in the rest 
of the system.)  Inflate to about 200 mmHg, close the bellows valve, release pressure 
and read the zero as usual; this is the "maximum".  Repeat the procedure once or twice, 
checking the cam position to make sure you get the same reading.  Note that this is not a 
fixed value for if you were to inflate to 300 before closing the bellows valve, the reading 
would be lower; and inflation to 120-130 would give a higher value.  For this reason, 
always record the maximum zero reading when taking blood pressures. 

 
d. "Minimum" zero is measured as in c above, except that the cam is turned so that the 

piston can travel its maximum.  It is usually nearly 20 mm lower than the "maximum" and 
should not be closer than about 4 mm to the 0 on the manometer tube scale. 

 
e. Replace the rear case, putting it over the thumb wheel first.  Start all four screws before 

tightening any.  Take care not to cross thread. 
 

f. After a series of blood pressure readings or before transport, open the bellows valve to 
drain Hg from that chamber, then close it and the reservoir valve.  Between readings, the 
bellows valve should be left on "open" so that pressure on the bellows is not left in the 
device. 
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Appendix 2 Maintenance Procedures for Standard Sphygmomanometer 
 
 
The following checks should be conducted at least every month, and a log kept of the dates and the 
people carrying out the troubleshooting (see Appendix 4). 
 
1. With the instrument placed flat on the table, and the inflation system disconnected, the level of 

mercury should read zero in the standard instrument.  If the reading is either above or below the 
zero mark, mercury should be added or withdrawn until it does read zero.  The top of the 
meniscus is on the zero line when the eyes are level with this line and the mercury is correctly 
adjusted. 

 
2. The inflation system should then be reconnected, and the cuff rolled around a bottle and secured.  

The valve should be closed on the Air Flo system, and the instrument inflated until the mercury 
rises to 240 mmHg.  The Air Flo valve should then be slowly opened and the mercury allowed to 
fall to 200 mmHg.  The valve should then be closed; at which time the mercury column should 
remain stable.  If the column continues to fall, there is an air leak, and the following step should 
be taken: 

 
3. The system should be reinflated until the column rises to 200 mmHg.  The tubing should be 

pinched at various locations to localize the area of the leak.  Appropriate replacement of the 
tubing, cuff, or valve should be performed. 

 
4. With the instrument inflated above full calibration, the screw cap should be examined for mercury 

leaks.  If this happens, the screw cap should be tightened.  If the leak persists or the mercury is 
seen at the bottom of the tube, the silicone rubber, which provides a seat for both ends of the 
glass tube, should be replaced. 

 
5. With time, the mercury will become dirty and an oxide layer will be deposited on the inside of the 

glass tube.  The instrument should be laid nearly on its side (on a tray) so that the mercury will 
return to the reservoir and none can be seen in the glass tube.  The tube should be removed 
carefully and cleaned out using the long pipe cleaner supplied with the instrument.  The tube 
should then be replaced and the zero level rechecked. 

 
Since mercury is a toxic substance all maintenance procedures must be performed carefully and with 
attention to safety.  Mercury should not be allowed to get in contact with rings and other jewelry. 
 
(Maintenance instructions for the standard sphygmomanometer are adapted from those given for the 
MRFIT study in Controlled Clinical Trials, Vol. 7, No. 3 (Supplement), Sept. 1986. 
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Appendix 3 Check Procedures for Maintenance of the Omron HEM907XL Blood Pressure 
Equipment 

 
The following checks should be conducted at least every month, and a log kept of the dates and the 
people carrying out the troubleshooting (see Appendix 4).  
 
1. Assemble the following equipment: 

2. Connect the manometer, inflation bulb, cuff, and the monitor with the T-tube (see p 26 of the 
Omron HEM907XL Instruction Manual. 

3. Tightly wrap the cuff over a sturdy cylinder 

4. Release the valve of inflation bulb to remove the air inside the cuff completely 

5. Set the MODE to “CHECK” 

6. Close the valve of inflation bulb and inflate the cuff to the pressure to be checked, based on 
the manometer read 

7. Compare the pressure values displayed on the monitor with the one on the manometer 

 

CHECK RESULT: The accuracy of the monitor should be validated to ±3 mmHg or 2% of standard 
manometer reading. If the result shows a difference exceeding this tolerance, contact Omron repair 
department (1-877-216-1336). 
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Appendix 4 Checklist for Biannual Observation of BP Technicians by BP Supervisor 
 
 
BP Technician Code #_______  Observer Code #_______ 
 
Date Observed  ____/____/_____ 
 
_______________________________________________________________________ 
 
Instructions: For each item, check "yes" or "no" in the space provided to indicate if the procedure is 
carried out correctly.  Record any comments in the blank line between that item and the next.  For 
certain items specific parts of the procedure which are important are listed separately.  Supervisor 
should recheck all measurements and procedures. 
 
 Yes No 
ALL:   
Measures arm for correct cuff size (  ) (  ) 
   
Palpates brachial artery (  ) (  ) 
   
Marks pulse point (  ) (  ) 
   
Wraps cuff center of bladder over brachial pulse (  ) (  ) 
   
Leaves subject for five minutes rest (  ) (  ) 
Instructs on Posture (  ) (  ) 
Full five minutes for rest allowed (  ) (  ) 
Work station free of excessive noise (  ) (  ) 
Explanation (  ) (  ) 
   
Count radial pulse 30 seconds, record reading (  ) (  ) 
RANDOM ZERO AND COMPARABILITY STUDY   
Finds Pulse obliteration point using standard 
manometer 

(  ) (  ) 

   
Calculates peak inflation, standard manometer (  ) (  ) 
   
Calculates peak inflation, R-Z (  ) (  ) 
   
If computer is down use the formula (pulse obliteration 
pressure + R-Z maximum zero number + 30 

  

Explanation (  ) (  ) 
   
Connects R-Z tube to cuff (  ) (  ) 
   
Sure reservoir lever open (newer devices have no 
lever) 

(  ) (  ) 

   
Opens bellows valve and waits full 3 seconds for 
mercury to settle  

(  ) (  ) 

   
Turns thumb wheel (down strokes only) (  ) (  ) 
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 Yes No 
   
Places stethoscope in ears (  ) (  ) 
   
Inflates rapidly to R-Z peak (  ) (  ) 
   
Counts full 5 seconds with pressure steady (  ) (  ) 
   
Closes bellows knob (  ) (  ) 
   
Places bell on brachial pulse (  ) (  ) 
   
Deflates cuff 2 mmHg per second (  ) (  ) 
   
Deflates cuff after 2 absent sounds (  ) (  ) 
   
Records readings (  ) (  ) 
   
Disconnects tubes (  ) (  ) 
   
Reads zero value (  ) (  ) 
   
Subtracts zero value from each BP reading, if using 
paper form 

(  ) (  ) 

   
Instructs to hold arm vertical for full 5 seconds (  ) (  ) 
   
Waits at least 30 seconds before proceeding (  ) (  ) 
   
Repeats R-Z readings (  ) (  ) 
   
Informs participant of average readings (  ) (  ) 
OMRON    
Assure unit is properly plugged into wall unit (  ) (  ) 
   
Push ON/OFF button to turn on power (  ) (  ) 
   
Set the MODE for AVG (if off site) 
Set the MODE for MANU if on site 

(  ) (  ) 

   
Set the P-SET to AUTO (if off site) 
Set the P-SET to = Item 15 SBP-B (if on site) 

(  ) (  ) 

   
Wrap the proper size cuff on arm (  ) (  ) 
   
Press the START button to take measurement (  ) (  ) 
   
Records the first measurement (  ) (  ) 
   
Records the second measurement (  ) (  ) 
   
Records the average measurement (if off site) (  ) (  ) 
   
Push the ON/OFF button to turn the power off (  ) (  ) 
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Inform the participant of the average reading (  ) (  ) 
 
Special Comments: 
 
______________________________________________________________________________ 
 
______________________________________________________________________________ 
 
______________________________________________________________________________ 
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Appendix 5 JHS Monthly Log for Sitting Blood Pressure Station 
 
 
Month________Year________ 
 
 
Weekly Check Procedures: 
    Week   
       
  1 2 3 4 5 
       
1. Random-Zero 

Sphygmomanometer: 
     

       
 Date of Check _____ _____ _____ _____ _____ 
       
A. Check Tube for Oxide Dust _____ _____ _____ _____ _____ 
       
B. Check Cap for Tightness   _____ _____ _____ _____ _____ 
C. Check Omron for Accuracy ______ _____ ______ ______ _____ 
 
 
Procedures performed only if there appear to be problems: 
 
C. If mercury bounces even though the cap appears tight, remove cap, clean of any mercury 

beads, and check opening at top of tube for dust 
 
 Check Needed and Performed during weeks  1 2 3 4 5 
 (Circle number of weeks applicable)      
 
D. If tube appears "dirty" (oxidized mercury) remove cap, tip manometer to retract mercury, run 

pipe cleaner down, replace cap  
 
 Needed and Performed during weeks 1 2 3 4 5 
 (Circle number of weeks applicable)      
 
E. List the problem encountered, the date, and the actions taken below: 
 

_________________________________________________________________________ 
 
_________________________________________________________________________ 
 
_________________________________________________________________________ 
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Monthly Check Procedures: 
 
A. Accuracy Check on Random-Zero Sphygmomanometer (to be performed every 2 months): 
 

Date last accuracy check performed: _____________ 
 
Is an accuracy check due this month? (  ) Yes  (  ) No 
 
Date accuracy check performed, if due: _____________ 
 
Problems found on accuracy check? (  ) Yes  (  ) No 
 
If yes, list problems found and corrective action taken: 
 
_________________________________________________________________________ 
 
_________________________________________________________________________ 
 
_________________________________________________________________________ 
 
 
Random Zero Sphygmomanometer Check 
 
Standard 200 170 140 100 60 
      
Random Zero ____ ____ ____ ____ ____ 
      
Zero ____     
      
Corrected      
R-Z Measure* ____ ____ ____ ____ ____ 
 
Corrected R-Z measure = [(Random-Zero) - Zero] 
 
Note that this corrected R-Z measure must be within 2 mmHg of the 
standard. 

 
B. Standard sphygmomanometer check (to be performed every two months) 
 

Date of check: ______________ 
 
A. Check cap for tightness ______ 
 
B. Check tube for oxide dust ______ 
 
C. Check that mercury is at 

zero with no pressure ______ 
 
List any problems found and corrective action taken: 
 
_________________________________________________________________________ 
 
_________________________________________________________________________ 
 
_________________________________________________________________________ 
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C. Accuracy check for Omron monitor (to be performed every two months) 
 
 Date of Check:  ________________________ 
 

Problems found on accuracy check? (  ) Yes  (  ) No 
 
If yes, list problems found and corrective action taken: 
 
_________________________________________________________________________ 
 
_________________________________________________________________________ 
 
_________________________________________________________________________ 

D. Measuring tape for arm circumference worn or stretched 
 

Tape measure has been tested as part 
of Anthropometry station procedures. (  ) Yes  (  ) No 
 
If no, perform tape measure calibration check: 
 
Check by holding the zero mark of the tape against the ruler used to measure standing height 
at the 150 cm. mark.  If the 30 cm. mark on the tape used for arm circumference falls outside 
the range 119.5 to 120.5 on the standing height ruler it should be replaced. 
 
 
Date of check: _____ 
 
Point on height ruler where 30 cm. on tape falls _____ 
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Appendix 6 Accuracy Check on the Random-Zero Sphygmomanometer 
 
 
This check should be performed every two months, using a standard manometer and an Y connector.  
Check that the mercury level of the standard device reads zero with no pressure in the system.  If it 
does, it should be treated as accurate and having an adequate supply of mercury. 
 
To perform the accuracy check on the R-Z instrument, attach the two arms of the Y connector directly 
to the reservoirs of the R-Z and standard devices, using Latex tubing.  Attach the base of the Y 
connector to a cuff with an Air Flo control valve and bulb.  To attach the Latex tubing to the reservoirs 
or to a valve, it may be helpful to moisten the openings of the tubing to allow the tubing to slip onto 
the desired parts.  Wrap the cuff around a bottle or can. 
 
First open the Air Flo valve to insure that all pressure is out of the system.  Check the zero level of the 
standard device.  Next, turn the R-Z valve to the OPEN position.  Close the Air Flo valve and inflate 
both machines until the mercury level in the standard device is at the 250 mmHg level.  After 5 
seconds, close the R-Z valve.  Allow the mercury in the standard manometer to drop to 200 mmHg.  
Record the exact levels of mercury in the RZ and standard device.  Repeat the procedure at 170 
mmHg, 110 mmHg, 80 mmHg and 60 mmHg.  Release the air from the Air Flo valve.  When the 
mercury in the R-Z instrument has stabilized and the standard is at zero, record the zero reading from 
the R-Z.  Subtract this value from the R-Z readings. 
 
The results should agree with the comparable readings on the standard instrument within + 2 mmHg.  
If this agreement is not found at all levels, repeat the procedure.  If the disagreement is constant, stop 
using the instrument and contact the manufacturer. 
 
Worn parts should only be changed as necessary (when there is disagreement between the R-Z and 
standard devices).  Only those parts in the parts kit should be changed.  No attempt should be made 
to change the rubber diaphragm or bellows. 
 
Note: These instructions are adapted from the procedures employed by the MRFIT study, described 
in Controlled Clinical Trials, Vol. 7, No. 3 (Supplement), September 1986. 
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Appendix 7 Form for Recording Simultaneous Blood Pressure Observations on a Volunteer 
by Two Technicians 

 
 
Instructions: 
 
Biannually, each technician should be part of a pair of technicians who simultaneously measure blood 
pressure using an Y-tube on a volunteer (not a JHS participant).  Each technician should separately 
record his/her measurements on a standard paper JHS SBP form.  The blood pressure supervisor 
should then transfer the results to this form and calculate the differences between the two sets of 
measurements.  If the difference on any individual measurement is greater than 4 mmHg, or if the 
averages of the two readings for each technician differ by more than 3 mmHg, the supervisor should 
indicate the corrective action taken on this form.  Any further sets of simultaneous measurements for 
a given pair should appear on a new form. 
 
 
Technician IDs: 1st ID: __________ 2nd ID:__________  Date: _______ 
 
 
  1st Technician 2nd Technician Difference 
     
a. Initial arm circumference (cm) ___________ ___________ ___________ 
     
b. Initial cuff size selected ___________ ___________ ___________ 
     
c. Pulse Obliteration Pressure ___________ ___________ ___________ 
     
d. First SBP ___________ ___________ ___________ 
     
e. First DBP ___________ ___________ ___________ 
     
f. First Zero Reading ___________ ___________ ___________ 
     
g. First Net SBP 

Corrected for Zero 
 

___________ 
 

___________ 
 

___________ 
     
h. First Net DBP 

Corrected for Zero 
 

___________ 
 

___________ 
 

___________ 
     
i. Second SBP ___________ ___________ ___________ 
     
j. Second DBP ___________ ___________ ___________ 
     
k. Second Zero Reading ___________ ___________ ___________ 
     
l. Second Net SBP 

Corrected for Zero 
 

___________ 
 

___________ 
 

___________ 
     
m. Second Net DBP 

Corrected for Zero 
 

___________ 
 

___________ 
 

___________ 
     
n. Average Net SBP ___________ ___________ ___________ 
     
o. Average Net DBP ___________ ___________ ___________ 
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ACTION TAKEN IF DIFFERENCES BETWEEN TECHNICIANS EXCEED LIMITS SPECIFIED: 
 
______________________________________________________________________________ 
 
______________________________________________________________________________ 
 
______________________________________________________________________________ 
 
______________________________________________________________________________ 
 
______________________________________________________________________________ 
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APPENDIX 8  JHS OMRON AND RZ COMPARISON CHECK SHEET 

 
1. Equipment:  

 Standard sphygmomanometer 

 Single stethoscope with bell  

 Double Y-stethoscope with bell 

 Y-connector  

 Random Zero 

 Standard cuffs 

 Omron HEM907XL 

 Omron cuffs 

 

2. Staff:  
Two BP technicians: Each will record three measurements on Form 2C for use by the Random 

Zero (RZ) technician and the Omron technician.  Three BP measurements will be made on each 

BP Comparability Study participant.  The technicians will alternate observations using the RZ 

and Omron.  Technician No. 1 will measure a participant’s BP three times with the RZ, and 

Technician No. 2 will measure the participant’s BP three times with the Omron.  The next 

participant would have Technician No. 2 measure BP three times with the RZ, and Technician 

No. 1 measure BP three times with the Omron. 

 

3. Procedures: 
 Follow procedures on the other side of this card.  Repeat steps for measurements 2 and 3  and 

record readings on Form 2C where indicated for 2nd and 3rd measurements.  
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 RZ Technician Omron Technician 
1 Measure and record participant’s arm circumference 

(Q5) with Gulick II tape. 
 

2 Select and apply appropriate size standard cuff 
according to the participant’s arm measurement. 

 

3 Determine and record the Pulse obliteration level 
using the standard sphygmomanometer and cuff with 
fingers on the radial artery (Item 13). 

 

4 Add 30 mm to the Pulse Obliteration level and 
record (Item 14).  

 

5 Record the RZ maximum value for the RZ in use 
(#3).  Sum the values from Item 13 and Item 14 to 
determine the Peak Inflation level for the Omron P-
Set level setting (Item 15) (Done automatically by 
Data Entry System if using direct data entry). 

Apply the Omron appropriate sized cuff to the 
participant’s arm with the arrow at the brachial 
artery (same size used during the core exam Blood 
Pressure measurement). 

6 Attach Y-connector to the RZ, the Omron, and an 
appropriately sized Omron cuff with small connector 
removed so that the tubing can be attached to a Y-
connector.  

 

7 After the Omron is turned on, turn the bellows valve 
dial on the RZ to OPEN. 

Turn on the Omron.  Turn the P-SET dial on the 
Omron to the P-Set level estimated in #5 (RZ) 
above. Turn the MODE on the Omron to MANUAL. 

8 Place the double Y-stethoscope earpieces into ears.  Place the double Y-stethoscope earpieces into 
ears, holding the bell over participant’s artery. 

9 Omron will inflate the cuff for both devices, and the 
mercury column in the RZ will rise. 

Press START on the Omron, cuffs will inflate. 

10 When the mercury column on the RZ has dropped 20 
mm from its highest point, turn the RZ dial to CLOSE. 

Watch the Omron. 

11 Listen for the onset of the 1st (sounds) and 5th 
(disappearance) Korotkoff phase sounds. 

Listen for the onset of 1st (sounds) and 5th 

(disappearance) Korotkoff phase sounds.  
12 When the cuff is completely deflated, record readings 

from the RZ (Q6 for 1st reading).  Read and record 
the RZ (Q7) and subtract it from the RZ systolic and 
diastolic readings, recording the corrected 
measurement (Q8). 

When the cuff is completely deflated and the 
Omron is at “0,” record the systolic and diastolic BP 
levels from the Omron (Item 24 for 1st reading).   

13 Open the RZ dial and turn the thumb wheel.  
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Appendix 9 

OmROn®  
INSTRUCTION MANUAL  
IntelliSenseTM Blood Pressure Monitor Model HEM907XL  

 

Table of Contents  
Be Sure to Read This Section  
Exemptions 2  
Notes on Safety 3  
Know Your Unit  
Features of the Product 7  
Components of the Product 8  
Options 9  
Features and Functions 10  
Names of the Parts 10  
Functions and setting  
while the unit is in use 12  
Preparations before Measurement  
How to Apply the Cuff 14  
How to Use the Power Source 16  
How to Use the AC Adapter 16  
Installation and Replacement  
of Battery Pack 17  
How to Measure Blood Pressure  
List of Measurement Modes 19  
SINGLE Mode 20  
AVG Mode 22  
MANU Mode 24  
How to Check Pressure Accuracy. .26  
How to Clean the Unit after Use 27  
List of Error Codes 28  
Troubleshooting 29  
Specifications  
Caution 30  
Five Year Limited Warranty 31  
Specifications 31  
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Appendix 10 Omron HEM-780 Instruction Manual 
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Appendix 11 Self Monitored Blood Pressure Teaching 
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FOREWORD 
 
This manual is one of a series of protocols and manuals of operation for the Jackson Heart Study 
(JHS).  The complexity of the JHS requires that a sizeable number of procedures be described, thus 
this rather extensive list of materials has been organized into the set of manuals listed below.  Manual 
1 provides the background, organization, and general objectives of the JHS Study.  Manuals 2 and 4 
describe the operation of the Cohort Procedures, and Events Ascertainment Components of the 
study.  Detailed Manuals of Operation for specific procedures, including those for Blood Pressure and 
Quality Assurance, make up Manuals 3 and 5.  The Data Management System is described in 
Manual 6. The Central Laboratory and Specimen Repository are described in Manual 7. Manual 8 is 
designed to provide volumetric CT image data for measuring coronary and abdominal aortic calcified 
plaque as well as measuring body composition in the abdomen. 
 
 

 
 

JHS Study Protocols and Manuals of Operation 
 
 

MANUAL TITLE 
  
1 General Description and Study Management 
  
2 Cohort Component Procedures 
  
3 Blood Pressure 
  
4 Morbidity and Mortality  
  
5 Quality Control 
  
6 Data Management 
  
7 
 
8 

Specimen Collection and Processing 
 
Computed Tomography (CT) Scan 

               
 9 MRI Forthcoming 
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1.0 PURPOSE 
 
The Jackson Heart Study (JHS) provides a framework for research into the genetic, biochemical, 
epidemiological, and physiological causes of cardiovascular disease in African-Americans.  The study 
participants will include 5,600 African-Americans between the ages of 35-84 years.  Female and male 
participants will be equally represented.  Blood and urine samples and other information on these 
individuals will be extensively analyzed to determine how best to prevent and treat cardiovascular 
disease. 
 
Jackson, MS is the site of the only Exam Center involved.   The technicians at the exam center collect 
blood and urine specimens, process them, and ship them to the Central Laboratory at Fairview-
University Medical Center in Minneapolis, MN.  Specimens collected for immediate testing and 
specimens collected for long-term storage are both sent to the Central Laboratory. 
 
The Central Laboratory performs general blood and urine chemistry tests, routine plasma lipid tests 
(cholesterol, triglycerides, and HDL-cholesterol), and other more specialized analyses.  A complete 
list of tests performed is located in Appendix 1. 
 
The foundation on which all of these tests are based is the blood and urine samples that are collected 
and processed by the technicians at the Exam Center.  Probably the most important step (and 
potentially the most variable) is the collection and processing of the samples.  Laboratory tests can be 
repeated, but if the sample itself is NOT correctly collected and processed, the laboratory results may 
be precise, but perhaps not reflective of the in vivo state.  It is important that this study measures true 
differences between participants rather than differences in collection procedures.  The JHS depends 
heavily on the Exam Center technicians who perform the blood and urine collection and sample 
processing.  It is important that these people be not only well trained and competent at drawing blood 
and processing the blood and urine, but also willing to take pride and responsibility in their work. 
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2.0 PREPARATION 
 
 
2.1 Participant Contact 
 
Since the study depends on the voluntary participation of participants, every effort must be made to 
make the entire procedure as easy and painless as possible for them.  The technicians must remain 
calm and project an attitude of competence even when faced with the most nervous or inquiring 
participant.  The best way to achieve this is for the technicians to be thoroughly knowledgeable about 
all aspects of the procedures.  The JHS involves the collection of 30-40 mL of blood from each 
participant.  Three or four tubes of blood are collected.  The fourth tube (CPT) will be collected from 
all participants who did NOT have that tube collected at visit 1.  Any participant who is concerned 
about the volume of blood should be reassured that the total amount of blood drawn is only about two 
ounces, although it may look like more.  The technician may also assure participants that they donate 
11 times as much blood (450 mL) when they donate a pint of blood. Participants will also be asked to 
provide a random urine specimen during their visit. The technicians and the clerk should be wearing a 
clean laboratory coat. 
 
 
2.2 Staff Certification Requirements 
 
A certified JHS technician at the Exam Center performs the blood drawing and blood and urine 
processing.  Technicians complete a training course taught by certified laboratory staff.  Each 
technician must complete the training and pass both written and practical exams before becoming 
JHS-certified.  Re-certification takes place annually and is authorized by supervisory personnel. 
 
2.3 Blood Collecting Trays and Tubes 
 
Prior to venipuncture two trays are prepared for each participant.  One tray holds the Vacutainer 
tubes used in the blood collection.  The other tray holds the various plastic microvials which contain 
the final serum, plasma, and urine aliquots that are sent to the Central Laboratory and local laboratory 
for analyses.  The collection tubes and storage microvials are labeled with LABID numbers.  A list of 
equipment, suppliers, and vendors is provided in Appendix 2. 
 

2.3.1 Blood Collection Tray 
 
First, the technicians organize and prepare the blood collection tray.  The tray itself should be made 
of hard plastic, which is unbreakable and can be easily cleaned.  The tray has individual 
compartments, filled with the following supplies. 
 
• A test tube rack to hold the three or four blood collection tubes drawn from each participant.  

These tubes are described in detail in the next section. 
 
• Sterile, disposable 21 gauge butterfly needles 
 
• Plastic Vacutainer tube guides 
 
• Vacutainer Luer adapters 
 
• Sterile alcohol swabs 
 
• Gauze sponges 
 
• Tourniquets 
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• Bandages ("Band Aids") 
 
• Smelling salts, ice packs, and wash cloths should be readily available in the specimen collection 

area for patients who become faint during the blood draw 
 

2.3.2 Blood Collection Tubes 
 
Draw 30-40 mL of blood from each participant using three or four Vacutainer tubes.  Specimens from 
these blood collection tubes are used in approximately seven different biochemical assays.  It is 
important that the technicians know more than just the arrangement of the blood collection tubes and 
the sequence of tube collection.  They should also be familiar with the purpose of each tube, the type 
of anticoagulant in each tube, and possible sources of error in the handling of each tube.  These 
tubes are organized in the test rack in the following sequence: 
 
Tube #1 is a 10-mL red and gray-stoppered tube filled with 9.5 mL of blood.  This tube does NOT 
contain anticoagulant, so it does NOT need to be mixed following collection.  After drawing, allow the 
blood to clot at room temperature for 30 minutes.  Following centrifugation, the serum is frozen and 
sent to the Central Laboratory.  One potential problem with the processing of this tube is that one of 
the tests it is used for is a blood glucose determination.  If the serum is allowed to remain in contact 
with the red cells for much longer than 30 minutes, the serum glucose levels can be artifactually 
decreased. 
 
Tubes #2 and #3 are 10-mL lavender-stoppered tubes containing the liquid anticoagulant EDTA.  
The whole blood from this tube is used to measure glycosylated hemoglobin and for DNA extraction.  
The plasma is used for future testing.  After each tube is fully filled with blood, invert four times then 
place into a room temperature rack until centrifugation. 
 
Tube #4 is 8.5 mL black-and-blue-stoppered tubes containing citrate anticoagulant and ficoll hypaque 
cell separation media (Cell Preparation Tube or CPT).  It is collected only from participants who did 
NOT have this tube collected at visit 1.  This tube is used to isolate lymphocytes for cryopreservation 
and, ultimately, transformation.  After this tube is fully filled with blood, invert four times then place 
into a room temperature rack until shipment.  These tubes are not centrifuged. 
 
2.4 Blood Collection Tubes: Labeling and Set-up 
 
Three or tubes are drawn in the following sequence: 
 
Tube #1:    9.5-mL red and gray-stoppered tube 
Tube #2 and #3: 10-mL lavender-stoppered tube (EDTA) 
Tube #4:    8.5-mL black and blue-stoppered tube (CPT) 
 
Attach pre-numbered adhesive LABID labels to each Vacutainer tube and each plastic microvial prior 
to blood collection.  Place the labels on the tubes so that the barcoded ID number is positioned 
vertically.  Arrange the set of tubes in a test tube rack.  When the participant arrives for the Exam 
Center visit, place a LABID label on the Venipuncture form along with the participant's JHS ID 
number.   Handle only one participant's specimens at a time so the chance of mislabeling is 
minimized.  Each center must keep a permanent record of the matching of the JHS ID number to the 
laboratory ID number (e.g., participant log). 
 
Select a number of JHS participants to donate duplicate samples for analysis.  Assign duplicate 
samples a unique laboratory ID number and ship to the Central Laboratory one week later. This is 
described more completely in the Quality Control Section. 
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2.5 Sample Aliquot Tubes: Labeling and Set-up  
 
The technician prepares a tray of the plastic microvials that will contain the final samples that will be 
assayed locally or shipped to the Central Laboratory for each participant.  Each type of microvial has 
a corresponding color-coded screw cap that fits onto it.  The technicians should be trained to organize 
the tray for the sample processing as follows: 
 

2.5.1 Sample Tray 
 
The tray itself should be a flexible sponge test tube rack that will fit tubes from 10-16 mm in diameter.  
The tray has 5 rows and 10 columns.  The columns are numbered 1-10 from left to right.  The rows 
are lettered A-E from top to bottom. 
 

2.5.2 Organization 
 
The technician needs the following supplies for each sample tray:  
 

5 - 2.0-mL polypropylene vials (red top) 
5 - 2.0-mL polypropylene vials (purple top) 
5 - 2.0-mL polypropylene vials (clear top) 

 
Vertically label the microvials with the LABID number (letter designator at bottom) and arrange in the 
sample tray in the following order: 
 

Col 1: 2.0-mL red top vials (rows A-E) 
Col 2: empty 
Col 3: 2.0-mL purple top vials (rows A-E) 
Col 4: empty 
Col 5: 2.0-mL clear top vials (rows A-E) 
Col 6: empty 
Col 7: empty 
Col 8: empty 
Col 9:  empty 
Col 10: empty 

 
All extra labels are returned to the Central Laboratory with the weekly specimen shipment. 
 
2.6 Preparation for Specimen Collection 
 
Prepare for specimen collection in the following manner.  In the early morning, prior to drawing blood 
from the participants: 
 
1. Check to make sure the blood collection tray is properly equipped.  Every item on the checklist 

must be ready before proceeding. 
 

2. Check that each Vacutainer tube is properly labeled with the appropriate LABID number.  
 
3. Check that the sample processing tray is properly equipped.  Every item on the checklist must be 

ready and in its proper position. 
 
4. Check that each microvial is labeled with the appropriate laboratory number. 
 
5. Check that a urine collection container is labeled with the appropriate laboratory number. 
 
6. Perform and record quality control (QC) check on centrifuge temperature (4°C+ 2°C). 
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7. Perform and record QC check on refrigerator temperature (4°C + 2°C). 
 
8. Perform and record QC check on freezer temperature (-70°C + 10°C). 
 
9. Perform and record QC check on room temperature. 
 
At participant arrival:  
 
1. Place the LABID label (labeled on the collection tubes and aliquot vials) on the Venipuncture 

Form.  Make sure the JHS ID number on the Venipuncture Form is correct. 
 
2. Check that Quality Control tubes are prepared and labeled, if needed (see Quality Control section  

of this manual for details). 
 

 
2.7 Venipuncture Form and Urine Collection Form 
 
Enter the participant's JHS ID Number and name on the Venipuncture form when the participant 
arrives for the visit.  At the completion of specimen collection and processing, the entire original 
Venipuncture Form is kept on file at the Exam Center. 
 
The original Urine Collection Form is also kept on file at the Exam Center. 
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3.0 VENIPUNCTURE 
 
 
3.1 Precautions for Handling Blood Specimens 
 
Handle all specimens as potentially infectious for laboratory workers.  OSHA rules mandate that 
technicians must always wear disposable protective gloves when collecting and processing 
specimens. 
 
Use 0.5% sodium hypochlorite (household bleach diluted 1:10) to clean up any spills of blood, 
plasma, or serum. 
 
OSHA regulations require that all needles and sharp instruments be discarded into puncture resistant 
containers. 
 
Avoid formation of potentially infectious aerosols when removing the rubber stoppers from Vacutainer 
tubes.  In addition to wearing protective gloves, hold a piece of gauze over the stopper while slowly 
removing it from the tube. 
 
Place all used Vacutainer tubes and blood-contaminated products in biohazard bags for proper 
disposal. 
 
3.2 Phlebotomy Room  
 
The blood drawing takes place in an isolated room or in an area where participants are separated by 
room dividers. 
 
3.3 Participant Preparation 
 
Informed consent must be obtained from the participant before drawing blood and collecting urine.  
This procedure is followed to ensure that the participants understand the purpose of blood drawing 
and the possible complications of venipuncture.  A standard informed consent has been prepared for 
this study.  With regard to laboratory procedures, the consent statement informs study participants 
that although there may be some minor discomfort, their blood will be drawn by trained technicians.  
The consent statement also states that a copy of clinically relevant test results is sent to their 
physicians and that they will be contacted if clinically important tests are abnormal, if so desired by 
the participant. 
 
Complete the JHS Venipuncture Form with the participant. 
 
Blood drawing is standardized to the sitting position 
 
Give the participant enough time to feel comfortable after the blood collection, as well.  In many cases 
the most memorable part of the experience for participants will be the contact with the technicians 
who draw the blood and their general attitude and competence. 
 
If the participant is nervous or excited, the technician briefly describes the procedure, e.g., "I am 
going to be drawing about three ounces of blood.  This blood will be used in tests for lipids (or fats) 
and cholesterol and other chemistry tests.  We hope to be able to use the results of these tests to 
determine some of the causes of heart disease." 
 
HANDLING PARTICIPANTS WHO ARE EXTREMELY APPREHENSIVE ABOUT HAVING BLOOD 
DRAWN: Do NOT under any circumstances force the participant to have blood drawn.  It may help to 
explain to the participant that the blood drawing is designed to be as nearly painless as possible.  It is 
sometimes best to let the participant go on with another part of the visit.  It may also be helpful to 
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have the participant relax just so the phlebotomist can check the veins in the participant's arms, 
without actually drawing blood.  
 
Provide participant with a labeled urine collection container and instructions for specimen collection.  
If possible, obtain this specimen prior to blood collection.  The urine specimen may then be 
processed with the blood specimens.  
 
3.4 Venipuncture 
 
Before applying the tourniquet, screw the Luer adapter into the plastic Vacutainer tube guide.  Insert 
the butterfly tubing onto the adapter. 
 
With jacket or sweater removed, have the participant sit with the sleeves rolled up to expose the 
antecubital fossa (elbow).  The preferred arm to draw from is the left arm.  The right arm should be 
used only if blood collection is NOT possible from the left arm.  This does NOT mean you must stick 
the left arm.  Only do so if an adequate vein is apparent. 
 
PRECAUTIONS WHEN USING A TOURNIQUET: The tourniquet should be on the arm for the 
shortest time possible.  Never leave the tourniquet on for longer than two minutes.  To do so may 
result in hemoconcentration or a variation in blood test values.  If a tourniquet must be applied for 
preliminary vein selection, and it remains on the arm for longer than two minutes, it should be 
released and reapplied after a wait of two minutes.  Instruct the participant that he/she should not 
clench their fist prior to the venipuncture.  Doing so could cause fluctuations in the results in several 
of the analytes being measured.  Specifically, it could artifactually raise the serum potassium level.  If 
the participant has a skin condition, put the tourniquet over the participant's shirt or use a piece of 
gauze or paper tissue so as NOT to pinch the skin.  Wrap the tourniquet around the arm 3 to 4 inches 
(7.5 to 10.0 cm) above the venipuncture site. 
 
Identify the vein, then cleanse the venipuncture site. 
 
1. Remove alcohol prep from its sterile package. 
 
2. Cleanse the vein site with the alcohol prep using a circular motion from the center to the 

periphery. 
 
3. Allow the area to dry to prevent possible hemolysis of the specimen and a burning sensation to 

the patient when the venipuncture is performed. 
 
4. If venipuncture becomes difficult, the vein may need to be touched again with your hand.  If this 

happens, cleanse the site again with alcohol. 
 
Perform venipuncture. 
 
1. Grasp the participant's arm firmly, using your thumb to draw the skin taut.   This anchors the vein.  

The thumb should be 1 or 2 inches (2.5 or 5.0 cm) below the venipuncture site.  
 
2. With the needle bevel upward, enter the vein in a smooth continuous motion.  
 
3. Make sure the participant's arm is in a flat or downward position while maintaining the tube below 

the site when the needle is in the vein.  DO NOT HAVE THE PARTICIPANT MAKE A FIST IN 
THE HAND OF THE ARM FROM WHICH BLOOD IS TO BE DRAWN. 

 
4. After blood has appeared in the butterfly tubing insert tube #1 into the plastic vacutainer tube 

holder.  Grasp the flange of the tube holder and push the tube forward until the butt end of the 
needle punctures the stopper, exposing the full lumen of the needle.  The tube should begin filling 
with blood.  
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5. Once the draw has started, do NOT change the position of a tube until it is withdrawn from the 

needle.  If blood is flowing freely, remove the tourniquet after two minutes. A tourniquet may be 
reapplied during the collection to spare the participant a restick, but the tourniquet must NOT be 
on for more than two minutes.   

 
6. Keep a constant, slight forward pressure on the end of the tube.  This prevents release of the 

shutoff valve and stopping of blood flow. 
 
7. Fill each Vacutainer tube as completely as possible; i.e., until the vacuum is exhausted and blood 

flow ceases.  If a Vacutainer tube fills only partially, remove the tube and attach another without 
removing needle from vein. 

 
8. When the blood flow into the collection tube ceases, remove the tube from the holder. The shutoff 

valve covers the point, stopping blood flow until the next tube is inserted (if necessary).  Tubes 
which require mixing (#2 through #4) should be gently inverted four times immediately following 
removal of the tube from the adapter, then placed into a room temperature rack. 

 
If a blood sample is NOT forthcoming, the following manipulations may be helpful. 
 
1. Turn needle slightly or lift the holder in an effort to move the bevel away from the wall of the vein.  
 
2. Move needle slightly in hope of entering vein.  Do NOT probe.  If NOT successful, release 

tourniquet and remove needle.  A second attempt can be made on either arm.  The same 
technician should NOT attempt a venipuncture more than twice.  If a third attempt is necessary, a 
different phlebotomist should attempt the venipuncture. 

 
3. Loosen the tourniquet.  It may have been applied too tightly, thereby stopping the blood flow.  

Reapply the tourniquet loosely.  If the tourniquet is a Velcro type, quickly release and press back 
together.  Be sure, however, that the tourniquet remains on for no longer than two minutes at a 
time.  

 
At the conclusion of the blood draw: 
 
1. Remove the last collection tube from the Vacutainer tube holder prior to removing  the needle 

from the participant’s arm.  Lightly place clean gauze over the venipuncture site.  Remove the 
needle quickly and immediately apply pressure to the site with a gauze pad.  Discard the butterfly 
needle, adapter and Vacutainer tube holder into a needle box.  DO NOT ATTEMPT TO RECAP 
NEEDLES!  Have the participant hold the gauze pad firmly for one to two minutes to prevent a 
hematoma. 

 
2. If blood flow stops before collecting tube #4, repeat the venipuncture, collecting only the unfilled 

tubes from the previous attempt.  A tourniquet may be applied in this case but should be released 
if possible as soon as blood flows into the first tube.  As always, the tourniquet must never be on 
for longer than two minutes.  

 
Bandaging the arm.  
 
1. Under normal conditions: 
 

a. Slip the gauze pad down over the site, continuing mild pressure. 
 
b. Apply an adhesive or gauze bandage over the venipuncture site after making sure that blood 

flow has stopped. 
 
2. If the participant continues to bleed:  
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a. Apply pressure to the site with a gauze pad.  Keep the arm elevated until the bleeding stops. 
 
b. Wrap a gauze bandage tightly around the arm over the pad. 

 
c. Tell the participant to leave the bandage on for at least 15 minutes.  

 
PRECAUTIONS - WHEN A PARTICIPANT FEELS FAINT OR LOOKS FAINT FOLLOWING THE 
BLOOD DRAWING: 
 
1. Take an ampule of smelling salts, crush it, and wave it under the person's nose for a few 

seconds.  
 
2. Provide the person with a basin if he/she feels nauseous.  
 
3. Have the person stay seated or lying down until he/she feels better. 
 
4. Have someone stay with the person to prevent them from falling and injuring themselves if they 

should faint. 
 
5. Place a cold wet cloth on the back of the person's neck or on their forehead. 
 
6. Once the episode has passed, some fruit juice may be given to the participant in order to 

counteract any possible hypoglycemia due to their pre-clinic visit fast. 
 
7. If the person continues to feel sick, take a blood pressure and pulse reading.  Contact a medical 

staff member, who will advise you on further action.  
 
3.5 Blood Mixing During Venipuncture 
 
To invert tubes, hold the tube horizontal to the floor.  Slowly tip the stopper end down while watching 
the air bubble rise to the butt.   Now, lower the butt end slightly while watching the bubble float to the 
stopper (1st inversion).  Invert each tube, except #1 and #2, four times.  Four inversions should take 6 
to 8 seconds. 
 
1. Draw tube #1 (10-mL red and gray top).  Place the tube in a rack at room temperature. 
 
2. Draw tubes #2 and #3 (10-mL lavender top).  Invert four times and place in room temperature 

rack. 
 
3. Draw tube #4 (8.5 mL black and blue top).  Invert four times and place in room temperature rack 
 
 
4.0  Blood and Urine processing 
 
Processing of the various blood samples is divided into 3 stages.   
 
4.1 Stage One: Immediate Processing  
 
Tube #1 remains at room temperature for thirty minutes to allow the blood to clot (blood at 4°C clots 
extremely slowly).  Set a timer for 30 minutes as a reminder to centrifuge this tube. 
 
4.1.1 Whole blood for glycosylated hemoglobin and DNA isolation 
 
Tube #3 is placed into the refrigerator until shipment.  It is NOT centrifuged.  This tube must be 
shipped within 48 hours of collection. 
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4.1.2  Centrifugation 
 
Place tube #2 in the centrifuge trunion.  Balance the centrifuge then spin these tubes at 3,000 x g for 
10 minutes at 4ºC. 
 
Wait for centrifuge to come to a complete stop.  Remove the tubes from the centrifuge as soon as 
possible.  Proceed to stage two processing. 
 
4.1.2   Urine specimens 
 
1. Thoroughly mix the random urine specimen. 
 
2. Using a plastic transfer pipet, deliver 2 mL of urine to each of the five labeled microvials in  

column 5. 
 
3. Screw clear plastic caps onto each vial, and leave the sponge rack at room temperature. 
 
4.  Re-attach the screw cap to the collection container, and hold it at room temperature until all vials 

are safely frozen. 
 
4.2  Operating the Centrifuge 
 
Refer to Centrifuge Operating Manual for specific operating and balancing instructions.  In order to 
achieve a 3000 x g centrifugal force within the centrifuge, the corresponding revolutions per minute 
(RPM) will vary from centrifuge to centrifuge depending on radius of the centrifuge's rotor.  Consult 
the centrifuge's operating manual for the appropriate RPM for each centrifuge. 
 
4.3   Stage Two: 
 
Approximately 15 minutes after venipuncture.  
 
4.3.1  Lavender-stoppered Tube (Tube #2)  
 
1. Remove tube from the centrifuge and put it in the sponge test tube rack holding the microvials 

labeled with the corresponding laboratory number.  Remove the stopper. 
 
2. Using the plastic transfer pipette, and being careful not to disturb the cell layer, remove the clear 

plasma supernatant from tube #2.  The pipette tip should NOT get any closer than one-half inch 
from the cells.  Equally transfer the plasma into the five 2.0-mL microvials in column 3.   

 
3. Fasten the purple screw caps onto the microvials in column 3, and leave them in the sponge rack. 
 
4. Re-stopper collection tube #2, and discard it in a biohazard waste bag. 
 
5. Leave the sponge rack holding the filled aliquot vials at room temperature until it is time to 

remove the serum from tube #1.  The EDTA plasma vials must NOT be refrigerated.  They are to 
remain at room temperature until placed in the freezer. 

 
4.4   Stage Three 
 
Stage three begins approximately 30 minutes after venipuncture. 
 
As soon as possible after the 30 minutes timer goes off, and NOT longer than 45 minutes after blood 
collection, centrifuge tube #1 at 3,000 x g for 10 minutes at 4ºC.   
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4.5      Final Blood Processing 
 
1. Remove the red and gray top tube from the centrifuge and place it in the sponge test tube rack. 
 
2. Remove the stopper from tube #1.  Using a plastic transfer pipette, aliquot all of the serum 

equally into the five tubes in column 1. 
 
3. Fasten red screw caps on each of these vials. 
 
4. Replace the stopper on the red and gray-stoppered blood collection tube and discard it in a 

biohazard waste bag. 
 
5. Refrigerate one of the urine vials for local testing, then place the foam rack holding the remaining 

14 specimen vials in the -70ºC freezer. 
 
4.1.5      Black and blue-stoppered tubes (#4) 
 
1. This tube is to be shipped to the Central Laboratory without centrifugation.   
 
2. Shipments of tube #4 must occur daily, and the specimens must be stored at ambient 

temperature. 
 
3. Tube #2 (see above) may be shipped within 48 hours of collection. 
 
4.6          Freezing 
 
When all of the blood and urine specimens have been aliquotted into their respective microvials, and 
the microvials have been replaced in the sponge rack, the entire rack is placed upright in the -70°C 
freezer for a minimum of 30 minutes.  Samples must be placed into the freezer within 90 minutes 
from venipuncture time.  Samples must be thoroughly frozen before packaging them for storage and 
shipping.  Record the time that the samples are placed in the freezer on the Venipuncture form. 
 
Once the specimens are safely stored in the freezer, the urine may be discarded.  The urine can be 
poured down a sink with copious amounts of water, or it can be flushed down a toilet.  The empty 
collection jug should be discarded in accordance with local biosafety guidelines.   
 
 
5.0     STORAGE AND SHIPPING 
 
5.1           Storage 
 
5.1.1        Frozen Specimens 
 
Place all of the frozen serum and plasma vials from a single participant into a 5” x 8” zip-seal storage 
bag.  Place all of the frozen urine vials from a single participant into a separate 5”x 8” zip-seal storage 
bag. Check again to make sure all tubes are numbered.  Press the air out of the bag and seal.  Place 
these bags in the Central Laboratory box in the -70°C freezer and do NOT remove it until the time of 
shipment.  This shipment is prepared weekly. 
 
5.1.2  Ambient Specimens 
 
Ambient specimens (CPT tubes) are stored at room temperature until shipment.  The CPT shipment 
is prepared daily.  
 
 
 



12 

M7_ Version 1.0 _ 04-11-2007 
 

5.1.3     Refrigerated Specimens 
 
There are two types of refrigerated specimens: whole blood to be sent to the Central Laboratory (one 
tube per participant) and urine to be analyzed in the central laboratory (one vial per participant).  
Maintain a separate rack for each vial in the refrigerator until shipment.  The whole blood EDTA tube 
(#3) may be shipped within 48 hours of collection. and urine is delivered to the local laboratory daily. 
 
5.2    Shipping 
 
All frozen specimens collected and stored within the last workweek are shipped to the Central 
Laboratory on Monday, with the exception of Quality Control sera, as discussed in the Quality Control 
section below, by overnight courier.  If very few participants were seen in the Exam Center during a 
week, two or three weeks of frozen specimens can be combined into one shipment. 
 
Ship CPT specimens daily, even if only one participant was seen on a given day. 
 
Ship refrigerated whole blood EDTA specimens (tube #3) within 48 hours of collection. 
 
If there is any deviation from the regular shipping schedule contact the Central Laboratory to notify 
them of any changes. 
 
Weigh all packages before shipping, if possible.  It is important to record an accurate weight on the 
Federal Express airbill.  Do NOT over-estimate the package weight. 
 
5.2.1   Packaging Instructions (frozen specimens) 
 
The bags of frozen specimens are packed and shipped in styrofoam boxes.  Packaging instructions 
are as follows: 
 
1. Place a layer of dry ice on the bottom of the styrofoam box. 
 
2. Put half of the bags of specimens into the styrofoam box on top of the dry ice. 
 
3. Layer more dry ice on top of and around the sample bags. 
 
4. Put the remaining specimen bags into the styrofoam box on top of the dry ice.  
 
5. Layer more dry ice on top of and around the sample bags.  The amount of dry ice in the shipping 
box should total at least five pounds. 
 
6. Place packing material (e.g. bubble wrap) on top of the dry ice to fill the box. 
 
7. Place the paper shipping forms on top of the packing material.  The shipping forms and 
instructions are shown in Appendix 3. 
 
8. Seal the outer box tightly with strapping tape.  Affix UN3373 label to outside of box. 
 
9. Address the box and contact Federal Express for pickup. 
 

10. If necessary, more than one box may have to be shipped per week. 
 
5.2.2   Packaging Instructions (ambient specimens) 
 
1. Place ambient specimens into a foam-lined mailer.  More than one mailer may be required for all 
of the specimens. 
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2. Close the mailer and place it inside a large zip-seal storage bag.  Press the air out of the bag and 
seal. 
 
3. Place the mailer inside a larger styrofoam shipping box.  Add room temperature freezer packs and 
other packing material (e.g. bubble wrap) to occupy extra space. 
 
4. Place the paper shipping forms on top of the packing material.  The shipping forms and 
instructions are shown in Appendix 3. 
 
5. Seal the outer box tightly with strapping tape.  Affix UN3373 label to outside of box. 
 
6. Address the box and contact Federal Express for pickup. 
 
7. If necessary, more than one box may have to be shipped per day. 
 
5.2.3    Packaging Instructions (refrigerated specimens) 
 
1. Place refrigerated specimens into a three-tube foam mailer system.  Place the mailer in a zip-seal 
bag. 
 
2. Press the air out of the bag and seal. 
 
3. Place the mailer inside a small styrofoam shipping box.  Add a previously frozen freezer pack and 
other packing material (e.g. bubble wrap) to occupy extra space.   
 
4. Place the paper shipping forms on top of the packing material.  The shipping forms and 
instructions are shown in Appendix 3. 
 
5. Seal the box tightly with strapping tape.  Affix UN3373 label to outside of box. 
 
6. Address the box and contact Federal Express for pickup.  This shipment occurs on Tuesdays and 
Thursdays. 
 
5.2.4         Mailing Instructions 
 
All shipping containers are sent to the Central Laboratory by overnight courier Federal Express) to 
ensure receipt within 24 hours.  The empty styrofoam containers are returned to the Exam Center via 
UPS.  
 
Containers shipped to the Central Laboratory are addressed as follows: 
 
 JHS Central Laboratory 

University of MN Medical Center, Fairview 
 Room L275 Mayo 
 420 Delaware Street S.E. 
 Minneapolis, MN 55455 
 Telephone:  (612) 273-3318 (office) 
 Telephone:  (612) 273-3645 (lab) 
 FAX: (612) 273-3489 
 Email: grynder1@fairview.org 
 
 
 
 
 
 

mailto:grynder1@fairview.org
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6.0   QUALITY CONTROL 
 
 
6.1   Venipuncture and Equipment Records 
 
In the Exam Center there are two different aspects of quality control.  One is the daily or monthly 
record of the performance of the refrigeration equipment and centrifuge.  This is most easily kept as a 
check sheet with the daily or monthly records, as described below.  The other aspect of quality control 
is the Venipuncture Form that is part of each participant's records.  It shows the number of attempts it 
takes to achieve a successful venipuncture and the code number of the technician who performs the 
venipuncture. This record provides needed documentation that the blood was drawn in a 
standardized manner and that the equipment was functioning properly.  This quality control 
documentation is the best evidence that all specimens in the Exam Center are being drawn and 
processed identically.  Differences in the way the samples are collected or processed could 
potentially create a significant difference in assay results, which could seriously compromise the 
laboratory test data.  It is very important that the quality control records of the procedures and the 
equipment be properly maintained. 
 
For the equipment, daily records should be kept on all refrigerators and freezers.  The temperature of 
the refrigerated centrifuge must be recorded daily.  See Appendix 4 for a sample form.  In addition, 
the actual speed of the centrifuge needs to be checked and recorded annually with a tachometer.  A 
sample Quality Control Checklist is enclosed in this manual (see Appendix 5).  The local blood 
processing certifier will fill out this sheet monthly, certifying that daily checks have been performed 
properly and describing any problems in this area.  The Monthly Quality Control Checklists should be 
kept in a permanent file in the Exam Center. 
 
6.2    Quality Control Duplicate Blood and Urine Samples 
 
As part of the overall quality control program for laboratory analyses, duplicate specimens are sent to 
the laboratory, with one half of each specimen pair sent under the participant's regular JHS laboratory 
ID number, and the other half under a Quality Control Phantom Participant (QC) laboratory ID 
number.  The QC laboratory ID numbers are not distinguishable from other laboratory ID numbers so 
that this forms a blinded external quality control program monitoring measurement variability. 
 
To reduce the burden upon JHS participants, no one person is asked to contribute sufficient extra 
blood to make a complete set of duplicates for all tests.  Instead, extra blood is drawn from three 
participants and sent out under the same QC ID number.  For data analysis, results on each 
laboratory measurement are matched to the appropriate participant results. 
 
All QC samples (except the refrigerated whole blood tube) are stored an extra week at the Exam 
Center and then sent to the Central Laboratory with a regular shipment. 
 
Ideally the QC samples are drawn on three separate days.  For example, on Monday draw Tube 1 
(chemistry); on Tuesday, draw Tube 2 (glycated hemoglobin); and on Wednesday, draw Tube 3 
(special chemistries).  Tube 4 is NOT collected as part of the QC program.  The QC urine duplicate 
can be collected on Thursday or Friday. 
 
6.2.1   Weekly Blood and Urine QC Sample Checklist 
 
The JHS Exam Center venipuncture technicians maintain a weekly checklist posted in their work area 
of the QC samples to be collected during the week.  As each sample is drawn and processing 
completed, it is checked off.  On Friday morning, this checklist is consulted to see if there were any 
additional samples needed to make up the complete set of QC samples.  An example of the checklist 
is given below: 
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Figure 1. Weekly Blood QC Sample Checklist 
 

Week of:      
 
Day Tubes Laboratory Sample collected? 
    
Monday 1 Chemistry _________ 
    
Tuesday 2 Gly. Hgb _________ 
    
Wednesday 3 Special chemistry _________ 
    
Thursday or 
Friday 

Urine Chemistry _________ 

    
   _________ 
    
   _________ 
 
 
6.2.2   Preparation for Drawing and Processing QC Samples 
 
Blood Drawing Tubes: Each morning the blood drawing technician prepares an extra blood collection 
tube for the QC sample to be drawn that day.  Each tube is labeled with the QC ID number to be used 
that week.  In addition, the technician may wish to mark QC tubes "QC" in a clearly visible fashion, to 
reduce the chance that these tubes might be mixed up with the regular blood collection tubes during 
processing.  The QC tubes are set in the same rack used to hold the regular blood collection tubes, in 
a separate row from the other tubes. 
 
Sample Aliquot Tubes: Each morning a separate foam block is prepared for each set of QC blood 
tubes that the technician plans to draw that day.  The foam block contains all the storage vials 
needed to process the day's quality control samples. The tubes in each block are labeled in advance 
with the QC ID number being used that week.  Care must be taken during processing that the labels 
on the sample aliquot tubes match the label on the QC blood collection tubes.   
 
On the day that the duplicate urine sample is to be collected, five extra tubes for the urine QC 
duplicates should be set out and labeled with the urine QC ID number.  One participant per week is 
chosen for use as the urine QC duplicate. 
 
 
6.2.3   Collecting and Processing QC Blood and Urine 
 
Selecting Participants for QC Blood Draw: Normally, the QC samples are drawn from the first 
member of each group of participants whose blood is being processed simultaneously.  Based upon 
the size of their veins, the difficulty of drawing the blood, and the apprehension a participant shows 
about the blood draw, the venipuncture technician may need to forego the drawing of the QC tube 
from the first, and draw from another participant instead. 
 
Order of QC Tubes in Relation to Regular Blood Collection: The QC tubes may be added at the end 
of the blood draw without harming the measurements.  This procedure is followed to cause the least 
disruption of the collection of the regular blood samples.  If the blood flow falls off at the end of the 
draw, so that it would be difficult to obtain the extra QC tubes, a different participant is used to get this 
blood.  A NEW NEEDLE STICK SHOULD NOT BE DONE JUST TO GET MORE BLOOD FOR A QC 
SPECIMEN. 
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Processing and Freezing QC Blood and Urine: QC blood samples are processed along with the 
regular blood samples.  After processing is completed for each QC blood collection tube, the 
microvials are put into the -70°C freezer (for a minimum of 30 minutes).  After the samples are 
thoroughly frozen, they are put into a freezer storage bag.  The QC samples should be kept separate 
from the other samples collected during the week so they are NOT shipped along with them.  The 
refrigerated whole blood QC specimen is shipped along with its mate within 48 hours of collection. 
 
The four urine QC samples should be placed into the freezer at the same time as their matched 
participant specimens.  As with the blood specimens, the urine samples should be kept away from the 
other urine specimens collected during the week so they are NOT included with that week's shipment.   
 
Logging the Match between QC and Regular JHS ID's and Reporting These to the Coordinating 
Center: The QC Phantom Participant's folder is kept in the blood drawing area during the week the 
phantom ID number is being used to draw QC blood tubes.  In the folder is the JHS Quality Control 
Phantom Participant Form which is used to keep track of the match between the QC and regular JHS 
specimens.  A sample copy is shown in Appendix 8.  At the top of the log sheet is a space for the QC 
Phantom Participant's laboratory ID number.  As participants donate blood to make up a QC set, 
labels with their ID numbers are added to the line corresponding to the tubes donated.  This step 
must be done immediately after completing drawing blood for that participant, to minimize the chance 
of recording the wrong ID number.  One such form is recorded for each QC ID number used.  As 
soon as the full set of tubes is completed for each phantom participant (or at the end of the week, if 
any set is incomplete), the QC phantom participants' folder with this form is given to the receptionist 
(or other person designated by the Study Coordinator).  The folder is processed like other 
participants' folders, except that the QC phantom participant form is sent to the Coordinating Center 
and the Exam Center keeps a photocopy of this form in the phantom's folder.  Neither a Venipuncture 
Form nor Urine Collection Form is completed for the phantom duplicate.  A separate JHS study ID is 
NOT assigned to the QC specimen set.  It is NOT assigned a study ID. 
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6.3    Reporting of Results/DNA Amounts 
 
The Central Laboratory has the responsibility for reporting results to the Exam Center as well as the 
Coordinating Center.  All test results are transmitted to the Coordinating Center via FTP.  This 
transmission occurs once per week.  In addition, any alert result will be included in a separate 
manually-transmitted FAX.  The following table summarizes the reference ranges and JHS alert 
ranges for routinely performed tests: 
 
Table 1  JHS Laboratory Reference & Alert Ranges 
 
Analyte Reference Range JHS Alert Range 
2Glycosylated hemoglobin 4.3 – 6.1% NA 
2C-reactive protein <0.5 mg/dl NA 
2Glucose 74-106 mg/dL <60, >200 mg/dL 
2Cholesterol <200 mg/dL* >360 mg/dL 
2Triglyceride Male: 0 - 250 mg/dL >1000 mg/dL 
 Fem: 0 - 220 mg/dL >1000 mg/dL 
2HDL-Chol. >35 mg/dL* <20 mg/dL 
2LCL-Chol. (calculated) <100 mg/dL* >260 mg/dL 
   
   
   
   
   
   
   
   
   
   
   
   
   
   
   
 
1Test performed at Central Laboratory 
*The National Cholesterol Education Program designates these range values as “desirable”. 
 
Whole blood collected in EDTA tubes is processed for DNA extraction in the Central Laboratory.  This 
procedure does NOT generate a "result" to be reported to the exam center.  However, if the total DNA 
yield is below the JHS threshold (100 ug), the exam center will be notified (via FAX) of this result 
immediately, in order to arrange specimen recollection from that individual.  This recollected 
specimen will consist of two 10 mL EDTA tubes.  After collection the uncentrifuged EDTA tubes will 
be shipped to the Central Laboratory under the same original conditions.  The participant need NOT 
be fasting for this re-collection. 
 
 
7.0    TRAINING PROCEDURES 
 
 
7.1    Technician Training and Evaluation 
 
The technician must study the JHS Specimen Collection and Processing Manual and watch several 
participant samples being processed.  Then the technician may proceed to a mock drawing and mock 
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processing of samples, without performing any actual venipuncture.  Mock venipuncture is performed 
with the Vacutainer system.  A piece of latex tubing with a knot in one end leading to a glass of water 
is used as a target vein.  Practice tubes are collected in the correct order, then placed at their proper 
positions.  The sample is processed from start to finish exactly as if real blood were being used.  
Each technician performs a minimum of two mock draws from beginning to end.  Although the mock 
draws take time, they provide hands-on experience and allow the technician to become comfortable 
with the procedures before proceeding to live participants. 
 
At this point the technicians are ready to practice on live volunteers.  The technicians practice at least 
once with just one volunteer at a time and again process the blood entirely by themselves from start 
to finish.  If the technicians do NOT feel comfortable, they can repeat the process with dummy tubes.  
If enough volunteers are available, it may be beneficial to repeat this several times.  Any questions or 
problems that the technicians have must be solved before the technicians proceed to drawing the 
JHS participants. Before the technicians draw blood from any JHS participant, they must take and 
pass the practical and written tests included at the end of this manual.   After passing the tests and 
evaluation of their instructor, they may proceed to drawing blood from JHS participants.
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APPENDICES 
 
Appendix 1 JHS Laboratory Tests 
 
Traditional Risk Factors (performed on all participants): 
 
Glucose (serum) 
Glycosylated hemoglobin (whole blood) 
Cholesterol (serum) 
Triglyceride (serum) 
HDL-Chol. (serum) 
Calc. LDL-Chol. (serum) 
DNA isolation (whole blood) 
C-reactive protein (serum) 
 
 
Newer Risk Factors  (performed on a focused subset or subsets of participants): 
 
Lymohocyte cryopreservation (whole blood) 
Lymphocyte transformation (whole blood) 
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Appendix 2 Equipment and Supplies 
 
Supplies to be obtained by Exam Center: 
 

Supplier Catalog no. Description Usage/week 
Sarstedt 72.609 Microsample Tubes 500/pk 1260 
" 65.716.003 Red Screw Caps 1000/pk 450 
" 65.716.008 Purple Screw Caps 1000/pk 270 
" 65.716. Clear Screw Caps 1000/pk 225 
    
Allegiance B3036-4 Butterfly Needles, 21G x 3/4", BD #367250 45 
" B3062 Alcohol Swabs 2,000/cs 45 
" B3063-5 Gauze Sponges 200/pk 45 
" B3063-70 Band Aids 100/pk 45 
" B3060 Tourniquets n/a 
" B3035-4 Vacutainer Tube Holders 10/pk 45 
" P5214-12 Transfer Pipettes 500/pk 270 
    
Obtain locally  Freezer Bags 5" x 8" 47 
Obtain locally  Freezer Bags, Large 40 
Allegiance S9221-1 Sponge Tube Rack n/a 
Obtain locally  Dry Ice (approximately 9 lbs./shipment)  
Allegiance B3062-40 PDI Ammonia Inhalant n/a 
    
    
  Vacutainer Tubes 100/pk  
Allegiance B2970-32 9.5 mL, SST, red/gray top, BD #366510 90 
" B2991-54 10 mL, EDTA, lavender top, BD #366457 135 
" B2973-3 8.5 mL, CPT, black/blue top, BD #362761 90 
" B2922-1 Blood Collection Trays n/a 
" T2050-1 Thermometers -20 C - +110 C n/a 
" 1550SD*RS Harvard Trip Balance (Ohaus 1550SD) n/a 
" C6510-1 Timer - 3 channel digital n/a 
Polyfoam Packers  325 Styrofoam shipping box 10 
" 409/410 Large 5-tube mailer/sleeve 45 
" 364/365 Small 3-tube mailer/sleeve 15 
" 414 Gel packs, 24 oz., +30ºF 10 
UAL Med Prod  BH302CL Biohazard labels 320/roll 10 

 
 
Equipment purchased and maintained by Exam Center: 

Table-top refrigerated centrifuge capable of producing 3,000 x g 
Freezer capable of maintaining -70°C 
Refrigerator 4°C
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Appendix 3 JHS Shipping Forms 
 
Serum / Plasma 
JHS Central Laboratory                  Contents Sheet 
Fairview-University Medical Center               Frozen Specimens  
Room L275 Mayo                     Page ____ of ____ 
420 Delaware Street S.E.                  Ship date _______ 
Minneapolis, MN 55455 
 
Complete Sample: 
5-red top microvials 
5-purple top micovials 
 
 
LABID    SET COMPLETE?    MISSING VIALS    COMMENTS 
STUDY ID   YES NO      #     COLOR 
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Whole blood 
JHS Central Laboratory                    Contents Sheet 
Fairview-University Medical Center              Ambient Specimens  
Room L275 Mayo                      Page ____ of ____ 
420 Delaware Street S.E.                   Ship date _______ 
Minneapolis, MN 55455 
 
Complete Sample:        
1-black/blue top CPT tubes 
 
 
LABID    SET COMPLETE?    MISSING VIALS    COMMENTS 
STUDY ID   YES NO      #     COLOR 
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Urine 
JHS Central Laboratory                      Contents Sheet 
Fairview-University Medical Center                   Frozen Specimens 
Room L275 Mayo                        Page ____ of ____ 
420 Delaware Street S.E.                     Ship date _______ 
Minneapolis, MN 55455 
 
Complete Sample: 
4-clear top microvial 
 
 
LABID    SET COMPLETE?    MISSING VIALS    COMMENTS 
STUDY ID   YES  NO     #     COLOR 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



A-8 

M7_ Version 1.0 _ 04-11-2007 
 

Whole blood 
JHS Central Laboratory                    Contents Sheet 
Fairview-University Medical Center            Referigerated Specimens  
Room L275 Mayo                      Page ____ of ____ 
420 Delaware Street S.E.                   Ship date _______ 
Minneapolis, MN 55455 
 
Complete Sample:        
1-purple top EDTA tube 

                     
 
 
LABID    SET COMPLETE?    MISSING VIALS    COMMENTS 
STUDY ID   YES NO      #     COLOR 
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CONTENTS SHEET INSTRUCTIONS 
 
The contents sheets list the complete inventory of specimens in a shipment.  The original form is sent 
to the Central Laboratory with the specimen shipment, and a copy is filed at the Exam Center.  More 
than one contents sheet may be used in each shipment, depending on the number of specimens 
enclosed.  The number of pages attached and each page number are filled in at the top of the 
contents page (e.g. "page 1 of 5").  This form is filled out at the Exam Center as the specimens are 
collected and stored.  This form must be checked against the specimens when packed for shipment.  
Record the date of shipment. 
 
The LABID number is entered in the left hand column of the contents sheet.  This is most easily done 
by attaching one of the adhesive LABID labels in the space provided.  The Study ID label should also 
be applied in this section.  This should be done at the time of collection.  It is suggested that a second 
person check these IDs against the IDs on the vials to correct any errors. 
 
The tubes comprising a complete set are listed in the upper left hand corner of the sheet.  Under the 
category SET COMPLETE?, YES or NO should be marked for each participant to indicate whether 
the correct number of tubes has been shipped.  If there is some deviation from the correct count, 
"NO" should be marked, and a description of the problem should follow in the column headed 
MISSING VIALS.  The number of missing tubes and the color of their caps should be recorded here.  
 
COMMENTS on the quality of the specimens upon receipt are recorded at the Central Laboratory. 
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Appendix 4  JHS Daily Temperature Record 
 
JHS 
DAILY TEMPERATURE RECORD 
 
DATE      DATE 
Mo/Da/Yr   Freezer Refrig Room Initials  Mo/Da/Yr  Freezer Refrig Room Initials 
________  ______  ____  _____  _____  ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____  ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____  ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____  ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____  ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____  ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____   ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____  ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____  ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____  ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____  ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____  ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____  ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____  ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____   ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____  ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____  ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____  ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____  ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____  ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____  ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____  ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____   ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____  ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____   ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____  ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____  ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____  ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____  ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____  ________  _____  _____  _____  _____ 
________  ______  ____  _____  _____  ________  _____  _____  _____  _____ 
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Appendix 5.  JHS Monthly Equipment Quality Control Checklist 
 
 CENTER _________________________________  
 DATE ___________________________________ 
 TECHNICIAN ____________________________  
 ID NUMBER ________________________ 
 

 (S)atisfactory/(U)nsatisfactory        Comments 
 
SET UP 
 
1. Daily QC records  
 refrigerator temperature  ___  ______________________ 
 centrifuge temperature   ___  ______________________ 
 freezer temperature   ___  ______________________ 
 room temperature    ___  ______________________ 
2. Annual QC records 
 centrifuge tachometer check  ___  ______________________ 
3. Equipment and Supplies 
 refrigerated centrifuge   ___  ______________________ 
 refrigerator      ___  ______________________ 
 -70ºC freezer     ___  ______________________ 
 stopwatch      ___  ______________________ 
 timer        ___  ______________________ 
 Vacutainer needles    ___  ______________________ 
 tourniquet      ___  ______________________ 
 Vacutainer tubes    ___  ______________________ 
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Appendix 6  JHS Venipuncture and Processing Procedures Certification Checklist 
 
 VENIPUNCTURE Satisfactory/ 

Unsatisfactory 
Comments 

1. Labels checked ___ ______________________ 
2. Participant prepared and procedure explained. ___ ______________________ 
3. Venipuncture Form filled. ___ ______________________ 
4. Tourniquet application and release ___ ______________________ 
5. Venipuncture technique ___ ______________________ 
6. Tube collection sequence ___ ______________________ 
7. Inversion technique ___ ______________________ 
8. Tube incubation location ___ ______________________ 
9. Stasis obtained ___ ______________________ 
10.  Needle disposal ___ ______________________ 
 
 
 PROCESSING   
    
1. Knowledge of centrifuge operation ___ ______________________ 
2. Aliquotting supply set-up ___ ______________________ 
3. Stage I tube spin ___ ______________________ 
4. Stage II aliquotting ___ ______________________ 
5. Stage III tube spin ___ ______________________ 
6. Vials sealed ___ ______________________ 
7.  Final processing stage ___ ______________________ 
8.  VPT Form completed ___ ______________________ 
9. Freezer organization ___ ______________________ 
10. Time constraints ___ ______________________ 
11. Disposal of contaminated supplies ___ ______________________ 
 
 PACKAGING AND SHIPPING   
    
1. Specimens bagged ___ _____________________ 
2. Adequate dry ice used in shipping ___ _____________________ 
3.  Shipping paperwork ___ _____________________ 
 
 MISCELLANEOUS   
    
1. Incident Form ___ _____________________ 
2. QC Procedure ___ _____________________ 
3. Containers correctly labeled for shipping ___ _____________________ 
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Appendix 7  Sample Exams for Certification 
 
PRACTICAL EXAM FOR JHS BLOOD DRAWING TECHNICIAN 
 
1. Place the following four blood collection tubes in the correct set-up order and location  for the 

venipuncture:  1-10 mL red and gray top, 2-10 mL lavender tops, 1-8.5 mL black and blue tops. 
 
2. Specify which tube(s) remain at room temperature after collection. 
 
3. Remove the appropriate tubes from the tray, balance them and place them in the centrifuge.  

How long should they spin?  At what speed? 
 
4. Set up a sponge tray with the appropriate number and order of specimen storage tubes.  Indicate 

the colors of screw caps and the types of specimen put into these tubes. 
 
5. Place the collection tubes in front of their respective sample tubes.  Describe what further 

processing is required of each collection tube before it is aliquotted into its respective sample 
tube. 

 
6. Organize the color-capped sample tubes and prepare them for shipment. 
 
7. Describe the quality control for each piece of equipment. 
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SAMPLE WRITTEN EXAM 
 
1. When handling biological specimens, what type of protective apparel must always be worn? 

___________________ 
 
2. What is the recommended solution for use in cleaning an area where blood or urine has spilled? 

_________________________ 
 
 
3. Is it acceptable for the participant to make a fist in the hand of the arm from which the blood 

specimen is being collected?  If so, when? _____________________________ 
 

_____________________________________________________________________ 
 
4. During a typical week, how many JHS participants will have additional blood specimens collected 

to be used as part of the phantom duplicate? 
 

a) 5 
b) 4 
c) 3 
d) 0 

 
5. From which tubes are the packed cells used? 
 

a) None  
b) All  
c) #1  
d) #2, #3, #4 and #5 

 
6. How long should tube #1 sit at room temperature before centrifugation? 
 

a) 5 minutes 
b) 30 minutes 
c) 2 hours 
d) No waiting time required 

 
7. Why is this step (un)necessary?_________________________________________ 
 
8. Which tube is drawn last? 
 

a) A 10 mL lavender-stoppered 
b) An 8 mL black and blue-stoppered 
c) A 10 mL red and gray-stoppered 
d) A 7 mL lavender-stoppered 



A-19 

Manual 7_ Version 1.0 _ 04-11-2007 
 

 
9. For what type of tests will the 10-mL lavender-stoppered tubes be used? 
 

a) Special Chemistry 
b) Lipid 
c) Hypertension 
d) Special coagulation 

 
10. When is the tourniquet removed? 
 

a) after tube #1 fills 
b) after the tourniquet has been attached for two minutes 
c) after all tubes fill 
d) it does not matter 

 
11. How many JHS participants will provide duplicate QC urine samples weekly? 
 

a) 0 
b) 1 
c) 2 
d) 4 
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Appendix 8  JHS Quality Control Phantom Participant ID Form 
 
 
JHS QUALITY CONTROL PHANTOM PARTICIPANT ID FORM 
 
Note:  This form should be sent to the Coordinating Center within two weeks of the first entry for a QC 
phantom. 
 
 
Phantom Participant Laboratory ID Number_____________________________ 
 
 
 
Date ID Assigned: ____ /____ /____ ID of Person Assigning ID: ___________ 
 
 
Phantom QC Log 
 
  Date Collected Technician 
Tube Matching Laboratory ID (Mo/Day/Yr) ID 
    
    
    
    
1 _______________________ ____/____/____ ___________ 
    
    
    
    
2 _______________________ ____/____/____ ___________ 
    
    
    
    
3 _______________________ ____/____/____ ___________ 
    
    
    
    
Urine _______________________ ____/____/____ _________ 
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FOREWORD 
 
This manual is one of a series of protocols and manuals of operation for the Jackson Heart Study 
(JHS).  The complexity of the JHS requires that a sizeable number of procedures be described, thus 
this rather extensive list of materials has been organized into the set of manuals listed below.  Manual 
1 provides the background, organization, and general objectives of the JHS Study.  Manuals 2 and 4 
describe the operation of the Cohort Procedures, Blood Pressure and Events Ascertainment 
Components of the study.  Detailed Manuals of Operation for specific procedures, including those for 
Blood Pressure and Quality Assurance, make up Manuals 4 and 5.  The Data Management System is 
described in Manual 6.   
 

JHS Study Protocols and Manuals of Operation 

MANUAL TITLE 

1 General Description and Study Management 

2 Cohort Component Procedures 

3 Blood Pressure 

4 Cohort Events Ascertainment  

5 Quality Assurance 

6 Data Management 

7 Central Laboratory and Specimen Repository’ 

Specimen Collection and Processing 
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INTRODUCTION 
 
The JHS cohort is comprised of 5,302 African-American adults residing in the Jackson, MS 
Metropolitan Statistical Area. Of those, most were between the ages of 35-84 at the initiation of Exam 
1, though some members of the Family Study component of the cohort were younger (21-35) or older 
(85+). 
 
Chapter 1 of this manual describes the procedures for retaining the cohort including scheduling the 
second examination (1.2), conducting off-site examinations (1.3), and ongoing contact with the 
cohort.    
 
Chapter 2 provides an overview of the design, objectives, and content of the second clinical 
examination (Exam 2) and describes the logistics for setting up the clinical examination (Sections 
2.2).  The training and certification required to administer the forms as well as the quality assurance 
activities for all baseline interviews are described in the next sections (Section 2.3-2.5).   
 
Chapter 3 provides the background, rationale and description of each interview, the training and 
certification required to administer the form, the quality assurance activities, and the data collection 
instruments and procedures.   
 
Chapter 4 provides similar information for the procedures performed during Exam 2.   
 
Chapter 5 describes the rationale and procedures of the medical data review performed before the 
participant leaves the Examination Center.   
 
Chapter 6 covers the study's referral and review guidelines, including activities associated with 
reporting results to participants and her/his health care providers.   
 
Chapter 7 outlines the procedures at the Examination Center to ensure participant safety.   
 
Chapter 8 describes procedures for annual telephone follow-up of the cohort.   
 
Chapter 9 introduces the procedures for surveillance and monitoring events of the cohort and refers 
the reader to the detailed information contained in Manual 4: Events Ascertainment. 
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1.0 RETENTION OF PARTICIPANTS FOR EXAM 2 (CONTACT YEAR 06 EXAMINATION) 
 
 
1.1 Introduction and Overview of Retention Focus 
 
Retention of the cohort is a continual focus within the JHS. Maintaining contact with participants is 
critical so that they are available for re-examination as the study progresses. The Examination 
Center unit (retention/TRIPP [Translating Research into Prevention and Practice], annual follow 
up, and clinic) works very closely with the Community Outreach unit of the Coordinating Center to 
bring back a high percentage of the cohort for Exam 2. The retention plan for Exam 2 is designed 
to maximize the number of participants re-examined ~ 4 years after their baseline examination in 
Exam 1. The target is to re-examine at least 85% of the original cohort. While the 85% return goal 
is set as the target, every attempt will be made to maximize the return at Exam 2. The JHS is well 
aware of the need to obtain as high a rate of return as possible in order for the study to assess 
the natural history and/or evolution of cardiovascular disease and its risk factors in the cohort. 
Making accurate inferences regarding risk factors changes and disease prevalence / incidence 
demands the retention of sufficient numbers of the cohort. The plan provides for extensive 
monitoring of the process. These efforts will include coordinated and community-driven strategies 
derived from the prerecruitment study (Participant Recruitment Study) and the lessons learned in 
Exam 1.  
 
1.1.1.  Building on Lessons Learned in Exam 1:  Community Driven Strategies 
 
1.1.1.1 Gathering the JHS Family  
 
An important Exam 1 lesson was that by engaging participants as member of the “JHS family”—
not only did they come to clinic, they recruited other household and family members as well. 
Exam 2 retention activities capitalizing on this lesson include: 
 

• Hosting “family days” in the clinic when we focus scheduling to accommodate entire 
families (or households) to attend.  

• Incorporating special recognition for families with the most clinic attendees 
• Offering a digital family photo 
• Including a  “family history” format to encourage families to learn and record more about 

the personal and health histories of their families. This will be disseminated via the 
newsletter, community gatherings, and the JHS web page. 

 
Similarly, involving the Council of Elders (with IRB clearance and approval) in contacting 
participants and discussing the importance of the study and their individual participation was 
effective in increasing clinic attendance. Activities for Exam 2 will include: 

• A coordinated retention effort from the Council of Elders targeted for each specific age / 
gender / SES group 

• Focus on multiple methods of contact including mail or phone, and in some cases in 
person e.g. to provide transportation or other needed services to assist cohort members 
to keep their clinic appointments.  

• Identify a small group of young males who might be willing to assist in similar targeted 
retention activities with this high-risk group.  

 
Active involvement of the investigators, particularly the PI, in contacting participants who had 
missed one or more clinic appointments was effective for some. Repeating this positive activity 
during Exam 2, we will: 

• Generate a monthly list of persons who are more than one month post clinic exam date 
for PI/investigator phone calls or home visits to express appreciation for and personally 
invite their continued participation  
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Specific strategies for retention will focus on overcoming barriers, enhancing the clinic as the 
“home” of the JHS family, and maintaining ongoing contact/communication.  
 
Barriers: Barriers included transportation, child care, work, health care providers, health services, 
and time constraints. The retention plan will continue to: 

• Provide transportation to anyone who needs it via a contract with a local cab company; 
utilize the Council of Elders for personal transportation when persons are unwilling to use 
commercial cab services. We will pay transportation costs (mileage) for all other 
participants driving their own vehicles who so request this.  

• Provide child care services in the JHS “children’s” space during the time of clinic 
examinations. The Council of Elders as well as high school volunteers have provided this 
service during the summer months.  

• Negotiate time off work with agreeable employers of participants using targeted 
communication from the three institutional leaders and the JHS PI discussing the 
importance of heart health in our community, and their potential contribution by providing 
paid leave for the clinic examination.  

• Negotiate continued support of participant health care providers using targeted 
communications (including personal visits from the Social Worker and / or Outreach staff) 
to request their supportive communication with patients regarding JHS participation.  

• Provide JHS results reporting of abnormal results at the request of the participant. 
Participants are encouraged to share their results with their health care providers. The 
Social Worker will develop and maintain an extensive resource directory for use by 
participants and will proactively provide assistance to all participants in obtaining 
affordable health care services.  

• Reduce time constraints by limiting the exam length to 2 hours, providing advance 
notification of pending examination schedule and flexible scheduling of examinations.  

o Annual personalized letter at time of Family Reunion / Birthday Celebration to 
provide updated information on the status of their clinic examination (e.g. due this 
year, due next year, etc).  

o Reconsider evening clinics 
o Provide split clinics for rescheduling incomplete exams 
o Conduct off site exams at the participant’s home or other convenient location 

should they be unable to schedule a convenient clinic visit. We anticipate up to 
10-15% of the cohort may benefit from this alternative (N ~ 750 persons). 

 
Enhancing the Clinic as the “Home” of The JHS: will continue to focus on aesthetics, 
communication with the staff, participant comfort, and clinic flow / examination time.  

• Clinic aesthetics 
o Painting and routine maintenance  
o African American art work from Tougaloo and Jackson State art departments, 
o Reading material, information on heart disease and heart health promotion, a 

pleasing “snack” environment where participants can mingle and talk with each 
other, as well as receive a nutritious snack will be a high priority.  

o Exam rooms serve as “office” JHS staff with personalized decorative items to 
create a mutually comfortable feeling for participants and staff  

• Enhance participant physical comfort by providing 
o Lockers for personal belongings 
o Modest clinic clothing  
o Temperature control--provide robes for participants for warmth  

• A personable, communicative and caring clinic staff is essential to retention.  
o Include the Council of Elders in personnel interviewing and new staff training 
o Ongoing staff training 

• Timely participant flow  
o 2 hour exam 
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o Provide JHS videos, heart health education, and other useful information for use 
as during any potential time in the waiting area or snack area  

o Video of the self-monitored blood pressure teaching  
• Flexible clinic scheduling 

o To achieve 5 completed exams daily, we will schedule up to 10 exams, with the 
potential for up to 15 if this level of over scheduling is approved by the Clinic 
Manager.  

o Saturday clinics  
o Off site examination options 

 
Maintaining ongoing Contact and Communication with the JHS family is also essential to 
retention. Participants are more likely to remain committed long-term if they can identify with the 
study. Just as family members stay in touch with each other to hear about day to day activities 
and important events in each others’ lives, give and receive advice / recognition / gratitude, and 
learn new things, the JHS stays in touch with the participants regularly to provide an ongoing flow 
of information and recognition intended to provide a “lifeline” to the JHS.  

• Sending birthday cards and holiday mailings  
• A certificate of JHS membership  
• Monthly raffle and end of clinic “trinkets”  
• JHS Newsletter semiannually  
• JHS Family Reunion and Birthday Party each September 
• Annual Celebration of Life sponsored by the Coordinating Center 
• Community Monitoring Board, held annually in December  
• Participant link on the JHS web site  
• Extending the number of contact attempts to > 6-8 as needed 
• Active efforts for participant conversion of missed appointments/contacts or refusals 
• Well trained clinic and AFU staff 

o Skill training 
o Interpersonal relationships 
o Supervision 
o Quality control 

 
1.1.1.2 Safeguarding Concerns 
 
Maintaining a timely examination and providing immediate feedback on results are important 
ways of safeguarding participant concerns.  

• Provide same day feedback on all elements of clinic examination with option for 
notification of health care provider for abnormal results 

• Ongoing involvement of cohort in development of consent forms 
• Continue innovative “pledge of the investigator” initiated in Exam 1 consent 
• Initiating formal “process” consent form with review of prior consent documents as part of 

each exam cycle 
• Ongoing community workshops and educational offerings, particularly concerning 

genetics 
• Community Monitoring Board 

 
1.1.1.3 Building Community Partnerships 
 
As we have learned from the Participant Recruitment Study and Exam 1, support of family and 
community is crucial to ongoing participation. The feeling that there is benefit to the entire 
community, not just the individual participant, is an important lesson. Several activities of the 
Community Outreach arm of the JHS have been instrumental in recruitment and will be essential 
for ongoing retention. Most notable is the development of the Community Health Advisor (CHA) 
Network for the JHS in each of the three counties.  
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• CHAs will continue to serve as community ambassadors for the JHS, sponsoring and 
participating in JHS and community activities 

• “Red Hat Society” will continue to visit area churches on a regular basis—wearing a red 
hat or a red tie highlighting ongoing participation and providing timely information about 
the study and its many community activities to church attendees 

• Target specific demographic and health groups ongoing study involvement 
• Continue community health fairs and screenings targeted in the most densely populated 

JHS participant communities, as well as to areas with a high concentration of potential 
“difficult to retain” participants 

• Community JHS presentations to include the following topics: KYN, obesity, managing 
stress, genetics and other subject matter related to cardiovascular disease 

• Community Outreach office will continue a well-articulated public relations and media 
campaign with targeted television, radio and print activities, when appropriate.  

 
1.1.2 Overview of Protocol for Retention 
 
The protocol for participant retention includes detailed instructions to staff regarding participant 
scheduling. Special instructions are included for: 

• persons who have moved > 50 miles since Exam 1  
• an initial contact letter followed by telephone contact during Annual Follow Up 
• scheduling confirmation  
• reminder telephone calls 
• detailed plans for no shows and rescheduling incomplete examinations  
• off-site examinations 

Extensive tracking of each phase of the protocol is included and will be carefully monitored by the 
Participant Retention Committee, the Administrative Team, and the Steering Committee at their 
regular monthly or bi-weekly meetings.  
 
The JHS web site will serve as a central information source for participants regarding their current 
“phase” in the study. They will be able to schedule upcoming clinic exam or AFU calls via this 
mechanism. In addition, all participants will receive annual updates in conjunction with mailings 
for the Annual Birthday Party and Family Reunion. Included in this mailing will be information that 
alerts them to the upcoming examination cycle and provides an approximate date and year for 
their pending individual examination. The mailing will be merged from the Participant Scheduling 
List (see below) to obtain accurate scheduling information. This will be updated each year to 
reflect their exam status, either thanking them for having completed their exam, or letting them 
know when they may expect to be contacted. This communication will also include the invitation 
for the participant to schedule her / his examination with the Examination Center by phone or web 
site in advance of receiving a call from JHS.  
 
1.2 Scheduling Clinic Appointment (CLA) 
 
1.2.1 Eligibility for Exam 2 Scheduling 
 
All participants in the CY06 who completed all or part of the baseline clinic examination (Exam 1) 
are eligible for continuation in Exam 2.  Timing of Exam 2 scheduling is an approximately 
equidistant time from the Exam 1 clinic visit, taking into account modifications to accommodate a 
shorter exam cycle. If the participant is not seriously injured or ill and is willing to come for the 
exam, s/he should be scheduled. Participants can complete the second exam with broken limbs 
as long as one arm is unbroken for completion of the blood pressure measurement. 
 
For female participants who are in the age range where pregnancy could be a possibility, probe to 
determine pregnancy status. Inform them that while they can come in while pregnant as there are 
no tests that could be detrimental to their pregnancy, we would prefer, if possible, to examine the 
women when they are NOT pregnant. Explain that this is because there are important changes in 
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women’s blood chemistries during pregnancy (such as glucose) that may not be within their 
normal range. 
 
1.2.1.1 Participant Scheduling List 
 
The Examination Center Data Manager will run a Participant Scheduling List from the program 
provided by the Coordinating Center for that purpose. The Participant Scheduling List orders 
participants by their expected Exam 2 exam date in keeping with the order of their participation in 
Exam 1. This program will accommodate changing the exam window such that the 3 ½ year cycle 
for Exam 1 is compressed into 3 years for Exam 2 and participant flow is equalized across the 
three years.  
 
1.2.1.2 Greater than 50 Mile Scheduling List 
 
Also, the Coordinating Center has provided a program for identifying persons who have moved > 
50 miles from their home address at the time of Exam 1. The Data Manager will run the > 50 Mile 
List as a subset of the Participant Scheduling List.  
 
The primary purpose of the > 50 Mile List is to enable the research interviewer to efficiently begin 
contacting and scheduling these participants in the most cost-effective manner. The goal is to 
bring them back for the second exam without having to pay high travel costs. To do this requires 
flexibility on the acceptable travel interval between the first and the second examination. Contact 
should be initiated at least 4 months in advance of their target date to give the best chance of 
arranging travel within a month of their date.  
 
1.2.2 Participant Contact (ARC) 
 
Initial contact letters (Appendix) will be mailed to participants selected from the Participant 
Scheduling List at least one week prior to initiating scheduling attempts and to the >50 Mile List 
with one of the first mailings. For most participants, contact should be initiated approximately 4-8 
weeks in advance of their target exam date. As noted above, for those participants on the > 50 
Mile List, contact should be initiated immediately upon receipt to allow for the most flexible 
scheduling possible over the duration of the three year exam cycle. Early contact could facilitate 
bringing them in during a planned family visit or for vacation sometime over the exam period, but 
who otherwise would not be returning. Start with those whose target appointment date is in 
September 2005, and then move to each succeeding month. 
 
The Research Interviewer will make contact attempts with participants selected from these lists 
as part of their AFU calls, and invite them to come to Exam 2. This initial telephone contact will 
include: 

• an introduction and description of Exam 2  
• invitation / scheduling 
• arrangements for expense reimbursement / transportation / child care 
• arrangements for reminder telephone call 
• review of pre-exam instructions 
• any special arrangements for participants now living > 50 miles away. 

 
Participants will be directed to the JHS web site at the interviewer’s discretion for additional 
information.  
 
Results of all initial telephone contacts will be recorded in the DMS using the ARC (Annual Follow 
Up Record of Calls) form (Forms Manual for form and question by question [QxQ] instructions; 
Section 8.0, Manual 2 for more detailed information).  
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1.2.3 Participant Scheduling 
 
1.2.3.1 Making the Clinic Appointment 
 
Clinic appointments are made by the research interviewer at the completion of the Annual Follow 
Up interview using the Clinic Appointment Form (CLA). Detailed QxQ instructions are specified in 
the Forms Manual. Upon completion of the interview and appointment scheduling, the interviewer 
accesses the web based scheduling system, enters the participant’s JID, and the date and time of 
the clinic appointment.  
 
The interviewer is to assist the participant to make an appointment for a date and time that is 
most convenient for her/him during her/his target exam week. If a participant is unable to 
schedule an appointment at that time, schedule an appointment for another time—keeping it as 
close as possible to the target week. The participant may make a tentative appointment date with 
the understanding that s/he will be called back within 7-10 days to confirm. If the participant is 
willing to come for the exam but is unwilling to schedule a specific appointment date, ask him/her 
to indicate a specific week or month when he/she thinks he/she might be able to take the exam. 
Arrange to recontact them approximately 2 weeks prior to that week (or month) to schedule a 
definite appointment. If the participant expects to move and/or not be in the area of the 
Examination Center during the Exam year for another reason, use the special procedures for 
participants who are >50 miles, below. 
 
Review the pre-exam instructions with the participant as noted in the CLA form. After determining 
that he/she can fast (CLA), please stress fasting for 12 hours (nothing except water and all 
medications, including blood pressure medications) since both of these were a problem for some 
persons during Exam 1. Also, stress the importance of bringing ALL medications, including over 
the counter, herbals, and so forth, as well as prescription medications.  
 
Indicate that the participant will be contacted during the week before the exam date, and again 
the day before as a reminder. Ask her/him to place the date and time on her/his calendar while 
you are talking with them.  
 
Also, participants may make their own appointments separate from the Annual Follow Up process 
by using the JHS web-based appointment scheduling system. Specific instructions for using the 
system are mailed to the participant with the initial contact letter. Participants go to the JHS web 
site at www.jsums.edu/~jhs/ and select the Participant button. The scheduling system is then 
selected and s/he follows the instructions for scheduling an appointment.  
 
The Data Manager will run a daily update to the Participant Scheduling List and the web-based 
appointment scheduling system to capture all activities of that day and to generate the list of 
participants scheduled to be examined for the next day(s).  
 
1.2.3.2 Special Arrangements 
 
1.2.3.2.1 Transportation 
 
The JHS will provide or reimburse transportation to the JHS Examination Center for completion of 
the clinic examination. Special arrangements are available with a contract taxi service to pick up 
and return the participant to her/his home or place of departure. Inform the participant that this is 
available. Also inform the participant that if s/he would like to be reimbursed for travel, a travel 
reimbursement form will be available in the clinic and will require an exact address for calculation 
of mileage. Mileage will be paid at the current state mileage rate, but not to exceed $40. 
 
 
 
 

http://www.jsums.edu/%7Ejhs/
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1.2.3.2.2 > 50 Mile Arrangements 
 
If the participant lives > 50 miles away, JHS will also reimburse costs for travel to the Examination 
Center as possible, determined on an individual basis. However, whenever possible, the 
interviewer should attempt to schedule the Exam 2 visit at a time when the participant will be in 
Jackson for family or other business. If this is possible, make an appointment during that time. If 
this is not possible and the participant is unwilling to travel at her/his own expense to complete 
the exam, advise the participant that the JHS has limited funds for assistance with actual travel 
costs for cases such as this.  Negotiate with the participant at this point to determine how to 
accommodate the most economical travel costs from her/his destination to the JHS Examination 
Center. The Director of Retention, in consultation with the Exam Center Director, will determine 
the allowable travel reimbursement for such participants within budget limits.  
 
The interviewers should schedule each of the >50 mile participants according to the following list 
of priorities: 
 

1) Schedule the participant’s appointment within one month of the target date with no 
reimbursement for actual travel expenses above usual and customary mileage for a clinic 
exam visit. 

2) Schedule the participant’s appointment for ANY TIME during the three year exam cycle 
with no reimbursement for usual and customary mileage for a clinic exam visit. 

3) In consultation with the Director of Retention and the Exam Center Director, arrange for 
participant to return to Examination Center with reimbursement for actual travel expenses 
within a budgetary constraint. In general, the JHS will use the following general 
guidelines in determining allowable expenses, though these may be individually 
negotiated: a) up to $250 for train, plane, or bus fare; b) state gasoline reimbursement 
rate per mile for driving (not to exceed $250); c) $65 for one night’s lodging, and d) $30 
per diem for two days. The suggested maximum total per any one participant is $375. 
(DO NOT QUOTE NUMBERS TO PARTICIPANTS). 

4) Arrange for the participant to have an off-site examination in a locale within the tri-county 
area with no reimbursement for actual expenses above usual and customary mileage for 
a clinic exam visit, 

(NOTE: These costs may need to be adjusted during the time frame of the exam to 
accommodate changes in air fares and gasoline rates) 

 
If the JHS is to pay travel costs for > 50 Mile participants, assure that they understand that 
receipts are necessary to be reimbursed. Tell the participant to bring all receipts with him/her to 
the clinic visit and that s/he will be mailed a check after the clinic exam is completed. 
 
PLEASE NOTE THAT NO ADDITIONAL TRAVEL MONIES SHOULD BE SPENT ON 
PARTICIPANTS THAT ARE EXCLUDED FROM THE EXAM 1 DATA ANALYSIS—SEE LIST 
PROVIDED BY THE COORDINATING CENTER FOR THIS PURPOSE. 
 
1.2.3.2.3 Child or Adult Care Arrangements 
 
If the participant needs assistance with child or adult care, inform the participant that the JHS will 
either provide that care at the clinic (preferable) or, if we cannot locate appropriate volunteers to 
do so, we will reimburse the participant for those costs for the time of the clinic visit (not to exceed 
$30). This reimbursement should not be offered unless it is clear that there are no other options 
available to bring the participant to the clinic. In that instance, attempt to make an appointment for 
an off-site clinic visit (Section 1.3, below). 
 
1.2.3.3 Confirmation of Clinic Appointment 
 
Confirmation letters, including pre-examination instructions (PART-Participant Instruction Sheet; 
MIN-Medication Instruction Sheet), a plastic bag for transporting all medications to the JHS clinic, 
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and a Health Care Provider (REQPC-Request Health Care Provider Contact Information) and 
Contact worksheet, are sent to participants one to two weeks before their exam is scheduled. The 
JHS web site link with instructions for access, and a Consent Brochure for the appropriate exam 
year are also included in the confirmation letter. If, in the judgment of the interviewer, the 
participant would benefit from viewing the JHS consent video in advance of the clinic visit, this 
may also be included in the mailing.  
 
Specific instructions include: 

• Appointment time and date 
• Directions to the clinic (a map) and to parking facilities (JHS provides free parking) 
• Preparations 

o No blood donation within 7 days of visit 
o 12 hour fast 
o No tobacco or vigorous activity 
o Clothing to wear for the visit 

• Things to bring 
o Eyeglasses for reading 
o Name and address of health care provider 
o Name, address, and phone number(s), email of contact persons 
o Medications 

 A script describing the need for medication information is on the Annual 
Follow Up forms and is read to the participant at the time of scheduling. 
The reminder sheet also indicates which medications should be brought. 
A bag is provided in which to carry the medication. 

• Clinic Operation 
o Clinic hours and phone number 
o Length of exam (no more than 2 hours) 
o Snack is provided after finger stick blood 

• Transportation 
o The JHS will provide transportation and arrange for participant pick-up for those 

participants who need this service 
o Those who drive are asked to record mileage for reimbursement or bring their 

exact address for web-based calculation of mileage 
• Optional contact by JHS Council of Elders for additional information about participation 

 
When appropriate, a letter is sent to the participant’s employer explaining the JHS and requesting 
time of during working hours (Appendix: Employer Letter) 
 
1.2.3.4 Reminder Telephone Calls 
 
The evening Patient Representative in the Examination Center makes reminder telephone calls to 
participants three and one day before their scheduled clinic appointment. Confirmation of 
transportation and child care needs will be made on the final reminder call. If a participant has 
moved and is traveling to attend the clinic, this phone call will be made in keeping with the 
participant’s travel schedule.  
 
1.2.3.5 Rescheduling Missed Appointments 
 
After the scheduled clinic date for the participant has passed and the clinic examination has not 
been noted as Complete, the tracking system report will identify participants who have missed 
their appointments. When possible, the Clinic Receptionist / Patient Representative should call 
the participant ON THE SAME DAY as the missed appointment to attempt to reschedule. 
Otherwise, initiate calls the day following the missed appointment and follow the procedures for 
scheduling a clinic appointment. At that time, the scheduler attempts to address any concerns or 
fears that the participant may still have. A volunteer Council of Elders contact may also be 
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initiated. When necessary, the Clinic Manager or one of the investigators may also talk with the 
participant.  
 
After several unsuccessful reschedule attempts, or missed appointments, attempt to schedule an 
off-site examination appointment for the participant.  
 
1.3 Off Site Examinations 
 
Every effort will be made to maximize the return rate of the JHS cohort for Exam 2. These efforts 
will include performing an off site examination with participants who refuse or are unable to travel 
to the Examination Center, but are willing to provide information at home or some other 
convenient locations. Implementation of this option will not be started until there is sufficient 
documentation of the inability to schedule the participant for an on site examination. When an off 
site examination is scheduled, a member of the Examination Center clinic staff will travel to the off 
site location and complete all Exam 2 components. When this occurs, the Tanita Bioimpedance 
scales and height measures will be used for height and weight measurement (as well as for their 
usual measurement of body composition parameters). As well, blood pressure will be measured 
using digital equipment rather than random zero mercury manometers. 
 
In addition to individual off site examinations, on occasion, the Examination Center will set up off 
site examinations in a convenient community based locations to accommodate groups of 
participants who live at a significant distance from the Examination Center. These will be 
scheduled well in advance and participants residing in that locale with pending clinic 
examinations will be notified of this option for completing their Exam 2 clinic visit.   
 
1.4 Recognition of Participant Ongoing Personal Contact  
  
A personal thank you is sent to each participant immediately following each AFU interview (see 
Appendix).  At the time of the clinic visit, each participant receives a small gift of appreciation for 
taking part in the exam as well as a more substantial gift or $25 as selected by the participant. 
Another thank you and formal recognition as a participant in the JHS is mailed immediately after 
completion of the baseline exam and 24-hour measures. This recognition is a certificate of 
membership in the JHS cohort that is suitable for framing (see Appendix).  
 
The Examination Center maintains personal contact with each participant throughout the year on 
special occasions such as birthday, holidays and special cultural events significant to the African-
American community. The Office of Community Partnership issues a semi-annual JHS Participant 
Newsletter mailed to all cohort participants updating them on study progress including new and 
emerging findings. 
 
1.5 Participant Follow-up and Satisfaction  
 
A “Comments and Suggestions" box is prominently located in the reception area of the 
Examination Center clinic. Forms and pencils are provided for participants to comment on their 
clinic visit.  A Participant Evaluation of Clinic Visit (PEC) (see Forms Appendix; section 3.10) is 
conducted at the conclusion of the clinic visit to obtain a global rating of the visit and suggestions 
for improvement. A Participant Satisfaction Survey (see Forms Appendix) is conducted by 
telephone on a 5-10% random sample of the cohort at periodic intervals.  This satisfaction 
instrument is designed to gather information about all components of the clinic scheduling, clinic 
examination, and annual follow up. Additionally, in-depth interviews regarding the experience of 
participating in the JHS may be conducted with a designated percentage of the cohort on 
occasion. Interviewer/recruiters and clinic staff will notify the Examination Center co-PI of any 
participants who have had particularly notable experiences for follow-up interviews. These 
interviews will provide ongoing information for quality improvement and retention of the JHS 
cohort. Findings from the satisfaction surveys and in-depth interviews will be reviewed regularly 
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by the Council of Elders, Participant Recruitment, and Clinic Operations Committees who will 
advise on strategies to improve study performance. 
 
 
2.0 EXAM 2 DESIGN, LOGISTICS, TRAINING, AND QUALITY CONTROL  
 
2.1 Introduction 
 
During the annual follow up interview, cohort members in the Contact Year 06 are invited to 
return for a second clinical examination (Exam 2). As envisaged during the initial design of the 
JHS, a core component of the cohort examination has remained constant to allow for 
comparability. As with Exam 1, measurements of blood chemistry (glucose, lipids), blood 
pressure (sitting), body frame / size (anthropometry) are included in Exam 2. Core interviews are 
continued to document relevant / incident cardiovascular disease, symptoms and medical care, 
fasting status prior to blood draw, use of medications (prescriptions, over the counter, herbals, 
vitamins and mineral supplements, and gonadal hormones in women), menstrual status in 
women, and prevalent / incident cerebrovascular disease (stroke / TIA). 
 
In addition to these core components some additional JHS procedures and interviews have been 
included to supplement this information. New procedures in Exam 2 include the documentation of 
body composition, including percent body fat as well as the addition of hip circumference to the 
determination of body frame / size. As it is anticipated that mercury blood pressure manometers 
may be phased out of clinical use, a blood pressure comparability study is included to allow for 
validation of digital measurement in comparison with the gold standard random zero mercury 
manometer used in Exam 1. Exam 2 blood pressures will continue to be taken with the random 
zero equipment; however, some participants whose examinations are conducted off site may 
have digital blood pressure measurement, after assuring measurement comparability. Similarly, a 
comparability study will be conducted using the gold standard standing balance beam scale and 
standing height measurement and the Tanita TBF 300A body composition analyzer equipment. 
As with blood pressure measurement, participants having off site examinations will have their 
height and weight measured using the Tanita equipment, after assuring measurement 
comparability. 
 
New interviews in Exam 2 include a more extensive documentation of renal medical history, as 
well as additional information on having been breastfed as an infant, weight at birth, age 18, and 
other factors related to weight control and perception.  
 
Table 2.1, below, provides a summary of the core components of Exam 2 identifying the activities 
at each work station and cross referencing each procedure with its respective location in the 
Manual of Operations. Table 2.2 provides a summary of the two comparability studies included in 
Exam 2 which are being conducted to assure measurement comparability using different 
equipment. 
 
 
Table 2.1   Core Components of the Exam 2 JHS cohort examination, listed in alphabetical 
order, and location of the procedure / interview in the Manual of Operations 
Exam Component Description Manual_section  
Anthropometry Measure height, weight, waist and hips.  M2_3.2 
Body Composition Measure percent body fat, free fat mass, total body 

water, basal metabolic rate, and desirable range for 
percent body fat and fat mass 

 
M2_3.2 

Informed Consent Obtain informed consent for core Exam 2 
examination including authorization for collection of 
study data, access to medical records, release of 
study data, data sharing, and reaffirmation of 
continuing use of Exam 1 study data 

 
 
M2_3.3, 3.4 
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Interviews Collect medical, health, stroke /TIA, and renal 
history; medication/vitamin use 

M2_3.0 

Finger Stick 
(Digipuncture) 
Laboratories 

Collect by digipuncture fasting glucose and lipids 
(total cholesterol, Triglycerides, HDL, LDL, VLDL) 

M2_4.3 

Medical Data Review Ascertain the completeness of the exam and verify 
abnormal results. Review results of medical history 
with participant and provide a written summary 
report of clinical examination findings. Refer 
participant for diagnosis or treatment if needed. 
Return medications, answer questions. Meet with 
social worker for assistance with locating medical 
care and completion of satisfaction interview. Thank 
participants. Reschedule for missed procedures. 

 
 
 
M2_5.0, 6.0 

Reception Greet the participant, collect Participant Contact 
Information form, and verify identifying information. 
Obtain informed consent, collect medications, and 
determine fasting status. 

 
M2_3.1 

Self- Monitored Blood 
Pressure 

Participants will be given a home blood pressure 
monitor and taught to use it. Initial readings will be 
obtained in clinic with follow up self-report readings 
2-6 weeks post clinic visit 

 
M2_4.5 
M4 

Sitting Blood Pressure Assess sitting blood pressure using random zero 
sphygmomanometer and / or Omron HEM-907XL 
(comparability study or off site measurement); 
average of two measurements 

 
M2_4.1 
M4 

Snack Provide heart healthy snack with no stimulants M2_4.4 
 
 
Table 2.2   Components of the Comparability Studies in the JHS Exam 2 and their location 
in the Manuals of Operation 
Comparability 
Component 

Description Manual_Section 

Blood Pressure Comparability between two measures of sitting 
blood pressure: random zero sphygmomanometer 
and Omron HEM-907XL digital manometer on 300 
participants at the beginning of Exam 2 

 
M2_4.1 
M4 

Height  Comparability between two measures of height 
obtained with traditional wall mounted tape devise 
and Tanita TBF 300A height rod on 300 
participants at the beginning of Exam 2 

 
M2_3.2 

Weight Comparability between two measures of weight 
obtained with standing balance beam scale and 
Tanita TBF 300A Body Composition Analyzer 
scale on 300 participants at the beginning of Exam 
2 

 
M2_3.2 

 
Annual follow up telephone contact is a continuing component of Exam 2 using core procedures 
identical to those used in the ARIC study. It is intended to obtain updated information regarding 
participant vital and health status, medical history, diagnostic and invasive procedures, and 
hospitalizations. If the participant has either died or been hospitalized, surveillance activities are 
triggered. In addition to the core procedures, Exam 2 includes documentation of additional 
information on an annual basis to identify symptoms of congestive heart failure, identify reasons 
for cardiovascular diagnostic procedures, update family history, track psychosocial parameters, 
and any changes in insurance or health access status.  
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Cohort surveillance is also continued using core procedures identical to the ARIC study cohort 
surveillance activities. It is intended to gather key event information by abstracting medical 
records for all cohort hospitalizations. For cohort deaths, surveillance includes contacting next of 
kin, coroners, and attending health care providers, as well as obtaining a death certificate to allow 
determination of cause of death. Table 2.3 summarizes the core components of annual follow up 
and surveillance, identifying the activities and cross referencing each procedure with its 
respective location in the Manual of Operations.   
 
Table 2.3   Components of Annual Follow Up (AFU) and Surveillance in the JHS Exam 2 
and their location in the Manuals of Operation 
Component Description Manual_Section 
AFU ID information Update Contact (CON) form M2_8.5 
AFU Interview Annual telephone call to ascertain: 1) correct contact 

information, 2) update tracing information on 3 contact 
persons, 3)ascertain participant’s vital status, 4) 
document medical events, life events, and functional 
status 

 
M2_8.0 
 

Annual Follow Up 
Additional 
Questions 

Additional questions administered at the time of AFU 
contact to document: 1) CHF symptoms, 2) update 
family history, 3) ascertain cardiovascular invasive 
procedures / diagnostic tests and their indications, 4) 
update psychosocial parameters, 5) update health 
access and insurance status 

 
M2_8.5 

Surveillance Ascertainment of cohort events by: 1) abstracting 
hospitalizations each year, 2) obtaining information 
from death certificates and key informants (next of kin, 
coroner, health care provider) on cause and 
circumstances of death 

 
M2_9.0 
M4 

 
 
This chapter provides an overview of the design and objectives of the second cohort examination 
for the JHS (Exam 2). It describes the logistics for setting up the examination as well as the 
overall training and quality control. Chapters 3-9 of this manual provide the details of the second 
cohort examination including procedures for administering participant interviews and conducting 
exams, annual follow up, and cohort surveillance; references to the pertinent manuals of the 
protocol for those examination procedures not covered in detail in Manual 2; and references to 
appendices of forms and question by question (QxQ) instructions for their administration. Chapter 
3 provides the rationale and describes the Exam 2 clinic interviews, the training and certification 
required to perform the interview, the quality assurance activities, and the data collection 
instruments and processes. Chapter 4 provides similar information for the procedures performed 
during Exam 2. Chapter 5 describes the activities associated with reporting results. Chapter 6 
details the referral and review guidelines for abnormal clinic examination findings. Chapter 7 
outlines the procedures at the Examination Center to ensure participant safety. Chapter 8 
provides the rationale and describes the Annual Follow Up interviews, the training and 
certification required to perform the interview, the quality assurance activities, and the data 
collection instruments and processes. Chapter 9 refers the reader to the Cohort Surveillance / 
Events Ascertainment Manual of Operations for similar information regarding surveillance. 
 
In general, the numbering of the sections within Chapters 3-6 and 8 follows a standard format: a 
description of the rationale for the interview, procedure, or activity (.1), operational procedures 
(.2), training requirements (.3), the certification criteria (.4), routine quality assurance activities 
(.5), and data collection procedures (.6). 
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The rationale (.1) for core interviews, measurements, and procedures briefly summarizes the 
major premise(s) for its inclusion in the JHS and its continued use in Exam 2. A more detailed 
rationale is provided for the new components in Exam 2.  
 
The section on operational procedures (.2) describes in detail the procedures for administering 
the interviews, conducting examinations or taking measurements, or gives a reference to the 
appropriate manual of operations for the procedures with their own separate protocols. 
Standardized definitions or terms for use by the interviewer or respondent in an interview or 
instructions for administering or filing in individual questions on the data collection forms for each 
interview, measurement or procedure are provided in the QxQ instructions which are located in 
the appendix Forms Manual immediately following the individual data collection form.  
 
Training requirements (.3) and certification criteria (.4) are listed separately from their traditional 
rubric of quality assurance to provide easier reference for study personnel. Training materials 
additional to those in this manual of operations on data management, general interviewing 
techniques, the administration of all interviews, the measurement techniques were compiled for 
the Exam 2 central training workshop and are available in a separate notebook.  
 
To reduce the use of repetitive statement for each procedure in the sections on training and 
certification for interviews and procedures, it is understood that the minimum training and 
certification requirements / criteria for all Exam 2 interviewers, technicians, and clinicians are a 
command of the pertinent protocol sections and forms, and demonstrated proficiency on the JHS 
direct data entry/management system (DMS) or back-up procedures for completing paper forms. 
Detailed instructions for completing paper forms and for standardized interviewer techniques are 
found in the Appendix. 
 
Table 2.4 lists the personnel responsible for the training or each interview / procedure at the 
outset of Exam 2. The Quality Assurance section (.5) briefly summarizes and /or references the 
additional quality control activities that are carried out by Examination Center personnel and 
globally by the Coordinating Center (see Manual 5, Quality Assurance and Quality Control). 
 
The final section in each section is on Data Collection (.6) which briefly summarizes the standard 
and backup operation procedures for data collection using both the direct and delayed entry 
systems. A separate manual, Manual 6: Data Management serves as the official reference 
document for all data collection and systems management procedures. 
 
The appendices for this manual provide support material for Chapters 1-8 containing, among 
other items, prototypes for all participant results reports and quality control checklists. Forms and 
QxQs are maintained in a separate Forms Manual that also serves as an Appendix to this 
manual.  
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Table 2.4 Training and Certification Criteria for JHS Exam 2 Interviews and Procedures 

COMPONENT CERTIFICATION 
REQUIREMENT 

CERTIFIER OR 
REVIEWER 

RECERTIFICATION 
REQUIREMENTS 

RECERTIFIER OR 
REVIEWER 

AFU (CY06-09) 
Annual Follow Up – 
typically done by 
telephone 

Review of AFU procedures Director AFU or Interviewer 
team leader/CC Central 
Trainer 

Annual Rose Questionnaire 
Exercises 

Annually, 1 taped participant 
interview  

Supervisor or Interviewer 
team leader 

ANTHROPOMETRY / 
BODY 
COMPOSITION 

Height 
Weight 
Waist 
Hip 
% Body Fat 
Fat Mass 

Technicians certified at CC 
training; Clinic Manager leads all 
other training 

1cm of trainer 
1 cm of trainer 
1 cm of trainer 
1 cm of trainer 
Agreement with trainer 
Agreement with trainer 

Clinic Manager or 
interviewer team leader/CC 
Central Trainer 

Biannually (January/July), 
results sent to CC annually 

Annual recertification for lead 
technician during annual CC 
monitoring visit 

Supervisor or Interviewer 
team leader 

Monitor 

BLOOD PRESSURE, 
SELF-MONITORED 

SMBP lead technician 

1 acceptable group and individual 
class 

Clinic Manager or lead 
technician 

Biannually (January / July), 
results sent to CC annually 

 

Annual recertification for lead 
technician during annual CC 
monitoring visit 

 

Clinic Manager 

 

 

Monitor 

 

BLOOD PRESSURE, 
SITTING 

 

 

2 replicate measures 
 

Lead technician (Clinic Manager) 
certified, all others training by 
Clinic Manager 
 
 
 
< 4 mm Hg/reading 
< 3 mm Hg/average 

Lead technician 
 
 
 
 
 
Coordinating Center 

Biannually (January / July), 
results sent to CC annually 
 
Annual recertification during 
annual CC monitoring visit 
 
Continuous 

Lead technician 
 
 
Monitor 
 
 
Coordinating Center 
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Table 2.4 Training and Certification Criteria for JHS Exam 2 Interviews and Procedures 

COMPONENT CERTIFICATION 
REQUIREMENT 

CERTIFIER OR 
REVIEWER 

RECERTIFICATION 
REQUIREMENTS 

RECERTIFIER OR 
REVIEWER 

Digit preference 
mean values 

None   

CONSENT Adequate technique on 5 taped 
consent 

Clinic Manager / EC 
Director 

Biannually (January / July) 
 
Methods reviewed annually 
during CC monitoring visit 

Clinic Manager and CC 
monitoring round robin 
 
Monitor 

DIGIPUNCTURE Training by Clinic Manager / lead 
technician who are certified; 

2 acceptable draws/processing 

Clinic Manager / Lead 
technician  

Biannually (January / July) 

 

Annual CC monitoring visit 

Lead Technician 

 

Monitor 

LETTERS/REPORTS 
Participant results 
reports 

Steering Committee approval Clinic Manager or EC 
Director / PI 

Methods reviewed annually 
during CC monitoring visit 

Monitor 

MEDICATION 
SURVEY Interview 

 

Transcription 

 

Coding 

Adequate technique on 5 taped 
interview 

 

80% correct on supervisor review 

 

80% correct on coding exercises 

Clinic Manager or lead 
interviewer 

 

Clinic Manager 

 

Coordinating Center 

Annually, 1 taped participant 
interview included in round 
robin 

Methods reviewed annually 
during CC monitoring visit 

Clinic Manager and CC 
monitoring round robin 

 

Monitor 

MEDICAL DATA 
REVIEW 

Steering Committee approval EC Director / JHS PI Methods reviewed annually 
during CC monitoring 

Supervisor or Interviewer 
Team Leader and Monitor 

MEDICAL HISTORY 
interview 

Adequate technique on 5 taped 
interviews 

Clinic Manager or 
Interviewer team leader 

Annually, 1 taped interview 
included in round robin review 

Clinic Manager 

PHYSICIAN 
REVIEWS 

Adequate technique on 5 reviews Exam Investigator Annually, 1 complete review Exam Investigator 
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Table 2.4 Training and Certification Criteria for JHS Exam 2 Interviews and Procedures 

COMPONENT CERTIFICATION 
REQUIREMENT 

CERTIFIER OR 
REVIEWER 

RECERTIFICATION 
REQUIREMENTS 

RECERTIFIER OR 
REVIEWER 

PARTICIPANT 
SATISFACTION 
interview 

Adequate technique on 5 taped 
interviews 

Clinic Manager or 
Interviewer team leader 

Annually, 1 taped interview 
included in round robin review 

Clinic Manager 

PARTICIPANT 
SAFETY 

Local review of safety procedures Clinic Manager Annual safety review Clinic Manager 

RECEPTION 
interview 

Adequate technique on 5 taped 
interviews 

Clinic Manager or 
Interviewer team leader 

Annually, 1 taped interview 
included in round robin review 

Clinic Manager 

RENAL DISEASE 
interview 

Adequate technique on 5 taped 
interviews 

Clinic Manager or 
Interviewer team leader 

Annually, 1 taped interview 
included in round robin review 

Clinic Manager 

RESULTS 
REPORTING 

Adequate technique on 5 reports Committee Chair or 
Interviewer team leader 

Annually, 1 complete review Committee Chair or 
Interviewer team leader 

REFERRALS AND 
REVIEW 
GUIDELINES 

Adequate technique on 5 referrals Committee Chair or 
Interviewer team leader 

Annually, 1 complete review Committee Chair or 
Interviewer team leader 

STROKE 
SYMPT0MS interview 

Adequate technique on 5 taped 
interviews 

Clinic Manager or 
Interviewer team leader 

Annually, 1 taped interview 
included in round robin review 

Clinic Manager 

SURVEILLANCE Central and local review of 
surveillance procedures 

Surveillance Supervisor or 
Lead Records 
Administrator 

Exercises annually at Exam 
Center and University of North 
Carolina Collaborative 
Coordinating Center 
certification training 

Supervisor or Lead Records 
Administrator 

UNCCC Monitor 
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2.2 Participant Flow 
 
The participant flow is based on a paradigm modified from its long term successful use in the 
ARIC study for use in Exam 1 of the JHS. The schedule is divided into fixes and non-fixed 
sequences to accommodate legal requirements, scientific constraints of which measurement 
cannot precede another, the daily fluctuations in Examination Center staffing patterns, and 
unforeseen number of participants who keep scheduled appointments, the configuration of the 
Examination Center physical layout, equipment availability and function, and allowing for the 
future integration of ancillary studies, and so forth. Participant flow and the approximate time 
associated with each workstation are outlined in Table 2.5. 
 
Table 2.5  Participant Flow, JHS Exam 2 
Procedures / Workstations Approximate 

Time 
FIXED SEQUENCE #11 

 
                   RECEPTION 
                        Informed Consent 
                        Informed Consent Form 
                        Update Contact Information 
                        Fasting Status 
                        Collect Medications 
                   CHANGE OF CLOTHES 
 
                   ANTHROPOMETRY 
                   SITTING BLOOD PRESSURE 
 
                   DIGIPUNCTURE 
 
                   SNACK 
 

 
15 minutes 
 
 
 
 
 
 
 
6 minutes 
6 minutes 
 
5 minutes 
 
8 minutes 
 

FLEXIBLE SEQUENCE2 

 
                 BODY COMPOSITION  
 
                 STAFF ADMINISTERED QUESTIONNAIRES 
                        Health History 
                        Medical History 
                        Renal Disease 
                        Stroke Symptoms 
                         
                  SELF MONITORED BLOOD PRESSURE TEACHING 
 

 
 5 minutes 
 
40 minutes 
 
 
 
 
 
20 minutes 

FIXED SEQUENCE #21 

 
                   DATA INVENTORY  (staff activity) 
                   CHANGE CLOTHES 
                   MEDICAL DATA REVIEW           

 
 
  5 minutes 
10 minutes 

TOTAL TIME 2.0 hours 

1Components in the Fixed Sequence #1 and #2 are considered first priority should a participant 
be unable to complete Exam 2 in one visit 
2Components in the Flexible Sequence can be rescheduled for a second visit should the 
participant be unable to complete Exam 2 in one visit 
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2.2.1 Rationale 
 
The fixed components of scheduling participant flow reflect the requirement to initiate the 
examination with the administration of informed consent, the scientific constraints which establish 
the grouping of procedures which require fasting, and the logistical necessity of conducting 
medical data reviews after all other procedures have been completed. The flexible components 
reflect the advantages of having the interviews and examinations conducted in accordance with 
the Examination Center physical layout and the scheduling patterns for participants. This 
approach is intended to minimize participant burden to approximately 2 hours and reduce 
variability in study measurements.  
 
2.2.2 Fixed Sequences 
 
Exam 2 always begins with the administration of the informed consent at the reception 
workstation and always ends with the reporting of clinical examination results at the medical data 
review workstation. An outline of the components and the order in which they must be scheduled 
is provided in Table 2.5. After the participant has been welcomed and has signed the consent 
form, s/he is asked to change into a surgical scrub suit, provided by the Examination Center. The 
Examination Center provides a safe place to store clothing and valuables for the duration of the 
visit. After changing, anthropometry and sitting blood pressure are measured prior to 
digipuncture. Because the measurement of sitting blood pressure requires knowledge of the 
circumference of the right arm in order to select the appropriate blood pressure cuff size, 
anthropometry is generally performed prior to sitting blood pressure, and is generally performed 
at the same workstation. Digipuncture must be done while the participant is in a fasting state and 
could affect the participant’s blood pressure. Therefore digipuncture is generally performed 
immediately after anthropometry and sitting blood pressure measures and at the same 
workstation.   
 
Following digipuncture, the participant is shown to the snack area and provided with a caffeine-
free, heart healthy snack. 
 
 
2.2.3 Flexible Sequences 
 
The interviews and the body composition measures are scheduled in the non-fixed portion of the 
exam.  
 
The Participant Itinerary Form (PIN) (Forms Manual) serves as a summary of clinically relevant 
data, either from participant self-report at the initiation of the exam visit or from the Coordinating 
Center from Exam 1 data, for use during reception, interviews, procedures, and medical data 
review. The PIN serves as a summary of procedures and interviews performed during Exam 2 
and is either direct entered into a PDA format using a small portable computer (PDA) and 
subsequently downloaded to the DMS, or using a paper form and subsequently direct entered 
into the DMS. The PIN has several purposes: to monitor the amount of time it takes to complete 
each component for the examination to provide staff with information about where the participant 
is in the process, or to establish the participant’s sequence of procedures and interviews based 
on the daily staffing patterns. It also serves as a single source to identify the completion status for 
each exam component. The paper version of the PIN stays on the front of the participant record 
as s/he moves from one workstation to another. 
 
The participant’s record of data acquisition is documented on the JHS Cohort Inventory (CXI) 
(Forms Manual) from within the DMS. The CXI is completed as a report from the DMS as each 
interview or procedure is completed and monitors the completion of data collection forms.  
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2.3 Training 
 
The Examination Center staff is trained before the baseline exam to use a standardized 
technique for administering all Exam 2 interviews.  Central training conducted by the Coordinating 
Center liaison in coordination with the Examination Center unit managers (Clinic Manager, Data 
Manager, Director of Retention and Annual Follow Up, and Surveillance Supervisor) includes an 
overview of the JHS Exam 2 components; an update overview of epidemiological cohort research 
methods; instructions in research interviewing techniques: communication, respecting cultural 
diversity and in specific forms completion including: 

1. a thorough review of the forms, instructions and protocol to promote adherence to the 
protocol 

2. practice in the use of non-judgmental attitude 

3. practice with the degree and nature of prompting permitted dealing with problem interview 
situations 

4. use of response cards 

5. practice handling participants’ comments and recording relevant information on the note logs 

6. review of post interview responsibility for the data 

For clinic staff, the Clinic Manager and interviewer team leader are responsible for training new 
staff based on standardized interview techniques (see Appendix), QxQ instructions for each form, 
practice scripts, and role playing. For Annual Follow Up staff, the Director of Retention and 
Annual Follow Up and interviewer team leader are responsible for similarly training new staff. For 
surveillance staff, the Surveillance Supervisor is responsible, in conjunction with the ARIC 
Coordinating Center, for training in methods of abstraction and out-of-hospital death interviewing 
techniques.  

The Clinic Manager is responsible for training the clinic staff to perform each exam procedure by 
the Clinic Manager, assisted by appropriate study investigators as needed.  

2.4 Certification 
Table 2.4 summarizes certification and re-certification criteria for all elements of the JHS Exam 2 
interviews and procedures.  Interviewers are certified by the interviewer trainer at the successful 
completion of training.  Certification is achieved by the demonstration of adequate technique on 
five taped interviews, reviewed and approved by the Clinic Manager (for exam interviews), 
Director of Retention (for annual follow up interviews), Surveillance Supervisor (for out-of-hospital 
death interviews) or interviewer team leader.  Re-certification is completed annually and requires 
the successful completion of one taped interview.  With participant approval, all interviews are 
taped for quality control.  All tapes are included in the round robin and are reviewed by the 
interviewer supervisors selected to monitor each year’s round robin.  Special certification criteria 
beyond these tape reviews are described below with the appropriate exam component. 

2.5 Quality Assurance 
With participant approval, most interviewer-administered forms are taped for quality control.  A 
non-systematic sample of forms is reviewed by the Clinic Manager / interviewer team leader 
and/or Coordinating Center training liaison monthly.  Routine quality assurance is provided 
through observation by the Clinic Manager.  Protocol adherence and interviewing techniques are 
reviewed at least biannually by Coordinating Center examination monitors.  Deviations from 
protocols and possible remedial actions are discussed with the Clinic Manager and staff at that 
time.  Major deviations are brought to the attention of the JHS Cohort Operations Committee.  
Data quality is monitored by the Quality Control Committee semi-annually. 
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3.0 INTERVIEWS IN THE JHS EXAM 2 CLINIC VISIT 
 
3.1 Reception 
 
The reception workstation welcomes the participant to the clinic and initiates the baseline exam 
interviews and clinical measurements at the Examination Center.  Prior to the participant's arrival, 
an Exam 2 folder is assembled which contains labeled data collection forms: the most recent 
annual follow up Record of Calls and Clinic Appointment Scheduling (CLA) forms (these may also 
be filed in a separate, recruitment folder at the discretion of the Examination Center, but are 
available for use during the JHS exam), the Participant Itinerary Sheet (PIN), and blank copies of 
the JHS Exam 2 informed consent form and a print out of the participant’s Exam 1 ICF form. 
Folders also contain ALERT/REFERRAL logs for use in baseline exam.  The PIN is attached to 
the outside of the clinic visit folder. Paper versions of all DMS forms are readily available for staff 
use should the DMS be inaccessible.  

For off site examinations, participant folders are assembled to include the above plus a paper 
copy of all Exam 2 data clinical exam data collection forms. Specifically, the file would include the 
CON (contact), ICF (Informed Consent Form), FTR (Fasting Tracking), BCF (Body Composition 
Form), SBP (Sitting Blood Pressure), FST (Finger Stick Form), HHX (Health History Form), MHX 
(Medical History Form), RDF (Renal Disease Form), SSF (Stroke Symptoms Form), SMP (Self 
Monitored Blood Pressure), and a blank copy of the medical data review form.  

On arriving at the Examination Center, the participant is greeted and welcomed.  Travel 
reimbursement and participant payment information is obtained.  Approach to Life and Health 
Care Provider Contact forms are collected and checked for completion.  If incomplete, assistance 
is offered. 

Informed Consent for the full JHS exam (see Appendix) is obtained before administering any 
other JHS interviews.  Participant questions are answered.  Demographic and tracking 
information (CON Form) are updated.  Fasting status (FTR form) is determined.  Consent to tape 
interviews for quality assurance assessment is requested and documented on the Itinerary sheet 
(see Forms Appendix).  The Informed Consent Form (ICF) is completed either during or after the 
participant has left the reception workstation.  Medication bags are logged and labeled. 

General instructions on how to administer each interview are given in the text of Chapter 3 under 
the name of the data collection form.  Specific instructions for completing each item on the data 
collection form are given in the QxQ instructions that follow each individual form in the Forms 
Manual Appendix. 

The receptionist informs the participant that s/he will receive the results of Exam 2 at the 
conclusion of the exam before the participant leaves the Examination Center.  Results of all 
studies done during the visit are reviewed by the JHS clinician after the participant has left the 
Examination Center (see Appendix).  The participant is requested to take study results to her/his 
health care providers. Final results reports will only be mailed to health care providers if an alert 
finding is identified (see Chapter 6: Referrals and Review Guidelines; Appendix: Alert Letters).   

When Informed Consent and the Fasting forms have been administered, the participant is shown 
where to change into an examination gown/robe, asked to remove all jewelry, and to place 
clothing and valuables in a secured locker. 

Staff is trained for the reception workstation at central training and by the Clinic Manager at the 
Examination Center.  Certification requirements include the successful completion of training on 
general interviewing techniques, Informed Consent, the Fasting/Tracking form, direct data entry 
for the DMS, and use of the web-based Participant Scheduling and Tracking System.  Although 
no formal certification schedule has been established, interviewers working at the reception 
workstation are observed by the Clinic Manager for quality assurance and standardization. 
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3.2 Informed Consent  
 
Administration of Informed Consent precedes all other activities at the Examination Center.  The 
core content and consent options of the Exam 2 informed consent documents comply with the 
National Institutes of Health and the National Heart, Lung, and Blood Institute guidelines on the 
protection of human subjects, the American Society of Human Genetics' statement on informed 
consent for genetic research and the approval of the JHS Steering Committee.  The Institutional 
Review Boards of Jackson State University, Tougaloo College, and the University of Mississippi 
Medical Center have approved the study protocol and informed consent procedures, maintaining 
annual review. 

The JHS consent includes two sections: the Consent Information and the Statement of 
Participation (Appendix). After reading the Consent Information, the participant is asked to select 
the specific items that s/he agrees to participate in and sign the Statement of Participation. The 
JHS consent form is available in written and audio recorded versions. Though the font size of the 
document is large, some participants may have difficulty reading the form. If requested, a 
magnifying glass is available for participant use or a staff member will read the document to the 
participant. In advance of the JHS Exam 2 clinic visit, participants received a consent brochure 
that provided key information regarding the exam.  

The JHS consent form includes two unique components. The first is an investigator pledge to the 
participant to maintain confidentiality of the participant’s data. This was initiated in Exam 1 and 
continues with the Exam 2 form. Exam 2 initiates a formal mechanism that provides participants 
the opportunity to review their prior consent statements and reaffirm or modify them in keeping 
with current preferences. As an addendum to the consent documents, the participant will receive 
a print out of her/his Exam 1 consent preferences for review. Also, a consent brochure from Exam 
1 will be available should the participant wish to review or clarify aspects of that exam. The Clinic 
Manager and a study investigator are available to answer any questions the participant may 
have. 

3.2.1 Rationale 
 

The primary objective of administering the Exam 2 informed consent is to affirm that the 
participant understands (1) the purpose of the research; (2) what data collection procedures are 
used; (3) the risks and benefits of participation; (4) alternatives to participation (5) what 
procedures are in place to protect confidentiality; (6) that s/he is free to participate, refuse any 
procedure or answer any question, and to withdraw at any time; (7) that withdrawing carries no 
penalties; and (8) that s/he may affirm or modify prior consent choices.  The informed consent 
has a record of the JHS Principal Investigator and the name of a staff contact person (witness). 
Signing permits the participant to indicate her/his current preference for the use and disposition of 
study data, including genetic materials, and to change her/his preference at a future date; affirms 
permission to release clinically relevant study data to the health care provider of her/his choice, 
and gives the participant's permission to abstract her/his medical records in the event of 
hospitalization or death. 

 
3.2.2 Administration 
 

The Informed Consent is administered as the first component of the baseline exam as part of the 
fixed sequence #1.  The goals of JHS at the baseline exam are reviewed with the participant prior 
to the administration of any other data collection instrument.  Consent to participate in the second 
JHS examination is documented on the Informed Consent Form (ICF) (see Forms Appendix).  
Written, audio and visual consent forms are available.  Time is allowed for the person to read and 
ask questions about the informed consent documents in a confidential setting.  If the participant is 
visually handicapped or otherwise incapable of reading the study description and informed 
consent page, the narrative portion is read to her/him and then the person is asked to sign the 
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document.  The original Informed Consent documents are filed in the participant's JHS study 
folder.  A copy of the informed consent and signature page is given to the participant. 

 

3.2.3 Training 
 

Interviewers are centrally trained in general interviewing techniques and the goals and objectives 
of informed consent, including role play.  The Clinic Manager or interviewer team leaders are 
responsible for providing staff training for new staff. 

 

3.2.4 Certification 
 

Certification requires adequate technique on 5 informed consents with annual recertification 
during monitoring visit and completion of consent exercises. Interviewers who administer 
informed consent are observed by the Clinic Manager or interviewer supervisor. 

 

3.2.5 Quality Assurance 
 

Routine quality assurance is provided at the Examination Center by means of observation by the 
Clinic Manager.  Administrative techniques and adherence to protocol are also monitored at least 
semi-annually by Coordinating Center monitors; frequency distributions of consent preferences 
recorded on the Informed Consent Form (ICF) are monitored by the Quality Control Committee 
on a semi-annual basis. 

 

3.2.6 Data Collection 
 

Descriptions of the study and the signature pages acknowledging informed consent for the 
second exam are paper forms.  The participant receives a copy of the full informed consent 
document and the signed consent statement.  In all cases, the original signature page must be 
kept at the Examination Center and stored in the participant's JHS study folder. 

 
3.3 Informed Consent Form (ICF) and Informed Consent Tracking (ICT) Form 
 

The Informed Consent Form (ICF) form is an internal form that applies to the written consent 
given by cohort members at the time of the second clinic visit to participate in the regular JHS 
study.  It serves to identify the restriction, if any, on exam procedures or use of study data by 
directly entering the items on the Statement of Participation from the signed consent document. 
The form is completed by JHS staff, and NOT administered to participants. 

The Informed Consent Tracking (ICT) Form is an internal document that applies to any 
modifications of consent restrictions between exam cycles. It serves to identify any modifications 
in restrictions that a participant may notify the JHS s/he wishes to make. 

3.3.1 Rationale 
 

The purpose of the form is to document and track in the JHS central database the level of 
consent given at Exam 2, and subsequent (if any) changes to, participants' restrictions on the use 
of her/his study data, including DNA, by JHS and other investigators. 



42 

Exam 2 Cohort Procedures Manual.DOC 

3.3.2 Administration 
 

All items on the ICF form are completed by an interviewer at the reception workstation after 
participants have read and signed the baseline exam Informed Consent form. QxQ instructions 
are provided in the Forms Manual Appendix. 

All items on the ICT form are completed by an interviewer either at Annual Follow Up or at the 
clinic reception workstation when a participant notifies the study of a desire to either change 
her/his type of consent or access to medical records, or to withdraw from the study.  QxQ 
instructions are provided in the Forms Manual Appendix. 

3.4. Fasting Tracking 
 
The Fasting Tracking (FTR) form is a core data collection form which confirms the participant has 
had nothing to eat or drink for 12 hours before the baseline visit.  The form is administered at 
reception. 

3.4.1 Rationale 
 

The participant's fasting status affects the measurement of glucose and lipids, as well as body 
composition.  To standardize measurements, participants are requested to take nothing by mouth 
except water for 12 hours prior to arriving at the Examination Center. 

3.4.2 Administration 
 

The FTR is completed for all participants during the reception for the baseline exam (fixed 
sequence #1).  QxQ instructions for administering the FTR form are provided in the Forms 
Manual Appendix.  The participant's fasting status is verified.  Strict fasting is defined as nothing 
taken by mouth, except water, for the preceding 12 hours.  However, for purposes of results 
reporting of the clinical chemistries, participants can be considered fasting if they have fasted for 
at least 10 hours or if they have ingested no more than one cup of black, unsweetened coffee/tea 
within the past 10 hours.  Ingestion of more substantive liquids or solids constitutes breaking the 
fast.  The participant's fasting status is recorded in number of hours on the FTR form, but the 
consumption of coffee/tea is recorded in a note log. 

Finger stick samples are drawn on all participants, regardless of fasting status.  If the participant 
has not fasted for 10 hours, the participant is also offered the opportunity to repeat finger stick 
blood drawing in the fasting state at a later date.  The FTR is completed; the non-fasting state 
and rescheduled date of digipuncture are noted on the Participant Itinerary Form.  When the 
participant returns in the fasting state for digipuncture, the questions concerning fasting status 
and recent blood donation on the FTR form are updated and the data on the Finger Stick Form 
(FST) are updated. 

The FTR form also documents whether the participant has given blood within the last 7 days.  It is 
assumed that very few cohort members will have donated blood within the last week as they are 
reminded during both the scheduling calls not to do so, or to reschedule her/his clinic visit if they 
have had to give blood.  Recent donors are not rescheduled once they come for baseline exam; 
the response to question 6 on the Fasting/Tracking form is recorded to reflect the recent blood 
donation and the individual is sent to the digipuncture workstation. 

3.5 Medication Survey and Follow Up 
 
The Medication Survey (MSR) is part of the core data collection instruments and is administered 
to all participants during Exam 2 as part of the fixed sequence #1. The survey covers the use of 
any prescribed or over-the-counter medications, including vitamins, mineral supplements or other 
herbals or home remedies, used within the two weeks prior to the participant's interview as well 
as the current and regular use of aspirin and non-steroidal anti-inflammatory drugs in the JHS 
population.  It also queries usual medication – taking practices of participants. 
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As some participants do not bring all medications with them to the examination, a Medication 
Survey Follow Up (MSR-FUP) form is used to document information obtained from the participant 
after completion of Exam 2. It is an exact duplicate of sections B (Medication Transcription) and C 
(Interview) of the MSR, thus supplementing any missing information from that form. This form can 
be completed up to 3 months following the date of Exam 2.  

3.5.1 Rationale 
 

The goal of the MSR and MSRFUP is to ascertain medication usage by coding prescription and 
nonprescription drugs, home or folk remedies, used by the respondent within the two weeks 
preceding the interview.  This information assists in measuring patterns of medication use in the 
study communities, temporal changes in medical care practice, diagnostic classification of 
cardiovascular diseases, interpretation of laboratory results, and predictors of study end points.  A 
second goal for the MSR is to document individual medication-taking practices to assist in 
determining adherence to prescribed regimes. 

3.5.2 Administration 
 

The MSR is divided into five major sections.  QxQ instructions are located in the Forms Appendix.  
During reception, the interviewer determines and records in Part A of the form whether the 
participant has brought in all medications taken within the last two weeks.  Identification labels are 
placed on the participant's medication bag and MSR form.  If the participant has not brought in 
any (all) medications, inquiries are made to differentiate between non-compliance with pre-visit 
instructions or non-use of medications in the prior two weeks.  In case of inadvertent omissions, 
arrangements are made for obtaining the information, usually by telephone interview.  The 
deliberate omission to bring medications to the Examination Center is recorded on the MSR and 
on the Participant Itinerary Sheet (Forms Appendix) and conversion is attempted later with the 
participant during the review of medical data.  Subsequent parts of the MSR can be administered 
during reception (if the area affords the opportunity for maintaining confidentiality) or later, by 
trained interviewers or the JHS nurse/clinician in areas in the Examination Center usually 
designated for conducting interviews. 

Before starting Part B of the MSR, the name on the medication bag is checked against the name 
on the MSR.  Medication containers are removed from the participant's medication bag and the 
medication name and concentration are transcribed into column (a) of Section B on the form.  
Medications that are not in a container are examined only in front of the participant, with her/his 
permission.  When there are more than 26 medications, recording the name and concentration is 
continued on the back of the page if a paper form is used.  If the Medication Survey DMS form is 
used and more than 26 medications need to be entered, the name and concentration of the 
additional medications are written on a piece of paper labeled with the participant's ID, and filed in 
the participant's folder for future coding.  See below for coding instructions.  If the name of the 
medication exceeds the number of fields in the DMS, the name is abbreviated on the screen. 

When more than 26 medications have been recorded, the priority algorithm for data entry and 
coding of the medications is as follows: prescription medications first; aspirin and aspirin-
containing medications (aspirin, Alka Seltzer, headache powders, cold medications, medication 
for arthritis, etc.); anti-inflammatory drugs (ibuprofen, Motrin, Nuprin, etc.); then over-the-
counter-medications, followed by vitamins and food supplements. 

To administer Parts B and C, a trained interviewer or the JHS nurse/clinician shows each 
container of medication to the participant, transcribes its name in column (a) of Section B 
(MEDICATION RECORDS), records medication's concentration in column (b), the instructions for 
administration in column (c), and asks and records in column (d) whether the medication was 
used within the last 24 hours, and asks and records in column (e) the reason the participant takes 
this medication. 

When preparing to ask the participant about each medication, the interviewer removes all 
containers from the bag and sets them in front of the participant.  As each medication is reviewed, 
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it is shown to the participant while keeping the other medications in view.  After the participant 
answers the questions for each medication, its container is placed back in the carrying bag to 
minimize confusion and to assure that all medications are returned. 

The interviewer verifies the transcription of medication names and makes corrections on the 
paper (or DMS) form as required.  Use the American Drug Index and Physician's Desk Reference 
for unknown and incomplete names. 

Part C of the MSR ascertains (1) whether any of the participant-reported medications were used 
to treat cardiovascular diseases or symptoms (high blood pressure; high blood cholesterol; 
angina; arrhythmia; heart failure; blood thinning; diabetes; stroke; intermittent claudication) or (2) 
whether aspirin or aspirin-containing medications were used in the last two weeks and the reason 
for her/his use; current, regular use (at least once per week for several months) of aspirin or other 
non-steroidal anti-inflammatory drugs. 

[Parts B and C correspond to Parts A and B on the MSR FUP form. If the participant returns to 
the clinic to bring her/his medications, the same procedures are used as in the MSR to record 
information regarding each medication as above. If the participant is contacted by telephone, ask 
the participant to spell the name of the medication exactly as written on the bottle and record in 
column (a), the medication dosage in column (b), and the instructions for administration in column 
(c). Ask the participant is s/he has taken the medication in the past 24 hours and record in column 
(d) and the reason for taking the medication recording the response in column (e). Continue to 
the Interview questions to clarify the reasons for taking medications in the past two weeks by 
reading the questions and recording the respondent’s responses.]  

Part D of the MSR ascertains any reasons the participant may have for not taking her/his 
prescription medications as prescribed.  It also requests information on the participant’s current or 
regular use of either aspirin or non-steroidal inflammatory agents. 

Part E asks the participant to identify any folk medicine, herbals, roots or teas that they may have 
used for medicinal purposes in the last two weeks.  A separate question ascertains whether such 
remedies have ever been used and for what health-related reason. 

3.5.3 Certification 
 

Certification to administer the MSR and MSR FUP is achieved by the demonstration of adequate 
technique on 5 taped interviews, reviewed and approved by the supervisor or interviewer team 
leader.  Re-certification is required annually, and requires the successful completion of one taped 
interview of an actual participant.  This tape is included in the round robin that is reviewed by the 
four interviewer supervisors selected to monitor each year's round robin tapes. 

Separate certification is required for medication coding, based on a minimum of 80% correct 
responses on the certification test provided by the Coordinating Center and administered at 
central training.  Re-certification for medication coding is also required annually.  For the 
Medication-Coding Specialist, this includes coding a set of selected medication names circulated 
for this purpose and adequate performance on blinded re-coding of medications recorded during 
the previous year.  Re-certification criteria for medication coders require meeting minimum 
standards of coding repeatability (by interviewer/transcriptionist) and a review at the Coordinating 
Center of the accumulated performance on quality control repeat medication coding. 

3.5.4 Quality Assurance 
 

For each person certified to code medications a ten percent sample of medication coding records 
is identified by the Coordinating Center for blinded repeat coding at the Examination Center. 

3.6.5 Data Collection 
 

The six digits medication code numbers are listed in a hard copy or DMS version of the 
Medication Coding Dictionary.  The Medispan code in part (c) can be matched to the drug name 
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while transcribing the name of the drug in part (a) into the DMS screens, or can be ascertained 
later.  Drug names are listed alphabetically.  The medication code of a drug not listed in the 
dictionary is left blank, and its status code is always set to "Q" (questionable) so that the 
pharmacist at the Coordinating Center can develop a code number and update the dictionary.  
Detailed instructions for coding medications are provided in the QxQ instructions for the MSR. 
3.6 Health History 
 
The Health History (HHX) is a core data collection form, administered during the flexible 
sequencing component of Exam 2. It serves to update information obtained as part of the Exam 1 
Home Induction Interview in the Personal and Family History (PFH-A) form. Information included 
from the PFH is self-perceived health status, personal health history, and health care access. 
Additionally the HHX adds new items to further characterize self-perceived health status 
(comparison with self this time last year), and reproductive status (currently pregnant, ever tubal 
ligation or vasectomy), as well as to assess weight at key points over the participant’s lifetime 
(birth, age 18, perception of current weight status), having been breast fed or not as an infant, 
and several health behaviors related to weight management (diet, exercise).  
 
3.6.1 Rationale 
 
An extensive, well-accepted body of data supports the relationship between health history and 
risk for development of CVD.  Self-perceived health status has likewise been positively correlated 
with disease likelihood.  We hypothesize that these strong relationships will continue with the 
JHS.  That is, the more extensive the history of CVD and other metabolic conditions, the more 
likely the person is to develop CVD over her/his lifetime.  Further, this relationship will be 
moderated by a variety of socioeconomic and psychosocial variables, e.g., discrimination, stress, 
social support, coping, SES, health care access, and so forth. 
 
There is an evolving body of literature that relates having been breast fed, birth weight, and 
weight at age 18 (approximate correlate to weight at high school graduation) to adult weight and 
the development of obesity. As obesity and its impact on CVD is a major emphasis in the JHS, 
additional items to characterize weight over a lifetime, including health behaviors to manage it, 
and individual perception of current weight are anticipated to improve our understanding of these 
factors in the JHS cohort.  
 
3.6.2 Administration 
 
The HHX is administered to all participants during the Exam 2 clinic visit by a trained and certified 
interviewer.  The time reference for all health history questions (section B) is since the time of the 
baseline clinic visit (Exam 1). Detailed instructions for administering each question are contained 
in the QxQ instructions. Questions on deaths of family members may be considered sensitive by 
participants and care must be exercised to administer each item in a non-judgmental and caring 
manner.  
 
3.7 Medical History  
 
The Medical History (MHX) form is a core data collection form, administered during the flexible 
sequencing component of Exam 2.  It serves to update from the baseline examination potential 
sleep apnea or other sleep disturbance as well as a number of specific cardiovascular symptoms.  
Chest pain, possible infarction, intermittent claudication (peripheral vascular disease), and 
congestive heart failure are each detailed.  The occurrence of the participant-reported chest pain 
is confirmed as positive angina and/or myocardial infarction by London School of Hygiene criteria.  
The questionnaire also documents the occurrence of procedures to diagnose or treat 
cardiovascular disease. 
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3.7.1 Rationale 
 

A major objective of the JHS is the assessment of CHD in the study population at each clinical 
examination and across time beginning from the baseline examination.  This is done, in part, by 
the documentation of the symptoms of heart disease and exposure to diagnostic and therapeutic 
procedures of each participant at each visit and annual follow-up call.  Another objective is a 
similar assessment of peripheral vascular disease (PVD).  Questions on claudication provide 
updated information on PVD symptoms.  Another major contributor to CHD is sleep apnea.  Data 
also suggest a relationship between sleep quality irrespective of sleep apnea, as a correlation 
with CHD. 

3.7.2 Administration 
 

The MHX form is administered during the Exam 2 clinic visit by trained and certified interviewers 
with an understanding of the medical terms and diagnostic procedures referred to in this 
instrument.  The frame of reference for questions in section A (chest pain on effort) and sections 
B and C (invasive/non-invasive diagnostic and therapeutic cardiovascular procedures) is the time 
period since the baseline JHS examination.  Detailed procedures for administering the form are 
provided in the QxQ instructions immediately following the form in the Forms Appendix. 

3.8 Renal Disease Form 
 
Renal disease is an important correlate of cardiovascular disease. In Exam 1, data was obtained 
regarding dialysis. Exam 2 extends that data collection by including information on a wide variety 
of symptoms of renal disease in addition to overt kidney failure indicated by dialysis. Items for the 
Renal Disease Form (RDF) were modified from the National Kidney Foundation’s KEEP (Kidney 
Early Detection Evaluation Program) [1] and are administered during the flexible sequencing 
component of Exam 2.  
 
3.8.1 Rationale 
 
The extraordinarily high rates of renal insufficiency and failure among the African American 
population [2] warrant the focus of the JHS. Renal disease is both an important co-morbidity as 
well as a key determinant of cardiovascular disease occurrence and outcome. Renal disease 
shares risk factors (such as obesity, diabetes, hypertension, hyperlipidemia) with cardiovascular 
disease and is also an important marker of cardiovascular disease prognosis. In a recent survey 
of 680 Mississippians (515 AA, mostly from Jackson), the Mississippi Affiliate of the National 
Kidney Foundation found that 67% of the participants learned for the first time that they might 
have kidney disease [3]. This data suggests that African Americans who are enrolled in the JHS 
may be unaware that they actually have kidney disease that can progress toward end stage renal 
disease. This potential lack of awareness underscores the importance of renal disease symptoms 
makes it imperative to include questions regarding potential renal disease symptoms as well as 
acute or chronic renal insufficiency.  
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the National Medical Association 2002; 94(8 Suppl):1S-6S 

3. National Kidney Foundation Mississippi Affiliate KEEP Executive Summary for 2001-
2003.  March, 2004. 

 
 
 



47 

Exam 2 Cohort Procedures Manual.DOC 

3.8.2 Administration 
 
The RDF is administered by trained interviewers as part of the flexible sequence of Exam 2.  
 
 
3.9 Stroke Symptoms  
 
The Stroke Symptoms Form (SSF) is one of the core data collection instruments to assess the 
symptoms of stroke and transient ischemic attack.  The interview is administered during the 
flexible component of the JHS exam. 

3.9.1 Rationale 
 

Stroke and transient ischemic attack (TIA) are identified as end points in the JHS study.  A 
baseline history of stroke symptoms was collected during baseline exam and is updated during 
Exam 2. The time frame for this form is since the last JHS exam (Exam 1). 

3.9.2 Administration 
 

The SSF administered by certified interviewers.  Positive symptoms are recorded during the 
standardized interview along with her/his speed of onset, duration, and co-morbid manifestations.  
QxQs instructions are in the Forms Appendix.  Section A of the form documents the participant's 
medical history of a stroke.  The subsequent sections cover six neurological symptoms which are 
associated with strokes and TIAs and are administered in a standardized format.  Descriptors of 
the neurological symptoms (earliest, longest and worst) often require probing, but the definitions 
are left to the respondent. 

 
3.10 Participant Evaluation of Clinic Visit  
 
The Participant Evaluation of Clinic Visit (PEC) is continued from Exam 1 to ascertain 
participant’s global perspective of the clinic visit. It is intended to provide participants with the 
opportunity to express any concerns or issues they may have had with the visit and provides 
input into their overall satisfaction with the procedures and approaches used in the clinic, 
including staff encounters and information received.  
 
Additionally, a small percentage (5-10%) of the cohort may be called to complete a more 
extensive Participant Satisfaction Survey (PSS) to ascertain their satisfaction with all elements of 
the JHS Exam 2 components, including scheduling, annual follow up, clinic visit, and ongoing 
contact with the cohort. Participants who have expressed particularly good or particularly 
troublesome experiences with the JHS may be asked to take part in an in-depth interview with an 
investigator to engage in mutual dialogue regarding their experience.  
 
3.10.1 Rationale 
 
As detailed in the Retention Plan in section 1.0, the JHS is dedicated to providing a positive 
experience for all JHS participants. Close monitoring of participant satisfaction can provide 
essential input for maintaining that experience for the vast majority of the JHS cohort. 
 
3.10.2 Administration 
 
The PEC is administered during the Exam 2 clinic visit as a part of the fixed sequence #2 
components. It is conducted by a trained and certified social worker (or designee) at the end of 
the clinic visit. In addition to completing the PEC, the Social Worker is assuring that participants 
have access to needed health care or other social services, making arrangements to assist the 
participant as needed in these areas. 
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3.10.3 Training 
 
See below. 
  
3.10.4 Certification 
 
See below 
 
3.10.5 Quality Control 
 
The PEC is considered an essential component of overall quality control for the JHS Exam 2. A 
PEC report is generated each month by the Data Manager and forwarded to the Clinic Operations 
Committee for monthly review and determination of any needed actions. Actions will be presented 
to clinic staff by the Clinic Manager at regular clinic staff meetings. 
 
3.10.6 Data Collection 
 
The PEC is a self-administered paper form completed by the participant. If needed, the Social 
Worker may collect data via interview. No identifying information is included on the form and it is 
direct data entered into the DMS. QxQs are included in the Forms Appendix.  
 
4.0 PROCEDURES IN THE JHS EXAM 2 CLINIC VISIT 
 
4.1 Body Composition (Height, Weight, Waist / Hip Girth, Body Fat, Fat Mass) 
 
Height, weight, waist / hip girth, and body composition (body fat and fat mass) are measured 
during baseline exam.  All measurements are recorded on the Body Composition Form (BCF) 
(see Forms Appendix).  Procedures for measuring the height, weight and waist and neck girths 
are provided below.  Separate instructions for completing the data collection form are provided in 
the BCF QxQ instructions (Forms Appendix).  At the option of the Examination Center, the 
circumference of the right upper arm (to determine blood pressure cuff size) can also be 
measured at this workstation and recorded on the Sitting Blood Pressure (SBP) form. 

4.1.1 Rationale 
 

Overweight and obesity are associated with morbidity and mortality from cardiovascular disease, 
and their prevalence is increasing at a remarkable rate in all ages in the US population. Over 60% 
of the JHS cohort was either overweight or obese at baseline. Common assessment of 
overweight and obesity relies on the use of anthropometry in the form of body mass index (BMI), 
skinfold thicknesses, and body circumferences. These anthropometric approaches, though useful 
indicators, have limits in their ability to differentiate between levels of fatness and leanness. [1,2] 
More complete measures are needed for accurate assessment of body fat; fat free mass (FFM) –
which can be further separated into lean soft tissue, including water and bone; and total body 
water (TBW): the components of body composition.  

Biolectrcial impedance analysis (BIA), a practically useful indirect method for assessing body 
composition, has gained in use over the last decade. BIA methods assume the body to be a 
cylindrically-shaped ionic conducter where the extracellular and intracellular non-adipose tissue 
compartments act as resistors and capacitors, respectively. By introducing a small alternating 
electrical current passed across two body parts and measuring the potential (voltage) difference 
that results, the electrical impedance (or resistance and capacitance) of the body is measured. 
BIA has been used as an indirect measure of body composition in large scale studies, including 
NHANES III, 1988-94) [3] as well as a number of other studies where it has been shown to 
quantify FFM, body fat, and TBW reliably when compared with more direct measures of 
densitometry [4], deuterieum isotope dilution [5,6] and dual energy X-ray absorptiometry (DXA) 
[7,8] across normal, obese, and diabetic individuals. [9,10]   
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BIA was used in the JHS as it has been determined to be safe, is noninvasive, has no associated 
discomfort, and required little respondent burden, and could potentially provide valid predictions 
of major body compartments, specifically TBW, FFM, and % body fat. A single frequency 50-kHz 
leg-to-leg BIA system combined with a digital scale that uses stainless steel pressure-contact foot 
pad electrodes was selected for use in the JHS as an indirect measure of body fat. This method 
offers operational advantages over the traditional arm-to-leg approach which requires gel 
electrodes and has been shown to be comparable with the traditional method and reliable in 
assessing body composition in a variety of populations [11,12] The anterior and posterior portions 
of each foot pad comprise two separate electrodes with current applied via the anterior portion of 
the foot pad electrodes and the voltage drop across the posterior (heel) portion is then measured. 
Leg to leg impedance and body mass are simultaneously measured as the participant’s bare feet 
come in contact with the electrodes. FFM and body density are then calculated using prediction 
equations provided by the manufacturer (Tanita Corporation of America, Inc., Arlington Heights, 
IL) which use weight, age, and an impedance index, height2/Z. Percentage of body fat is 
estimated using the equation of Brozek et al. [13] 
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4.1.2 Procedures 
 

Anthropometry and determination of body composition are performed as part of the fixed 
sequence #1 before the clinic snack and after the participant has changed into a scrub suit or 
examination gown and been given the opportunity to empty her/his bladder.  All measurements 
are made with the participant wearing light-weight, non-constricting underwear.  Participants 
wearing nylon hose or other forms of constricting undergarments are instructed to remove them.  
Weight and height are measured without shoes.  Technicians complete the procedures on every 
participant by following the general checklist for performing anthropometric measurements 
(Forms Appendix). 

All anthropometric measurements are taken by either a team of two persons (one serving as 
observer; the other as recorder) or by one technician using a full length mirror to aid in the 
appropriate placement of the tape measure to record the girths.  Using the team approach, the 
observer calls out the name of the next measurement, takes the measurement, and keeps the 
measuring instrument in place until the recorder repeats the number.  The recorder checks the 
position of the examinee and verifies the horizontal placement of the measuring instrument during 
each procedure, and records the result.  When a single technician performs the measurements, 
s/he verifies the horizontal placement of the measuring instrument (using the mirror when 
appropriate) for each measurement and records each measurement immediately after it is taken. 

4.1.2.1 Standing Height 
 
The participant stands erect on the floor or the horizontal platform with her/his back against the 
vertical metal centimeter ruler mounted on the wall.  The heels are placed together and 
positioned against the vertical ruler.  The participant is instructed to stand as straight as possible, 
but with feet flat on the floor.  The participant looks straight ahead with her/his head in the 
Frankfort horizontal plane (i.e., the horizontal plane which includes the lower margin of the bony 
orbit -- the bony socket containing the eye -- and the most forward point in the supratragal notch -
- the notch just above the anterior cartilaginous projection of the external ear) (Figure 4-1).  The 
right angle is brought down snugly, but not tightly, on the top of the head.  A footstool is used if 
the examiner is shorter than the participant, such that the examiner's view is level with the point 
of measurement on the head of the participant.  The certified technician follows a checklist for 
height measurement (Forms Appendix) which outlines the procedures for checking the equipment 
and measuring the participant's height and enters study data on the Anthropometry form.  The 
participant's height is recorded to the centimeter.  The conversion chart in Table 4-1 is provided 
to assist in the converting to and from metric measures.  A chart converting centimeters to inches 
is available for use in informing the participant of her/his height in inches (Table 4-2) and weight 
in pounds (Table 4-3). 
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Figure 4.1 Frankfort Plane for Measuring Body Height 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Thyroid Cartilage________ 
Cricothyroid Membrane 
 
ORBITALE: Lower margin of eye socket 
TRAGION: Notch above traqui of ear or at upper margin of zygomatic bone at that point 
FRANKFORT PLANE: Orbitale-tragion line horizontal 
THYROID CARTILAGE: Firm, curtinalyenous providence on neck 
CRICOTHYROID MEMBRANE: Below thyroid cartilage 
 
 
 
Table 4.1 Converting To and From Metric Measures 
Conversion from Metric Measures 

Symbol When you Know Multiply by To Find Symbol 
Height 
Cm Centimeters 0.3937 inches in 

Weight 
Kg Kilograms 2.2046 pounds lb 

 
Conversion to Metric Measures 

Symbol When you Know Multiply by To Find Symbol 
Height 
In Inches 2.54 centimeters cm 
Ft Feet 30.7 centimeters cm 
Weight 
Lb Pounds 0.454 kilograms kg 
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Table 4.2    Body Size Measurements: Body Height in Centimeters and Inches 
 

Centimeters Inches  Centimeters Inches 
122 48.0  165 65.0 
123 48.4  166 65.4 
124 48.8  167 65.7 
125 49.2  168 66.1 
126 49.6  169 66.5 
127 50.0  170 66.9 
128 50.4  171 67.3 
129 50.8  172 67.7 
130 51.2  173 68.1 
131 51.6  174 68.5 
132 52.0  175 68.9 
133 52.4  176 69.3 
134 52.8  177 69.7 
135 53.1  178 70.1 
136 53.5  179 70.5 
137 53.9  180 70.9 
138 54.3  181 71.3 
139 54.7  182 71.7 
140 55.1  183 72.0 
141 55.5  184 72.4 
142 55.9  185 72.8 
143 56.3  186 73.2 
144 56.7  187 73.6 
145 57.1  188 74.0 
146 57.5  189 74.4 
147 57.9  190 74.8 
148 58.3  191 75.2 
149 58.7  192 75.6 
150 59.1  193 76.6 
151 59.4  194 76.4 
152 59.8  195 76.8 
153 60.2  196 77.2 
154 60.6  197 77.6 
155 61.0  198 78.0 
156 61.4  199 78.3 
157 61.8  200 78.7 
158 62.2  201 79.1 
159 62.6  202 79.5 
160 63.0  203 79.9 
161 63.4  204 80.3 
162 63.8  205 80.7 
163 64.2  206 81.1 
164 64.6  207 81.5 
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Table 4.3 Body Size Measurements: Body Weight in Kilograms and Pounds 
 

Kilograms Pounds  Kilograms Pounds 

48 105.8  81 178.6 
49 108.0  82 180.8 
50 110.2  83 183.0 
51 112.4  84 185.2 
52 114.6  85 187.4 
53 116.8  86 189.6 
54 119.0  87 191.8 
55 121.3  88 194.0 
56 123.5  89 196.2 
57 125.7  90 198.4 
58 127.9  91 200.6 
59 130.1  92 202.8 
60 132.3  93 205.0 
61 134.5  94 207.2 
62 136.7  95 209.4 
63 138.9  96 211.6 
64 141.1  97 213.8 
65 143.3  98 216.1 
66 145.5  99 218.3 
67 147.7  100 220.5 
68 149.9  101 222.7 
69 152.1  102 224.9 
70 154.3  103 227.1 
71 156.5  104 229.3 
72 158.7  105 231.5 
73 160.9  106 233.7 
74 163.1  107 235.9 
75 165.3  108 238.1 
76 167.6  109 240.3 
77 168.8  110 242.5 
78 172.0  111 244.7 
79 174.2  112 246.9 
80 176.4  113 249.1 

 

The height rule is observed weekly to see that it (a) touches the hard-surfaced floor or platform on 
which measurements are done, and (b) is perpendicular to the floor.  This weekly check is 
recorded on the Anthropometry Equipment Calibration Log (see Appendix). 
4.1.2.2 Body Weight 
 

Using the balance beam scale--Before a participant is weighed, the scale is balanced so that the 
indicator is at zero when no weight is on the scale. The scale must be level and on a firm surface 
(not a carpet). The participant is instructed to stand in the middle of the platform of the balance 
scale (Detector, model #437) with head erect and eyes looking straight ahead.  Weight is 
adjusted on the indicator until it is balanced.  Results are recorded to the nearest kilogram.  A 
chart converting kilograms to pounds is available for use in informing the participant of her/his 
weight in pounds (Table 4-1). 

To maintain accuracy, the scale is zero balanced daily and calibrated with a known weight (50 
lbs) every week or whenever the scale is moved.  The daily zero balance and the weekly scale 
calibration are documented on the Anthropometry Equipment Calibration Log (see Appendix).  
The scale is professionally calibrated and serviced annually.  The certified technician follows a 
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checklist for weight measurement (Forms Appendix) which outlines the procedures for checking 
the equipment and measuring the participant's weight and enters study data on the BCF. 

Using the Tanita TBF 300A Body Composition Analyzer. Before starting, connect the cable from 
the weighing platform to the jack located on the back of the control box. The ▲ on the plug 
should be facing up when inserted. Connect the plug of the AC adapter to the DC jack located in 
the back of the control box. Insert the power cord to the AC adapter, and plug it into a power 
outlet. Use only the Tanita AC adapter provided with the unit and assure that the weighing 
platform is on a flat, level surface. 

The Tanita unit should be preset to start up in the Goal Setter Mode. This mode controls the type 
of output that the unit provides and is accomplished by pressing the [8] key immediately after 
turning on the power. When this input has been completed, the unit is preset to start in this mode 
with each use.  

 
Figure 4.2 Set Up, Tanita TNF300A Body Composition Analyzer 
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Turn the unit on by pressing the ON/OF key. If there is no printer paper in the feeder, “P-End” will 
flash on the LCD.  

If you DO NOT want to use printer paper, press the [CE] key to continue measurement 
with no printer paper.  When there is no “P-End” message, but the printer fails to print, 
the chosen number of print outs may be “0”. Select a number of print outs greater than 
“0”.  

See Operating Instructions Manual for the Tanita located in the Appendix for details on 
Loading Printer Paper (p 16 of Manual) 

Set the number of printouts and the printing language. Press and hold the [0] key and press the 
[ON/OFF] key once. Release the [0] key after “Prt-1” is displayed on the screen. Using the 
number keys, enter ‘3’ to obtain 3 printouts (one for participant, one for provider, one to be filed in 
participant chart). The LCD will then automatically advance to language selection. Select [1] for 
English. When input has been completed, the unit will automatically switch to the measurement 
section. If further changes are needed, turn off the unit, and repeat the steps for setting number of 
printouts and language.  

Once all presets have been completed, after a momentary delay, the ◄ mark and “0.0” will 
appear on the LCD. If measuring units need to be changed, do so at this time by pressing the 
[kg/lb] key. An arrow on the LCD will follow the selection of weighing units. Throughout the data 
entry, mistakes may be corrected by pressing the [CE] key. Follow the flashing arrow on the LCD 
for proper sequence. The following additional steps must be completed BEFORE the participant 
steps on the scale: 

• Enter the Clothes Weight. This function will automatically subtract the chosen amount of 
clothes weight. Enter Clothes Weight to the nearest decimal point, or the flashing light will 
not advance. Clothes Weight can be entered by 0.1kg /0.2lb increments. In order to allow 
comparability between the weights obtained via the standard balance beam scale and the 
Tanita, no allowance will be made for clothes weight. ENTER “0.0”. 

• Enter Gender and Body Type. Select from one of the four body types: Standard Male, 
Standard Female, Athletic Male, Athletic Female. For most participants, you will select 
the “Standard” mode. The Athletic key should be used for individuals over the age of 17 
and under the following conditions: 

o Tanita defines “athlete” as a person involved in intense physical activity of at 
least 10 hours per week and who has a resting heart rate of approximately 60 
beats per minute or less. Tanita’s athlete definition includes “lifetime of fitness” 
individuals who have been fit for years but currently exercise less than 10 hours 
per week. Tanita’s athlete definition does not include “enthusiastic beginners” 
who are making a real commitment to exercising at least 10 hours per week but 
whose bodies have not yet changed to the required Athlete mode.  

• Enter Age. Enter age using two digits. 

• Enter Height. Using feet and inches to the nearest 0.5 decimal point, enter the height 
obtained from either the wall mounted metal ruler or, if doing an off site examination, the 
height obtained from the Tanita height ruler. Height will automatically be rounded up or 
down to the nearest 0.5 or whole number 

• Set the Target % body fat. Acceptable levels of body fat for men range between 18-25% 
and for women between 25-31%. Explain to the participant that you are selecting the 
mid/upper level of the acceptable range by entering 24% for men and 30% for women. 
You may also inform them that the “fitness” levels for men are between 14-17% and 21-
24% for women and that the “essential” fat that is necessary for men is 2-4% and for 
women is 10-12%. 

Check the participant’s feet for calluses. If the participant has thick calluses on her/his feet, place 
0.5cc of a conductant (saline, water) in the center of each electrode. After assuring that the 
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participant’s feet are clean (have them use a wipe to cleanse the bottom of their feet), ask the 
participant to step onto the scale when the flashing arrow appears next to STEP ON and the LCD 
screen displays “88888”. Instruct the participant to make sure the heels are placed on the 
posterior electrodes and the front part of the feet is in contact with the anterior electrodes as 
indicated in the Figure. The weight will be displayed on the upper portion of the LCD screen. 
Record it on the BCF form in item 13. 

Figure 4.3 Foot Placement for Body Composition Measurement, Tanita TNF 300A 
Body Composition Analyzer 

 

4.1.2.3 Abdominal (Waist) Girth 
The participant is instructed to stand erect and relaxed with the feet approximately 6 inches apart 
and the weight equally distributed on both feet.  The participant is asked to lift the scrub suit top 
just high enough to make the area visible (hands must not go above waist level).  An 
anthropometric tape is applied at the level of the umbilicus (navel) and the participant is instructed 
to breathe quietly. The tape should be snug, but not so tight as to compress tissue (Figure 4-4).  
The full length mirror or recorder verifies that the participant is standing erect and that the tape is 
horizontal.  The measurement is recorded to the nearest centimeter at the point of relaxation end 
exhalation.  The technician follows a checklist for the measurement of the maximal abdominal 
girth (Forms Appendix). 
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Figure 4.4 Location of Waist Girth Measurement 

 
4.1.2.4 Hip Circumference 
 
The participant stands erect, yet relaxed, with weight distributed equally over both feet and with 
the feet together. The hip girth is measured at the level of the maximal protrusion of the gluteal 
muscles (hips) (Figure 4-5). The tape is placed horizontally level around the participant’s gluteal 
muscles (hips) at the level of maximal protrusion. The position is verified by passing the tape 
measure above and below the observed maximum. The tape is kept horizontal at this level and 
the measurement is recorded to the centimeter, rounding down. 
 
A checklist for maximal hip circumference measurement (Appendix) is used for measuring each 
participant. The most common source of error for this measurement is due to not having the tape 
horizontal and not verifying that the maximum width is being measured. The position of the tape 
is checked from both the front and the back. 
 
The tapes used for measuring firth are calibrated monthly against the metal height rule, as 
indicated on the Anthropometry Equipment Calibration Log (Appendix). Tapes that show damage 
or wear or that do not measure within the required range are replaced.  
 
 
 
 
 
 
 
 

Waist girth at level of umbilicus 
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Table 4.5 Location of Hip and Upper Arm Girth Measurements and Subscapular 
Skinfold 

 
 
4.1.2.5 Arm Circumference 
 
The participant stands facing away from the technician with the right arm flexed at 90 degrees at 
the elbow, hand across midsection. The observer determines and marks the tip of the olecranon 
(elbow). Bony landmarks for measuring the circumference of the right arm are depicted in Figure 
4-6. The participant straightens the arm, allowing it to hang loosely at the side. The technician 
then determines and marks the posterior tip of the acromion process (shoulder bone). Using a 
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centimeter tape, the technician measures the length of the upper arm between the two marks and 
marks the midpoint (+). 
 
The technician wraps the tape around the arm at the midpoint mark, making sure that the tape is 
level. The arm circumference is measured to the nearest centimeter, rounding down, and is 
recorded in Item 8 on the Sitting Blood Pressure (SBP) form.  
 
4.1.2.6 Body Fat Percentage and Fat Mass 
 
Body fat percentage and fat mass are automatically measured once the weight measurement has 
stabilized on the Tanita TBF300A Body Composition Analyzer scale. The participant continues to 
stand with her/his heels and front part of the foot in contact with the posterior and anterior 
electrodes of the scale unit as described in 4.1.2, above. After the weight stabilizes, the 

impedance measurement is taken. This is denoted by four “bubbles” ▫▫▫▫ which appear on the 
bottom half of the LCD. As the measurement is being made, each of the bubbles will disappear 
one by one. It is important that the participant not step off the scale until the last bubble has 
disappeared and the display emits a short BEEP.  
 
When measurement is complete, both weight and percent body fat will be displayed on the LCD, 
and detailed results will automatically print out. The LCD will then return to the Gender and Body 
Type screen in about 10 seconds, making it ready for the next participant. 
 
Figure 4-6 provides shows an example printout with explanations. The printout includes a 
summary of Body Type, Gender, Age, Height, Weight, BMI (calculated), Fat %, Fat Mass. A 
TARGET section follows and contains: Target Body Fat%, Predicted Weight, Predicted Body Fat, 
and Fat to Lose. These measures are recorded from the printout on the BCF Items 14-25, as 
indicated in the QxQs (Forms Appendix). 
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Table 4.6 Bony Landmarks for Anthropometric Measures 
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Figure 4.7 Sample Tanita TNF 300A Body Composition Print Out 
 

 
 
4.1.3 Training 
 
Technicians are trained by the Clinic Manager and the Coordinating Center training liaison and 
are responsible for training of newly hired technicians (observers) and recorders. Training 
includes an (1) introduction to the rationale for body size measurements, the expected limits of 
reproducibility, and usual errors; (2) a demonstration of proper and improper procedures; (3) 
practice on volunteers; and (4) testing on volunteers with four different body types—lean, obese, 
athletic, and aged. 
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4.1.4 Certification 
 
Common criteria are used for initial certification and recertification for anthropometry and body 
composition determination. Examination Center supervisors and technicians are certified after 
participating in central training by the Clinic Manager and Coordinating Center liaison with 
investigator oversight / assistance as needed. All observers are recertified bi-annually (January 
and July) by the local expert. Each technician practices on volunteers with a variety of body 
shapes for the assessment of certification an recertification, measures one volunteer, meeting the 
following criteria: 
 

• The standing height measurement must agree within 1.0 cm of the trainer/certifier 
• The waist and hip circumference measurements must agree within 1.0 cm of the 

trainer/certifier 
• Weight must agree within 1kg (or 1 pound) of the trainer/certifier 

 
Recertification is performed every 6 months. The following additional certification criteria for each 
type of measurement used must be met” 
 

• Absence of digit preference for more than 6 months during one year 
• Absence of systematic differences in mean values 
• Adequate performance on replicate measurements 

 
4.1.5 Quality Assurance 
 

In addition to annual recertification, protocol adherence in the performance of each procedure is 
reviewed at least annually by the by Coordinating Center monitors. Deviations from protocol and 
possible remedial actions are discussed with the Clinic Manager and staff at that time.  Quality 
control observations of technicians by an observer are also performed biannually by Examination 
Center staff in January and July of each year and documented on the Report on Use of 
Observation and Equipment Checklist (see Appendix).  These are sent to the JHS Coordinating 
Center for review.  Major deviations from the protocol are brought to the attention of the Cohort 
Operations Committee. 

Anthropometry equipment is calibrated frequently and results are recorded on an Anthropometry 
Equipment Calibration Log (see Appendix).  Scales are zero balanced daily and calibrated 
weekly, or when moved.  Measuring tapes are checked monthly and replaced as needed.  The 
number of above measurements are recorded on the Report on Use of Observation and 
Equipment Checklist (see Appendix) and sent to the Coordinating Center biannually. 

Digit preference, systematic differences in location statistics, completion of checklists/logs 
according to schedule are analyzed by the Coordinating Center. Important quality 
assurance/control measures analyzed include training/certification, instrument checks, random 
repeatability studies and biannual observations of technicians by other technicians and 
Coordinating Center monitors are monitored and reviewed by the Quality Control Committee. 
Refer to Manual 5 for a detailed description of quality assessment procedures. 

4.1.6 Data Collection 
 

The BCF is collected by either the technician (observer) or recorder by direct data entry on a data 
entry screen or on a paper form (see Forms Appendix) for delayed data entry according to QxQ 
instructions. 
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4.2 Sitting Blood Pressure 
 
Sitting Blood Pressure (SBP) is performed as part of the fixed sequence #1 during the Exam 2 
clinic visit. See Manual 3, Blood Pressure.  See Forms Appendix for SBP form and QxQ 
instructions. 

4.3 Finger Stick Laboratories 
 
Measures of fasting glucose and lipids are obtained via finger stick (digipuncture) blood samples 
using the Cholestech LDX analysis system. The Cholestech LDX Manual is found in the 
Appendix.  
 
4.3.1 Rationale 
 
Glucose and lipids are well known risk factors for heart disease and their measurement is 
continued in Exam 2 to provide immediate information to participants regarding their values.  
 
4.3.2 Administration 
 
The FST form is completed by trained and certified technicians during the fixed sequence #1 
component of the Exam 2 clinic visit to record results of the glucose and lipids (Cholesterol, 
Triglycerides, HDL, LDL, VLDL) obtained by the Cholestech system. The FST and QxQ 
instructions for completion are contained in the Forms Appendix. 
 
4.3.3 Training 
 
4.3.4 Certification 
 
4.3.5 Quality Control 

The Cholestech L·D·X System requires no user calibration. The calibration information for 
running a test is encoded on the brown mag stripe on each cassette and is read each time a 
cassette is run. Since calibration differences between methods can play a role in the variation in 
results between methods, the National Cholesterol Education Program (NCEP) established the 
Lipid Standardization Panel (LSP) to look at improving the accuracy and precision of lipid 
methods. To make it easier for vendors, such as Cholestech, to standardize their methods, a 
national network of laboratories (The National Cholesterol Reference Method Laboratory 
Network) was set up with lipid methods standardized to the CDC (Centers for Disease Control 
and Prevention) reference methods for lipids. The Cholestech Total Cholesterol, HDL Cholesterol 
and Triglyceride methods on the test cassettes are standardized to the CDC through one of the 
network laboratories. The Glucose method is standardized to a hexokinase method at a reference 
laboratory.  

The Cholestech Controls are run to assure that all parts of the Cholestech L·D·X System - the 
cassettes, the analyzer, the pipette and the operator - are functioning properly. Together the 
Optics Check Cassette and the controls give you assurance that your test results are accurate, 
precise and reliable.  

The Optics Check Cassette checks the optical part of the Cholestech L·D·X Analyzer. It should 
be run each day you run patient samples and the results recorded on the Optics Check Log 
(Appendix). Instructions for completing the Cholestch LDX Optics Check can be found in the 
Appendix: Cholestech Manual, p 13-14.  

Good Laboratory Practice principles suggest that external controls must be run whenever the 
laboratory director has any question about test system integrity or operator technique (e.g., when 
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reagents may have been stored or handled in a way that can degrade their performance or when 
operators have not performed a particular test in recent weeks). Controls should be run 

• With each new shipment of cassettes (even if cassettes are from the same lot previously 
received)  

• With each new lot of cassettes  
• As otherwise required by your laboratory's standard Quality Control procedures  
• If you are not running the Cholestech L·D·X System under CLIA waived status, or if your 

local or state regulations require more frequent testing of quality control material, then 
quality control must be performed in compliance with those regulations.  

If the controls do not perform as expected, repeat the test or contact our office for more help. Toll 
Free 1-877-WILBURN  

As soon as the LDX cassettes are received, they should be placed in the refrigerator. When 
stored refrigerated at 2-8°C (36°-46°F) the cassettes are stable and can be used until the 
expiration date printed on the cassette pouch and box. Cassettes can be taken out of the 
refrigerator and stored at room temperature for thirty (30) days. Once the cassettes have been 
removed from the refrigerator, and have reached room temperature, the room temperature timing 
starts. The cassettes cannot be returned to the refrigerator to extend the dating to the expiration 
date on the label once they have reached room temperature. A Quality Control Log for 
Cholestech cassettes can be found in the Appendix.  

4.3.6 Data Collection 

 
Finger stick is standardized to the upright position. If the participant is nervous or excited, the 
technician briefly describes the procedure, e.g. “I am going to be sticking your finger once to 
obtain a few drops of blood to check your sugar (glucose) and blood fats (lipids). You will feel a 
quick prick, then I will massage your finger to obtain sufficient blood to accomplish the tests. You 
will know the results of your tests in just a few minutes. This information is important for your 
health and the JHS will be able to use the results of these tests to determine some of the causes 
of heart disease.” 
 
HANDLING PARTICIPANTS WHO ARE EXTREMELY APPREHENSIVE ABOUT HAVING A 
FINGER STICK. Do not under any circumstances force the participant to have a digipuncture. It 
may help to explain to the participant that the finger stick is designed to be as painless as 
possible. It may help to have the participant go on to another part of the exam. It may be useful to 
have the participant relax for a short time before the finger stick.  
 
Use the third finger of the participant’s left (or nondominant) hand for the digipuncture. Cleanse 
the digipuncture site with a sterile alcohol prep using a circular motion from the center to the 
periphery. Allow the area to dry. Perform the digipuncture using the equipment for that purpose. 
Grasp the participant’s finger firmly, using your thumb to draw the skin taut. With the lancet firmly 
inserted in the digipuncture device, enter the finger in a smooth continuous motion.  
 
The Cholestech LDX system uses reflectance photometry (the amount of light reflected from a 
solid surface) to meaure the amount of substances in the blood. The analyzer measures color 
changes of the 4 reagent pads that is then converted to mg/dL or U/L and displayed on the Liquid 
Crystal Display (LCD) screen.  
 
The Cholestech system should be operated in an environment with a room temperature between 
68-87 degrees centigrade, has a stable work surface, and no direct hear or bright light. Check 
that the ROM pack is inserted and the clip is in place. 
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Important: Do not remove the ROM pack while the analyzer is plugged in or it will lose its 
optical calibration and stop working! 
 
Insert the power plug in the back of the analyzer and plug into the wall (see Appendix, Cholestech 
Manual, p 9).  The following messages will appear on the screen: 
 
 Testing Memory 
 
 Selftest running 
 
 Selftest OK 
 
Should these messages fail to appear, or a message that says: Calibation Fail…Call Tech 
Service, call for technical service. 
 
Prior to using the Cholestech monitors, assure that the Configuration Menu has been completed 
and the Optics Check Testing procedure has been completed for the day (see above). See 
Appendix: Cholestech LDX Manual, p 10 for directions.  
 
Testing Procedure: 
 
Remove the Cholestech test cassette from its pouch, assuring that it has warmed to room 
temperature (at least 10 minutes after removing from refrigerator) before using. DO NOT TOUCH 
THE BLACK BAR OR MAGNETIC STRIPE. Wear gloves at all times when collecting blood 
specimens. 
 
Performing Finger Stick: 
 
Have the participant sit quietly for 3-5 minutes before collecting the finger stick sample. Place a 
capillary plunger into the end of a Choelstech capillary tube with the red mark. The participant’s 
hands should be warm to the touch. If they are not: 

• Wash hands with warm water 
• Apply warm compress for several minutes 
• Gently massage finger from base to tip 

Clean the site with alcohol swab and thoroughly dry the site 
Perform fingerstick with deep, firm pressure. Gently squeeze finger to obtain drop of blood. Wipe 
away the first drop 
Squeeze the finger again, holding it downwards until a second drop appears 
Hold the capillary tube horizontally by the end with the ;unger and touch it to the drop of blood 
without touching the skin. DO NOT COLLECT AIR BUBBLES. If necessary, collect another drip of 
blood in order to fill the capillary tube in 10 seconds.  
Wipe off excess blood and have participant apply pressure with swab until bleeding stops 
 
Performing the Test: 
 
Three buttons [RUN, DATA, STOP] control all the steps needed for operation of the analyzer.  
 

1. Press RUN to complete the selftest 
2. The cassette drawer will open and the screen will display: Load cassette and press 

RUN 
3. Use the Cholestech LDX Capillary Tube to place sample into the test cassette 

sample well (See Appendix: Cholestech Manual, pp 19-22 for additional information) 
4. Fingerstick sample must be applied within 5 minutes after collection or blood 

will clot 
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5. Keep the cassette level once sample applied and IMMEDIATELY place the cassette 
into the drawer of the analyzer with the black reaction bar facing toward the analyzer 
and the brown magnetic stripe on the right.  

6. Press RUN and the drawer will close, displaying: Test running 
7. Place all materials coming in contact with blood samples or control in biohazards 

waste container 
8. Analyzer will beep when test is complete and display: Test= ### units 
9. Press DATA to view the calculated results 
10. The machine will display results outside the normal range with a <### or >### sign 
11. Problems will result in a text message referring you to the Troubleshooting section of 

the Cholestech Manual (Appendix, pp 38-43) 
12. The drawer will automatically open. Remove the cassette and discard in biohazards 

waste container 
13. Record results on the FST form 

The Cholestech measuring range for each analyte is as follows: 

• Total Cholesterol 100 -500 mg/dL or 2.59 - 12.93 mM/L  
• HDL Cholesterol 15-100 mg/dL or 0.39-2.59 mm/L  
• Triglycerides 45-650 mg/dL or 0.51 - 7.34 mm/L  
• Glucose 50-500 mg/dL or 2.78 - 27.75 mm/L  
• ALT 10-400 U/L, 37°C  

Results outside these ranges will be reported as less than (<) the lower limit or greater than (>) 
the upper limit. If repeat testing gives the same < or > result the sample should be sent to a 
clinical lab for testing. If Triglycerides are > 400, the LDL cannot be calculated and the results will 
be reported as NA.  

4.4 Snack 

A light snack is scheduled as soon as possible after digipuncture during the flexible sequence for 
the Exam 2 clinic visit.  Caffeine-free refreshments are provided, including decaffeinated coffee 
and tea, fruit juices and reduced fat or skim milk.  Menus are determined by the Examination 
Center staff, but will include heart-healthy alternatives. 

4.5 Self-Monitored Blood Pressure 
 
See Manual 3, Blood Pressure. See Forms Appendix for Self-Monitored Blood Pressure (SMP) 
and Post Self Monitored Blood Pressure (ASB) forms and QxQ instructions.  
 
5.0 MEDICAL DATA REVIEW 
 
Through the participant informed consent, the medical data review, and the cover letters for any 
alert results reports sent to participant health care providers it is made clear that the interviews 
and exam components are not a substitute for regular medical care.  One of the benefits to 
participants, however, is the summary of clinically relevant results distributed by the Examination 
Center at the conclusion of Exam 2.  At the end of the Examination Center visit, participant 
interview and examination data are reviewed by the trained staff to provide the participant with a 
summary of study results for height, weight, BMI, sitting blood pressure, glucose, lipids 
(cholesterol, triglycerides, HDL, LDL, VLDL) percent body fat, fat mass, and target body fat/body 
mass goals (see Appendix). Participants are reminded that they should take their results to their 
health care provider and are provided with a duplicate copy for that purpose. 
 
Three procedures are included in Medical Data Review: Data Inventory, Participant Medical Data 
Review Exit Interview, and Clinician Reviews.  
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5.1 Rationale 
 
The primary objectives of the Medical Data Review are to safeguard participant safety and to 
inform the participant of findings detected during the clinical components and through responses 
to the interview/questionnaires.  Clinical and interview data are reviewed with participants to 
confirm selected positive symptoms reported during the interviews/exams and to determine if 
these appear to warrant immediate (same day), urgent (same week) or routine medical follow-up.  
Conditions requiring emergency referral are dealt with as soon as observed and, in general, have 
been dealt with before the Medical Data Review takes place.   For example, blood pressure 
readings > 210/120 mm Hg are attended to as soon as observed.  Table 5-1 indicates the 
classification of blood pressure for adults.  The JHS physician is consulted, the clinic visit 
terminated, the person referred for immediate medical care, and a return visit to complete missed 
procedures and interviews is scheduled as appropriate.  Persons with elevated blood pressures 
less than 210/120 mm Hg are referred to her/his source of medical care at the Medical Data 
Review following the guidelines shown in Table 5-2.   
 
When clinically relevant finger stick laboratory data is identified during the examination, the data 
are again reviewed prior to producing summary reports for participants and her/his physicians.  
As part of this review, JHS clinical personnel may recommend follow-up again if 
symptoms/conditions appear to warrant further medical attention. 
 
At the Examination Center, participants' clinically relevant data are reviewed at two levels.  The 
first review takes place during the Medical Data Review (see below, section 5.3), which is 
conducted after all interviews and physical exams have been completed and data have been 
assembled as part of the data inventory step (section 5.2).  The second level of medical data 
review takes at the end of the clinic visit during the exit interview. 
 

Table 5.1 Classification of Blood Pressure for Adults, Based on Joint 
National Committee on Detection, Evaluation and Treatment of High Blood 
Pressure (JNC-VII, 2003) Guidelines 

 
Category* 

SBP 
(mm Hg) 

 DBP 
(mm Hg) 

Normal <120 and <80 

Pre Hypertension 120-139 or 80-89 

Stage 1 Hypertension 140-159 or 90-99 

Stage 2 Hypertension ≥160 or ≥100 

*When SBP and DBP fall into different categories, use the higher category. 
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Table 5.2 Medical Care Referral Guidelines for Blood Pressure, Based on Joint National 
Committee on Detection, Evaluation and Treatment of High Blood Pressure  
(JNC-VII, 2003) Guidelines 

Referral 
Classification 

Examination 
Findings 

Recommendation to Participant1 Explanation 
to 

Participant 

Emergency Referral SBP > 260 

or  
DBP > 130 

Transportation to emergency care 
facility. Stop exam and reschedule 
clinic visit 

Your BP is 
very high. 

Immediate Referral SBP 210-259 
or  

DBP 120-129 

Consult with JHS MD.  Refer to 
source of care immediately (today). 
Stop exam and reschedule clinic visit 

Your BP is 
very high. 

Urgent Referral SBP 180-209 
or  

DBP 110-119 

Consult with JHS MD and proceed 
unless otherwise indicated. Refer to 
source of care within 1 week 

Your BP is 
high. 

Routine Referral SBP 160-179 
or  

DBP 100-109 

Refer to source of care within 1 month Your BP is 
elevated. 

 SBP 140-159 
or  

DBP 90-99 

Refer to source of care within 2 
months 

Your BP is 
elevated. 

 SBP 120-139 
or  

DBP 80-89 

Recheck in 1 year (no JHS referral) Your BP is in 
the pre-
hypertension 
range 

 SBP < 1202or  
DBP < 80 Recheck in 2 years (no JHS referral) Your blood 

pressure is 
normal 

1 If the systolic and diastolic categories are different, follow recommendations for the shorter time follow-up (e.g., 160/85 mm Hg should be 
evaluated or referred to source of care within 1 month).       2  Unusually low readings should be evaluated for clinical significance. 
 
5.2 Procedures 
 
5.2.1 Data Inventory 
 
The data inventory step initiates the last fixed component #2 of the Examination Center 
examination sequence and is done after all interviews and examination procedures have been 
completed in preparation for the Medical Data Review.  Participant data are collected by various 
means during the course of the baseline exam and require summarization and placement in the 
participant's folder for nurse/clinician review. 
 
Although the JHS study does not diagnose or treat any medical condition, the participant's health 
and safety is of paramount concern.  Therefore, data collected during the examination that could 
indicate the need for immediate (same day), urgent (within one week) or routine (within one to 
two months or first convenient appointment) referral for medical care are put together into one 
document, the Medical Data Review Printout (see Appendix), and reviewed with the participant 
prior to the completion of the examination. 
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A staff person reviews the participant itinerary (PIN) to determine that all interviews and 
procedures have been completed and checks participants’ folders to verify that they contain the 
paper versions of the forms to be completed by JHS staff.  After completion of the baseline exam 
and confirmation of quality control procedures, participants are invited to change back into street 
clothes while the data are being prepared for the medical data review. 
 
5.2.2 Participant Medical Data Review Exit Interview  
 
Trained staff conducts the medical data review as part of the fixed sequence #2 at the end of the 
Exam 2 clinic visit to:  

• summarize the results of selected measurements obtained during the Exam 2 
exams/interviews 

• identify potential medical problems 

• answer participant questions 
 
In summary, factual information is given to participants about her/his results during the Medical 
Data Review, identifying abnormalities and recommending referral as needed, but avoiding 
medical advice about prognosis, prevention or therapy.  Physician back-up is available at all 
times.  
 
5.2.3 Clinician Reviews 
 
Clinician reviews of medical data reports are conducted one week after the participant’s Exam 2 
clinic visit by the Clinic Manager with back up of the Clinic RN and oversight by the Examination 
Center Director/co-PI and JHS PI. This step in the Medical Data Review process is to assure that 
all alerts have been recognized and adequately managed by Examination Center staff. 
 
The Clinic Manager review is an ongoing activity at the Examination Center. Once a week, the 
Clinic Manager reviews the data of participants seen in the preceding week.  This procedure 
includes the information initially reviewed during the Medical Data Review and serves as a quality 
control to assure that all alert values have been appropriately identified and processed. After the 
examination of the participant’s Medical Data Review printout, the Clinic Manager records the 
interpretation of the Medical Data Review printout and reviews the preliminary interpretation.  The 
Clinic Manager also confirms the results for alert values.  Any referrals made during Medical Data 
Review are reviewed at this time, and sent to a JHS physician for review. This general medical 
review provides a clinical staff’s interpretation of the study results and an overview of referrals 
and reports from the Examination Center. 
 
5.3 Training 
 
Staff is trained for the data inventory and assembly of study materials for the Medical Data 
Review, as well as the Medical Data Review tasks by the Examination Center Clinic Manager. 
The Clinic Manager is trained to perform the clinician review by the Examination Center 
Director/Co-PI and/or the JHS PI. 
 
5.4. Certification 
 
Certification for data inventory is the responsibility of the Clinic Manager.  Annual recertification is 
required, and staff performance is monitored by the Clinic Manager. The Examination Center 
Clinic Manager is responsible for certification of the clinicians responsible for Medical Data 
Review. 
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5.5 Quality Control 
 
Quality assurance consists of observation by the supervisor and retraining or corrective action, as 
required. The Examination Center PI is responsible for ensuring that the medical data review, 
referrals and reporting of results are done according to procedures in the JHS protocol. 
 
 
6.0 REFERRALS AND REVIEW GUIDELINES 
 
6.1 Rationale 
 
Participants are referred based on the guidelines for alerts referral listed below (Table 6.1).  Prior 
to the Medical Data Review (described in section 5.0), a DMS utility system retrieves affirmative 
responses (from the questionnaires) to key items indicative of hypertension, diabetes, ischemic 
heart disease, hypercholesterolemia, cancer, chest pain on effort, congestive heart failure, 
TIA/stroke, and intermittent claudication.  Guidelines for conducting the Medical Data Review are 
provided in the Medical Data Review instructions. 
 
Referrals for follow-up care can be made at the Medical Data Review or in subsequent 
communications.  Uniform criteria for emergency, immediate, urgent and routine referrals have 
been established, (section 6.2), and are summarized in Tables 6.1 and 6.2.  Sources of medical 
care for participants who do not have a health care provider will be identified in consultation with 
the representatives of the local medical community.  All referrals are documented on a separate 
Report/Referral Form (REF) and the JHS Alert/Referral log (ALT) (see Forms Appendix).  
Detailed QxQ instructions are specified in the Forms Appendix. 
 
6.2 Procedures 
 
Referrals are made during the Medical Data Review or upon receipt of the study’s clinically 
relevant data, which follow the criteria listed below. 
 
1. Emergency Referral.  Transportation to the nearest emergency care facility is provided or an 

emergency squad is called. 

2. Immediate Referral.  The participant is urged to see her/his health care provider within one 
day. 

The nurse/clinician consults with the JHS physician, and the participant’s health care provider 
is called.  The participant’s health care provider is also sent a letter of explanation (see 
Appendix). 

Participants who have no health care provider are referred based on consultation with a 
provider in the community. 

 
3. Urgent Referral.  The participant is asked to see her/his health care provider in one week. 

The nurse/clinician confirms the decision with the JHS physician, and explains the reason(s) 
for an urgent referral to the participant.  This usually occurs during the Medical Data Review, 
but can occur when alert values are returned to the Examination Center from a central 
agency.  The JHS physician calls the participant’s health care provider and sends a referral 
letter (see Appendix).  Follow-up letters are also sent to the participant (see Appendix). 
 
Participants who have no health care provider are referred based on consultation with a 
provider in the community. 
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4. Routine Referral.  The participant is asked to see her/his health care provider at the first 
convenient appointment. 

The nurse/clinician advises a visit to the participant’s health care provider.  A referral letter is 
sent to the participant (see Appendix) and her/his health care provider (see Appendix) as a 
cover letter for the final results report. 

 
5. No Referral.  The study results are summarized for the participant and her/his health care 

provider and sent along with cover letters (see Appendix). 

Procedures/symptom-specific guidelines are summarized in Tables 6.1 and 6.2.  The types of 
participant and health care provider referral and results letters used for each of the five referral 
categories are summarized in Table 6.2; examples of the texts of these letters are provided in the 
Appendix. 
 

Table 6.1 Medical Care Referral Guidelines 

Referral  
Classification 

Examination 
Findings 

Recommendation 
to Participant 

Explanation to  
Participant 

IMMEDIATE 
Referral 

*SBP> 210 mm Hg or 
  DBP> 120 mm Hg 
 
 

See health care provider 
today 
 

BP very high 
 
 
 

URGENT 
Referral 

 
*SBP> 180-209mm Hg           
or 
*DBP> 110-119mm Hg 

See health care provider 
within a week 

 
 

 
Your BP high. 

ROUTINE 
Referral 

 

*SBP 160-179 mm Hg or 
  DBP 100-109 mm       
  Hg 
 
*SBP 140-159 mm Hg or 
  DBP 90-99 mm Hg 
 
*SBP 120-139 mm Hg or 
  DBP 80-89 mm Hg 
 

 
 
 

See health care provider 
within one year 

 

Your BP is high 
 
 
 
Your BP is high 

 

Your BP is borderline 
high 

NO 
Referral 

* SBP 130-139mm Hg  
 or 
   DBP 85-89mm Hg 
 
*SBP<140mm Hg and 
  DBP< 90mm  Hg 
 
Height, weight 

Recheck in one year 
 
 
 

Recheck in two years 
 
 

None 

Confirm only 
 
 
Confirm only 
Your reading is high 
normal 
 
Report only 

*Interview items/measurements require confirmation during Medical Data Review 
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TABLE 6.2 SUMMARY OF PROCEDURES FOR ROUTINE REPORTING AND IDENTIFICATION, NOTIFICATION, AND 
DOCUMENTATION OF ALERTS 

 
Exam  ACTION SEQUENCE FOR 

ROUTINE RESULT 
REPORTING  

Action Sequence for 
Identifying Abnormal / 
Alert Result 

ABNORMAL / ALERT 
VALUE BY CATEGORY 
OF REFERRAL 

ACTION SEQUENCE FOR 
REPORTING ABNORMAL / 
ALERT RESULT  

ALERT / 
REFERRAL 
DOCUMENTATION 

BP BP  Technician informs 
participant of BP 
              ↓ 
Clinic nurse discusses 
findings and gives 
instructions for follow up at 
exit interview.  
               ↓ 
Social Work referral to 
assist with HCP or other 
identified social needs as 
indicated. 
                ↓ 
Weekly Clinic Manager 
review of all results from 
preceding week with review 
of appropriate alert action 
for previously identified 
alerts. Any new alerts 
identified initiate Alert 
Action sequence for 
participant and HCP 
notification.   
                ↓ 
Weekly EC clinician review 
of abnormal results from 
preceding week with review 
of appropriate alert action. 
                 ↓ 
Comprehensive abnormal 
results reporting to HCP (if 
requested) within 2 weeks 
following clinic visit.  

BP Technician identifies alert 
value 
           ↓ 
Notifies Clinic RN/Manager 
            ↓ 
Confirms reading 
             ↓ 
Contacts JHS Medical 
Officer or EC Clinician on-
call 
              ↓ 
Initiates Alert Action 
procedure 

Emergent:   SBP≥260 
                      DBP≥130 
 
 
 
Immediate: SBP 210-259 
                      DBP 120-129 
 
 
 
 
 
Urgent:      SBP 180-209 
                   DBP 110-119 
 
 
 
 
 
 
 
Routine 1:   SBP 160-179 
                      DBP 100-109 
 
 
 
 
 
 
 
 Routine 2:     SBP 140-159 
                         DBP 90-99 
 
 
 

Stop clinic exam and 
transport to local ER. Notify 
participant and HCP by 
telephone.  
 
Continue with clinic exam. 
Notify participant and HCP 
at exit interview. If no HCP, 
use Referral Procedure and 
make appointment for same 
day. 
 
Continue with clinic exam. 
Notify participant at exit 
interview and HCP by letter 
(M2Appendix) for 1-week 
appointment. If no HCP, use 
Referral Procedure and 
make appointment for one 
week.  
 
Continue with clinic exam. 
Notify participant at exit 
interview and HCP by letter 
(M2Appendix) for one-month 
appointment. If no HCP, use 
Referral Procedure and 
make appointment for one 
month. 
 
Continue with clinic exam. 
Notify participant at exit 
interview and HCP by letter 
(M2Appendix) for two-month 
appointment. If no HCP, use 

Record alert value, 
referral action, 
notification method 
and date of notification 
on ALT (Alert and 
Referral Log) at time of 
action. 
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TABLE 6.2 SUMMARY OF PROCEDURES FOR ROUTINE REPORTING AND IDENTIFICATION, NOTIFICATION, AND 
DOCUMENTATION OF ALERTS 

 
Exam  ACTION SEQUENCE FOR 

ROUTINE RESULT 
REPORTING  

Action Sequence for 
Identifying Abnormal / 
Alert Result 

ABNORMAL / ALERT 
VALUE BY CATEGORY 
OF REFERRAL 

ACTION SEQUENCE FOR 
REPORTING ABNORMAL / 
ALERT RESULT  

ALERT / 
REFERRAL 
DOCUMENTATION 

 
 
 
 
Routine 2:      SBP 120-139 
                         DBP 80-89 

Referral Procedure and 
make appointment for two 
month. 
 
Continue with clinic exam. 
Notify participant at exit 
interview and HCP by letter 
(MSAppendix) for one year 
appointment. If no HCP, use 
Referral procedure and 
make appointment for one 
year. 

Lab Lab  Technician collects 
samples 
              ↓ 
Clinic nurse informs 
participant at exit interview 
findings.   
               ↓ 
Weekly Clinic Manager 
review of all results from 
preceding week with review 
of appropriate alert action 
for previously identified 
alerts. Any new alerts 
identified initiate Alert 
Action sequence for 
participant and HCP 
notification. Retain paper 
file of lab results for back 
up until completion of 
comprehensive reporting. 
              ↓ 
Weekly EC clinician review 
of abnormal results from 

Lab Technician identifies 
alert (Panic) value 
immediately 
           ↓ 
Notifies Clinic RN/Manager 
            ↓ 
Reviews reading 
             ↓ 
Contacts JHS Medical 
Officer or EC Clinician on-
call 
              ↓ 
Initiates Alert Action 
procedure 
              ↓ 
Repeat finger stick provides 
repeat confirmation of alert 
result 

Emergent:     None 
 
Immediate: 
Glucose:      < 45 or >500 
 
 
 
 
 
 
 
 
 
Urgent: 
Gluc:     45-60 or 200-500 
TotChol:               >  360 
HDL:                    <    20 
LDL:                     >  260 
TG:                        >1000 
 
 
 
 

 
 
Notify participant and HCP 
by telephone on day alert 
received. FAX complete lab 
results to HCP. If no HCP, 
use Referral Procedure and 
make appointment for same 
day. 
 
 
 
 
Notify participant in clinic 
and HCP by letter 
(M2Appendix) for 1-week 
appointment. Enclose copy 
of alert lab value and 
complete finger stick lab 
results to HCP. If no HCP, 
use Referral Procedure and 
make appointment for one 
week. 

Record alert value, 
referral action, 
notification method 
and date of notification 
on ALT (Alert and 
Referral Log) at time of 
action. 
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TABLE 6.2 SUMMARY OF PROCEDURES FOR ROUTINE REPORTING AND IDENTIFICATION, NOTIFICATION, AND 
DOCUMENTATION OF ALERTS 

 
Exam  ACTION SEQUENCE FOR 

ROUTINE RESULT 
REPORTING  

Action Sequence for 
Identifying Abnormal / 
Alert Result 

ABNORMAL / ALERT 
VALUE BY CATEGORY 
OF REFERRAL 

ACTION SEQUENCE FOR 
REPORTING ABNORMAL / 
ALERT RESULT  

ALERT / 
REFERRAL 
DOCUMENTATION 

preceding week with review 
of appropriate alert action.  

 
Routine:  
All other abnormal values 
not classified as alert value 
 

 
Notify participant in clinic 
and HCP by letter 
(M2Appendix) for 1-week 
appointment. Enclose copy 
of alert lab value and 
complete finger stick lab 
results to HCP. If no HCP, 
use Referral Procedure and 
make appointment for one 
week. 
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7.0  PARTICIPANT SAFETY 
 
The safety and welfare of the JHS participants is protected by: 
 

• specific measurements taken in the design or conduct of the examination for her/his safety; 

• the mechanisms established for handling potential emergencies; 

• routine notification of participants and her/his health care providers regarding the results of 
the examination, and 

• the procedures JHS staff use to review all potentially medically important results and make 
the appropriate referrals. 

An important factor in participants’ welfare involves her/his expectations regarding the examination. 
If they believe the JHS examination is a substitute for a clinical examination, delay in seeking 
needed medical care could occur. Therefore, the provision of adequate information is a requisite to 
the JHS informed consent procedures (described in section 3.2). 
 
7.1 Measures to Protect the Participant 
 
Examination procedures which convey potential risk to participants include the fasting requirement 
and digipuncture.  Methods by which participant risk is minimized (more fully described elsewhere 
in JHS Manuals) include the following: 

• The possibility of hypoglycemia with a 12-hour fast is diminished by routine inquiry about 
reasons that should exempt the participant from fasting during the scheduling of baseline exam. 
Other medical conditions or dietary restrictions, which may be incompatible with the snack 
provided in the clinic, are also ascertained. 

• Hematomas or prolonged bleeding may result from digipuncture. These are usually avoided if 
well-trained technicians follow the procedures for finger stick.  Prior to digipuncture, the 
participant is asked: “Do you have any bleeding disorders?” If the participant answers 
affirmatively or is uncertain, s/he is asked about whether s/he has had blood drawn previously 
and if so, whether there were any problems such as swelling or continuing to bleed at the 
digipuncture site. If the answer to this question is “yes,” the Clinic Manager is summoned to 
approve the digipuncture. Occasionally, with any participant, bleeding persists after the 
digipuncture. If the participant continues to bleed: 

• Apply pressure to the site with a gauze pad. Keep the hand and arm elevated until the 
bleeding stops 

• Wrap a gauze bandage around the finger over the pad. 

• Tell the participant to leave the bandage on for at least 15 minutes 

If the measurements taken have not stopped all bleeding within 30 minutes, and there is no 
obvious explanation for the prolonged bleeding, a medical referral is made. Also, the participant 
is instructed to seek medical care promptly if bleeding recurs after leaving the JHS clinic. 

• Participants may experience dizziness or syncope during the digipuncture. When a participant 
feels faint or looks faint following finger stick, follow the rules for a minor emergency, below 
(section 7.3.2). Additionally, 

• Have someone stay with the person to prevent them for falling and injuring themselves if 
they should faint 

• Place a cold wet cloth on the back of the person’s neck or on their forehead 



76 

Exam 2 Cohort Procedures Manual.DOC 

• Once the episode has passed, some fruit juice may be given to the participant in order to 
counteract any possible hypoglycemia due to their pre-clinic visit fast 

• If the person continues to feel sick, take a blood pressure and pulse reading. Contact a 
medical staff member, who will advise you on further action 

 
7.2 Stopping Rules for Interviews and Procedures 
 
Participant safety and comfort during the clinical examination are monitored throughout the clinic 
visit. Interviewers and technicians observe participants for signs of fatigue or physical and/or 
emotional discomfort. When any one of these conditions is observed, participants are offered the 
opportunity to discontinue the interview or procedure, and are given an opportunity to rest before 
the next procedure. Persons incapable of completing the entire clinical exam are invited to change 
back into her/his street clothes and participate in the medical data review and reschedule the clinic 
exam on another day. 
 
For persons with conditions which require emergency and immediate referrals, such as cardiac 
events, unstable angina, or blood pressure > 210/120 mm Hg (see Tables 16 and 17), the JHS 
physician is consulted immediately, the clinic exam is terminated as soon as the condition is 
observed, and another appointment for baseline exam rescheduled as appropriate. For blood 
pressures requiring referral within one week (SBP 180-209 mm Hg or DBP 110-119 mm Hg; the 
urgent referral category in Table 20), the JHS physician is also consulted, and the clinic exam is 
either continued and the participant advised to seek medical care within one week or the clinic 
exam is terminated and rescheduled, based on the JHS physician’s recommendation. The 
termination of any interview or procedure is documented on the Participant Itinerary Sheet (PIN). 
 
7.3 Methods for Handling Emergencies 
 
While all life-threatening emergencies (e.g., acute MI) require immediate evaluation of the 
participant at an acute care facility, some emergency measures may be required in the clinic before 
departure (e.g., cardiac arrest). In addition, there are minor emergencies (hypotension, fainting, 
etc.) which may require treatment in the clinic only. Although most emergencies are of the less 
severe nature, the JHS Examination Center is prepared for both types. 
 
7.3.1 Major Emergencies 
 
In a serious event the primary concern of the Examination Center staff is to implement pre-
established procedures to get the participant to the nearest medical facility. The JHS clinic is 
located within a few city blocks of a large, general, and acute–care hospital.  A staff person with 
certification in basic life support is on duty and physically present at every clinic session.  Needed 
life support procedures are continued until emergency care arrives or the participant is transported 
to a hospital. The JHS Examination Center has specific emergency procedures which define: 
 

• Who is in charge during the emergency 

• Who is to administer treatment 

• Who is to be notified 

• What action clinic staff is to take 

• Which reports are to be filed 

In addition to trained personnel and emergency equipment, the Examination Center has posted in a 
conspicuous place (e.g., the reception area): phone number of police and fire stations, ambulance 
services, and specific phone numbers or codes to alert medical teams, if applicable. 
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In each participant’s folder, the name and phone number of her/his health care provider or usual 
source of medical care and the home and work telephone numbers of one or more contact person 
are available on the CON form. The Examination Center is required to have either a physician or a 
registered nurse on site at all times when participants are interviewed and examined. 
 
All emergency situations are coordinated by the staff person designated, a priori, or by a physician 
if present. The Examination Center has a designated physician on duty for each clinic session. If 
not physically present in clinic, s/he is within immediate reach by phone or paging system and 
within a short distance to the clinic. The physician duty roster is posted with the clinic secretaries 
and in the office of the nurse/clinician so that the name of the responsible physician is readily 
accessible. However, in no case is emergency referral and/or care deferred while staff is attempting 
to locate a clinic doctor. 
 
JHS staff is trained to carry out her/his specific responsibility during an emergency. Retraining is the 
responsibility of the Examination Center, following institutional guidelines. 
 
All emergencies, whether serious or minor, are documented. This requires filling out an 
institutionally-approved form identifying the type of emergency. This is done by the person in 
charge at the time, and all reports are co-signed by a clinic physician and are filed at the 
Examination Center.  
 
7.3.2 Minor emergencies 
 
The most common minor emergency is simple syncope (fainting) and near syncope. These events 
may occur during digipuncture. Many syncopal episodes can be prevented if clinic staff is alert to 
early signs. In any situation in which syncope is likely, e.g., after the digipuncture, staff verifies that 
the participant does not look or feel faint. If the participant looks faint or feels faint in the 
digipuncture area: 
 

1. Have the person remain in the reclining position or in the chair, sitting with head between the 
knees  

2. Crush an ampoule of smelling salts and wave it under the participant’s nose for a few seconds 

3. Provide the participant with a basin and a towel if s/he feels nauseous 

4. Have the participant stay in the reclining position or chair until s/he feels better and her/his color 
returns 

 
If the participant continues to feel sick, recline the chair, place a cold wet towel on the back of the 
person’s neck, and notify the supervisor. If a participant feels faint, s/he is cautiously lowered to the 
supine position on the floor and one attendant immediately calls for an in-house nurse/clinician to 
assist the patient. The remaining attendant raises the participant’s legs above the plane of the body 
to increase venous return. Prior to this, the staff member momentarily palpates for a carotid pulse 
and checks to be sure the subject is breathing. If life support measures are needed, the procedures 
outlined in section 7.3.1 are followed. 
 
7.4 Emergency equipment 
 
A basic first aid kit is maintained at the Examination Center. The kit contains a reference guide of its 
contents, and is checked every year and immediately after each use.  The Clinic Manager identifies 
a person responsible for this task. 
 

8.0 FOLLOW UP OF THE JHS COHORT 
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8.1 Introduction 
 
Annual Follow Up (AFU) interviews are conducted for the purpose of reviewing the health-related 
developments occurring since the last contact with the JHS. Each follow up is completed by 
telephone (preferred) or in person (if necessary). The follow up call is preceded by a letter sent by 
mail about two weeks in advance of the call (Appendix: AFU Contact Letter). Information for this 
letter is taken from the study data base and is merged into the letter using mail merge procedures.  
 
Each study participant is recontacted approximately every 12 months on a time schedule based on 
the date of the baseline clinic examination. This date has been adjusted for Exam 2 to 
accommodate an examination of shorter duration (three years) and to equalize the distribution of 
participants across the three years of the exam cycle. This will mean that some participants will be 
contacted sooner, while others will be contacted later, than they might otherwise have been with the 
new time windows.  
 
8.2  Training and Certification 
 
AFU interviewers are trained and certified in general interviewing techniques and the administration 
of all relevant AFU interviews. This requires familiarity with the contents and procedures for 
administering the forms, assigning contact and appointment status codes on the Record of Calls 
(ARC) form, scheduling a clinic appointment for Exam 2, verifying contact information on the CON 
form, and recording any changes in consent restrictions on the Informed Consent Tracking (ICT) 
form.  
 
Staff is certified in administering all forms and questionnaires after review of a standardized 
protocol.  Satisfactory completion of two annual follow up interviews is necessary for certification on 
any new form or interview.  Recertification is required annually with the recommendation of a 
periodic refresher course and retraining if quality assurance analysis indicates poor performance or 
inconsistent results. 
 
8.3 Quality Assurance 
 
Individual interviewer performance is reviewed regularly by the Director of Retention / Annual 
Follow using a remote listening device that allows her/him to randomly select an interviewer. At 
least one interview is monitored each quarter.  
 
The Coordinating Center conducts regular quality assurance of data from AFU interviews by 
interviewer code, providing output to the interviewer. In conjunction with the Data Manager, any 
data discrepancies are addressed.  Discrepancies in excess of 5% require review of protocol 
elements and reanalysis within 6 weeks to assure correction of identified issues.  
 
8.4 Annual Follow Up  
 
8.4.1 Eligibility Requirements for Annual Follow Up Interviews 
 
Participants who completed at least part of the baseline clinic examination are contacted annually.  
Individuals excluded from annual follow-up (AFU) and subsequent examinations at the beginning of 
the study are only those enumerated residents who completed the home interview, but did not sign 
the informed consent form at the Examination Center examination (baseline exam).   
 
Unless requested otherwise by the participant, or a participant is lost to follow-up, an attempt is 
made annually to contact all surviving JHS cohort members. This includes participants who have 
moved away from the community in which they were recruited. Telephone AFU interviews can be 
conducted anywhere in the continental U.S. Addresses and telephone numbers of cohort members 
with multiple residences are kept on file to contact participants on her/his target anniversary date. 
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8.4.2 Time Window for Annual Contacts between Examinations 
 
Study participants are recontacted annually on or near the anniversary date of her/his initial 
examination date, adjusted for Exam 2 modifications in duration and equalizing participants across 
years.  The target date for the AFU interview is this adjusted baseline visit date. Contact years are 
numbered sequentially with the date of the baseline visit as CY01 assigned regardless of the 
calendar years in which that visit was completed (Table xx). 
 
Table 8-1. Contact Years by Visit Dates 
 

Contact Year 01 
Baseline Exam 

Contact Year 02 
AFU 1 

Contact Year 03 
 AFU2 

Contact Year 04 
AFU 3 

9/26/2000-9/25/2001 3/26/2001-3/25/2002 3/26/2002-3/25/2003 3/26/2003-3/25/2004 

9/26/2001-9/25/2002 3/26/2002-3/25/2003 3/26/2003-3/25/2004 3/26/2004-3/25/2005 

9/26/2002-9/25/2003 3/26/2003-3/25/2004 3/26/2004-3/25/2005 3/26/2005-3/25/2006 

 
Because recruitment is done over a three-year period, all participants will be in any one of three 
JHS baseline examination contact years during the calendar year in which annual contact 
interviews are conducted.  Regardless of the contact year, the optimal time for placing the initial call 
each year for annual contact is generally not more than three weeks before the target (anniversary) 
date.  A one year window, up to 6 months before and 6 months after the target date, is the 
maximum allowed for each annual contact. This window will allow accommodation of ARIC with 
JHS AFU. 
 
When the contact window expires and no contact is made, a final result code for that window is 
entered on the Annual Follow-Up Record of Calls (see Appendix), and a new window begins.  
 
The contact year to which a participant death is assigned is determined by two factors: the date of 
death and whether or not the participant had already been interviewed during the contact year in 
which the death occurred.  For example, if the death is determined during or prior to the regularly 
scheduled AFU interview, the death is assigned to the contact year in which the AFU form was 
administered.  If however, a participant is interviewed in Contact Year 02, dies a short time 
afterwards, and the family notifies the Examination Center of the death, the death is assigned to the 
next contact year, i.e. Contact Year 03. 
 
8.4.2.1 Modified Windows for Exam 2 Scheduling 
 
In order to accommodate the reduced length of time allocated for the conduct of Exam 2 (3 years 
instead of 3 ½ as required for Exam 1), all participant annual follow up windows have been 
modified. Additionally, windows have been modified to accomplish an approximate equal number of 
participants across each month and year of clinic scheduling. Table x below provides details on the 
reallocation of participant Exam 2 dates based upon the date of the baseline examination (Exam 1). 
A similar collapsing of participant windows was first accomplished for the JHS cohort as part of the 
Interim Clinic Protocol (2004-2005) in the year between Exams 1 and 2 (see ICP Manual of 
Operations) to allow all participants to be contacted by telephone during a one year time frame. 
Based on this table, we anticipate approximately 150 participants to be scheduled each month for 
the three years from September 2005 through September 2008. 
 
Table 8.2 JHS Exam 2 Revised Scheduling Windows 

Exam 2 DOV Exam 1 DOV N cum(n) 
09/26/05-12/31/05 09/26/00-04/21/01 441 441 
01/01/06-03/31/06 04/22/01-08/22/01 446 887 
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04/01/06-06/30/06 08/23/01-01/23/02 443 1330 
07/01/06-09/30/06 01/24/02-04/29/02 447 1777 
10/01/06-12/31/06 04/30/02-07/10/02 443 2220 
01/01/07-03/31/07 07/11/02-09/27/02 448 2668 
04/01/07-06/30/07 09/28/02-01/07/03 444 3112 
07/01/07-09/30/07 01/08/03-03/28/03 444 3556 
10/01/07-12/31/07 03/29/03-06/27/03 446 4002 
01/01/08-03/31/08 06/28/03-10/21/03 446 4448 
04/01/08-06/30/08 10/22/03-02/03/04 440 4888 
07/01/08-09/25/08 02/04/04-03/31/04 419 5307 

TOTAL  5307*  
*Total enrolled participants exceeds total participants for data analysis 
 
 
8.4.3 Follow Up Procedures 
 
Annual follow-up of cohort members is used to (1) maintain contact and correct address information 
on cohort participants, (2) update tracing information on three contact persons, (3) ascertain the 
participant's vital status (4) document interim medical events/hospitalizations, life events and 
functional status between the three-year comprehensive examinations, and (5) obtain additional 
sociocultural information.   
 
There are four primary components to annual follow-up: (1) the generation of scheduling material 
by the JHS Coordinating Center; (2) the scheduling of the AFU interview by Examination Center 
staff; (3) the administration of the AFU interview; (4) the ascertainment of medical information 
relating to hospitalizations for cardiovascular disease and documentation of fatal events.  It is 
anticipated that the scheduling of a Examination Center examination every third contact year will 
occur during the annual follow up call in AFU Year 03 (Contact Year 04).  These steps are 
summarized in Figure 8.1 and described in the following sections.  
 
Figure 8-1. Interim Contact Procedures between Clinical Examinations in the JHS Cohort 

Study 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
8.4.2.1 Scheduling Annual Follow Up Interview 
 
The Coordinating Center initiates the AFU procedures by generating several times a year AFU 
materials for use in scheduling and conducting the AFU interview.  These materials include the 
Participant Tracing Information Sheet (see Forms Appendix).  The list of participants includes the 
participant name, participant ID, date of baseline exam, and date of Visit 2 (optional), sorted in the 
order requested by the Examination Center.  The Participant Contact Information Sheet includes the 
participant's name, address, telephone number(s); gender, date of birth, state of birth, social security 
number; employer's name and address; date of baseline exam; and the names, addresses, and 
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telephone numbers of two contact persons, and the personal health care provider.  The Contact (CON) 
form lists the current data on file for the names and addresses of the participant and her/his three 
contact persons. 
 
The scheduling of AFU interviews at the Examination Center is done year round and involves 
identifying the participants who require scheduling, establishing contact, administering the AFU 
form, and recording participant-reported medical events to JHS surveillance staff.  The procedures 
for scheduling baseline exam and event classification are described in sections 1.2 and Manual 4: 
Cohort Surveillance / Events Ascertainment, respectively. 
 
Participants who do not have phones, have trouble communicating by phone, or have special needs are 
not contacted by telephone but are visited in-person.  If these participants can be identified in advance, 
the letter indicates that an interviewer will visit the home, and AFU interviews take place there. 
 
8.4.2.2 Conducting Annual Follow Up Interviews (AFU and AFO) 
 
In Contact Year 06 forward, version "B" the AFU and Version C of the Annual Follow-Up Other 
(AFO) forms are administered along with AFU Year 1, 2, 3, or AFE supplementary questions for 
any persons who have not previously completed them.  QxQ instructions for the Record of Calls 
and version "B" of the AFU and version “C” of the AFO forms and prototype scripts for their 
administration have been prepared for the AFU interview (See Forms Appendix).  The interview 
includes the use of three forms (CON, ARC and AFU) which update address and tracing 
information of cohort participants (See Forms Appendix); and ascertains her/his vital status (AFU, 
section A), death information (AFU, section B); perceptions of general health (AFU, section C); 
chest pain on effort (AFU, section D); possible infarction (AFU, section E); intermittent claudication 
(AFU, section F); TIA/stroke (AFU, section D); hospitalizations (AFU, sections H and K); and 
functional status, weight loss, and life events (AFU, section I) (See Forms Appendix, Annual Follow-
up form). The Record of Calls (ARC) is used throughout the contacting process to log each 
participant's interim and final contact and appointment status (when applicable).  At some point 
after the AFU interview, every participant-reported hospitalization is verified and the discharge 
diagnoses recorded.  Potential cardiovascular events are reviewed further by the abstraction of 
participants' hospital records to document the presence/absence of JHS Study end point criteria.  
Detailed information on diagnostic criteria and event determination of the cardiovascular events is 
provided in Manual 4, Cohort Surveillance / Events Ascertainment Component Procedures. 
 
The components of the AFU interview are usually done in the following order: (1) completion of the 
Record of Calls; (2) administration of the AFU questionnaire; (3) documentation of the participant's 
hospitalizations during the past year - section K of the AFU form; (4) completion of the AFO 
questionnaire; (5) completion of any incomplete AF1, AF2, AF3, or AFE forms; (6) scheduling of the 
appointment for Visit 2 exam (Contact Year 06); (7) updating of the contact information (CON form; 
and, if indicated, updating of the informed consent information (ICT form). 
 
The Record of Calls (ARC form) is used to keep track of attempts to contact a participant.  The 
participant's name, ID, contact year, and contact year date ranges are pre-printed at the top of the 
form.  Space is provided to document contact attempts, pertinent information for future contacts, 
and the outcome of the contact.  There are 26 contact RESULTS CODES.  The final result code is 
circled and entered into the data entry system.  The paper copy of the form is kept in the 
participant's folder to assist in future contacts.  The results codes are as follows: 
 

1 Annual Follow-Up Notification Letter Sent – Letter notifying participant that s/he will 
be contacted by the JHS in the near future for the annual follow-up call.   

2 No Action taken – No attempt has yet been made to contact the participant. 

 

3 No Answer – No answer after 10 rings 
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4 Busy – Busy signal 

 

5 Answering Machine – Message left on answering machine for participant. 

 

6 Privacy Block – Phone with privacy block on all calls 

 

7 Disconnected/Non-Working Number – Recording from phone company or fast busy 
signal. 

 

8 Recording/ # Change – Recording from phone company of number change.  
Record new number in notes section and retry. 

 

9 Participant Does Not Live Here/Never Heard Of – Phone answered, name does not 
reside here or denies knowledge of name. 

 

10 Participant Lived Here, But Moved Permanently – Phone answered, person has 
moved. New contact information, if available, recorded in notes section and retry. 

  

11 Tracing – Attempts are being made to locate the participant, but so far neither the 
participant nor a reliable source have been contacted. 

 

12 Physically/Mentally Incompetent – Participant was successfully contacted by 
phone, letter or in person, but has a physical or mental impediment to 
communication (e.g. slurred speech, hearing impaired). 

 

13 Language Barrier – Participant was successfully contacted by phone, letter or in 
person, but interviewer was unable to understand the respondent, or the participant 
was unable to understand the interviewer. 

 

14* Contacted, Interview Complete – Participant was successfully contacted y phone or 
in person and the entire interview, including the questionnaires (AFU, AFO, AF1, 2, 
or 3) and hospitalization was completed. 

 

15* Contacted, Interview Partially Complete or Rescheduled – The participant was 
successfully contacted by phone, letter or in person, but the interview is incomplete 
or was not done at all. This may be a temporary code if it is possible that the 
interview may be completed at a later date within the same contact year.  

 

16* Contacted, Interview Refused – Participant was successfully contacted by phone, 
letter or in person, but the interview was not done and will not be completed at a 
later date within the same contact year.  
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17* Reported Alive, Will Continue to Attempt Contact This Year – Reliable information 
(e.g., from employer, relative, etc.) indicates that the participant is living, but direct 
contact has not yet been made.  It is possible that contact will be made during this 
same contact year through further efforts.  For example, “temporarily away”, would 
fit in this category.  Record date of return in notes section and retry. 

 

18* Reported Alive, Contact Not Possible This Year – Reliable information indicates that 
the participant is living, but direct contact has not yet been made. This code should be 
used only if repeated contact attempts have been made, or when it has been 
determined that it is not possible that contact will be made during this same contact 
year.  

 

19* Reported Deceased – Reliable information indicates that the participant has died. 

 

20* Unknown – Neither the participant nor another source of information has been 
contacted in a manner sufficient to provide reliable vital status data during the 
specified date range. 

 

21* Does Not Want Any Further Contact – Participant has requested that s/he does not 
wish to be contacted any more by the JHS.  This code alerts staff that no additional 
contacts should be attempted during the same contact year.  Notes should be kept 
on the ARC to describe the nature of the refusal.  The Director of Recruitment 
determines the type of action to be taken at the following contact anniversary date, 
e.g., a polite letter, post card or an alternative that is sensitive to any known 
reasons for this participant’s desire not to be contacted again by the study. 

 

22 Other – Any other results not covered by specified RESULTS CODES. 

23 ARIC AFU – This participant has completed the ARIC AFU conducted by ARIC 
interviewers 

24 Exam scheduled --Exam 2 has been successfully scheduled. Enter the date and 
time in the NOTES boxes. 

25 Clinic Exam not scheduled, pending – Participant is willing to schedule clinic exam, 
but unable to do so at time of AFU call. Indicate in the NOTES boxes the plans for 
further contact regarding scheduling.  

26 Clinic Exam not scheduled, refused – Participant indicates that s/he is not willing to 
schedule Exam 2 visit. This code requires an entry in the NOTES box to indicate 
whether the refusal is considered to be a “soft” or a “hard” refusal. A “hard” refusal 
generates mailing of a “refusal” letter to the participant while a “soft” refusal is 
followed by supervisor contact to attempt to convert the participant to a successful 
scheduling. Please refer to the section on Off Site Examinations is necessary to 
retain participation. 

Codes 1-13 and 22 are interim codes.  Codes 14 – 20, 21, and 23 are final codes.  See Forms 
Appendix for detailed instructions for completing the form, and a description of the Results Codes for 
contacts.  It should be noted that these codes are required for all AFU contacts, in contrast to the 
APPOINTMENT CODES (24-26) which are only used in the Contact Years in which the participant is 
scheduled for a clinic visit. 
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Note that comments are required in the NOTES for codes 8,10,11-15, 18, 21, 22, and 26. 
 
8.4.2.2.1 Annual Follow Up (AFU) 
 
Once contact has been made, the entire AFU interview is administered to surviving participants.  
When a participant has expired prior to the annual contact, the relevant portions of the AFU form 
(Sections A, B, H and K) are administered to a member of the participant's household (or a contact 
person) in order to officially record the death and to obtain the date and location of death and other 
relevant medical information.   
 
Section A of the AFU form documents the participant's vital status and the date on which the status 
determination was made.  The criteria for establishing participant vital status are defined in the 
form's instructions.  Section B is completed on individuals who have died and records demographic 
information necessary for obtaining a copy of a death certificate.  Sections C-G are administered to 
all surviving participants and document perceptions of health and interim (since the previous AFU 
interview) medical events; the majority of the questions were taken from the London School of 
Hygiene Questionnaire for chest pain on effort, possible infarction, and intermittent claudication. 
Guidelines for administering this section are provided below, in Section 7.4.2.2.1.1.  Sections H and 
O on the AFU form are administered to all respondents (participants and proxies) to document 
overnight hospitalizations in acute or chronic medical care facilities.  The surveillance staff is 
notified of every cohort hospitalization and an event investigation is initiated.  Section I is 
administered only to surviving participants.  Section J is administered to all respondents to 
ascertain any changes in stress, coping and social support and negative emotions of anxiety or 
depression.  Section L is administered to all respondents to ascertain any change in employment 
status.  Table 8.2 summarizes the data collected in each of the versions of the AFU interview since 
study inception in 2000. 
 
Table 8.3 Summary of Data Collected During Annual Follow-Up (AFU) Interview From 

JHS Cohort Members 
 
 

Data Item 
JHS/ AFU 

Form Version 

 A B C 

DATE OF STATUS DETERMINATION X X X 

VITAL STATUS X X X 
DEATH INFORMATION 
Date of death 
Location of death 

 
X 
X 

 
X 
X 

 
X 
X 

COMPARISON OF HEALTH TO OTHERS ONE’S OWN AGE X X X 
 
STROKE/TIA X X X 
 
HOSPITALIZATIONS X X X 
 
FUNCTIONAL STATUS X X X 
 
MARITAL STATUS X X X 

RESIDENCE WITHIN ARIC STUDY BOUNDARIES X X X 

NURSING HOME ADMISSIONS X X X 

HISTORY OF CARDIOVASCULAR AND RELATED DISEASES X X X 

DIAGNOSTIC PROCEDURES FOR CVD X X X 
 
INVASIVE PROCEDURES/TREATMENT FOR CVD X X X 
CURRENT MEDICATIONS FOR HYPERTENSION, 
HYPERCHOLESTEROLEMIA, DIABETES X X X 

REGULAR OR CURRENT USE OF ASPIRIN X X X 
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Data Item 
JHS/ AFU 

Form Version 

 A B C 

HISTORY OF HRT USE OR GYNEGOLOGIC SURGERY X X X 
 
CURRENT CIGARETTE SMOKING X X X 
 
CURRENT EMPLOYMENT STATUS X X X 

 
 
8.4.2.2.1.1 Administration of London School of Hygiene Questionnaire 
 
The questions in Sections D-F (CHEST PAIN ON EFFORT, POSSIBLE INFARCTION, and 
INTERMITTENT CLAUDICATION) of the AFU form are based on the London School of Hygiene 
Questionnaire.  The purpose of the London School of Hygiene Questionnaire (generally referred to 
as the 'Rose Questionnaire') is to standardize the identification of 'angina on effort' as defined by 
Dr. Geoffrey Rose.  It is not the purpose of the questionnaire to arrive at a medical diagnosis.  The 
questionnaire will fail to identify angina pectoris in some participants whose pains are regarded by 
the physician as genuinely ischemic.  It may categorize other cases as pain due to a quite different 
cause.  Any special effort, however, to alter the conduct of the interview in such instances would 
destroy the basic purpose of the questionnaire technique, which is to insure uniformity in the 
eliciting of defined symptoms. 
 
Questions must be put to the participant exactly as they are printed: small changes can make 
unexpectedly large differences in responses.  Unequivocal answers must be recorded as such, 
whether they seem reasonable or not. Supplementary questions (probing) should rarely be used.  
When they have to be asked, they should depart as little as possible from the wording of the initial 
question, and must not be such as to suggest any one particular answer to the participant. 
 
If serious doubt arises about the correct interpretation of a particular answer, it is recorded in such a 
way as to exclude the suspected condition. An example of this type of situation is demonstrated in 
the following question and hypothetical response.  
 

{Question} "Do you get it when you walk uphill or hurry?"  
{Response} "Well, I think I might, but I really can't remember." 

 
This answer is recorded as NO and no probes are employed. 
 
An exception is made to this rule only if a negative response to the lead-in question is an 
interpretation or denial of a positive response. 
 

{Question} "Have you ever had any pain or discomfort in your chest?" 
{Response} "No. Only indigestion." 

 
The answer is recorded as YES, because the participant's interpretation of the symptom is 
disregarded. 
 
A frequently made error in the administration of the Rose Questionnaire is to extrapolate the 
participant's response to similar, but not defined, situations in the question. 
 

{Question} "Do you get it when you walk uphill or hurry?" 
{Response} "Yes, the chest pain occurs when I cut the grass.” 

 
The answer to this question is recorded as NO, i.e., a strict interpretation is required.  If pain is 
experienced only during some other form of exertion (e.g., cycling, stair climbing, lawn mowing, 
etc.) it must always be recorded NO.  The response 'NEVER HURRIES OR WALKS UPHILL' can 
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only be coded if the participant specifically denies walking uphill or hurrying.   
 
For the remaining questions, unequivocal answers need not be probed.  However, responses 
qualified by terms describing frequency of events, such as 'occasionally' or 'sometimes' should be 
probed by a question such as 'Does it happen on most occasions?’  Individual QxQ instructions are 
provided in the Forms Appendix. 
 
8.4.2.2.2 Annual Follow Up Other (AFO) 
 
The AFO form is administered to determine recent medication use related to chest pain or some 
other heart condition, whether the participant has experienced any of the signs or symptoms of 
congestive heart failure, had any invasive procedures or diagnostic tests with their associated 
indication (reasons), update family history, assess the degree of global psychosocial experiences 
over the previous year, and health care access.  
 
If the additional year questions for Contact year 02, 03, 04, and 05 were not administered in the 
corresponding Annual Follow-Up year 1, 2, 3, or 4 (forms AF!, AF2, AF3, AFE), these forms should 
be administered during the current Contact year.. 
 
8.4.2.2.2.1 Congestive Heart Failure Questions 
 
Detailed information on congestive heart failure (CHF) symptoms that may have been experienced 
in the past year, since the last JHS contact, is assessed as part of the AFO form. Participants are 
asked about possible symptoms of CHF as detailed in the table below. Difficulty breathing or 
swelling of the feet or ankles are common symptoms that are assessed by a series of questions 
that request information about shortness of breath when at rest or that awakens the person at night, 
needing extra pillows to improve their breathing, night time cough, or lower extremity swelling. The 
items included in this battery were derived from several standardized sources used by Multiethnic 
Study of Atherosclerosis (MESA), Framingham and Cardiovascular Health Study (CHS) (1-4).  
 

 
8.4.2.2.2.1 Background, Rationale, and Hypotheses 
 
Congestive heart failure (CHF) is a syndrome that disproportionately affects African Americans (5-
6). National Health Surveys were unable to document differences in self-reported heart failure 
between blacks and whites (7), but there is evidence that African American ancestry is a major risk 
factor for hypertension and hence congestive heart failure (6).  CHF is lethal in African Americans, 
and contributes significantly to high prevalence of cardiovascular disease morbidity and mortality in 
African Americans nationally (7-8).  African Americans appear to develop asymptomatic left 
ventricular dysfunctional (ALVD) which is a precursor for the development of symptomatic 
congestive heart failure (9).  It also appears that African American males are at a greater risk of 
developing ALVD (10).  Risk factors for the development of CHF are numerous, but two major ones 
are hypertension and coronary heart disease (9).  Congestive heart failure mortality rate increases 
with age in African Americans and at every age mortality rates for African Americans exceed rates 
for the white population (11).  CHF may occur earlier in life in African Americans because of the 
high prevalence of hypertension in this group (12).  National surveys reported that African 

Table 8-4.  Congestive Heart Failure Criteria Symptoms List 
    

  Paroxysmal nocturnal dyspnea 
        Orthopnea 

  Dyspnea on exertion 
  Shortness of breath (dyspnea at rest) 
  Night Cough  
  Bilateral lower extremity edema 
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Americans have higher prevalence and incidence of hypertension and heart failure across every 
age group when compared to whites (13).  Most of these studies also reported that CHF is at least 
50% higher in African Americans than in whites. Overall, the heart failure rates are 3 to 7 times 
higher in African Americans when compared to other ethnic groups nationally. 
The management of heart failure is characterized by high rates of hospital admission and 
readmission.  For African Americans the most practiced self-care behavior for heart failure is the 
use of prescribed medications, with the least practiced behavior of symptom monitoring and 
management (14) of the contributable risk factors such as coronary heart disease and 
hypertension. This suggests that African Americans respond more to intervention than prevention 
and this may account for high readmission rates into hospitals (5).  Clinical studies reported higher 
rate of readmission in elderly African American patients with CHF when compared with whites, but 
case fatality CHF mortality rates are similar (8). 
CHF mortality rates in Mississippi are about 4 to 6 times higher than US National rates for ages 20-
64 (15).  Finally, the CHF mortality rates in African Americans in Mississippi are increasing, 
according to the most recent available data (11).  Data on incidence and prevalence of CHF in 
African Americans is limited or unavailable. JHS is all African American study and will be an 
excellent resource for studying CHF in African Americans. The CHF questions will collect incident 
data on CHF in cohort participants during the annual follow-up interview. The next phases (II and 
III) of the JHS will include CHF event ascertainment. This will parallel the current system that is 
utilized by JHS to identify, classify, review and adjudicate both coronary heart disease (CHD) and 
stroke. 
8.4.2.2.2.1.2 References 
 
 1.  Bild DE, Detrano R, Peterson D, Guerci A, Liu K, Shahar E, Ouyang P, Jackson S, Saad MF. 
Ethnic differences in coronary calcification: the Multi-Ethnic Study of Atherosclerosis (MESA). 
Circulation. 2005 Mar 15;111(10):1313-20. 
2.  Vasan RS, Sullivan LM, Roubenoff R, Dinarello CA, Harris T, Benjamin EJ, Sawyer DB, Levy D, 
Wilson PW, D'Agostino RB; Framingham Heart Study. Inflammatory markers and risk of heart 
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Circulation. 2003;107(11):1486-91.  
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Heart Study. Curr Cardiol Rep. 2001;3:184-90.  
4.  Schellenbaum GD, Heckbert SR, Smith NL, Rea TD, Lumley T, Kitzman DW, Roger VL, Taylor 
HA, Psaty BM. Congestive heart failure incidence and prognosis: case identification using central 
adjudication versus hospital discharge diagnoses. Ann Epidemiol. 2005; Jun 15. 
 5.  Alexander M, Grumbach K, Remy L, Rowell R, Massie BM. Congestive heart  failure 
hospitalizations and survival in California: patterns according to race/ethnicity. American Heart 
Journal. 1999; 137(5): 919-27. 
6.   He J, Whelton PK Epidemiology and prevention of hypertension. Medical Clinics of North 
America. 1997; 81(5): 1077-97. 
7.   Ni H. Prevalence of self-reported heart failure among U.S. adults from the 1999 National Health 
Interview Survey. American Heart Journal. 2003;146(1): 121-8 
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9.  Philbin EF, DiSalvo TG. Influence of race and gender on care process, resource use, and 
hospital-based outcomes in congestive heart failure. American Journal of Cardiology. 1998; 82(1): 
76-81. 
10.   Malki, Q et al. Clinical presentation, hospital length of stay, and readmission rate in patients 
with heart failure with preserved and decreased left ventricular systolic dysfunction. Clinical 
Cardiology.  2002; (4):149-152. 
11.   Wolinsky FD, Overhage JM, Stump TE, Lubitz RM, Smith DM. The risk of hospitalization for 
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13.  McCullough, PA et al. Confirmation of a heart failure epidemics: findings from the Resource 
Utilization Among Congestive Heart Failure (REACH) Study. Journal of the American College of 
Cardiology. 2002; 39:1. 
14.  Artinian NT, Magnan M, Sloan M, Lange MP. Self-care behaviors among 
patients with heart failure. Heart and Lung. 2002;31(3):161-72. 

15.  Yancy, Clyde W. Treatment of heart failure in African Americans: clinical update. Ethnicity and 
Disease. 2002 Winter;12(1):S1-19-26 
 
8.4.2.2.2.2 Diagnostic Tests / Invasive Procedures Questions 
 
These items are included to assess the type and reasons for any cardiovascular diagnostic tests or 
procedures the participant may have had in the previous year. They are intended to update and 
supplement information previously gathered during the baseline and Exam 2, as well as in earlier 
annual follow up interviews. Of particular note beginning with Contact Year 06, items have been 
added to assess the participant’s awareness of the rationale or indication for each test or procedure 
conducted. A series of likely clinical indications are included for each relevant test / procedure. 
Items are based upon standard clinical care practices for cardiovascular disease diagnosis / 
intervention.  
 
8.4.2.2.2.2.1 Background, Rationale, and Hypotheses 
 
Capturing these data may be very important. Cardiac catheterizations are done very frequently, and 
coronary disease is clearly the leading killer of the JHS cohort. But, paradoxically, there are 
unresolved questions about the high rate of negative catheterizations (i.e., catheterizations that 
don't lead to definitive interventions like PTCA or surgery) in African American patients (vs the rates 
of procedures in whites).  The whole notion that blacks were somehow "immune" to coronary 
disease found support in the high frequency of negative catheterizations seen studies like the 
National Heart Lung and Blood Institute's CASS Study (which set the standards for bypass surgery 
that are followed by most surgeons today).  An increasing number of cardiac catheterizations are 
done outside the hospital. Our data MAY shed some light on this as we collect these data points 
longitudinally.    
 
8.4.2.2.2.2.2 References  
 
1. Taylor HA.; Chaitman BR.; Rogers, William J.; Kern MJ.; Terrin ML Aguirre FV.; Sopko G; 
McMahon R; Ross RN.; Bovill,EC.; TIMI Investigators Myocardial Infarction: Race and Prognosis 
After Myocardial Infarction: Results of the Thrombolysis in Myocardial Infarction (TIMI) Phase II 
Trial. Circulation. 88(4):1484-1494, October 1993.  
2. Cooper R, Ford E. Coronary heart disease among blacks and whites in the NHANES-I 
Epidemiologic Follow-up Study: incidence of new events and risk factor prediction. Ann Epidemiol. 
1992;2:637- 645. 
3. Strogatz DS. Use of medical care for chest pain:- differences between blacks and whites. Am J 
Publ Health.1990;80:290-294. 
4. Sempos C, Cooper R, Kovar MH, McMillen M. Divergence of the recent US trends in coronary 
mortality for the four major sex-race groups. Am J Publ Health. 1988;78:1422-1427. 
 
8.4.2.2.2.3 Update Family History Questions 
 
This section of the AFO provides an update on family history items initially obtained in the Home 
Induction Interview. The intent is to determine if there have been any deaths or new diagnoses 
among natural parents, full siblings, or natural children of cohort members since the last JHS 
contact. The items were modified from those asked in the Personal and Family History (PFH) form, 
Exam 1. Original items were modified from those used in ARIC. Additional questions were added in 
the JHS on the health history of full siblings and natural children to assure that a wide range of 
essential family health data can be captured.   
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8.4.2.2.2.3.1 Background, Rationale and Hypotheses 
 
An extensive, well-accepted body of data supports the relationship between health history and risk 
for development of CVD. We hypothesize that strong relationships will continue with the JHS. That 
is, the more extensive the history of CVD and other metabolic conditions, the more likely the person 
is to develop CVD over her/his lifetime. Further, this relationship will be moderated by a variety of 
socioeconomic and psychosocial variables, e.g., discrimination, stress, social support, coping, SES, 
health care access, and so forth.  
 
8.4.2.2.2.4 Update Global Psychosocial Questions 
 
Five questions will be used to assess global psychological functioning each year at annual follow-
up.  Participants will be asked to rate her/his response to each question on a 6-point Likert-type 
scale.  The specific psychological domains assessed include:  major stressors, depressed mood, 
anxiety, coping, and social support. 

8.4.2.2.2.4.1 Background, Rationale and Hypotheses 
 
Epidemiologic and clinical studies have identified a number of psychosocial risk factors that appear 
to influence the incidence, morbidity, and mortality associated with cardiovascular disorders.  
Measures of each of these psychosocial domains are assessed at baseline.  An annual global 
assessment will provide valuable information on change over the year’s time. 
 
Hypotheses include: 

1. Greater global distress will be associated with an increased risk of hypertension and CHD 
events independent of the contribution of traditional CHD risk factors. 

2. The relationship observed between global psychological distress, hypertension, and CHD 
events will be moderated by global social support, global coping, SES, and education. 

8.4.2.2.2.4.2 Scoring/Coding 
 
Each item is read to the participant and requires a rating on a 6-point Likert-type scale. One score 
is derived for each of the Psychosocial Annual Follow-up Questions.  Each rating scale ranges from 
0 (assigned 0 points) to 5 (assigned 5 points). 
 
 
8.4.2.2.2.5 Access to Care Questions 
 
Items 11 through 29 were included to supplement the information collected at the baseline and 
subsequent visits regarding participant access to health care resources. These questions will be 
provide ongoing information regarding the status of JHS participants in terms of type and stability of 
health insurance coverage, prevalence of prescription medication insurance coverage, out of 
pocket expenditures for medications, prevalence of health care access barriers, interactions with 
health care providers, and satisfaction with health care. These items were derived from items 
frequently used in population-based surveys such as the Medical Expenditure Panel Survey [1], 
National Health Interview Survey, Community Tracking Survey [2], which are frequently used to 
inform policy makers, legislators, and the public regarding health care access and utilization issues 
in the United States. 
 
8.4.2.2.2.5.1 Background, Rationale, and Hypotheses 
 
Health insurance status is an important determinant of health care access and satisfaction with 
health care. Numerous researchers have determined that regardless of race, the lack of health 
insurance status is associated with poor health outcomes, decreased use and expenditures for a 
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variety of health services, increased prevalence of experiencing health care access barriers, 
decreased satisfaction with care, decreased quality of health care, and increased financial burden 
[3-5].  
 
Simply asking questions regarding current health insurance coverage with each round of data 
collection does not address the considerable changes in health insurance status that can occur 
between data collection periods. Health insurance coverage instability can occur when a person 
gains or loses coverage as well as when the person experiences changes in coverage such as 
reduced benefits or increased co-payments. Instability in coverage has been associated with same 
health care access barriers experienced by persons who are uninsured.  Furthermore, asking 
uninsured persons about the length of time uninsured is important since longer time uninsured 
associated with increased financial burden and access barriers [6]. 
 
Clearly, a means of measuring health insurance instability is needed to accurately determine the 
impact of health insurance status on health care access, utilization, and the health of JHS 
participants. The prevalence of health insurance instability among JHS participants is unknown. 
Asking annually about current health insurance coverage, the type of coverage, gaps in coverage, 
and the length of time not covered will provide information about the current health insurance status 
as well as stability of coverage over time.  
 
Health insurance coverage does not always include coverage for prescription medications. Recent 
changes in Medicare prescription coverage have sparked interest in examining how elderly 
Americans cope with prescription medication expenditures. Co-payments and restrictions in 
coverage influence participants’ ability to purchase medications and other health services.  Out of 
pocket expenses for prescription medication affect use of medications and ultimately health. 
However, not much has been written regarding factors that influence prescription medication use 
and expenditures for African Americans or non-elderly Americans. Asking questions about the 
status of insurance coverage for prescription medication and the OOP associated with prescription 
medication use will allow investigation of factors influencing prescription medication expenses and 
the affect of these expenses on the lives of JHS participants [7,8].  
 
Few questions were asked at the baseline visit regarding health care access barriers and the use of 
health services. The AFO delves more deeply into use of primary care services and the existence 
and nature of health care access barriers experienced by JHS participants. Self report of the 
number of primary care visits has been shown to be fairly reliable measure of the level utilization. In 
addition to asking about problems getting care the participant is asked about whether he or she/ as 
gone without care, the type of care foregone, and confidence with getting high quality care. The 
inclusion of these measures of realized health care access will allow analyses of the relationship 
between primary care use, health insurance status, and health status [8,9]. 
 
The relationship of the JHS participant and health care providers is an important aspect of health 
care access. Being listened to and respected, having thing explained, and having the provider 
spend enough time with a person are important aspects of these relationships which can have an 
impact on a person’s perception of how they are treated by health care professionals as well as 
trust and satisfaction with health care. These attitudes can also influence JHS participants’ 
willingness to access the health care system [10].  
 
Hypotheses that can be examined with these health care access measures include: 
 
• Health insurance status (including instability in coverage) will be associated with the use of 

primary care services, prevalence of having unmet health care needs, satisfaction with care, 
confidence with getting care, prevalence of symptoms indicating angina or heart failure 
exacerbation, and level of stress and anxiety. 

 
• Prescription medication coverage status will be associated with the use of medications to treat 

chest pain and heart failure and OOP expenditures for prescription medications. 
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• Out of pocket expenditures for prescription medications will be associated with use of 

medications to treat chest pain and heart failure.  
 
• Interactions with health care providers will be associated with use of and satisfaction with 

health care. 
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8.4.2.3  Updating Contact Information 
 
Tracing information listed on the computer-generated Participant Contact Information Sheet is 
verified at the conclusion of the AFU form using the CON form (see Forms Appendix).  Instructions 
for administering the form and a prototype script are provided at the end of the annual follow-up 
instructions.  Any changes to tracing information recorded on the paper form during the telephone 
interview are recorded on the computerized version of the CON form by staff certified in the use of 
the JHS Data Entry System.  Prior to making any changes in the DMS, a hard copy of the current 
version is printed, dated, and placed in the participant file for future reference. 
 
8.4.2.4 Tracing Participants Unable to Contact  
 
Participants found to have moved or who are otherwise lost to follow-up are traced using the tracing 
information obtained at baseline exam and during subsequent annual follow-up contacts or other 
local sources of information, such as the telephone directory, city directory, etc.  By using the 
Contact Form, Examination Center staff can call or write to the family members, friends, employers, 
or physicians the participants identified as contact persons during previous interviews.  By using 
Social Security numbers, periodic searches of the National Death Index are done.  Every attempt is 
made to schedule and complete an AFU interview for each participant. 
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8.4.2.5 Informed Consent Tracking 
 
See Informed Consent Tracking, section 3.3 
 
9.0 SURVEILLANCE / EVENTS ASCERTAINMENT 
 
See Manual 4, Cohort Surveillance/Events Ascertainment Component Procedures for a complete 
review of the procedures and protocol associated with cohort surveillance and events 
ascertainment.  
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Appendices 
 

 
APPENDIX 1 RETENTION OF PARTICIPANTS FOR EXAM 2 
Appendix 1.1 Prototype Participant Letter: Cohort Notification of Exam 2 

Appendix 1.2 Prototype Participant Letter: Notification of Upcoming Annual Follow Up Interview 

and Exam 2 Scheduling Call 

Appendix 1.3 JHS Information / Consent Brochure 

Appendix 1.4 Prototype Participant Letter: Refusal Conversion 

Appendix 1.5 Prototype Employer Letter: Request for Release from Work 

Appendix 1.6 Prototype Employer Letter: Institutional Heads Request for Collaboration with JHS 

to Release from Work 

Appendix 1.7 Prototype Health Care Provider Letter: Request for Continued Collaboration / 

Support of JHS Participation 

Appendix 1.8 Certificate of JHS Membership  

Appendix 1.9 Prototype Participant Birthday Card 

Appendix 1.10 Prototype Participant Holiday Card / Calendar 

Appendix 1.11 Prototype Condolences Letter 

Appendix 1.12 Prototype JHS Participant Newsletter 

Appendix 1.13 Prototype Annual Family Reunion and Birthday Celebration 

Appendix 1.14 Prototype JHS Participant Web-based access 

 

APPENDIX 2 EXAM 2 DESIGN, LOGISTICS, TRAINING, AND QUALITY CONTROL 
Appendix 2.1 Standardized Interview Techniques  

Appendix 2.2 Instructions for Completing Paper Forms  

 

APPENDIX 3 INTERVIEWS IN EXAM 2 
Appendix 3.1 Consent Form 

 

APPENDIX 4 PROCEDURES IN EXAM 2 
Appendix 4.1 Tanita TNF 300A Manual  

Appendix 4.2 Cholestech LDX Manual    

Appendix 4.3 Anthropometry Equipment Calibration Log 

Appendix 4.4 Cholestech Optics Check Log/ Cassette Quality Control Log 

Appendix 4.5 Checklist for Anthropometry Measurement 

Appendix 4.6 Checklist for Height Measurement 

Appendix 4.7 Checklist for Weight Measurement 

Appendix 4.8 Checklist for Maximal Waist Measurement 
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Appendix 4.9 Checklist for Maximal Hip Circumference Measurement 

Appendix 4.10 Report on Use of Observation and Equipment Checklists 

 

APPENDIX 5 MEDICAL DATA REVIEW 
Appendix 5.1 Prototype Medical Data Review Print Out and Information Sheet  

Appendix 5.2 Tanita Patient Education Handout  

Appendix 5.3 Cholestech Patient Education Handout 

 
APPENDIX 6 REFERRAL AND RESULTS REPORT 
Appendix 6.1 Prototype Health Care Provider Results Reporting Letter: Health Care Provider 

Designated 

Appendix 6.2 Prototype Health Care Provider Results Reporting / Referral Letter: No Health Care 

Provider Designated 

Appendix 6.3 JHS Alerts and Referrals Procedures 

Appendix 6.4 JHS Resource Manual 
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APPENDIX 1 RETENTION OF PARTICIPANTS FOR EXAM 2 
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Appendix 1.1 Prototype Participant Letter: Cohort Notification of Exam 2 

 
(The mailing envelope for this letter will include one of the following statements: 

 
 Help us fight heart disease! 
 Thanks….we need your help again! 

 
 
[DATE] 
 
[NAME] 
[ADDRESS] 
[ADDRESS] 
 
Dear [Mr. Ms. Name] 
 
I would like to share some exciting news with you. The Jackson Heart Study (JHS), the medical 
research project in which you are participating. is celebrating  continuation for the next 8 years! 
You may have seen me in the recent news making this wonderful announcement. On behalf of the 
JHS staff, and the many people who benefit from the knowledge gained as a result of your 
continued participation, I want to thank you for being a loyal participant. As a member of this 
ongoing study, you contribute valuable information in our search for causes and prevention of heart 
disease in African Americans. Without dedicated people like you, this would not be possible. 

Between 2000-2004, you completed your first JHS clinical examination. We are pleased to invite 
you for your second visit approximately five years after the time of your first exam. Your expected 
return visit will be the week of [DATE}. This second visit will be much shorter than the first (only 
about 2 hours) and will include some special teaching about taking your own blood pressure at 
home. You will receive your own personal home blood pressure monitor, and a $25 check or 
equivalent gift (your choice) in appreciation for your time..  
Please, choose one of the following options for scheduling your second clinic visit: 

• Call the office at 601-815-5050 or 1-866-680-0660 

• Access our web-based scheduling system at www.jsums.edu/~jhs/  and sign in with your 
personal JHS identification number, JXXXXXX. 

• Allow your JHS interviewer to schedule your appointment when she calls to conduct your 
annual follow-up interview. 

We thank you for your continued participation in the Jackson Heart Study. 
 
Sincerely, 
 
 
 
 
Herman A. Taylor, MD, MPH,   Sonja R. Fuqua, PhD, RN 
Principal Investigator    Director of Retention  
 
 

 

http://www.jsums.edu/
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Appendix 1.2  Prototype Participant Letter: Notification of Upcoming Annual Follow Up 

Interview and Exam 2 Scheduling Call 
 
 

 
 
 
[DATE] 
 
[NAME] 
[ADDRESS] 
[ADDRESS] 
 
Dear [Mr. Ms. Name] 
 
It has been almost a year since the Jackson Heart Study (JHS), the medical research project 
in which you are participating, conducted your annual follow-up telephone interview. As in 
the past, a JHS interviewer will be calling to gather information about your health status 
over the past year. If you have had any hospitalizations or illnesses during the past year, 
please gather information regarding the date and type of illness or hospitalization so it is 
available when the JHS interviewer calls.  The interview will take about 15 minutes. 
This year, we are pleased to invite you to your second clinic examination. It has been 
almost 5 years since your first exam, and we are excited about the new tests that we believe 
you will find both interesting and useful. You will be taught to take your blood pressure 
and will receive a blood pressure monitor for your personal use. You will also receive a 
$25 check or equivalent gift (your choice) in appreciation for your time. The exam will be 
much shorter—taking no more than 2 hours. Upon completing your interview, the 
interviewer will schedule an appointment. Please have your calendar ready to select a 
convenient day and time for your visit. 

MAKEABA an interviewer will call you in the near future or you may telephone the 
JHS office at 601- 368-4618 or 1-866-680-0660 to set an appointment for your interview 
and second clinic examination. Your identification number is JXXXXXX, please have it 
available when you call. 
We thank you for your continued participation in the Jackson Heart Study. 
 

Sincerely, 
 
 
 
 
Sonja R. Fuqua, PhD, RN 
Director of Retention 
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Appendix 1.3 JHS Information Brochure / Consent 
 
 
 
 
INSERT WHEN COMPLETED
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Appendix 1.4 Prototype Participant Letter: Refusal Conversion 
 
 
 
 
 
 
[DATE] 
 
[NAME] 
[ADDRESS] 
[ADDRESS] 
 
Dear [Mr. Ms. Name] 
 
Recently, you indicated that you did not want to participate in the 
current Jackson Heart Study (JHS) examination. I appreciate all the 
time you have already given us both on the phone and in the JHS 
clinic. On behalf of all the JHS staff and investigators, and all the 
people who benefit from the knowledge gained as a result of your 
participation thus far, I want to thank you for being a loyal participant. 
As a member of this ongoing study you contribute valuable 
information in our search for causes and prevention of heart disease 
in African Americans, but we know that it is only possible because 
you have been willing to sacrifice some of your time and tell us about 
yourself. 
Thank you again, and should you reconsider, we would be more than 
happy to hear from you. If your schedule permits, we can offer to 
come to your home to conduct the interviews and brief physical 
examination. As you know, we are also including instruction on how 
to take your own blood pressure and a home blood pressure monitor 
will be given to you. This should take no more than 90 minutes of 
your time, at most. 
Again, we are sad to lose you after so many years. If you should 
change your mind, please call me at 601.815.5050 or access our 
web-based scheduling system at www.jsums.edu/~jhs/  and sign in 
with your personal JHS identification number, JXXXXXX. Any time 
you give us will be of great benefit to the study and the people whose 
health may be improved as a result of JHS findings. 
With best regards, 
 
Herman Taylor MD, MPH    Mary Crump RN, MSN 
  
Director and Principal Investigator  Clinic Manager  
  

 

http://www.jsums.edu/
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Appendix 1.5 Prototype Employer Letter: Request for Release from Work 
 

 

DATE 

EMPLOYER NAME 

ADDRESS 

 

 

Dear Employer: 
 
Your employee, [NAME], is a participant in an important medical research project 
called the Jackson Heart Study (JHS).  This project is sponsored by the National 
Heart, Lung, and Blood Institute in the Jackson Metropolitan area.  It is being 
conducted by Jackson State University, Tougaloo College and the University of 
Mississippi Medical Center.  The purpose of the study is to better understand 
characteristics which may predispose African-Americans to heart or blood vessel 
diseases. 
 
The JHS requires a two examination now and in three to four years to collect the 
medical information.  We hope you will allow your employee time off to complete 
this examination—hopefully without having to take personal or vacation time to do 
this.  Her/his participation is important to the study.  If you have any further 
questions you may call me at [telephone number]. 
 
Thank you. 
 
 
Sincerely, 
 
 
 
 
Herman A. Taylor, Jr. MD, MPH 
Principal Investigator 
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Appendix 1.6 Prototype Employer Letter: Request for Collaboration with JHS to Release 
from Work 

 

 
Date 
 
Business Leader/Employer Name 
Business Leader/Employer Address 
 
 
 
Dear NAME BUSINESS LEADER/EMPLOYER: 
 
I would like to extend my thanks and appreciation for your continued support of the 
Jackson Heart Study (JHS).  As a business leader in Hinds, Madison and/or 
Rankin Counties, your advocacy in and support of the Study remains critical.    

 
Cardiovascular disease is still the number one killer of African Americans in 
Mississippi and the nation.  The JHS is the first large scale epidemiologic 
observational study on African Americans and heart disease.  Between September 
2000 and March 2004, the JHS recruited over 5,300 participants aged 21 and over.  
During this time, the business community demonstrated support by allowing 
potential participants time off without having to use company personal leave or 
vacation time.  A collaborative effort with the business leadership will again allow 
maximization of our efforts to reach participants.   JHS’s 2nd exam cycle will occur 
over a period from September 2005  through September 2008, during which time 
each participant will undergo one brief exam.   By allowing your employees time off 
for their exams, once again you are providing support needed to achieve our 
research goals. 

 
We look forward to your continued support and involvement with the JHS.  Should 
you need to talk with me or require further information, I can be reached at (601) 
368-4650.  Thank you for your continued support of the JHS. 
 
Regards,  
 
 
Herman A. Taylor, MD, MPH, FACC 
Director/Principal Investigator 
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Appendix 1.7 Prototype Health Care Provider Letter: Request for Continued Collaboration / 
Support of JHS Participation 

 

Date 
 
Health Care Provider Name 
Health Care Provider Address 
 
 
 
Dear NAME HEALTH CARE PROVIDER 
 
I would like to extend my thanks and appreciation for your continued support of the 
Jackson Heart Study (JHS).  As a health care provider in Hinds, Madison and/or 
Rankin Counties, your advocacy in and support of the Study remains critical.    

 
Cardiovascular disease is still the number one killer of African Americans in 
Mississippi and the nation.  The JHS is the first large scale epidemiologic 
observational study on African Americans and heart disease.  Between September 
2000 and March 2004, the JHS recruited over 5,300 participants aged 21 and 
older.  During this time, the health care provider community demonstrated support 
by distributing study information and discussing the importance of research 
participation with their patients.  A collaborative effort with the health care providers 
will again allow us to maximize our efforts in reaching participants, as well as allow 
us to offer health care resources when needs are identified.   JHS will begin the 2nd 
exam cycle in September 2005 and it will continue through September 2008.   By 
continuing to support this important research investigating the high rates of heart 
disease in our community, you significantly contribute to the cardiovascular health 
of all African-Americans. 

 
We look forward to your continued support and involvement with the JHS.  Should 
you need to talk with me or require further information, I can be reached at (601) 
368-4650.  Thank you for your continued support of the JHS. 
 
Regards,  
 
 
Herman A. Taylor, MD, MPH, FACC 
Director/Principal Investigator 
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Appendix 1.8 Certificate of JHS Membership 
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Appendix 1.9 Prototype Participant Birthday Card 
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Appendix 1.10 Prototype Participant Holiday Card / Calendar 
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Appendix 1.11 Prototype Condolences Letter 
 

DATE 

 

 

NAME [Family Member of Deceased JHS Participant] 

ADDRESS 

 

Dear NAME [Family Member of Deceased JHS Participant} 

 

On behalf of the Jackson Heart Study family of participants, staff, and researchers, 

I wanted to express my deepest sympathy on the death of [Name – JHS 

Participant]. No words can do justice to the profound sadness that we share with 

you in this time of loss. We are grateful that [name-participant] was part of the 

Jackson Heart Study. Please know that by [her/his] participation in the Jackson 

Heart Study, [s/he] will continue to leave a Legacy of Health for African Americans 

through [her/his] contribution to understanding and reducing the heavy burden of 

heart disease in African Americans.  

 

Our thoughts and prayers are with you and your family. 

 

 

Sincerely, 

 

 

 

Herman A. Taylor, Jr. MD, MPH 

Principal Investigator 
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Appendix 1.12 Prototype JHS Participant Newsletter 
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Appendix 1.13 Prototype Annual Family Reunion and Birthday Celebration 
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Appendix 1.14 Prototype JHS Participant Web-based access 
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APPENDIX 2 EXAM 2 DESIGN, LOGISTICS, TRAINING, AND QUALITY CONTROL 
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Appendix 2.1 Standardized Interview Techniques  
 
 
I. Overview of Interviewing 

A. Interviewer bias – includes anything that creates a systematic difference between 
responses obtained by different interviewers 

1 Respondent's perception of the interviewer and his/her reaction to that. 

2 Interviewer's perception of the respondent and his/her reaction to that. 

B. Characteristics of a good interview 

There is an appropriate atmosphere 

- friendly, but businesslike 

1. The respondent is at ease 

- female interviewers may be perceived as less threatening 
- ensure confidentiality of participant 
- someone much older than respondent may be viewed as more judgmental 
- space for interviewing is appropriate, quiet, friendly 

2. The interviewer obtains the answer to the question that is asked 

- proper use of probes 
- repeats question, rather than interpreting it 

3. Clarification is obtained for confusing answers 

4. The interviewer gives only neutral responses to the respondent’s answers 

5. The response is recorded accurately 
 
C. Specific skills required for interviewers 

1. Be able to ask questions at the correct pace and in a conversational tone 

2. Know the questions and response categories well enough to keep the interview flowing 
smoothly 

3. Know when there are probes that can be used, and know how to use them 

4. Be able to think as an interviewer, and put aside other roles (researcher, and health care 
provider, etc.) for the time being 

5. Be able to maintain a positive attitude about the interview so that respondent feels that the 
interview is important 

6. Be able to keep some level of control over the interview process, e.g. by rewarding the 
respondent for answering questions, and not for other behavior 
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7. Neat, pleasant, professional dress; not too timid, not too aggressive 
 
II. Administration of Interviewing 

B. Administration of work 

1. Supervisor 

a. One supervisor for each ten interviewers 

b. Importance of prompt review of work, and quick feedback 

c. Face-to-face conference with each interviewer once a week 

2. Other considerations 

a. Good pay and working conditions help keep up morale 

3. Tracking procedures 

a. Response rate, overall and by interviewer 

b. Reasons for non-response 

c. Length of interview, overall and by interviewer 

B. Interviewer training 

1. Must cover all aspects of the interview 

a. Introducing yourself 

b. Handling people who are reluctant 

c. Following instructions for administration of interview form 

d. Obtaining consent 

e. Answering consent 

f. Obtaining privacy for the interview 

g. Setting respondent at ease 

h. Administering the interview 

i. Ending the interview 

j. Importance of role playing, using both standard and problematic situations 

k. Discuss problems that arose 
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C. Quality control of field work 

1. Observation 

a. Supervisor going with interviewer 

b. Tape recording 

c. Monitoring telephone interview 

2. Editing 

a. Field editing 

b. Editing by supervisor – edit first few interviews, if no problems then only need edit a 
sample of remaining interviews 

3. Validation 

a. That interview was done – by re-interview, telephone call, or sending a letter 

D. Ways to reduce the standard errors from interview effects by 10% for at least the 
one-third of items most affected by interviewers  (Source:  Fowler FJ, Mangione TW) 

1. Increase effective sample size by about 20% (if simple random sample) 

2. If interviewers receive less than 1 day of basic training, increase by a day or two 

3. Tape all or a sample of interviews;  review one a week per interviewer, provide 
feedback 

4. Rewrite questions to reduce the need for probing and make administration and 
reading of questions easier 

5. Reduce the number of interviews per interviewer by 20% by using 20% more 
interviewers 

 
Reference 
 
Fowler FJ, Mangione TW.  Reducing Interviewer effects on health survey data – Executive 
Summary.  Center for Survey Research – Univ. of Massachusetts/Boston.  Report No. NCHSR 86-
8.  U.S. Department of Health and Human Services. 
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Appendix 5.3 Jackson Heart Study Interviewer Techniques 
 
 

1. Standardized Interviewing Techniques 
 
The Jackson Heart Study is a single site study being conducted in the Jackson Mississippi area, 
with African-American persons aged 35-84.  The aim is to produce a study that represents 6,500 
people throughout the Jackson area in Madison, Rankin and Hinds counties. 

In order to produce valid and reliable data, the study designers must pay attention to the training 
and the methods in which the data are collected.  Thus, a standardized approach to interviewing 
and the training of interviewers is necessary.  The study is standardized through the use of scripts 
in training, centralized training of supervisors, setting of qualifications for supervisors, reviewing of 
data that is collected, listening to tapes that are produced at interviews, and finally observing the 
interviewer in the field. 

Scripts are used to teach you techniques in probing as well to determine how well you are following 
skip patterns in the forms and adhering to the various aspects of protocol.  Scripts are specifically 
used in the Rose Questionnaire.  All of your interviews will be taped and you will gain knowledge 
about how to do this talking with experienced interviewers who are systematically reviewed by your 
supervisor to determine that you are asking the questions as written and are not leading the study 
respondent or providing answers for them.  You will occasionally be observed through monitoring 
visits. 

The study is further standardized in centralizing training for supervisors and where possible for the 
interviewers.  The study initially will train local interviewer supervisors who will be responsible for 
training on site as the need for new personnel is required.   

 
2. Dealing with the Sample Population 
 

The sample members for Jackson Heart Study will include a variety of persons who, generally, will 
have characteristics similar to those encountered with any household survey.  Some of the 
situations you may encounter at the household, along with suggestions for dealing with them 
appropriately, follow: 

1. Fear of Being Victimized – Some of your respondents may refuse to participate in a survey 
because they are afraid of being victimized in some way.  It is your responsibility to assure 
the sample member of the legitimacy of your call/visit and intentions and to make the 
respondent feel secure.  Your identification badge and letter will aid you in reassuring the 
respondent. 

2. Handicaps – If a sample member seems to have a handicap that will interfere with proper 
completion of the interview, would cause undue stress for the sample member, or prevent 
the sample member from completing the clinic/examination, do not attempt to complete the 
interview with her/him.  Determine if there is a person available who is knowledgeable 
about the sample member’s health and tactfully obtain information which will help 
determine if the sample member should be excluded from the study.  If such a person does 
not exist, thank the sample member for his/her time and terminate the interview.  Code the 
result appropriately and provide explanatory notes so that your supervisor can evaluate the 
case. 

3. Difficulty Understanding Questions – Some of your respondents may have difficulty in 
comprehending the questions slowly and allow the respondent adequate time to respond.  
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Repeat the question, if necessary.  (Unless specifically allowed by the specifications, do not 
define and explain, which may result in obtaining a biased response.) 

4. Tendency to Stray from the Topic – Some respondents will welcome the opportunity to talk 
with someone who is neutral about their health problems.  Attempts to explain their 
problems or vent their feelings may cause them to stray from the questions being asked.  
You must be careful to control the interview situation, while not alienating the respondent. 

5. Tendency to Respond in a Socially Desirable Manner – Some of the respondents will rely 
on you to help with a response or offer responses that they think are what you or the 
government would like to hear rather than expressing their knowledge or opinion about a 
given subject.  Keep in mind that we are trying to gather objective data on the sample 
members’ health.  Reassure sample members that there are no right or wrong answers to 
the questions and encourage them to respond according to their experience and 
knowledge. 

 
3. Interviewing Guidelines 
 

The survey response rate and the quality of the data collected depend on how well you handle 
various interview situations.  Every interview situation will be different, and it is impossible to 
enumerate every possible situation that you might encounter and suggest ways for handling those 
situations.  There are, however, some basic guidelines presented in this section that, if followed, will 
assist in obtaining a sample member’s participation in the survey and obtain accurate data. 

 

4. Contacting the Respondent 
 

• Official Notification:  Jackson Heart Study staff will have notified appropriate law 
enforcement personnel, post offices and community leaders of the study.  If 
interviewer/recruiters are questioned in the field, show their ID badge (which should always 
be worn in the field) and other identifying information. 

• Leaving Messages:  Interviewer/recruiters will leave door hangers along with business 
cards.  This will provide an opportunity for someone in the household to directly contact the 
Interviewer/recruiter or Jackson Heart Study center staff to schedule an appointment. 

• Interviewing People You Know:  Interviewer/recruiters are not allowed to conduct 
interviews with friends, relatives or acquaintances.  If the Interviewer/recruiter discovers 
that the respondent is someone s/he knows, inform her/him of the Jackson Heart Study 
policy and record on HEF form.  Jackson Heart Study wants to be able to ensure 
confidentiality to all respondents and to maintain a professional relationship in the interview 
setting. 

• Your Introduction:  Initial contacts with sample members will be made in person (or by the 
printed Jackson Heart Study door hanger).  When you meet with a sample member, read 
the introduction as it is printed.  The focus of the introduction is to identify the 
Interviewer/recruiter, the organization you represent and the purpose of your visit.  Attitude:  
Approach each respondent with a positive, self-assured and matter-of-fact manner.  
Friendliness, not familiarity, is an asset. 

 
5. Obtaining Participation 
 
You will be provided with the following materials to motivate sample members to participate in the 
study: 
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• Introductory letter, 

• Study brochure, and 

• Copies of local newspaper clippings and endorsements. 
 
You may, however, encounter questions about the survey or objections to participation.  A list of 
possible questions and suggested answers appear below. 

 
 

6. Commonly Asked Questions 
 

A. “Will I have to take any drugs and/or medications?”  Explain to the respondent that 
there will be no drugs or medication administered during the clinic visit -- only related 
tests, such as EKG, Lab test, Physical Examination. 

 
B. “How often and how long are the clinic visits?”  Explain clinic visits are (1) once 

every three years, (2) clinic visit will last approx. 2-4 hours. 
 

C. “What type of tests will be administered?”  Name all tests that will be administered. 
 

D. “Will transportation be provided?”  Transportation will be provided as needed. 
 

E.  “Are child accommodations provided?”  Yes. 
 

F.  “How do I know you and the survey are legitimate?”  Repeat your introduction and 
give the respondent the introductory letter and brochure.  Suggest that the respondent 
call the number on the brochure for information and verification.  Also point out that the 
local health officials are aware of the survey and show the sample member local 
newspaper clippings and endorsements.  Above all else, always wear your picture ID 
badge in the field and have it visible. 

 
G. “What’s this survey about?”  Explain that we are interviewing approximately 5,300 

participants in the Jackson Heart Study who live in 3 counties in the state of 
Mississippi, Hinds, Madison and Rankin, to collect data about their health.  The data 
collected will help the National Institutes of Health, and local area health professionals 
to understand better, the factors associated with heart disease. 

 
H. “I don’t want to buy anything!”  “We are not selling anything.  We are doing an 

important research study for the National Heart, Lung and Blood Institute.” 
 

I. “Why interview me?”  “Researchers used scientific sampling procedures to select a 
random sample of the people in your community.  It is important that you participate 
because we can’t replace you with someone else if you don’t.” 

 
J. “Who’s paying for this study?”  The National Heart, Lung and Blood Institute is 

sponsoring the study. 
 

K. “I’m too busy”  “Then let’s make an appointment for some other time that is more 
convenient for you.  We can make the appointment now.”  Note:  If the participant does 
not make an appointment then and request for you to call back, tell them you can call 
back tomorrow morning, afternoon, or evening.  “Which would you prefer?” 

 
L. “My answers won’t be of any help.”  Explain that there are no right or wrong answers 

and their opinions and experiences will be helpful to the study. 
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M. “I don’t want everybody to know my personal information.”  Advise that “Your 

answers will be kept fully confidential.  The information that you give us will be 
analyzed statistically, and there will be no way that your name will be connected with 
your answers.  Your name, address, and phone number will be separated from your 
answers, and all identifying information will be destroyed when the study results are 
reported.  Your answers will not be given to your doctor or anyone else responsible for  
your health care without your permission and will not, in any way, affect the care you 
receive from them.” 

 
N. “I can’t help you because I never had heart problems.”  Explain that you still need 

to talk to them about their health and that the study is based on selecting people from 
the general population, most of whom will not have heart problems.  Also, explain that if 
a question is asked for which they don’t know the answer, they can simply say “don’t 
know” and you will move on to the next applicable question. 

 
O. “Will this affect my medical care?”  Assure the sample member that participation in 

this study will not affect any medical care s/he now receives or might receive in the 
future.  Also, explain that participation in the survey is voluntary and that all data 
collected will be kept fully confidential. 

 
P. “My doctor may not want me to be in the study.”  Inform the sample member that 

area physicians are in support of Jackson Heart Study and show her/him copies of 
local endorsements.  Suggest that the sample member complete the home interview, 
and if s/he still feels uncomfortable about the clinic examination, s/he may contact 
his/her physician to discuss the study. 

 
Q. “What do I get out of the study?”  “There are several things that you will get from the 

study.  You will receive free of charge a medical examination and a free home blood 
pressure cuff with instructions on its use.  You may find out that you have a medical 
condition you have been unaware of and you will be able to get treatment from your 
personal physician for it earlier.  You will also have an opportunity to participate in one 
of the most important health studies ever conducted.  Legacy of Health.” 

 
R. “How long will this take?”  The telephone call today will take about 15-20 minutes, 

depending on your answers.  Let me start and I’ll move through the interview as quickly 
as I can” (Immediately ask the first question). 

 
S. Request for information that you are unable to provide.  If you are unable to 

answer a sample member’s question about the study, advise her/him that you will talk 
to your supervisor to get the needed information, and that you will be back in touch in a 
day or so.  Then talk to your supervisor as soon as possible. 

 
T. “What will the clinic visit involve?”  If this question is asked during annual follow up 

call, provide the respondent with a brief explanation, such as:  “The clinic visit will 
involve a physical examination by highly trained clinic staff using modern equipment 
and an interview.”  If this question is asked later during the visit, interviewer/recruiters 
will review the Jackson Heart Study brochure with the respondent.  The Jackson Heart 
Study brochure will consist of the clinic scheduled activities and a brief description of 
the major tests that will be conduced at the clinic. 

 
U. “Will I get results of my test?”  “Any abnormal findings will be made known to you, as 

well as either complete results or a summary of results of important tests.  For 
example, we will provide the actual blood pressure values, blood cholesterol and 
fasting blood sugar results, and many more.  Your lab results will be given to your 
primary physician also.” 
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V. “Where did you get my name or why have you come to my house.”  You are 

already identified as a participant in the JHS and came to the clinic approximately 4 
years ago.  

 
W. “I would like to participate but I can’t take that much time off work.”  Tell the 

respondent that the Jackson Heart Study project has received extensive community 
support and that Jackson Heart Study staff will be happy to send a letter to the 
employer requesting time off (see attached letter).  Be sure to note that the respondent 
has requested this letter and inform your supervisor as soon as possible. 

 
X. “I heard you can get AIDS from blood tests.”  Explain that the clinic uses only 

sealed, disposable needles and that only a finger stick will be done in Exam 2.  The 
needles will not be “shared”; therefore there is not a known risk for AIDS from blood 
drawing. 

 
Y. “I don’t like the idea of blood tests.”  “I don’t like to have my blood drawn.  The clinic 

staff is very well trained and performs finger sticks with a minimum of discomfort.  The 
blood tests are one of the most important parts of the Jackson Heart Study and are 
needed to compare with your other study results.” 

 
NOTE: If the respondent refused to have blood drawn, consider that a refusal for the clinic 
appointment.  Try, however, to obtain a home interview without scheduling the 
appointment. 

 
Z. “I just told you the answer to that question.”  “I’m sorry I repeated the question.  I 

don’t want to rely on my memory to record your information correctly.”  Note that this 
can be avoided if you realize the respondent has answered the question by a lead-in 
such as “I know this sounds repetitive but could you tell me…” or “You may have told 
me this before but just to make sure I have it right…” 

 
The important point to remember when answering questions or overcoming objections is to try 
not to alienate the respondent.  If you feel that you are unsuccessful in countering the 
respondent’s objections, politely thank her/him for his/her time and terminate the interview.  Try 
to “leave the door open” for someone else to talk to the sample member and encourage 
her/him to participate. 

 
7. Conducting the Interview 
 
The interviewer must help the respondent to feel at ease and comfortable with the interview.  
During the initial contact and throughout the interview, you should: 

• Maintain a positive attitude. 

• Repeat that any information the respondent gives you will be kept confidential if s/he 
appears to be apprehensive about providing information, 

• Maintain control of the interview. 

• Assume a nonjudgmental, noncommittal, neutral approach to the respondent and the 
subject matter, so that the sample member will feel comfortable answering the 
questions truthfully. 

 
The process of asking the questions, probing, and recording responses correctly is crucial to 
obtaining usable, high-quality data.  The standard practices listed below must be followed. 
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8. Asking the Questions  

• Ask the questions using the exact words printed in the questionnaire. 

• Ask the questions in the exact sequence in which they appear or as instructed.  Whenever 
you are not to ask questions in sequence, a skip instruction will appear beside the 
response categories for the question asked.  (Skip routing instructions are discussed in 
more detail later in this chapter.) 

• Ask every question specified even when a respondent has seemingly provided the answer 
to the question when another question was asked.  The answer received in the context of 
one question may not be the same answer that will be received when the other question is 
asked. 

• If the answer to a question indicates that the respondent did not understand the intent of 
the question, repeat the question. 

• Read the questions at a moderate speed, preferably at a pace of about two words per 
second. 

• Avoid suggesting answers to the respondent.  As noted elsewhere in this manual, the 
sample members may rely on you to help with an answer to a question.  As the interviewer, 
your job is to ask the questions, make sure the respondent understands the questions, and 
then record his/her responses.  Do not assist the respondent in selecting responses. 

• Read transition statements just as they are printed in the questionnaire.  Transition 
statements are designed to inform the respondent of the nature of a question or a series of 
questions, to define a word, or to describe what is being asked for in the question. 

• Sensitive questions should be asked in a neutral manner, which should not differ from the 
normal professional flow of the interview.  The respondent may be more comfortable if you 
avoid eye contact when asking sensitive questions. 

• Read questions in a natural tone, following the punctuation in the question.  Only 
emphasize words that are underlined or appear in bold.  When response categories are to 
be read, put a brief pause between the options so the participant knows what the choices 
are. 

• Do not show the questionnaire to the respondent.  You do not want the respondent to see 
the questions and response categories of the questionnaire.  For this reason, you will want 
to arrange the seating so that you are sitting across from the respondent.  When it is 
appropriate for the respondent to see the response categories to a question, the 
questionnaire will instruct you to guide the respondent to look at a designated RESPONSE 
CARD. 

 
9. Probing 
 
You will be required at times to probe to obtain a more complete or more specific answer from a 
respondent.  Chapters 3 and 4 provide explanation of the questions you will ask.  When you know 
the objective of a question, you will be able to judge whether a response is adequate or inadequate.  
In order to elicit complete, adequate answers, you often will need to use an appropriate neutral or 
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non-directive probe.  The important thing to remember when probing is that you must not suggest 
answers or lead the respondent.  General rules for probing follow. 

• Use neutral questions or statements to encourage a respondent to elaborate on an 
inadequate response.  Examples of neutral probes are “What do you mean?”, “How do 
you mean?”, “Tell me what you have in mind.”, “Tell me more about…”. 

• The silent probe, which is pausing or hesitating to indicate to the respondent that you 
need more or better information, is a good probe to use after you have determined the 
respondent’s response pattern. 

• Clarification probes should be used when the response is unclear, ambiguous or 
contradictory.  Be careful not to appear to challenge the respondent when clarifying a 
statement and always use a neutral probe. 

• Repeat the question if the respondent misunderstood or misinterpreted the question.  
After hearing the question the second time, the respondent will likely understand what 
information is expected. 

• Unless you have been provided with a response code of “Don’t know”, the “I don’t 
know” response almost always requires a probe since this response can mean one of 
several things: 

- The respondent doesn’t understand the question and says “Don’t know” to  avoid 
saying s/he doesn’t understand; 

- The respondent is thinking the question over and says “Don’t know” to fill the 
silence and gain time to think;   

- The respondent may be trying to evade the issue because s/he feels uninformed, is 
afraid of giving a wrong answer or the question seems too personal; or, the 
respondent may really not know. 

 
Some of the questions in the Jackson Heart Study ask about recall of events over time.  You may 
assist the respondent without violating probing rules by working with her/him on math or pinpointing 
dates or events (such as age a parent was diagnosed with a specific disease).  Another way to help 
pinpoint more accurate information is to ask respondent to think about time of year or season when 
an event occurred. 

 
 

10. Recording Responses 
 

Most of the questions in the Jackson Heart Study instruments have precoded responses.  There 
are a few questions, however, that are open-ended – that is, you must write in a response to the 
question.  Some questions have pre-coded responses as well as an “Other (Specify)” category.  If 
the respondent’s answer does not fit into a pre-coded answer, you must specify the response.  The 
recording practices below must be followed at all times to assure that the response recorded 
accurately reflects the respondents’ answers and to assure that questionnaire data can be 
converted to machine-readable form.  Detailed Instructions for Completing Paper Forms may be 
found in Appendix 10. 

 

11. Instrument Conventions 
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Certain conventions are used consistently in the Jackson Heart Study instruments.  Familiarity with 
these conventions will help you use the instruments with ease and confidence. 

 

12. Instructions to the Interviewer 
 
Your instructions are always in CAPITAL LETTERS, and they are not to be read to the 

respondent.  Often, your instructions are also in brackets.  For example: 
 

37. Have you ever smoked a pipe regularly?  
[CODE “NO” IF LESS THAN 12 OZ. IN A 
LIFETIME] ………………………………………………………Yes Y 

  
 No N 

 
 
 

Instructions to interviewers may also appear in boxes.  Boxed material in capital letters are 
interviewer instructions.  Other statements which are in boxes but are not capitalized are to be read 
to the respondent.  An example of each type of boxed statement appears below. 

 
Did your natural father ever have or does he now have any of the following 

diseases?  [READ EACH RESPONSE CATEGORY] 
 

26a. Cancer? ………………………………………………… Yes  Y 
 
  No  N 
 
  Don’t know  D 
 
 
 
 26b.   Diabetes? (sugar in the blood) ………….. Yes  Y 
 
   No  N 
 
   Don’t know  D 
 
 
 
 26c. High blood pressure or 
  hypertension (high blood)? ………………. Yes  Y 
 
   No  N 
 

Go to Item 44 
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   Don’t know  D 
 
 
 
 26d. Stroke? ……………………………………….. Yes  Y 
 
   No  N 
 
   Don’t know  D 
 
 
 
 26e. Heart attack? ……………………………….. Yes  Y 
 
   No  N 
 
   Don’t know  D 

 
 
 
 
 
 
 
 
 
 

The first box consists of an interviewer instruction; the second of a lead-in statement which 
is to be read to the respondent. 

 
 

13. Questions 
 

Questions are printed in upper and lower case type.  Answer choices and codes are printed below 
the question.  Answer choices are never read to the respondent unless they are included in the 
body of the question or unless you are instructed to do so.  In Example 1 below, the answer choices 
are not read to the respondent; In Examples 2 and 3, they are read because they are included in 
the question or because you are instructed to do so. 

 

EXAMPLE 1 
 

14. What was the cause of your natural 
        mother’s death? …………………………………… Cancer C 
 
 Heart attack A 
 

If “No” or “Don’t Know”, Go to Item 28 

I would like to ask you a few questions about your parents’ health. 
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 Stroke S 
  
 Unknown U 
 
 Other (Specify) O 
 
 
Specify:   
 
 
 
 
EXAMPLE 2 
 

1. Compared to other people your age, would  
 you say that your health is excellent,  

good, fair, or poor? …………………………………………. Excellent E 
 
 Good G 
 
 Fair F 
 

 Poor P 
 
 
EXAMPLE 3 

 

36. (Do/did) you inhale the cigarette smoke? 
      [READ RESPONSE CATEGORIES] ………………… Not at all  N 

 
      Slightly   S 
 
      Moderately  M 
 
      Deeply   D 
 

14. Alternate Wording 
 

Where you must choose the correct wording for a question, a choice of words or phrases is given in 
parentheses.  The choice you make depends upon previous answers from that respondent.  For 
example: 
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57. What (is/was) your (current/most recent)  
occupation?  [IF MORE THAN ONE JOB, 
RECORD OCCUPATION FOR JOB FOR 
MOST HOURS WORKED PER WEEK.] 

 
 
 
 

For currently employed respondents you would read “What is your current occupation?”  
For unemployed respondents, you would read, “What was your most recent occupation?” 

 
15. Word Insertion 

 
Many questions in the Jackson Heart Study survey instruments contain capitalized words 

or phrases within brackets.  For these questions, you must insert the appropriate name, date, place, 
etc., as required by the questions.  For example: 

 
 

[IF YES TO ANY DISEASES IN QUESTION 26, ASK FOR EACH DISEASE.]  How old was 
he when he was first told he had [NAME OF DISEASE]?  [ENTER “99” FOR “DON’T KNOW”; 
“98” FOR AGES 98 AND OLDER.] 

 
           Age 
 
 

 27a. Cancer:  
 
 
 27b. Diabetes: 
 
 
 27c. High Blood  
  Pressure: 
 
 
 27d. Stroke:  
 
 
 27e. Heart attack:  
 
 
 
53. How long have you lived in  

[NAME OF COMMUNITY]? …………………………………………………. 
                         YEARS 
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In the first example, you would insert the name of each disease specified in the preceding question.  
In the second example, you would read the name of your study community, e.g. Mississippi. 

 
 

16. Skip Instructions 
 
Skip instructions direct you to the next applicable question or item in the instrument.  As with other 
interviewer instructions, they are in capital letters and appear with arrows, brackets, or as a lead-in 
to a specific question.  Since skip instructions are crucial to the accurate administration of the 
questionnaire, see example below. 
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EXAMPLE 1 
 
12. Have you ever taken birth control pills 

to prevent pregnancy?………………………………………………………………Yes Y 
 

 No  N 
 
 
 
 
13. At what age did you start taking birth control pills for the first time? …………. 

 age 
 
 
 
14. Are you currently taking birth control pills?…………………………Yes     Y 

 
    No N 
 
 
 
 
15. At what age did you stop taking birth control pills? ……………………………….. 

   age 
     
 

 
16. For how many years altogether have you used birth control pills? …………….. 
  Years 
 
 
C.  HORMONE USE 
 
17. Have you ever taken female hormone pills, skin patches, shots, 
 or implants, including birth control pills for reasons other than 
 preventing pregnancy?……………………………………………………….Yes   Y 

 
  No   N 
 
  Don't Know  D 

 
 
 
 

 
 
 
 
 
 

Go to Item 17 

Go to Item 30 

Go to Item 16 
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Appendix 2.2 Instructions for Completing Paper Forms  
 
I. Instructions for Completing Paper Forms General 

 

A. Background 
 
The Jackson Heart (JHS) Study utilizes computer-assisted direct data entry as its primary mode of 
data collection.  Nevertheless, the existence of paper forms is necessary for situations in which 
direct data entry is not possible.  In such instances, data is collected on paper forms and then 
entered on the computer at some later time.  The purpose of this document is to provide 
instructions for completing these paper forms.  It should be read carefully prior to working with any 
forms.  Specific sets of instructions associated with each form (QxQ's) should then be read for 
those forms that are of interest. 

B. Form Structure 
 
Most of the paper forms in JHS are designed to correspond exactly to the computer screens used 
for data entry.  However, the quantity of text showing on one paper page will not usually match the 
quantity of text on a screen.  For example, the first page of a form may show items 1 to10, while the 
first screen of the form may show items 1 to 8.   
 
Most forms are structured as follows: 
 
        First page: 
                         a. Form Title  
                         b. "Header" Information 
                              1. Participant's ID Number 
                              2. Contact Year 
                              3. Form Code (preassigned 3-letter code) 
                              4. Version (1-letter code and date) 
                              5. Participant's Last Name and Initials 
                         c. Summarized Instructions 
                         d. First Screen of the Form 
 
 
        Following pages: 
                         a. Form Title, Code, and Version 
                         b. Successive Screens 

C. General Instructions for Completing and Correcting Items on the Forms 
 
All items fall into two main categories: (1) fill in the boxes, and (2) multiple choice.  Techniques for 
completing each of these types of items, as well as making corrections, are described below.  A 
general rule is to record information only in the spaces provided (except for some error corrections).   
 

1. Fill In The Boxes: Recording Information 
 
When alphabetic information is required, print the response beginning in the leftmost box using 
capital letters.  Punctuation may be included.   
 

Example: If the participant's last name were O'Reilly, it should be entered as follows: 
 



144 

Exam 2 Cohort Procedures Manual.DOC 

 
LAST NAME: 

 
 
If the response contains more characters than there are boxes, beginning with the first character 
enter as many characters as there are boxes.   
 

Example: If the subject's last name were Hobgoodnotting, it should be entered as follows: 
 
 

LAST NAME: 
 
 
Whenever numerical responses are required, enter the number so that the last digit appears in the 
rightmost box.  Enter leading zeroes where necessary to fill all boxes.  (This does not apply to the 
address section or to any item which combines alphabetic and numeric information.  Such items 
should be treated as alphabetic.)   
 

Example: If the participant's diastolic blood pressure was 96, it should be coded as: 
 

 
Diastolic: 

 
 
In some cases, numeric fields have a pre-printed number of decimal places.  Also, it is possible that 
the QxQ instructions will specify the number of decimal places to be recorded.  Instructions on how 
to round values to the expected number of decimal places are found in the QxQ instructions.  When 
necessary, enter trailing zeros to fill the requested number of places to the right of the decimal 
point.  Leading zeros may be needed so that all boxes to the left of the decimal are also filled. 
 

Example with trailing zero:  If the participant takes twelve vitamins per day, it should be 
recorded as: 

 
Number per day:                       .               
 
 

Example with leading zero:  If the participant takes two and one-half vitamins per day, it 
should be recorded as: 

 
Number per day:                      . 

 
 
In most cases when dates are recorded, slashes ("/") are used as the separator characters for 
month, day, and year.  These are usually pre-printed in the response field.  The format to be used 
to record dates is indicated under the boxes.  If not, the QxQ instructions will indicate which format 
and separator to use.  JHS uses the U.S. order for recording dates (month/day/year).  The QxQ 
instructions may also contain information on how to handle partial dates.  When necessary, use 
leading zeros within each date unit (month or day or year) so that each box is filled. 
 

Example: Data collected on April 3, 2000 would be recorded as: 
 
 

Date of data collection: 
 

m   m   d   d  y   y 
 

O ' R E I L L Y     

H O B G O O D N O T T I 

0 9 6 

1 2 0 

0 2 5 

0 4 0 3 0 0 
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JHS usually records time using a 12-hour clock, with AM or PM indicated separately.  In most 
cases, colons (":") are used as the separator character for hours and minutes, and are typically pre-
printed in the response field.  The format to be used is indicated under the boxes.  If not, the QxQ 
instructions will indicate which format and separator to use.  When necessary, use leading zeros 
within each time unit (hour or minute) so that each box is filled.  Note that midnight is recorded as 
12:00 AM, and noon is recorded as 12:00 PM. 
 
 

Example: A time of fasting determination of 8:05 in the morning is recorded as: 
 
 

a. Time of fasting determination:                          :                      
 

           h      h           m    m 
 

b. AM.................A 
 

PM.................P 
 

2. Fill In The Boxes: Correcting Mistakes 
 
If a number or letter is entered incorrectly, mark through the incorrect entry with an "X".  Code the 
correct entry clearly above the original incorrect entry. 
 

Example: If the participant's systolic blood pressure was actually 130, but was incorrectly 
entered: 
 
 

Systolic: 
 
 
 

The correction would look like: 
 
 
 

Systolic: 
 
 
If a mistake is made, corrected, and then it is discovered that the correction is incorrect, make a 
second correction as shown below: 
 
 
 

Systolic: 
 
 
 
 

3. Fill In The Boxes: Unknown Or Inapplicable Information 
 

0 8 0 5 

1
 

3 9 

1 3 9 

1 3 9 
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If an item of this type (either alphabetic or numeric) does not apply to the subject being interviewed, 
leave it blank.  For example, if the participant does not have an "other" phone number, that item is 
left blank.  Similarly, if the form provides spaces for three measurements, but only two are taken, 
the third space is left blank. 
 
If the item does apply, but the response is unknown, mark through the box(es) with two horizontal 
lines. 
 
Example: The question "How old were you when you had your first heart attack?" is asked, 

but the participant does not recall how old s/he was.  The question does apply 
because it has been established that the participant has had a heart attack, but the 
answer to this question is not known.  In this case, the response would look like: 

 
 

How old were you when you had  
your first heart attack? 

 
4. Multiple Choice: Recording Information 
 
In this type of question several alternatives are given for the answer, each having a corresponding 
letter.  When it is decided which alternative is most appropriate, circle the corresponding letter in 
the space provided.  Always circle one letter only. 
 

Example: If the participant indicates that they have never had chest pain or 
discomfort, the response would look like: 

 
Have you ever had any pain 
or discomfort in your chest?  Yes  Y 

 
No  N 

 
5. Multiple Choice: Correcting Mistakes 
 
If a response is coded incorrectly, mark through the incorrectly coded response with an "X" and 
circle the correct response. 
 

Example 1: The actual response is No, but Y was circled incorrectly. The correction looks 
like: 
 

Yes  Y 
 

No  N 
 
 

Example 2: If a mistake is made, corrected, and then it is discovered that the correction 
is incorrect, make a second correction as shown below: 

 
 

Yes  Y 
 

No  N 

6. Completing "Header" Information 
 
The following guidelines should be observed in filling out the "header" information located at the top 
of the first page on all forms: 
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ID NUMBER: Write in the participant's 7-digit ID.  The first box contains the letter J, followed by the 
6-digit numeric portion of the ID number.  
 
 

Example: ID NUMBER: 
 
 
CONTACT YEAR: Fill in the appropriate contact year for the form.  Use leading zeroes.  Note: This 
item may be pre-coded on some forms. 
 
LAST NAME: Code the response beginning in the leftmost box using capital letters.  If the name 
contains more letters than there are boxes, beginning with the first letter enter as many letters as 
there are boxes.  Punctuation (e.g., apostrophes and hyphens) and blanks may be entered as part 
of the last name.  Follow the guidelines and examples given above for alphabetic "fill in the boxes" 
items. 
 
INITIALS: Record the participant's first initial in the first box and middle initial in the second box.  If 
a female participant is married and uses a "maiden" name (father's surname) as a middle name, 
use that initial as the second initial.  Otherwise, if the participant has more than one middle name, 
record only the first initial and the second initial.  If there is no middle name, record the first initial in 
the first box and leave the second box blank. 
 

Example 1: A participant's first initial is K, but he has no middle name.  The entry would 
be as follows: 

 
 

INITIALS: 
 
 

Example 2: If the participant's full name is John Oscar Van Camp, Jr., and the 
participant specifies that his last name is "Van Camp", it should be entered 
as: 

 
 
LAST NAME:         INITIALS: 
 
 

7. Skip Patterns ("Go to" Boxes) 
 
Skip patterns occur in many multiple choice type items.  Here, if a certain response is selected, it is 
necessary to skip over one or more items to the next applicable item.  This is indicated by an arrow 
from the response which necessitates a skip to a box containing a "go to" statement.  If that 
response is selected, the next item to be asked is the one indicated in the box.  If the other 
response is selected, always proceed to the next item unless otherwise directed.  The box will also 
indicate the screen containing the "go to" item if that item is not on the current screen. 
 

Example:  7. Since we last contacted you, have you had any pain  
or discomfort in your chest?   

Yes Y 
 

No N 
 

 
 

J 9 9 9 9 9 9 

K  

J O V A N  C A M P     

Go to Item 
20, Screen 5 
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In this case, if the response is "No", skip to Item 20 on screen 5.  If the response is  
"Yes", proceed to the next question, Item 8. 
 
Occasionally, a skip pattern will occur in a fill-in type item.  In those instances, specific instructions 
are provided on the form.  Again, if the skip criteria are not satisfied, continue with the next item. 
 
A few items will trigger a skip regardless of the response.  For these, follow the instructions on the 
form. 
 
II. General Instructions: Completing Computer Data entry Screen 
 
SEE MANUAL 6, DATA MANAGEMENT 
 
III. Instructions for Recording Responses that Do Not Match Precoded Response 

Categories 
 
Most of the questions in the JHS instruments have precoded responses.  There are a few 
questions, however, that are open-ended that is, you must write in a response to the question.  
Some questions have precoded responses as well as an “Other (SPECIFY)” category.  If the 
respondent’s answer does not fit into a precoded answer, you must specify the response.  The 
recording practices below must be followed at all times to assure that the response recorded 
accurately reflects the respondent’s answers and to assure that questionnaire data can be 
converted to machine-readable form. 
 

• You must listen to what the respondent says and record the appropriate answer if the 
response satisfies the objective of the question. 

 
• In recording answers to open-ended questions or “Other (SPECIFY)” categories, print the 

response verbatim. 
 

• Record the response immediately after it is given. 
 

• Use a black ball point pen provided by the Exam Center. 
 

• Record in the white space below the questions any responses that “don’t quite fit” in one of 
the response categories.  Your notes will help the analysts in understanding points of 
confusion, difficulty, etc. 

 
• Print or write legibly. 

 
• If a respondent refused to answer a question, write “refused” in the left margin beside the 

question. 
 

• A single answer choice code must be circled in each question to represent the 
respondent’s answer.  The only deviation from this rule is for disease questions which are 
subdivided into several diseases and an answer code is to be circled for each disease 
listed. 
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APPENDIX 3 INTERVIEWS IN EXAM 2 
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Appendix 3.1 Consent Form 
   
   
 

Title of Investigation:  The Jackson Heart Study 
Principal Investigator:   Herman A. Taylor, MD, MPH 
 
Introduction: As one of more than 5,000 persons who took part in Exam 1 of the 
Jackson Heart Study (JHS), you are being invited to continue your participation in 
this study, which may include future examinations, telephone, or mail contacts. 
Please ask us about anything in this document or that we tell you that you do not 
understand. 
 
Purpose: The Jackson Heart Study is a medical research study to identify the 
risk factors and causes of high blood pressure, heart or other cardiovascular 
disease, obesity, diabetes, kidney disease, or lung disease in African Americans. It 
is conducted by Jackson State University, Tougaloo College, and the University of 
Mississippi Medical Center, and sponsored by the National Heart, Lung, and Blood 
Institute (NHLBI) and the National Center on Minority Health And Health Disparities 
(NCMHD).  
  
Procedures: Your study participation will last several years. This exam will take no 
more than 2 hours of your time and includes:  

• An interview with questions about your health, health care, lifestyle and 
family medical history. To assure that all the questions are asked in the same way 
of everyone, some interviews may be tape-recorded.  
• An examination to measure your blood pressure, height, weight, waist and 
hip size, and body composition using a special scale. 
• Laboratory blood tests for cholesterol (lipids and blood fats) and sugar 
levels. A few drops of blood will be taken by pricking your finger. 
• You will be given a home blood pressure monitor and taught to use it. 

 
After the examination, you will be contacted by telephone one or more times each 
year: 

• 2-6 weeks after your visit to ask a few questions (5 minutes or less) about 
follow up of your examination and home blood pressure monitoring, and may 
also be asked about your experience and satisfaction with the JHS either at 
the end of the clinic visit (2 minutes or less) or by telephone after the visit (10 
minutes or less).   

• Yearly, to ask about your health during that year and getting copies of hospital 
and physician’s medical records for any diagnosis or treatment of conditions 
including blood pressure, heart or other cardiovascular disease, obesity, 
diabetes, kidney disease, or lung disease and risk factors for these diseases. 
In the event of your death, information will be sought from your relatives or 
other informants including coroner’s reports and information from the state 
health department.  

 



151 

Exam 2 Cohort Procedures Manual.DOC 

 
Future JHS examinations will occur approximately every 3 years. The next JHS exam 
cycle will be from 2009-2012.  Also, you may be asked to take part in other studies 
conducted by JHS or collaborating investigators outside the regularly scheduled JHS 
exam cycle.  
Risks: All of the tests included in this study are routinely included as part of 
standard health screenings and are considered safe.  There will be slight discomfort 
when your finger is pricked for blood testing. No materials will be injected into your 
body; blood will only be withdrawn. There may be some discomfort and annoyance 
from the repeated blood pressure measurements. You might experience some 
embarrassment or anxiety from answering any sensitive background questions or 
have concerns about learning of some health condition that you did not know you had. 
This is a concern to some people who would rather not know, or who do not have 
insurance or a regular source of health care.  If you have any of these concerns, a 
JHS social worker will be available to talk with you.  
Benefits: You may or may not receive a direct benefit from being in this study.  You 
will be given a summary report of all of your results from this examination, including 
your blood pressure, blood cholesterol, blood sugar, BMI, and body composition 
percentages. Since this is a research study, and the examination you receive is not a 
substitute for care you would receive from your health care provider, we cannot make 
a diagnosis, provide treatment, or give medical advice related to any condition.  We, 
therefore, encourage you to share your summary report of results with your health 
care provider and, with your permission, abnormal results will be sent to her/him. 
Should you not have regular health care, or be unable to afford such care, the JHS will 
assist you in locating affordable health care. All study participants will also receive a 
regular newsletter updating them on the overall findings of the JHS. 
Alternatives: You may decide not to take part in the clinical examination. Even if you 
decide not to take part in the examination, you may continue as a JHS participant by 
responding to annual follow up calls, and by participating in any future JHS clinical 
examinations. 
Costs:  There will be no costs to you for participating in this study.  
Research-related injury: In case of injury or illness resulting from your participation in 
this study, medical treatment is available to you at the University of Mississippi 
Medical Center.  You will be charged the usual and customary charges for any such 
treatment you receive. 
Compensation: You will receive your choice of $25.00 in cash or gifts in appreciation 
for taking part in the study. Transportation, if needed, will be reimbursed or provided. 
The JHS will provide a taxi service if needed. Should you require reimbursement for 
use of personal transportation, documentation of mileage from your home address to 
the JHS will be used to determine actual reimbursement costs, not to exceed $20.00. 
Child care will be provided, if needed, at the JHS clinic. 
Participation is voluntary:  Your participation in the JHS is completely voluntary and 
you are free to withdraw your consent and to stop taking part at any time, without 
affecting any future relationship for you or your relatives with the JHS, Jackson State 
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University, Tougaloo College, the University of Mississippi Medical Center, or the 
Jackson Medical Mall. You may decide not to answer any question or complete any 
examination. 
Withdrawal from the study: You may choose to stop your participation in this study 
and withdraw at any time.  If you decide to withdraw the information already collected 
about you may still be used in this study unless you request that your records, and test 
results obtained from this exam or prior exams be removed from study files. You may 
also request that your DNA and blood samples and cell lines be destroyed or that all 
identifiers be removed (including code numbers) from such samples. Your decision to 
stop your participation will have no affect on the quality of your medical care. 
New Information: You will be told of any information we learn during your 
participation in this study that may affect your willingness to participate.   
Confidentiality: The confidentiality of your information is a top priority for the JHS. 
Every effort will be made to keep the information we learn about you private.  All 
information collected during this research--including interviews, laboratory data, or 
examination findings--will be kept confidential and results will not be disclosed to 
anyone without your permission except as described below.  Information may be 
released to other researchers for scientific purposes, but only after removing your 
name and all other personal identifiers. Research may be done for conditions not 
directly related to the heart and blood vessels. Researchers from private 
companies, under conditions of data confidentiality specified by the JHS and the 
Institutional Review Boards reviewing the JHS, may have access to your 
information or samples, in a way that cannot identify you.  Please note that neither 
the JHS investigators, nor you, nor your family would benefit financially from this. 
Study records may be reviewed by the Food and Drug Administration (FDA), the 
Office for Human Research Protections (OHRP), and the Institutional Review Boards 
(IRB) of the University of Mississippi Medical Center, Jackson State University, and 
Tougaloo College and Office of Compliance of the University of Mississippi Medical 
Center. Study data may be submitted to regulatory agencies in other countries but you 
will not be identified. If the National Heart, Lung, and Blood Institute or the National 
Center for Minority Health and Health Disparities shares this information with others, 
the information is no longer covered by the federal privacy regulations. To help insure 
your privacy, a Certificate of Confidentiality has been obtained from the National 
Heart, Lung, and Blood Institute for this study.  This Certificate is intended to help 
protect against the involuntary release of information collected during this study.  The 
researchers can make disclosures of information only in very special cases (for 
example, if they think that a participant or someone else is in serious danger or harm). 
Protected Health Information: Protected Health Information is any personal health 
information through which you can be identified.  The data collected in this study 
includes all the interviews, examinations, laboratory tests, genetic (inheritance or 
DNA) analyses, and review of records as described in this form. A decision to 
participate in this research means that you agree to the use of your health information 
for the study described in this form. This information will not be released beyond the 
purposes of conducting this study. The information collected for this study will be kept 
indefinitely.  While this study is ongoing you may not have access to the research 
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information beyond the summary report of your clinic examination results.  This 
summary report may be released to your health care provider only upon your special 
request to do so.  
Your information will be grouped with that of all other persons taking part in the JHS 
and will be used only for statistical analysis to further medical knowledge without 
disclosing your personal identity. When results of this study are published, presented 
at medical or research meetings, or to the Jackson community, only group findings will 
be presented.  
Questions: Any questions about the study, the specific interviews, examinations, 
laboratory tests, or record reviews, or any questions about the findings of the study 
can be answered by the Director of the Jackson Heart Study, Dr. Herman A. Taylor. 
He can be reached at the Jackson Medical Mall offices of the Jackson Heart Study, 
350 W. Woodrow Wilson Drive, Suite 701, Jackson, MS 39213, (601) 815-5050.  A 
pager number is provided through the voice mail for after hours and on weekends. 
This research study has been reviewed by the Institutional Review Boards (IRBs) of 
Jackson State University, Tougaloo College, and The University of Mississippi Medical 
Center. Any questions about your rights as a research participant can be addressed to 
one of the following persons: 
 
Richard Ogletree, Pharm.D. Marlene Setze, Ph.D  Shaila Khan, Ph.D. 
Chair, IRB   Chair, IRB   Chair, IRB 
Univ. of MS Medical Ctr Jackson State University Tougaloo College 
2500 North State Street  1400 J.R. Lynch Street  500 West County Line Rd 
Jackson, MS 39216-4505 Jackson, MS 39217 Jackson, MS 39174 
(601) 984-2815  (601) 979-2931    (601) 977-7737 



154 

Exam 2 Cohort Procedures Manual.DOC 

STATEMENT OF PARTICIPATION 
 
 

I have been told about my continued participation in the Jackson Heart Study and 
the possible risks and benefits.  My participation is voluntary and I may withdraw at 
any time without any penalty or loss of benefits to which I am entitled, including 
medical care at the University of Mississippi Medical Center. By signing this form, I 
confirm that I have read the preceding consent information (or it has been read to 
me) and that I understand the contents. A copy of the consent information will be 
given to me for my records.  
 
The JHS investigators and the scientists with whom they are collaborating will use 
the information and samples that have been collected from me (including the 
results of questionnaires, clinic examinations, and blood tests) for heart disease 
risk factor and related disease research purposes. My name or other information 
that could identify my family or me will not be released. 
 
I have VOLUNTARILY agreed to any of the following conditions marked with an  
X or √ in the “Yes” column.    

 
Yes No  
� � I agree to participate in the clinic and annual interviews, clinic 

examinations, blood pressure teaching and record review. 
   
 � � I give my permission for JHS investigators to review a copy of 

my medical records. 
 

 � � I would like to receive JHS results from the clinic examinations. 
 

 �   � I give permission for JHS to provide my health care provider 
with my examination results, if they are outside the normal range.  

 
 � � I agree to allow my study data / samples to be used for future other  

  research by scientists studying diseases not directly related to heart  
  disease risk factors and related diseases. 

 
� � I agree to have my study data or samples released researchers  
  from for profit organizations who wish to develop diagnostic  
  laboratory tests, medications, or other therapies that could benefit  
  many people. (Note: Neither you nor your heirs will benefit financially  
  from this, and your cell line or DNA will not be sold to anyone for  
  profit.) 
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Through your JHS participation you have demonstrated your desire to contribute to 
improving heart health of African Americans. We commend the commitment and 
contributions you have already made. We also respect your right to make 
adjustments to decisions that you made regarding use of study data obtained in 
your previous JHS exam. In case you would like to change any prior permission 
you gave in the past, we want to provide the opportunity to affirm or modify your 
consent responses for Exam 1.Your consent information from Exam 1 is attached 
for your review. 
 

Yes No 
� � I affirm my consent responses for Exam 1 
 
� � I would like to make the following modification to my consent 
responses for Exam 1: 
 
_________________________________________________________________ 
 
_________________________________________________________________ 

 
 

By signing this form I am not giving up any legal rights I may have. 
 

________________________________________________________________ 
Signature of Participant   Date 

          
________________________________________________________________ 
Participant’s legally authorized representative (when applicable) Date 

 
________________________________________________________________ 
Relationship to Participant      

 
________________________________________________ 
Name of Person Obtaining Informed Consent (please print name) 

 
I acknowledge that the participant identified above has been entered into this study, 
with properly obtained informed consent. I pledge that I will maintain the highest 
standards of scientific conduct in carrying out this research to protect this participant 
from harm. I promise to assure that all participant information is used ONLY for the 
purposes expressly granted in this consent. Further, I will maintain confidentiality of all 
participant research information in keeping with the law and federal regulations. 

 
________________________________________________________________ 
Signature of Investigator     Date 
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APPENDIX 4 PROCEDURES IN EXAM 2 
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Appendix 4.1 Tanita TNF 300A Manual  
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Appendix 4.2 Cholestech LDX Manual    
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Appendix 4.3 Anthropometry Equipment Calibration Log 
 

ANTHROPOMETRY EQUIPMENT CALIBRATION LOG 
 
Deliver to Coordinating Center on Friday afternoons.  Keep photocopy in Exam Center. 
 
Week of ___________________ 
               (Monday’s date) 
 
DAILY CHECKS   (at beginning of day) 
                                                                         M     T     W     Th     F 
1.a.   Scales Read Zero                                  __    __   __     ___   ____ 
 
WEEKLY CHECKS 
 
1.        Scales 
 
           A.        Calibration check                                  Date    __________________ 
                       of  scales with 50 
                        lb weight                                               Time   __________________ 
 
                       Reading of scales with 50 lb weight   ________________________ 
   
                       If reading outside of 49.5 to 50.5 range, scale should be 
                       Serviced. 
 
                       If service is REQUESTED, give           Time   ______   Date _______ 
                        
                       RECALIBRATION by independent      Time   ______    Date ______ 
                       Service technician 
 
           B.         Repeat calibration because of moving scales 
 
                        Scales moved:    1. Date ________    2.  Date ________________ 
 
                                                         Time ________        Time ________________ 
 
                        Calibration:          1. Date ________    2. Date ________________ 
 
                                                         Time ________        Time ________________  
 

                  
2.      Height Rule 
 
         a.     Touches hard-surfaced      _________________________________ 
                  platform on which 
                  measures are done 
 
         b.       Perpendicular to floor       _________________________________ 
 
MONTHLY CHECKS 
 
1.      Check Measuring Tape:           Date   ______________________________ 
    
         a.     Excess wear of damage found    (Y or N)   _____________________ 
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         b.     Height above floor (to nearest cm) on          ____________________ 
                  height rule of the 30 cm mark of the 
                  tape when the zero mark of the tape 
                  is aligned with the 150 cm mark of the  
                  height rule 
 
                  Note:          If this measure is outside the 119.5-120.5 cm range, 
                                      the tape should be replaced. 
 
         c.      Height above floor (to nearest cm) on    _______________________ 
                   height rule of the 100 cm mark of the  
                   tape, with the tape aligned as above. 
 
                  Note:           If this measure is outside the 49.5-50.5  cm 
                                       Range, the tape should be replaced. 
 
         d.      Tape replaced (Y or N)    _______      Date replaced    ____________ 
 
                                                                                 Time replaced    ____________  
 
 
Technician doing weekly check: 
 
  ID#   ____________   Signature _______________________    Date __________ 
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Appendix 4.4 Cholestech Optics Check Log / Cassette Quality Control Log 
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Appendix 4.5 Checklist for Anthropometry Measurement 
 
                   

CHECKLISTS FOR ANTHROPOMETRY MEASUREMENTS 
 
Date of Visit:      _________________________________ 
 
 
Technician:  ________________________________    I.D. #____________________ 
 
Supervisor:  ________________________________    I.D. # ____________________ 
 
This booklet contains a checklist for each anthropometry measurement and equipment 
calibration.  The purpose of these checklists is to help train technicians to take uniform and 
accurate measurements using calibrated measuring equipment.  Each checklist leads you 
through a series of steps to obtain and to record a measurement.  All measurements are 
done on the right side, unless the limb is missing, atrophied or injured. 
 
                          Item                                                               Yes                  No 
 
A. Anthropometry is done BEFORE the  ________ ________  

Snack.        
 
B. Prepare participant for anthropometry: 
 (May be done by the receptionist or    
 technician).     ________ ________ 
 
 1)    If the participant is wearing                       
                    any nylon hose other than knee 
        highs, the participant is instructed 
                    to remove hose.    ________ ________ 
 
             2)    Participant is wearing light- 
         weight, non-constricting 
                     underwear.                                                 ________ ________     
 
             3)     Participant is wearing scrub 
                     suit.        
                                                           
            4)     Participant has removed shoes.               ________ ________ 
 
             5)     Participant has emptied bladder.             ________ ________ 
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Appendix 4.6 Checklist for Height Measurement 
 

CHECKLIST FOR HEIGHT MEASUREMENT 
 
            ITEM                                                                                     YES            NO 
 
1.     Participant is prepared.                                                    _______ _______   
  
2.     Procedure is explained to participant.                               _______ _______ 
  
3.     Participant’s spine and heels are 
         placed against the wall.                                                       _______ _______ 
   
4.      Participant’s eye to ear plane is  
         horizontal  (i.e., Frankfurt plane).                                        _______ _______ 
 
5.      Measurement is taken with triangle 
         or measuring block.                                                             _______ _______ 
 
6.      Recording is completed.                                                      _______ _______ 
         
7.      Data are recorded accurately to 
         the nearest centimeter, rounding  
         down.                                                                                     _______ _______ 
 
 
                         Technician:  __ __ __  cm 
 
                          Supervisor:  __ __ __  cm 
 
8.       Other:   ____________________________________________________________ 
 
Comments: 
________________________________________________________________________ 
 
________________________________________________________________________ 
 
________________________________________________________________________   
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Appendix 4.7 Checklist for Weight Measurement 
 

 
CHECKLIST FOR WEIGHT MEASUREMENT 

 
 
ITEM                                                                 YES               NO 
 
A.    PROCEDURE 
 
1.     Participant prepared and  
        procedure explained                            ______   ______ 
 
2.     Position of participant 
        on center of scale                                 ______   ______  
 
3.     Balance achieved                                 ______   ______   
 
4.     Recordings completed                         ______   ______  
 
5.     Data recorded accurately 
        to the pound, rounding 
        down                                                       ______   ______  
 
              Technician:     ___  ___  ___  lbs 
 
               Supervisor:     ___  ___  ___  lbs 
 
6.      Other  _________________________    ______   ______    
 
 
Comments: 
___________________________________________________________________ 
 
___________________________________________________________________ 
 
___________________________________________________________________      
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Appendix 4.8 Checklist for Maximal Waist Measurement 
 

CHECKLIST FOR MAXIMAL WAIST MEASUREMENT 
 

ITEM                                                                                            YES      NO 
 
1.      Subject stands erect, yet relaxed, 
         with weight equally distributed on 
         both feet.        _____ _____ 
                                                                       
2.      Measuring tape is placed around 
         subject’s waist at the level of the 
         umbilicus (navel).   _____ _____ 
                                                          
3.      Recorder or another observer 
         verifies horizontal position 
         of tape, both front and back 
         of the subject, or uses mirror 
         to check tape.                                                                 _____ _____ 
 
4.      Subject takes a normal breath and 
         gently exhales holding breathe in 
         in a relaxed manner at the end of  
         exhalation.    
                                                                    _____ _____ 
5.      Tape is horizontal and snug, but not 
          tight enough to compress tissue. 
          (Invert tape, if needed, to insure 
          reading edge of tape is snug to skin 
          for measurement).                                                          _____ _____ 
  
6.      Reading is recorded to the nearest 
         centimeter, rounding down, at point 
         of relaxed and exhalation.                                            _____ _____ 
 
                            Technician:   ___   ___   ___ cm 
 
                             Supervisor:  ___    ___   ___ cm 
 
Comments: 
________________________________________________________________________ 
 
________________________________________________________________________ 
 
________________________________________________________________________ 
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Appendix 4.9 Checklist for Maximal Hip Circumference Measurement 
 

CHECKLIST FOR MAXIMAL HIP CIRCUMFERENCE MEASUREMENT 
 
ITEM                                                                                  YES        NO 
 
1.  Subject stands erect, yet relaxed, 
     with weight equally distributed on 
     both feet and feet together.                                      _____ _____                
 
2.  Measuring tape is placed horizontally 
     and level around the subject’s gluteal 
     muscles (hips) at the level of maximal 
     protrusion of the gluteal muscles. 
     Verify this position by passing the 
    Tape above and below the observed 
     maximum.                                                                   _____ _____ 
  
3.   Recorder or another observer verifies 
      horizontal position of tape, both front 
      and back of the subject, or uses a  
      mirror to check tape.     _____ _____    
                                              
4.   Tape is horizontal and snug, but not 
      tight enough to compress tissue.   
      (Invert tape, if needed, to insure 
      reading the edge of tape is snug to 
      the skin for measurement.                   _____ _____                     
 
5.    The measurement is made at the  
       participant’s side.                                 _____ _____     
          
6.    Tape is read to the centimeter,  
       rounding down.                                             _____ _____                  
 
                           
                                      Technician:  ____ ___  ___ cm                  
 
                                       Supervisor:  ___  ___  ___ cm 
 
 
Comments:  ____________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
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Appendix 4.10 Report on Use of Observation and Equipment Checklists 
 

REPORT OF USE OF OBSERVATION AND EQUIPMENT CHECKLISTS 
 
DATE:  _____/ ________/______           (Month/Day/Year) 

Biannually:    ______ January                  ______ July (20___  ___) 

This form should be completed biannually and sent to the Coordinating Center 
(by the end of January and July). 
 
Form Type               Observer ID            Observed ID            Date (MM/DD/YY) 
 
Anthropometry        ___________           ___________           ______________  
 
                                  ___________           ___________          ______________ 
 
                                  ___________           ___________          ______________ 
 
                                  ___________           ___________          ______________ 
 
                                  ___________          __________             ______________ 
  
                                  ___________          ____________         ______________  
 
                                  ___________           ___________          ______________  
 
BP Observation       ___________          ____________         ______________ 
 
                                  ___________          ____________         ______________ 
 
                                  ___________           ____________        ______________ 
 
                                  ___________           ____________        ______________ 
 
                                  ___________           ____________        ______________   
 
                                  ___________            ___________          ______________ 
 
                                  ___________           ____________         ______________ 
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REPORT ON USE OF OBSERVATION AND EQUIPMENT CHECKLISTS (Cont’d) 

 

Form Type Observer ID  Observed ID  Date  (MM/DD/YY) 

BP Tape Test ___________  ____________  ________________ 

  ___________  ____________  ________________ 

  ___________  ____________  ________________ 

  ___________  ____________  ________________ 

  ___________  ____________  ________________ 

                         ____________  ____________  ________________ 

                         ____________                ____________               ________________ 

BP Double ______________ _____________ ________________ 
Stethoscoping 
  ______________ _____________ ________________ 
 
  ______________ _____________ ________________ 
 
  ______________ _____________ ________________ 
 
  ______________ _____________ ________________ 
 
  ______________ _____________ ________________ 
 
  ______________ _____________ ________________ 
 
Digipuncture    ______________ _____________ ________________ 
 
  ______________ _____________ ________________ 
 
  ______________ _____________ ________________ 
 
  ______________ _____________ ________________ 
 
  _______________ _____________ _________________ 
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REPORT ON USE OF OBSERVATION AND EQUIPMENT CHECKLISTS (cont’d) 
 
Tanita   ____________  ____________  ____________ 
Bioimpedance 
Monitor  ____________  ____________  ____________ 
 
   ____________  ____________  ____________ 
 
   ____________  ____________  ____________ 
 
   ____________  ____________  ____________  
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REPORT ON USE OF OBSERVATION AND EQUIPMENT CHECKLISTS (cont’d) 
 
 
 Individual checklist for equipment should be filled weekly or monthly, according to 
the requirement of the checklist, and kept in the Field Center. 
 
 Key:  N =  Expected total number of checks needed: 
          n  =  Number of checks done: 
                 % =  % of checks done.  
 
Checklist    Frequency  N n %            
____________________________________________________________________  
 
Anthropometry Equipment 
Calibration Log 
 
 (1)  Scale Read Zero  Daily 
 (2)  Weight Scales  Weekly 
 (3)  Height Rule  Weekly 
 (4)  Measuring Tape  Weekly 
 
Sitting Blood Pressure 
      Monthly Log for BP Station Weekly 
     Monthly 
____________________________________________Appendix 4.3 Anthropometry 
Equipment Calibration Log 
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APPENDIX 5 MEDICAL DATA REVIEW 
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Appendix 5.1 Prototype Medical Data Review Print Out and Information Sheet  
MEDICAL DATA REVIEW REPORT FOR EXAM 2  

1. Name (CONA 1, 3, 4, 2):   

2. JHS ID (CON) 

3. Birth date (ELGA 5a): 

4. Exam date 

5. Physician name (CONA 34B,A): 

6. Age in years (FTRA1, ELGA5A): 

7. Height in feet & inches (ANTA/B1): 

8. Weight in pounds (ANTA/B2): 

9. BMI (BCF 8) 

10. % Body Fat (BCF 12) 

11. Avg. Sitting BP (SBPB 22, 23) 

12. Taking antihypertensives (MSRA30a) 

 
Possible Angina 
 
 13 Ever had chest pain (MSR B8) Yes  No 

 14 HTN diagnosis (HHX 8A) Yes  No 

 15. Diabetes diagnosis (HHX 12a) Yes  No 

 16. High Cholesterol diagnosis (HHX 9a) Yes  No 

 17. Pain more frequent past 2 months (MHX B 20) Yes No 

 18. Pain more severe past 2 months (MHX B22) Yes  N 

 
Possible Congestive Heart Failure: 
 
 19. Slept on 2+ pillows to breathe (MHX B47) Yes  No 

 20. Awakened by breathing trouble (MHX B48) Yes  No 

 21. Had swelling of feet or ankles (MHX B49) Yes  No 

 22. Decreased swelling overnight (MHX B50) Yes  No 

 

Recognized TIA or stroke 
 

 23. Stroke diagnosis (SSF B1) Yes  No 

 24. Date of first stroke (DDFB 2A, 2B) 

 25. Leg pain with walking (MHX B37) Yes  No 
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Cardiovascular surgery 
 

23. Heart or arterial surgery (MHX B51) Yes  No 

24. Coronary bypass (MHX B 52 A)   Yes  No 

25. Other heart procedure (MHX B52 B1) Yes  No 

26. Other revascularization (MHX B52 E1)   Yes  No 

27. Specify (MHX B42 E2) Yes  No 

28. Other Heart, neck or leg (MHX B52 F) Yes  No 

29. Balloon angioplasty (MHX B53) Yes  No 

30. Coronary angioplasty (MHX B54 A) Yes  No 

31. Neck angioplasty (MHX B54 A) Yes  No 

32. Lower extremity angioplasty (MHX B54 C) Yes  No 

 

Catheterization 
33. Heart catheterization (MHX B55 A) Yes  No 

34. Carotid artery catheterization (MHX B55 B) Yes  No 

35. Other arterial catheterization (MHX B55 C1) Yes  No  

36. Specify (MHX B55 C2  

 

Diagnostic procedures 
 

37. Echocardiogram (MHX B56 A) Yes  No 

38. ECG (MHX B56 B) Yes  No 

39. Treadmill or stress test (MHX B56 C) Yes  No 

40. MRI of Brain (MHX B56 D) Yes  No 

 

Laboratory Values 
 

41. Glucose (FST A5)  

42. Cholesterol (FST A6)  

43. Triglycerides (FST A7)  

44. HDL (FST A8) 

45. LDL (FST A9) 

46. VLDL (FST A10) 
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Administrative  
 

47. Code of person Completing Medical Data      

 

48. Date of Medical Review         
 M M D D Y Y Y Y 
 
  
  
 52. Code of clinician Reviewer:      

 
 

53. Date of review by clinician:         
 M M D D Y Y Y Y 

 
  

 

  

 

 

/ / 

/ / 
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Appendix 5.2 Tanita Patient Education Handout  
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Appendix 5.3 Cholestech Patient Education Handout 
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APPENDIX 6 REFERRAL AND RESULTS REPORT 
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Appendix 6.1 Prototype Health Care Provider Results Reporting Letter: Health Care 
Provider Designated  

 

DATE 

 

Provider’s name 

Provider’s address: 

 

Dear Provider Name: 

 

Your patient, PATIENT’S NAME, is a participant in the Jackson Heart Study and was seen at our 

Exam Center on VISIT DATE. During the course of our evaluation, the following abnormality was 

identified. We believe that this requires your attention. 

 

ABNORMAL RESULT:  [LIST RESULT] 
 

The Jackson Heart Study routinely offers to send all clinically relevant data to the participant’s 

health care provider. PATIENT’S NAME has requested that we send the result to you, and we 

have also provided a report to her/him.  

 

The Jackson Heart Study procedures are designed exclusively for epidemiological research. Our 

study procedures do not substitute for a clinical examination. The study does not provide any 

diagnosis or medical treatment. We have recommended that Mr./Mrs./Ms. PATIENT’S NAME that 

s/he contact you to determine how to follow up on these results.  

 

Should you have any questions, please feel free to contact us at 601-815-5050.  

 

 

Sincerely, 

 

 

Mary E. Crump RN, MSN 

Clinic Manager 
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Appendix 6.2 Prototype Health Care Provider Results Reporting/ Referral Letter: No 
Health Care Provider Designated  

 

DATE 

 

Provider’s name 

Provider’s address: 

 

Dear Provider Name: 

 

Thank you for agreeing to see, PARTICIPANT’S NAME, a participant in the Jackson Heart Study 

who was seen at our Exam Center on VISIT DATE. PARTICIPANT’S NAME does not have a 

regular health care provider. During the course of our evaluation, the following abnormality was 

identified. We believe that this requires your attention. 

 

ABNORMAL RESULT:  [LIST RESULT] 
 

PATIENT’S NAME has requested that we send the result to you, and we have also provided a 

report to her/him.  

 

The Jackson Heart Study procedures are designed exclusively for epidemiological research. Our 

study procedures do not substitute for a clinical examination. The study does not provide any 

diagnosis or medical treatment. We have recommended that Mr./Mrs./Ms. PATIENT’S NAME that 

s/he contact you to determine how to follow up on these results.  

 

Should you have any questions, please feel free to contact us at 601-815-5050.  

 

 

Sincerely, 

 

 

Mary E. Crump RN, MSN 

Clinic Manager 
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Appendix 6.3 JHS Alerts and Referrals Procedures 
CLINIC PROCEDURES –EXAM 2 

MEDICAL DATA REVIEW AND RESULTS/ALERTS REPORTING 
 

 
I. Overview 
 
The purpose of medical data review and results/alerts reporting is to provide timely information 
regarding the results of the JHS clinic examination to participants and, if requested or indicated, 
their health care provider (HCP). Additionally, medical data review is conducted to identify and 
provide timely notification of any alert findings that require emergent, immediate or urgent 
attention by a HCP. This process is a major component of assuring participant safety.  
 
Results that are immediately available during the clinic examination (blood pressure, 
anthropometrics, body fat, glucose, and lipids) are reviewed with the participant at the end of the 
clinic visit during the exit interview. Any abnormal or alert values will result in an appropriate level 
referral based on the categorization of findings as emergent, immediate, urgent or routine as 
identified  in Manual 2: Cohort Procedures. Participants without a HCP, but needing referral, will 
be assisted in that process. 
 
The Medical Data Review and Results/Alerts Reporting Form (ALT) are used to track all results 
reporting activities.  
 
Table 6.2 provides a summary of procedures for routine results reporting and identification, 
notification and documentation of alerts. Each column of this summary table is reviewed below.  
 
II. Medical Data Review: Action Sequence for Routine Results Reporting  
 
This section details the action sequence for routine results reporting for each examination 
component reportable to participants and their HCP (if requested) presented in Table 6.2, column 
2. As the same series of steps is listed for each component in the table, this section provides a 
common overview of the entire process applicable to all procedures. 
 
A medical data review is conducted in several steps for each participant. The first step occurs 
during the clinic visit at the time of the exit interview. The next step occurs during a weekly review 
as the Clinic Manager performs quality control to assure that all abnormal results were properly 
handled. Results of the medical data review process are documented on the ALT and maintained 
in the Data Management System (DMS).  
 
A. End-of-Clinic Medical Data Review  
 

The end-of-clinic medical data review serves to summarize the results of selected 
measurements obtained during the baseline exams/interviews, identify potential medical 
problems and answer participant questions. It is important to note that the intent of this 
review is to provide factual information about results, identify abnormalities and 
recommend referral as needed, while avoiding medical advice about prognosis, 
prevention or therapy. All such medical advice is in the purview of the participant’s HCP 
and is not within the scope of the JHS. 
 
1. Medical Data Review print out 
 
The Medical Data Review (MDR) print out is generated at the end of the clinic visit 
(Appendix). This print out contains relevant participant personal (birth date, age) and 
medical history (taking hypertensive medications, history of hypertension, diabetes, 
elevated cholesterol, stroke, chest pain, coronary bypass surgery, balloon angioplasty or 
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cardiac catheterization, undergoing dialysis, menstrual bleeding); indication of identified 
HCP as well as values from the clinic examination (height, weight, sitting blood pressure).   
 
2. Nurse Manager/Clinic RN review 

 
Using the information contained in the MDR print out, the Clinic Manager or RN conducts 
an exit interview with the participant at the conclusion of the clinic examination visit. 
During this exit interview, all known findings from the clinic exam/questionnaires are 
reviewed with the participant to confirm selected positive symptoms reported during the 
interviews/exam and to determine if these appear to warrant immediate (same day), 
urgent (same week) or routine medical follow-up. Specifically, the Clinic Manager or RN 
reviews anthropometrics, blood pressure, body fat, fasting blood glucose and lipids. The 
information on the MDR print out provides background information to assist the nurse in 
determining the urgency of any abnormalities. For example, should the participant have 
an elevated blood pressure, the Clinic Manager or RN will determine from the print out 
and confirm with the participant that s/he takes blood pressure medication. Ascertaining 
whether medications have been taken that day, if the participant knows her/his normal 
blood pressure reading, and the last time s/he was seen by a HCP will be instrumental in 
subsequent follow-up actions. Guidelines for abnormal and alert referrals are 
summarized in Table 1 and detailed below.   
 
A printed summary of the exam results that are immediately available from the Clintrial 
DMS is completed during the end-of-clinic medical data review and given to the 
participant. This includes BP, height, weight and calculated body mass index, body fat, 
blood glucose and lipids. In addition, the participant receives a copy of her/his Tanita 
Bioimpedance monitor print out and a summary health education handout that explains 
these findings. Any remaining participant questions are answered during this interview.  
 
At the conclusion of the end-of-clinic medical data review, the participant is directed to 
the Social Worker who conducts the Participant Evaluation of Clinic Visit on as many 
participants as possible during each clinic day. When it is not possible for the Social 
Worker to conduct the evaluation interview, participants will be asked to complete the 5-
item evaluation on their own.  
 
In the event the participant has social service needs, does not have a HCP and either 
needs alert / routine referral or requests assistance with locating health care, the Social 
Worker is consulted to assist with the referral process.  
 

B. Daily and Weekly Review 
 

Designated lead technicians conduct a daily review of examination results to detect and 
initiate action on alert findings. The Clinic Manager conducts a weekly review of all 
available examination results for participants completing clinic examinations during the 
preceding week. The purpose of this examination is to assure that all alerts have been 
identified and handled according to the results and alerts reporting protocol. Information 
needed to complete this weekly review includes 1) appointment listing for previous week, 
2) a copy of the MDR and ALT completed at the time of the Exam 2 visit. A notation of 
review is indicated in the upper right or left hand corner of the result report.  

 
1. Appointment listing 

 
The Data Manager prints a query report from the Participant Itinerary Form for 
the specified week. This report includes all participants who have completed all 
or part of a clinic examination during the specified time frame. Specific exam 
components not completed or refused by each participant are identified in this 
report.  
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The Clinic Manager uses this report to assure that the reports provided for 
weekly review are complete.  
 

2. Compilation of reports 
 

The Clinic Receptionist creates a Results Reporting file with name and J number 
for each participant at the time of clinic file generation on the morning of the clinic 
visit. This file is placed in alphabetical order by day of the week in the Weekly 
Review filing space in the JHS file storage room. The MDR Report and the ALT 
printout are placed in the individual participant Result Reporting file. 

 
3. Notation of review 

 
a. Daily review. All abnormal values are recorded on the ALT form by the lead 

technician at the time of the daily review and entered in the Medical Data Review and 
Alerts/Referral Log (ALT) in the DMS (see section D1, below). 

 
b. Weekly review. The Clinic Manager affixes a check () followed by her/his 

initials, the date of review and an indication of the level of reporting to each report 
reviewed. For normal values, no further annotation is included. For abnormal values, 
results that require routine reporting are indicated by the letters RR; those requiring alert 
reporting are indicated by the letters AR.  

 
The Clinic Manager affixes a check () followed by her/his initials beside each 

name on the weekly appointment list that accompanies the weekly compiled results. The 
placement of initials indicates completion of the weekly medical data review. Using this 
checklist, the Clinic Receptionist enters confirmation of completion of the weekly medical 
review in the Medical Data Review and Alerts/Referral Log in the DMS (see section D2, 
below). 
 

C. Comprehensive Results Report  
 

A comprehensive report of participant examination results is generated by the 
Coordinating Center and delivered to the Exam Center at the time of the exit interview 
(Medical Data Review printout). In addition to the reportable examination findings, this 
report includes information necessary for completing the review process, e.g. participant 
name, J number, gender, HCP status, and whether or not s/he is taking medications for 
hypertension.  
 
Also, a final packet, including an appropriate cover letter for the participant HCP, two 
copies of the results report, an explanations booklet, and a risk factor analysis is 
generated for distribution to each participant.  
 
A dual process of clinic staff and Clinic Manager review of all results reporting letters and 
results is completed to assure accuracy prior to mailing. Designated clinic staff review the 
comprehensive results reports generated each week to assure accuracy and 
subsequently completes the documentation process using the ALT form (see Forms 
Manual and QxQs for each form). A final quality control review is conducted by the Clinic 
Manager prior to mailing any abnormal results to the participant’s designated HCP (with 
permission of participant). 

 
For participants who request that abnormal results be mailed to their health care provider, 
the Examination Center will mail a complete set of findings to the designated HCP two 
weeks of the clinic visit date.  
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1. Distributing reports 
 

a. Initial review. Designated clinic staff review letters and reports for 8-10 
participants each week to assure accuracy and to complete the ALT forms for 
each participant.  
 
b. Quality review. The Clinic Manager completes a final quality control review of 
each participant report packet to assure that the information matches the actual 
results for each participant and that the correct information is attached to each 
letter for each participant.  
 
c. Participant reports. The Clinic Receptionist makes a duplicate copy of the 
complete participant report (letter, results report, explanations) for both the 
participant and HCP. The copy is filed in the participant JHS file.  

 
D. Annotating Routine Medical Data Review  
 

Any abnormal result found at any stage of the medical data review process (end-of-clinic, 
daily review, weekly review, comprehensive review) is annotated on the Alert and 
Routine Referral Log (ALT) and entered into the DMS. Likewise, the confirmation of 
completion of each of the weekly review and comprehensive results reporting procedures 
is annotated in the Medical Data Review printout and maintained in the participant paper 
record. 
 
1. ALT form 
 
The Alert and Routine Referral Log (ALT) form is used to record all abnormal findings 
and subsequent referral action for any reportable result from the clinic examination. The 
form includes space for recording information on abnormalities in blood pressure, body 
fat, body mass index, blood glucose and lipids. For each exam component, space is 
provided to record the date the abnormal finding was received, the alert item/value, the 
date of referral action, the JHS code of the person completing the review, the type of 
referral action taken, the referral source and the method of notifying both the participant 
and her/his HCP. Specific instructions for completing the ALT form are included in the 
Forms Manual for Manual 2. 
 
The paper version of the ALT is maintained in the participant’s file. 

 
The Data Manager queries the Alerts Reporting Crystal Reports provided by the 
Coordinating Center to generate a monthly report of Alert and Referral actions on a 
designated date each month. This report is transmitted electronically to the Clinic 
Manager, the Chair of the Clinic Operations Committee, and the Director of the Exam 
Center for inclusion in the monthly agenda of appropriate committee meetings (e.g. Clinic 
Operations, A Team, Steering Committee).  
   

III. Medical Data Review: Action Sequence for Identifying and Reporting Abnormal 
Results 

 
This section details the action sequence for identifying (Table 6.2, column 3), reporting (Table 
6.2, Column 5) and documenting (Table 6.2, column 6) abnormal results for each examination 
component reported to JHS participants and their health care providers (HCP) (See Manual 2 
v2.0, section 6: Results and Alerts Reporting). Table 6.1, column 4 summarizes the range and 
categorization of abnormal values for quick reference. Definitions for each of the identified alerts 
categories: Emergent, Immediate, Urgent and Routine, are provided. 
 
A. Definitions of Results Categories 
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1. Alerts are those results that require participant notification and referral to HCP 
within a time period prior to the usual results reporting schedule (within 2 weeks 
after the clinic examination). There are three categories of alert referrals: 

 

a. Emergent referrals are those immediate or urgent clinical findings 
identified during the clinic examinations that are accompanied by life-
threatening (e.g. hemodynamic instability) findings. In all such instances, 
the clinic examination is stopped and the participant is transported to the 
nearest Emergency facility. Emergency procedures are outlined in 
Section 7 of Manual 2 v2.0, Cohort Procedures. Chapter 4 of the EC 
Clinic Procedure Manual outlines the protocol for handling emergencies, 
including those that do not fall in any of the alert categories.  

 

b. Immediate referral is made for specified abnormal findings that require 
immediate (same day) attention. When identified during the clinic 
examination or exit interview, the participant must be notified and 
notification of her/his HCP is initiated before the participant leaves the 
clinic. Contact is made with a selected HCP if the participant does not 
have an established provider.  

 

c. Urgent referrals are made for specified abnormal findings identified 
during the clinic exam. They require participant notification and HCP 
referral within one week. 

 

2. Routine referral occurs for those abnormalities that are unlikely to result in an 
adverse affect within several weeks of the clinic examination. These results are 
reported routinely with comprehensive reporting of results to participants in clinic 
and HCP (if requested).  

 

B. Identifying and Reporting Clinic Alerts 
 

1. Blood Pressure 
 

The technician completing the BP measurement during the clinic examination identifies 
abnormalities in blood pressure and notifies the Clinic RN or Clinic Manager. S/He 
repeats the BP reading to confirm the abnormality and identifies the alert category. The 
nurse assesses the participant’s clinical status.  

 

BP alert values in accordance with Joint National Commission VII guidelines are 
summarized below: 

 
Medical Care Referral Guidelines for Blood Pressure, Based on Joint National Committee 
on Detection, Evaluation and Treatment of High Blood Pressure  
(JNC-VII, 2003) Guidelines 

Referral 
Classification 

Examination 
Findings 

Recommendation to Participant1 Explanation 
to 

Participant 

Emergency Referral SBP > 260 Transportation to emergency care Your BP is 
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Medical Care Referral Guidelines for Blood Pressure, Based on Joint National Committee 
on Detection, Evaluation and Treatment of High Blood Pressure  
(JNC-VII, 2003) Guidelines 

Referral 
Classification 

Examination 
Findings 

Recommendation to Participant1 Explanation 
to 

Participant 

or  
DBP > 130 

facility. Stop exam and reschedule 
clinic visit 

very high. 

Immediate Referral SBP 210-259 
or  

DBP 120-129 

Consult with JHS MD.  Refer to 
source of care immediately (today). 
Stop exam and reschedule clinic visit 

Your BP is 
very high. 

Urgent Referral SBP 180-209 
or  

DBP 110-119 

Consult with JHS MD and proceed 
unless otherwise indicated. Refer to 
source of care within 1 week 

Your BP is 
high. 

Routine Referral SBP 160-179 
or  

DBP 100-109 

Refer to source of care within 1 month Your BP is 
elevated. 

 SBP 140-159 
or  

DBP 90-99 

Refer to source of care within 2 
months 

Your BP is 
elevated. 

 SBP 120-139 
or  

DBP 80-89 

Recheck in 1 year (no JHS referral) Your BP is in 
the pre-
hypertension 
range 

 SBP < 1202or  
DBP < 80 Recheck in 2 years (no JHS referral) Your blood 

pressure is 
normal 

1 If the systolic and diastolic categories are different, follow recommendations for the shorter time follow-up (e.g., 160/85 mm Hg should be 
evaluated or referred to source of care within 1 month).       2  Unusually low readings should be evaluated for clinical significance. 

 
If the alert value is determined to be Emergent or Immediate, the JHS 
Medical Officer or EC Clinician on call is notified immediately (prior to 
participant leaving the clinic). S/He reviews and confirms this level of alert 
finding and provides instructions to initiate participant and HCP 
notifications according to protocol definitions (described above) including 
any further recommendations.  
 
Participant notification of BP value occurs at the time of measurement and 
is discussed and explained at the medical data review conducted at the 
end of the clinic visit. If the alert is Emergent, the participant is transported 
to the nearest emergency facility and her/his HCP is notified by telephone. 
If the alert is Immediate the participant’s HCP is notified by telephone at 
the time of the medical data review at the completion of the clinic visit. If 
the alert is Urgent, an alert letter (M2A6.1-6.2) is sent to the HCP. If the 
alert is Routine level 1 or 2, a letter is sent to the HCP (M2A6.1-6.2) 
recommending a one or two month appointment, respectively.  



248 

Exam 2 Cohort Procedures Manual.DOC 

 
If the participant does not have a HCP, the Social Worker is consulted and a referral 
process is initiated. 
 
2. Laboratory 
 

The laboratory technician receives panic and routine laboratory reports immediately from  
the Cholestech monitor reading at the time of the finger stick. The technician screens the  
results, identifies abnormalities and notifies the Clinic RN or Clinic Manager of the alert 
value. The Clinic RN or Clinic Manager reviews the laboratory results and confirms the 
alert category. 
 
The Cholestech alert values are as follow: 

 
Alert Category Glucose Lipids 

Emergent:  None None 

Immediate: Glucose:      < 45 or >500 

 

None 

Urgent: Gluc:     45-60 or 200-500 
          

TotChol:               >  360 
HDL:                    <    20 
LDL:                     >  260 
TG:                        >1000 
 

Routine: Any abnormal value not 
classified as an alert 

TotChol:      >200 -< 360 

HDL:           >20 < 35 

LDL:           >100 < 260 

TG:              >200 <1000 

 

If the alert value is determined to be Immediate, the JHS Medical Officer or EC Clinician 
on call is notified immediately (prior to participant leaving the clinic). The technician 
provides an immediate repeat finger stick analysis (if necessary, using a different 
monitor) of any results reported as a panic value. The JHS Medical Officer or EC 
Clinician reviews and confirms this level of alert finding and provides instructions to 
initiate participant and HCP notifications according to protocol definitions (described 
above) including any further recommendations. If the alert is Immediate, the participant’s 
HCP is notified by telephone on receipt of the abnormal value. The full laboratory report 
is Faxed to the HCP. If the alert is Urgent, an alert letter that includes the alert lab value 
is sent to the participant HCP (M2A6.1). If the participant has no HCP, s/he is notified by 
letter (M2A6.2) and instructed to call for HCP referral, if needed. 

 

If the participant does not have a HCP, the Social Worker is consulted and a referral 
process is initiated. 

 

C. Generating Alerts Reports 
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Alert values for reportable clinic examination findings are identified and addressed in the 
clinic at the time of the exam. The weekly medical data review also serves to identify any 
alert values that may not have been identified in earlier reviews. As described above, 
technicians conducting each element of the clinic examination identify alerts and notify 
the Clinic RN or Manager. The JHS Medical Officer or EC Clinician on call reviews alerts 
with the clinic nurse and directs alerts actions. Participant and HCP telephone calls are 
initiated by the Clinic RN with directions to the Clinic Receptionist to provide appropriate 
reports via Fax to the HCP. The Clinic Receptionist generates participant and HCP alert 
letters and examination results. The Clinic Manager reviews all alert letters and 
accompanying results for accuracy prior to mailing. 
 
1.       Compiling information  
 

Information for alerts reports is compiled by the appropriate technician as 
described above and delivered to the Clinic RN or Clinic Manager for review and 
confirmation of alert category.  

 
2.       Categorizing alert values 

 
The lead technician or Clinic Manager/RN, in consultation with the JHS Medical 
Officer or EC Clinician on call, categorizes the alert value(s) following identified 
protocol for each exam component (see above). The Clinic Manager or RN 
initiates the process of participant and HCP notification, making telephone calls 
and directing distribution of Fax reports to the identified HCP for Emergent or 
Immediate alerts. The lead technician or nurse notifies the Clinic Receptionist of 
the alert categorization.  
 

3.       Generating cover letters and results report  
 

The Clinic Receptionist will generate the appropriate alert letter as specified 
above for each exam component requested by the lead technician, Clinic 
Manager or RN. Once the letter and copy of result report are generated, the 
Clinic Receptionist delivers it to the Clinic Manager for review prior to mailing and 
documentation in the Medical Data Review and Alerts Referral/Reporting Log 
(ALT) in the DMS (see section D2, below). 
 

4.       Distributing reports 
 

The Clinic Manager reviews each participant / HCP letter and enclosed results 
report for accuracy prior to mailing. This quality control review is conducted to 
assure that the information matches the actual results for each participant and 
that the correct information is attached to each letter for each participant. 
Following this review, the letter is returned to the Clinic Receptionist for mailing. 
 
Prior to mailing the alert results report, the Clinic Receptionist makes a duplicate 
copy of the complete mailing (letter, results report, explanations) to both the 
participant and HCP. The copy is filed in the participant JHS file. 

 

D. Documenting Clinic Alerts and Referrals 
 

Any abnormal result found at any stage of the medical data review process (end-of-clinic, 
weekly review, comprehensive review) is annotated on the Alert and Routine Referral 
Log (ALT) and entered into the DMS.  

 



250 

Exam 2 Cohort Procedures Manual.DOC 

1. ALT form 
 

The Alert and Routine Referral Log (ALT) form is used to record all abnormal findings 
and subsequent referral action for any reportable result from the clinic examination. The 
form includes space for recording information on abnormalities in blood pressure, body 
mass index, body fat, blood glucose and lipids. For each exam component, space is 
provided to record the date the abnormal finding was received, the alert item/value, the 
date of referral action, the JHS code of the person completing the review, the type of 
referral action taken, the referral source and the method of notifying both the participant 
and her/his HCP. Specific instructions for completing the ALT form are included in the 
Forms Manual for Manual 2. 
 
The paper version of the ALT is maintained in the participant’s file. 

The Data Manager queries the Alerts Reporting Crystal Reports provided by the 
Coordinating Center to generate a monthly report of Alert and Referral actions on a 
designated date each month. This report is transmitted electronically to the Clinic 
Manager, the Chair of the Clinic Operations Committee, and the Director of the Exam 
Center for inclusion in the monthly agenda of appropriate committee meetings (e.g. Clinic 
Operations, A Team, Steering Committee).  
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WELLNESS 

HEALTH 

COMMUNITY 

Appendix 6.4 JHS Resource Manual 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

  
 
 
 
 
 
 
 

 

• How to stay well in Mississippi 
• Things you can do for yourself and others  
• Where to find help in your community 

 

Jackson Heart Study 
Resource Guide 
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What’s in the Guide? 
 
How to Use this Guide  Page 
 
BASIC NEEDS 
 
Food      7     
Housing     8 
Work      9 
Medical Care     10 
 
STAYING WELL 
 
Staying Well     11 
Coping With Stress    12 - 13 
Eating Well     14 - 15 
Exercise and Relaxation    16 - 17 
Mental Distress     18 - 19 
Disability     20 
Alcohol and Drugs    21 
Violence and Abuse    22 
 
 
GROWING OLDER 
 
Care for the Elderly    23 
 
COMMUNITY RESOURCES 
 
Local Physicians    24-28   
Health Care Resources     29 
Health Associations    30 
Community Support Services   31 
Hospitals     32 
Support Groups     33-34 
 
PRESCRIPTION INFORMATION  35   
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To Find the Subject You Want               

• Look through the list on page 4-5 

• For general topics see page 2    
 
 

 
To Find Community Services             
Local Phone Numbers for Community 
Services Agencies are listed at the back 
of the Guide.         
  
For Community Services that are not  
listed in this guide, please look in the table  
of contents in the Yellow Pages of the 
phone book under Social Services. 
       
Local numbers for many types of 
Services are in the Government 
Pages or White Pages in your phone book.  
 
 
Free Statewide Phone Numbers 

      

• Toll-free (800) numbers are included in the back of this Guide. 
 
 
 
         

        
You are welcome to contact the Jackson Heart Study Social Worker to assist you in 
obtaining other information or needed services. You can reach her by calling 601-815-
5050.      
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A-B_____________   Page 
 
Abuse     22 
Addiction    21 
Adult Day Care    23 
Adult Education    9      
Alcohol     21 
Anxiety     18 
 
C- D_______________  
 
Cancer Support    33 
Child Abuse Hotline   22 
Child Health Services   10 
Clinics     29 
Community Services   31 
County Hospitals   32 
Depression    18 
Disability Service   20 
Discrimination    9 
Domestic Violence   22 
Drugs     21 
Durable Power of Attorney  23 
 
E_____________ 
 
Eating Problems   15 
Education    9 
Elder Abuse    22 
Elder Care    23 
Emergency Food   7 
Emergency Housing   8 
Employment    9 
Exercise    16 
 
F_______________ 
Food Programs    7 
Food Stamps    7 
 
 
G- H___________ 
GED Programs    9 
Health Examinations   10 
Homeless    8 
Hospitals    32 
Housing    8 
Housing, Low-income   8 
 
 
I-J-K-L_____________ 
Insurance    10 
Job Training    9 
Jobs     9 
Long Term Care   23  
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M-N-O_____________ 
 
Meals On Wheels   7 
Medicare    10 
Medicaid    10 
Medi-Gap    10 
Mental Health    18 
Nursing Homes    23 
Overeating    15 
 
P-R-S_____________ 
 
Physician List    25 
Public Assistance   31 
Relaxation    17 
Renting     8 
Retirement    23 
Self Help    33   
Smoking    21 
Social Security    20 
Stress     12 
Support Groups 
 
T-U-V_________ 
 
Unemployment    9 
Veterans’ Services   9 
Violence    22 
 
W-X-Y-Z_______ 
WIC     7 
Wills     23 
Work     9 
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Basic Needs  
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Basic Needs 
 

Everyone has basic needs, like food, clothing and a safe place 
to live.  Without them, you can’t survive. Yet sometimes 
these needs can be hard to meet. 

 
This chapter contains ideas about things you can do 
for yourself and where to find help in your community. 
 

Food 
Emergency Food is available 
from community pantries, community 
centers, senior meal programs and churches. 
 
Government Food Programs, such as Food  

Stamps, School Breakfast and Lunch Programs,  
and the Women, Infants, and Children Program 

(WIC) are other resources for the low- income.  
 

Things You Can Do 
• Look for places with low prices 

• Find out about local community food programs.  

• Cut out coupons from the newspapers. 

• Add more whole grains and beans to your diet 

• Eat a wide variety of foods each week. 

• Eat fresh fruits and vegetables each day 

• Eat less fat, avoid fried foods and pastries 

• Eat nourishing soups. 
 
 
Where To Find Help 
 
Local Phone Numbers 
City of Jackson Senior Services  (601) 960-0454   
New Dimension Food Pantry             (601) 969-9856    
DHS (Food Stamp Office) (601) 362-9892 
WIC office                                       (601) 364-2666      
Meals n Wheels (601) 960-0438 
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Housing 
 
Good housing can be expensive. Many people are homeless, or 
just one paycheck away from it.  There are not many resources, but 
low-income housing is available for senior citizens and the disabled.   
 
There are also agencies that help with utility bills.   
 

Things You Can Do 
 
Looking for a home to Rent 
You cannot legally be turned down for housing because of 
race or a disability.  For advice, call the Fair Housing Authority.   

 
 
Neighborhood Problems 
Streetlights out? Too Noisy? Talk to neighbors, or call the City of Jackson.   
 
 
 
Homeless 
In the Jackson area there are emergency shelters for the homeless.  
Some shelters offer counseling and other services.    
 

 
 
 

 
Where To Find Help  
Local Phone Numbers 
Human and Cultural Services  (601) 960-0335 
Jackson Housing Authority   (601) 362-0885 
Regional Housing Authority            (601) 373-7040 
Hinds Co. Human Resources            (601) 354-3857 
   (Homeless Support Services) 
Veterans Homeless Services                    (601) 362-4471 
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Work 
 
A job with fair pay is a basic need.  Unemployment offices help people 
find jobs, and get benefits. 

 
 
         

 
 
  
  
 

 

 
Things You Can Do 
• Attend adult education classes to complete a GED program 

• Take classes at a community college or university. 

• Job training programs, such as Job Corps.   

• Temp agencies can help; look in the Yellow 
Pages 

• Veterans can get special help.  

• Stay healthy at work by taking regular breaks. 

• Report discrimination to the Equal Employment 
Opportunity Commission (EEOC).  

• Report dangers at work to management or the Occupational Safety and 
Health Organization (OSHA). 

• If you are injured at work, discuss with management how to apply for 
worker’s compensation benefits. 

 
 
 
 
Where To Find Help  
 
Local Phone Numbers 
 
Duling GED program  (601) 987-3695 
EEOC     (601) 965-4537 
Vet Center    (601) 965-5727 
WINN Job Center   (601) 321-7931 
Unemployment Insurance Office (601) 321-7937 
OSHA     (601) 965-4606  
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Medical Care 
Do you need to see a doctor or some other  
kind of health care provider?  Do you know where to 
go?  Medical care can be very expensive. If you do 
not have health insurance or money to pay for 
medical care, you can get low-cost treatment at the 
community clinic or a hospital.  The JHS Social 
Worker can also help you. See page 29 
 
Medicare covers seniors and people with 
disabilities. 
 
Medicaid covers certain individuals and families with low incomes and resources 
who need help paying for medical care. 
 

Things You Can Do 

To Find Medical Care 
Community clinics serve almost anyone, even if you have no insurance and do 
not qualify for Medicare and Medicaid.  Private clinics serve people who can pay 
or have insurance.  
Medicare pays medical costs for some people over 65, and some people with 
disabilities. You can buy “Medigap” insurance to cover costs not covered by 
Medicare. Sometimes you get Medicare automatically; other times you have to 
apply.   
Children’s Health Insurance Program (CHIP) provides free medical and dental 
check –ups for children from low-income families. 
Private Health Insurance 
Insurance is expensive and you usually have to pay part of the treatment cost. 
There are agencies that assist county residents who are uninsured or 
underinsured.  See page 29 

 
Where To Find Help 
Local Phone Numbers 
Medicaid     (601) 961-4361 
Medicare     (601) 965-6273 
Medicaid (CHIP)    (601) 359-6050  
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Staying Well 
 
We can prevent a lot of illness and suffering by learning to take better 
care of ourselves and each other. 
 

Think about your life and the people you 
live and work with. What are some 
changes that you would like to make? 
 
This chapter offers helpful information about 
diet, exercise, drugs, physical disability, 
mental health problems, violence and dying.   
 
Some problems we can solve alone, if we take the time to make a 
change. For other problems, we need help from a friend, a family 
member, professional, or a small support group. 
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Stress  
 

Are You Stressed?  
 
The signs vary.  
 
Are you: 
 
 Moody or depressed? 
 
 Getting aches and pains? 
 
 Having problems eating? 
 
 Not sleeping well? 
 
 Eating too much? 
 
 Drinking or smoking a 

lot? 
 
 Getting violent? 

   
 
 

Life can be 
demanding! 
     
Family, work, commuting to work 
and money issues can add to the 
stresses of daily life, and can cause 
a non-stop kind of stress that wears 
you down  
 
     Times of major change are the 
hardest, like divorce, or losing your 
job, or the death of someone you 
love.  Even happy changes, like the 
birth of a baby can be stressful. 

 
 
    

      
 
 
 
 

 
 

           
      

       
         

        
      

       
     
     

       
       

    
 

 Stress may mean you need to make some changes. Ignoring 
the signs can lead to bigger problems, even serious illness.  Think 
about what stresses you. Find ways to make a change. Help yourself 
feel better. Changing the way you live can be very difficult. It takes 
hard work and patience. You may need help. Talk to friends and 
family.  If you can’t cope, there are counselors and others in your 
community who can help. 
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Where To Find Help 
 
Local Numbers 
The Crisis Line     (601) 713-4357 
Healing Hearts First Baptist Church  (601) 949-1949 
Central Mississippi Medical Center  (601) 376-2600 
Mississippi Department of Mental Health  (601) 369-1288 
Mississippi Mental Health Association  (601) 351-8503 

Coping With Stress  
 

 Things You Can Do To Prevent Stress 
 
Think about what stresses you: 

• Learn your signs of stress. When they appear: 

• Take a break 

• Talk to a friend 

• Make a change you think could help you 

• Learn about deep relaxation 

• Avoid debt. Don’t buy what you can’t pay for. 

• Stand up for yourself 

• Find time for yourself every day 

• Take up a hobby 

• Try to keep a sense of humor  
 
 
Resist Illness: Adopt a Healthy Lifestyle 
• Nutritious Meals eaten slowly can be calming.  

• Exercise can give you some relief from stress.  

• Drugs and alcohol can make things worse.   

• Make sure to get enough sleep. 
 
 
Trouble Coping Alone? Get Help. 
• For help solving a family problem  seek counseling 

• Need a professional therapist? Call a mental health 
clinic. 

• Very depressed, even suicidal? Call Contact Crisis Line. 
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Healthy Eating For Cardiovascular Health 
 

Eating well may help prevent serious illnesses like diabetes, 
cancer and heart disease. The kind of foods you choose, and how 
much of them you eat are both important. Most experts agree that 
we should eat more whole grains, vegetables and fruit and less fat, 
sugar and salt. 

 
Enjoying your food is important, but remember: 
• Eat only when you are hungry 
• Choose a place where you can eat in peace 
• Stop when you feel full. 
 

Steaming, stir- frying, baking and micro waving meats and 
vegetables are healthier than deep- frying. 
 
Add pepper, lemon juice, or other spices rather than lots of salt. Mrs. 
Dash’s is a healthy alternative to salt. 
 
It is important to remember these food safety tips 

 
• Meat, milk and eggs should be kept in a cold place. 
• Always rinse fruits and vegetable before use. 
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Eating Problems 
 

Many people eat too much because they are bored, lonely, or 
depressed, or they are addicted to certain foods.  Others eat only 
small meals or make themselves throw up their food. These 
habits can be dangerous and hard to change. Join a support 
group like Overeaters Anonymous. 

Eating Well  
 
Things You Can Do 
 
• Eat a Variety of Foods 
• Use whole grain breads and cereals 
• Try to eat five servings of vegetables and fruits daily 
• Select low-fat or non-fat dairy products 
• Trim the fat from beef and pork 
• Skin chicken and turkey to reduce their fat content 
• Drink water or fruit juice instead of sodas, coffee and 

alcohol 
• Check food labels for fat, fiber, sugar and salt content. 
 
Cooking 
• Cut down on deep-fat frying, try stir-frying, baking or broiling 
• Use vegetable oil, like corn, canola or olive 
• Use less salt; too much can raise your blood pressure 
• Wash fresh fruits and vegetables to remove chemicals 
• Cook and eat with family or friends 
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Exercise 
 

 matter how old you are, exercise and relaxation can 
help you stay well, look good and live longer. 
 
Some kinds of exercise make you flexible. Some 
make you strong. Others give you stamina. You 
need all three. 
 
Regular exercise is best – several days a week, if 
you can, there are many ways: swimming, 
gardening, walking, jogging—each helps the body 
in different ways. Some people join a group; others 
exercise alone. 
 
Relaxing is also important. Read. Sing. Walk the 
dog. Play music. Write a letter. Get together with 
friends.  Even making a small change in your daily 
routine can be relaxing.  It’s never too late to start. 
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Exercise and Relaxation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

 
 
 
Where To Find Help 
Local Numbers 
YMCA    (601) 948-3091 
Baptist Healthplex  (601) 925-7900 
Parks & Recreation Office (601) 960-0471 

Things You Can Do 
 
Exercise Regularly 
• Make exercise a regular part of your life 

• Check with your health care provider about safe exercises 

• Start slowly; forcing your body could cause an injury 

• Exercise should be fun, so enjoy yourself 

• Exercise for 20-30 minutes, at least three times a week 

• Try different kinds of exercise 

• Instead of elevators, use the stairs 
 
Take Time to Relax 
• Find a quiet safe spot to sit or lie down 

• A few deep breaths can help release tension 

• Take a leisurely walk.  Or talk to a friend 

• Ten minutes of exercise can also ease tension 

• Relax with music, movies, reading, or by playing with a pet 

• Take a hot shower or bath 

• Soak your feet in warm water 

• Take at least one day of rest every week 
 
Other Places to Go 
• Classes at a YMCA or health club 

• A local library museum, or community center 

• A park, beach, swimming pool or recreation center  
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Mental Health 
 
 
 
 
 
 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Where To Find Help 
 
Local Phone Numbers 
Central MS Medical Center   (601) 376-2600 
St. Dominic Behavioral Health    (601) 200-3090 
Brentwood Behavioral Healthcare   (601) 936-2024 
MS State Hospital     (601) 351-8000 
Region 8 Mental Health Center   (601) 825-8800 
 

Many people experience severe mental distress at some point in their lives.  It may last 
only a few days or weeks; it may be there most or all the time.  It can make you feel very 
alone. 

 
The signs vary. You could feel: 

• overwhelmed or confused 

• frightened or angry 

• worthless or depressed 

• others do not understand you 

• everyone is against you 

• you cannot take care of yourself 

• you are going to hurt yourself, or someone 
else. 

 
Get help ignoring the signs, or denying there is a problem, can make matters worse. 
 
For serious mental illness, try to find a mental health specialist.  Public mental health 
programs offer some services and referrals, but treatment is not always easy to get.  
Family and friends may also be able to help.  Self-help groups, counselors and clergy 
offer important kinds of guidance and support. 
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Mental Distress 
 

Things You Can Do 
 
 
 

 

 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 
 
 
 

 

Treatment 
The main treatments are counseling and medication. Both can help people to 
lead a normal life, though drugs may have unwanted side effects. Most 
insurance plans don’t cover all the costs of treatment for mental health 
problemsso make sure to check your coverage. 

 

 

Do You Have a Mental Health Problem? 

• Learn to recognize the signs that you are becoming sick 

• Keep a journal: write down your symptoms and feelings 

• Tell friends your trouble signs; let them warn you. 

• A support group may help. See page 34 

• Be hopeful; don’t be ashamed. 

• You are entitled to respect like everyone else. 
 
 
Finding Help in a Crisis 
Call a mental health center. In a serious emergency, Call 9-1-1 
 
 
Spending Time With People in Distress? 

• Be patient. Recovery takes time. 

• Be sensitive. Treat the person with respect. 

• Take care of yourself too; take time away. 

• Encourage the person to continue treatment of some kind. 

• If the treatment is not helping, try to find an alternative. 

• Be understanding; invite them to do things with you. 

• Encourage the person to be independent. 
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Disability 
 

 

 

Things You Can Do 
 

 
 
 
 
 
 
 

 

Things You Can Do 
 
 
 
 

 

 
 
 
 
 
 
 
 
Where To Find Help 
 

Local Phone Numbers 
Social Security Administration  (601) 965-5377 
Vocational Rehabilitation  (601) 853-5100 

There are many kinds of disabilities, and many causes.  Some of us are born 
with them. Others are disabled by illness or injury. Physical disabilities limit the 
full use of your body, while people with developmental disabilities, may be 
mentally challenged or have problems communicating. 

 
Being disabled does not mean the person is sick or helpless.  People with 
disabilities can be as healthy and capable as anyone else.  Many organizations 
offer services ranging from job training and housing to transportation and sports. 

Disability Services 
 
Independent Living Centers help with counseling, job training, 
housing, benefits counseling, peer support, living skills classes and 
legal advice. 
 
Other Services and Benefits 

• For medical help, call the health department. See page 30 

• To find out if you are eligible for S.S. I. assistance, call the  Social 
Security Administration office. 

• For self-help groups.  See page 34 
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Things You Can Do 
 

For help with a Drug Problem 

• Realize that you are not alone 

• There are many people like you. 

• Find out about support groups.  See page 32. 
• Seek counseling or a drug treatment program 

• Be patient. Recovery takes time. 
 
Tobacco is also a health hazard.  Quitting is hard, but not 
impossible.  

 

Alcohol and Drug 
 

 

 

 

 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
Where To Find Help 
 

Local Phone Numbers 
ACT Tobacco Center      (601) 815-1181 
Baptist Behavioral Health Services    (601) 968-1102 
Brentwood Behavioral Health     (601) 936-2024 
St. Dominic Chemical Dependency Treatment Center (601) 200-3090  

Many people use some kind of drug.  It could be tobacco 
or alcohol, a prescribed medicine or an illegal drug.  
Regular use of many kinds of drugs can lead to 
addiction. 
 
The first step towards healing is to admit that you have a 
problem and need to make a change.  Then you need to 
find help.  Ask a health care provider or counselor who 
knows about addiction.  Drug treatment programs offer 
chances to start living without alcohol or drug; support 
groups can help you stay off them. 
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Where To Find Help 
 
Local Phone Numbers 
(DHS) Child Abuse Hotline   (601) 359-4991 
 

 

Violence and Abuse 
 
There are many types of violence and abuse.  They include: 

• Domestic violence 

• Child abuse 

• Neighborhood Violence 

• Abuse in a Nursing Home or at Work 
 
 
 Things You Can Do 
 
If you are attacked 

• Go to a safe place 

• Call 9-1-1. 

• For a place to stay, call an emergency shelter.   

• For general help, find a counselor 

• To report child abuse or elder abuse, contact the Department of 
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Growing Older 
 

Care For the Elderly 
Growing older can bring happiness and 
satisfaction, but can also be difficult.  You may be 
living alone, just when you are having trouble 
taking care of yourself. You may have health or 
money problems. There are many Community 
Services that the elderly may need at this time in 
their lives. They range from medical care, 
prescription assistance, financial planning, legal 
services, and other senior services.  The Aging 
and Adult Services agency can assist seniors 

         
   

 

 
 

 

Things You Can Do 

• Work to maintain a healthy lifestyle, by eating right and staying active. 

• Get financial advice. Try to save money. 

• Contact the local senior service agency for help with resources, such as food, 
clothing, shelter, utilities, etc.  

• To get help applying for Social Security, Medicare or Medicaid.   

• To get help paying for prescriptions. 

• To get information about home care, senior housing, and live- in facilities, such as 
personal care homes or nursing homes.  

• Protect Your Wishes about medical care. 

• Have a ‘Durable Power of Attorney for Health Care’  

• Have a will stating where you want your property to go. 
 

Where To Find Help 
Local Phone Numbers 
Deliver Me (Senior Support Services)  (601) 354-4646 
Social Security Administration   (601) 965-5377 
City of Jackson Senior Services                         (601) 960-0454    
Medicaid      (601) 961-4361 
Medicare      (601) 965-6273 
Aging and Adult Services    (601) 359-4929 
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JHS Network Providers 
 
 
 

 
 
 
Internal Medicine 

 
 

Arhin Akwasi, M.D.     500 W. County Line Rd. 
       Tougaloo, MS 39174 
       (601) 957-6776 
 
Natalie Brookins- Reddix, M. D.   5903 Ridgewood Rd. 
       Suite 310 
       Jackson, MS 39211 
       (601) 899-3310 
 
Zina Lee, M.D.     5429 Robinson Rd Ext. 
       Jackson, MS 39204 
       (601) 914-0163 
 
Maurice McShan, M.D.    5908 Ridgewood Rd. 
       Jackson, MS 39211 
       (601) 899-3310 
 
 
Denzel Robertson, M. D.    1134 Winter St. 
       Jackson, MS 39204 
       (601) 948-5572 
 
Adesola Shekoni, M.D.    5160 Galaxie Drive 
       Jackson, MS 39206  
       (601) 713-0890 
 
 
Nurudeen Shekoni, M.D.    5160 Galaxie Drive 
       Jackson, MS 39206 
       (601) 713-0890 
 
 
Robert Smith, M.D.     1134 Winter St. 
       Jackson, MS 39204  
       (601) 948-5572 

The JHS Network Providers are a group of health care providers who have agreed to see 
Jackson Heart Study participants who do not have a regular source of health care and need 
treatment for abnormal JHS examination results. The JHS Social Worker can assist you to select 
a provider and to obtain affordable health care.  This list is constantly updated, so make sure to 
contact the JHS Social Worker for assistance in obtaining a referral. 
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Rosie Walker- McNair, M.D.   1600 N. State St. 
       Suite #301 
       Jackson, MS 39202 
       (601) 352-3440 
 
Indira Veerisetty, M.D.    12 Professional Pkwy 

        Ridgeland, MS 39157 
       (601) 856-2460 
 

Family Practice 
 
  
 Hursie Davis-Sullivan, M.D.   1814 Hospital Drive 
        Jackson, MS 39204 
        (601) 373-2940 
 
 Shunda Garner, M.D.    187 Doctor’s Drive 
        Pearl, MS 39208 
        (601) 939-8921  

        
       115 W. Madison St. 
       Bolton, MS 39041 
       (601) 866-7723 
 
Don Gibson, M.D.     811 Hwy 49 S.  
       Richland, MS 39218 
       (601) 932-5060 
 
Wesley Granger, M.D.    12 Professional Pkwy 
       Ridgeland, MS 39157 
       (601) 856-2460 
 
Samuel Okoye, M.D.    4304 Hwy. 80 W. 
       Jackson, MS 39209 
       (601) 922-4722 
 
Joyce Olutade, M.D.    1815 Hospital Drive 
       Jackson, MS 39204 
       (601) 815-5700 
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Andrea Phillips, M.D.    909 Westland Service Drive 
       Jackson, MS 39202 
       (601) 948-8501 

 
Earnest Rankin, M. D.    2570 Bailey Ave.  
       Suite F 
       Jackson, MS 39213 
       (601) 366-1693 
 
David D. Richardson, M.D.    1551 E. County Line Rd. 
       Jackson, MS 39211 
       (601) 957-2273 
 
Harvey Sanders, M.D.    5429 Robinson Rd. Ext. 
       Jackson, MS 39204 
       (601) 914-0163 
 
       1134 Winter St. 
       Jackson, MS 39204 
       (601) 948-5572 
 
 
Selika Sweet, M.D.     4635 Hwy 80 E 
       Pearl, MS 39208 
       (601) 936-3833 
 
 
Cassandra Thomas, M.D.    514C E. Woodrow Wilson 
       Jackson, MS 39216 
       (601) 981-7198 
           

General Practice 
 
Oliver Cunnigen, M.D.    1134 Winter St. 
       Jackson, MS 39204 
       (601) 948-5572 
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Specialty Clinics 
  

Cardiology   
 
Myrna Alexander, M.D.    971 Lakeland Dr., Suite 850 
       Jackson, MS 39216 
       (601) 981-8543 
 
Tellis Ellis, M.D.     971 Lakeland Dr., Suite 850 
       Jackson, Ms 39216 
       (601) 981-8543 
 
Richard Rayford, M.D.    971 Lakeland Dr., Suite 850 
       Jackson, Ms 39216 
       (601) 981-8543 
 
 
Malcolm Taylor, M.D.    971 Lakeland Dr., Suite 850 
       Jackson, MS 39216 
       (601) 981-8543 
 

Gastroenterology 
 

  
 Mark Wilson, M.D.     1421 North State St. Ste. 203 
        Jackson, MS 39202 
        (601) 355-1234 
Nephrology 

 
Gary Davis, M.D.     5903 Ridgewood Rd, Ste 340 
       Jackson, MS 39211 
       (601) 899-3340 
 
Hollye Johnson, M.D.    5903 Ridgewood Rd, Ste.340  
       Jackson, MS 39211   
       (601) 899-3340 
 
Tunde Olutade, M.D.    5903 Ridgewood Rd, Ste 340 
       Jackson, MS 39211 
       (601) 899-3340 
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Podiatry 
 
 Willie James Lewis, DPM    128 Poindexter St. 
        Jackson, MS 39203 
        (601) 355-0026 
 
 Robert Woodruff, DPM    3855 Azalea Drive 
        Jackson, MS 39206   
        (601) 366-7063 
Pulmonary 
 

Obie McNair, M.D.     1134 Winter St. 
        Jackson, MS 39204 
        (601) 948-5572 
 

Joyce Wade, M.D.     1151 N. State St. #301 
        Jackson, MS 39202 
        (601) 352-0041 
 
Urology 
 

Ronald Davis, M.D.     971 Lakeland Drive, Ste. 315 
        Jackson, MS 39216 
        (601) 982-0982 
 

Lionel Frasier, M.D.     971 Lakeland Drive, Ste. 315 
        Jackson, MS 39216 
        (601) 982-0982 
 
 Felix Gordon, M. D.     971 Lakeland Drive, Ste. 315 

Jackson, MS 39216 
(601) 982-0982 
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Community Healthcare Resources  
 

Resources in Hinds County for the Uninsured  
 
Health Care Referrals for uninsured/underinsured participants, who are residents 
of Hinds County, are made to the Hinds County Health Alliance (HCHA).  The 
HCHA located at the Jackson Medical Mall, is a nonprofit organization that 
assists Hinds county residents obtain health care.  The Hinds County Health 
Alliance coordinates care services that include: 1) primary care at a discounted 
cost, 2) prescription drug assistance, 3) transportation assistance, and 4) case 
management. The address and phone number is: 

 
Hinds County Health Alliance 
350 W. Woodrow Wilson, Suite 615 
Jackson, MS 39213 
(601) 362-3010 

 
Jackson Hinds Comprehensive Health Center 
3502 W. Northside Drive 
Jackson, MS 39213 
(601) 362-5321 
 
UMC Adult Medicine Clinic 

 Jackson Medical Mall 
 350 W. Woodrow Wilson Blvd. 
 Jackson, MS 39213 
 (601) 815-1420 
 

Hinds County Health Department 
350 W. Woodrow Wilson Drive, Suite 411-A 
Jackson, MS 39213 
(601) 364-2666 
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Healthcare Resources in Madison County for the Uninsured  
 
Health Care Referrals for uninsured/ under-insured participants who are 
residents of Madison County are made to G.A. Carmichael Clinic located 
in Canton. The type of assistance offered includes: medical, dental and 
eye exams, pharmacy, lab work, WIC, diabetic foot care, immunization, 
medical screening, and transportation.  The address and phone number 
is: 
 
G.A. Carmichael Clinic 
1668 Peace St. 
Canton, MS 39046          
(601) 859-5213   
 
Madison County Health Department 
317 N. Union Street 
Canton, MS 39046 
(601) 859-3316 
 
 

Healthcare Resources in Rankin County for the Uninsured 
 
 Family Health Care Clinic 
 4635 E Hwy 80 
 Pearl, MS 39208 
 (601) 933-2500 
 
 Family Health Care Clinic 
 1551 W. Government St. 
 Brandon, MS 39042 
 (601) 825-3163  
 

Rankin County Health Department 
 100 Tamberlin St.  
 Brandon, MS 39042 
 (601) 825-2141 
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HEALTH ASSOCIATIONS 
 
Alzheimer’s Association    American Red Cross   
877-525-4357     601-353-5442 
 
American Cancer Society    Arthritis Foundation, MS Chapter 
601-362-8874     601-206-7726 
 
American Diabetes Association   Diabetes Foundation of MS, Inc. 
601-932-1118     601-957-7878 
 
American Heart Association   Epilepsy Foundation of MS 
601-321-1200     601-936-5222 
 
American Lung Association   Lupus Foundation of America 
601-362-5453     601-366-5655 
 
American Parkinson’s Disease Association Muscular Dystrophy Association 
800-223-2732     601-936-6862 
 
Community Support Services 
 
Catholic Charities 601-355-8634   Department of Human Services  
Mon. – Fri. 8:30 a.m. – 5:00 p.m.   601-362-9892  
Services include: homemaker and  477 Medgar Evers Blvd. 
caregiver services.      Jackson, MS 39213  

      Services provided: public assistance 

Clinton Community Christian Corporation 
601-924-9436 
Services Provided: Group Meals, Home 
Delivered Meals, Transportation 
Meal Site: 2001 Northside Dr., Clinton 
 

Deliver Me Senior Support Services 
601-354-4646 
Services Provided: Financial Assistance for 
medicine, eyeglasses, food, etc. 
 

Madison County Meals on Wheels 
601-859-5747 
Service provided: Meal delivery to seniors 
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HOSPITALS 
 

Hinds County 
 
Baptist Medical Center   St. Dominic 
1225 North State St.   969 Lakeland Drive 
Jackson, MS 39202-2002   Jackson, MS 39216 
601-968-1000    601-200-2000 
 
Central MS Medical Center  University Medical Center 
1850 Chadwick Drive   2500 N. State Street 
Jackson, MS 39204    Jackson, MS 39216 
601-376-1000    601-984-1000 
 
 
River Oaks Hospital Women’s Hospital At River Oaks 
1030 River Oaks Drive   1026 Flowood Drive 
Jackson, MS 39208    Jackson, MS 39232  
601-932-1030    601-932-1000    
   
  
Madison County 
 
Madison County Medical Center 
Hwy 16 East 
Canton, MS 39046 
601-898-4049 
 
Rankin County 
 
Rankin Medical Center 
350 Crossgates Blvd. 
Brandon, MS 39042 
601-825-2811 
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SUPPORT GROUPS 
 
 

Alzheimer’s Support Groups 
 
University Medical Center Alzheimer’s Support Group 
 601-815-8498 
 
VA Hospital Alzheimer’s Support Group 
601-362-4471 ext. 11038 
 
Cancer Support Groups 
 
Cancer Masters First Baptist Church 
601-949-1949 or 601-939-7251 
 
Central MS Medical Center  
601-376-1172 
 
Chapel of the Cross General Cancer 
Support Group 601-856-2593 
 
C.O.P.E (Cancer Outreach Provides Empathy) 
Methodist Medical Center 
601-376-1163 
 
Leukemia Society Support Group 
601-948-6262 
 
MS Baptist Medical Center Support Groups 
601-948-6262 
 
St. Dominic Cancer Support Group 
601-364-3979 
 
Caregiver Support Groups 
 
Baptist Adult Day Care 
601-956-7794 
 
St. Dominic Caregivers Support Group 
601-200-6468 
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Grief Support Groups 
 
Bereavement Education/ Support Group 
Hospice Ministries 601-989-1053 
 
Friends in Crisis 
601-936-9492 
 
Healing Hearts 
First Baptist Church 601-949-1949 
 
St. Dominic Behavioral Health Services 
601-200-3110 
 
Literacy Support Groups 
 
Jackson Program For Adult Readers 
601-987-3695 
 
Literacy Programs Governor’s Office of Literacy 
601-432-6591 
 
Reading Help Program 
601-981-359-3778 
 
Stroke Support Groups 
 
Stroke Support Group 
Methodist Rehabilitation Center 
601-981-2611 
 
Self Help Groups 
 
Alcoholics Anonymous 
(601- 982-0081 
 
Gamblers Anonymous 
601- 471-4333 
 
Overeaters Anonymous 
601- 957-0321 
 
Narcotics Anonymous  
601- 949-9499 
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Prescription Resource Information 
 
The Medicare Discount Card (1-800-633-4227) is only one of a number of 
programs available to help Medicare beneficiaries receive discounts on the price 
of their prescription drugs.  Other Drug Discount Cards may be used as well. 
 
Some of the other Discount Drug Cards are: 

• Share Card (Pfizer)     1-800-717-6005 

• Lilly Answers Card (Lilly)    1-877-795-4559 

• Care Card (Novartis)    1-866-974-2273 

• Orange Card (GlaxoSmithKline)   1-888-672-6436 

• The Merck Assistance Program   1-800-727-5400 

• The Nordisk Patient Assistance Program 1-800-727-6500 

• Bayer Patient Assistance Program  1-800-998-9180 
 
Discount Drug Cards to help the uninsured/underinsured are: 

• Partnership for Prescription Assistance  1-888-477-2669 

• Together RX Access Program   1-800-444-4106 

• My Free Medicines     1-800-620-7620 
 

In addition, there are some web sites dedicated to helping patients in getting the 
medicines they need.  Some of those web sites are: 

• www.pparx.org 

• www.HelpingPatients.org 

• www.rxassist.org 

• www.rxhope.com 

• www.benefitscheckuprx.org 

• www.needymeds.com 

• www.Qdrug.com 

• www.themedicineprogram.com 

• www.resourcesforseniors.com/prescript.html 

• www.myfreemedicine.com 

• www.together-rx.com 
 

JHS participants can work with their health care provider and local pharmacies to 
determine which discount drug card best suits their needs. 

http://www.pparx.org/
http://www.helpingpatients.org/
http://www.rxassist.org/
http://www.rxhope.com/
http://www.benefitscheckuprx.org/
http://www.needymeds.com/
http://www.qdrug.com/
http://www.themedicineprogram.com/
http://www.resourcesforseniors.com/prescript.html
http://www.myfreemedicine.com/
http://www.together-rx.com/
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FOREWORD 
 
This manual is one of a series of protocols and manuals of operation for the Jackson Heart Study 
(JHS).  The complexity of the JHS requires that a sizeable number of procedures be described, 
thus this rather extensive list of materials has been organized into the set of manuals listed 
below.  Manual 1 provides the background, organization, and general objectives of the JHS 
Study.  Manuals 2 and 4 describe the operation of the Cohort Procedures, Blood Pressure and 
Events Ascertainment Components of the study.  Detailed Manuals of Operation for specific 
procedures, including those for Blood Pressure and Quality Assurance, make up Manuals 4 and 
5.  The Data Management System is described in Manual 6. The Central Laboratory and 
Specimen Repository is described in Manual 7.  Manual 8 is designed to provide volumetric CT 
image data for measuring coronary and abdominal aortic calcified plaque as well as measuring 
body composition in the abdomen. 
 

 
 

JHS Study Protocols and Manuals of Operation 
MANUAL TITLE 

1 General Description and Study Management 

2 Cohort Component Procedures 

3 Blood Pressure 

4 Morbidity Mortality Classification Manual 
/Cohort Events Ascertainment  

5 Quality Assurance 

6 Data Management 

7 Central Laboratory and Specimen Repository 
Collection and Processing 

8 Computed Tomography (CT) Scan 

  
 9 MRI Forthcoming 



 II 
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1. Introduction 
 

The Jackson Heart Study (JHS) is a single-site prospective epidemiologic investigation of 
cardiovascular disease (CVD) among African-Americans from the Jackson, Mississippi 
metropolitan area. This study represents an expansion of one of the study sites of the 
Atherosclerosis Risk in Communities (ARIC) Study which included four geographically diverse 
communities in the U.S. (northwestern suburbs of Minneapolis, Minnesota; Washington County, 
Maryland; Forysth County, North Carolina; and the city of Jackson, Mississippi). 

TRAINING OF TECHNOLOGISTS 
 
Dr. Carr has performed on-site training January 10-12, 2007. The training sessions included 
didactic, small groups and hands on training. Following the course the technologists will complete 
the certification test and observe CT scans of participants and QC procedures. They will leave 
with a comprehensive understanding of the CT protocol. It is anticipated that upon completion 
they will be “Provisionally Certified”. They will have knowledge and training material for the other 
technologists at their site. During the pilot phase the technologists will complete the 3 certification 
exams on their CT system. Each of these scans will also be rated on technical quality criteria and 
immediate feedback will be provided. These exams will be reviewed by the CTRC personnel and 
either further training for full certification will occur.  
 
 
2. CT Exam Protocol and Procedures 
 
2.1 Field Center Scheduling 
 

The JHS local investigators will arrange details of scheduling participants for the CT 
exam.  Scheduling details will be mutually agreed upon between the CT scanning center 
and Field Center. A Field Center interviewer/scheduler will be responsible for 
explaining and obtaining consent for the CT examination including pregnancy 
screenings.  Participants will be scheduled for a certain date and time, and escorted to 
the CT scanner.  The Field Center will take the participant and CT Scan Worksheet (see 
Appendix B) which identifies the participant by name. The CT Technologists need to have 
the individual’s real name to confirm identity.  The CT Scan Worksheet provides the 
detailed information required by the CT scanning sites for labeling and performing the CT 
exam (See Appendix B). 
 
Required information for the CT scheduling form includes the participant’s name (for 
scheduling and greeting purposes only), participant’s weight (as recorded at the clinic 
visit), and date of birth, JHS study ID and a secondary identifier called the “alpha code” 
which will replace the participant’s real name.  

 
2.2 CT Exam Overview 
 

The CT examination is designed to provide volumetric CT image data for measuring 
coronary and abdominal aortic calcified plaque as well as measuring body composition in 
the abdomen. The exam consists of scout images and one ECG gated series of the 
entire heart and a series through the lower abdomen. On average, 15 
minutes of participant time will be spent within the CT scan suite; this 
includes instructions, setup and imaging. In rare cases, the exam may 
require 20 minutes.  In many cases, the examination will be completed in 
less than 10 minutes. Participants will have ECG electrodes attached 
(according to your vendors recommendations) for cardiac gating and be 
instructed as to a standardized breath holding instructions.  

http://www.nhlbi.nih.gov/cgi-bin/redir.pl?url=http://www.bios.unc.edu/cscc/ARIC
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Figure 1 CT Exam – Detail of CT scan Series: 
 

Series Description No. of 
images 

Scan time ECG gating 

Series Description No. of 
images 

Scan time ECG gating 

1 Scout  2 < 8 sec no 
2 Heart / Coronary 

arteries  
50 15 sec yes 

3 Lower abdomen /L3-S1  44 20 sec no 
 

1Scout images will consist of a frontal and lateral low energy 2D scanogram when 
possible 
2Duplicate scans will not be obtained of the coronary circulation since previous studies 
have demonstrated minimal add value. 
3 Additional reconstructions will be made using a display field-of-view (DFOV) of 50 cm 
for the measurement of subcutaneous fat. These require no additional radiation exposure 
and simply represent additional copies of the already acquired data. 

 
 

2.3 Entering Participant Identifying Information  
 

The CT scanners to be used in this study store demographic, detailed scan technical 
information and the raw image data in the standard DICOM file format. Participant 
identifying information will be encrypted at each CT site for the following reasons: 
Safeguard participant confidentiality.   
Comply with federal requirements for medical information, Health Insurance Portability 
and Accountability Act of 1996 (HIPAA). 
Provide positive and redundant participant identification for CT image files now and in the 
future.  The data coordinating system has assigned a unique study identification number 
for each participant. The exact method will be decided upon by the coordinating center 
and CT scan site. Below is a method we have successfully used in prior studies. 
 
The Jackson Heart Study - study identification number (“J” + 6 digits) will be entered in 
the field on the CT scanner where the local medical record numbers is typically placed.  
An “alpha code” (5 letters) will be entered in the name field. The participant’s weight, 
date-of-birth, ordering physician (Dr. Herman Taylor, interpreting physician (Dr. Mike 
Doherty), will be entered on the demographics page of the GE Lightspeed Pro 16 after 
pressing the “New Exam” button.   
 
*** It is very important that you enter your technician ID initials on this screen. This may 
vary between CT vendors, but most systems have a field for entering the CT 
technologists name/initials. Please type your tech ID in this location. If you do not have a 
field for this on your CT scanner please call the CTRC for additional help in resolving this 
issue. 

 
 
Example CT Data Entry:   

Name    BJDEC (Exact format TBD) 
ID number:     J123456 
Date of Birth   03 MAR 1947 
Technologist   JJC 
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Gender    Male 
Weight    175  
Ordering Physician  Dr. H. Taylor 
Interpreting Physician  Dr. M. Doherty 
History    JHS research CT exam 

The series number and time stamp on each CT image will ensure proper identification of 
the respective series of the coronary and abdominal aorta CT scans. Scan technical data 
(site, CT scanner, kV, mA, fov, slice thickness, spatial resolution, kernal etc.) are 
automatically stored within 
the DICOM header as part 
of the DICOM standard for 
each image file and will be 
recorded and tracked by the 
CTRC.  
 

2.4 Pre-CT Exam 
Activities 

 
Subjects weighing more 
than 350 lbs (~160 kg) will be excluded from the CT exam. This exclusion is secondary to 
technical difficulties related to imaging individuals of this size and greater.   

 
Pregnancy Screening: The field center personnel will ask women if they have the 
potential to be pregnant and complete pregnancy screening process as detailed in the 
Clinic Exam procedures.  

 
CT inclusion criteria: 
 
Enrolled in JHS study, eligible for the CT exam with signed consent obtained.  
Pregnancy screen completed if applicable 

 
CT exclusion criteria: 
 
1. Weight greater than 350 lbs (~160 kg).  
2. Pregnant or pregnancy status unknown  
3. Female participant < 40 years of age 
4. Male participant < 35 years of age 

 
2.5 Participant Preparation at the CT Scan Site 
 

The CT Tech: 
 
1.  Reviews the CT Scan Worksheet with the JHS Study ID and alpha code. 

 
The technologist will instruct the subject on the importance of breath holding and 
immobility during scanning. The technologist will attach 3 electrocardiography electrodes 
under the righ and left clavicle and on the left side of the thorax near the axilla (to 
maximize ECG signal) or as instructed by your equipment provider. 

 
2.6 Positioning the Participant and Calcium QCT Phantom on the CT couch 
 

The participants will be positioned for the study feet first. The rectangular 3 sample 
calcium calibration QCT Phantom (Image Analysis, Columbia, KY) will be placed 
underneath the participant and is long enough that it can extend from the top of the chest 
to the sacrum (or tail bone).  The phantom will not need to be repositioned between the 
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cardiac and abdominal CT scans. The QCT phantom will be inside the special padded 
cushion to make it comfortable for participants. The long axis of the QCT phantom should 
parallel the participant’s spine. The phantom is made of tissue equivalent plastic with 
rods of hydroxyapatite of known radiographic density. The density is demonstrated in the 
figure below: 

 
 
 
2.7 Scout Image of the Thorax  
 

The technologist will instruct the participant 
about  
the importance of holding still and holding 
their 
breath when instructed during the CT exam. 
The standard breathing instructions, (at end-
inspiration), have been pre-recorded using 
the auto-voice feature. This standard voice 
will be used during the scouts, cardiac and 
limited scan of the abdomen.  Two scout images of the thorax (Frontal and lateral scout 
images, ka scanograms or tomograms) which will include  
the entire chest,  abdomen and pelvis will be obtained. (see adjacent figures). 

 
The technologist performing the scan will check 
participant centering and position of the Calcium 
CT Calibration Phantom . The technologist will then 
choose the start position for just above the carina of 
the trachea. The end location of the volume 
acquisition will be beyond the diaphragmatic aspect 
of the heart so that the entire coronary arterial 
system will be imaged. The CT couch will be 
moved to the start position.  The technologist will confirm correct positioning of the 
calcium phantom on the scout image, correct prescribing of the start and end scan 
locations and appropriate ECG gating and if all are acceptable will then precede with 
scan. 

2.8 Heart 1 CT Scan Series 
 

Scanning procedure for cardiac gated CT scans of the coronary arteries are based on the 
standard protocols developed as part of the NHLBI’s MESA and CARDIA studies (Carr 
et. al. Radiology 2005; 234(1):35-43.) . To ensure complete coverage of the entire heart, 
a minimum of 10.5 cm of image data in the z direction (head-to-foot) will be acquired with 
each scan. This coverage results in 44-60 slices depending upon the length of the heart. 

The heart scans will be reconstructed centered on the 
heart 
using 
a 
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display field-of-view of 35 cm. This will include the Calcium QCT phantom within the 
images as well as the majority of the lungs. 

 
**** One of the CT quality factors is inclusion of the phantom on the cardiac CT images – the 
technologist should confirm that the entire QCT phantom (i.e. all four cylinders) are visible on 
each slice – if not reconstruct the images altering the left-right or anterior-posterior positioning 
while maintaining a 35 cm DFOV to include the entire phantom. **************** 

 
 Technical Parameters for each CT system is in Appendix C. 
 
Participant Weight and the CT exam: 
 
Participants weighing more than 350 lbs (~160 kg) will be excluded from the CT exam. As 
individuals become larger more X-ray photons are stopped or attenuated by their tissue. This 
means that there are fewer photons making the trip through the participant to make an image. 
This results in decreased image quality. To compensate, the tube current (or mA) will be adjusted 
upwards (25%) for participants who weigh more than 100 Kg (220 lbs.) at their clinic visit. This is 
why clinic personnel must record weight on the CT completion form, in addition the CT tech must 
append the weight after the name.   
This adjustment, although imperfect, will maintain a more constant signal-to-noise ratio (or photon 
flux) across participants of varying weights and result in improved image quality and calcium 
measurement. Note that this along with all the additional technical and demographic information 
including individual time stamps for the scan, scan series and individual image is recorded in the 
DICOM header which is part of each image and will be available on the CT image library of all the 
JHS studies as part of our quality control procedures.  
 
Reconstruction Parameters: 
 
The following technical parameters should be entered into a memorized protocol on each CT 
system, which should greatly facilitate protocol compliance. All series will be performed using the 
large scan field-of-view. This may also be referred to as the “body” as opposed to the “head” scan 
field-of-view. The technologist will reconstruct using a display or reconstruction field-of-view of 35 
cm (or 350 mm). Why are we scanning the heart with a 35 cm fov? By reconstructing with a 35 
cm fov we insure that the QCT phantom is included in the reconstructed images. It is very 
important when prescribing the scan to make sure that the anterior-posterior center is 
such that the entire phantom is included in the image. You will have to center AP behind 
the heart on individuals with very large chest. If while reviewing your images you see that 
the phantom is partially clipped off, reconstruct the series with the appropriate AP offset. 
Be sure to check this on all studies and if necessary reconstruct to include the phantom 
on the images.  The standard reconstruction kernel will be used for the two cardiac series. For 
the cardiac series, the 240 degree (cardiac CINE) segmented scan reconstruction algorithm will 
be used.  
 
Additional Reconstructions:  Two additional reconstructions of the same scan data will be 
made for measurements of surrounding tissues.  
 

1. “Hi-res Recon” Thin slice reconstruction at 1.25 mm – these images allow 
better definition of potential plaque by using thinner slices and may be useful 
for future analyses related to plaque characterization. 

 
2. “Max 50 cm Recon”. These images can be used along with the scout in 
       future studies to obtain information about body composition with attention  
       directed to the chest wall, muscles and  fat. 

 
Figure 2 - Table CT Image Reconstruction Parameters 
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Series Scan FOV Display FOV Kernel Recon. type 

Heart 1 Large / Body  350 mm GE=standard 

Siem=b30f 

Imatron=Sharp 

240° 
(partial)quic
k scan 

 
2.9       Breathing Instructions 

 
All CT scan sequences will be performed with suspended respiration and a single breath 
hold.  The cardiac scan series will require participants to suspend respiration a variable 
amount of time, ranging from 10 to 15 seconds, depending upon the combination of heart 
rate and heart length.  The technologist will instruct the participant as described above 
and then a standardized digitally recorded voice will provide breathing instructions. 
Breathing will be suspended at end inspiration to depress the diaphragm and liver for 
improved imaging of the heart. 
 

Standardized Script for breathing instructions: 
”Take a deep breath in… <5 sec. pause> 
”Blow it all the way out… <5 sec. pause> 
”Take a deep breath in… <5 sec. pause> 
”Blow it all the way out… <5 sec. pause> 
”Take a deep breath in and hold your breath ….. 
<15 second scan acquisition> 
”Breathe and relax” 
 

Though total imaging time will be less than 15 seconds, it will require about 5 to 7 minutes  
to complete. 
 
 
 
 
 
 
 
 
 
2.10 Limited Lower Abdominal Aorta CT series (L3-S1) 

Scanning Procedures for the Aorta:   
 

The scanning procedure described below will require 
approximately 5-10 minutes of the participant’s time. The 
technologist proceeds directly to prescribing the 
abdominal aorta scan from the initial scout image.  The 
abdominal aorta protocol requires a lateral scout image 
to identify the disk spaces and vertebra of the lumbar 
spine. The technologist will identify the three lower 
lumbar vertebra and scan from mid L3 through S1. (See 
adjacent figure with the start and end locations 
designated by the thick red lines). 

 
 

Helical Scan Acquisition of the Abdominal Aorta: The abdominal aortic scan will be 
prescribed graphically based on the location of L3 and S1 vertebra from the lateral scout image. 
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Why are we using S1 as at landmark? The Lumbosacaral junction is the most easily identifiable 
and consistent landmark identified in the abdomen/pelvis. Our objective is for you to scan the 
entire aspect of the two lowest lumbar vertebra, typically L4 and L5.  The protocol is designed to 
avoid imaging the true pelvis where in females the ovaries are located. We performed a study 
and have determined that 150 mm superior to S1 is above the renal arteries in all participants in 
our sample population. Other landmarks like the top of the diaphragm and counting the vertebral 
levels are variable between people and we believe are less reproducible. The CT scanners will be 
set at the technical parameters specified in the table below. Like in the cardiac scan we will adjust 
up the mA for those individuals that weigh more than 220 lbs. 

 

Figure 3 CT Technical Parameter for the Abdominal Aorta Scan: 

CT System Mode FOV Pitch1 Kernel 
/recon 

KV mA time mAs2 

GE 
LightSpeed 
Plus (WFU/MGH/UT) 

Helical 35 & 50 
cm 

4i 
3:1 
HQ 

Std 
/full 

120 300 
or51
5  

0.5 s 200 
150 

 
1Note pitch on multidetector CT systems have been described with competing 
conventions by different vendors, thus for the Siemens & Marconi systems the pitch can 
be explained as 3:1 [7.5 mm table travel per rotation over a 2.5 mm slice collimation] or 
alternatively as 0.75:1 [7.5 mm table travel per rotation over a beam collimation of 10 mm 
(i.e. in 4 slice mode 2.5 mm x 4 = 10 mm beam collimation)]. 
2mAs for the Abdominal Aorta scan was reduced (decreasing participant exposure) in 
May 2002 after review of the initial images from the pilot / vanguard phase of the study.  

 
Abdominal Aorta CT scan series will be acquired in the helical mode, full or 360° recon mode with 
a 2.5 mm slice collimation and a scan pitch of 3:1 or 0.75:1 depending upon the definition of pitch 
chosen by the CT scanner manufacturer for a particular system. A detailed definition of pitch is 
provided in the note below the table on technical factors. The CT Reading Center will confirm 
through the quality assurance scans performed on phantom objects that all protocol parameters 
are set appropriately. Human and software will check each pilot and participant scan for the key 
technical parameters related to image quality and radiation exposure to insure protocol 
compliance. Scans will be obtained during suspension of breathing. Technologist should instruct 
participants and use the same breathing script as used for the heart 1 and heart 2 series. 
 
Abdominal Aorta Reconstruction Parameters:   
 
The technologist will use the 35 cm field of view and the standard reconstruction kernel 
at 2.5 mm slice thickness. In addition, a retrospective reconstruction into a 500 mm 
(50cm) display fov will be performed so that we include the entire body in this set of 
images and an additional reconstruction at the 35 cm DFOV will be made using 1.25 mm 
slice thickness.  Because of significantly reduced motion of the abdominal aorta relative 
to the coronary arteries, the full or 360 degree reconstruction rather than the partial scan 
reconstruction algorithm will be used for the aorta scans.  Cardiac gating is not required 
and will not be used in imaging the abdominal aorta. The images will be obtained with 
participant’s holding their breath and using the standard breathing instructions 
(autovoice). 
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3.0 Radiation Dose Estimates for the JHS CT EXAM 
 
3.1  Introduction 
 
The CT exam involves the use of ionizing radiation (X-rays) to generate images of the 
participants, which are then analyzed to provide quantitative information for scientific 
investigation. The level of exposure utilized in the CT exam is on the same magnitude as that 
typically used in diagnostic imaging. The next section describes the potential risks of exposure to 
low levels of radiation and how this exposure compares to the average natural exposure of 3.6 
mSv annually.  The radiation exposure in this CT exam is well below the threshold for any 
observable direct dose related effects of ionizing radiation. Therefore the concerns of low-level 
radiation exposure for participants are the potential for (1) hereditary defects, (2) developmental 
defects for exposure of a fetus/embryo in utero and (3) cancer induction. The CT Exam is 
designed to minimize or eliminate these potential risks. Specifically the following steps have been 
implemented: 
 
1. To reduce the risk of any radiation induced hereditary effects, the gonads (testes and 

ovaries) are not directly irradiated in the CT exam.  
 

2. To, in all likelihood, eliminate the potential risk of any radiation induced developmental 
defects to an embryo/fetus as a result of a research CT exam, female participants who 
have the potential to be regnant (i.e. functioning ovaries and uterus) will be required to 
have a pregnancy test prior to being eligible for an research CT exam. In addition, the 
true pelvis which contains the uterus and ovaries receives negligible exposure related 
only to scatter photons since it is not directly imaged in the CT protocol. 
 

3. To further reduce the low risk of any radiation induced cancer, we are using as low a 
radiation exposure scan as possible to obtain the information necessary to accomplish 
the goals of this research.  

 
Participants in this study will receive a one-time exposure of less than 6.6 mSv. This level of 
radiation exposure is equivalent to less than two years of average annual background exposure 
(secondary to natural and man-made sources of radiation), less than the 7 mSv annual exposure 
of residents of Denver, Co, and much less than the 50 mSv annual exposure allowed for radiation 
workers.  

 
3.2  Radiation Exposure and Dose Calculation by Exam Component 
 
As specified in the preceding sections of this MOP, participants will have a CT exam that consists 
of the following components: 

 
Series Description No. of 

images 
Scan time ECG gating 

Series Description No. of 
images 

Scan time ECG gating 

1 Scout  2 < 8 sec no 
2 Heart / Coronary 

arteries  
50 15 sec yes 

3 Lower abdomen(L3-
S1) 

44 20 sec no 
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The heart scan is comparable to those currently in use in both the NHLBI-funded CARDIA and 
MESA studies. The lower abdomen scan is less coverage and thus lower exposure than the scan 
of the abdomen that is used in the NHLBI MESA, FHS-SCAN and Framingham Heart Studies. 
 
 
Participants undergoing the Entire CT exam will have the following:  
 
1. Peak radiation dose of approximately 2.5 rad (25 mGy) at the peripheral position 

(essentially the skin) of the patient.   
 
2. Highest doses to radiosensitive organs are approximately 0.65 rad or 6.5 mGy) to the 

lungs and slightly less than the skin dose (1.25 rad or 12.5 mGy) to the female breast. 
 
3. An estimate of effective dose would be 3.5 to 3.9 mSv for the entire CT exam and is 

itemized by scan series below:    
 

Figure 4 – Summary of Effective Dose Estimates 
Sequence Description Deff [mrem] Deff [mSv] 

1 Scout NA NA 
2 Heart / Coronary arteries 150 to 190 1.5 to 1.9 

3 Lower abdomen 
/Abdominal Aorta 

200 2.0 

 Total 350 to 390 3.5 to 3.9 
 
Note: Dr. McNitt-Gray, expert in medical physics and imaging states that the radiation exposure 
related to the low energy scouts / topograms are inconsequential in dose compared to the above 
series, as a result they are not detailed in the above table.  
 
These estimates of effective dose can be compared to the annual average effective dose from 
background radiation, which is 3.6 mSv/year and the annual whole body effective dose that a 
radiation worker (medical personnel, nuclear chemist or other radiation worker) is allowed on an 
annual basis (50 mSv/year).   
 
3.3  Detailed Discussion of Dose Estimates 
 
Exam description 
 
The CT exam will consist of the series of scans described above with repeat series (total of 2) 
through the coronary arteries using standard techniques. 
 
Technical factors for each series used in the dose estimates 
 
1.  Coronary Scans 1 and 2 (which are identical sequences) 
Using the GE LightSpeed multidetector scanner, the standard protocol will be employed: 
• 8 x 2.5 mm collimation (8i axial) mode with 20 mm table increment (contiguous scans) 
• Prospective EKG gating; x-ray beam is only on 2/3 of a scan rotation 
• 120 KVp, 400 mA, 0.26 second scan time = 104 mAs 

Scan Coverage:  2 cm below the carina extending to the base of the heart. 
 
Peak Radiation Dose 
 



 10 

Estimated radiation dose (CTDI) is reported below using the technical factors described above for 
each sequence.  These values were calculated based on measured values using a standard test 
object (CTDI 32 cm-diameter body phantom) in comparable scanners (GE LightSpeed) at UCLA: 
 
For one prospectively ECG gated low dose  heart scan the peak dose is 12.5 mGy (1.25 rad). 

3.4 Effective Dose Calculations 
 
Effective Dose is the sum of the weighted absorbed doses for all irradiated tissues, where the 
weighting factors represent the different risk of each tissue to mortality from cancer and 
hereditary effects. These weighting factors are higher for the gonads and lower for less sensitive 
organs (such as the extremities). 
 
These estimates were obtained by finding the average dose to each radiosensitive organ (based 
on the phantom radiation dose measurements described above and anatomical coverage for 
each sequence).  The weighting factors were then applied according to the description in the 
International Council on Radiation Protection Report 60.  These estimates were performed for 
each sequence and then summed to obtain the results for the entire exam. The results are 
summarized in table 2 above. 
 
For each coronary scan, the estimated effective dose is estimated to be 1.5 mSv (150 mrem) for 
men and 1.9 mSv (190 mrem) for women.  The difference is that the breast is irradiated in this 
scan, and because the breast dose carries a weighting factor of .05 of the total effective dose, the 
effective dose is higher for women. A similar effective dose was calculated for the abdominal 
scan used in FHS-SCAN and MESA studies of 2.7 mSv for both women and men is noted since 
neither gender’s gonads are directly irradiated. In this protocol the majority of the abdomen was 
imaged. In the Jackson Heart Study we are reducing the scan coverage by 30% and removing 
the liver, kidneys and marrow of the upper spine from the imaged region. Thus the a conservative 
estimate of the effective dose for this more limited scan area is 2.0 mSv. 
 
For the entire exam, the estimates of effective dose range 3.5 mSv for men to 3.9 mSv for 
women.  These values would compare with 3.6 mSv annual background exposure in the U.S to  
radiation and the 50 mSv whole body exposure annual limit for radiation workers.   
 

Therefore, the total effective dose from these scans for an average Jackson Heart 
Participant is significantly less than that allowed for radiation workers on an 
annual basis and is equivalent to about 1.1 times annual background exposure.  
However, because these estimates are based on population averages, these 
estimates should not be taken to provide an estimate of risk for any individual 
patient. 

3.5 Informing Participants of Radiation Exposure: 
 
To provide participants with a concise and understandable explanation of the radiation involved 
with the CT exam we have chosen to present the effective dose. The effective dose estimates the 
exposure by organ irradiated and allows the values to be compared directly with the annual 
exposure to natural sources of radiation (3.6 mSv) and the annual allowance for radiation 
workers(50 mSv). We believe that the alternatives of (1) simply providing a number out of context 
or (2) comparing the dose to other medical procedures, while informative to scientists and 
healthcare professionals, is less informative to the lay public. The following language is 
recommended to the field centers for informed consent concerning the CT exam. Local 
requirements or standard language may require modifications as appropriate. 

Recommended Language for Informed Consent 
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The estimated amount of radiation (effective dose) the average participant in this 
study will receive is less than 4 mSv. This amount of radiation exposure can be 
compared to the amount of radiation exposure you get each year from natural and 
man made sources which is 3.6 mSv (average annual background exposure to 
radiation in the U.S.).  The actual amount you receive for the whole CT exam 
depends on several factors such as how big you are and if you are a man or 
women. People who have jobs in which they work with radiation have a yearly limit 
of 50 mSv. This CT exam is about 8% of the yearly amount of radiation exposure a 
worker is allowed to receive each year.   

We believe the above language accurately and conservatively presents the information related to 
radiation exposure with the research CT exam and will allow our participants and potential 
participants to make an informed decision about involvement in this study.  

The investigators are aware that local review and approval of the CT protocol, as for other 
aspects of the study, must be made through the appropriate local Investigational Review Boards 
(IRB). In some cases additional review by radiation safety committees may be required. The CT 
Reading Center will provide assistance and the material contained in the manual of operation to 
the field center principal investigator and imaging investigator to facilitate and enhance the 
process as requested. 

4.0 CT Scan Site Procedures for Secure Networking of CT image to Wake Forest  
University CTRC 

 
The JHS CT Data Acquisition Center is located in the Jackson Medical Mall. The specific CT 
system is a GE Healthcare Lightspeed 16 Pro.  The standardized protocol has been stored on the 
CT system during Dr. Carr’s training visit and this protocol includes automatic routing from the CT 
scanner to the Wake Forest Univ. CTRC using secure networking protocols over the internet. The 
system uses Medical Imaging Resource Center (MIRC) software developed with support from the 
Radiological Society of North America (http://www.rsna.org/mirc/) in an open source environment. 
The software has been specifically designed to meet the needs of clinical trials and has been 
incorporated in the National Cancer Institute’s CA-BIG project. Dr. Carr has collaborated in the 
development of the clinical trials software applications.  A computer with the MIRC Field Center 
software has been installed in the CT control room at the Jackson Medical Mall. Upon completion 
of each exam the images are automatically networked to the MIRC PC. The MIRC Field Center 
System is set up to receive DICOM images from imaging modalities and forward these images to 
Wake Forest University’s research PACS. In order to ensure HIPPA compliance, this system is 
configured to de-identify patient health information before forwarding the images. Furthermore, 
the forwarding mechanism is based on the secure HTTP protocol using SSL networking. The 
cryptographic keys use the RSA/DES3 algorithms and are 2048 bits long and provide industrial 
strength security. The CTRC can receive images continuously and simultaneously from the JHS 
CT scanner 24 hours a day, 7 days a week. In addition the images are archived redundantly to 
prevent lose of image data during the transfer (CT scanner holds a temporary copy, UMMC 
sends the images to two independent PACS archives, the MIRC field center applications 
maintains a copy of all images until received successfully at WFU CTRC and once received we 
have extensive backup procedures detailed in the CTRC MOP. 
 
5.  CT Scanner Quality Assurance Procedures 

5.1  CT Scanner Certification and Quality Assurance 
 
The CT Scanners will complete a certification process prior to the pilot exam. During this process 
measurement of scan quality will be obtained concerning spatial resolution and contrast 
resolution with particular attention directed to the calibration of CT numbers.  
 

http://www.rsna.org/mirc/
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CT Certification Process: 
 

1. CT images will be sent to the CTRC to provide format of DICOM header and additional 
CT scanner specific information. 

2. CTRC will ship the Cardiac CT phantom (QRM-Germany) to the site and a series of 
scans of this phantom will be obtained (This was completed on Jan. 11, 2006). . 

3. The QCT phantom & torso phantom to be used throughout the exam will be scanned 
according to protocol (This was completed on Jan. 11, 2006). 

 
The purpose of the CT scanner certification process is to validate the CT scanners ability to 
measure the known amounts of simulated calcified plaque contained in the standard QCT 
phantom (Image Analysis, Columbia, KY). We will then use this information to fine-tune the CT 
protocol for the CT system. It will also allow us to ensure comparability to other CVD disease 
research studies that use CT such as MESA and the Framingham Heart Study. 
 
CT Calibration 
 
Calibration to Air (Baseline, then daily) - An initial baseline followed by daily scans will be 
obtained. This calibration is part of the daily scanner start-up routine. These procedures will follow 
the manufacturer’s recommended procedure. 
 
Calibration to Water (Baseline) 

An initial baseline calibration will be obtained and analyzed using a water 
phantom. These procedures will follow the manufacturer’s recommended 
procedure and will include zeroing and calibrating the scanner unit. 

Calibration to Calcium (Baseline, 1st and 15th of each Month) 
Each CT scanning site will be provided a standardized Calcium QCT Calibration 
Phantom which includes a Torso QA phantom for scanner calibration (Image 
Analysis Inc, Lexington, KY). The center plug of the Torso QA phantom contains 
a region with a known concentration of calcium hydroxyapatite (100mg/ml).  The 
Calcium QCT Calibration phantom contains four cylindrical rods with the 
following concentrations of calcium: 0, 50, 100, 200 mg/ml calcium 
hydroxyapatite. On the first and 15th of each month quality assurance scans of 
the torso phantom will be performed at the CT scan site. The analysis of these 
scans by the CT Reading Center allows convenient and quick verification of 
accuracy and precision of the CT scanners at different sites. 

Positioning the Calibration and Torso Phantoms. 
The table height of the CT couch will be positioned such that the center of the 
Torso Calibration phantom will be located at isocenter of the scanner field of 
view. 

Place the torso phantom on top of the calibration phantom (positioned in couch 
pad) and using your laser alignment light; adjust the table height until the torso 
center insert is at the location of isocenter on the CT scanner. This is the table 
height you will use for QA scans with your Torso phantom.  

Scanning the TORSO QA Phantom 
After the correct position has been determined, take a vertical axial slice through 
the center of the TORSO phantom.  Use the same parameters as with participant 
exams. Each site will perform a scout of the phantom followed by an axial scan 
(identical parameters to the heart series).  Reconstruction should be done with 
the same parameters as in scanning study subjects. Then display your axial 
image on your CT monitor and examine it to ensure that it is free of artifacts, 
such as air gaps and streaks.  Ensure that the calibration phantom is included in 
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the field of view.  If there are significant artifacts over the calibration phantom, 
you should discard the image and rescan the phantom.   

Using your CT software place ROIs on the calibration phantom reference 
samples (0, 75 150 mg/mL).  The 0 sample will be an apparent blank space on 
one end of the calibration phantom.  Then place an ROI in the TORSO vertebral 
sample.  The ROIs should be as large as practical while remaining completely 
within the reference cylinder.  (We recommend ROIs about 70% of the sample 
area.)  Record the five mean CT numbers within these five ROIs and send these 
numbers by FAX or E mail to the CARDIA reading center (Email, fax) using the 
standard QA forms provided (attached QA Data Sheet). Record the  mean CT 
numbers within these ROIs. The QA data sheet will then be filed in the local 
study 3-ring binder for your records. 

The QCT & Torso phantom scans provide valuable information concerning the 
CT scanner and any change over time (temporal drift). It is critical that these 
scans be performed and the results & images be sent to the CTRC. 

***** Torso QCT scans will be performed on or about the 1st & 15th of each month*****  
 
Some common sources that cause poor results include: inappropriate table height (TORSO plug 
should be at isocenter when scanned); mal-positioning of the phantom; old or improper CT 
calibrations; use of improper scan parameters.  
6.0  CT Technologist Training Material 
 
CT protocol training material will be provided for all technologists from each field site. The 
curriculum for the CT Training is presented in Appendix A and a draft of the electronic 
education material is in Appendix D.  

 

The instructional material will provide the technologist who will perform the  CT studies an 
overview of the study objectives, study organization and an introduction to the CT Reading 
Center personnel. It will detail the study protocol and quality control procedures. It will 
complement this manual of operation and provide pictures to facilitate learning the CT protocol. 

The experience in MESA and CARDIA with CT technologists is that in some cases multiple 
technologists at each site are performing protocol exams as part of their work schedule. 
Although it is desirable to minimize the number of technologists involved, this is, in most 
cases, outside the ability of investigators to designate. The WFU Reading Center has 
designed a program to accomplish the following: 

1. Identify the technologist performing each CT study 

2. Train and maintain skills of each CT technologist 

a. Train a “Master” technologist from each site at WFUHS 
CTRC 

b. Provide pre-certification material and exam for each 
technologist 

c. Provide Preliminary Certification until completion and 
review of the 3 studies on protocol. 

d. Time-limited certification for 6 months 

3. Provide feedback to CT technologist on an individual and by site 
basis 

4. Identify protocol variances / violations /and violations impacting 
participant safety 
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a. Retrain / enhanced training as needed   

b. Stop CT exams if needed to resolve problem 

The training material will consist of a CD with a PowerPoint presentation, this CT manual of 
operations and a pre-certification exam. Technologists will be required to read the 
PowerPoint training material and answer the pre-certification exam. Hypertext links will allow 
the technologist to link directly to the relevant material in the MOO. The pre-certification exam 
will allow the Reading Center to assign a unique technologist identification which will be 
entered on every scan performed by the technologist. After successful pre-certification, the 
next three exams will be performed in conjunction with the Master technologist. After these 
have been reviewed and accepted, the technologist will be given full certification for 6 
months. Every 6 months the Reading Center will create a new training presentation in 
PowerPoint focusing on core issues and any potential problems identified across all scan 
sites in the study. A brief questionnaire directed at these issues must be completed by each 
technologist and returned to the Reading Center to maintain certification. If problems are 
identified at a specific site, additional training by Dr. Carr may be required. He will review 
selected studies completed to date and discuss issues related to protocol compliance. 
Feedback will be provided to the technologists concerning their scan technique for the heart. 
Questions and issues they may have will be discussed and resolved as appropriate. These 
visits will take one working day each and will concentrate on obtaining adequate and optimal 
scan images using the CT scanning protocol. 

 
 



 
 
 

JHS Manual 8_V 1.0 01-12-2007     

15 

Appendices



 16 

Appendix A 
 

The central training curriculum for CT Technologists: 
 

Jackson Heart Study 
Technologist CT Training Course  

Schedule & Itinerary 
Jackson Medical Mall, Jackson, MS 

January 10-12, 2007 
 
 

1. Dr. Carr meets with JHS & UMMC personnel 
2. Dr. Carr meets with UMMC CT technologists and reviews training PowerPoint 
presentation, including interactive Q&A period. 
3. Hands on training with phantoms, QC, forms 
4. Calibration scans for testing CT scanner performance. 
 
 

CT Reading Center and Jackson Heart Study Site Visit 
January 10 – 12, 2007 

Jackson, MS 
 

Itinerary for Dr. Jeffrey Carr  
 
Wednesday, January 10 
 
 12 noon  Arrive at Jackson Airport 
 
 12:45 – 1:15 p.m.  Arrive at Jackson Medical Mall (JMM) 
   Jackson Heart Study (JHS) 
   Meet with Dr. Taylor 
    
 1:15 – 1:50 p.m.  Meet with Directors Council Members & 
   Tour JHS 
   JHS Conference Room 
    
 2:00 – 3:30 p.m.  Meet with Data Acquisition Center, CC & EC Staff 
   JHS Library 
 
 4:00 p.m.  Check into Marriott (downtown) 
   200 Amite Street 
   Jackson, MS    
   601-969-5100  
 
 7:00 – 9:00 p.m.  Dinner with JHS Investigators 
 
Thursday, January 11 
 
 8:00 – 9:00 a.m.  Prep meeting with Data Acquisition Center Staff 
   JMM - CT Station 
 
 9:00 – 9:15 a.m.  Break 
 
 9:15 – 12 noon  Training of CT Technicians and Pilot Testing * 



 
 
 

JHS Manual 8_V 1.0 01-12-2007     

17 

   CT Station 
 
 12 noon – 1 p.m.        JHS Seminar – Topic: “Medical Implications of Calcium Score”  
   Presenter - Dr. Jeffrey Carr 
   UMC Conference Room  
   (Lunch will be provided) 
 
 1:15 – 4:00 p.m.  Pilot Testing (continuation) * 
   CT Station 
 
 4:00 – 4:10 p.m.  Break 
 
 4:10 – 5:15 p.m.  Debriefing of Pilot Testing* and Review of Protocol 
   JHS Conference Room 
 
 5:15 p.m.  Activities Adjourn – Leave for Hotel 
 
Friday, January 12 
 
 8:00 a.m.  Check out of hotel 
   
 8:30 – 10:30 a.m.  Debriefing of Pilot Testing* and Assessment of Readiness  
                                                     for CT Studies 
   JHS Conference Room 
  
 10:45 a.m.  Leave for Airport  
   Flight leaves around 12 noon 
 
*NOTE: Since the CT Scan Protocol had not been approved by the UMMC IRB, Pilot Testing was  
replaced with the use of 3 volunteers, who are not JHS participants, to allow Dr. Carr to train 
technologists on body positioning and related skills.  UMMC Radiology Department will conduct 
Pilot Testing after IRB approval of the CT Scan protocol. 
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Appendix B – CT Scanning Worksheet 
CT Scanning Worksheet 

To Be Completed by CT Scheduler 

   

Last Name First Name MI 

   

Date of Birth Weight Sex 

  DR. H. TAYLOR 
Dr. M. DOHERTY 

CT Scan Date CT Scan Time Referring Physician 
  

  

JHS Study ID JHS Name Code 
 

To Be Completed by CT Technologist 

Series Description: Series Number: Number of Images 

Scout   

Heart: 35 cm FOV @ 2.5 mm   
Heart Retrorecon: 27 cm FOV @ 1.25 
mm   

Heart Retrorecon: 50 cm FOV @ 2.5 
mm   

Aorta: 35 cm FOV @ 2.5 mm   
Aorta Retrorecon: 27 cm FOV @ 1.25 
mm   

Aorta Retrorecon: 50 cm FOV @ 2.5 
mm   

  

Table Height:: 150  or    mA:  400 or 515 (if > 220 lbs) (circle 
one) 

Exam Number: Local Archive: Tech ID# 
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Comments:  
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Appendix C 
Appendix C: The CT Technical Parameters for each CT system 

 
System Mode FOV Multi-slice Kernel 

/recon 
time ECGgating 

GE LightSpeed 16 
Pro 

Axial/CI
NE 

35 cm 8 slice 
by2.5 mm 

Std /Partial 0.5 s Prospective 
70% 

 
 
 
Heart Scans: Adjusting mA / mAs based on Weight 

System KVp Gantryspeed 
[s] 

Exposure 
Time [s] 

Weight 
< 220 lbs 

Weight 
= > 220 lbs 

GE 
LightSpeed 16 
Pro 

120 0.50 s 0.33s 320 mA 
106 mAs 

400 mA 
133 mAs 

 
Note: The Siemens and Philips systems will enter mAs values while the GE systems will 
enter mA values. The appropriate value has been made bold in the above table. 

CT Technical Parameter for the Abdominal Aorta Scan: 
 
CT System Mode FOV Pitch1 Kernel 

/recon 
KV mA time mAs2 

GE 
LightSpeed 
Plus (WFU/MGH/UT) 

Helical 35 & 50 
cm 

4i 
3:1 
HQ 

Std 
/full 

120 300 0.5 s 200 
150 

 
1Note pitch on multidetector CT systems have been described with competing 
conventions by different vendors, thus for the Siemens & Marconi systems the pitch can 
be explained as 3:1 [7.5 mm table travel per rotation over a 2.5 mm slice collimation] or 
alternatively as 0.75:1 [7.5 mm table travel per rotation over a beam collimation of 10 mm 
(i.e. in 4 slice mode 2.5 mm x 4 = 10 mm beam collimation)]. 
2mAs for the Abdominal Aorta scan was reduced (decreasing participant exposure) in 
May 2002 after review of the initial images from the pilot / vanguard phase of the study.  

**** During Protocol Development and Training final adjustment to scanning 
protocols will be made **** 

 Table CT Image Reconstruction Parameters 
Series Scan FOV Display FOV Kernel Recon. type 

Heart 1 Large / Body / 55 cm 350 mm 

500 mm (retro) 

standard 240° (partial) 

Abd. Aorta Large / Body / 55 cm 350 mm 

500 mm (retro) 

standard 360° (full) 
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Appendix D: 
 
CT Technologist Training and Certification Procedures: 
 
The WFU CT Reading Center will coordinate with FC personnel for the training of CT 
technologists. The process will consist of: 

1) pre-certification training material 
2) pre-certification test 
3) detailed review and successful completion of  three complete CARDIA CT exams 
4) quarterly recertification test completion 

 
A lead technologist at each Field Center along with as many as possible participant technologists 
will be trained during Dr. Carr’s site visit and course scheduled for December 2006, exact date 
TBD.  This visit provides an opportunity for hands-on training and relationship building for the CT 
exam. During this visit a lead CT tech for the project is designated and trained. Detailed training is 
provided by an animated and graphical PowerPoint course provided by the CTRC. This course is 
based on the manual of operations(MOO) but includes actual CT exam images and pictures 
documenting critical aspects of the CT exam and quality control procedures. A written exam must 
be completed. Following the successful completion of the pre-certification exam the RC will issue 
a technologist ID number and preliminary certification. The RC will then review each exam by the 
Technologist and provide full certification once three exams have been completed with complete 
protocol adherence. Written quarterly recertification will be required to maintain skills. 
 
Figure 5 CT Technologist by Site 
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Center state 

& ID# 
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Licensing Tech ID # 

     
     
     
     
     
     
     
     

 
  

Figure 6 Technologist Training Record: 
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FOREWORD 

 
 
This manual is one of a series of protocols and manuals of operation for the Jackson Heart Study (JHS).  
The complexity of the JHS requires that a sizeable number of procedures be described, thus this rather 
extensive list of materials has been organized into the set of manuals listed below.  Manual 1 provides the 
background, organization, and general objectives of the JHS Study.  Manuals 2 and 10 describe the 
operation of the Cohort and Surveillance Components of the study.  Detailed Manuals of Operation for 
specific procedures, including those of reading centers and central laboratories, make up Manuals 3 
through 9 and 11. 
 
 

JHS Study Protocols and Manuals of Operation 
 
 

MANUAL TITLE 
  
1 General Description and Study Management 
  
2 Cohort Component Procedures 
  
3 Blood Pressure 
  
4 Morbidity and Mortality Classification Manual 
  
5 Quality Control 
  
6 Data Management System 
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1.0 INTRODUCTION  
 
 
1.1 Overview 
 
The Data Management System (DMS) is used to collect, process, and store information about 
participants in the Jackson Heart Study (JHS).  This user guide describes the steps in the collection and 
management of data entered in the DMS during a center exam interview, from paper forms, or through 
batch-loading of an ASCII file. 
  
The JHS DMS was developed using the Clintrial 4 (hereafter referred to as Clintrial) clinical research 
system software.  Clintrial consists of a set of integrated core modules for data collection, management, 
and retrieval.  This document specifically discusses the tasks using the Clintrial Enter module and Clintrial 
Manage module. 
 
Clintrial Enter allows for data entry, editing, verification (double data entry), and storage of data in a JHS 
study database.  Data checks are automatically performed during data entry by a check of a data value 
against predetermined edit specifications, and any value that fails a data check can be corrected 
immediately or flagged for future resolution. Built-in Clintrial reports and custom reports are available to 
check status of data entered and to look for any data inconsistencies. 
 
Data are entered into update tables and are referred to as unmerged data in Clintrial while in the update 
tables.  The data manager using the Clintrial Manage module moves data to the data tables.  The update 
and data tables are in an Oracle database, and Clintrial handles the storage and use of these data tables 
in a way transparent to the user. 
 
Using the Clintrial Manage module, a data manager can perform additional tasks in the management of 
the JHS data.  The person in this role has extended access rights to the study data tables and familiarity 
with the Clintrial database structures.  Tasks within the Manage module include batch-loading laboratory 
or ancillary data from an ASCII file, manual coding of medication data from industry-standard dictionaries, 
moving data from update tables to data tables, making global changes or deletions across multiple 
records, and reviewing processing logs and error or change reports. 
 
1.2 Sample Data Management Workflow        
 
Section 2 of this document provides the step-by-step instructions on each task for data entry.  Figure 1 
gives a visual representation of the data entry workflow.   
 
Section 3 of this document describes other tasks that are performed in the management of the JHS data.  
Figure 2 shows a data management workflow of the data entry and management tasks for the DMS. 
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Figure 1 Data Entry Workflow 
 
 Login to Clintrial and Start Data 

Entry Session 
 

 ↓  
 Set the Protocol  

↓ 
Set the Study Book 

↓ 
Enroll Subjects 

↓ 
Enter Data, 

Add Flags and Notes 
← 
→ 

Automatic Data Checking, 
Automatic Flags 

↓  
Verify (Re-enter) Data  

↓  
Edit Data 

↓ 
View Reports 

↓ 
End Data Entry Session and 
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Figure 2 Data Management Workflow 
 
 Enter Data (see Figure 1)  
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 Batch Load and Screen Laboratory 

and Ancillary Data 
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1.3 Data Entry Help Menu and Glossary of Terms 
 
The Help menu includes step-by-step instructions to perform tasks in Clintrial along with overviews of 
concepts and descriptions of the menus and options.  A glossary provides an extensive dictionary of 
special Clintrial terms.   
 
To search for information in Help: 
 
1. Select Help > Help Topics. 
2. To find a topic in the Help Topics dialog box: 

a) Click on the Contents tab for topics by category. 
b) Click on the Index tab for index entries. 
c) Click on the Find tab for a search on specific words. 

3. For the glossary of terms, click on the Contents tab and then double-click on Glossary at the top of 
the list.  

 
Additionally for help on an open window or dialog box, press F1. 
 
Some of the Clintrial terms and their descriptions that are found in this document are as follows: 
 
Protocol – a Clintrial account that consists of the data and other components used by the DMS for a 
research study. 
  
Study Book – an online representation of a list of the data collection forms.  Each study book contains an 
ordered list of study pages grouped into blocks. 
 
Block – a group of related study pages in a study book, usually representing a visit or contact occasion. 
 
Study Page – a data entry window that usually corresponds to a single data collection form, however 
some forms have multiple study pages because of a length limitation of the data entry window template. 
 
Study Page Number – a sequential number assigned to the study pages in their alphabetical order 
(usually) by form-version. 
  
Repeating Page – a single block of study pages that can be repeated multiple times for repeated visits 
(only twice in the JHS DMS).  A repeat visit is optional and rare for the baseline visit.  A block repeat key 
value uniquely identifies a repeat of a block and is stored in the block repeat key item that is a visit-related 
context (key field) item.  The block repeat key value is entered during data entry for a repeated visit from 
a drop-down list of values. 
  
Subject – a participant in a research study for whom data are entered in the DMS. 
 
1.4 References 
 
Information for this instruction manual for JHS comes from the Clintrial 4 Release 4.2 software manuals 
and from the Clintrial 4.2 Design Training Guide published by Domain Pharma Corporation.  Clintrial is a 
trademark of Domain Pharma Corporation. 
 
The current release of Clintrial 4.2 stores data in an Oracle8 database. Oracle is a registered trademark 
of Oracle Corporation. 
 
The SAS System Version 8 from SAS Institute Inc. is used in writing the custom reports and for the data 
retrieval process in the JHS DMS. 
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2.0 DATA ENTRY GUIDE 
 
 
2.1 Starting a Data Entry Session 
 
2.1.1 Logging In 
 
You must login to a Clintrial session to access the JHS DMS for data entry.  The steps to login and start a 
data entry session is as follows: 
 
1. From the Windows Desktop, double-click on the JHS Data Entry icon.  As an alternative, select 

Start > Programs > Clintrial 4.2 > Clintrial Enter. 
2. The Database Connection dialog box is displayed.   Login to Clintrial, as follows, with the 

information that was set up for your user account:  
a) Enter your Clintrial User Name. 
b) Enter your Password. 
c) Enter the character string @ORC0 for Database. 

3. Click OK to leave the dialog box.   
 
The first time you start a Clintrial session, the fields in the Database Connection dialog box are empty.  
The next time you start a session, the user name and database that you last used to start Clintrial are 
displayed as defaults in the dialog box. 
 
On a successful login, you are in the Clintrial Enter window. 
 
2.1.2 Changing a Password 
 
If you want to change your Clintrial password for any reason, do the following: 
 
1. From the Clintrial Enter window, select File > Password. 
2. In the Password dialog box, follow the instructions to set up a new password.  Click on OK to finish. 
 
A password must conform to the Clintrial password minimum length currently set at 6, must consist of 
alpha and/or numeric characters (other symbols and spaces not allowed), and cannot begin with a 
number.  A password is not case sensitive. 
 
If you have any difficulty getting started in Clintrial or forget your current user name and/or password, see 
your Database Administrator (DBA). 
 
2.2 Selecting the Protocol and Study Books 
 
2.2.1 Overview 
 
This DMS organizes data for the different components of this study into protocols.  One protocol named 
JHS_COHORT comprises the data from the Baseline Visit (enumeration, home induction interview, 
center exam, and 24-hour exam) and the annual contacts (annual contact details are not yet available).  
The Surveillance and Family Study components of this study will be organized into two additional 
protocols (details are not yet available). 
 
The data in JHS_COHORT are organized into study books.  A study book represents the collection of 
data collection forms called study pages grouped into visits called blocks.  The study books in 
JHS_COHORT are as follows:  
 
• INTERVIEW (enumeration and home induction interview data) 
• EXAM (center exam and 24-hour exam data) 
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• ANNUAL (annual follow-up data, not yet available) 
 
An enrollment study book named ENROLL is available exclusively to enroll new study participants.  A 
participant must be enrolled before any data can be entered for that participant. 
  
2.2.2 Setting the Protocol and Study Book 
 
The first time you start the JHS DMS for data entry, you must set the protocol and study book.   
 
To set the protocol, do as follows: 
 
1. In the Set Protocol dialog box, click to highlight the protocol in which you want to work, for example, 

JHS_COHORT. 
2. Click on OK to continue. 
 
The next time you start the DMS, Clintrial automatically selects the protocol that you last used and asks if 
you want to use the protocol selected.   Click on Yes to select the protocol; click on No to enter the Set 
Protocol dialog box to select another protocol. 
 
After setting the protocol, set the study book as follows: 
 
1. The Set Study Book dialog box opens automatically after you set the protocol.  Click to highlight the 

study book in which you want to work, for example, INTERVIEW. 
2. Click on OK to continue. 
 
Clintrial automatically chooses the study book that you used during your last session on subsequent 
logins to the DMS.  A message is displayed asking you to confirm that this is the study book you want to 
use.  Click Yes to select the study book; click No to enter the Set Study Book dialog box. 
 
2.3 Accessing Forms Using the Clintrial Navigator 
 
2.3.1 Overview 
 
The best method to access forms within each study book is by using the Clintrial Navigator.  The 
Navigator is a browser that graphically displays the blocks, study pages, and subjects in a study book. 
The Navigator uses icons to uniquely identify these objects, and a double-click on an icon opens that 
object in the Navigator.  Figure 3 shows the Navigator in the navigation order of Navigate by Page. 
  
In the Navigator for the JHS DMS, the study pages are listed in ascending order of their study page 
number. Note that some forms have multiple study pages (indicated as Part 1, Part 2, etc.) due to a 
length limitation in the design of the data entry window templates. 
 
The Navigator menu commands offer another method to navigate through the sequence of forms and 
subjects in a study book.  A description of the menu commands is in Figure 4. 
 
The Help menu provides more detailed instruction in the use of the Clintrial Navigator. 
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Figure 3 The Navigator  (Navigate by Page) 
 

 
 
 
 
Figure 4  Navigator Menu Commands 
 
 Menu command Description 
 Go To Open a form by using the Go To dialog box.  Enter ID 

NUMBER, CONTACT YEAR, and PAGE number. 
 Go To Selected Go to the study page highlighted in the Navigator. 
 Next* Go to the next study page in the navigation order. 
 Previous* Go to the previous study page in the navigation order. 
 Next Subject Go to the current study page for the next subject. 
 Next Page Go to the next study page for the current subject. 
 Previous Subject Go to the current study page for the previous subject. 
 Previous Page Go to the previous study page for the current subject. 
 Navigate by Subject Set the navigation order to By Subject (list of subjects 

under each study page). 
 Navigate by Page Set the navigation order By Page (list of study pages 

under each subject). 
 Expand Expand the selected Navigator order. 
 Collapse Collapse the selected Navigator order.  
 Sort Subjects Set the sort order for subjects in Navigator as ascending 

or descending. 
 Navigator Open the Navigator. 
 

*Depending on the Navigation order selected, Next or Previous opens either the next or previous 
page for the current subject (Navigate by Page), or opens the current page for the next subject 
(Navigate by Subject). 
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2.3.2 Using the Navigator 
 
For the JHS DMS, the Navigator is set to open automatically whenever you open a study book.  If 
Navigator does not open automatically, select the Navigate > Navigator menu commands. 
 
This section describes the Navigator in navigation order Navigate by Page that is the recommended 
navigation setting for the JHS DMS.  For Navigate by Page, the Navigator icons as shown in Figure 3 
are as follows: 
 
• Subject – a book (closed if collapsed, open if expanded) 
• Block – a boxed arrow (right arrow if collapsed, down arrow if expanded) 
• Study page – a page  
• Repeating page – overlapping pages 
 
An icon is shaded if any data are present. 
 
As displayed in Figure 3, the study book EXAM is open and contains one block called CENTER EXAM 
with the study pages grouped under each subject.  For JHS, the study pages are listed in alphabetic order 
by form code. To expand or collapse a subject, block, or study page, double-click on its icon. 
 
The Contact Information form in the INTERVIEW study book is designed as a repeating page to allow for 
the possibility of additional data from a repeat contact with a subject.  For the first Contact Information 
form, enter the repeating page number as 0 (zero) when prompted.   Enter repeating pages as 
consecutive numbers 1, 2, etc.  
 
2.4 Enrolling Subjects 
 
2.4.1 Overview 
 
A new subject must be enrolled in a protocol before any data can be entered for that subject.  The DMS 
allows for enrollment of new subjects either in the ENROLL study book or within a study book prior to 
entry of any data.  It is recommended to enter a new subject within a study book from the File menu due 
to current Clintrial limitations that may cause loss of data using the ENROLL study book.  
 
Enrollment data are the subject-related items ID NUMBER, LAST NAME and INITIALS appearing at the 
top of the first page of each form.  These are required fields in the DMS, and the fields must contain data 
to continue data entry. 
 
2.4.2 Adding New Subjects 
 
Enrolling subjects in a data study book (recommended) 
 
If you are only adding a few subjects at a time along with their data, you can enroll the new subjects from 
within a data study books. 
 
To enroll a new subject, do as follows: 
 
1. Select the File > New Subject menu commands to open the New Subject dialog box. 
2. Enter ID NUMBER, LAST NAME and INITIALS in the Enrollment Information section.  

a) ID NUMBER is a unique subject identifier.  If you enter a non-unique subject identifier into the 
DMS, Clintrial displays a message that you cannot enroll the subject since the subject has 
already been enrolled. 

b) Since these are required fields, if INITIALS or LAST NAME is not available then enter X’s in the 
field.  For example, enter the household last name for LAST NAME and X’s for INITIALS for 
enrollment of a Household ID. 
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c) Use the Tab key to move from one field to another.  If you use the Enter key, Clintrial attempts to 
leave the New Subject dialog box, and if any fields are blank, it displays a message to enter data 
in the highlighted fields which you must do before you can leave this dialog box.  

3. After completing the subject enrollment information, click one of the following: 
a) Go To Page to save the subject information and to go to the subject’s first study page. 
b) Add Next to save the subject information and add another new subject (repeat items 2 and 3). 
c) OK to save the subject and to close the New Subject dialog box. 

 
To modify or delete any subject information in the New Subject dialog box that have not yet been saved, 
do one of the following: 
 
1. To modify the subject information, place the cursor in the field you want to modify, delete the old 

information and enter the new information. 
2. To delete the subject information, click on Cancel to delete the information and exit from the New 

Subject dialog box. 
 
Enrolling subjects in the enrollment study book (not recommended) 
 
The enrollment study book contains only one study page that opens automatically when you open the 
ENROLL study book.  Using the enrollment study book is most effective when you are enrolling a group 
of subjects prior to entry of any data, or when you want to view or print a list of enrolled subjects. 
  
To enroll a subject in the enrollment study book, do as follows: 
 
1. Select the File > Set Study Book menu commands.  Highlight ENROLL and click OK to continue. 
2. The SQL Restriction Clause Builder window automatically opens.  Click Cancel or OK to continue.  

SQL restrictions are not being used at this time. 
3. The cursor is on the first field to enter a new subject.  Enter ID NUMBER, LAST NAME and 

INITIALS.  Use either the Tab or Enter key to move to the next field. 
4. To enter additional new subjects, press Ctrl-A or select the Edit > Add Subject menu commands.  

Enter each new subject as in step 3.  Repeat these steps until you enter the last subject. 
5. Close the enrollment study page by clicking on the (X) windows button for the page or select the File 

> Close menu commands. 
 
To modify or delete any subject information in the enrollment study book that have not yet been saved, do 
one of the following: 
  
1. To modify the subject information, place the cursor in a field belonging to the subject you want to 

modify, delete the old information and enter the new information. 
2. To delete the subject information, place the cursor in a field belonging to the subject you want to 

delete and select Edit > Delete Subject from the menu commands. 
 
Modifying and deleting subject information after data have been saved 
 
Once a subject’s enrollment data have been saved by either enrollment method, you cannot modify the 
enrollment data in the Clintrial Enter module.  Modification to saved enrollment data must be done in the 
Manage module by the Data Manager. 
 
2.5 Entering Data 
 
2.5.1 Overview 
 
Data are entered in a study page that is a representation of the data collection forms.  Some forms have 
multiple study pages due to form length limitations in the design of the data entry screen templates.  
Flags and notes are information about data that can be attached to fields or a study page during data 
entry. 
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Figure 5 shows an example a study page open for data entry. 
 
 
Figure 5 Study page 
 

 
 
 
2.5.2 Adding New Data 
 
2.5.2.1 Characteristics of Form Fields 
 
Field Types 
 
Several types of fields appear in a study page: 
 
• Enterable fields are fields in which you can enter data.  These fields have a white background and 

can accept the cursor. 
• Non-enterable fields are fields in which you cannot enter data.  These fields have a colored 

background (usually gray) and will not accept the cursor.  Examples are computed fields and skipped 
fields that follow a skip trigger field. 

 
Data Types 
 
Each field has been assigned a data type attribute.  The following data types are used in the JHS DMS: 
 
Field Type Data Type Description and Example 
Numeric FIXED  An integer that cannot include a decimal point. 
    The integer can be prefaced with a plus or minus sign. 
    Example: 100. 
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Numeric FLOAT  A number that can include a decimal point. 
    The number can be prefaced with a plus or minus sign. 
    Example: 25.6 
Date  DATE  A date in the format mm/dd/yyyy (month/day/year). 
    Leading zeroes are accepted but not required for month and day. 
    Missing date parts must be estimated, e.g., 01 for missing month or day. 
    Enter a slash or hyphen as the delimiter separating date parts. 
    Example: 06/20/2000 
Character TEXT  A character string that can include letters, numbers, punctuation marks, 
    spaces, and special characters.  Enter character strings in upper case. 
    Partial dates (mm/yyyy) and times (hh:mm) are entered as character 
    strings since Clintrial does not have a comparable data type. 
    Examples: J123456, ASPIRIN, 09/2001, 04:45 
 
Note the following for date field types: 
• From the Clintrial Help menu, “Years can be entered as two digits or four. When a two-digit year is 

entered, Clintrial stores numbers 00 to 49 as 21st century (2049) and numbers 50 to 99 as 20th 
century (1950).”  It is important to enter year as a 4-digit number to ensure the correct century. 

• Although the Clintrial date uses the DATE data type, a date is stored with the DATETIME data type in 
the Oracle database.  In rare cases during data entry, you may see a date field type displayed in 
DATETIME format. 

 
Value Ranges 
 
Most numeric and date fields have lower and upper bounds.  You must enter a value within the specified 
limits.  However, if the correct value is outside these bounds, the JHS DMS has been designed to allow 
you to enter a value that overrides these bounds. 
 
If you enter a value outside the bounds, Clintrial issues a message that the item value is outside the 
range and asks if you want to override and accept this value.  You can accept or not accept the value, 
with the following actions: 
 
• If you do accept this value, Clintrial will attach a flag to the field and a red flag icon will appear to the 

right of the field (see Using Flags for more information).  The cursor will move to the next field. 
• If you do not accept this value, the value of the field will return to its previous state (either blank or a 

previously entered value), and the cursor will move to the next field (unfortunately a Clintrial feature 
with the autoskip functionality).  You must return to the previous field that invoked the message by 
pressing Ctrl-Tab or clicking on the field to enter the correct value. 

 
Drop-Down Boxes 
 
Drop-down boxes are used for fields that have a list of acceptable values, such as a list containing Yes, 
No and Don’t Know.  You can only select the values that appear in the list for the field.  You can enter a 
value in the field in one of the following ways: 
 
• Enter the code associated with the value in the list, such as Y for Yes.  The value appears in the field. 
• Click on the down arrow button to display the list.  To select a value, press the keyboard key that 

corresponds to the value’s first letter or click on the value.  The value appears in the field.  Long lists 
will have a scroll bar to move down the list of values. 

 
You may encounter a value in a drop-down list that cannot be selected if that value has become obsolete.  
The value will be displayed as red text.  
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Missing Data 

There are no special character or numeric entries for missing data in the JHS DMS.  Simply leave the 
value blank.  For the JHS DMS, it is recommended to add a flag called PERMANENTLY_MISSING to the 
field (see Using flags).  Add a comment in the Item Flag dialog box to indicate the reason for permanently 
missing. 

To change a field with data to missing, delete the value in the highlighted field by pressing the keyboard 
Backspace key or selecting the Edit > Clear menu commands.  To change data to missing for a field with 
a drop-down list, select (None) from the drop-down list. 
 
Using Item Help 
 
You can view the attributes of any enterable field on a study page in the Help menu.  Item Help displays 
the attributes of a field defined during the development of the DMS.  To open Item Help, do the following: 
 
1. Highlight the field whose attributes you want to view. 
2. Select Help > On Current Item from the menu commands, or press Shift-F1. 
3. Close the Item Help window by clicking on the (X) windows button. 
 
2.5.2.2 Navigating in a Form 
 
Navigating between fields 
 
The following keyboard commands allow you to navigate between fields on a study page: 
 

Command Description 
Tab or Enter Next field. 
Shift-Tab or Shift-Enter Previous field. 
Ctrl-Home First field in page section (a partition of the study page). 
Ctrl-End Last field in page section (a partition of the study page). 

 
Navigating within a single field 
 
The following keyboard commands allow reposition of the cursor and selection of text within a field: 
 

Command Description 
Home Moves cursor to the beginning of the field. 
End Moves cursor to the end of the field. 
Ctrl-Right Arrow Moves cursor one word to the right. 
Ctrl-Left Arrow  Moves cursor one word to the left. 
Escape  Restores a non-coded field to its original value. 
Shift-Home Selects text from cursor position to the beginning of the field. 
Shift-End Selects text from cursor position to the end of the field. 
Shift-Right Arrow Selects one character to the right. 
Shift-Left Arrow Selects one character to the left. 
Ctrl-Shift-Right Arrow Selects one word to the right. 
Ctrl-Shift-Left Arrow  Selects one word to the left. 

 
Autoskip (currently disabled in the JHS DMS) 
 
The JHS DMS uses the Clintrial automatic skipping feature that automatically advances the cursor to the 
next enterable fields.  This feature is not available from fields with drop-down boxes.  Autoskip will only 
advance if the maximum number of characters have been entered in the current field, so if the entry is 
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less than the maximum length, you will need to advance to the next field using the Tab or Enter key or 
clicking on the field. 
 
Go To skips 
 
A field in a form may display an instruction that entry of a particular value for that field causes a skip of 
one or more fields to a latter field.  The field that causes a skip is called a trigger field, and the field to 
skip to is the target field.  For a trigger field, the paper copy of the form displays a ‘Go to’ statement 
beside the trigger value for that field, and the data entry window displays an asterisk (*) beside the trigger 
value for that field. 
 
If you enter a trigger value in a trigger field in the DMS, then the cursor goes to the target field and marks 
the skipped fields as non-enterable fields.  If the value of a trigger field is changed, the skipped fields 
become enterable. 
 
A few exceptions for skips in the JHS DMS are as follows: 
 
• The target field may be too far from the trigger field for a skip in Clintrial.  Therefore, a message is 

displayed to skip to the target field, and then the skip will go to the farthest field it can reach.  Use the 
Tab or Enter keys to go the remaining distance to the target field. 

• The skipped fields may not be marked as non-enterable due to Clintrial limitations in certain locations 
in a page design. 

 
Scrolling in a study page 
 
As you perform data entry in a study page, the Tab or Enter key move the cursor to the next enterable 
field on the study page, automatically scrolling down the page and displaying the fields in the data entry 
window.  You can manually scroll down a page by using the vertical scroll bar on the right side of the 
window. 
 
Some study pages are designed from forms with a landscape layout and require scrolling left to right. The 
Tab or Enter key moves the cursor to the next enterable field, automatically scrolling to the right on a 
page and displaying the fields in the data entry window.  For these wide pages, a horizontal scroll bar is 
available at the bottom of the data entry window that you can use to scroll manually from left to right. 
 
Search field  
 
At the bottom of the Navigator window is a Search field in which you can enter text (case sensitive) to 
search for a particular study page.  The search begins at the currently selected icon and proceeds within 
the hierarchy until the first match is found.  You can only search expanded icons.   
 
For example, to find the next occurrence of the SBPE Sitting Blood Pressure study page in the CENTER 
EXAM block for subject J000000, expand the subject and CENTER EXAM icons and then enter "S" in the 
Search field.  The search begins as soon as you enter any text.  Continue to enter additional characters in 
the text until the search takes you to the SBPE study page. 
 
Last field action 
 
When the cursor is on the last field of the study page, pressing the Tab or Enter key will move the cursor 
to the first field of the study page. You do not exit from the study page. 
 
Printing study pages 
 
You can print study pages from the Navigator without having to open them.  Only study pages that 
contain data can be printed, and only study pages and subjects included in the current subject list and 
page list can be selected for printing. 
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The Navigator provides several options to print for selecting one or more individual study pages or 
subjects or selecting a selected group of study pages or subjects.  These options differ depending on the 
current navigation order setting.   
 
From the Navigator window in the navigation order Navigate By Page, you can select for printing as 
follows: 
 
1. Select subject(s) or study page(s) to print.   

a. Selecting an individual subject prints all study pages for the subject 
b. Selecting one or more individual study pages for a subject prints the individual study page(s) for 

the subject. 
c. Selecting the Edit > Select All menu command prints all the study pages in the study book. 

2. Select File > Print from the menu commands.  In the Print Options dialog box, you can make further 
selections on study pages to print, if desired. 

3. Click on OK to print and to close this dialog box. 
 
2.5.2.3 Using flags 
 
Flags can be attached to an individual field as an Item Flag or to a form by way of a Record Flag.  Flags 
are typically used to: 
 
• Label and monitor data quality problems. 
• Capture information that cannot be entered in the fields on a screen. 
 
For example, a flag might be added to a field where the data are missing or where the data are outside a 
specified range of values. 
 
Flags have two parts: 
 
• A flag category is used to indicate the type of problem or assertion found with the data, such as 

ILLEGIBLE or MISSING. 
• A flag name is associated with a single flag category.  
 
In the JHS DMS, there are four categories of flags with each category associated with a single name (the 
same value as the category).  The categories (and names) and their description are as follows: 
 

FLAG CATEGORY (AND FLAG 
NAME) 

Action 

OVERRIDE Use when overriding an edit range. 
PERMANENTLY_MISSING Use when a field value or form is permanently 

missing. 
CANT_ENTER Use to indicate when a value cannot be entered 

into the field (e.g., if a field is too short or if a 
value is different from the field type). 

QUERY Use only when entering data from paper forms 
to indicate that a field should be queried. 

 
There are other flag categories supplied by Clintrial that cannot be removed but are not used for JHS.  
The flag categories to ignore for JHS are CDR, GENERAL, CLASSIFY, and LABLOADER. 
 
To attach a flag to a field, do the following: 
 
1. With the cursor in the field, select Flags > Item Flag menu commands. 
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2. In the Item Flag dialog box, select a Category from the list.  Select a Name from the list (same as 
Category).  Enter text in the Comment field to provide a reason for the flag. 

3. Click OK to continue. The dialog box closes, and a red flag icon appears next to the field. 
 
You attach a flag to a record for a form-level flag, for example, if the entire form is permanently missing.  
A single form is usually comprised of multiple records appended together, with each record containing a 
subset of the form fields.  Only attach a flag to the first record for a form-level flag.  To attach a flag to the 
first record, do the following: 
 
1. With the cursor in the first field on a study page, select Flags > Record Flag.  Note that the cursor is 

automatically positioned in the first field of the study page when the study page is opened. 
2. In the Record Flag dialog box, select a Category from the list.  Select a Name from the list (same as 

Category).  Enter text in the Comment field to provide a reason for the flag. 
3. Click OK. The dialog box closes, and a red flag icon appears next to the record (top right of form). 
 
Multiple flags can be attached to an item or a record, but only one red flag icon will appear. 
 
2.5.2.4 Using notes 
 
Notes are used to enter comment fields and ‘Other’ responses or to make notes about an individual field 
in a study page or about an entire study page.  A note for a field is attached as an Item Note.  An 
example: a note for the reason text to the field ‘Other Reason’.  A note for a form is added as a Record 
Note.  An example: if a study page cannot be completed, then a record note can indicate why the data 
are unattainable. 
 
Notes have two parts: 
 
• Note category defines the source of the note. 
• Note name defines a subcategory for the source of the note. 
 
Clintrial supplies two note categories of SPONSOR and INVESTIGATOR, and in INVESTIGATOR, there 
is one note name.  For JHS, all notes will be note category INVESTIGATOR with note name 
UNSPECIFIED.  The other note categories are not meaningful in JHS, but cannot be removed in Clintrial. 
 
To attach a note to a field, do the following: 
 
1. With the cursor in the field, select Notes > Item Note menu commands 
2. In the Item Note dialog box, select INVESTIGATOR from the Category list.  Select UNSPECIFIED 

from the Name list.  Enter the text in the Note Text field to provide a comment or ‘Other’ reason. 
3. Click OK to continue. The dialog box closes, and a yellow note icon appears next to the field. 
 
You attach a note to a record for a form-level note.  A single form is usually comprised of multiple records 
appended together, with each record containing a subset of the form fields.  Only attach a note to the first 
record for a form-level note.  To attach a note to the first record, do the following: 
 
1. With the cursor in a field belonging to the record, select Notes > Record Note.  Note that the cursor 

is automatically positioned in the first field of the study page when the study page is opened. 
2. Select a Category from the list.  Select a Name from the list.  Enter text in the Note Text field to 

provide a reason for the note. 
3. Click OK.  The dialog box closes, and a yellow note icon appears next to the record (top right of 

form). 
 
Multiple notes can be attached to an item or a record, but only one yellow note icon will appear. 
 
2.5.2.5 Saving data and exiting a study page 
 



16 

Exam 2 Data Management System Manual.doc 

 

Data entered in a study page are not permanent until the study page is saved.  You can save at any time 
during data entry in a study page or when you exit from a study page. 
 
 The following options are available to save data and/or to exit from a study page: 
 
• Select File > Save menu commands to save data without exiting from the study page. 
• Select File > Close menu commands or click the study page (X) windows button to save data and 

exit from the study page. 
• Select File > Close Without Saving to exit the study page without saving data.   
 
2.5.3 Creating and Selecting Subject Lists 
 
Long lists of subjects in the Navigator can make data entry cumbersome.  To limit the number subjects 
displayed in the navigation window, such as to those attending the center that day or to those who are in 
the stack of forms for data entry, you can specify a subset of subjects by using subject lists.  You can 
create as many subject lists as needed and save these lists indefinitely. 
 
Every Clintrial protocol has a default subject list called All that includes all subjects enrolled in the study. 
This list cannot be deleted or modified. 
  
You create and modify subject lists using the List Wizard.  The Wizard is a series of dialog boxes to 
guide you through the steps of entering or modifying list criteria.  To create a list in the Wizard, select 
specific subjects to include.  You can optionally include or exclude subjects based on a SQL restriction. 
You can also create a list that includes or excludes subjects based upon the presence or absence of flags 
or notes.  Once created, a list can be modified as needed.  
 
To open the List Wizard, select one of the following menu commands appropriate to what you want to do:  
 
• List > Create List 
• List > Edit Subject List 
 
You can select a particular subject list for the Navigator to display, and only those subjects belonging to 
the list will be displayed.  To select a subject list, do one of the following: 
 
• From the Subject List drop-down box at the top left of the Navigator window, select the list you want. 
• Select List > Select Lists from the menu commands.  In the Select Lists dialog box, select the 

subject list you want and click OK to continue. 
 
2.5.4 Browsing, Changing, Deleting, or Printing Data in the Enter Module 
 
Browsing Data 
 
To browse data in a saved study page in the update table, double-click on the study page icon to re-open 
the study page in the Navigator.  Use the scroll bar or the Tab or Enter key to browse through the data, 
being careful not to change inadvertently any data.  Select File > Close Without Saving to exit from the 
study page. 
 
Changing Data 
 
There are three edit modes available in an Enter session to change data: 
 
• Edit Update Data (default) - enter new data or edit unmerged data. 
• Verify - perform verification of previously entered data. 
• Edit Merged Data - edit data that have been validated and merged (moved) to the data table 

(merging data is described later in Managing Data). 
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By default, when you start Enter, the edit mode is set to Edit Update Data.  If you want to perform 
verification or edit merged data, you must set the edit mode to one of these other options.  All study 
pages must be closed before you set the edit mode.  The name of the current edit mode is displayed in 
the title bar of the study page.  To change the edit mode, select File > Edit Mode.  Select an edit mode, 
then click OK to continue. 
 
To change data in a saved study page, double-click on a study page icon to re-open the study page in the 
Navigator.  Use the scroll bar or the Tab or Enter key to move through the study page.  Select a field to 
change, then enter the data.  Select File > Save to save the changed data without exiting or File > Close 
to save and exit from the study page. 
 
Deleting Data 
 
Depending on the situation, you can delete data in an open study page in following ways: 
 
• Close a study page without saving new or updated data 
• Undo data entered since the last save 
• Delete data from a field 
• Delete all data for a study page 
 
To close an open study page and not save data, select File > Close Without Saving.  For example, if 
you inadvertently open the wrong study page from the Navigator, close the study page without saving to 
avoid creation of any blank records in an update table and to not shade the study page icon. 
  
If you want to undo data entered since last save in an open study page, select Edit > Undo Page Edits. 
 
If you want to delete data from a field in an open study page, highlight the field and select Edit > Clear or 
use the Delete key.  To delete or clear a value from a codelist field, highlight the field and select (None) 
from the drop-down list.  Select File > Save to save data deletions without exiting or File > Close to save 
and exit from the study page. 
 
If you want to delete all data in a previously saved study page, select Edit > Delete Page Data in the 
open study page and click on Yes to confirm the deletion.  The study page will automatically close, and 
the study page icon will not be shaded. 
 
Printing Data 
 
You can print Clintrial reports, most non-report windows, and study pages.  You can open a study page 
for printing or print from the Navigator window.  If the Print or Print Preview command is not available for a 
displayed window, then that window does not have the print or preview capability. 
  
Select File > Printer Setup to specify which local or network printer to use.  Depending on your printer, 
you can also adjust certain printer defaults like page orientation, paper size, and print resolution. Consult 
your printer's documentation or your Clintrial Data Manager for more information. 
 
To print from within a report, window, or open study page, do as follows:  

 
1. Select File > Print. 
2. The Print Options dialog box opens. Accept default settings or modify any of these values as needed. 
3. Click OK to print. 
 
To preview a document, select File > Print Preview.  Previewing a document before printing lets you see 
how the text will look when printed, shows certain report features that do not normally display on the 
screen (e.g., headers and page numbers), and allows an opportunity for an adjustment to page 
orientation for best printing results. 
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You can print study pages from the Navigator without having to open them.  Only study pages that 
contain data are printed.  Only study pages and subjects included in the current page list and subject list 
can be selected for printing.  However, use this print capability with caution.  To print multiple study pages 
at a time is dependent on the number of allowable open study pages set for system parameter 
ENT_OPEN_PAGES (default is 1).  Set ENT_OPEN_PAGES temporarily to the maximum of 10 to print 
study pages from the Navigator.  Otherwise, you will get a Clintrial error that terminates Enter if the 
number of study pages to print exceeds the number specified by this parameter except if set to 10. 
 
To print study pages from the Navigator, do as follows (assumes Navigate By Page navigation order): 
 
1. Select the page(s) that you want to print in one of following ways: 

a. Click on one or more individual study pages within a subject (Shift-click for more than one) 
b. Click on a block (i.e., CLINIC EXAM) to print all study pages in the block for that subject 
c. Select Edit > Select All to print all the study pages for all subjects in the study book 

2. Select File > Print. 
3. The Print Options dialog box opens. Accept default settings or modify any of these values as needed. 
4. Click OK to print. 
 
2.6 Clintrial-Supplied and Custom Reports 
 
Clintrial-Supplied Reports 
 
Clintrial provides Enter reports that you create through the use of a Report Wizard.  Within the Wizard, 
you enter criteria that determine the report's format and content in a series of dialog boxes. 
 
You can create one of the following reports: 
 
• A Flag Report, which displays information about flags that have been attached to data in the current 

study book. 
• A Note Report, which displays information about notes that have been attached to data in the current 

study book. 
• A Subject Report, which displays information about the status of data entered for study subjects. 
• A Verification Report, which displays information about records that have failed to pass blind 

verification. 
 
The Flags, Notes, and Subject reports are available in two basic formats: detailed and summary.  The 
detailed format provides in-depth information on each record matching the selection criteria.  The 
summary format gives a count and categorical breakdown of records matching the selection criteria.  
 
To create a Clintrial-supplied report, do as follows:  
 
1. To open the Report Wizard, select Reports from the Enter menu and then select the type of report: 

Subject, Flag, or Note. 
2. Select the criteria for the report.  Click Next to move to the next dialog box.  Click Back to return to a 

previous dialog box to change an earlier entry. 
3. Select Finish to end your selection and view the report.  As soon as the Finish button is available, it 

indicates that the minimum amount of necessary information has been entered. 
4. The report appears on the screen.  You can also print the report (File > Print) or save the report to a 

file in a directory of your choice (File > Save As). 
 
Custom Reports 
 
Custom reports developed for JHS such as recruitment status, participant profiles, and lab results can be 
run from the Custom menu in Enter.  The Custom menu is a user-modifiable menu in which you can set 
up shortcuts to Windows applications (e.g., Notepad, Excel), to specific document files (e.g., text files, 
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spreadsheets), and to the SAS System to run JHS data reports.  These applications and documents can 
be directly opened from Clintrial in the Custom menu. 
 
When creating a shortcut, you can specify whether the shortcut appears in every Clintrial module you use 
(create in Common Menu Items) or in only the module from which it was created (create in Module 
Specific Menu Items).  You can create up to eight shortcuts of each type. 
 
Custom menu items will appear only on the workstation on which they were created since they are stored 
in the Windows Registry.  For computers running under Windows NT, Custom menu settings are also 
particular to the user who created them. 
 
2.7 Closing Windows 
 
When you have completed data entry using the Navigator or completed other tasks in a DMS window, 
you need to close the active task window. 
 
To close a window, you can use one of several options: 
 
• Click on the rightmost (X) windows button at the far top right of a window. 
• Select the File > Close menu commands. 
• Click on the OK button, if provided (in dialog boxes). 
• Click on the Finish button, if provided (in List or Report Wizard). 
 
2.8 Ending a Data Entry Session 
 
To close the Clintrial Enter window and end your DMS session, click on the rightmost (X) windows button 
or select the File > Exit menu commands. 
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3.0 PROGRAMMER GUIDE TO MANAGING DATA 
 
 
3.1 Overview 
 
In the Clintrial Manage module, a Clintrial Data Manager can perform data management tasks such as 
the following: 
 
• batch-load data 
• assign codes based on field values from industry-standard dictionaries  
• validate data, that is, calculate derived fields and run consistency checks 
• merge or move data that have passed validation from update to data tables 
• globally change or delete records 
• view processing logs and reports 
• view error reports and make corrections 
• view audit trail reports 
 
A typical data management workflow in the Manage module is displayed in the introduction of this 
manual. 
 
A person using the Manage module has privileged access rights to the study data tables and has 
familiarity with the Clintrial database structures.  
 
3.2 Batch-Loading Data 
 
3.2.1 Overview 
 
Batch-loading is the process of loading data from ASCII files directly into update tables in the Clintrial 
database. You can batch-load study data, enrollment data, and thesaurus (dictionary) data. 
 
Enrollment data must be previously entered for a subject whose data are batch-loaded.  Either the subject 
is enrolled in the Enter module, or the enrollment data are batch-loaded, screened, validated, and merged 
before study data can be entered for the subject. 
 
The input ASCII file contains records composed of data fields. The data fields on a record correspond to 
items in a pre-defined panel into which the data are batch-loaded.  You can only batch-load into one 
panel at a time.  To load data from one input ASCII file into more than one panel is a complicated, 
multiple control files, multiple runs process not discussed in this manual. 
  
The data fields on a record in the input ASCII file are in either a fixed format or variable format.  Fixed 
format records contain data values of specified length beginning in fixed locations in the record with no 
delimiter separating the values.  Variable format records contain data values without a specified length 
and not necessarily in the same location in each record, and these records include a delimiter to separate 
the values for fields. 
 
A control file is created as an interface between the input ASCII file and the Clintrial database table for 
the batch-loading.  The control file interprets the organization and format of data in the input ASCII file 
and provides the instructions on the loading process. 
 
All batch-loaded data are automatically loaded into the Clintrial database's update tables. The data must 
pass screening before the data can be edited, coded, validated, and merged to the study data tables.  
Screening is the process that includes updating internal system items to uniquely identify the records, 
grouping the records into observations (not used in JHS), and applying data checks to data that has been 
batch loaded into the update table. The data checks confirm that subjects are enrolled and that 
mandatory items are defined, and they apply the range checks (lower and upper limits) and checklist tests 
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(checklists not currently used in JHS) for an item.  Records that have been batch loaded and screened in 
Manage appear identical to those records entered interactively in Enter. 
 
Once data have passed screening, the data are ready to be edited, coded, validated, and merged.  You 
can view the results of batch-loading in the SQL*Load Log from the Reports menu. 
 
3.2.2 Preparing Data for Batch Loading 
 
3.2.2.1 Creating a Control File  
 
To create a control file, do as follows: 
 
1. Select Load > Control File > New from the Manage window. 
2. In the Open dialog box, select the panel for which you are creating the control file and the file format 

of the input ASCII file (fixed format or variable format). 
3. Click OK to continue.  The default version of the control file is displayed in the Control File window. 
4. You can optionally edit the default control file at this time.  See edit instructions below. 
5. To save the control file, select File > Save or File > Save As to write the control file to the default 

C:\CT42 Clintrial directory or a directory of your choice.  By default, the file name is panelname.ctl. 
6. To close the Control File window, select File > Close or click on the window’s X button. 
 
To edit the default control file, do as follows: 
 
1. If the Control File window is not opened, select Load > Control File > Edit to open the control file for 

editing.  Indicate the directory location and file name in the Open dialog box.  Click on Open to open 
the control file in the Control File window. 

2. Edit the control file to correspond to the input ASCII file format, as follows: 
a. Reorder items in the control file to match the order of values in the input ASCII file. 
b. Delete items for which the input ASCII file does not contain values. 
c. Add conversion instructions, such as instructions to convert date formats. 
d. The control file must specify the character used to indicate character strings in the input ASCII 

file.  Change the ENCLOSED By clause to contain this character.  Default is the double quotation 
mark, for example, OPTIONALLY ENCLOSED BY ‘ “ ‘. 

e. For a variable format control file, change the default delimiter ‘@’ to the character that is used as 
a field delimiter in the input ASCII file, for example, FIELDS TERMINATED BY ‘,’ for a comma-
separated file (.cvs). 

f. For a fixed format control file, change an item fixed size if needed. 
g. By default, a control file includes the line TRAILING NULLCOLS to indicate that, if not enough 

values are supplied for a record in the input ASCII file, items in the panel will be given the value of 
Null when the record is batch loaded. 

h. For probably all date fields, you will want to change the date format of the item.  For example, 
specify the date format as DATE “MM/DD/YYYY” if the input ASCII file contains the date 
10/03/2000 (has not yet been tested in JHS). 

i. For items of data type NUMBER or DATE, the default control file contains a NULLIF clause.  The 
NULLIF clause in the default control file specifies an item as Null if the value in the input ASCII 
file is blank.  Specify another value if the input ASCII file contains a value other than blank for 
Null, for example, a period (.). 

j. Items of data type TEXT contain an LTRIM clause to trim leading blanks and a RTRIM clause to 
trim trailing blanks. 

3. Select File > Save or File > Save As to save the edited control file. 
4. Select File > Close or click on the window’s X button to close the Control File window. 
 
3.2.2.2 Loading the Data 
 
To batch load data requires that the Oracle SQL*Loader is installed on the computer (use the 32-bit 
version).  Consult Oracle SQL*Loader documentation for more detailed information on loading data. 
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It is recommended that you check a batch-load of a sampling of records in the input ASCII file to ensure 
that positions and formats of fields in the input ASCII file match the corresponding control file. 
 
To batch-load data, do as follows: 
 
1. Select Load > Load Data from the Manage window.  The Batch SQL Loader dialog box opens. 
2. In the dialog box, specify the names and locations of the control file for Control File and the input 

ASCII file for Data.  Clintrial saves the files specified in this dialog box as defaults for the next 
session, but you can change these defaults if needed.  You can also specify names and locations of 
files created by the batch-load process: the Log file, the Bad file, and the Discard file.  The Log file 
is a report file of the batch-loading process.  The Bad file lists records that were rejected.  The 
Discard file lists records that did not meet the selection criteria for batch loading. 

3. If you click Advanced in the Batch SQL Loader dialog box, the Advanced Batch Loader Options 
dialog box opens.  You can select addition options as needed such as Records to Skip, Records to 
Load, Rows per Commit, Maximum Errors, Maximum Discards, and Maximum Bind Array.  In most 
cases, you will probably use the Clintrial defaults.  Click OK to continue. 

4. From the Batch SQL Loader dialog box, click Load to batch load the data into an update table.  Click 
OK to close message that job was submitted.  The Batch SQL Loader dialog box closes after the job 
has run. 

5. From the Manage window, select Reports > SQL*Load Log to view the results of the job run.  The 
Open dialog box opens.  Select the path and name of the load log file, then click Open.  The Oracle 
Batch Log window opens.  For information on the log's entries, see your Oracle documentation. You 
can print the report from File > Print.  Close the Oracle Batch Log window from File > Close or from 
the window's X button to return to the Manage window. 

 
3.2.2.3 Screening Batch-Loaded Data 
 
You screen records after data are batch loaded into an update table.  Screening combines the following 
processes running concurrently: 
 
• Applies data checks to record data 
• Updates the system items 
• Groups records into observations as needed (not used in JHS) 
 
The data checks include the same checks applied during interactive data-entry.  Records that have been 
successfully batch-loaded and screened appear identical to records that were entered interactively. 
 
You can only screen records whose record status is Unscreened (3) or Screening Error (-3).  Records 
that pass screening are assigned the status Verified (1).  Records that fail screening are assigned the 
status Screening Error (-3). 
 
To screen batch-loaded data, do as follows: 
 
1. Select Load > Screen from the Manage window.  The Screen dialog box opens. 
2. In the Screen dialog box, select the panel(s) from Panels that you want to screen.  To screen 

records, check Release for Validation.  To override data-entry checks on the data, check Override 
Checks.  To select records for screening by using a SQL restriction, click SQL.  To screen data as a 
batch process, check Submit Batch. 

3. Click OK to screen the records.  Click OK in the message box at the completion of the screening 
process. 

4. To view the results of screening in Screen Log, select Reports > Screen Log > View in the Manage 
window.  The Screen Log is a cumulative report that describes the results of the screening process 
with entries for each panel that was screened.  You can print the Screen Log report from File > Print 
or save from File > Save As.  Close the Screen Log window from File > Close or from the window's 
X button to return to the Manage window. 
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Once a record passes screening, it can be edited, coded, validated, and merged. 
 
3.3 Coding Data – not available at this time 
 
3.3.1 Overview 
 
3.3.2 Coding Thesaurus 
 
3.3.3 Coding Techniques – Automatic, Interactive 
 
3.3.4 Items To Be Coded 
 
3.4 Validating and Merging Data 
 
3.4.1 Overview 
 
Validation is a data cleaning process that checks the integrity of study data in the update tables by finding 
errors and data inconsistencies.  Records must pass validation before they can be merged to the data 
tables. 
 
Merging is the process of moving data that has passed validation from the update tables to the data 
tables. 
 
3.4.2 Validating Data 
 
During validation, a validation procedure is run against the data in the update tables.  A validation 
procedure is a PL/SQL procedure that is built automatically from derivations and rules.  Derivations and 
rules are specified during the design of the DMS for a protocol panel.  Derivations calculate derived 
values in the records being validated.  Rules check that the data meet certain requirements of the study 
protocol.  There is one validation procedure for each panel. 
 
Records in the update tables must pass validation before they can be merged (moved) to the data tables. 
  
You can view the results of the validation process in the Validation Log.  An evaluation of a rule to False 
during validation also generates an entry in the Error Log. You can then review and edit the record from 
the Error Log. 
 
To validate data, do as follows: 
 
1. You can select records for validation either by panel (the Clintrial default) or by study page (the JHS 

DMS preference).  To validate records by study page, set the Manage user preference 
SELECT_BY_PAGE to Yes from File > Preferences in the Manage window. 

2. Select Manage > Validate in the Manage window.  The Set Study Book dialog box may open if a 
study book has not been selected (go to 3), otherwise the Validation dialog box opens (go to 4). 

3. In the Set Study Book dialog box, select the study book for the data that you want to validate.  Click 
OK to continue.  The Validation dialog box opens. 

4. To validate records by study page, do as follows: 
a. From the Page List drop-down list, select the page list that you want to use.  You can create a 

new list from List > New List or edit an existing list from List > Edit Page List using the List 
Wizard. 

b. Select either All pages or Selected pages to validate.  Select the specific pages to validate from 
the list for Selected pages. 

c. Optionally you can restrict the data included in the validation as follows:  
1) For the date and time that records were last modified, enter a Date and Time Range. 
2) For record status, select a Status. 
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3) For flags present, select one or more Flags. 
4) For notes present, select one or more Notes. 
5) For a SQL restriction, select Edit > SQL Restriction. 

d. Check the type of database table(s) you want to validate in Table(s): UPDATE, DATA, or both. 
e. If you are running a test validation, clear the Release for Merge check box.   Otherwise check 

Release for Merge. 
f. To run the validation as a batch process, check Submit Batch.  Otherwise the validation runs 

interactively. 
g. Select File > Run.  Click OK in the message box at the completion of the validation run.  You 

return to the Validation dialog box. 
h. Select Reports > Validation Log to view the results of validation in the Validation Log.  You can 

print the Validation Log from File > Print or save from File > Save As.  Close the Validation Log 
window from File > Close or from the window’s X button. 

i. Close the Validation dialog box at the completion of the validation process from File > Close or 
from the window’s X button. 

 
3.4.3 Merging Data 
 
Once data have been validated, then data can be merged (moved) from the update tables to the data 
tables where the clean data are stored. 
 
To merge records, do as follows: 
 
1. You can select records for merging either by panel (the Clintrial default) or by study page (the JHS 

DMS preference).  To merge records by study page, set the Manage user preference 
SELECT_BY_PAGE to Yes from File > Preferences in the Manage window. 

2. Select Manage > Merge in the Manage window.  The Set Study Book dialog box may open if a study 
book has not been selected (go to 3), otherwise the Merge dialog box opens (go to 4). 

3. In the Set Study Book dialog box, select the study book for the data that you want to validate.  Click 
OK to continue.  The Merge dialog box opens. 

4. To merge records by study page, do as follows: 
a. From the Page List drop-down list, select the page list that you want to use.  You can create a 

new list from List > New List or edit an existing list from List > Edit Page List using the List 
Wizard. 

b. Select either All pages or Selected pages to merge.  Select the specific pages to merge from 
the list for Selected pages. 

c. Optionally you can restrict the data included in the merge as follows: 
1) For the date and time that records were last modified, enter a Date and Time Range. 
2) For record status, select a Status. 
3) For flags present, select one or more Flags. 
4) For notes present, select one or more Notes. 
5) For a SQL restriction, select Edit > SQL Restriction. 

d. To validate the panels of the selected study pages before merging, if not done in Manage > 
Validate, check Validate First. 

e. To run the merge as a batch process, check Submit Batch. Otherwise merge runs interactively. 
f. Select File > Run.  Click OK in the message box at the completion of the merge run.  You return 

to the Merge dialog box. 
g. Select Reports > Merge Log to view the results of the merge in the Merge Log.  For information 

on any errors, see the Help menu for the Manage module on Validation and Merging: Error 
actions.  You can print the Merge Log from File > Print or save from File > Save As.  Close the 
Merge Log window from File > Close or from the window’s X button. 

h. Close the Merge dialog box at the completion of the merge from File > Close or from the 
window’s X button. 
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3.5 Global Data Changes and Deletions 
 
3.5.1 Introduction 

 
Global change is the process of changing one or more values in multiple records simultaneously.  You 
can make global changes to individual or multiple panels, and to records in the update table, data table, 
or both.  You cannot directly change any derived item values.   
 
Global deletion is the process of deleting multiple records simultaneously.  You can make global 
deletions to individual or multiple panels, and to records in the update table, data table, or both. You can 
view the results of global deletion in the Global Delete Log.  
 
Global change and global deletion are powerful processes that alter records irrevocably.  Because of this, 
before you save any global changes or deletions, you should preview the results of the global change or 
deletion process to ensure that the desired change is made or that the correct records have been 
selected for deletion.  If the preview results are correct, you can then run the global change or deletion 
process and save the results. 
 
If you want to change or delete enrollment data for study subjects, that is, records in the enrollment panel, 
you must perform a global change or global deletion.  You cannot change or delete enrollment data using 
any other method.  To change or delete subject item values or any subject-related context items, you 
must select only the enrollment panel.  If you change or delete the subject item, when the global change 
is successful, records are changed or deleted in all panels in which the subject item is stored.  To change 
other context item values, select all the panels you want to change, excluding the enrollment panel and 
any type 0 panels (non-subject data). 
 
You can view the results of global change in the Global Change Log.  Errors that occur during global 
change are recorded in the Error Log with the error types of GLOBCHG. 
 
You can view the results of global deletion in the Global Delete Log.  Errors that occur during global 
deletion are recorded in the Error Log with the error types of GLOBDEL. 
 
3.5.2 Global Change 
 
To make a global change, do as follows: 
 
1. Select Manage > Global Change in the Manage window.  The Select dialog box opens. 
2. In the Select dialog box, select the panels and tables whose records you want to change.  When you 

click OK, the Global Change dialog box opens. 
3. In the Global Change dialog box, do as follows: 

a. Select the subjects you want to make changes to, except for type 0 panels.  To select the 
subjects, do one of the following: 
1) For all subjects, click All Subjects. 
2) For individual subjects, click Selected Subjects.  Select the subjects you want to change. 

b. Under Restrict Data, select records to change as follows: 
1) For the presence of flags, select one or more Flags.  
2) For the presence of notes, select one or more Notes. 
3) For a SQL restriction, click the SQL Restriction box. 

c. To override data-entry checks on the new values, check Override Checks. 
d. To run the changes as a batch process, check Submit Batch. Otherwise global changes are 

done interactively. 
e. Enter the new values for the items you want to change in the Change To field.  To specify global 

change values, note the following: 
1) The new value must match the database format of the item. 
2) For items with data type TEXT, you must enclose the new value in single quotes. 
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3) The new value can be a constant, or a calculated value that can refer to other items in the 
panel. 

4) To specify a calculated value, enter a valid SQL UPDATE statement. The SQL statement can 
contain any valid Oracle function or operator. 

f. To preview your changes before running them (recommended), select View > Preview. 
i. To run the changes, select File > Run.  Click OK in the message box at the completion of the 

global change run.  You return to the Global Change dialog box. 
g. Select Reports > Global Change Log to view the results of a global change in the Global 

Change Log. You can print the Global Change Log from File > Print or save from File > Save 
As.  Close the Global Change Log window from File > Close or from the window’s X button to 
return to the Manage window. 

h. Close the Global Change dialog box at the completion of the global change from File > Close or 
from the window’s X button. 

 
3.5.3 Global Deletion 
 
To make a global deletion, do as follows: 
 
1. Select Manage > Global Delete in the Manage window.  The Select dialog box opens. 
2. In the Select dialog box, select the panels and tables whose records you want to delete.  When you 

click OK, the Global Delete dialog box opens. 
3. In the Global Delete dialog box, do as follows: 

a. Select the subjects you want to delete, except for type 0 panels.  To select the subjects, do one of 
the following: 
1) For all subjects, click All Subjects. 
2) For individual subjects, click Selected Subjects.  Select the subjects you want to delete. 

b. Under Restrict Data, select records to delete as follows: 
1) For the presence of flags, select one or more Flags.  
2) For the presence of notes, select one or more Notes. 
3) For a SQL restriction, click the SQL Restriction box. 

c. To run the deletions as a batch process, check Submit Batch. Otherwise global deletions are 
done interactively. 

d. To preview your deletions before running them (recommended), select View > Preview. 
j. To run the deletions, select File > Run.  Click OK in the message box at the completion of the 

global deletion run.  You return to the Global Delete dialog box. 
e. Select Reports > Global Delete Log to view the results of a global deletion in the Global Delete 

Log. You can print the Global Delete Log from File > Print or save from File > Save As.  Close 
the Global Delete Log window from File > Close or from the window’s X button to return to the 
Manage window. 

f. Close the Global Delete dialog box at the completion of the global deletion from File > Close or 
from the window’s X button. 

 
3.6 Logs and Reports 
 
Clintrial contains twelve logs and reports in the Manage module that show the results of various data 
management processes.  Logs and reports can be viewed online, printed, and saved to a file. 
 
No JHS DMS custom logs and reports are available at this time. 
 
The Manage logs and reports are as follows: 
 
Audit History Report – a report that shows the history of changes to the audit start point for all audited 
panels, including the current and past audit start points for each panel, and the dates at which the audit 
start points became effective. 
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Audit Notes Report – a report that shows the changes made to notes attached to records in one panel.  
It does not show deletions of notes attached to clinical data.  For a note to appear in the report, the record 
to which it is attached must itself be eligible for auditing.  
 
Audit Records Report – a report that shows all changes and deletions made to a panel's records after 
the audit start point has been reached. 
 
Automatic Coding Log - a cumulative report that describes the results of the automatic coding process.  
Contains entries for each panel that was coded automatically. 
 
Coded Item Report - a report that provides information about items that were coded interactively for a 
panel, including the verbatim text, thesaurus term, and code applied for each item. 
 
Error Log - a cumulative log of errors that occurred during screening, validation, merging, global change, 
and global deletion.  There is one Error Log per protocol.  Errors are displayed in ascending order by 
panel and subject item.  Each row represents a record in the panel.  When viewing the Error Log, you can 
double-click a record to open that record for editing in a study page. 
 
Global Change Log - a cumulative report that describes the results of global change processes. 
Contains entries for each panel and table that was submitted for global change.  When you change 
enrollment records, this log shows only one record modified, however, records in every panel in which 
that subject item is stored are also modified. 
 
Global Delete Log - a cumulative report that describes the results of global deletion processes. Contains 
entries for each panel and table that was submitted for global deletion.  When you delete enrollment 
records, this log shows only one record deleted, however, records in every panel in which that subject 
item is stored are also deleted. 
 
Merge Log - a cumulative report that describes the results of merging processes.  Contains entries for 
each panel that was submitted for merging. 
 
Screen Log - a cumulative report that describes the results of the screening process after a batch-load.  
Contains entries for each panel that was screened. 
 
SQL Load Log – a report that displays the results of batch-loading. 
 
Validation Log - a cumulative report that describes the results of the validation process.  Contains entries 
for each panel and table that was validated. 
 
To view a log or report, select View from the Reports menu for a log.  It takes several minutes for a log to 
display following notification of completion of a batch process.  If an open log window is empty, wait 
another minute and then select File > Refresh. 
 
Logs can be filtered to show only specific rows.  In the log window, select View > Filter to open the 
Specify Filter dialog box.  Click on Help for instructions.  Click on OK to return to the log window. 
 
Logs can be sorted according to criteria you define.  In the log window, select View > Sort to open the 
Specify Sort Columns dialog box.  Click on Help for instructions in sorting data.  Click on OK to return to 
the log window. 
 
When viewing a log or report, you can navigate between its pages by using the View > First Page, View 
> Prior Page, View > Next Page, and View > Last Page. 
 
You can purge logs of data at any time.  When you purge a log, you can purge all of its records (Purge 
All) or only selected records (Purge Selected) from the Reports menu for the log. 
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3.7 Closure Checks 
 
Not available at this time. 
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4.0 PROGRAMMER GUIDE TO RETRIEVING DATA 
 
 
4.1 Overview 

 
SAS Version 8 is being used for retrieval of study data entered in the JHS DMS and stored in the Oracle 
database.  SAS Version 8 can access the Oracle database directly using the new SAS/ACCESS 
LIBNAME statement that can take full advantage of SAS Version 7 and Version 8 enhancements. 
  
The SAS data retrieval program and retrieval process described here are for the second release of the 
JHS_COHORT protocol distributed on December 14, 2000.  The SAS retrieval program will require 
modification after each protocol release for any new form/version. 
 
Earlier versions of this SAS retrieval program used the SAS/ACCESS to Oracle interface to read the 
Oracle data tables.  Due to retrieval constraints using the SAS/ACCESS interface -- limited to SAS 
Version 6 naming conventions and restricted to text value lengths no longer than 200 characters -- the 
program was rewritten to use the new SAS/ACCESS LIBNAME statement to read the Oracle data tables.  
This enables the use of 32-byte names for SAS variables and enables read/write of character data up to 
32,767 bytes using a DBMAX_TEXT option.  And, now there is no creation of access and view descriptor 
files as an intermediate step to creation of SAS analysis datasets. 
 
As an alternative to the SAS data retrieval procedure, a description of the Clintrial Retrieve Query By 
Form (QBF) procedure is also provided. 
 
4.2 SAS Retrieval for Custom Reports 
 
Not available at this time.  Development will be similar to SAS retrieval for data analysis. 
 
4.3 SAS Retrieval for Data Analysis 
 
4.3.1 Overview 
 
The SAS data retrieval program reads data directly from the Oracle data tables with the SAS/ACCESS 
LIBNAME statement and creates output SAS analysis datasets, one dataset per form/version. 
 
Data integrity and security are maintained in this process.  The SAS/ACCESS LIBNAME statement 
requires entry of Oracle username, password, database alias, and protocol name.  A parameter specifies 
access to the Oracle data tables as read-only.  The JHSCC must identify allowable users for data 
retrieval, and the Database Administrator must provide adequate Oracle access rights for these 
users.  These rights must be similar to the Oracle SYSTEM user account for access to data 
entered by any user.  The SAS retrieval program delivered to the JHSCC will include the SYSTEM user 
account as default. 
 
4.3.2 Contents of SAS Retrieval Program 
 
The SAS retrieval program contains the following sections: 
 
1. Documentation block providing a description of the program. 
2. SAS environment options. 
3. Initialization of program macro variables. 
4. Initialization of macro variables for Oracle access. 
5. LIBNAME statements for input Oracle data tables and output SAS analysis datasets. 
6. Program title and footnote statements. 
7. %INCLUDE statement for PROC FORMAT code. 
8. Macros: 
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a. RETRV reads Oracle data tables and creates output SAS analysis datasets, with conversion of 
DATETIME variables to SAS DATE variables and with a %INCLUDE statement for FORMAT and 
LABEL statements by form/version. 

b. RENAME provides original and temporary variable names for a list of variables to convert from 
DATETIME to SAS DATE format. 

c. COUNT counts the number of variables in a list for renaming. 
9. Macro calls to RETRV for each form/version.  Parameter PAGES is the list of page sections (likewise, 

data tables) that comprise a single form, and parameter DVARS is the list of DATETIME variables to 
convert to SAS DATE variables. 

 
4.3.3 Setup of the SAS Retrieval Program 
 
The current version of the SAS retrieval program was developed in SAS Version 8.1 that was installed as 
a standalone program on a workstation connected to the JHS server containing the Oracle database.  
This SAS retrieval program does not need to be called from within Clintrial or the JHS DMS. 
 
Steps to set up the SAS retrieval program: 
 
1. Install the SAS System software, Version 8 or later, according to your site’s software installation 

policy. 
2. Copy the SAS retrieval program file and accompanying files (%INCLUDE source code) to a directory 

on your workstation. 
3. Edit the SAS retrieval program as follows: 

a. Modify the ‘outds’ macro variable to specify the LIBREF name of the LIBNAME statement for the 
output SAS analysis datasets and modify the corresponding LIBNAME statement with the 
directory location of the output SAS analysis datasets.  The SAS retrieval program delivered to 
the JHSCC includes the LIBNAME statement as used at the UNC-CSCC. 

b. Enter the Oracle access information for your site (macro variables ‘username’, ‘userpw’, 
‘database’, and ‘protocol’).  The SAS retrieval program delivered to the JHSCC includes the 
SYSTEM user account information, the database alias ORC0, and the protocol name 
JHS_COHORT. 

c. Modify the ‘home’ and ‘byformcd’ macro variables to specify the directory locations of the 
%INCLUDE source code.  The program delivered to the JHSCC includes the directory locations 
used at the UNC-CSCC. 

 
4.3.4 Generation of %INCLUDE Source Code for Formats and Variable Labels 
 
A process was established to generate PROC FORMAT statements and FORMAT and LABEL 
statements from information in the database to include in the SAS retrieval program.  A single text file is 
created of the PROC FORMAT statements for all codelists in the database, and individual text files for 
each form/version are created of FORMAT and LABEL statements for items in the protocol.  In addition, a 
list of DATETIME variables is generated to update the RETRV macro parameter DVARS for each 
form/version to convert DATETIME variables to SAS DATE variables. 
 
The steps to generate source code for the SAS retrieval program are as follows: 
 
1. Generate the PROC FORMAT code of all codelists in the database from a Clintrial Retrieve module 

query.  To create a format library text file, do as follows:  
a. Select any query type from File > New Query from the Retrieve browser (for example, select By 

SQL). 
b. In the query dialog box (for example, Query By SQL dialog box), do as follows: 

1) Enter a query.  For example, for Query By SQL, enter SQL text ‘select * from 
JHS_COHORT.ABBA1_ALL;’.  Entry of a valid query is required to get to the next dialog box 
to generate the PROC FORMAT code. 

2) Select Results > To SAS Data File. 
3) Select File > Run Query. 
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c. Now in the Create a SAS File dialog box, do as follows: 
1) Check option Generate SAS Format Library.  You do not need to generate a SAS data file. 
2) Click on Browse to select a directory path location and to enter a file name (without 

extension) for the resultant code.  The directory path and file name must not contain 
embedded periods (.), otherwise Clintrial will truncate the path or name at the first period.  
The output text file will have extension FMT (for example, FrmtlibV1-2.fmt). 

3) Click OK to continue. 
4) Close the open windows and exit Clintrial. 

d. To preserve the original version of FrmtlibV1-2.fmt, make a duplicate copy of the file to modify 
for the SAS retrieval program (for example, JHSRetrV1-2PrFormat.sas). 

e. Edit text file JHSRetrV1-2PrFormat.sas to replace single and double quotation marks embedded 
in the value text string with two single quotation marks.  It is not required to remove statements 
for forms or items not in the current protocol. 

f. Include this text file in a %INCLUDE statement in the SAS retrieval program. 
g. Special note: Clintrial uses the following conventions for SAS format names: 

1) 8-character maximum. 
2) Prefix ‘$’ if code is TEXT data type. 
3) The 6-character codelist SAS name assigned in Design. 
4) Suffix ‘V’ if decoding to values or ‘S’ if decoding to short label or ‘L’ if decoding to long label.  

In JHS, we decode to values. 
 
2. Run the following three SQL SELECT commands (in file JHSRetrV1-2Selects.sql) from a SQL 

command window to create FORMAT statements and LABEL statements for all relevant items in the 
current protocol.  You will need to run these SQL commands using an Oracle user account with 
access rights like user SYSTEM.  The PLSQL Developer software is used at the UNC-CSCC. 

  
 For FORMAT statements of character codes: 

SELECT distinct 'format '||a.item_name||' $'||b.sasname||'V. ;' item_code 
FROM ctsdd.item a, ctscodes.code_index b 
WHERE a.protocol='JHS_COHORT' 
and b.codetype='TEXT' 
and a.codename is not null 
and a.codename=b.codelist 
ORDER BY item_code ; 
 

 For FORMAT statements of numeric codes: 
SELECT distinct 'format '||a.item_name||' '||b.sasname||'V. ;' item_code 
FROM ctsdd.item a, ctscodes.code_index b 
WHERE a.protocol='JHS_COHORT' 
and b.codetype='FIXED' 
and a.codename is not null 
and a.codename=b.codelist 
ORDER BY item_code ; 
 

 For LABEL statements: 
(SAS V8 allows up to 40 characters for variable label text.  A blank is added as the last character 
of the label text to handle cases where DESCRIP is null and needs a blank space between 
double quotation marks as label text.) 
SELECT distinct 'label '||item_name||'="'||substr(descrip,1,39)||' ";' item_label 
FROM ctsdd.item 
WHERE protocol='JHS_COHORT' 
ORDER BY item_label ; 

 
a. Run the SELECT commands.  For example, in the PLSQL Developer software, select File > 

Open > Command File, enter the SELECT commands, and then choose Session > Execute.  
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Select all the output statements generated (Edit > Select All) and copy (Edit > Copy) to a single 
text file (for example, Parse_TextV1-2.txt). 

b. Edit text file Parse_TextV1-2.txt as follows: 
1) Modify any variable labels with two consecutive double quotation marks (“”) indicating no 

label text by inserting a blank (" "), otherwise a single quotation mark prints as the label text. 
2) Replace embedded double quotation marks in the label text with single quotation marks. 
3) Remove semicolons embedded in label text. 
4) It is not necessary to remove extra lines of text and underscores generated by a SELECT 

command run, such as the header associated with a page break. 
c.  Continue with step 3. 

 
3. Run the SAS program Parse_TextV1-2.sas to select FORMAT and LABEL statements by 

form/version from input text file Parse_TextV1-2.txt (created in step 2) and create individual output 
text files for each form/version.  Currently this SAS program adds comment delimiters around the 
FORMAT statements in the output text files so that codes and not format values are stored in the 
output analysis SAS datasets. 
a. Check each output text file and remove any unwanted text.  For example, remove any lines that 

do not begin with ‘format’ or ‘label’ or do not contain the comment delimiters. 
b. Include the individual output text files in a %INCLUDE statement in the SAS retrieval program.  A 

single %INCLUDE statement contains the form/version file name as a macro variable. 
c. Special note for FORMAT statements: See step 1 for Clintrial’s naming conventions of SAS 

format names. 
d. Special notes for LABEL statements: LABEL statements for CONTEXT panel items (key field 

items) are hardcoded in the SAS retrieval program.  A label text can contain up to 40 characters 
in SAS Version 8. 

 
4. Run the following SQL SELECT command (in file ItemdateV1-2.sql) to list all DATETIME variables in 

the current protocol to convert to SAS DATE variables in the SAS retrieval program.  You will need to 
run the SQL command using an Oracle user account with access rights like user SYSTEM.  In the 
SAS retrieval program, add the variable names to the RETRV macro parameter DVARS by 
form/version. 

 
SELECT item_name 
FROM ctsdd.item 
WHERE protocol='JHS_COHORT' and dtype in('DATE','DATETIME') 
ORDER BY item_name; 

 
4.3.5 Special Notes on the Current Version of the SAS Retrieval 
 
1. The program contains retrieval code for forms included in the JHS_COHORT protocol as of 

December 14, 2000. 
2. The program retrieves data field values only and does not include retrieval of flags and notes. 
3. The program includes LABEL statements with the label text from the Clintrial item descriptions used 

as screen prompts.  The item descriptions were assigned when the item was created to 
accommodate screen design and to match form layout.  It is recommended that the JHSCC staff 
review and update these variable labels for the SAS retrieval program to meet their analysis 
needs.  Notes on the labels: 
a. Label text lengths are limited to 40 characters, so some labels are truncated. 
b. A label may be blank or abbreviated or the text of an instruction, as per the form layout. 
c. A label may be incorrect if a change was made to the item but was not made also to the item 

description.  A screen prompt can revised directly on the page section, not requiring that the item 
description be changed as well. 

4. The program includes codelist codes and values in a SAS FORMAT procedure and in FORMAT 
statements.  The FORMAT statements currently are within comment delimiters so that the data 
values written to the output SAS analysis datasets are the codes and not the format values. 
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5. Clintrial’s DATE format is stored as a DATETIME format in the Oracle database.  The SAS retrieval 
program converts DATETIME variables to SAS DATE variables using the SAS DATEPART function.  
Only study data dates are converted, not Clintrial-generated system dates. 

6. Although the SAS retrieval program sets the YEARCUTOFF option to 1912 (a UNC-CSCC ARIC 
statistical programming rule), it can only interpret dates as retrieved from the Oracle database.  Note 
the following year cutoff rule for Clintrial data entry (from Clintrial Help): “Years can be entered as two 
digits or four. When a two-digit year is entered, Clintrial stores numbers 00 to 49 as 21st century 
(2049) and numbers 50 to 99 as 20th century (1950).”  The data entry personnel must be 
instructed to enter dates with a 4-digit year to ensure the correct century. 

 
4.4 Clintrial Retrieve Query By Form (QBF) 
 
4.4.1 Introduction 
 
Clintrial Retrieve, one of the Clintrial core modules, can be used to access and extract data from the 
Clintrial database by creating and running queries.  To access the Retrieve module, a user account must 
have the appropriate access rights assigned by the Clintrial Administrator. 
 
Queries are created using the following four types of query tools: 
 
• Query By Form - selecting fields and entering selection criteria directly on a study page (form).  

Requires familiarity with the study forms and with the data entry standards, but does not require 
familiarity with either SQL or with the structure of the Clintrial database. 

 
• Query By Panel – defining detailed search criteria through use of SQL.  Requires familiarity with 

panels and items within Clintrial and with simple SQL syntax. 
 
• Query By SQL – creating SELECT and DESCRIBE statements.  Requires familiarity with the 

structure of the Clintrial database and with SQL. 
 
• Ad Hoc Query - creating subject record lists to retrieve data for those subjects.  It does not require 

familiarity with SQL, but does require familiarity with the structure of the Clintrial database. 
 
Query results can be sent to the screen, to an Oracle database table, or to a SAS data file.  Then these 
data can be used in other applications to perform statistical analysis, create reports, or perform other 
tasks. 
 
You can store the queries in a Query Library where it can be accessed at a later time.  You can modify, 
copy, run, and delete saved queries. 
  
Using the Custom menu in Retrieve and in other modules, a user can access and start up other 
applications to create reports from the study data.  The user has access to the application from within 
Clintrial, but it executes outside of Clintrial. 
  
4.4.2 Using Query By Form 
  
Query By Form (QBF) is a query method that creates a query directly from the same online study pages 
used in Clintrial Enter for data entry.  For the JHS DMS, a single study page is usually equivalent to one 
form.  However in several cases, a JHS form was split into two study pages due to Clintrial design 
limitations, i.e., PACA parts 1 and 2, PDSA parts 1 and 2, PFHA parts 1 and 2, DISA parts 1 and 2, 
MHXA parts 1 and 2, MSRA parts 1 and 2, SSFA parts 1 and 2. 
  
You can create a query from multiple study pages.  The number of study pages available at a time is 
determined by the ENT_OPEN_PAGES preference for the Enter module that is set by the Clintrial 
administrator.   For JHS data entry, the preference is set at 1 (allowable range is 1-10) to limit the number 
of open pages at one time by a single user account in Enter.  Once data have been entered and verified, 



36 

Exam 2 Data Management System Manual.doc 

 

set the ENT_OPEN_PAGES preference to at least 2 for the Retrieve sessions so that you can add 
multiple study pages to a query for the several JHS forms that are split into multiple study pages. 
  
Below are the steps for using Query By Form.  It is suggested to perform a separate query for each JHS 
form, repeating these steps for each form. 
 
Assumptions are that you have logged into the Clintrial Retrieve module and have selected the correct 
protocol: 
 
• Start the Clintrial Retrieve module from Start > Programs > Clintrial 4.2 > Retrieve.  Login to 

Clintrial with a valid Clintrial user name, password, and database alias (ORC0 for JHS).  You are now 
in the Clintrial Retrieve window. 

• From the Retrieve window menu bar, select File > Set Protocol and protocol JHS_COHORT for 
retrieval of the baseline visit 1 data, if not automatically set at login. 

 
The steps to use Query By Form are as follows: 
 
1. Start Query By Form. 

 
From the Retrieve window menu bar, select File > New Query > By Form (QBF) to start Query By 
Form.  The Select Page dialog box opens. 

  
2. Select study pages. 

 
From the Select Page dialog box, select the study page(s) to include in the query.  Study pages are 
added to a query one at a time.  These study pages do not need to be in the same block (visit) or 
study book (INTERVIEW or EXAM). 
 
To select a study page, do as follows: 
a. Select a study book. 
b. Select a study page from the list, or type the study page name in the Page field. 
c. Click OK to continue.  A Query By Form window opens, displaying the study page you selected. 
 
To open another study page, select Edit > Select Additional Page and repeat a-c above.  If multiple 
study pages are open, you can move to another study page that is open using the commands in the 
Window menu.  If an additional page is selected from the Edit menu that is already open, a new copy 
of the study page opens. 
 

3. Select fields. 
 
For the study page open in the Query By Form window, select either specific fields or all fields for the 
study page.  The selected fields are highlighted on the study page. 
 
To select or deselect all fields on the study page, select Edit > Select All. 
  
To select or deselect a specific field, place the cursor in the field that you want to select or deselect 
using the Tab key or the mouse and then choose Edit > Select Item. 
 

4. Enter criteria in fields to specify a subset of data to retrieve (optional). 
 

If you enter selection criteria for a field, you do not also have to retrieve values for that field when you 
run the query.  Selecting fields and entering selection criteria are separate tasks. 
 
To enter selection criteria for the study page open in the Query By Form window, do the following: 
a. Place the cursor in the field for which you want to enter selection criteria using the Tab key or the 

mouse. 
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b. Enter the selection criteria using one of the following methods: 
1) Enter an exact valid value.  For a text field, enter the value without quotation marks.  For a 

numeric value, enter a numeric value or function without quotation marks.  For a date field, 
enter a date in a valid date format without quotation marks. 

2) Enter a value pattern as an operator and a valid value. No quotation marks are needed for 
text or numeric types, but they are required for date types. 

3) Select a code from the codelist, and optionally add an operator. 
c. To enter a selection criteria for another field, repeat a and b. 

 
5. Create a sort order of retrieved records (optional). 

 
You create a sorting order for the retrieved records by field values.  The default sort order for a field is 
None.  You can specify sort orders for more than one field.  Clintrial sorts the results according to the 
tab order of the fields. 
 
To sort the query results for the study page open in the Query By Form window, do as follows: 
a. Place the cursor in the field whose values you want to sort. 
b. Select Edit > Sort to open the Sort Field dialog box. 
c. Select sort order Ascending, Descending, or None, then click OK to continue. 
 
To remove the sort order for a field, do a-c above and select None. 
  
To change the field sort order, do one of the following: 
a. Select Results > To Window to display the results on the screen, then run the query from File > 

Run Query.  When the results are displayed on your screen, select View > Sort to sort the 
displayed records. 

b. Select File > Convert to SQL to convert the query to SQL code, then change the SQL syntax to 
reflect the order you want. 

 
6. Create flag or note restrictions (optional). 
 

To create a flag or note restriction for the study page open in the Query By Form window, do as 
follows: 
a. Select Edit > Flags/Notes Restrictions. 
b. Select the flag or note category and the flag or note name from the drop down list. 
c. Specify the flag or note level. 
d. Specify the page to which you want the flag or note to be attached.  Note for the JHS DMS, the 

page number is displayed for the open study page and the field is disabled for entry. 
e. If you are creating a restriction at the Item level, specify the item to which you want the flag or 

note to be attached. 
f. Click Add.  Clintrial Retrieve adds the flag or note restriction to the Selection box. 
g. Select whether to retrieve records if the flag or note is present or absent from the drop down list. 
h. To create multiple flag or note restrictions, repeat b-g.  A logical operator field appears in the 

Selection box.  Select the flag or note connector from the drop down list. 
 
To remove a flag or note restriction, do as follows: 
a. Select the flag or note restriction to remove by clicking anywhere within the restriction in the 

Selection box. 
b. Click Delete. 
 

7. Display the query in SQL format (optional). 
 

You can display the SQL for the current query in Query By Form from File > Convert to SQL to 
review a single page query, to review a multi-page query as a whole, or to perform tasks for which 
you must use SQL.  You can display a query in SQL at any time and still return to the Query By Form 
page(s) if you do not alter the SQL.  However, if you alter the SQL in the Query By SQL window, you 
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should not return to the Query By Form page(s).  Any changes you make to the SQL cannot display 
in the Query By Form page(s). 
 

8. Run the query to retrieve the query results, and send the results to various locations in various export 
formats. 

 
To run a query in the Query By Form window, do as follows: 
a. Select the destination for the query results from the Results menu.  Options are To Window, To 

Oracle table, or To SAS Data file. 
b. Select File > Run Query.   
 
After the query runs, your results destination does one of the following: 
a. To Window - displays the results in a Query By Form Results window. 
b. To Oracle table – opens the Results to Oracle Table dialog box. 
c. To SAS Data file – opens the Create a SAS File dialog box. 
 
See the section on saving results to a SAS data file below for details on creating an output ASCII file 
(.DAT) of the study data retrieved from the query and a SAS source code file (.SAS) with the input 
statement containing the variable names and formats to read the ASCII data file. 
 

9. Print the query. 
 

Select File > Printer Setup to specify which local or network printer to use. Depending on your 
printer, you can also adjust certain printer defaults like page orientation, paper size, and print 
resolution. Consult your printer's documentation for more information. 
 
To print a report or window from the Query By Form window, do as follows: 
a. Select File > Print.  At any time the Print command is not available for a displayed window, then 

that window does not have print capability. 
b. The Print Options dialog box opens. Accept default settings or modify any of the values as 

needed. 
c. Click OK to print. 
 

10. Save the query to the Query Library for later use by you or other users (optional). 
 

To save a query in the Query By Form window, do as follows: 
a. Select File > Save Query As. 

1) If you have previously saved this query, Clintrial Retrieve saves the query to the same query 
name automatically. 

2) If you have not previously saved this query, the Save Query As dialog box opens. 
b. In the Save Query As dialog box, do as follows: 

1) If you are saving a Query By SQL, select the protocol under which you want to save the 
query. 

2) Enter the query name 
3) Enter a description for the query. 
4) If you want the security access type for the query to be Public, check Public Query. 
5) Click OK. 

 
To access the saved queries in the Query Library, select File > Query Library from the Query By 
Form window. 
 

4.4.3 Saving Results to a SAS Data File 
 
Query results can be saved to a SAS data file from the Query By Form window in one of two ways: save 
directly to a SAS data file without display, or display and then save to a SAS data file. 
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To run and save the query results directly to an SAS data file (does not display results), do as follows: 
 
1. From the Query By Form window, select Results > To SAS Data file from the menu. 
2. Create or select the query you want to run either for selected items (place cursor on item and then 

select Edit > Select Item) or for all items (select Edit > Select All). 
3. Select File > Run Query to run the query and which opens the Create a SAS Data File dialog box. 
4. From the Create a SAS Data File dialog box, to save the query results to a SAS data file, do: 

a. Specify path, file name, label, and record length for the SAS data file.  Note that path C:\CT42 is 
the default. 

b. To create a PROC FORMAT for this data file (optional), check Make PROC FORMAT.  
c. Click OK.  Clintrial Retrieve displays a confirmation message indicating where the query results 

are stored; click OK. 
 
To run and display the query and then save the results to a SAS data file: 
 
1. From the Query By Form window, run the query in File > Run Query which sends the results to a 

Query By Form Results window. 
2. From the Query By Form Results window, select File > Save Results As. The Save Results As 

dialog box opens. 
3. In the Save Results As dialog box, select SAS Data Files [.SAS] from the File Format drop down list. 

The file name in the File Name field changes to *.SAS, and the SAS fields at the bottom of the dialog 
box become active.  Then, do: 
a. Specify the path, file name, label, and record length for the SAS data file. Note that path C:\CT42 

is the default. 
b. To create a PROC FORMAT for this data file (optional), check Make PROC FORMAT. 
c. Click OK.  Clintrial Retrieve displays a confirmation message indicating where the query results 

are stored; click OK. 
 
4.4.4 Setup and Run the SAS Data 
 
If you have saved the query results to a SAS data file, then you have the following two or three text files in 
the directory that you chose: 
 
1. SAS source code file (.SAS) with a data step that includes an INFILE statement with the location and 

name of the ASCII data file, an INPUT statement with valid variable names and formats, LABEL 
statements for the variables (the prompt used in the data entry window), and optionally FORMAT 
statements for the variables with codelists. 

2. ASCII file of SAS data (.DAT) from the query that corresponds to the SAS source code INPUT 
statement. 

3. Optionally, PROC FORMAT code file (.FMT) with the VALUE statements for all the codelists attached 
to the variables in the query. 

 
To setup a SAS program using these files, do the following: 
 
1. Optionally insert the PROC FORMAT code file into the SAS source code file either directly or with a 

%INCLUDE statement. 
2. Add additional SAS statements to the SAS source code file either to save the data to a permanent 

SAS dataset, to create a report, or to run data analysis. 
 
You can now run the final SAS source code file in SAS.   Consult your local SAS support personnel for 
information on how to run SAS at your site.  
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5.0 ADMINISTRATOR GUIDE 
 
 
5.1 Data Entry Workstation Setup 
 
Setting year format for dates 
 
The format in which dates are entered and displayed in Clintrial is determined by the Window’s date 
setting.  Set the date format (a regional setting) to a four-digit year format (mm/dd/yyyy). 
 
In Clintrial data entry, enter four-digit years for dates to ensure the correct century.  If a two-digit year is 
entered, Clintrial interprets the year as follows: 
• 00 through 49 as the 2000’s 
• 50 through 99 as the 1900’s 
 
Creating a desktop Enter shortcut icon 
 
To put a shortcut on the desktop, do as follows: 
1. In Start > Programs > Clintrial 4.2, right-click on Clintrial Enter and left-click Create Shortcut. 
2. Holding down the left mouse button, drag the new shortcut icon, named Clintrial Enter (2), from 

Start > Programs > Clintrial 4.2 onto the desktop. 
3. To rename the shortcut, right-click the shortcut and left-click Rename.  Type the new name, and 

press Enter. 
4. Double-click the shortcut icon to start the Clintrial Enter module. 

 
To change any settings for the shortcut, right-click the shortcut and then left-click Properties.  
 
To delete a shortcut, drag the shortcut to the Recycle Bin.  The original item still exists on the disk.  
 
Screen resolution and window size 
 
The screen resolution and window size for data entry must be set the same as the setting used during the 
development of the JHS DMS.   The settings are as follow: 
 
• Set the screen resolution to 800 by 600 pixels in Start > Settings > Control Panel > Display.  Click 

on the Settings tab.  Under Screen area, click on the left or right of the arrow to get this resolution. 
• Set the window size to Maximum.  Click the middle windows button on the top right of an open 

window to toggle between maximum full screen and minimum window display. 
• Remove the toolbar buttons to maximize the screen further.  In a window, select the Window > 

Toolbar menu commands and click on Toolbar to remove the check.  Several bugs in Clintrial at the 
time of this writing affects some of the toolbar buttons, so it is recommended to use the menu 
commands or to right-click the mouse for selections. 

 
Installing and Deinstalling Oracle and Clintrial Client Software 
 
Installing the Oracle Client Software: 
 
1. Insert the Oracle CD into the workstation CD-Rom. 
2. Once the Oracle installer main menu appears, click on “Begin Installation”.   If the Oracle installer 

main menu does not appear, you can open the Windows Explorer and access the root directory of the 
Oracle CD-ROM.  From the root directory, double-click on SETUP.EXE. 

3. You are then asked to confirm the installation default settings, then click OK. 
4. You will then be asked to choose the type of installation, click on “Oracle 8 Client” then click on OK. 
5. You will then be asked the type of user you are installing for, choose “Application User” and click OK. 
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6. You will then be asked where the Oracle Documentation should be put, choose “CD-Rom” and click 
on OK. 

7. You will then be asked if you would like to view the Oracle documentation from within your browser, 
answer No. The Client installation is complete and the Oracle installer will be exited. 

8. In order to be able to use Clintrial you must now install the Oracle “Required Support Files 7.3.4.1.1” 
to do this repeat steps 1 through 3 above. 

9. You will then be asked to choose the type of installation, click on “Custom Installation” then click on 
OK. 

10. The Software Asset Manager will appear.  Double-click on the All Products entry on the left hand side 
of the Software Asset Manager window.  A scrollable list will be presented; choose “Required Support 
Files 7.3.4.1.1” by clicking on the entry, then click on Install. This will install the Required Support 
Files. 

11. Upon completion of the installation the Oracle Installer will notify you, at this point you must click on 
OK, you will be returned to the Software Assets Manager, click on Exit then Yes, to confirm that you 
would like to exit the Oracle Installer. 

12. Reboot your computer after exit from the Oracle Installer with the resultant changes to your 
AUTOEXEC.BAT (or, you can wait until after Clintrial installation and network connection). 

13. You are now ready to install the Clintrial client software on the workstation. 
 
Installing the Clintrial Client Software: 
 
1. Insert the Clintrial CD into the  workstation CD-Rom. 
2. Open the Windows Explorer and access the root directory of the Clintrial CD-Rom.  From the root 

directory double-click on Setup.exe. 
3. The Clintrial Welcome screen will appear, click Next. 
4. You will be asked for name and company, enter these and click Next. 
5. Clintrial will then ask you to confirm that the client software is to be installed in C:\CT42, click Next. 
6. Choose Typical as the setup type and click Next. 
7. Select Clintrial 4.2 as the Program Folder and click Next. 
8. The installation will then take place, at the end of which you will be asked if you would like to view the 

ReadMe file. Click on Finish. 
9. You are now ready to establish your network connection to the computer where the Clintrial database 

is located. 
 
Establishing Network Connection: 
 
1. Start the Oracle Net8 Easy Config module by selecting the following: Start > Programs > Oracle for 

windows 95 > Oracle Net8 Easy Config . 
2. Click Yes to continue on past the first dialog box with a warning that comment information in the 

Network Configuration files may be lost or repositioned when saving your Network configuration. 
3. Choose action Add New Service (database alias) and enter a name as the New Service Name.  Enter 

ORC0 as the service name (or the current database alias at your site).  Note that .WORLD is 
automatically appended to ORC0 in the display of available Service Names.  Click Next to continue. 

4. Choose TCP/IP (Internet Protocol) to connect to and communicate with the Clintrial database you 
want to use.  Click Next to continue. 

5. Enter the IP address as Host Name of the computer where the Clintrial database is located.  Leave 
1521 as the default Port Number.  Click Next to continue. 

6. Enter ORC0 (or the same name as the current database alias) for the Database SID.  Click Next to 
continue. 

7. Click Test Service to test the connection.  In the database connection dialog box, enter a valid Oracle 
database username (for example, SYSTEM) and its password and click Test.  After the test is 
completed, click Done to continue.  If the connection test was successful, click Next from the Test 
Service dialog box to continue; if not successful, click Back to review and correct previous entries. 

8. Click Finish to save your service name changes. 
9. You are now ready to create new Clintrial user accounts. 
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Setting Up Client User Accounts: 
 
1. Start the Clintrial Admin module by selecting the following: 

Start > Programs > Clintrial 4.2 > Clintrial Admin 
2. In the database connection dialog box, enter the User Name (for example, CTSYS) and Password 

that was set up with system privileges on installation of Clintrial on the server.  For Database, enter 
your service name added in Oracle Net8 Easy Config preceded by @ ( for example, @ORC0). 

3. From the Security menu, select Users to get the User Maintenance window. 
4. From the Edit menu, select Add. 
5. Enter a name (user account) for the new User Name.  A valid user name can be up to 20 characters 

long, alphanumeric, not beginning with a number, and without spaces or other symbols.  User name 
is not case sensitive. 

6. Enter a Password.  When you save the window, you will be prompted to re-enter the password for 
verification.  The password must conform to the parameters as set up by the system administrator 
(currently length set at 6).  A password must consist of alpha and/or numeric characters (other 
symbols and spaces not allowed) and cannot begin with a number.  A password is not case sensitive. 

7. Accept the defaults, or change the values for : 
Default Tablespace: CT_USER 
Temporary Tablespace: TEMPORARY 
Profile: DEFAULT 

8. From the File menu, select Save to save the window. 
9. From the Security menu, select User Access to set access rights and access levels for Protocol, Non-

Protocol, and Panel (to be determined).  Close the User Access Rights window. 
10. From the Parameters menu, select System to define any special characteristics of the work 

environment for the user.  Close the System Parameters window. 
11. Close the Clintrial Admin module after the new user accounts have been created with appropriate 

access rights and system parameter definitions. 
12. Optionally you can place a Clintrial 4.2 icon on the Desktop (for Switchboard with access to all 

Clintrial modules or just for Enter to perform data entry) by doing as follows. Open My Computer or 
Windows Explorer and select Clintrial 4.2.  From the File menu, select Create Shortcut.  Select the 
Clintrial 4.2 shortcut and drag the shortcut onto the Desktop by holding down the left button of the 
mouse. 

 
Deinstalling  Oracle and Clintrial Client Software: 

 
To delete Oracle and/or Clintrial client software from a computer, say, to restart installation after an 
unsuccessful attempt, use the following deinstallation instructions. 
 
To deinstall Clintrial Client Software, do the following. 
1. Double-click on the icon for My Computer. 
2. Double-click Control Panel. 
3. Double-click Add/Remove Programs. 
4. Select Clintrial 4.2 and click Add/Remove. 
5. The directory C:\CT42 can be deleted from Windows Explorer or by the RD DOS command at an MS-

DOS command prompt. 
 
To deinstall Oracle Client Software, do the following. 
1. Start the Oracle Installer module as follows: Start > Programs > Oracle for Windows 95 > Oracle 

Installer. 
2. Select all Oracle modules (shift-down arrow) in the rightmost column labeled “Products Installed at 

C:\ORAWIN95” and click Remove.  The Oracle Installer remains installed and does not need to be 
deleted if Oracle will be reinstalled. 
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5.2 System Parameters 
 
Clintrial system parameters define the characteristics of the work environment for all users of an Oracle 
database to which the users connect through Clintrial.  These system parameters are set in the Clintrial 
Admin module from a user account that has the Admin System access right.  In Admin and in the 
following table, system parameters are grouped by the module to which they pertain. 
 
Parameters of type ‘System’ cannot be overridden.  Those of type ‘Protocol’ can be overridden by 
modifying protocol parameters within the Design module.  Those of type ‘User’ can be overridden by user 
preferences for each module (or Group).  For JHS, the ‘System’ parameters are set for the study and do 
not override the values within protocol or user. 
 
The table below lists the parameter value to be used in JHS and a description of what the value means.  
If the description is blank, no value has yet been determined. 
 
Group Type Name Value Description 
     
Admin System  PASSWORD_ENCRYPTION No  
 System SAVE_STATS Yes  
 System ACTIV_LOG_END   
 System ACTIV_LOG_START   
 System PASSWORD_EXPI RE_DAYS   
 System PASSWORD_MINIMUM 6  
 System USR_DB_PROFILE DEFAULT  
 System USR_DFT_TSP CT_USERS  
 System USR_TMP TSP TEMPORARY  
 
Manage  System ALLOW_MERGE_TO_VALID Yes  
 System AUDIT_REASON_REQD Yes  
 System AUTOCODE_FULL_CNT No  
 Protocol AUTOCODE_RECODE_ALL No  
 System AUTOCODE_SET_FAIL Yes  
 Protocol ENCODE_CLEAR_ITEMS Yes  
 User SELECT_BY_PAGE  Yes  
 User AUDIT_ITEM_LIST   
 User ERRLOG_DISPLAY_ITEM   
 
Entry User  DD_BLANKS_IN_PATIENT No Blank spaces not allowed in 

subject item. 
 User ENT_AUTOSKIP_DFLT  No  
 User ENT_ENTER_AS_TAB  Yes Enter key acts as Tab key. 
 User ENT_FORM_INSERT  Yes Data is saved automatically 

when a page is closed. 
 User ENT_OPEN_NAVIGATOR  Yes  
 User ENT_TAB_PAGE_FORWARD No In last field on page, Tab key 

moves to first item on 
current page. 

 Protocol VERIFY_BLIND Yes  
 System VERIFY_SHOW_TAGS Yes  
 User ENT_ENR_STUDYBOOK   
 User ENT_OPEN_PAGES 1 Number of study pages that 

can be opened concurrently. 
Increase to 10 temporarily to 
print study book or do QBF. 



45 

Exam 2 Data Management System Manual.doc 

 

 
 
Design  System AUDIT_INVNOTES Yes  
 Protocol AUDIT_METADATA Yes  
 System AUDIT_PROTOCOL_MOD Yes  
 System AUDIT_SPONSORNOTES Yes  
 Protocol CONNECT_REQD_DD No  
 Protocol CONNECT_REQD_FRM No  
 Protocol CONNECT REQD VLD No  
 Protocol CREATE OBJ_DD Yes  
 Protocol CREATE_OBJ_FRM Yes  
 Protocol CREATE_OBJ_VLD Yes  
 Protocol DD_AUTOVALIDATE No  
 User DD_SASNAME_UPDATE Yes  
 Protocol DD_STRICT_CODE No  
 Protocol DD_STRICT SEARCH No  
 User FRM_CODEENTRY  No  
 User FRM_OVERRIDE  No  
 User FRM_USE_DESCRIP  Yes  
 System AUDIT_START_DEFAULT  MERGE  
 User DD_DBFMT_FIXED  NUMBER(5)  
 User DD_DBFMT_FLOAT  NUMBER(6,2)  
 User DD_DBFMT_TEXT  VARCHAR2(20)  
 Protocol PROC_ACCOUNT   
 System PROC_SITE_ACCOUNT  CTSITEPROC  
 System PROT_TMP_TSP  TEMPORARY  
 System XFER_TABLESPACE   
 
Retrieve  User RTV_INCL_SYS No  
 User RTV_DEF_DECODE  0 Codelist column used for 

decoding: 0=code, 1=value. 
 User RTV_SAS_RECLEN  80  
 User RTV_DEF_SOURCE  DATA From data tables only.  ALL 

includes both update and 
data tables. 

 User SAS_LIBNAME   
 
Resolve  System CTV_USE_ERRORLOG Yes  
 System CTV_APPL_RES_CODE   
 System CTV_AUTOCLOSED_RES   
 System CTV_OBSOLETE_RES   
 User CTV_FIRST HEADER Company Name  
 Protocol CTV_FIRST_HEADER_PR   
 User CTV_REQUESTER   
 Protocol CTV_REQUESTER_PR   
 User CTV_SECOND_HEADER Discrepancy 

Form 
 

 Protocol CTV_SECOND_HEADER_PR   
 Protocol CTV_SELECT_INVESTIGA See 1 below  
 Protocol CTV_SELECT_SUBJECTS See 2 below  
 Protocol CTV_SELECT_VISITS See 3 below  
 Protocol CTV_SELECT_VI SITS_1S See 4 below  
 User CTV_STARTUP_VIEW ALL   
 Protocol CTV_STARTUP_VIEW_PR   
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1) SELECT UNIQUE CT_RESOLVE_USER.INV_ID(<SUBJECTITEM>, 
'<PROTOCOL>') FROM<PROTOCOL>.SUBSTITUTE*PANEL_ SUBSTITUTE*DBTABLE 
    
2) SELECT UNIQUE <SUBJECT_ITEM> FROM <PROTOCOL>.SUBSTITUTE*PANEL 
SUBSTITUTE*DBTABLE 
WHERE CT_RESOLVE_USER.INV_ID(<SUBJECT_ITEM>, '<PROTOCOL>') = 
'SUBSTITUTE*INVESTIGATOR' 
 
3) SELECT UNIQUE <BLOCK_ITEM> 
FROM<PROTOCOL>.SUBSTITUTE*PANEL_SUBSTITUTE*DBTABLE 
 
4) SELECT UNIQUE <BLOCK_ITEM> FROM<PROTOCOL>.SUBSTITUTE*PANEL 
SUBSTITUTE*DBTABLE 
WHERE <SUBJECT_ITEM> = 'SUBSTITUTE*SUBJECT' 
 
 
Lab 
Loader 

User CTL_TEST_MODE No  

 System CTL_DUPFLAG_LOC DATA  
 
Classify System CTG_ALLOW_CHANGEVEB Yes  
 System  CTG_AUTOACCEPT No  
 System  CTG_EDIT_SYNTEXT No  
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5.3 Adding New User and Usergroup Accounts and Assigning Access Rights 
 
Adding a New User Account 
 
Each Clintrial user must have a user account consisting of an ID and password to work with Clintrial 
modules. Multiple users with similar access needs (for example, data entry personnel) can be assigned to 
a usergroup, which allow you to assign and modify their access rights as a single set. 
 
To add a new user, do as follows: 
 
1. Login to the Clintrial Admin module. 
2. From the Clintrial Admin window, select Security > Users.  The User Maintenance window opens. 
3. In the User Maintenance window, select Edit > Add.  The cursor is placed in the User Name field.  

Do as follows: 
a. Enter a name for the new user for User Name. 
b. Enter a password for Password. When you tab from the field or save the window, you will be 

prompted to re-enter the password for verification.  Follow the password requirements at the 
beginning of this manual.  You may choose to assign a generic temporary password to new 
users, which they can later change themselves. 

c. Accept the defaults for the remaining fields. 
d. Close the window from File > Close or from the window's X button to return to the Admin window. 

 
 
To modify a user password, do as follows: 
 
1. Follow steps 1 and 2 for a new user to login to Clintrial Admin and to open the User Maintenance 

window. 
2. In the User Maintenance window, do as follows: 

a. Select a user in the Select User list. 
b. Enter a new password.  When you tab from the field or save the window, you will be prompted to 

re-enter the password for verification. 
c. Close the window from File > Close or from the window's X button to return to the Admin window. 

 
To delete a user, do as follows: 
 
1. Follow steps 1 and 2 for a new user to login to Clintrial Admin and to open the User Maintenance 

window. 
2. In the User Maintenance window, do as follows: 

a. Select a user in the Select User list. 
b. Select Edit > Delete. 
c. Close the window from File > Close or from the window's X button to return to the Admin window. 

 
Note that upon deletion, the user will automatically be removed from any associated usergroups. 
 
Creating a Usergroup Account 
 
Usergroups are sets of individual user accounts.  Grouping of user accounts provides an easy way to 
manage access rights for multiple accounts with identical access requirements.  Once a group is created 
and its rights defined, its members automatically receive those rights and any subsequent modifications.   
 
Clintrial Help provides the following information about usergroups: 
 
• Belonging to a group does not prevent a user from having individual access rights beyond those of 

the group. 
• Users can be associated with one or more usergroups. 
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• In the case of a user whose individual access differs from that of the usergroup, or in the case of a 
user belonging to multiple usergroups with contrasting access rights, the highest access level always 
takes precedence. 

• Deleting a usergroup does not delete its members' individual user accounts. 
• When planning a usergroup, consider the following: What Clintrial activities will this group perform?  

What study data or metadata does this group need access to?  For the specified data, what tasks 
does this group need to perform, for example, read and write tasks? 

• Clintrial supplies three predefined usergroups.  These groups can be used as is, modified as 
necessary, or deleted altogether.  The groups and their default access rights are as follows:  

 
 Group  Module  Type  Access right Access levels 
 
 ADMIN  Admin  Non-protocol DBA  Full 
       System  Full 
   Design  Non-protocol Global  Full 
       System  Full 
   Tools  Non-protocol SQL  Full 
 
 ANALYSIS Retrieve Protocol Merged  Read 
       Library  Write 
 
 ENTRY  Enter  Protocol Unmerged Full 
 
To create a usergroup, do as follows: 
 
1. Login to the Clintrial Admin module. 
2. From the Clintrial Admin window, select Security > Usergroups.  The Usergroup Maintenance 

window opens. 
3. In the Usergroup Maintenance window, do as follows: 

a. Select Edit > Add.  An Add Usergroup dialog box opens.  Enter a name for the new usergroup 
for Usergroup Name and click OK.  A usergroup name can be up to 20 characters long, must be 
alphanumeric, and cannot begin with a number.  A usergroup name is not case sensitive. 

b. To add or remove group members, see below. 
c. Close the window from File > Close or from the window's X button to return to the Admin window. 

 
To delete a usergroup, do as follows: 
 
1. Follow steps 1 and 2 to create a usergroup to login to Clintrial Admin and to open the Usergroup 

Maintenance window. 
2. In the Usergroup Maintenance window, do as follows: 

a. Select the group you want to delete from the Usergroups list. 
b. Select Edit > Delete. 
c. Close the window from File > Close or from the window's X button to return to the Admin window. 

 
To add or remove group members, do as follows: 
 
1. Follow steps 1 and 2 to create a usergroup to login to Clintrial Admin and to open the Usergroup 

Maintenance window. 
2. In the Usergroup Maintenance window, do as follows: 

a. Select a group from the Usergroups list. 
b. To add users, select from the Non-members list and click <<. 
c. To remove users, select from the Members list and click >>. 
d. Close the window from File > Close or from the window's X button to return to the Admin window. 

 
Assigning Access Rights 
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Clintrial Help provides the following information on access rights: 
 
Once a user account or usergroup has been created, the Clintrial administrator must assign access rights 
for the new account.  Access rights determine a user or usergroup's ability to access data and perform 
tasks in Clintrial. 
 
An access right is composed of the following two parts: 
 
• The access right, which specifies the data type or action in question (for example, merged data). 
• The access level, which specifies what can be done with that right (for example, read or write). 
 
There are the following three categories of access rights: 
 
• Protocol access rights control access to data and actions related to a specific protocol. 
• Non-protocol access rights control access to data and actions independent of specific protocols. For 

example, the ability to use SQL. 
• Protected Panel access rights control access to protocol panels that have been designated as 

"protected" in Design.  To work with a panel of this type, the user must have access to both the 
protocol and the panel itself. 

 
Within each of these three categories, access rights are further grouped by the Clintrial module.  
 
The simplest and most effective way to assign access rights is through usergroups.  Once a group is 
created and its rights defined, its members automatically receive those rights.  Rights for a particular user 
are typically only defined when additional access beyond that of the group is required by a user. 
 
In the case of a user whose individual access differs from that of the usergroup, or in the case of a user 
belonging to multiple groups with contrasting access rights, the highest access level always takes 
precedence.  For example, if user X has write access to Admin, but X's usergroup access is read-only, 
the higher (write) access takes precedence 
 
By default, newly defined users and usergroups have no access rights.  Exceptions are Clintrial's 
predefined user account (CTSYS) and usergroups (Admin, Analysis, Entry). 
 
To assign access rights, do as follows: 
 
1. Login to the Clintrial Admin module. 
2. From the Clintrial Admin window, select Security and the access action you want to take (User 

Access, Usergroup Access, Protocol Access, or Panel Access).  See Clintrial Help for more 
detail. 

3. In an access rights window, select a row to which you are assigning access.  For each Clintrial 
module, select the appropriate access level from the drop-down list.  The list displays automatically 
when you click in a field.  The dash (-) signifies No Access.  If a user belongs to any usergroups, the 
usergroups are listed as unavailable rows under the user's name. 

4. Close the window from File > Close or from the window's X button to return to the Admin window. 
 
To copy settings from one row to another in an access rights window, do as follows: 
 
1. Click a field in the row you want to copy from. 
2. Select Edit > Copy Row. 
3. Click a field in the row you want to copy to, and select Edit > Paste Row. 
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5.4 Administering Clintrial and the Oracle Database 
 
This appendix may later include information on topics such as daily monitoring of data table space, 
installing Oracle and Clintrial service releases, and updating the DMS. 
 
Typical users and of the Clintrial modules 
 
Clintrial consists of five integrated core modules (listed below) and a Clintrial Switchboard that provides a 
single point of access to the Clintrial modules.  Supplemental modules that extend the basic Clintrial 
functionality are also available. 
 
Module  Use to        Typical user 
 
Admin  Create user and usergroup accounts.    Clintrial Administrator 
  Set up and manage access rights for users, usergroups,   or 
      and protocols for all Clintrial modules.    Database Administrator 
  Set system parameters. 
  Monitor database space. 
  Produce reports about system activities.  
       
Design  Design the study database to model your study protocol.  Designer 
  Define data structures for storing study data.   or 
  Create study books that are online representations of   Programmer 
      a set of data collection forms for data entry. 
 
Enter  Add (enroll) subjects to a study.     Data-Entry Operator 
  Enter study data interactively. 
  Verify (re-enter) study data. 
  Edit study data. 
  Add flags and notes to study data. 
  Produce reports about study data. 
 
Manage Batch load study data.      Data Manager 
  Code study data using a coding thesaurus. 
  Validate data (run derivations and rules). 
  Globally change or delete records. 
  Edit records based on an Error Log report. 
  Review an audit report of changes to study data.  
 
Retrieve Extract study data from the Oracle database using SAS.  Data Manager 
  Create simple or complex queries using SQL from Clintrial. or 
          Medical Reviewer 
 
Monitoring data table space 
 
At installation, Clintrial sets default storage parameters for its Oracle tablespaces.  Using the Admin 
module, the Clintrial Administrator can view and modify these storage parameters and can regularly 
monitor the growth of the database (e.g., run Reports > Space Utilization for tables and indexes). 
 
Frequent monitoring of the tablespaces by the Database Administrator is recommended.  Clintrial does 
not recognize when tablespace limits are approached, and a protocol could be damaged if space 
allocations are exceeded. 
 
Manuals on Oracle DBA administration are available from the Oracle Corporation.  Another source for 
information is from books by users such as Oracle Performance Tuning by Mark Gurry & Peter Corrigan 
from O’Reilly & Associates, Inc. 
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5.5 Blind Verification Procedure 
 
Introduction 
 
Verification or double data entry is the process of re-entering study data to compare the old and new 
values, checking for data entry errors or value conflicts.   
 
Clintrial supports two types of verification: interactive verification and blind verification. 

 
For the JHS, selected study data are re-entered using blind verification. The forms that are verified are 
those forms completed on paper (enumeration, home induction interview, Approach to Life A-C, and 
Hassles and Moods A-D forms). 
 
Blind verification is performed in the Enter module, and reports on verification errors are generated in the 
Enter module on ‘unmerged’ data in the update tables. 
 
JHS DMS Form Design and Its Significance in Verification Error Checking 
 
A single form or study page is usually made up of multiple records (panels or page sections), each 
containing a unique subset of items (fields) for the form. 
 
Knowing that a form requires verification, the designer sets the Verify attribute for usually all the panels 
for that form from the Panel Browser in the Design module.   
 
Following blind verification, not all the records (or panels) for a single form may have the same record 
status.  For example, the ELGA Eligibility form is composed of seven records.  If only an item contained in 
the first panel of this form has a value conflict from blind verification, then only the first record for the form 
containing this item receives a record status of Verify Error; the other records for the same form receive a 
record status of Verified. 
 
What is Blind Verification? 
 
In blind verification, Clintrial compares old and new values when you save a study page re-entered in the 
Verify edit mode.  During blind verification, the new values do not overwrite the old ones, nor can you 
choose which value to retain.   
 
If there is a value conflict, a record status is changed from Unverified to Verify Error, otherwise a record 
status is changed to Verified.  Clintrial also attaches a VERIFICATION/AUTOFLAG flag to an item with a 
value conflict.  The VERIFICATION/AUTOFLAG flag comment contains the original and re-entered values 
and the user accounts of the data-entry operator(s) who entered the values. 
 
Reviewing Blind Verification Results 
 
Three Clintrial reports accessed from the Reports menu in the Enter module can provide results on the 
blind verification.  These reports are the Verification Report, Subject Report, and Flag Report.  Only 
subjects in the update tables are included in these reports.  Once created, these reports can be viewed 
online, printed, or saved to a file.   
 
The Verification Report (record level) contains a list of records with a status of Verify Error. 
  
A Detailed Subject Report (record level) can contain a list of all records for a form(s) and their record 
status. 
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A Detailed Flag Report (item level) can include items with a VERIFICATION/AUTOFLAG flag, along with 
the comments containing the original and re-entered values and the user accounts of the data-entry 
operator(s) who entered the values. 
 
The Flag and Subject reports are available in two basic formats: detailed and summary. The detailed 
format provides in-depth information on the attributes of each record that it retrieves. The summary format 
gives a count and categorical breakdown of the records it finds. You can tailor each report by entering 
criteria prior to generating it using the Report Wizard. 
 
The Clintrial Help menu provides in-depth information on these three reports.  Select Help > Help Topics 
in the Enter module.  You can find information under the Contents tab in Enter Reports, and you can find 
information under the Index tab for ‘reports’. 
  
Special note on reviewing verification results: A form with any of its records and items marked with 
verification errors should not be changed and set to Verified until all verification results are reviewed for 
that form.  When you open a form in the Navigator after blind verification and set it to Verified on closing, 
you will lose information on all value conflicts for that form.  That is, all VERIFICATION/AUTOFLAG flags 
on items for the form will be removed and every Verify Error record status for the form will be changed to 
Verified. 
 
Special note on Clintrial reports: The Verification Report and Subject Report may not accurately show a 
record status of Verify Error when an item in that record has a VERIFICATION/AUTOFLAG flag.  The 
Flag Report appears to be the most accurate listing on blind verification errors.  It is advisable to review 
the Verification Report, Subject Report, and Flag Report together for a comprehensive review of all 
records entered (Subject Report) and those with verification errors (all three reports but most accurately 
the Flag Report). 
 
Performing Blind Verification 
 
In preparation for blind verification, the Enter module VERIFY_BLIND protocol parameter must be set to 
Yes in the Admin module by your Clintrial administrator.  You can only open a form for blind verification if 
its panels were set with the Verify attribute in the Design module by the designer.  You can only verify 
forms in the Enter module that are in update tables and that have a panel status of Unverified. 
  
The steps to verify forms using blind verification are as follows: 
  
1. From the File > Edit Mode menu, set the edit mode to Verify. 
2. In the Navigator, select the form (study page) that you want to verify. 
3. Enter data in all fields. 
4. Save the changes when you are done. Once saved, the record(s) for the form have their status 

changed from Unverified to Verified or Verify Error, and the form cannot be verified again. 
 
Flags and notes themselves do not need to be verified.  However, you can attach, modify, or delete flags 
and notes during verification if the system parameter VERIFY_SHOW_TAGS is set to Yes (all flags and 
notes are available) in the Admin module by your Clintrial administrator.  
 
During blind verification, Clintrial automatically attaches a VERIFICATION/AUTOFLAG flag to a field if 
you re-enter a value that is different than the original value or if you leave blank a field that originally had 
a value.  A VERIFICATION/AUTOFLAG flag comment contains the original and re-entered values for the 
field and the user accounts of the data entry operator(s) who entered the values.  
 
Modifying Data after Blind Verification and after Verification Results Review 

 
To change a record status from Verify Error to Verified, open the form after blind verification in Edit 
Update Table mode that is set from the File > Edit Mode menu in the Enter module.  You can add to or 
change the original values of any fields or retain the original values.  When you save the form and set the 
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form to Verified, then all records for the form receive a status of Verified and all 
VERIFICATION/AUTOFLAG flags are removed from fields in the form. 
 
When you modify or delete data in the update tables, you may be required to provide a Reason for 
Change.  A Reason for Change is an explanation appended to an individual record explaining why the 
record was modified.  The Reason for Change dialog box opens automatically when you edit a record.  
Enter an explanation directly into the Reason for Change Text box.  To apply the Reason for Change to 
the current record only, click OK.  To apply the Reason for Change to all modified records for a form, click 
Apply To All Changes. 
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FOREWORD 
 
This manual is one of a series of protocols and manuals of operation for the Jackson Heart Study (JHS).  The 
complexity of the JHS requires that a sizeable number of procedures be described, thus this list of materials has 
been organized into the set of manuals listed below.  Manual 1 provides the background, organization, and general 
objectives of the JHS Study.  The other Manuals describe the operations of the Clinic and Surveillance 
Components of the study.  Detailed Manuals of Operation for specific procedures are contained in the other 
Manuals listed. 
 
 

JHS Study Protocols and Manuals of Operation 
 
 

MANUAL TITLE 
  
1 General Description and Study Management 
  
2 Blood Pressure  
  
3 Specimen Collection and Processing 
  
4 Cohort Surveillance 
  
5 Quality Control 
  
6 Data Management System 
  
7 Central Laboratory and Specimen Repository 
  
8 CT Scan Site  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 ii 

 
 
 

 
 

 
 
 
 
 

Manual  1. General Description and Study Management 
 

TABLE OF CONTENTS 
 

1.0 INTRODUCTION ...................................................................................................................... 1 
1.1 Rationale ................................................................................................................................... 1 

1.2 Study Objectives ....................................................................................................................... 2 

1.3 Study Description ...................................................................................................................... 2 

1.4 Study Centers  .......................................................................................................................... 10 

1.5 Clinic Examination .................................................................................................................... 11 

1.6 Follow Up .................................................................................................................................. 12 

1.7 Clinical Review and Diagnosis Classification ........................................................................... 12 

1.8 Reading Centers ....................................................................................................................... 12 

2.0 DATA MANAGEMENT ............................................................................................................. 13 
2.1 Coordinating Center Data Management System ...................................................................... 12 

2.2 Examination Center Data Management System ...................................................................... 13 

2.3. Data Security and Confidentiality ............................................................................................. 13 

2.3.3 Specimen Repository Data Management ................................................................................. 14 

2.3.4 Collaborative Database ............................................................................................................ 15 

3.0 STUDY MANAGEMENT .......................................................................................................... 15 
3.1 Introduction ............................................................................................................................... 15 

3.2 JHS Director ............................................................................................................................. 15 

3.3 JHS Study Subcommittee and Charges ................................................................................... 16 

3.4 Communications ....................................................................................................................... 16 

3.5 Publication and Presentation Policy ......................................................................................... 16 

4.0 ANCILLARY STUDIES ............................................................................................................ 22 
4.1 Objectives ................................................................................................................................. 22 

4.2 Review Process ........................................................................................................................ 22 

4.3 Procedures ............................................................................................................................... 23 

 



 iii 

 
 
 
 

Manual 1. General Description and Study Management 
 

 
APPENDICES 

 
Appendix 1 JHS Principal Investigator and Directors ......................................................................... A-1 

Appendix 2 Jackson Heart Study Organizational Chart ...................................................................... A-3 

Appendix 3 JHS Committees and Subcommittee Members ............................................................... A-6 

 



 iv 

 
 

 

  Manual 1.   General Description and Study Management 

 
 

TABLES 
Table 1. Age-adjusted Mortality Rates for Men and Women in the United States (US) and  

 Mississippi (MS), 1997 .................................................................................................... 1 

 

Table 2. ARIC and JHS Exam 1 Study Component Schedule: Interview and  
 Procedures by Visit .......................................................................................................... 3 
 

Table 3. The JHS Study Component Schedule: Interview and Procedures by Visit  .................... 7 

 

Table 4. Components of the JHS Examination 2 ........................................................................... 11 

 

FIGURES 
Figure 1. JHS: Process from Manuscript Submission to Publication .............................................. 21 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 1 

 
1.0 INTRODUCTION  
 
The Jackson Heart Study is a population-based study of cardiovascular disease in African-Americans sponsored by 
the National Heart, Lung, and Blood Institute and the National Center for Minority Health and Health Disparities of 
the National Institutes of Health. 
 
 
1.1 Rationale 
 
Despite encouraging declines over the past three decades, cardiovascular disease (CVD) remains the number one 
cause of death in the U.S.  A number of risk factors for coronary heart disease (CHD) and stroke have been 
identified; however, relatively few population-based studies have examined CVD in a large group of African-
Americans.  Existing evidence indicates that death rates for CVD in the U.S. are considerably higher among 
African-Americans.  CVD death rates in Mississippi are the highest in the nation and particularly high among 
African-Americans.  Between 1980 and 1995, the decline in CVD death rates has been the slowest among African-
American men and women in Mississippi relative to other groups in the state and nation (Table 1). 
 
 
Table 1. Age-adjusted Mortality Rates for Men and Women in the United States (US) and Mississippi 

(MS), 1997 
 

            Black           White 
Mortality1,2 Region Men Women Men Women 
All Causes US 1,445 939 1,062 718 

 MS 1,630 1,000 1,266 794 

CVD US 540 401 436 300 
 MS 683 496 542 365 

Hypertension US 14 12 5 4 
 MS 12 13 4 6 

Heart Disease US 414 295 347 223 
 MS 548 385 448 285 

Stroke US 206 190 172 169 
 MS 233 191 186 174 

 

1 Age-adjusted death rates to the total US population for year 2000; 
ages 35-84; annual rate per 100,000. 

2 ICD-9, International Classification of Diseases, Clinical Modification, 9th Edition for causes 
of death listed are: 
 Cardiovascular Disease (CVD) 390-459 
 Hypertension with or without Renal Disease 401, 403 
 Heart Disease 390-398, 402, 404-429 
 Stroke or Cerebrovascular Disease 430-438 

Source: CDC Wonder Internet Web site (http://wonder.cdc.gov) 
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1.2 Study Objectives 
 
The primary objective of the Jackson Heart Study (JHS) is to investigate the causes of CVD in African-Americans to 
learn how to best prevent this group of diseases in the future.  More specific objectives include: 
 

(1) Identification of factors, which influence the development, and worsening of CVD in African-
Americans, with an emphasis on manifestations related to high blood pressure (such as remodeling 
of the left ventricle of the heart, coronary artery disease, heart failure, stroke and disorders 
affecting the blood vessels of the kidney). 

 
(2) Building research capabilities in minority institutions at the undergraduate and graduate level by 

developing partnerships between minority and majority institutions and enhancing participation of 
minority investigators in large-scale epidemiologic studies. 

 
(3) Attracting minority students to and preparing them for careers in public health and epidemiology.  

 
1.3 Study Description 
 
The JHS is a single-site prospective epidemiologic investigation of cardiovascular disease (CVD) among African-
Americans from the Jackson, Mississippi metropolitan statistical area.  This study represents an expansion of one 
of the sites of the Atherosclerosis Risk in Communities (ARIC) Study, which included four geographically diverse 
communities in the U.S.  (Northwestern suburbs of Minneapolis, Minnesota; Washington County, Maryland; Forsyth 
County, North Carolina; and the city of Jackson, Mississippi).  The ARIC study included a comprehensive baseline 
examination (1987-1989) and three subsequent follow-up examinations occurring at approximately three-year 
intervals (1990-1992, 1993-1995, and 1996-1999).  A total of 15,792 individuals between 45 and 64 years of age 
were initially examined and 3,732 were from the Jackson ARIC cohort. 
 
The JHS includes 5,302 African-American men and women between the ages of 35 and 84 which includes 1,626 of 
continuing ARIC participants from Jackson along with men and women from a larger tri-county geographic area 
than the prior study. Non-ARIC participants were selected from the African-American residents of Hinds, Madison 
and Rankin counties surrounding Jackson, Mississippi. This is an area larger than either Rhode Island or Delaware 
in square miles.  Family members were included in order to permit studies of familial and genetic contributions to 
CVD.  The extensive examination in Exam 1 included a series of questionnaires, physical assessment, and 
laboratory measurements. Table 2 compares these components with those from the prior ARIC examinations.. 
Table 3 contains the components of Exams 2 and 3.  The information collected included both conventional risk 
factors and new or emerging factors that may be related to CVD.  Some of the newer areas of focus included early 
indicators of disease, genetics, socio-cultural influences such as socioeconomic status and discrimination, and 
physiological relations between common disorders such as high blood pressure, obesity and diabetes and their 
influence on CVD.  The initial examination phase of the study was conducted over 3.5 years beginning in the fall of 
2000 and concluding in the spring of 2004.  This phase of the JHS will include Exam 2 , 2005-2008 and Exam 3, 
2009-2012; however, this Manual covers only Exam 2.   
 
The JHS is sponsored by the National Heart, Lung, and Blood Institute (NHLBI) and the National Center for Minority 
Health and Health Disparities at the National Institutes of Health in partnership with three Jackson, Mississippi 
institutions: Jackson State University, the University of Mississippi Medical Center, and Tougaloo College.  Jackson 
State University developed a coordinating Center (CC) where all data collected during the study is managed, 
analysis of data is performed and community involvement is coordinated. Tougaloo college operates an Under 
graduate Training Center (UTC) where selected students are given the opportunity to take course work in public 
health and epidemiology and gain  

 
 
practical experience in health research to help prepare them for potential careers in these fields. The University of 
Mississippi Medical Center developed an Exam Center (EC) which is responsible for conducting the examinations 
and retaining the cohort. The JHS offices and clinic facility are located in the main concourse of the Jackson 



 3 

Medical Mall, which is serving as a centralized location for high quality, efficient health care delivery for the 
underserved community. 
 
Table 2. The ARIC Study and JHS Exam 1 Component Schedule: Interview and Procedures by Visit 

 
 ARIC JHS 
 
PROCEDURES 
 

Visit 1 
1987-89 

Visit 2 
1990-92 

Visit 3 
1993-95 

Visit 4 
1996-98 

EXAM I 
2000-04 

 
 ANTHROPOMETRY 

 
 

 
 

 
 

 
 

 
 

 
  HEIGHT 

 
 

 
 

 
 

 
 

 
 

 
     Sitting Height 

 
X 

 
 

 
 

 
 

 
 

 
     Standing Height 

 
X 

 
 

 
X 

 
X 

 
X 

 
  FRAME SIZE 

 
 

 
 

 
 

 
 

 
 

 
     Elbow 

 
 

 
X 

 
 

 
 

 
 

 
     Wrist 

 
X 

 
 

 
 

 
 

 
 

 
  GIRTHS 

 
 

 
 

 
 

 
 

 
 

 
     Calf 

 
X 

 
 

 
 

 
 

 
 

 
     Neck 

    X 
 
     Hip 

 
X 

 
X 

 
X 

 
X 

 
 

 
     Waist 

 
X 

 
X 

 
X 

 
X 

 
X 

 
  SKINFOLDS 

 
 

 
 

 
 

 
 

 
 

 
     Subscapular 

 
X 

 
X 

 
 

 
 

 
 

 
     Triceps 

 
X 

 
X 

 
 

 
 

 
 

 
  WEIGHT 

 
X 

 
X 

 
X 

 
X 

 
X 

 
 MALE BALDNESS 

 
 

 
 

 
 

 
X 

 
 

 
 BLOOD PRESSURE 

 
 

 
 

 
 

 
 

 
 

 
    Sitting 

 
X 

 
X 

 
X 

 
X 

 
X 

 
    Supine 

 
X 

 
 

 
S 

 
S 

 
X 

 
    Standing 

 
X 

 
 

 
S 

 
S 

 
 

 
    Ankle 

 
X 

 
 

 
S 

 
S 

 
X 

      

4 
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 ARIC JHS 
 
PROCEDURES 
 

Visit 1 
1987-89 

Visit 2 
1990-92 

Visit 3 
1993-95 

Visit 4 
1996-98 

EXAM I 
2000-04 

    Ambulatory     X 
 
 ECHOCARDIOGRAPHY 

 
 

 
 

 
X 

 
 

 
X 

 
 ELECTROCARDIOGRAPHY      
 
    2-minute Rhythm Strip 

 
X 

 
 

 
X 

 
 

 
 

 
    12-Lead 

 
X 

 
X 

 
X 

 
X 

 
X 

 
    Heart Rate Variability 

 
S 

 
 

 
 

 
A 

 
 

 
 GLYCEMIC LOAD 

 
 

 
 

 
 

 
X 

 
 

 
 INTERVIEWS 

 
 

 
 

 
 

 
 

 
 

 
    Anger (CHOST, Anger In & Out) 

 
 

 
 

 
 

 
 

 
X 

 
    Annual Follow-up 

 
X 

 
X 

 
X 

 
X 

 
X 

 
    Blood Transfusion 

 
 

 
 

 
 

 
X 

 
 

 
    CHD Events/Procedures 

 
X 

 
X 

 
X 

 
X 

 
X 

 
    CES-D 

 
 

 
 

 
 

 
 

 
X 

 
    Cognitive Function 

 
 

 
X 

 
S 

 
X 

 
X 

 
    Coping Inventory 

 
 

 
 

 
 

 
 

 
X 

 
    Dietary Intake 

 
X 

 
S 

 
X 

 
S 

 
X 

 
    Family History of CHD 

 
 

 
X 

 
 

 
 

 
X 

 
    Fasting Status 

 
X 

 
X 

 
X 

 
X 

 
X 

 
    Genogram 

 
 

 
 

 
 

 
 

 
X 

 
    Global Stress 

 
 

 
 

 
 

 
 

 
X 

 
    Health History 

 
X 

 
X 

 
X 

 
X 

 
X 

 
    Home Interview 

 
X 

 
 

 
 

 
 

 
X 

 
    Inflammation 

 
 

 
 

 
 

 
X 

 
 

 
    Informed Consent 

 
X 

 
X 

 
X 

 
X 

 
X 
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 ARIC JHS 
PROCEDURES Visit 1 

1987-89 
Visit 2 
1990-92 

Visit 3 
1993-95 

Visit 4 
1996-98 

EXAM 1 
2000-04 

 
    Medication Survey 

 
X 

 
X 

 
X 

 
X 

 
X 

 
    Personal History  
    (Smoking, Alcohol, Access) 

 
X 

 
X 

 
X 

 
X 

 
X 

 
    Physical Activity 

 
X 

 
 

 
X 

 
 

 
X 

 
    Racism & Discrimination 

 
 

 
 

 
 

 
 

 
X 

 
    Religion 

 
 

 
 

 
 

 
 

 
X 

 
    Reproductive History 

 
X 

 
X 

 
X 

 
X 

 
X 

 
    Respiratory Symptoms 

 
X 

 
X 

 
 

 
 

 
X 

 
    Social Support 

 
 

 
X 

 
 

 
 

 
X 

 
    Socioeconomic Status 

 
X 

 
X 

 
X 

 
X 

 
X 

 
    Stress 

 
 

 
 

 
 

 
 

 
X 

 
    TIA/Stroke 

 
X 

 
X 

 
X 

 
X 

 
X 

 
    TIA/Stroke Summary 

 
X 

 
X 

 
 

 
 

 
X 

 
    Tracking 

 
X 

 
X 

 
X 

 
X 

 
X 

 
    Trait Anger 

 
 

 
X 

  
X 

 
X 

 
    Violence 

 
 

 
 

 
 

 
 

 
X 

 
    Vital Exhaustion 

 
 

 
X 

 
 

 
 

 
 

 
    Vitamin Survey 

 
 

 
 

 
X 

 
 

 
X 

 
 MEDICAL DATA REVIEW 

 
X 

 
X 

 
X 

 
X 

 
X 

 
 MRI, CEREBRAL 

 
 

 
 

 
X 

 
 

 
 

 
 PERIODONTAL EXAMINATION 

 
 

 
 

 
 

 
A 

 
 

 
 PHYSICAL ACTIVITY MONITOR 

 
 

 
 

 
 

 
 

 
X 
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 ARIC JHS 
 
PROCEDURES 
 

Visit 1 
1987-89 

Visit 2 
1990-92 

Visit 3 
1993-95 

Visit 4 
1996-98 

EXAM I 
2000-04 

 
 PHYSICAL EXAMINATION 

 
 

 
 

 
 

 
 

 
 

 
    Neck 

 
X 

 
X 

 
 

 
 

 
 

 
    Cardio/pulmonary 

 
X 

 
X 

 
 

 
 

 
 

 
    Lower Extremities 

 
X 

 
X 

 
 

 
 

 
 

 
 PULMONARY FUNCTION 

 
 

 
 

 
 

 
 

 
 

 
    FEV1.0 

 
X 

 
X 

 
 

 
 

 
X 

 
    FVC 

 
X 

 
X 

 
 

 
 

 
X 

 
    Max. Inspir. Pressure 

 
 

 
X 

 
 

 
 

 
 

 
 RETINAL PHOTOGRAPHY 

 
 

 
 

 
X 

 
 

 
 

 
 ULTRASOUND, B-MODE 

 
 

 
 

 
 

 
 

 
 

 
    Carotid Arteries 

 
X 

 
X 

 
S 

 
S 

 
X 

 
    Distensibility 

 
X 

 
X 

   

 
    Popliteal Artery 

 
X 

 
 

 
 

 
 

 
 

 
 URINE COLLECTION 24-Hour 

 
 

 
 

 
 

 
 

 
X 

               
              Spot Urine 

     
X 

 
 VENIPUNCTURE 

 
 

 
 

 
 

 
 

 
 

 
    Chemistries  

 
X 

 
X 

 
X 

 
X 

 
X 

 
    Hematology 

 
X 

 
X 

 
O 

 
O 

 
X 

 
    Hemostasis 

 
X 

 
X 

 
X 

 
X 

 
X 

 
    Lipids 

 
X 

 
X 

 
X 

 
X 

 
X 

 
 
 
 
 
S=Sample; A=Ancillary study mechanism; O=Optional 
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Table 3. The JHS Study Component Schedule: Interview and Procedures by Visit  
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1.4 Study Centers 
 
1.4.1 The Coordinating Center 
 
Jackson State University developed a Coordinating Center (CC) where all data collected during the study is 
managed, analysis of the data is performed and community involvement is coordinated.   
 
The JHS CC operates the Office of Community Partnership.  The goal of the Community Partnership is to create an 
environment of trust and long-term support of the JHS by providing opportunities for substantive community 
involvement in all phases of the study development, conducting health promotion/education activities, and linking 
participants to needed services.  The Partnership for Community Awareness and Health Education Committee 
serves as an independent body of community representatives, including political, medical, social, civic, business, 
health-related government agencies, and grassroots organizations, in order to provide ongoing input into the 
development and implementation of community outreach  and health education activities. 
 
The CC provides centralized administration, planning, and management for many components of the JHS.  The 
core operational and scientific coordinated functions include 1) database management; 2) protocol development; 3) 
quality assurance; 4) biostatistical analysis; 5) maintenance of phone system, local area networks, e-mail, intranet, 
and World Wide Web JHS home page; 6) equipment purchasing and maintenance; and 7) administrative support 
for the JHS and its committees (such as convening meetings, documenting decisions and action items, preparing 
and distributing meeting minutes and coordinating the work of the various subcommittees).  The CC provides 
technical support for the installation, use and maintenance of local computer equipment and CC staff provides 
software.  The CC serves as the official repository for all JHS Steering Committee records, manuals of operations, 
data collection instruments, research data and publications. 
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The CC's responsibility for the centralized management of the study includes the provision and tracking of training 
and certification; monitoring protocol adherence in the EC and reading centers; the design, implementation and 
monitoring of quality assurance programs in the EC and reading centers; and data management, including the 
development of a computerized data collection system, on-site and centralized data processing and data analysis.  
Training and certification, protocol adherence and quality control are discussed in each of the manuals.  The 
specific procedures for the distributed data management systems and data analysis are described in the following 
section of this manual.  The CC also supports the design, management, and analysis of case-control studies and 
the publication of results of collaborative studies. 
 
1.4.2 The Examination Center 
 
The University of Mississippi Medical Center developed an Examination Center (EC), which is responsible for 1) 
protocol development; 2) conducting the examinations, annual follow-up, and retention of participants; and 3) 
developing, pilot testing, and conducting surveillance for morbidity and mortality outcomes (events) of all 
participants. Surveillance includes annual telephone or mail contacts as part of morbidity and mortality follow-up for 
the entire cohort to ascertain: (a) occurrence of cardiovascular events (including coronary heart disease, 
cerebrovascular disease, and congestive heart failure), other illnesses, and hospitalizations, including information 
from participants, personal informants, hospitals and physicians, according to a standard protocol; (b) dates and 
recorded causes of all deaths, using local vital statistics sources, obituaries, the National Death Index, and other 
sources; and; (c) circumstances surrounding death, through interview of family members, physicians and review of 
coroners' and other records; (d) participate in classification of cardiovascular events and conditions, using a 
standard protocol. 
 
1.4.3 The Undergraduate Training Center 
 
Tougaloo College created an Undergraduate Training Center (UTC) where selected students are given the 
opportunity to take course work in public health and epidemiology and gain practical experience in health research 
to help prepare them for potential careers in these fields. 
 
The specific goals of the UTC are to 1) create a pool of well-trained high school students who upon entering 
college, can successfully complete undergraduate, graduate or professional degrees in health professions and 
public health; and 2) introduce a program of college courses to prepare students to pursue advanced studies 
towards public health and epidemiology, 3) recruit faculty to teach JHS related courses and do collaborative 
research with other institutions; and 4) participate on various JHS committees.  The UTC accomplishes these goals 
by introducing Outreach to High School students to courses in Science, Language and Mathematics (SLAM) 
inclusive of pre-college courses.  The UTC also implemented a JHS training plan where JHS scholars (freshmen or 
sophomore undergraduates) act as mentors and tutors to the Outreach high school students; take courses in Public 
Health, Epidemiology, Biostatistics, and Research Methods; attend Tougaloo College colloquia and the Summer 
Epidemiology course; and receive didactic academic experience through involvement in the practicum. A modular 
system for scholar education and associated JHS practica was initiated for Exam 2. The UTC collaborates with the 
JHS CC and EC and other local and international institutions to provide students with hands-on experiences to 
create interest in public health careers.  
 
1.5   Clinic Examination 
 
The clinic examination for Exam 2 takes approximately 3 hours.  The sequence of the exam is 
flexible so that up to four participants can be examined concurrently, in accordance with the 
available personnel and work station configuration.  The following sequencing restraints are 
necessary: (1) Fasting and abstinence from smoking and alcohol is required for not less than 12 
hours prior to the venipuncture, spot urine and blood pressure measurements, (2) The 
venipuncture and spot urine should be done before the sitting blood pressure, (3) Sitting blood 
pressure must be measured before the body composition (4) Computed Tomography should be 
done before the snack.  (5) Interviewing  will precede the  distribution of the home blood 
pressure monitor and related teaching, (6) Medical Data Review must be done prior to the exit 
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interview. Since participants must fast for not less than 12 hours prior to the examination,  a 
snack  is provided during the exam sequence.  Table 4 identifies and describes the components 
of the Examination 2. 
 
Table 4. Components of the JHS Examination 2 
 
Procedure Description 

 
Reception Greet the participant; determine fasting status; 

obtain tracking data; collect medications 
Informed Consent 
 
Spot Urine  
 
Venipuncture                           

Obtain informed consent 
 
Obtain urine specimen 
 
Obtain blood specimens for fasting blood glucose, 
hemoglobin A1c,lipids, C-reactive protein, and DNA 
 

Blood Pressure Obtain sitting blood pressure 
Body Composition 
 
 
Computed Tomography 

Measure weight and height . Measure waist., neck 
and hip circumference. Measure % body fat  
 
Accompany participant to site for heart x-ray 

  
Snack Provide a nutritious snack containing no caffeine or 

stimulants 
  
Interview Collect medical/health history (medication survey, 

medical history, health history, renal disease, stroke 
symptoms) 

Self-Monitored Blood 
Pressure 

Distribute home blood pressure monitor. Teach 
participants to measure blood pressure at home 
using provided equipment. 

Medical Data Review Ascertain the completeness of the exam and verify 
abnormal results. Review the results of the medical 
history and exam with the participant.  Refer 
participant for diagnosis or treatment elsewhere if 
appropriate. 

Exit Interview Provide clinic summary report and return 
medications. 
Provide instructions and thank participant. 

 
 
1.6 Follow-Up 
 
Annual follow-up of the JHS cohort is used to maintain contact, to correct address information of cohort participants 
and to ascertain medical events between three-year comprehensive examinations. 
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Follow-up contacts are targeted to occur within a month of the anniversary date of the original visit—adjusted for a 
three-year exam cycle rather than the 3 ½ year cycle used in Exam 1.  Contact letters are on JHS stationery and 
inform the addressee that s/he will receive a telephone call from JHS asking about interim health problems. 
 
A telephone interview is conducted to ask participants about hospitalizations for illness or surgery, diagnoses and 
symptoms.  If the participant cannot be reached by telephone, a home interview is attempted.  The questionnaire 
queries information on hospitalizations for illness or surgery, diagnoses, medical care and symptoms.  The 
participant is asked the standard Rose questionnaire for angina, possible MI and intermittent claudication, vital 
status, hospitalizations, and a variety of socio-cultural topics that will change each year.  Verification of address and 
phone number is made along with an update of the other information used to contact the participant.   Every 
attempt is made to identify cohort participants who have died in advance of the annual contact through regular 
review of obituaries and death certificates. 
 
1.7 Clinical Review and Diagnostic Classification  
 
During the follow-up contact, the cohort participant may indicate that he or she had been hospitalized.  Records are 
obtained for all hospitalizations, which occur after the Exam I visit.  Abstracters record all discharge diagnoses and 
clinical information related to cardiac or cerebrovascular diseases.  The participant will have signed a medical 
release form allowing the study to access medical records. 
 
Similarly, during the obituary review or a follow-up contact, it may be determined that the participant has died.  In 
these cases, the death certificate is obtained and the place of death is determined.  For in-hospital deaths, the 
hospital record is reviewed.  For out-of-hospital deaths and decedents admitted without vital signs, the participant's 
family and physician are contacted to provide information on the circumstances surrounding the death.  At entry to 
the study and with each subsequent clinic visit, the participant will have given consent to contact family members 
and physicians in the event of his or her death. 
 
A special Events Monitoring Subcommittee reviews the information on hospitalizations and provides the study 
diagnosis for coronary heart disease or cerebral vascular disease according to defined criteria.  The Events 
Monitoring Subcommittee also provides a classification of cause of death. 
 
1.8  Reading Centers 
 
1.8.1 Specimen Repository 
 
The Specimen Repository (SR) provides facilities and equipment to receive, store, aliquot, and distribute urine, 
white blood cells, DNA and /or transformed white blood cells from JHS participants.  The facilities provide aseptic 
and/or sterile conditions as appropriate (Bio-safety Level 2 Containment).  The SR, like the CL, is at the University 
of Minnesota Department of Laboratory Medicine and Pathology and the Fairview-University Medical Center.  The 
SR has laboratory facilities and personnel for developing and monitoring the inventory of specimens.  The JHS 
Ancillary Studies Committee reviews all requests for samples. 
 
The SR procedures are detailed in Manual of Operation (MOO) 7.  The MOO includes 1) a description of the 
procedures to be followed for processing, inventory control and delivering samples; 2) procedures for training 
personnel; 3) a detailed description of computer system and data entry system; and 4) a detailed protocol for long 
term storage.   
 
2.0 DATA MANAGEMENT 
 
2.1  Coordinating Center Data Management System 
 
The JHS uses state-of-the-art CADC systems during the collection of examination and annual follow-up, in order to 
maximize data accuracy.  A centralized data management system with direct data entry was developed using the 
software ClinTrial4.  This type of system displays screens that resemble paper forms, and eliminates the burden of 
data entry and editing, reduces data entry turnaround time, and improves the quality of data analysis while 
minimizing respondent burden.  The data collector reads the items from the screen, performs the measurement or 
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queries the participant, and keys the response into the computer.  As data for the EC are entered, they are edited 
by the system.  Values failing the edit checks cause an error message to be displayed and prompts further 
investigation.  In addition to collecting and editing the data, the system permits users to enter text into an electronic 
"post-it note".  This computer assistance rapidly directs the interviewer to the relevant sections of the interview for 
the particular respondent and provides for very rapid interviewer action, thus lessening the respondent burden. 
 
2.2   Examination Center Data Management System 
 
The EC is responsible for managing the data collected during the cohort examinations and event abstractions. This 
includes the initial recording, keying, editing, correction, and transmission of data to the JHS CC. It also includes 
maintaining an inventory of data forms and other materials collected and sent to the JHS Reading Centers and CC. 
 
The CADC workstation allows EC personnel to enter, edit and correct data values directly eliminating the need for 
paper forms, except as a back up.  
 
The JHS data management system is centrally operated through a local area network that connects workstation 
microcomputers to a local database computer.  The network eliminates the need for individual participant diskettes 
since the local database is updated from each workstation as participant information is entered.  Data records 
corresponding to each form are written to multiple hard disk files as the data are collected.  Thus, a system failure 
will only affect the current form being entered.  In the event that the network is not functioning, participant 
information is written to the workstation hard disk is used to update the local database once the network is 
operating properly.  If for some reason, such as power failure, the data management system is not functioning, 
paper forms are available for data collection.  These data can then be entered when the data management system 
becomes operational. 
 
As participant information is entered at a workstation, the local database is updated and automatically encrypted.  
In addition, a copy of each participant record is written to an encrypted ASCII file on the workstation hard disk.  This 
file serves as a backup from which the local database can be restored, if necessary.  If the network is not 
functioning, this file can be used to update the local database once the network is functioning. 
 
2.3   Data Security and Confidentiality 
 
All investigators maintain data security and confidentiality in accordance with their Institutional Review Board 
agreement.  The Principal Investigator and Center Directors/Co-Principal Investigators maintain data security and 
confidentiality in accordance with guidelines of the NIH. 
 
All JHS staff is instructed in procedures for maintaining data confidentiality, and sign a form indicating their 
awareness of the necessity of maintaining confidentiality of data.  Staff will be informed that any inappropriate use 
or disclosure of confidential data is cause for immediate termination of employment.  
 
Certifying Institutional Review Board approvals by each collaborating institution are included in accordance with 45 
CFR 46.  Participant data are collected and stored by two methods.  In addition to the computerized data 
management system, data may be collected on paper forms or audiotape for quality control, and then stored in 
locked file cabinets, stored in locked rooms.   Since this is a single study center, original data does not leave the 
premises, and electronic back up of the data is made on a regular basis.  
 
2.3.1   Coordinating Center 
 
Since this is a single study site, the data are entered quickly after collection and do not leave the premises.  Data 
are only made available to persons performing statistical analysis.  If outside consultants or investigators with 
offices outside the study site need access to the data for publications, a data tape or CD-ROM is prepared with no 
personal identifiers included.   
 
The JHS maintains a "secure data room" that is an interior room within the CC office suite.  This room is designed 
so that it is environmentally controlled with Halon fire protection.  This room is used to store original paper forms 
and data tapes.  The room is locked at all times and only select members of the CC computing division have 
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access to this room.  The CC also has procedures for disposal of confidential data, as defined by any medium 
containing masked information or personal identifiers.   
 
2.3.2   Examination Center 
 
The local area network adds a level of confidentiality since a user must have a special ID and password to log onto 
the network in order to gain access to the data management system.  In addition, another level of security is 
function-specific, so that interviewers only be allowed to access the specific interviews they were assigned, and 
staff performing editing, analysis, etc., have another function-specific ID and password.  Data is backed-up after 
each interview is completed, and daily back-ups are performed to the network server to minimize data loss.   
 
Disclosure to the participants regarding confidentiality of their data is completed during reception.  The consent 
form states that information provided by the participant is kept confidential and is only used for scientific research 
purposes without revealing their name.   Individuals are informed that participation in JHS is voluntary, and that 
they may withdraw from the study at any time.  Individuals are informed that the purpose of the survey is to collect 
information to aid in the understanding of the mechanisms of disease of the heart, lung, and blood vessels, and 
help physicians treat patients by recommending preventive measures against future disease among healthy 
individuals. 
 
Individuals are informed that they may refuse to answer any questions or to participate in any of the tests.  Refusal 
to participate or answer any of the questions does not result in any loss of benefits to which they might otherwise 
be entitled, nor does it adversely affect their medical care.  In publications, the individual identities of participants 
are not disclosed, and data are reported only in aggregate.  Abnormal findings are relayed to the participant and his 
or her physician as agreed to by the participant.  EC staff is trained in procedures for insuring confidentiality of 
participant information. 
 
2.3.3  Central Laboratory and Specimen Repository Data Management 
 
Aliquots of plasma and serum and tubes of whole blood per subject are stored at the CL/SR.  An inventory record 
on paper accompanies each batch of specimens. Specimen analyses are performed on many different instruments 
with software written for each machine permitting transmittal of results directly to the central computer for the 
clinical laboratory.  Results are then sent from the CL/SR to the CC via file transfer protocol (FTP) for transfer into 
the main study database. 

 
During Exam 1, inventory records listing participant ID numbers for blood specimens were sent weekly from the EC 
to the CC. Data backup at the EC included electronic copies of the inventory records of specimens sent. The study 
elected not to draw extra blood specimens as backup in case of loss or damage during processing or shipping. The 
CC stored all data received from the CL/SR in the collaborative database and sent a floppy disk to the EC 
containing study results of its participants in order to update the local databases each week. 
 
Additional tests may be run on selected cases and controls. These results are transmitted from the laboratory's 
computer via FTP to the CC. 
 
For the first 12 months of Exam 2, no specimens were stored or shipped.  Finger stick samples were analyzed at 
the point of contact using the Cholestech  LDX system.  This system uses reflectance photometry (the amount of 
light reflected from a solid surface) to measure the amount of substances in the blood.  The analyzer measures 
color changes of the 4 reagent pads that is then converted to mg/dL or U/L and displayed on the Liquid Crystal 
Display (LCD) screen.  Data from the display screen was recorded directly into the data management system. 
 
Beginning in October 2006 (approximately), blood specimens will be collected via venipuncture.  All blood 
specimens will be processed, packaged and shipped to CL, in accordance with CL instructions. Sample collection, 
processing, storage and analysis are monitored using an internal and external quality control program through the 
analysis of blind duplicates.  An added check on drift or shifts in laboratory performance is provided by analysis of 
blood from monthly random sub-samples of the JHS cohort.  Laboratory technicians are trained in proper 
venipuncture and processing methods and are certified and periodically recertified by the chief technologist.   
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2.3.4   Collaborative Database 
 
The collaborative portion of the database management system is used to store, update, and access the data from 
the EC and the reading centers. Since each data item is edited, corrected, and verified at the data collection site, 
editing by the collaborative system largely consists of record level "data base closure" checks, such as ensuring the 
receipt of all expected records from each exam, contact, hospitalization, and death. The focus of the collaborative 
DMS is retrieval for analyses. The LDMS directly generates analysis files in SAS data set, BMD save file, and 
SPSS save file formats. It includes a relational query language, a programming language, and a full-screen forms-
oriented retrieval facility. It includes comprehensive security and confidentiality facilities including passwords, 
encryption, and audit trails. Given the size of the collaborative database, it is maintained on the University's 
mainframe computer. 
 
 
3.0  STUDY MANAGEMENT 
 
3.1    Introduction 
 
The JHS Study is funded by the National Heart, Lung, and Blood Institute and the National Center for Minority 
Health and Health Disparities of the National Institutes of Health, and directed by the Epidemiology and Biometry 
Program of the Division of Epidemiology and Clinical Applications. The Principal Investigator, Center Directors/Co-
Principal Investigators, and their affiliations are listed in Appendix 1. The operations of the study are directed by the 
JHS Study Steering Committee whose members are the Principal Investigator of the overall JHS, Director/Co-
Principal Investigators or two representatives of the EC, CC, UTC, and the NHLBI Project and Field Officers as 
shown in the organizational chart in Appendix 2. 
 
3.1 JHS Director 
 
The JHS Director actively participates in Monitoring Board, Steering Committee and appropriate subcommittee 
meetings to develop and implement a coordinated plan to achieve study objectives.  The JHS Director acts as chair 
of the JHS Steering Committee. The Steering Committee is comprised two representatives each from the CC, the 
EC, the UTC, and the NHLBI Project Officer, the NHLBI Field Site Medical Director and a community 
representative.  The JHS Director has the primary responsibility for planning and facilitating the conduct of the 
study, responding to issues raised by the Monitoring Board, e.g. protocol design, participant safety, and feasibility, 
and determining the content and implementation of the study.  The JHS Director enlists appropriate senior 
personnel, either as staff, consultants, or subcontractors, with expertise in cardiovascular epidemiology, behavioral 
medicine, medical sociology, cardiovascular and renal physiology, medical genetics, clinical cardiovascular 
disease, noninvasive imaging, laboratory measurements, statistics, and longitudinal studies management to 
develop the study.  The JHS Director fosters an atmosphere among the JHS investigators to work cooperatively 
with each other and the NHLBI Field Site and Project Office.  The JHS Director actively promotes the JHS to the 
scientific community and the general public.   
 
The Directors’ Council (DC) comprising the Center Directors, the NHLBI Field Office Director and the Sr. 
Operations Manager forms the equivalent of an Executive Committee which meets fortnightly or more frequently if 
deemed necessary by JHS Director to discuss issues relating to the overall operations and performance of the 
study.  
 
In view of the emphasis in Exams 2 and 3 on scientific productivity and cohort retention, a small administrative unit 
has been formed to provide administrative and scientific support to assist the Director in achieving the scientific and 
operational goals of the JHS through 2013. The JHS Director’s Office staff is directly accountable to the JHS 
Director and is to be specifically responsible for the scientific productivity of the JHS and the oversight of the 
administrative and fiscal operations of the three JHS Centers. The creation and funding of the Office as a distinct 
administrative entity within the EC provides the resources to assure scientific productivity through such activities as 
Invited Collaborators, conferences and convening of an Emerging Science Committee of external experts. Web-
based conferences, off-site regional locations and national scientific meeting linkage will be utilized as well as 
conferences held in Jackson.  In addition to accomplishing this plan for scientific productivity, the Office staff will 
provide the infrastructure and create opportunities to train minority investigators. Ancillary Study instigation and 
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monitoring will also be a major responsibility of the Office leadership, with these instigation efforts often made in 
conjunction with the aforementioned Invited Collaborators conferences. Finally, the Office staff will provide essential 
across center administrative, infrastructure and fiscal coordination. Included among the numerous such 
responsibilities will be the consistent deliverable content and schedule compliance for all centers.   
 
3.3   JHS Study Subcommittee and Charges 
 
Subcommittees responsible for the details of study design and implementation support the Steering Committee.  
These committees report and make recommendations to the Steering Committee. The subcommittees and their 
charges are listed in Append 3. The committees are:  the Scientific Directions; Ancillary Studies; Genetics; Clinic 
Operations and Results Reporting; Events Monitoring; Community Partnership; Retention; Statistics, and Sampling; 
Academic; Research Training Appointments; and IRB Adherence. 
 
3.4   Communications 
 
3.4.1  Periodic Reports 
 
The EC and reading centers prepare routine periodic reports to the JHS Study Project Office as contract 
deliverables which document the progress to date in each major activity, administrative matters, staffing changes, 
current or anticipated problems, and scientific productivity. The CC also provides reports on the data collection at 
the EC, quality control findings on examinations, re-abstracted records, re-certification, laboratory determinations, 
and protocol adherence. Status reports on annual follow up and data collection prepared for the Project Officer are 
also sent to the EC. Quality control reports are likewise sent to the reading centers. 
 
3.4.2   Newsletters 
 
The CC prepares and distributes a newsletter to facilitate communication among JHS participants. In general, each 
edition includes (1) reports from the Project Office, the EC, CC and UTC and the Steering Committee, (2) a 
description of the facilities and staff  (3) general information on data management and (4) a calendar of events. The 
newsletter also provides reports on issues such as participant follow-up rates and preliminary study results and 
abstracts. 
 
3.4.3   Electronic Mail 
 
The EC, reading centers, the CC, some UTC staff, NHLBI Field and Project Office are linked by electronic mail 
using microcomputers at each center. The electronic mail network is used to facilitate rapid and efficient 
communication among centers for messages such as announcements, meeting agendas, abstracts for clearance 
and acknowledgements of receipt of data. 
 
3.4.4   Site Visits 
 
Project Office staff conduct periodic monitoring visits to the JHS Centers as needed to (1) maintain channels of 
communication with investigators and staff, (2) solve participant follow-up problems, (3) monitor adherence to the 
protocol and (4) provide technical support for activities such as data management and quality control. 
 
3.5   Publication and Presentation Policy   
 
3.5.1 Overview 
 
The Publications and Presentations Subcommittee (PPS) is responsible for overseeing all aspects of study 
publications and presentations, from the formation of writing groups and approval of manuscript proposals through 
the final approval of JHS manuscripts prior to journal submission.   An overview of the process is shown in Figure 1. 
 
The goal of the PPS is to encourage the preparation of manuscripts and abstracts while providing oversight for their 
scientific quality and content.  The PPS will establish, disseminate and oversee policies for the use of JHS data in 
abstracts, presentations and publications, and help maintain the publications database at the Coordinating Center.   
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The PPS is composed of members from the three Jackson institutions, the National Heart, Lung, and Blood 
Institute (NHLBI) field site, the JHS Director’s office, community representatives, and recognized outside scientists.  
Meetings occur on a regular basis as necessary (e.g. monthly).  Abstract approval between meetings takes place 
by e-mail or fax as necessary to facilitate scientific productivity. 
 
3.5.2   Publications Data Base 
 
A series of tracking tables and data bases maintained by the CC for the PPS are used to monitor the approval and 
status of new proposals, presentations, abstracts and manuscript publications.  A separate listing of all JHS 
manuscript proposals, abstracts and presentations, and JHS publications (including those in press) is updated 
quarterly and maintained on the JHS web site (http://ccaix.jsums.edu/~jhs/) with subject and author-based search 
capability. This is true for Ancillary Studies and Genetics Studies as well. 
 
3.5.3   Preparation and Approval Process for Manuscripts, Abstracts and Presentations 
 
3.5.3.1a.  Manuscript proposals.  Manuscript proposals most commonly arise from JHS investigators.  A JHS 
investigator includes Principal Investigators, Co-Principal Investigators and academic staff from the three partner 
institutions, the JHS Director’s office, participating NHLBI staff (field site and project office) and JHS subcontractors.  
The PPS and the JHS Steering Committee may also designate a topic, select a writing group, and identify its 
chairperson (lead author).  The proposal must include a clear statement of the nature of the publication, its 
rationale, the hypotheses to be addressed, the analytic approach to be used (types of statistical computations or 
summarization of data likely to be required) and pertinent references (see Appendix for manuscript proposal form).  
The lead author initiates the manuscript proposal draft, prepares a list of co-authors, and obtains any suggestions 
for the proposal.  For locally generated proposals, the lead author would in principle strive to include investigators 
from all local institutions involved in the JHS based on their potential interest and areas of expertise.  The writing 
group should be composed of both interested collaborators and experienced investigators.  Interested JHS 
investigators should have an opportunity to participate.  For proposals developed by non-JHS investigators, at least 
one JHS investigator must be included. 
 
3.5.3.1b.   Format and submission.   The JHS has a standardized form (attached and available electronically on 
the JHS web site) that is used for proposal submission.  Proposals are submitted electronically to the PPS chair 
and Administrative Coordinator (see contact information at end) who will arrange distribution to the members and 
maintain appropriate databases. 

 
 
3.5.3.1c.  PPS Proposal Approval.  The manuscript proposal, including the list of proposed authors, is submitted 
to the PPS for approval.  Review will include assessment of scientific content, potential overlap with previously 
approved manuscript proposals, priority, and recommendations for members of the writing group. 
 
3.5.3.1d.  Distribution of manuscript proposals to Steering Committee.   After approval by the PPS, manuscript 
proposals are sent to the JHS Steering Committee for ratification and any additional recommendations that they 
may wish to make.  The Steering Committee meets monthly. 
 
3.5.4    Data analysis.  The writing group prepares and communicates a detailed plan for data analysis containing 
computational specifications to the CC, or it prepares statistical computations using the data set distributed by the 
CC when local analytic assistance is available.  In some cases analyses may be done outside the CC (e.g. 
biostatistical consultants).  The CC has representation on the writing group in most cases and this person serves as 
the liaison to the writing group, both for communications about computing issues and for providing or obtaining 
appropriate statistical input.  The CC performs the specified statistical computations according to priorities set by 
the PPS.  
 
3.5.3    Authorship.  The initiator of a manuscript proposal generally assumes first authorship.  The PPS will assist 
in resolving any conflicts or confusion that occurs with respect to appropriate recognition of authorship.  The lead 
author should elicit involvement in the manuscript from the co-authors, circulate drafts for co-author input and 
coordinate revisions.  S/he should determine the order of authorship.  Selection of the journal for initial submission 
is delegated to the writing group with input from the PPS and JHS Steering Committee. 

http://ccaix.jsums.edu/%7Ejhs/


 18 

 
3.5.4    Abstract approval.  Abstracts should be submitted electronically to the PPS chair and Administrative 
Coordinator for approval at least 2 weeks prior to the submission deadline.  Abstracts will be circulated to PPS 
members for review and recommendations.  After approval by the PPS and incorporation of any revisions, the 
abstract will be sent by the Administrative Coordinator to NHLBI (ebpdocs@nhlbi.nih.gov) for rapid review and 
response (usually takes approximately one-two weeks).  In cases where ARIC approval is required, simultaneous 
submission is made to the ARIC Publications Committee (see section 3.4.7, Coordination with ARIC).  Following 
communication of these approvals (sent by the Administrative Coordinator) the writing group chair may submit the 
abstract.  A copy of the final abstract, notification of acceptance and, if published, its citation, should be sent to the 
PPS Administrative Coordinator. 
 
3.5.5.    PPS review of completed manuscripts.  The writing group prepares reviews internally, and submits the 
completed manuscript to the PPS for review and approval.  Two JHS reviewers are assigned by the PPS chair to 
review the manuscript.  Ad hoc reviewers with special expertise may be assigned by the chair.  Under exceptional 
circumstances this review may be waived by the PPS with a majority vote.  A detailed critique is expected from the 
reviewers within two weeks.  Upon receiving the critiques, two courses of action are possible:  (1) if the PPS deems 
the reviewer suggestions to be mainly editorial in nature, it may approve the manuscript and request that the 
authors incorporate suggested changes to the final version, or submit in writing reasons for not doing so.  No 
further action is needed from the PPS; or (2) if, in the PPS’s judgment, the critiques entail substantive changes, a 
revised manuscript must be further reviewed by the primary reviewers, before PPS approval is granted.  The PPS 
may recommend data verification by the CC based on reviewer comments and prior experience with JHS data 
analysis, although this will not be required in all instances.  Members of the JHS Steering Committee receive copies 
of approved manuscripts. Manuscripts should include the phrase:  “the Jackson Heart Study” in the title whenever 
possible and acknowledgement of funding sources for the JHS contract.  In the case of genetic or family studies no 
pedigrees will be published. 
 
3.5.6 NHLBI review.  NHLBI review of completed manuscripts occurs following PPS approval.  The  
PPS Administrative Coordinator will send the manuscript to NHLBI (see contact information) once the lead author 
has incorporated any recommended revisions based on the PPS review.  Manuscript review may take 2-4 weeks.  
In cases where ARIC approval is required, simultaneous submission is made to the ARIC Publications Committee 
(see section 3.4.7, Coordination with ARIC). 

 
3.5.7    Coordination with ARIC.   Manuscript proposals that involve data from any or all of the four ARIC centers, 
including Jackson alone, will follow existing ARIC publication policies (http://www.bios.unc.edu/cscc/ARIC/).  If 
other standard criteria are met, approval by ARIC will generally be granted unless a substantially similar manuscript 
proposal was already approved by ARIC, in which case modification or withdrawal of the new proposal would be 
necessary.  Approval, along with other comments from the ARIC Publications Committee, will be conveyed to the 
JHS investigators. In the particular case where proposals include both ARIC and JHS data (e.g. longitudinal 
designs that include the first JHS exam), formal ARIC consideration will not be required; instead only JHS PPS 
approval will be necessary.  Thus, an exemption from the ARIC review process would be in effect when the 
manuscript proposal requires JHS data for analysis.  The ARIC Steering Committee will send copies of approved 
proposals and manuscripts to the JHS PPS to facilitate awareness and minimize potential overlap for new 
proposals.  The JHS PPS Administrative Coordinator will submit requests for approval of proposals; abstracts and 
completed manuscripts involving ARIC data to the designated person at the ARIC Coordinating Center (see contact 
information).  
 
3.5.8    Journal submission of manuscript.  After approval and incorporation of recommended revisions, the 
manuscript is formally submitted to a journal for consideration. The lead author must notify the PPS when the 
manuscript is submitted, which journal was selected and whether the manuscript was approved or rejected by the 
journal (e.g. a copy of paper and cover letter will suffice).  Once published, a reprint or copy of the manuscript 
should be sent to the PPS Administrative Coordinator. 
 
3.5.9     Presentations.   A formal slide or poster presentation at a national or regional scientific meeting can be 
reviewed by the PPS if desired by the lead author.  However, notification of a JHS presentation must be sent to the 
PPS Administrative Coordinator for tracking purposes and should include the title, authors, name of the meeting, 

mailto:ebpdocs@nhlbi.nih.gov
http://www.bios.unc.edu/cscc/ARIC/
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date and location.  In the case of lectures and other informal presentations no formal approval is required assuming 
initial release of JHS results is not involved. 
 
3.5.10    Interviews and press releases.  Discussions with the media and press releases should not be used as a 
forum to release new information, but may be used to clarify scientific findings for the lay public.  In general, 
scientific findings from the JHS made available to the media will involve those findings presented at scientific 
meetings and published in the literature.  Investigators are requested to keep the NHLBI Project Office informed of 
contacts with representatives of the major national media and of major national media coverage of information that 
they have supplied.  Release of general descriptive information about the JHS for local use (such as a local 
newspaper, university newsletter or state medical society journal) does not require prior approval.  Use of centrally 
prepared materials for such purposes is encouraged and can be obtained from JHS investigators associated with 
the partnering institutions, published journal articles, previous abstracts or presentations, and other JHS published 
materials.  A copy of the resultant article should be sent to the Project Office. 
 
3.5.11   Contact Information 
 
PPS Administrative Coordinator:  Brenda Campbell Jenkins, brenda.w.campbell@jsums.edu 

Jackson Heart Study Coordinating Center 
Jackson Medical Mall, Suite 701 
350 W. Woodrow Wilson Dr. 
Jackson, MS  39213 
(601) 368-4631 Fax:  (601) 982-5421 

 
PPS Chair:    Herman A. Taylor, MD, MPH, htaylor@medicine.umsmed.edu 
     Jackson Heart Study 
     Jackson Medical Mall, Suite 701 
     350 Woodrow Wilson Drive 
     Jackson, MS 39213 
     (601) 368-4644   Fax: (601) 982-5421 
 
 
NHLBI:     Shirley Arnold, arnolds@nhlbi.nih.gov  

Epidemiology & Biometry Program 
NIH / NHLBI / DECA 
II Rockledge Centre, Room 8170A 
6701 Rockledge Dr., MSC 7934 
Bethesda, MD  20892 
(301) 435-0445    Fax:  (301) 480-1455 

 
ARIC Coordinating Center: Debbie Rubin Willaims, uccdrw@mail.cscc.unc.edu 

University of North Carolina, Biostatistics Department 
Collaborative Studies Coordinating Center 
Bank of America Center, CB#8030 
137 E. Franklin Street, Suite 203 
Chapel Hill, NC  27514  
(919) 962-3246    Fax:  (919) 966-3804 

 
 
 
 
 
 
 
 
 
 

mailto:brenda.w.campbell@jsums.edu
mailto:arnolds@nhlbi.nih.gov
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Figure 1.  Jackson Heart Study Proposals and Manuscripts 
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4.0   ANCILLARY STUDIES  
 
4.1   Objectives 
 
An ancillary study is an investigation, which is not part of the Jackson Heart Study (JHS) protocol but uses all or a 
subgroup of the JHS cohort, samples, or data collected by JHS.  In most cases, an ancillary study will involve 
acquisition of additional data, which are not compiled as part of the standard JHS data set. 
 
The JHS Steering Committee encourages investigators to propose and conduct ancillary studies. Such studies 
enhance the value of JHS and ensure the continued interest of the diverse group of investigators who are critical to 
the successes of the study as a whole. They provide an exceptional opportunity for investigators, either within or 
outside of JHS, to conduct additional projects within an already existing participant cohort.  In general, ancillary 
studies will require outside (non-JHS) funding. 
 
The objectives of the JHS Ancillary Studies Sub-Committee (ASSC) is to assure the protection of human research 
subjects as it relates to the JHS, and to assure the integrity of the main goals of the JHS.  The aim of the Ancillary 
Studies Guidelines is to stimulate scientific productivity of the JHS and to stimulate interest in the JHS by a diverse 
group of investigators. 
 
The guidelines describe the procedures for application, submission, review, approval or rejection of ancillary 
studies, as well as guidelines for publications and presentations resulting from ancillary studies. 
 
4.2   Review Process 
 
In order to protect the integrity of JHS, all ancillary studies must be reviewed and approved before access to JHS 
data or participants is permitted. The review process is as follows: 
 
A. Application 
 

New ancillary study proposals should be sent to the Ancillary Studies Sub-Committee (ASSC) in care of the 
JHS Coordinating Center. The ASSC will review the proposal to ascertain that it is completed satisfactorily. 
If the proposal is incomplete, the Principal Investigator (PI) of the ancillary proposal will be notified within 
five (5) working days after receipt by the JHS Coordinating Center.  The ancillary study proposal form and 
guidelines are available on the Jackson Heart Study Web site (http://www.jsums.edu/~jhs) or can be 
obtained by contacting the JHS Coordinating Center (Phone: (601) 982-1133; Fax: (601) 982-0006. 

 
B. Submission 
 

Electronic inquiries and submission of applications are encouraged.  The ancillary study application should 
be submitted to Ms. Brenda Campbell, Research Associate at brenda.w.campbell@jsums.edu and inquiries 
about ancillary studies may be directed to the -chair of the ASSC: Dr. James Perkins at 
James.Perkins@jsums.edu 

 
C. ASSC Review 
 

The ASSC will review the ancillary study proposals to determine if items 1, 2, or 3 below apply.  If not, the 
recommendation of the ASSC will be sent directly to the JHS Director for Steering Committee review.  

 
 

 1. Proposals with New Participant Burden 
 

If the ancillary study proposal indicates participant burden, the proposal will be sent to the Clinic 
Operations Committee (COC) for review. The COC will review he proposal within 10 working days 
and return it to the ASSC Chair with their comments and recommendations.  

 
 2. Proposals Requiring Specimen Collection 
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If the ancillary study proposal indicates blood use of any kind, the proposal will be sent to the COC 
for review. The COC will review the proposal within 10 working days and return it to the ASSC 
Chair with their comments and recommendations. 

 
 3. Proposals Involving the JHS Family or Genetics Studies 
 

If the ancillary study proposal indicates the use of family relationship information or the use of 
genetic material (DNA), the proposal will be sent to the Genetics Subcommittee for review.  The 
Genetics Subcommittee will review the proposal within 10 working days and return it to the ASSC 
with their comments and recommendations. 

 
D. Steering Committee Review  
 

The Steering Committee will review whether the proposed study duplicates existing JHS research, whether 
it is feasible, and whether the impact of the proposed study on JHS operations and resources is justified by 
its scientific merit (see below for further discussion of review guidelines).  ASSC and COC review 
comments will be attached to the ancillary study proposal before the proposal is submitted to the Steering 
Committee.  Approval/disapproval will be made by the Steering Committee.  

 
E. National Heart, Lung, and Blood Institute Project Office Review 
 

The approved ancillary study proposal will be sent to the National Heart, Lung, and Blood Institute Project 
Office for review by the JHS Monitoring Board.  In the situation where anticipated direct costs exceed 
$500,000 in a given year, additional instructions as specified on the National Heart, Lung, and Blood 
Institute web site  www.nhlbi.nih.gov/funding/policies/500web.htm) should be followed with submission 
directed to Paul Solis, Acting Director, Division of Epidemiology and Clinical Applications. 

 
4.3   Procedures 
 
A. Informed Consent and Institutional Review Board Approval  
 

If separate informed consent is necessary, this must be obtained from all participants of the ancillary study. 
This should clearly identify the ancillary study as one being performed in addition to the main study and 
inform subjects that their participation in the ancillary study is not necessary for them to continue in the 
JHS.  Institutional Review Board (IRB) approval for the ancillary study is the responsibility of the principal 
investigator of the ancillary study and must be obtained prior to initiation of the study. 

 
B. Inclusion of JHS Investigators in Ancillary Studies 
 

A JHS investigator must be included as a co-investigator in every ancillary study proposal.  If the CC or EC 
resources are to be used, arrangements must be made with the Center  
 
Directors/Co-Principal Investigators. Separate funding will usually be required for ancillary study related 
expenses, such as space rent and support staff.  In order to avoid misunderstandings, all communication 
regarding resources with the JHS Coordinating Center and Examination Center must take place between 
the senior JHS investigator involved in the ancillary study and the Center liaisons.  

 
C. Proposal, Data Request, and Funding Source Changes 

Following approval of an ancillary study by the Steering Committee, there can be no substantial changes in 
the proposal or type or amount of data requested from the Coordinating Center.  If major changes are 
made, the ancillary study must be reconsidered as a revised proposal.  Also, if a previously approved 
ancillary study is to be submitted to a different organization for funding, a revised proposal must be 
submitted for approval. 
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D. Time Requirement for Review of Ancillary Studies 
 

Ancillary study proposals should be submitted for review at least 60 days prior to the deadline for the 
funding application. This will provide time for circulation to appropriate committees, JHS Steering 
Committee recommendation and NHLBI approval prior to submission to a funding agency.  Additional time 
is required if direct costs exceed $500,000 in a given year.  
 

E. Ancillary Study Proposal Form 
 

The proposal form must be fully completed by the PI of the proposed ancillary study.  The body of the 
ancillary study proposal must include the following information: 1) investigator information; 2) project 
sponsoring information; 3) design and methods; 4) assurances that data used by ancillary study PI will be 
given back to JHS to incorporate into larger JHS data set; 5) data management of the ancillary study 
project; 6) genetic/family studies information (if applicable); and 7) “other information” regarding the 
ancillary study.  Each section is elaborated in detail on the proposal form which is found on the JHS web 
site (http://www.jsums.edu/~jhs).  The completed proposal should not exceed five (5) pages (excluding 
literature citations and appended questionnaires and forms). 
 

F. Criteria Used to Assess Priority of Ancillary Studies 
 

The JHS Steering Committee will use the ancillary study application to assign priority of the proposed study 
in relation to the JHS objectives and, most importantly, determine its potential impact on the JHS facilities 
and operations.   

 
 Highest priority will be given to studies which: 
 

• do not interfere with or duplicate the JHS research objectives; 
• have the highest scientific merit; 
• produce the least burden on JHS participants and the least demand on JHS 
      resources such as blood samples; 
• have objectives closest to those of JHS; and 
• require the unique characteristics of the JHS cohort. 

 
The Steering Committee will review the proposal primarily to determine that it will not compromise, 
complicate, or jeopardize the conduct of the JHS.  Review of proposed ancillary studies for scientific merit 
is not the primary responsibility of this review process, but is a necessary consideration for allocating 
access to  scarce JHS resources. All ancillary study  
 
proposals approved by the Steering Committee will also be sent to the NHLBI Project Office and the JHS 
Observational Studies Monitoring Board for review, comment and approval. 

 
The ASSC will record the progress of approved ancillary studies since the composite impact of the total 
number of active studies will be difficult to assess without central monitoring.  Investigators with approved 
ancillary studies will report to the Chairperson(s) of the ASSC every six months regarding the status of 
study funding, initiation and termination dates, success of data collection, and any presentations and 
publications derived from the ancillary study. A written progress report on ancillary studies will be made 
twice a year at the request of the ASSC.  This written report will be submitted to the Steering Committee. 

 
G. Guidelines for Publications and Presentations from Ancillary Studies 
 

Potential manuscripts from ancillary studies will follow the same procedures as JHS publications and 
presentations and must adhere to the following guidelines: 
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1. The ancillary study investigator will submit a formal manuscript proposal to the JHS Publications and 
Presentations Sub-Committee (PPS), which consists of a title, proposed writing group, introduction and 
rationale, analysis plan, conclusion, and references. 
 

2. The PPS will submit the proposal to the Steering Committee requesting nominations for the writing group 
from the JHS investigators who have special expertise in the subject of the manuscript. 
 

3. When the writing group has been finalized, and a memo from the PSS has confirmed the final writing 
group, the manuscript can be started. 
 

4. The PPS requests that the writing process involves the whole writing group, i.e.; drafts should be circulated 
regularly to the writing group. 
 

5. The PPS should review the last draft of the manuscript arising from an ancillary study. 
 

6. When approved by the PPS , this draft will be submitted to the JHS Steering Committee and NHLBI for final 
review. 
 

7. If the data analysis for the ancillary study was not conducted at the JHS CC the analysis may be verified by 
the CC before submission to a journal. 
 

8. The Chair of the writing group for the paper will be responsible for reporting to the PPS on the paper's 
progress. 
 

9. A reprint of the final published article must be sent to the JHS CC. 
 

10. Abstracts generated from ancillary studies must follow the same guidelines for all JHS abstracts. The 
proposed abstract must be sent to the Chair of the PPS: 

 
(a) two weeks prior to the deadline for the abstract's submission if data from a JHS paper in progress 

is used (e.g. abstract is based on paper already reviewed and approved by the PPS); and 
 
(b) four weeks in advance if the project has not already been reviewed by the Publications Committee. 

The proposal should be approved by all co-authors before it is sent to the PPS Chair. 
 

A-1 
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Appendix 1 JHS Principal Investigators and Directors 
 
Herman A. Taylor Jr., M.D., M.P.H.  JHS Director and Principal Investigator     
  Jackson Heart Study 

University of Mississippi Medical Center 
Department of Medicine/Cardiology 
350 W. Woodrow Wilson Drive 
Suite 701 
Jackson, MS 39213 
(601) 982-1133 
htaylor@medicine.umsmed.edu 

 
Frances Henderson, BSN., PhD              Co-Director Jackson Heart Study Exam Center 

University of Mississippi Medical Center 
Department of Medicine 
350 W. Woodrow Wilson Drive 
Suite 701 
Jackson, MS 39213 

  henfra@att.net 
 
 
Ervin Fox, MD., MPH  Co-Director  
  Jackson Heart Study Exam Center 

University of Mississippi Medical Center 
Department of Medicine/Cardiology 
350 W. Woodrow Wilson Drive 
Suite 701 
Jackson, MS 39213 
erfox100@yahoo.com 
 

 
Daniel Sarpong, Ph.D.  Director and Co-Principal Investigator 
  Jackson Heart Study Coordinating Center 

Jackson State University 
350 W. Woodrow Wilson Drive 
Suite 701 
Jackson, MS 39213 
(601) 982-1133 
dsarpong@jsums.edu 

 
 
Asoka Srinivasan, Ph.D.   Director and Co-Principal Investigator 
  Jackson Heart Study Undergraduate Training Center 

Tougaloo College 
Professor of Biology 
500 West County Line Road 
Tougaloo, MS 39174 
(601) 977-7781 
asok@juno.com 

 
 
 
 
 
 

mailto:erfox100@yahoo.com
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Michael Steffes, M.D., Ph.D  Principal Investigator 
     Jackson Heart Study Central Laboratory Reading Center  
     and Specimen Repository Reading Center 
                 University of Minnesota Medical School 
     Department of Laboratory Medicine & Pathology 
     420 Delaware Street, SE 
     Minneapolis, MN 55455-0391 
     (612) 624-8164 
     Michael.w.Steffes-1@tc.umn.edu 
   
 
Evelyn Walker, M.D.   Director, NHLBI JHS Field Site  
     Jackson Heart Study 

Jackson State University 
350 W. Woodrow Wilson Drive 

    ewalker@ccaix.jsums.edu 
 
 

Cheryl R. Nelson, M.S.P.H.  NHLBI JHS Project Officer 
NHLBI 
6701 Rockledge Drive 
Bethesda, MD 20892-7934, 

     nelsonc@nhlbi.nih.gov 
 
 
Paul Solis, PhD         Director, Epidemiology and Biometrics Program,  

DECA 
6701 Rockledge Drive 
Bethesda, MD 20892-7934, 

    manoliot@nhlbi.nih.gov 
 
Jennifer Jennings   NHLBI JHS Contracting Officer 

NHLBI 
6701 Rockledge Drive 
Bethesda, MD 20892-7934  

      [Jenningsj@nhlbi.nih.gov] 
 
 
Austin Sachs    NHLBI JHS Contracting Specialist 

NHLBI 
6701 Rockledge Drive 
Bethesda, MD 20892-7934  
Sachs, Austin (NIH/NHLBI) [E] [sachsa@nhlbi.nih.gov] 

 
 
 
 
 
 
 
 
 
 

mailto:ewalker@ccaix.jsums.edu
mailto:nelsonc@nhlbi.nih.gov
mailto:Manoliot@nih.gov
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Appendix 3  JHS COMMITTEES AND SUBCOMMITTEES 
        

COMMITTEES/SUBCOMMITTEES CHARGE CHAIRS & MEMBERS 
1.1  
1.2 STEERING COMMITTEE 
 
 
 
 
 
 
 
 
 

 
 
 

EXECUTIVE COMMITTEE  
DIRECTOR’S COUNCIL  

 
Overall planning and conduct of JHS. 
 
Development (through subcommittee 
mechanism)  
and approval of all aspects of study protocol. 
 
Respond to issues raised by the Monitoring 
Board.  
 
Review reports of all major Committees. 
 
Review recommendations for Ancillary Studies 
from Scientific Output and Directions. 

1.3  
1.4 Herman Taylor, Chair   (JHS Director) 
Frances Henderson – EC 
Michael Winniford -- EC  
Emmanuel Keku -- CC 
Daniel Sarpong  -- CC 
Asoka Srinivasan -- UTC 
Wendy White -- UTC 
 
Community Representative: 
Jermal Clark 
 
NHLBI Representatives: 
Cheryl Nelson  (Project Officer) 
Evelyn Walker  (Field Site Director) 
 
Herman Taylor, Chair (JHS Director) 
Ervin Fox, EC 
Frances Henderson, EC 
Daniel Sarpong, CC Director 
Asoka Srinavasan, UTC Director 
Justin Vincent, Sr. Operations Manager 
Evelyn Walker, Field Site Director 
 
 

 
JHS SUBCOMMITTEES 

 
IRB Adherence Subcommittee  

 
 
 
 
 
 
 
 
 
 
 
 
 

Publications and Presentations Subcommittee 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Set, disseminate and enforce policies for use of 

1.17  
 
 
IRB Adherence Subcommittee  
Justin Vincent, Chair 
Mary Crump 
Brenda-Campbell Jenkins 
Melinda Leflore 
Daniel Sarpong 
Asoka Srinivasan or Designee 
 
 
 
 
 
 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Scientific Directions Subcommittee 
And Emerging Science 

 
 
 
 
 
 

Scientific Directions Subcommittee 
And Emerging Science (Continued) 

JHS data in abstracts, presentations, and 
publications. 
 
Maintain updated file of all JHS manuscript 
proposals, publications, abstracts, 
presentations and ancillary or sub studies. 
 
Review all manuscript proposals and determine 
suitability  and protect against overlap with 
other proposed projects and recommend priority 
for data analysis. 
 
Review abstracts and manuscripts prior to 
submission. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Continuous review of scientific directions for the 
JHS to insure innovative scientific hypotheses 
are addressed and  to insure that the most 
productive approaches are used to test these 
hypotheses. 
 
 

 
Publications and Presentations 
Subcommittee 
Nimr Fahmy, Chair 
Patricia Dubbert  
Joseph Maher 
Frances Henderson 
Gailan Marshall 
Neil Powe 
Daniel Sarpong  
Michael Steffes 
 
Ad Hoc: 
Clifton Addison 
Myra Carpenter 
Richard deShazo 
Ervin Fox 
Robert Garrison 
Emmanuel Keku 
Kent Kirchner 
Charles Rotimi 
Tandaw Samdarshi 
Asoko Srinivasan 
James Wilson                       
 
Community Representative:                          
Richard  Sullivan 
 
NHLBI  Representatives: 
Cheryl Nelson  
Evelyn Walker 

 
NCMHD Representative: 
Jerome Wilson  
 
JHS Coordinators: 
Lynette Ekunwe 
Brenda Campbell-Jenkins  
 
 
Scientific Directions Subcommittee                   
,Chair 
Ermekgul Akylbekova 
Teresa Carithers 
Ervin Fox   
Celso Gomez-Sanchez  
Elise Gomez-Sanchez                                         



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ancillary Studies Subcommittee 
 
 
 
 
 
 
 
 
 

1.4.1.1.1  
1.4.1.1.2  
 
1.4.1.1.3  

 
 

Ancillary Studies Subcommittee 
1.4.1.1.4 (Continued) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Review ancillary studies for compatibility with 
JHS goals and make appropriate 
recommendations to JHS Steering Committee. 
 
 
 
 
 
 
 
 
 
 
 

 
Frances Henderson 
Robert Garrison  
Emmanuel Keku  
Abdul Mohamed          
Ana Diez-Roux 
Mario Sims 
David Williams 
James Wilson 
  
Ad Hoc: 
Michelle Albert 
Donna Arnett 
Gerado Heiss    
Rick Kittles                      
                
Community Representative: 
John Bower 
 
Emerging Science I 
Eric Boerwinkle 
David Herrington 
Rick Kittles 
Bruce Psaty 
Ellen Wijsman 
 
Ad Hoc: 
Robert Garrison  
Daniel Sarpong 
Michael Steffes 
James Wilson 
 
 
Ancillary Studies Subcommittee         
James Perkins, Chair 
Emekgul Akylbekova 
Ervin Fox 
William Johnson 
Anthony Mawson 
Mario Sims 
William Woolverton  
Jiankang Liu 
   
Ad Hoc: 
Asoka Srinivasan or Designee 
 
 
 



 

 

1.4.1.1.5  
 
1.4.1.1.6  
1.4.1.1.7  
 
 
 
1.4.1.1.8  
1.4.1.1.9 Statistics and Quality Assurance 

Subcommittee 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Genetics Subcommittee 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Genetics Subcommittee (Continued) 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
Establish standard methods for data collection; 
develop methods for technician monitoring; 
develop methods for  
data coding; establish quality  control 
procedures; processing of Coordinating Center 
statistical requests; oversee quality control and 
quality assurance, data management systems, 
and analysis. 
 
 
 

 
 
 
 

 
 
Monitor genetic data collection protocols.   
 
Assist in the development of genetics 
educational materials for the community. 
 
Assist in developing mechanisms for the 
community to become actively involved in 
genetics research and in decisions made 
regarding JHS genetics studies. 
 
Develop and monitor policies to ensure privacy 
and confidentiality of genetic information, 
including development of informed consent for 
genetics. 
 
Assist in the development of policies for sharing 
genetic information with participants and 
development of policies to assure access to 

 
Community Representative: 
Charles Spann 
 
NHLBI  Representative: 
Cheryl Nelson   
 
JHS Coordinator: 
Brenda Campbell-Jenkins 
 
 
Statistics and Quality Assurance Subcommittee 
William Johnson, Chair 
Clifton Addison  
Mary Crump 
Nimr Fahmy  
Daniel Sarpong 
Warren May 
Gregory Wilson       
 
Ad Hoc: 
 
NHLBI  Representative: 
Sean Coady                            
 

1.17.1.1.1.1.1  

1.17.1.1.1.1.2 Genetics Subcommittee 
Rick Kittles, Co-Chair 
James Wilson, Co-Chair 
Ermekgul Akylbekova 
Errol Crook   
Joseph Maher 
Charles Rotimi 
Charmaine Royal 
Barbara Wilson 
 
Ad Hoc: 
Donna Arnett 
Sarah Buxbaum 
Jean MacCluer 
Asoka Srinivasan  
 
Community Representative: 
Bruce Taylor 
Aneice McLemore 



 

 

1.4.1.1.10  
1.4.1.1.11  
1.4.1.1.12  
1.4.1.1.13  
 
1.4.1.1.14  
1.4.1.1.15  
1.4.1.1.16  
1.4.1.1.17  
1.4.1.1.18  
1.4.1.1.19 Clinic Operations and Participant 
1.4.1.1.20  Results Subcommittee 

 
 
 

1.5  
1.6  
1.7  
1.8  
1.9  
1.10  

 
 

1.11  
1.12  
1.13  
1.13.1.1.1  
1.13.1.1.2  
1.13.1.1.3  
1.13.1.1.4  
1.13.1.1.5  
 
 
1.13.1.1.6  
1.13.1.1.7  
1.13.1.1.8  
1.13.1.1.9 Events Monitoring Subcommittee 
1.14   
 
1.15  
1.16  
1.16.1.1.1  
 
 
 
 
 

genetic data by the scientific community while 
protecting participants’ privacy. 
 
Assist in the development of quality control of 
genetic data and samples. 
 
Assist in further refinement of JHS genetics 
hypotheses   and suggest directions for new 
genetics research.   
 
Participate in the review of proposals for new 
JHS genetics research.  
 
Assist with incorporating genetics into the 
educational aspects of the JHS, including 
genetic epidemiology into the summer 
Epidemiology Course and Scholars Program  
to ensure that scholars have the opportunity to 
apprentice in an area of genetics research. 
 
 
Monitor and manage operation of clinic and 
conduct of exams (tracking flow). 
 
Develop methods for data coding and 
transmission in concert with CC (Coordinating 
Center). 
 
Establish quality control procedures for clinic  
exam and its components in collaboration with 
Statistics and Quality Assurance Subcommittee. 
 
Establish and monitor examination "alert 
criteria". 
 
Develop methods for providing clinical 
information to participants and their health care 
providers. 
 
Interface with clinical subcontractors for CC. 
 
Develop scientific rationale and protocol for all  
Interviews, procedures and specimen collection  
in cooperation with PIs of the appropriate  
Reading Center, Repository or Laboratory.  
 
Ensure appropriate referral for participants 
requiring medical follow-up. 

 
 
NHLBI  Representative: 
Ebony Bookman                      
 
JHS Coordinator: 
Lynette Ekunwe 
 
 
 
 
 
 
 
 
Clinic Operations and Participant Results 
Subcommittee 
Daniel Sarpong, Chair 
Clifton Addison 
Michelene Brock 
Mary Crump 
Patricia Dubbert 
Debra Douglas 
Frances Henderson 
Wendy White 
 
Ad Hoc: 
PIs of Central Agencies 
Sonja Fuqua 
William Rock, Local Lab Reading Center 
Michael Steffes, Central/Repository Reading 
Center 
Minta Uzodinma 
Justin Vincent 
Evelyn Walker 
Gregory Wilson 
 
NHLBI  Representative: 
Cheryl Nelson  
 
 
 
Events Monitoring 
Alan Penman, Chair 
David Conwill 
Ervin Fox 
Sonja Fuqua 



 

 

 
 
 
 
 
 
 
 
 
 

Community Partnership Subcommittee 

Multiple working groups anticipated, focusing on 

 various aspects of charge: media and government  

relations,  student involvement, etc. 

 
 
 
 
1.16.1.1.2  
 
1.16.1.1.3  
1.16.1.1.4  
1.16.1.1.5  
1.16.1.1.6  
 
 
 
 
1.16.1.1.7  
 
1.16.1.1.8  
1.16.1.1.9  
1.16.1.1.10 Translating Research into Practice and 

Prevention (TRIPP) Subcommittee 
 
 
 
 

1.16.1.1.11  
 

1.16.1.1.12  
1.16.1.1.13  
1.16.1.1.14  
1.16.1.1.15  
1.16.1.1.16  
1.16.1.1.17  

 
 
Develop and monitor protocols for annual follow 
up, cohort morbidity and mortality assessment, 
and events ascertainment. 
 
Establish quality control procedures for events  
ascertainment in concert with Statistics and 
Quality  
Assurance Subcommittee. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Enhance awareness of study among community 
health care providers/general community. 
 
Develop, implement and evaluate plan for 
community partnership. 
 
Facilitate community awareness and feedback 
regarding JHS (including ethical and genetics 
research issues). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Translate research affiliated with JHS into 

Emmanuel Keku 
 
 
Michael McMullan 
Michelle Richard 
Wayne Rosamond 
Cynthia Dorsey-Smith 
 
Ad Hoc: 
Ermekgul Akylbekova 
Robert Garrison 
 
NHLBI  Representative: 
Evelyn Walker 
 
 
Community Partnership Subcommittee 
Evelyn Walker, Chair 
Clifton Addison 
Sonja Fuqua 
Donna Antoine-LaVigne 
Cynthia Dorsey-Smith 
Justin Vincent 
 
Ad Hoc: 
Mary Crump 
Wendy White 
 
Community Representative: 
Jermal Clark 
 
NHLBI  Representative: 
Cheryl Nelson  
 
NCMHD Representative: 
Francisco Sy 
 
 
Translating Research into Practice and Prevention 
Subcommittee                   
Frances  Henderson, Chair               
Diane Beebe 
Kenneth Ray Butler 
Mary Crump 
Sonja Fuqua 
Donna Antoine-LaVigne 
Rob Rockhold 
Marjayua Lartey-Rowser 



 

 

1.16.1.1.18  
 
 
 
 
 
 
1.16.1.1.19  
1.16.1.1.20 Academic Subcommittee 

 
 
 
 
 
 
 
 

1.16.1.1.21  
1.16.1.1.22  
1.16.1.1.23  
1.16.1.1.24  
1.16.1.1.25  
1.16.1.1.26  
1.16.1.1.27  
 
1.16.1.1.28  
 
 
 
 
 
1.16.1.1.29 Retention Subcommittee 
1.16.1.1.30  
1.16.1.1.31  
1.16.1.1.32  
1.16.1.1.33  
1.16.1.1.34  
1.16.1.1.35  
1.16.1.1.36  
1.16.1.1.37  
 
 
 
 
 
 
 

practice for health professionals and the lay 
public. 
 
Develop the raw materials for two major 
products:  a lay-oriented lecture series and 
articles for local print media. 
 
Identify external funding sources for committee 
activities. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Conduct major educational activities associated 
with the JHS. 
 
Establish cross-center collaboration for 
practicum development. 
 
Develop summer epidemiology course. 
 
Develop seminar series for local investigators in  
collaboration with the Emerging Science 
Groups.       
 
Develop, update and implement guidelines for 
individuals seeking JHS appointments that 
provide skilled-based research training 
opportunities. 
 
Facilitate awareness and development of skilled-
based placements within the JHS and among the 
larger community of educational institutions. 
 
 
 

Cythia Dorsey-Smith 
 
Debra Sutton  
Justin Vincent  
 
Community Representatives: 
Jermal Clark 
Margie Cunningham 
 
NHLBI  Representative: 
Evelyn Walker 
 
 
Academic Subcommittee 
1.18 Asoka Srinivasan, Chair 
Marilyn Houston-Coleman 
Mary Crump 
Barbara Dease 
Candace Jackson  
Emmanuel Keku 
Ernest Limbo 
Richard McGinnis 
Robin Rockhold 
 
Ad Hoc 
Nimr Fahmy 
Wendy White 
 
Community Representatives: 
Clyde Christopher 
Dorothy Williams  
 
NHLBI  Representative: 
Evelyn Walker  
 
 
Retention Subcommittee 
__________,Chair 
Clifton Addison 
Mary Crump 
Debra Douglas 
Sonja Fuqua 
Frances Henderson 
Donna Antoine-LaVigne 
Cynthia Dorsey-Smith 
Justin Vincent 
Wendy White 



 

 

 
 
 
 
1.16.1.1.38 Research Training (RT) Subcommittee 

 
 
 
 
 
 
 
 
 
 
 

 
 
Develop, implement, and evaluate JHS Retention 
Plan.   
 
Establish monitoring and quality control 
procedures concert with the Statistics and 
Quality Assurance Subcommittee. 
 
Monitor AFU productivity and completion rates. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Provide continuous review of appointment 
applications and matching applicants with 
placement. 
 
Serve as a resource for information on training 
funding opportunities and liaison with other 
training programs that serve the same mission. 
 
 
 
 
 
 
 
 

 
 
Community Representative: 
Margie Cunningham 
 
NHLBI Representative: 
Evelyn Walker 
 
 
Research Training Appointments 
Subcommittee 
Paul Tchounwou, Chair  
Clifton Addison 
Rosie Calvin 
Lynette Ekunwe 
Joey Granger 
Brenda Campbell-Jenkins  
Gloria Miller 
Linda Moore 
Wendy White 
 
Community Representative: 
 
NCMHD Representative: 
Derrick Tabor 
 
Ad Hoc 
Asoka Srinivasan 
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 FOREWORD 
 
 
Morbidity and Mortality Classification Manual, is one of a series of protocols and Manuals of 
Operation for the Jackson Heart Study (JHS). The complexity of the JHS requires that a sizeable 
number of procedures be described, thus this rather extensive list of materials has been organized 
into the set of manuals listed below.  Manual 1 provides the background, organization, and general 
objectives of the JHS Study.  Manual 2 describes all components and procedures carried out with the 
JHS cohort.  Manual 3 provides detailed information about sitting blood pressure measurement. 
Manual 4 describes cohort surveillance, events ascertainment, morbidity and mortality classification. 
Manuals 4 and 5 provide information on the quality control and Manual 6 provides information on the 
data management systems of JHS respectively.   
 
 JHS Protocols and Manuals of Operation 

 
 

MANUAL TITLE 

1 General Description and Study Management 

2 Cohort Component Procedures 

3 Blood Pressure 

4 Cohort Surveillance 

5 Quality Control  

6 Data Management System  
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Manual 4 Morbidity and Mortality Classification Manual  
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1.0 INTRODUCTION 
 
Jackson Heart Study (JHS) cohort morbidity and mortality includes monitoring and validating events 
among cohort participants.  In addition to hospitalized myocardial infarction (MI) and coronary heart 
disease (CHD) endpoints, clinically recognized strokes among cohort participants are also identified 
and validated through cohort morbidity and mortality procedures.  Hospitalized and outpatient events 
of congestive heart failure (CHF) among cohort participants are also identified. 
 
The aim of JHS cohort surveillance is to identify all cohort morbidity and mortality events including 
hospitalizations and out of hospital deaths for cohort participants and to validate the diagnoses of all 
cardiovascular disease (CVD) events including CHD, cerebrovascular accident (CVA) and CHF 
(Figures 1-1 and 1-2 detail the processes of surveillance). 
 
JHS will obtain information pertaining to CVD events from cohort annual follow-up interviews, hospital 
discharge indexes, and death certificates. Identification and abstraction of CVD event morbidity and 
mortality data will be carried out by the JHS-Examination Center (EC). The surveillance team at EC 
will enter event data using automated entry forms (via laptop computer) that are provided by the JHS-
Coordinating Center (CC). 
 
Surveillance activities for JHS consist of two essential components which work together to ultimately 
complete the process of events ascertainment: the annual follow-up (AFU) unit and the medical 
record abstraction (MRA) unit. The AFU is charged with calls to the cohort members yearly. The call 
is normally placed between 6 months before the anniversary of the cohort initial clinic examination 
and not more than 6 months past the anniversary date. JHS started recruitment and Exam 1 in 
September 2000, hence by the end of recruitment (February 29, 2004) and clinical exam (March 31, 
2004), the AFU should be in contact year (CY3) for those recruited into the cohort in September 
2000. The AFU utilizes several forms (First, Second and Third Year Questionnaire [AF1, 2, & 3] 
Annual Follow-Up Other Form, Annual Follow-up Questionnaire Form and Annual Follow-up 
Record of Calls) to obtain updated information on cohort health status and events. The 
information that is obtained by the AFU unit on cohort hospitalizations and deaths is transmitted to the 
MRA unit.  
 
The MRA unit has two sub-units that function together to obtain information regarding hospitalizations 
and in-hospital deaths (via medical record abstraction), and out of hospital deaths (via interview of 
close relatives, next of kin). A certified abstractor compares the AFU hospitalization reports with the 
yearly hospital discharge list obtained from area hospitals for quality control (QC) or data checks. The 
abstractor performs medical record with direct data entry into a laptop computer equipped with Fox-
pro® and all JHS abstraction forms. The abstracted information is transmitted to University of North 
Carolina Coordinating Center (UNCCC) every two weeks. Out of hospital deaths information, 
including interviews and death certificates, is also transmitted to UNCCC every two weeks. 
 
All event data that is entered into the CC surveillance database will be checked for eligibility based on 
cohort membership, event timing with respect to the baseline clinic exam and the presence of a valid 
CVD diagnosis (as defined in the JHS Protocol Manual 10, Section: Cohort Surveillance). All 
incomplete or ineligible forms will be referred to EC surveillance team for clarification and correction. 
Other data related to cohort events will include ECG data from hospitalizations, and CT or MRI data 
from CVA related events. ECG data will be coded and transmitted to the CC through the ECG coding 
center. Once these data are available then computer generated classification of diagnoses for cohort 
events will be created using the standard algorithms used in the Atherosclerosis Risk in Communities 
(ARIC) Study protocols (see ARIC Surveillance Manual of Operation). 
 
After all data quality checks for completeness and eligibility are resolved, the event data will be 
entered into the second phase of the surveillance data quality process. This second phase includes 
transmittal of event summary records to Morbidity and Mortality Classification Committee (MMCC) 
members for independent review of each JHS cohort event according to standard protocols as used 
in ARIC.  
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Event Determination 
 
The MMCC will make final assignment of all diagnostic categories for all cohort events after initial 
assignment by means of computer algorithm utilized by ARIC. The UNCCC will obtain from JHS-EC 
copies of hospital discharge summaries for JHS events that need a review. The event summary form 
(ESF), discharge summary and the management program (MGP)-generated ESF make-up the 
MMCC review package. The review package is sent to 1 or 2 reviewers based on the event type. 
Data will be checked for completeness and consistency upon completing the review forms by the 
MMCC. Incomplete or unresolved (e.g., “dirty”) data will be sent back to reviewers for resolution. Final 
(resolved) data will be entered into the data entry system at UNCCC for event classification. 
Reviewers’ diagnosis results are compared for those that need 2 reviewers. A review package is sent 
to an adjudicator when two original reviews disagree. Once this review process is complete, the data 
will be transferred to the closed files. 
  
Potential events will be identified via the hospital discharge lists, AFU procedures and death listing. 
 
Closure Activities 
 
Each year before closure, the collected hospitalization information at AFU will be compared to the 
cohort eligibility (CEL) form to identify missed hospitalizations for JHS. For participants that are lost to 
follow-up, a National Death Index (NDI) search will be activated. JHS will send such AFU data to the 
UNCCC. 
 
Data Closure and Data Distribution 
 
Raw data for CHD from the data collection forms (HRA, DTH, CEL, IFI, PHQ, COR, SXI, STR) will be 
closed in March annually. Raw data, several derived files for event classification results, and one 
incident CHD file for the complete JHS participants will be distributed in April annually. The first 
distribution of JHS data will occur ~ April, 2005. Raw data for stroke and CHF will be closed 
subsequently in April (pending) annually. The distribution of stroke and CHF data will include the raw 
stroke and CHF abstraction data; the derived stroke and CHF files and the incident stroke and CHF 
files in May (undetermined) annually. Data and the derived variable dictionary will be sent along with 
the data distribution. 
 
Quality Control (QC) Report 
 
Each year in May the UNCCC will generate a set of QC reports for the hospital record abstractions, 
completeness of event investigation for out-of-hospital deaths, and MMCC reviews for the JHS data. 
Similar reports for ARIC events would be available at the Jackson ARIC center, for comparison.  
 
Surveillance Data Management System 
 
The surveillance data management system will be carried out by the UNCCC. Details of this 
component are provided in the UNC Subcontract technical proposal. 
 
This manual details the procedures for identifying and validating selected events among the JHS 
cohort. The diagnostic criteria are described in Section 2 and review and classification procedures are 
described in Section 3. The procedures for obtaining certain indicators of medical care are described 
Section 4. The procedures for linkage of multiple events are described in Section 5. Sections 6, 7, 
and 8 describe the surveillance procedures for the identification of CHD, CVA and CHF events 
respectively. Section 9 describes how the MMCC functions and Section 10 outlines the QC measures 
used in JHS surveillance. 
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JHS morbidity and mortality methods evolved from those used for the ARIC Study. ARIC methods 
have been published (White et al., 1996). Additional information on trends in event rates using 
surveillance methods has been published (Rosamond et al., 1998). CHD events occurring among 
cohort participants are ascertained through cohort follow-up. Methods for stroke classification and 
event rates have also been published (Rosamond et al., 1999). 
 
The JHS cohort is a combined cohort of JHS only and JHS/ARIC joint participants. The JHS cohort 
also includes an embedded family study cohort. The ARIC cohort at Jackson, MS was available for 
recruitment into JHS. The recruited ARIC cohort is identified as the JHS/ARIC joint cohort and is a 
subgroup of JHS. All letters and paper work prepared on behalf of the JHS/ARIC joint cohort will be 
sent on joint logo (ARIC/JHS) stationary. Letters that require signatures will be jointly signed by both 
JHS and ARIC Principal Investigators. The data for the JHS/ARIC joint cohort will be collected and 
processed by ARIC (UNCCC) and released to JHS CC at specified dates. 
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Figure 1.1 
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Figure 1.2 
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2.0 DIAGNOSTIC CRITERIA 
 
2.1  Fatal Coronary Heart Disease (CHD) 
 
2.1.1    Definite Fatal Myocardial Infarction (MI) 
 
Must meet criteria 1 and 2 below: 
 
1. No known non-atherosclerotic or non-cardiac atherosclerotic process or event that was 

probably lethal. 
                            
2. Definite hospitalized MI within four weeks of death; use criteria in Section 2.2.2 for Definite 

Hospitalized MI. 
 
2.1.2   Definite Fatal CHD 
 
Must meet ALL of the following criteria: 
 
1. Lack of sufficient evidence to diagnose Definite Fatal MI according to the criteria given in 

Section 2.1.1. 
             
2. No known non-atherosclerotic or non-cardiac atherosclerotic process or event that was 

probably lethal. 
             
3. Presence of one or both of the following findings: 
 

a) A history of chest pain within 72 hours of death; 
 

b) A history of ever having had chronic ischemic heart disease such as coronary 
insufficiency or angina pectoris. 

 
2.1.3   Possible Fatal CHD 
 
Must meet ALL of the following criteria: 
 
1. Lack of sufficient evidence to diagnose Definite Fatal MI or Definite Fatal CHD according to 

the criteria in Sections 2.1.1 and 2.1.2. 
             
2. No known non-atherosclerotic or non-cardiac atherosclerotic process or event that was 

probably lethal. 
             
3. Death certificate with consistent underlying cause of death, i.e., ICD10 codes:  410-414, 

427.5, 429.2, and 799. 
 
2.1.4   Non-CHD Death 
 
All deaths that do not meet the above criteria for Definite Fatal MI,  Definite Fatal CHD, or Possible 
Fatal CHD. 
 
2.1.5   Chronology of Death 
 
The time interval from onset of acute symptoms to time of death is recorded, where possible, for all 
CHD deaths.  For out-of-hospital deaths, their time interval is ascertained by their MMCC reviewer 
and recorded on the final diagnosis form. 
 
2.1.6   Limitation of Activity 
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For out-of-hospital CHD deaths it is noted whether the decedent's activity was limited in the month 
before death because of sickness or illness. 
 
 
2.2 Hospitalized Myocardial Infarction (MI) 
 
2.2.1   Introduction 
 
JHS is to establish a well-standardized process for the identification of hospitalized coronary disease 
of an acute nature.  The criteria presented are based on two source documents: the findings of the 
Community Cardiovascular Cohort Surveillance Program (CCSP) Pilot Study and the results of the 
Minnesota Heart Survey1-3, as well as other surveillance studies.  The diagnostic criteria presented 
here approximate those contained in the above-mentioned documents.  The differences in diagnostic 
criteria are the lack of a duration requirement for cardiac pain, and the use of the more sensitive and 
specific CK-MB and LDH isoenzymes and inclusion of troponin proteins.  The description of 
diagnostic criteria to follow includes troponins in the category of “cardiac enzymes” even though they 
are technically structural proteins and not enzymes.  The combinations of pain, ECG and enzyme 
categories required for each diagnosis below are approximately the same as those contained in the 
above-mentioned documents. 
 
It is recognized that aggressive treatment of early signs and symptoms of acute coronary events, 
such as coronary artery bypass graft or thrombolytic therapy, may prevent the development of the full 
diagnostic syndrome.  In such cases, it may be difficult to diagnose the event accurately.  The use of 
such modalities is recorded and subject to data analysis, but not employed in the criteria for 
diagnosis. 
 
2.2.2   Definite Hospitalized MI 
 
Definite hospitalized MI must meet one or more of the following criteria: 
 
1. Evolving diagnostic ECG pattern (ED1 - ED7, section 2.2.6.2) 
 OR 
2. Diagnostic ECG pattern (D1 or D2, section 2.2.6.4) and abnormal enzymes (Table 2.1); 
 OR 
3. Cardiac pain and abnormal enzymes; (Table 2.1) 
 AND 

a) Evolving ST-T pattern (EV1 - EV8, section 2.2.6.3) 
 OR 

b) Equivocal ECG pattern (E1 - E4, section 2.2.6.5) 
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2.2.3   Probable Hospitalized MI 
 
Probable hospitalized MI must meet one or more of the following criteria in the absence of sufficient 
evidence for Definite Hospitalized MI: 
 
1. Cardiac pain and abnormal enzymes 
 OR 
2. Cardiac pain and equivocal enzymes and 
 

a) Evolving ST-T pattern 
 OR 

b) Diagnostic ECG pattern 
 OR 
3. Abnormal enzymes and evolving ST-T pattern 
 
2.2.4   Suspect Hospitalized MI 
 
Suspect hospitalized MI must meet one or more of the following criteria in the absence of sufficient 
evidence for Definite or Probable Hospitalized MI. 
 
1. Abnormal enzymes 
 OR 
2. Cardiac pain and incomplete enzymes and 
 

a) Diagnostic ECG pattern 
 OR 

b) Evolving ST-T pattern 
 OR 
3. Cardiac pain and equivocal enzymes   
 OR 
4. Equivocal enzymes and  
 

a) Diagnostic ECG pattern 
 OR 

b) Evolving ST-T pattern 
 OR 

c) Equivocal ECG pattern 
 
The criteria for Definite, Probable, Suspect, and No Hospitalized MI are summarized in Table 2.1. 
 
2.2.5   Definition of Cardiac Pain 
 
Pain having both the following characteristics: 
 
1. It occurs anywhere in the anterior chest, left arm or jaw 
 AND 
2. Absence of a definite non-cardiac cause of pain.  (If there is evidence of a non-cardiac cause, 

the pain diagnosis is downgraded by computer to "not present".) 
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Table 2.1.  Summary of JHS Diagnostic Criteria for Hospitalized MI 
──────────────────────────────────────────────────────────── 
Cardiac Pain  ECG Finding  Enzymes                        Diagnosis 
──────────────────────────────────────────────────────────── 
Present         Evolving Diagnostic         Abnormal                   Definite MI 

ECG Pattern                  Equivocal       Definite MI 
                                           Incomplete      Definite MI 
                                            Normal         Definite MI 
 

Diagnostic ECG Pattern   Abnormal        Definite MI 
                                            Equivocal       Probable MI 
                                            Incomplete     Suspect MI 
                                            Normal          No MI 
 

Evolving ST-T Pattern     Abnormal   Definite MI 
                                                        Equivocal       Probable MI 
                                            Incomplete      Suspect MI 
                                            Normal          No MI  
 

Equivocal                  Abnormal        Definite MI 
    Equivocal       Suspect MI 

                                            Incomplete      No MI 
                                            Normal          No MI 
 
                 Absent, Uncodable,         Abnormal        Probable MI 
                 or Other                   Equivocal       Suspect MI 
                                          Incomplete      No MI 
                                            Normal         No MI 
 
Not Present,     Evolving Diagnostic        Abnormal        Definite MI 
Unknown or       ECG Pattern                Equivocal       Definite MI 
Missing                                     Incomplete      Definite MI 
                                            Normal          Definite MI 
 
                 Diagnostic ECG Pattern    Abnormal        Definite MI 
                                            Equivocal       Suspect MI 
                                            Incomplete      No MI 
                                            Normal          No MI 
 
                 Evolving ST-T Pattern     Abnormal        Probable MI 
                                            Equivocal       Suspect MI 
                                            Incomplete      No MI 
                                            Normal          No MI 
 
                 Equivocal ECG Pattern     Abnormal        Suspect MI 
                                            Equivocal       Suspect MI 
                                            Incomplete      No MI 
                                            Normal         No MI 
 
                 Absent, Uncodable,         Abnormal        Suspect MI 
                 or other                  Equivocal       No MI 
                                            Incomplete      No MI 
                                         Normal          No MI 
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2.2.6   Definitions of Electrocardiographic Criteria 
 
The ECG series is assigned the highest category for which all criteria are met, i.e., evolving 
diagnostic is greater than diagnostic is greater than evolving ST-T patterns is greater than equivocal 
is greater than other.  The ECGs are coded using Minnesota Code. 
 
2.2.6.1   Evolving Diagnostic Q Waves 
 
An evolving Diagnostic Q Wave pattern is defined as an evolving pattern on serial ECGs of ECG 
changes within lead groups, i.e, anterior (V1 - V5); lateral (I, aVL, V6) or inferior (II, III, aVF).  Two or 
more ECG recordings during the hospitalization are needed for this classification. 
 
2.2.6.2   Evolving Diagnostic ECG (Judged within lead group) 
 
ED1 through ED7 cannot be assigned if a 7-1-1 code is present.  ED2 through ED7 cannot be 
assigned if a 7-2-1 or 7-4 code is present. 
 
ED1. If the following condition is met for any lead group, then ED1 is positive.  Either no Q-code or 

a 1-2-6 code in reference ECG followed by a record with a Diagnostic Q-code in the same 
lead group OR any code 1-3-x or 1-2-8 in reference ECG followed by a record with any code 
1-1-x in the same lead group and there is no 7-1-1 code in either ECG, then ED1 is positive. 

 
ED2. If an Equivocal Q-code in some lead group of reference ECG is followed by a record with a 

Diagnostic Q-code in the same lead group, AND if there is also a lead group not necessarily 
the same as for the Q-code change, in which there is no Major ST-segment Depression in 
reference ECG but followed by a record with a Major ST-segment Depression in that same 
lead group and there are no 7-1-1, 7-2-1, or 7-4 codes in either ECG, then ED2 is positive. 

 
ED3. If an Equivocal Q-code in some lead group of reference ECG is followed by a record with a 

Diagnostic Q-code in the same lead group, AND if there is also a lead group not necessarily 
the same as for the Q-code change, in which there is no Major T-wave Inversion in reference 
ECG but followed by a record with a Major T-wave Inversion in the same lead group and 
there are no 7-1-1, 7-2-1, or 7-4 codes in either ECG, then ED3 is positive. 

 
ED4. If an Equivocal Q-code in some lead group of reference ECG is followed by a record with a 

Diagnostic Q-code in the same lead group, AND if there is also a lead group not necessarily 
the same as for the Q-code change, in which there is no ST-segment Elevation in reference 
ECG but followed by a record with the ST-segment Elevation in that same lead group and 
there are not 7-1-1, 7-2-1 or 7-4 codes in either ECG, the ED4 is positive. 

 
ED5. If there is no Q-code or a 1-2-6 code in some lead group of reference ECG is followed by a 

record with an Equivocal Q-code in the same lead group, AND if there is also a lead group 
not necessarily the same as for the Q-code change, in which there is no Major ST-segment 
Depression in reference ECG but followed by a record with a Major ST-segment Depression 
in that same lead group and there are not 7-1-1, 7-2-1, or 7-4 codes in either ECG, then ED5 
is positive. 
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ED6. If there is no Q-code or a 1-2-6 code in some lead group of reference ECG is followed by a 
record with an Equivocal Q-code in the same lead group, AND if there is also a lead group 
not necessarily the same as for the Q-code change, in which there is no Major T-wave 
Inversion in reference ECG but followed by a record with a Major T-wave Inversion in that 
same lead group and there are no 7-1-1, 7-2-1, or 7-4 codes in either ECG, then ED6 is 
positive. 

 
ED7. If there is no Q-code or a 1-2-6 code in some lead group of reference ECG is followed by a 

record with an Equivocal Q-code in the same lead group, AND if there is also a lead group 
not necessarily the same as for the Q-code change, in which there is no ST-segment 
Elevation in reference ECG but followed by a record with an ST-segment Elevation in that 
same lead group and there are no 7-1-1, 7-2-1, or 7-4 codes in either ECG, then ED7 is 
positive. 

 
2.2.6.3   Evolving ST-T Pattern (Judged within lead group) 
 
This diagnosis cannot be assigned if a 7-1-1 or 7-2-1 or 7-4 code is present. 
 
EV1 Either 4-0 (no 4-code), 4-4 or 4-3 in reference ECG followed by a record with 4-2 or 4-1-2 or 

4-1-1; OR 4-2 in reference ECG followed by a record with 4-1-2; OR 4-2, 4-1-2 or 4-1-1 in 
reference ECG followed by a record with 4-0, 4-4 or 4-3; OR 4-1-2 in reference ECG followed 
by a record with 4-2,     

 PLUS 
no Q-code in both the reference ECG and the follow-up ECG.   

 
EV2 Either 4-2 or 4-1-2 in reference ECG followed by a record with 4-1-1 OR 4-1-1 in reference 

ECG followed by a record with 4-2 or 4-1-2 , 
 PLUS 

no Q-code in both the reference ECG and the follow-up ECG.  
 
EV3 Either 5-0, 5-4 or 5-3 in reference ECG followed by a record with 5-2 or 5-1 OR 5-2 or 5-1 in 

reference ECG followed by a record with 5-0, 5-4 or 5-3, 
 PLUS 

no Q-code in both the reference ECG and the follow-up ECG. 
 
EV4 Code 5-2 in reference ECG followed by a record with 5-1 OR 5-1 in reference ECG followed 

by a record with 5-2,  
 PLUS 

no Q-code in both the reference ECG and the follow-up ECG.  
 
EV5 Code 9-0 in reference ECG followed by a record with 9-2 OR 9-2 in reference ECG followed 

by a record with 9-0,  
 PLUS 

no Q-code in both the reference ECG and the follow-up ECG.  
 
EV6 Code 4-1-1 in reference ECG followed by a record with 4-1-1 OR  4-1-1 in reference ECG 

followed by a record with 4-1-1,    
 PLUS 

no Q-code in both the reference ECG and the follow-up ECG. 
   
EV7 Code 5-1 in reference ECG followed by a record with 5-1 OR 5-1 in reference ECG followed 

by a record with 5-1, 
 PLUS 

no Q-code in both the reference ECG and the follow-up ECG.  
 

EV8 Code 5-2 in reference ECG followed by a record with 5-2 OR 5-2 in 
       reference ECG followed by a record with 5-2, 
 PLUS 
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no Q-code in both the reference ECG and the follow-up ECG. 
  
2.2.6.4   Diagnostic ECG 
 
D1 (Diagnostic Q wave) 

An ECG record with any Diagnostic Q-code (Minnesota code 1-1-1 through 1-2-5 plus 1-2-7). 
 
D2 An ECG record with ST-segment elevation code 9-2 PLUS (T-wave inversion code 5-1 or 5-2 

in the absence of 7-2-1 or 7-4). 
 
2.2.6.5   Equivocal ECG 
 
E1 (Equivocal Q wave) 

An ECG record with an Equivocal Q-code [(Minnesota code 1-2-8 in the absence of 7-2-1 or 
7-3) or (any 1-3 code)]. 

 
E2 An ECG record with ST-segment depression (code 4-1-X or 4-2 or 4-3 in the absence of 

7-2-1 or 7-4). 
 
E3 An ECG record with T-wave inversion (code 5-1 or 5-2 or 5-3 in the absence of 7-2-1 or 7-4). 
 
E4 An ECG record with ST-segment elevation code 9-2 (in the absence of 7-2-1 or 7-4). 
 
2.2.6.6   Other ECG 
 
01 Reference ECG coded 7-1-1. 
02 Any ECG coded 7-1-1. 
03 OTHERWISE Normal ECG(s), defined as 1.0 in "clear" field of all ECGs. 
04.    Other findings including 1-2-6. 
 
2.2.6.7   Uncodable ECG 
 
U1 Technical errors coded 9-8-1 by Minnesota Code. 
 
2.2.6.8   Absent ECG 
 
A1 No ECG available for coding. 
 
2.2.6.9   Minnesota Coding Procedures 
 
The following ECG tracings are identified: 
 
1. The first codable ECG after admission; 
2. The last codable ECG recorded before discharge; and  
3. The last codable ECG recorded on day 3 (or the first ECG thereafter) following admission or 

an in-hospital event. Photocopies of the hospital ECGs are sent to the Minnesota Coding 
Center in Minneapolis for Minnesota Coding, using the Minnesota Coding for hospitalized 
ECGs.  Each ECG is read one time blinded. For cohort, serial change rules are not applied. 

 
2.2.7   Definitions of Cardiac Enzyme Criteria 
 
All pertinent enzyme results (as defined below) recorded on days 1 through 4 after hospital admission 
of an in-hospital CHD event are abstracted.  Information on non-ischemic cause for elevated 
enzymes is abstracted exclusively from the discharge summary on the medical chart.  For the 
purposes of this manual, the category of cardiac enzymes includes cardiac troponins, even though 
troponin is a structural protein of cardiac muscle and not an enzyme. 
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2.2.7.1   Abnormal Cardiac Enzymes 
 
Enzymes are classed as "abnormal" if any enzyme values recorded meet any of the following criteria: 
 
1.  a) CK-MB is "present" (if laboratory uses the criterion of "present" or "absent" without reporting a 

more specific value) or CK-MB is at least twice the upper limits of normal (if the 
laboratory gives a normal range) or, if no normal range is given, the CK-MB (heart 
fraction) is greater than or equal to 10% of the total CK value or, if the upper limits of 
normal is zero and the CK-MB is positive, 

 AND 
    b) There is no known non-ischemic cause (cardiac surgery, severe muscle trauma, 

rhabdomyolysis) for the elevated enzyme value. 
 OR 
2.  a) The ratio LDH1 : LDH2 > 1, or if LDH2 is missing and LDH1 is at least twice the upper limit of 

normal, 
 AND 
     b) There is no evidence of hemolytic disease. 
 OR 
3.  a) Total CK and total LDH are both at least twice the upper limit of normal.  (These increases do 

not have to occur on the same day.) 
 AND 

b) There is no known non-ischemic cause (surgery, severe muscle trauma, 
rhabdomyolysis) for the elevated enzyme value and no evidence of hemolytic 
disease. 

      OR 
4.  a) Troponin is "present" (if laboratory uses the criterion of "present" or "absent" without reporting 

a more specific value) or is at least twice the upper limits of normal, 
      AND 

b) There is no known non-ischemic cause (surgery, severe muscle  
trauma, rhabdomyolysis) for the elevated enzyme value and no evidence of hemolytic 
disease. 

 
2.2.7.2   Equivocal Cardiac Enzymes 
 
Enzymes are classed as "equivocal" if the criteria for abnormal enzymes are not met and if: 
 
1. Either total CK or total LDH are at least twice the upper limits of normal. 
  

OR 
2. Both total CK and total LDH are between the upper limits of normal and twice the upper limits 

of normal.  (These increases do not have to occur on the same day.) 
 OR 
3. CK-MB is "weakly present" or between the upper limits of normal and twice the upper limits of 

normal or 5% ≤ CK-MB < 10%. 
 OR 
4. If LDH1 is present and LDH2 is missing, and LDH1 is between the upper limits of normal and 

twice the upper limits of normal. 
      OR 
5. Troponin is "weakly present", or troponin levels are between the upper limits of normal and 

twice the upper limits of normal. 
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2.2.7.3   Spurious Enzymes 
 
If enzymes met one of the following criteria, the "abnormal" enzymes were considered spurious, and 
were downgraded to "equivocal". 
 
1. If the first abnormal CK-MB is at or after the date of trauma, cardiac procedure or 

rhabdomyolysis. 
 
2. If LDH1/LDH2 is abnormal and there is evidence of hemolytic disease. 
 
3. If both total CK and total LDH are abnormal, and there is evidence of hemolytic disease, or 

the first abnormal total CK/total LDH is at or after the date of trauma, cardiac procedure or 
rhabdomyolysis. 

 
4. If the first abnormal troponin is at or after the date of trauma, cardiac procedure or 

rhabdomyolysis. 
 
3.0 EVENT CLASSIFICATION-DETERMINING WHICH EVENTS GET MMCC REVIEW 
 
3.1 Hospitalized Events 
 
Hospitalized events are classified using a computer algorithm based on criteria given in Section 2.2.  
Most non-linked hospital events and some linked events have an automatic computer classification 
for MI.  Linked and non-linked hospitalized events that require MMCC review before final hospitalized 
MI diagnosis (Section 3.1.1) include the following: 
 
3.1.1 Hospitalized events (linked to at least one other eligible hospitalization within 28 days or non-

linked) if: 
a) the final computer diagnosis is "Definite MI" but discharge codes from 

hospitalizations for the event do not include 410 or 411.  (Note: Computer "Definite 
MI" + 410-411 discharge codes lead to automatic classification of Definite MI.) 

 
b) the computer diagnosis is "No MI" and hospital discharge ICD9-CM codes from at 

least one of the hospitalizations for the event include 410.  (Note: Computer "No MI" 
+ No 410 discharge code from any hospitalization in the event lead to automatic 
classification of "No MI.") 

 
This review of linked and non-linked hospitalizations is done, when needed, by one MMCC 
member for hospitalized MI diagnosis. 

 
3.1.2 Special Automatically Classified Cases (No MMCC Review required): 

 
a) If no chart can be located for all hospitalizations for the event, an automatic 

classification of "Unclassifiable" is given. 
 

b) No discharge codes for any hospitalizations for the event contains 410-411 codes, 
there is no mention of acute MI in discharge summary, there is no more than one 
ECG, and there is no Cardiac Enzyme above the normal limits, an automatic 
classification of "No MI" is given.  (Note: These are the cases that skip out of the 
HRA form at question 20.) 

 
 
3.2 In-hospital Deaths (MI and Death Classification) 
 
Non-linked in-hospital deaths are reviewed for death diagnosis by two MMCC reviewers (after final MI 
classification by computer algorithm) and adjudicated by a third reviewer if needed.  Linked in-hospital 
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deaths (including >28 day linked deaths) are reviewed for death and MI if needed by one MMCC 
reviewer.  The following cases, however, need no MMCC review: 
 
3.2.1 Those with ICD-10 codes for underlying cause of death and a final computer diagnosis of 

"Definite MI," and the date of death and date of MI are within 28 days.  The corresponding 
ICD-10 underlying cause of death codes are (I20-25, I46-49, I51.6, R99, J96). (Note: These 
cases are classified directly as "Definite Fatal MI") 

3.2.2 Those with ICD-10 codes for underlying cause of death for which the final computer 
diagnosis of "Definite MI" could not be made according to JHS criteria but who had pain of 
cardiac origin or a history of MI, angina pectoris, or coronary insufficiency.  (Note: These 
cases are classified directly as "Definite Fatal CHD") 

 
3.2.3 Those with ICD-10 codes for underlying cause of death not including for which the diagnosis 

of a Definite MI could not be made according to JHS Criteria and  
1.  No pain of cardiac origin, and  
 
2.  No history of previous MI, angina pectoris or 
    coronary insufficiency. 
 

(Note:  These cases are classified directly as "Non-CHD death") 
 

3.3 Out-of-Hospital Deaths 
 
3.3.1 All out-of-hospital deaths are reviewed by two members of the MMCC for death diagnosis 

except those with death certificate ICD-10 codes for underlying cause of death (I20-25, I46-
49, I51.6, R99, J96) and a catchment’s area hospital admission within28 days with a final 
diagnosis of "Definite MI". (Note: Cases are classified as "Definite Fatal MI.") 

 
This review for death diagnosis is done after final MI classification, in case there is an eligible 
linked hospital admission within 28 days of death, and is done by two MMCC reviewers, then 
adjudicated by a third reviewer if there is no agreement between the two reviewers. 

 
3.3.2 "Definite" and "Possible" CHD deaths are classified as to time from first symptoms to death. 
 
3.4 Case Law Used by MMCC 
 
An important function of the MMCC is to maintain complete records of any clarifications of JHS 
diagnostic criteria required to reach diagnostic decisions.  Such "case law" is systematized for 
convenient reference purposes and, when appropriate, incorporated into the JHS diagnostic protocol. 
 New case law is developed as a result of discussions with the MMCC and is approved by the Chair 
of the MMCC before adoption.   
 
The following are general cohort morbidity and mortality rules established as case law. 
 
Final Classification Rules 
 

1. When the death certificate is the only available document, and the ICD code is 
compatible with CHD (ICD-10:I20-25, I46, I51.6, R99, J96) then final JHS classification of 
cause of death is usually “Possible CHD,” unless there is (I) a demonstrable coding error, 
or (II) an explicit non-CHD probable cause of death (such as malignant hypertension with 
renal failure). Analogously, for other ICD codes the classification of cause of death is 
usually “Non-CHD”. 

 
2. The classification “Diagnosis Unclassifiable” will be reserved for cases not meeting JHS 

criteria for CHD diagnosis, but in whom a specific non-atherosclerotic or non-cardiac 
atherosclerotic process cannot be identified. 
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3. In the case of conflicting information, the more inclusive cause of death (e.g., Definite 
CHD rather that Definite MI) is preferred. 

 
4. Stroke qualifies as a “yes” answer to “a non-atherosclerotic or non-cardiac atherosclerotic 

process,” if judged to be the probable cause of death. 
 

5. If the decedent was debilitated from a potentially lethal non-atherosclerotic or non-cardiac 
process and had a related downhill course, with no symptomatic evidence of a recent 
coronary event, the death is classified a non-CHD. 

 
6. In cases of “Definite” or “Probable MI,” treated or aborted with TPA or similar clot-

dissolving therapy, in which the patient dies of a direct complication or adverse effect of 
this therapy (i.e., hemorrhage), a final death classification of “Definite fatal CHD” should 
usually be assigned. 

 
7. If a patient having an elective coronary artery by-pass graft (CABG) dies as a 

complication of surgery, a final death classification of “Definite fatal CHD” should usually 
be assigned. 

 
8. Generally, “hypertensive heart disease” will not be considered a “non-atherosclerotic cause of 

death”. 
 
Chronology 
 

9. Death is assumed to have occurred at the time the patient stops breathing on his/her own 
and does not recover. 

 
10. Symptoms are assumed to begin when the patient changes his/her activity. If symptoms 

come and go, the onset of symptoms is the time when they crescendo, leading to death. 
 

11. In cases where timing of symptoms or death is unknown, the best estimate of the chronology 
is to be made. 

 
12. Symptoms of CHD leading to a hospital admission for CHD are usually considered to be 

related to a subsequent death from CHD, which occurs either before discharge or within 
28 days of admission, which ever occurs first. Deaths of doubtful chronology admitted for 
the investigation or treatment of CHD are classified as deaths occurring in > 24 hours if 
admitted for at least 24 hours. 

 
13. Unknown chronology of death of an institutionalized patient is usually considered to be 24  

 hours. 
 
Evidence 
 

14. The relative credibility of conflicting witnesses is established from all the available evidence,  
 i.e., there is no fixed hierarchy of credibility (such as physician overriding a lay informant).  
 However, as a general rule: 

 
(i) A knowledgeable physician takes priority for medical history. 
 
(ii) A witness takes priority for events around death and timing of death. 
 

15. A clinical history of atherosclerotic heart disease (ASHD) or CHD counts as evidence of  
 previous manifestations of CHD. If the event under consideration is the first manifestation of  
 CHD, it does not qualify as a “history” of CHD. 
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16. A history of coronary artery bypass grafting (CABG) or coronary angioplasty at any time prior 
to death is equivalent to a positive history of CHD. 

 
17. Mention in the chart or documented previous angiographic evidence of CAD is regarded as 
  equivalent to recorded history of CHD when evaluating whether there was a past history of  
 ischemic heart disease.  However, evidence of CAD on catheterization at the time of the  
 event under consideration is not a “history of CHD”. 

 
 
The following are case laws developed and approved by the MMCC specifically for use with 
COHORT  
Reviews 
 
 

1. For cohort morbidity and mortality events, autopsy or unequivocal angiographic evidence 
of old MI or other chronic CHD counts as evidence of a history of CHD. 

 
2.  For cohort morbidity and mortality events, autopsy reports may be used to judge cause of 
death and in most cases take precedence. Autopsy evidence of an acute MI or MI within 4 
weeks may be used to answer “Yes” to “Was there a definite MI within 4 weeks of death” 
Such evidence includes acute coronary arterial thrombosis deemed sufficient to produce 
acute MI, even in the absence of evidence for acute myocardial tissue necrosis. 

 
3.   The diagnosis of “Definite MI” based upon “Evolving Diagnostic” ECG may be downgraded to 
the algorithm diagnosis which would be obtained if the ECG were “Diagnostic,” and the diagnosis 
of “Probably MI,” based upon “Evolving ST-T” ECG may be downgraded to the algorithm 
diagnosis which would be obtained if the ECG were “Equivocal,” but only if: 

  
  a. the clinical history is compatible with the downgraded diagnosis, and 
 

b. “Evolving Diagnostic” or “Evolving ST-T” ECG is suspicious because (1) a  
non-MI cause of the ECG abnormality is identified, or (2) a hospital ECG 
interpretation contradicts it. 

 
4. Changes in hospital pain or enzyme classification are permitted only in restricted 
circumstances based on strong clinical judgment. When a reviewer makes a change in 
classification, the change should be reflected in the reviewer’s answer to Item 7b (physician 
“preferred diagnosis”), not in the answers to Items 3, 5 or 6. 

 
 a.  The JHS protocol, not individual hospital physician’s judgment, determines 

what exact enzyme level qualified as “elevated.” 
 

b.  Reviewers may downgrade enzyme classification on the basis of an 
identified non-cardiac or non-ischemic cause, but only if enzymes review has 
not already occurred. 

 
  c.  Reviewers may downgrade the pain classification on the basis of an 

identified non-cardiac or non-ischemic cause, but only if pain review has not 
already occurred. 

 
d.  Changes in pain or enzyme classification are permitted when the narrative 

summary clearly contradicts the pain, enzyme, or ECG information 
abstracted and a JHS abstractor’s error appears probable.  

 
e.  If enzymes have been downgraded from “Abnormal” to “Equivocal” driving 

the JHS algorithm diagnosis from “Definite MI” to “Suspect MI,” or “Probable 
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MI” to “Suspect MI,” a reviewer who disagrees with the prior downgrading of 
enzymes should request another review of the decision to downgrade before 
completing classification of the case. Cases in which there remains 
continued disagreement as to whether enzymes should be downgraded 
should be sent for adjudication. The adjudicator in such cases may assign a 
more likely diagnosis of “Probable MI,” but may not upgrade the diagnosis to 
“Definite MI.”  

 
f.    An angina equivalent (e.g. pulmonary edema, exhaustion, syncope) may be 

considered similar to chest pain in recording a “preferred diagnosis.” 
 

5.   Upgrading the MI diagnosis in hospital deaths, e.g., from “No MI” to “Suspect” or “Definite       
 MI,” is not permitted on the basis of the judgment that had the patient lived, the enzymes or 
ECG would have provided sufficient evidence for the upgraded diagnosis. 

 
6. Upgrading the MI diagnosis in cases of delayed hospitalization is not permitted on the basis of 
the judgment that had the patient been hospitalized earlier the enzymes or ECG would have 
provided sufficient evidence for the upgraded diagnosis.  When the discharge summary clearly 
indicates a perioperative MI and JHS chest pain are “absent,” a diagnosis of “Probable” (but not 
“Definite”) “MI,” may be assigned if the algorithm criteria for “probable” or “Definite MI” would have 
been met had chest pain been “present.” 

 
 

 
If a reviewer believes the ECG DX and the discharge summary were so discrepant as to suggest a 
missing ECG that might change the MI DX, the reviewer should not review the case and notify the CC 
of the problem. The UNCCC will check at the coding center as to whether the appropriate tracings 
were in the system. If this were done, and if the tracings were appropriately included and coded, then 
the procedures should mandate acceptance of the ECG criteria. On the other hand, if a request for a 
check should reveal missing ECG or a programming error, such could then be corrected as needed. 
 
3.5 MMCC Final Diagnosis Forms 
 
When a member of the MMCC reviews a case, s/he completes a MMCC Final Diagnosis Form CDX 
(See Appendix VI) and returns it to the Coordinating Center for processing.  The CDX form is used for 
evaluating events among cohort participants. 
 
 
4.0 MEDICAL CARE ASSESSMENT 
 
 
Medical care elements which are recorded in cohort members include the participant's access to and 
use of providers for routine and special care, use of all prescription and over-the-counter medications, 
records of all hospitalizations for all reasons, records of all cardiovascular procedures and all 
cardiovascular diagnoses received, and detailed information on hospitalizations for CHD and CVA. 
 
For out-of-hospital deaths, the Physician Questionnaire and Informant Interview Form allow collection 
of information about physician visits prior to the acute event, utilization of physician and emergency 
services during the acute event, history of hospital admission within one month prior to death, receipt 
of cardiopulmonary resuscitation, delay in receiving definitive care, use of nitrates and digitalis shortly 
before death, and history of CABG.  The potential for cardiopulmonary resuscitation is assessed by 
the information on whether death was witnessed and the location of death. 
 
For events that include abstraction of the full hospital record, additional data on medical care are 
obtained.  These data include information on transportation to the hospital, time of arrival, receipt of 
cardiopulmonary resuscitation, use of a number of procedures, and medications for treatment of the 
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cardiovascular event (such as angioplasty and beta blocking agents), and the use of diagnostic 
procedures (such as cardiac catheterization and echocardiography).   
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5.0 LINKAGE OF MULTIPLE EVENTS 
 
 
Since many deaths are listed on both the hospital discharge index and the state death index, survey 
personnel must compare these lists carefully to avoid duplicating the investigation of in-hospital 
deaths.  If an eligible in-hospital death is found first from the death certificate lists, the case is flagged 
and it is linked with the hospital chart when that record is found.  The linked forms are given the same 
event ID number.  An in-hospital chart is abstracted, and the death certificate obtained as soon as 
possible.  Again, only one event ID number is assigned to these forms. 
 
If an eligible hospital record indicates that a patient was transferred directly from another acute care 
hospital, or that the patient upon discharge is being transferred directly to another acute care hospital, 
the record for the other hospitalization is abstracted onto another Hospital Record Abstraction Form 
(HRA).  The two forms initially have different hospitalization ID numbers. 
 
On occasion, it is difficult to differentiate between two or more successive admissions for the same 
event and two or more different events in the same person.  As it is often difficult to make this 
distinction on the basis of ECG, enzyme or pain characteristics, a simple rule is followed:  a CHD 
death or a hospital admission for MI occurring within 28 days of a previous admission for MI is 
regarded as the same event, for purposes of calculating rates. 
 
Over the duration of the JHS cohort morbidity and mortality, increasing numbers of cohort members 
are hospitalized for cardiovascular conditions more than once.  Others are hospitalized and 
subsequently die of CHD.  These events can be linked for future use.  Sufficient information for 
correct identification of these patients is collected, where hospitals permit, and matching procedures 
based on these identification variables are conducted. Patient initials, last name, SSN, sex, race, and 
date of birth of all JHS cohort morbidity and mortality participants are compared.  If the similarity is 
beyond a threshold level, these cases are sent out to the EC in the form of a data check for 
investigation.  The EC then determines if these events belong to the same participant and records 
their findings on all Cohort morbidity and mortality Event Inventory/Linkage Summary (SXI) forms for 
this participant.  The Coordinating Center also produces a listing of possible linkages suggested from 
cohort morbidity and mortality forms.  Various forms (HRA, IFI, COR) contain questions as to whether 
the person had been hospitalized within 4 weeks prior to this event.  The EC uses this listing to find 
linked hospitalizations that have not yet been abstracted.  Any positive findings from this investigation 
are also recorded on the SXI form. 
 
 
6.0 COHORT MORBIDITY AND MORTALITY 
 
6.1 Introduction 
 
The aim of cohort morbidity and mortality is to identify all hospitalizations for each cohort participant 
and validate the diagnosis of all potential congestive heart failure (CHF), coronary or cerebral 
vascular disease events.  Ascertainment and validation of all out-of-hospital fatal events that are 
cardiac related are also completed. 
 
6.1.1 Identification of Events 
 
In addition to the procedures for identification of potentially eligible events used in ARIC Manual 3, 
Version 6, cohort morbidity and mortality also uses information obtained from the annual follow-up 
interviews.  When the annual follow-up interview indicates that the participant has either died or been 
admitted to a hospital (for any reason), the medical record or death certificate is obtained, and 
information abstracted into a computer data base system.  The JHS records the occurrence of all 
hospitalizations but only investigates selected kinds of medical events for cohort participants.  These 
include: 1) hospitalized MI and stroke, 2) death from CHD, stroke and all-causes, 3) congestive heart 
failure.  The identification and classification of clinical stroke and congestive heart failure events will 
be covered separately in Section 10 and 11 respectively. This section (section 6) describes the 
identification, investigation and diagnosis of cardiac related hospitalized and fatal events.  JHS also 
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records the occurrence of a number of non-hospitalized, non-fatal events, events identified through 
the routine operations of the JHS clinics and annual follow up interviews, such as angina pectoris and 
peripheral vascular disease, including intermittent claudication. These are generally defined using 
standard instruments, such as the Rose Questionnaire, and their identification and diagnosis are 
described elsewhere. 
 
6.1.1.1 Identification of Hospitalized CHD Events 
 
All hospitalized events occurring in cohort members are identified.  Cohort events are deemed eligible 
based on the following criteria: 1) a valid cohort ID; 2) occurrence must be after the participant's 
baseline (visit 1) examination; and 3) an eligible CHD discharge code and/or a CHD key word in the 
discharge summary.  Hospital admissions may be identified initially through review of hospital 
discharge indexes or information elicited during the annual follow-up interview.  Hospital chart 
abstraction is carried out whenever needed to identify MI.  All events discharged with specified 
diagnostic codes are abstracted onto the Hospital Record Abstraction Form (HRA).  In order to 
assure completeness of ascertainment, the discharge summary information is reviewed for events 
discharged with certain screening codes more remotely related to MI.  If an MI is suggested, the chart 
is abstracted.  In addition, all discharge diagnoses for all hospitalizations are recorded. 
 
6.1.1.2 Obtaining Access to Hospital Medical Records 
 
A critical feature of the process of hospitalized event identification among cohort members is 
obtaining information from medical records.  Hospital cooperation is sought for the cohort morbidity 
and mortality components of the JHS.  The protocol sent to hospital administrators emphasizes the 
fact that, for cohort members, JHS obtains signed hospital record release forms.  On occasion, there 
may be a need to carry out special negotiations with out-of-area hospitals where cohort member was 
hospitalized. 
 
A critical feature of cohort morbidity and mortality is obtaining information from medical records.  
Without complete cooperation of hospitals, the usefulness of event rates in any community is limited.  
Cooperation is sought through hospital administration, medical records directors, hospital ethics 
committees, and influential medical staff. 
  
It is sometimes necessary to compromise with the hospital review committees and house staff.  
Again, the major consideration is confidentiality.  Some hospitals will not permit the abstraction of a 
patient's name.  It is important to obtain the name because this is the surest method to reduce 
redundancy in the records and determine case fatality after discharge.  However, less optimal 
procedures are available.  The first is to seek permission to code the name and record addresses, 
social security numbers, and birth dates.  If these are available, the likelihood of redundancy can be 
reduced by sorting lists of individuals by birth dates or social security numbers.”
 
6.1.1.3 Hospital Discharge Index 
 
Eligible hospitalized events are identified from the discharge index of each hospital surveyed.  
Discharge indices are obtained directly from the hospital or from an indexing service. 
 
Using the discharge index for each hospital, all hospitalized events occurring in JHS cohort members 
are identified.  However, only special diagnoses require hospital chart abstraction.  Hospital chart 
abstraction onto the Hospital Record Abstraction Form is carried out for all of the hospitalizations with 
the following ICD9-CM primary or secondary discharge diagnosis codes: 
 
MI:  402, 410 – 414, 427, 428 and 518.4 
 
A list of diseases included in these ICD9-CM rubrics is presented in Appendix I. 
 
Hospital chart discharge summaries are reviewed for the following screening codes: 
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Diabetes:  250 
Diseases of the circulatory system… 390-459 
Other Dyspnea and respiratory abnormalities 786.02; 786.09 
 
Cardiovascular symptoms:  signs and ill-defined conditions: 
 
794.3 (Abnormal function study) 
798   (Sudden death, cause unknown)  
799   (other) 
35.0 35.39; 35.9 – 35.99     Operations on valves and septa of heart 
36 – 36.3                             Operations on vessels of heart 
37.21 – 37.23       Diagnostic procedures on heart and pericardium 
37.6 – 37.66       Implantation of heart assist system 
88.50 – 88.58       Angiocardiography using contrast materials 
88.72        Diagnostic ultrasound of heart 
92.05        Cardiovascular and hematopoietic scan and radioisotope  
        Function study 
  
 
Should any mention of MI on the present admission (or synonyms for these conditions) be uncovered 
by the review of discharge summaries for the above conditions, hospital chart abstraction onto the 
Hospital Record Abstraction Form is undertaken. 
 
A number of hospitalized events for cohort members are fatal.  Hospital abstracting for these events 
is the same as for non-fatal events, regardless of whether the ICD-10 code for cause of death from 
the death certificate satisfies the eligibility criteria for fatal events. 
 
6.1.1.4 Hospitalized Events Occurring Outside the Study Community 
 
Review of death certificates or annual follow-up interviews may reveal that the cohort member was 
hospitalized outside the study area.  Hospitalization may occur outside the study area for the 
following reasons: 
 
1. A major hospital catchments area for the region exists outside of the area (e.g., tertiary care 

hospital referral centers). 
 
2. Residents who work outside of the geographic area may be admitted to an out-of-area 

hospital if they have an event requiring admission on an emergency basis. 
 
3. A resident may have an event while in transit outside of the geographic area for recreation or 

social activities. 
 
4. A cohort member may have moved from the study community. 
 
Every effort is made to identify discharge diagnoses for such events and, if applicable, review the 
hospital chart.  In soliciting access to discharge indexes and, occasionally, medical charts, a letter 
briefly describing the JHS cohort study is sent to the hospital administrator as well as the director of 
medical records, along with a copy of the JHS hospital record release form, signed by the participant 
at the time of the first exam.  In some situations, it is also useful to send an abbreviated protocol.  
Additional contacts, including telephone conversations, with the hospital administrator or the head of 
the proper department (cardiology, neurology, etc.) may be necessary.  No major obstacles are 
expected in obtaining access to medical charts, in view of the consent for such access provided by 
JHS cohort members.  Cohort participants who deny access to medical records are not investigated. 
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6.1.1.5 Range of Facilities Covered for Hospitalized Events 
 
Events occurring to cohort members in acute care hospitals are investigated, regardless of where the 
hospital is located.  Events in other institutions providing medical care (such as nursing homes, 
rehabilitation hospitals, long-term chronic disease hospitals and psychiatric hospitals) are not 
investigated.  Cohort events in hospitals in the study community are identified by review of the 
discharge indexes from these hospitals and by the annual follow-up interview.  The annual follow-up 
interview also allows identification of events occurring in or leading to admission to acute care 
hospitals out of the study community.  Events in out-of-area hospitals will generally have to be 
investigated by requesting a complete copy of the medical record to be mailed to the EC.   
 
6.1.2 Identification of Deaths 
 
6.1.2.1 Death Certificates 
 
JHS obtains a monthly printout from the state department of health of deaths in the community, from 
which cohort deaths are identified.  Deaths occurring in cohort members are also identified if the 
member has moved out of the study community.  Methods include systematic review of death 
certificates, annual follow-up interview, hospital chart review, use of obituary notices and other 
means.  The corresponding death certificate is located and abstracted onto the JHS Death Certificate 
Form (DTH).  ICD10 codes for both the underlying and contributory causes of death are recorded for 
all deaths. 
 
6.1.2.2 Deaths Occurring Outside the Study Area 
 
Deaths outside of the study area but within the state are included on State Health Department 
monthly printouts, but some delay between the death and death registration is expected.  The delay 
for out-of-state deaths is even greater, and they may appear only on final death files at the State 
Health Department.  If the death certificate file is reviewed for the JHS prior to receipt of the out-of-
area certificates, a subsequent review is undertaken to identify these deaths.  If the location of an out-
of-area death is learned through the annual interview with a participant's proxy, a copy of the death 
certificate can be obtained directly. 
 
Deaths occurring outside the study community are also identified through the National Death Index 
and, by monitoring of obituaries. 
 
 
 
6.1.2.3 Identification of Deaths Requiring Special Investigation 
 
Deaths in cohort members that occurs out-of-hospital (as defined in Section 6.2.1.2) require a special 
investigation to determine whether or not they died of CHD if their death certificates have any of the 
following ICD10 codes for the underlying cause: 
 
E10-E14, I10-I11, I20-I25, I46-I51, I70-I9(except I97.2), J81, J96, R96, R98 and R99. 
 
For a listing of disease categories see Appendix I.  
 
Deaths in hospitalized cohort members which occur before an ECG or a complete set of enzymes is 
obtained also require special investigation, if the death certificate has one of the death certificate 
codes as shown. 
 
The special investigation required for these deaths is described in Section 6.2.1.2. 
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6.2 Event Investigation 
 
For the hospitalized event of MI, investigation entails review of the hospital record.  Investigation of 
the fatal events occurring in cohort members includes review of the death certificate and hospital 
record where available (Section 6.1). 
   
6.2.1 Procedures for Fatal CHD 
 
The Death Certificate (DTH) Form is completed for all eligible fatal events.  A worksheet and the 
Surveillance Event Inventory/Linkage Summary (SXI) Form are used to monitor selection and 
completion of investigation forms.  One or more of the following data forms may be completed: 
Hospital Record Abstraction (HRA) Form, Stroke (STR) Form, Informant Interview (IFI) Form, 
Physician Questionnaire (PHQ), and the Coroner/Medical Examiner Report (COR)  
Form.  Autopsy reports for cohort members are copied. 
 
For out-of-hospital deaths and some inadequately diagnosed in-hospital events, investigations 
include physician questionnaires, interviews with next-of-kin and collection of other information (see 
below). 
 
6.2.2   Out-of-Hospital CHD Deaths 
 
CHD deaths occurring outside of regular acute care hospitals are categorized as "out-of-hospital CHD 
deaths".  This includes deaths in nursing homes and other chronic care facilities.  It also includes 
persons dead on arrival at acute care hospitals, dying in outpatient departments or emergency rooms, 
or admitted without vital signs.  For purposes of defining out-of-hospital death, "no vital signs" means 
no pulse rate or no systolic blood pressure.  A person admitted on a respirator who never had a pulse 
rate or a systolic blood pressure off the respirator is also considered an out-of-hospital death. 
 
For out-of-hospital deaths information is sought from the decedent's family and physician(s) within 6 
months after death.  The family member is contacted for an interview, and the physician is sent a 
questionnaire.  Whenever possible, the informant is the spouse or another family member of the 
decedent.  Also, the informant may be someone else who witnessed the death.  Some death 
certificates contain the names of the spouse and a witness. 
 
If neither an Informant Interview (IFI) nor a Physician Questionnaire (PHQ) form can be completed, 
then the Hospital Discharge Indices from eligible hospitals are checked for the period covering 28 
days before death.  If an ICD code eligible hospitalization is found, a HRA is abstracted, regardless of 
discharge day. 
 
6.2.3 Procedures for Fatal Events 
 
The Cohort Eligibility Form (CEL) and the DTH Form are completed for all fatal events occurring in 
cohort members.  One or more of the following forms may also have to be completed:  1) Hospital 
Record Abstraction Form (HRA), 2) Informant Interview Form (IFI), 3) Physician Questionnaire 
(PHQ), and 4) Coroner/Medical Examiner Report Form (COR) and their supplements. 
 
The DTH Form is completed and submitted to the Coordinating Center prior to or concurrent with 
submission of other forms.  Occasionally it is necessary to obtain certificates for deaths occurring out-
of-state to study area residents by writing to the state in which the death occurred. 
 
A proportion of fatal events (in-hospital or out-of-hospital) are coroner or medical examiner's cases.  
This means that the county coroner or state medical examiner has performed an investigation of the 
circumstances of death in order to ascertain whether the causes were natural.  In this case, the 
coroner/medical examiner signs the death certificate.  In general, the coroner/medical examiner takes 
cases of unexpected death where no physician was in attendance during the 24 hours prior to death. 
 During this investigation, the coroner/medical examiner may or may not order an autopsy.  Any death 
where a legal question is likely to arise (e.g., after surgery, during an automobile accident, etc.) will 
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probably be a coroner/medical examiner case.  If a death is certified by a coroner/medical examiner, 
the Coroner/Medical Examiner Form is completed and submitted to the Coordinating Center.  If an 
autopsy is performed, a copy of that report is sent to the Coordinating Center. 
 
Specific procedures for investigating in-hospital and out-of-hospital deaths and requirements for 
completion of the other forms listed above are given in the next two sections. 
 
6.2.1.1 In-Hospital Deaths 
 
In-hospital deaths may be identified initially from death certificates or hospital discharge indexes.  
Hospital records for these events are abstracted if eligible as hospitalized events according to the 
rules.  The Death Certificate Form is also completed and sent to the Coordinating Center for all 
deaths. 
 
If the in-hospital death is initially identified from the hospital discharge index, the death certificate 
printout must be crosschecked to avoid duplication.  If the in-hospital death is initially identified from 
the death index, the hospital discharge index must be crosschecked.  Occasionally the hospital lies 
outside the catchment’s area for the JHS community.  In this case, this fact is noted on the Death 
Certificate Form and an attempt is made to find and, if eligible, abstract the hospital record. 
 
Cohort members who die in the emergency room, are pronounced dead on arrival at the hospital, or 
are admitted without vital signs are reclassified as out-of-hospital deaths.  Only the administrative 
data of the Hospitalized Event Form are recorded for patients without vital signs.  If the death is first 
identified from the death index and if the death certificate indicates "dead on arrival," an attempt is 
made to find the hospital record in order to verify this information. 
 
If the hospital record indicates that the cohort member has been transferred directly from another 
acute care hospital or is transferring directly to another such hospital, the record for the other 
hospitalization is found and reviewed. 
 
6.2.1.2 Out-of-Hospital Deaths 
 
Out-of-hospital deaths with one of the eligibility codes given in Section 6.1.2.3 require a special 
investigation into the cause of death.  For this purpose out-of-hospital death is defined to include: 
 
 
1. Deaths occurring outside of regular acute care hospitals. 
2. Deaths occurring in hospital emergency rooms or outpatient departments. 
3. Persons who were either dead on arrival or were admitted without vital signs.  For purposes 

of defining out-of-hospital death "no vital signs" means no pulse rate and systolic blood 
pressure (or admitted on a respirator with no pulse rate or systolic blood pressure at any time 
off the respirator). 

 
When the special investigation for out-of-hospital deaths is required, the information from the 
decedent's family and physician must be obtained within 6 months after death if feasible.  The former 
is contacted for an interview, the latter by questionnaire.  Often the informant is the spouse or other 
family member of the decedent.  On other occasions the informant is someone else who witnessed 
the death or someone whose name is mentioned on the death certificate.   
 
First an attempt is made to contact and interview the spouse or a first-degree relative (i.e., son, 
daughter, or sibling) of the decedent, or someone else who lived with the decedent.  If another person 
witnessed the death, this person is interviewed as well.  Using the information provided by the 
participant at the time of the clinic interview, the informant's telephone number can be identified, and 
a "Format 1" letter sent (Appendix II).  If a number cannot be found when reviewing information in the 
clinic interview, a reverse ("criss-cross") directory is used.  If the informant's telephone number is still 
unavailable, a "Format 2" letter is sent asking the informant to provide a telephone number on the 
enclosed, self-addressed stamped post card. A copy of the participant's consent form is attached to 
the letter to the informant.  These letters are sent with both the interviewer and the EC Principal 
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Investigator's signatures.  After enough time elapses for the "Format 1" letter to arrive, or after 
receiving the reply post card to the "Format 2" letter, the interview is conducted using the Informant 
Interview Form.  This interview may be conducted over the telephone, or if necessary, in person.  If 
no reply is received, a "Format 4" letter is sent to next-door neighbors (identified by the reverse 
telephone directory) to request information on the whereabouts of the potential informant.  A "Format 
4" letter is also sent to the neighbor(s) when an informant's telephone number is initially available, but 
attempts at telephone contacts are unsuccessful.  If no reply is received from the neighbor(s), no 
further effort is needed. 
 
When the death is witnessed by someone other than a member of the decedent's family, both the 
family member whose name was given by the participant, and the witness recorded on the death 
certificate are interviewed.  In such a case, the information from both interviews is recorded on 
separate Informant Interview Forms.  Up to three (the three most complete) Informant Interview 
Forms may be completed for a given event. 
 
Information is sought from physicians by sending the Physician Questionnaire. From both the clinic 
and informant interviews an attempt is made to identify the physician(s) who attended the decedent 
during the four weeks period prior to death.  One questionnaire is sent to the physician who signed 
the death certificate.  Another questionnaire is sent to the physician (if any, and if different from the 
first) who saw the patient for heart disease during the 28 days prior to death.  Release-of-Information 
Forms signed by the deceased cohort participant are attached to these letters. If there is no response 
after four weeks of the initial mailing to the physician, a follow-up letter and another copy of the 
Physician Questionnaire are sent.  If there is no response after eight weeks of the initial mailing, the 
physician is contacted by telephone.  Up to two (the two most complete) Physician Questionnaires 
may be completed for a given event. 
 
If the decedent died in a nursing home, personnel are asked to complete a Physician Questionnaire 
based on the nursing home record.  JHS/ARIC may offer to assist with abstraction if this would be 
helpful. 
 
A Release of Information Form may be needed. 
 
If information provided by the informants or physicians indicates that a person who died out-of-
hospital was hospitalized within 28 days prior to death for MI or heart surgery, an attempt is made to 
ascertain the discharge diagnoses and, if applicable, review and abstract the hospital record.  
Requests to hospitals include copies of the JHS/ARIC release forms. 
 
6.2.1.3 Procedures for Hospitalized Events 
 
For hospitalized events with one of the discharge diagnosis codes for MI (402,410-414, 427, 428, 
518.4), the Cohort Eligibility Form is completed.  For a possible MI, the Hospital Record Abstraction 
Form is used for hospital record abstraction.  For the special case of MI, for events with discharge 
codes other than ICD9 410 or 411, if the patient was discharged alive with no ECGs taken and no 
cardiac enzymes measured, only the administrative information on the Hospital Record Abstraction 
Form is completed.   
 
For certain ICD9 procedure and diagnosis codes (35-39, 88.5, 88.72, 92.05, 250, 390-459, 786.02, 
786.09, 794.3, 798, 799), which refer to conditions, more remotely related to MI, the medical record is 
obtained and its discharge summary reviewed.  Any evidence in the discharge summary of the 
occurrence of MI requires the use of the Hospital Record Abstraction Form. 
 
For all remaining ICD9 codes, the discharge lists are perused and only the discharge diagnoses 
recorded.  These latter codes do not lead to hospital abstraction. 
 
Abstracting of cardiac enzyme levels and ranges, copying of ECGs and treatment of transfer status 
follow guidelines specified for ARIC in Manual 3, Version 6. 
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6.2.1.4 Summary of Cohort Investigations 
 
Event Type FORM 
 CEL DTH PH

Q 
IFI CO

R 
HRA 
(Full) 

HRA 
(Part) 

SXI♦ 

 
Out-of-Hospital Death (CHD 
eligible) 
 

 
Y 

 
Y 

 
Y 

 
Y 

 
Y 

   
Y 

Hospital Death  
(no vital signs at arrival, CHD 
eligible) 
 

 
Y 

 
Y 

 
Y 

 
Y 

 
Y* 

  
Y 

 
Y 

Hospital Death  
(vital signs at arrival, CHD 
eligible) 
 

 
Y 

 
Y 

   
Y* 

 
Y 

  
Y 

Hospitalized Case 
(discharged alive,  
CHD eligible) 
 

 
Y 

    
 

 
Y 

  
Y 

Hospitalized Case 
(not CHD eligible) 
 

 
Y 

       

Death  
(not CHD eligible) 

 
Y 

 
Y 

      
Y 

 
* If a death is certified by a coroner/medical examiner, the Coroner/Medical Examiner Form is 
completed and submitted to the Coordinating Center.  If an autopsy is performed, a copy of that 
report is sent to the Coordinating 
Center. 
 
6.2.1.5 Summary of CHD Event Investigations 
 
The following scheme summarizes the forms completed for eligible events: 
 
1. Out-of-hospital CHD death (died in outpatient department, includes DOA, 
      ER admitted without vital signs) 
 

a) Death Certificate (DTH) Form.  
b) Up to two Physician Questionnaires (PHQ) and three Informant Interview (IFI) Forms. 
c) Coroner Form on all coroner/medical examiner's (COR) cases and Hospital Record 

Abstraction (HRA) Form on cases admitted to a catchment’s area hospital in past 28 
days with heart conditions meeting JHS screening codes regardless of day of 
discharge.   

 
2. *Hospital CHD deaths, no vital signs in-hospital 

a) DTH. 
  b) First part of HRA. 

c) PHQ, IFI, COR. 
 
3. *Hospital CHD death, vital signs sometime in hospital 

a) DTH, HRA (full). 
 
4. *Hospitalized CHD case, discharged alive 

a) HRA (full).  
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*If a patient also transferred to or from a catchment’s area hospital, complete an additional Hospital 
Record Abstraction form. 
 
  
6.3 Diagnostic Criteria 
 
Events occurring among cohort participants receive a computer derived diagnosis classification into 
fatal diagnostic categories (definite fatal myocardial infarction, definite fatal CHD, possible fatal CHD, 
non-CHD death) and MI categories (definite, probable, suspect, and no).  However, for cohort events, 
the final diagnosis classification is determined by MMCC review. The only exceptions are those 
outlined in Section 6.4.1.1. 
 
6.3.1  Hospitalized Myocardial Infarction (MI) 
 
As described in Section 6.1.1, all hospitalized events occurring in cohort members are identified; 
detailed chart abstraction is carried out only when acute MI is suspected.  In addition, hospitalization 
for mild and chronic manifestations of ischemic heart disease, such as angina pectoris and 
congestive heart failure.  (So-called silent infarctions are not identified from the hospital records, but 
from ECG changes occurring to cohort members between their baseline and follow-up examinations.) 
 Both Q-wave (transmural) and non-Q-wave (non-transmural) infarctions are sought in all hospital 
records abstracted. 
 
It is recognized that aggressive treatment of signs and symptoms of impending myocardial infarction, 
such as angioplasty, CABG or thrombolyic therapy, may prevent the development of the full 
diagnostic syndrome.  In such cases, it may be difficult to diagnose the event accurately.  The use of 
such modalities are recorded and subject to data analysis, but are not employed in the criteria for 
diagnosis.  A computer derived diagnostic classification is created for all eligible cohort events.  
These categories (definite MI, probable MI, suspect MI and No MI) follow the same criteria outlined in 
the cohort morbidity and mortality section 2.2.2 to 2.2.4. 
 
6.3.1.1 Definition of Cardiac Pain 
 
1. Pain occurring anywhere in the anterior chest, left arm or jaw, and 
 
2. Absence of a definite non-cardiac cause of chest pain. 
 
6.3.1.2 Definitions of Electrocardiographic Criteria: 
 
The ECG series is assigned the highest category for which criteria are met, i.e., evolving diagnostic 
ECG patterns are higher than diagnostic ECG patterns, which are higher than evolving ST-T patterns, 
which are higher than equivocal ECG patterns, which are higher than other, which are higher than 
uncodable. 
 
To fit an evolving ECG Pattern (Evolving Diagnostic and Evolving ST-T) two or more recordings are 
needed.  Changes must occur within lead groups, i.e., lateral (I, aVL, V6), inferior (II, III, aVF), or 
anterior (V1-V5) and be confirmed for all codes by Serial ECG comparison. 
 

Example 
 
Reference ECG codes:   1-3-4    4-0    5-0    9-0 
Follow-up ECG codes:   1-2-4    4-0    5-2    9-0 

 
To be considered Evolving Diagnostic (pattern ED3) both the 1-2-4 and the 5-2 must be 
determined to be Significant Increase by Serial Change rules.  If the 1-2-4 change is not 
Significant Increase and the 5-2 change is Significant Increase, then the change would fit 
Evolving ST-T (pattern EV3).  If the 5-2 change is not Significant Increase, then pattern would 
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be Diagnostic ECG (pattern D1) because of the 1-2-4, regardless of whether or not the 1-2-4 
change is Significant Increase.   

 
Minnesota Coding Procedures 
 
The following ECG tracings are identified: 
 
1. The first codable ECG after admission; 
 
2. The last codable ECG recorded before discharge; and  
 
3. The last codable ECG recorded on day 3 (or the first ECG thereafter)    following admission or an 
in-hospital event. 
 
Photocopies of the cohort hospital ECGs are sent to the Minnesota Coding Center in Minneapolis for 
Minnesota Coding, using the Cohort Hospital ECG Form (ECG) shown in Appendix P of Manual 5.  
ECGs are read three times, blinded; the final codes are adjudicated by a senior coder.  Minnesota 
Code criteria are in Appendix E of Manual 5. 
 
The data from the ECG form is entered and a determination is made at the Coordinating Center by 
computer algorithm as to whether or not the Minnesota Code change criteria are met.  A list of those 
IDs that fit the change criteria (i.e., any pattern ED1 through ED7 or EV1 through EV5, defined above) 
is sent to the ECG Coding Center.  ECGs for these IDs are examined side by side for Serial ECG 
change. 
 
Simultaneous ECG comparison is performed on the final Minnesota codes using the first codable 
ECG of the hospitalization as the reference.  Serial ECG changes are determined three times, 
blinded.  Serial change categories are 1) significant increase, 2) decrease (4-, 5-, and 9-2 codes, but 
not for Q-codes), 3) no change (this implies no increase for Q-codes) or 4) technical problem.  The 
final categories are adjudicated by a senior coder and added to the EKG Form.   
 
As an example, the JHS protocol defines a new Minnesota code 1-2-7 as a potential ischemic event.  
Persons with this severity of ECG change will have simultaneous ECG comparison.  The ECG 
comparison procedure (for this case) requires a > 1 mm R-wave amplitude decrease between 
corresponding leads of the reference and comparison ECGs.  The criteria for 1-2-7 are QS patterns in 
V1, V2 and V3.  If the reference ECG has R-waves that are > 1 mm tall in V1 or V2 or V3, when 
comparing these ECGs side by side, and the R-waves in the reference ECG appear to decrease the 
appropriate amount (at least 1 mm), then a "significant increase" is noted on the Appendix O form.  If 
the reference ECG has R-waves < 1 mm tall, it cannot fulfill the change criteria and no change (or no 
increase) is noted. 
 
 
6.4 Event Determination 
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Final assignment of diagnostic categories for all cohort events of interest in the JHS is made by the 
MMCC, after initial assignment to diagnostic categories is carried out by computer algorithm.  The 
final classification of a cohort event is that preferred by the MMCC review process.  This section 
describes the procedures by which these determinations are made. 
 
Computer-generated summaries of all relevant coded information from the data collection forms are 
provided to the MMCC in summary form (Event Summary Form (ESF)) for review.  In addition, the 
MMCC considers remarks by family interviewers, hospital record abstractors, or clinic examiners or 
other uncoded information recorded on the data collection forms.  These are recorded in the form of 
note logs in the database and made available for use by the committee.  All cohort events (with some 
exception noted below) are reviewed by two members of the MMCC.  The final diagnosis decision 
made by the MMCC reviewer is recorded on the CDX form. 
 
For types of events which often are not classifiable by computer algorithm, e.g., out-of-hospital 
deaths, the diagnostic criteria given in Section 3.3 may not be specific enough to permit unequivocal 
classification of each event by the MMCC.  If the MMCC discovers a rule which helps standardize this 
process, it either 1) makes a recommendation to the JHS Steering Committee for further specification 
of the JHS diagnostic criteria or 2) records the rule as a part of the "case law" for its own use in 
classifying similar events. 
 
In addition to diagnosing all cohort clinical events, the MMCC provides other information about these 
events.  Examples include clinical judgments required prior to making diagnoses and resolution of 
conflicting evidence regarding the time interval between onset of symptoms and death.  These are 
discussed in the appropriate sections below. 
 
6.4.1 Diagnosis of Coronary Heart Disease 
 
6.4.1.1 Hospitalized MI 
 
The following cohort cases are automatically classified (do not require MMCC review).  These 
account for 10-15% of the total number of cohort events. 
 
1. The computer assigns a diagnosis to cohort events that skip out of the HRA form and no 410-

discharge code is present.  These events are automatically classified as NO_MI by the JHS 
diagnostic algorithm. 

2. The computer also assigns a final diagnosis of NO_MI for cohort events with no 410 codes, 
no pain, normal or incomplete enzymes, and ECG finding that is absent, uncodable, or other. 

 
All non-linked, non-fatal hospitalized CHD events where discharge codes do not include 410, chest 
pain is absent or present, enzymes are normal or incomplete, and ECG findings are equivocal, 
absent, or uncodable will automatically be assigned a final diagnosis of NO_MI by the computer. 
 
All non-linked, non-fatal cohort cases that are not automatically classified by the computer will only be 
reviewed by one MMCC reviewer (instead of 2) and the computer.  A second MMCC reviewer will 
adjudicate disagreements between the reviewer and the computer. 
 
All other events including linked non-fatal hospitalizations, fatal hospitalization (linked and non-
linked), and out-of-hospital death (linked and non-linked) are reviewed by two MMCC reviewers and 
an adjudicator if necessary.  The only exception is for linked greater than 28-day deaths.  These 
special reviews are sent to one MMCC reviewer with no adjudications.  
 
6.4.1.2 CHD Death 
 
Narratives recorded by family interviewers and other uncoded information is important in diagnosing 
deaths that occurred out-of-hospital.  For many out-of-hospital events, the MMCC must resolve 
conflicting information collected from several informants.  In-hospital deaths meeting the criteria for 
"Definite MI" require MMCC review for a possible Non-CHD cause of death before being classified as 
"Definite Fatal MI". 
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A computer diagnosis of "Definite Fatal MI", "Definite Fatal CHD" or "Non-CHD Death" is provided for 
those events for which all the necessary coded information is available and unequivocal.  Except for a 
sample of unequivocal computer diagnosed Non-CHD Deaths, all cohort deaths require MMCC 
review and classification. 
 
All out-of-hospital deaths classified as "Definite Fatal CHD" or "Possible Fatal CHD" requires an 
MMCC determination of the interval between the onset of symptoms and death.  Differences between 
reviewers in time interval are not adjudicated. 
 
 
6.4.2 Event Summary Forms (ESF) 
 
Event summary forms for cohorts include information that is taken from various cohort forms (AFU 
and clinic visit forms).  The information includes visit exam reports, annual follow-up information, 
previous cohort diagnosis for MI, and previous diagnosis for stroke.  Autopsy reports, if available, can 
also be included for cohorts.  For cohorts, it is the reviewer's decision whether to downgrade the 
"spurious" enzymes.  The reviewer is given the downgraded enzyme values, original enzyme values, 
and 2 pages of additional enzyme data. 
 
6.4.3 Additional Cohort Forms 
 
The Cohort Eligibility Form (CEL) is used to determine if a cohort event is eligible for cohort morbidity 
and mortality.  Data from the CEL is run through various data and code checks against other cohort 
morbidity and mortality forms such as the DTH and HRA.  The Annual Follow Up Form (AFU) data 
pertaining to Rose angina are printed out on the cohort ESF and is also used to locate any possibly 
missing cohort events that are cohort morbidity and mortality eligible. 
 
6.5 Diagnosis of Prevalent MI at Baseline and Interim MI Between Clinic Visits 
 
6.5.1     Procedures 
 
6.5.1.1 Minnesota Coding 
 
Cohort 12-lead ECGs will be taken during EC visits.  One ECG is taken at the baseline exam and a 
second ECG is taken at the follow-up exam three years later. 
 
Abnormal ECGs and a 10% selection of normal ECGs will be transmitted from the Epicare Computer 
Center to the Minnesota Coding Center in Minneapolis.  These ECGs will be coded visually by the 
Minnesota Code.  ECGs are read three times, blinded; the final codes are adjudicated by a senior 
coder.   
 
6.5.1.2 Adjudication 
 
The visual Minnesota Codes will be sent to the Coordinating Center for comparison with the 
computer-generated codes.  Adjudication between the visual code and the computer code will be 
performed by two electro cardiographers only on ECGs that have a discrepancy involving any Q-
code, or any 4-2, 4-1-2, 4-1-1, 5-2, 5-1 or 9-2.  The Coordinating Center determines the IDs that have 
any of these discrepancies and will send a report form to the Minnesota Coding Center listing the ID, 
acrostic, date and time of ECG, the visual codes and the computer codes.  These ECGs are 
examined and the adjudicated codes are recorded on the report form, which is returned to the 
Coordinating Center. 
 
6.5.1.3 Serial ECG Coding 
 
The CC adds the adjudicated codes to the database as the definitive Minnesota Codes for the ID 
involved. 
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When two ECGs from different EC visits are available, a determination is made at the Coordinating 
Center as to whether or not Minnesota Code change criteria are met.  A list of those IDs that fit the 
change criteria (i.e. any pattern ED1 through ED7) is sent to the ECG Coding Center.  ECGs for 
these IDs are examined side by side for Serial ECG change. 
 
Simultaneous ECG comparison is based on the final Minnesota Codes.  Serial ECG changes 
(significant increase, no increase or technical problem) are determined three times; the final 
categories are adjudicated by a senior coder and added to the Appendix O form.  The simultaneous 
ECG evaluation procedure uses the ECG of the first clinic visit as the reference ECG for comparison. 
 
JHS requires Minnesota Code change plus agreement by simultaneous ECG comparison before 
declaring the ECG pattern change meets JHS criteria for an interim MI. 
 
6.5.2 Definitions 
 
A determination that a JHS participant has had an MI, either prior to the initial clinic visit or between 
visits, can be made on ECG evidence alone, using the following criteria: 
 
6.5.2.1 Prevalent MI at Baseline 
 
Baseline ECG (initial cohort visit) coded: 
 

a) Any 1-1-X code 
 
     OR 
 

b) Any 1-2-X and 4-1-1 or 4-1-2 or 4-2 or 5-1 or 5-2 
 
6.5.2.2 Interim MI between Cohort Visits 
 
This is an Evolving Diagnostic ECG Pattern (ED1 through ED7) between the baseline ECG (initial 
cohort visit) and an ECG from a later cohort visit.  An “unrecognized MI” or “silent MI” can be said to 
have occurred in the interval between visits if such ECG evidence of MI was found and there was no 
clinically recognized MI event picked up by the hospitals during follow-up.  More information on the 
determination of unrecognized MI can be found in Borland, 2002. 
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7.0 COHORT MORBIDITY AND MORTALITY FOR STROKE 
 
 
7.1 Introduction 
 
Potential clinical stroke events are identified and then validated for cohort participants.  The 
procedure for identification, investigation, and classification of these events is outlined below.  More 
information on the stroke classification system can be found in Rosamond, 1999. 
 
7.2 Identification of Stroke Events 
 
There are two ways of identifying cohort stroke events.  The abstractors review the CEL forms; 
identify those cohorts with a stroke code listed on their hospital discharge form and/or one of the 
following keywords listed in their discharge summary or mentioned during the admission: stroke, TIA, 
cerebrovascular disease, cerebral hemorrhage, cerebral infarction, subarachnoid hemorrhage, 
cerebral embolus, paralysis, aphasia, diplopia, lacunar (syndrome infarction), dysarthria, cerebral 
angiography, carotid endarterectomy, CT/MRI scan showing cerebrovascular findings, or Neuro ICU 
care.  Death certificates listings are also reviewed for the presence of an underlying cause of death 
suggestive of stroke (ICD10 code: I60-69). Stroke deaths without additional hospitalization data will 
not be investigated. Classification of non-linked stroke deaths (not linked to a hospitalization within 28 
days) is classified on the basis of underlying cause of death code.   
 
7.3  Investigation 
 
If a cohort event meets the above criteria, a specially trained abstractor then reviews these records 
and completes the Stroke Form (STR, Appendix VI).  Approximately every month, these data are sent 
to the Coordinating Center and run through a series of data check programs. 
 
7.4 Diagnosis 
 
All potential stroke hospitalizations are automatically assigned a stroke diagnosis by the 
computerized stroke algorithm (Appendix III).  The computerized stroke algorithm classifies stroke 
events based on the data from the STR form and the DTH form if the event is a death.  The possible 
computer stroke classifications are as follows: definite or probable subarachnoid hemorrhage (SAH); 
definite or probable brain hemorrhage (IPH); definite or probable brain infarction, thrombotic (TIB); 
definite or probable brain infarction, non-carotid embolic (EIB); possible stroke of undetermined type; 
undocumented fatal stroke; out of hospital death stroke; or no stroke.  Undocumented fatal strokes 
and out of hospital death strokes do not require a STR form.  In the rare case where a stroke event 
meets the criteria for two different diagnoses, the following hierarchy is used: 
 
Definite IPH 
Definite SAH 
Definite EIB 
Definite TIB 
Probable IPH 
Probable SAH 
Probable EIB 
Probable TIB 
Possible stroke of undetermined type 
 
A Stroke Event Summary Form (S-ESF) is produced for each stroke event that include information on 
number of major/minor symptoms, procedures, discharge diagnosis codes, and the computer 
classification of the event.  The S-ESF and all hospital materials for the stroke event are sent to one 
member of the Stroke-Mortality and Morbidity Classification Committee (S-MMCC) for classification.  
The S-MMCC reviewer fills out a Stroke Final Diagnosis Form (SDX).  The S-MMCC reviewer can 
either cite exclusionary conditions such as major head trauma, neoplasm, CNS infection, etc., or 
classify the stroke event in one of the following categories: definite or probable subarachnoid 
hemorrhage (SAH); definite or probable brain hemorrhage (IPH); definite or probable brain infarction, 
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thrombotic (TIB); definite or probable brain infarction, non-carotid embolic (EIB); possible stroke of 
undetermined type; or other (no stroke) if no exclusionary conditions were met.  Event summary 
forms (S-ESF) are not produced for the following three event types: 1) Events where the STR form 
indicates that neurological symptoms did not last more than 24 hours or there were no new 
neurological symptoms prior to or during the hospital admission; 2) Out of hospital stroke deaths not 
linked to a hospitalization; or 3) hospitalized events with no medical chart available.  These events 
are automatically classified without physician review as “no stroke”. 
 
7.5 Classification 
 
The one S-MMCC reviewer and the computer algorithm determine final classification of stroke events. 
 If there are discrepancies between these two sources, the final event classification is determined by 
a second reviewer (stroke –adjudicator).  An event is considered classified if one of the following 
situations occurs: 
 
1.   If the reviewer has not cited any exclusionary conditions and the computer algorithm 

diagnosis agrees with the reviewer's diagnosis, the event is classified as such. 
2.   If the reviewer does cite exclusionary conditions and the computer algorithm 

diagnosis is no stroke, the event is classified as no stroke. 
 
If the S-MMCC reviewer and the computer algorithm disagree, the adjudicator's classification is taken 
as the final classification. 
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Table 7.1.  Matching ICD-9 with ICD-10 for Underlying Cause of Death Codes related to  
                  STROKE 
 
ICD-9 
Code 

ICD-9 Classification ICD-10 
Code 

ICD-10 Classification 

430 Subarachnoid hemorrhage I60 Subarachnoid hemorrhage 
    
431 Intracerebral hemorrhage I61 Intracerebral hemorrhage 
    
432 Other intracerebral 

hemorrhage 
I62 Other nontraumatic intracranial hemorrhage 

    
433 Occlusion of precerebral 

arteries 
I63 Cerebral infarction 

    
434 Occlusion of cerebral arteries I63 

 
I65 

 
 
 

I66 
 

Cerebral infarction 
 
Occlusion of precerebral arteries not 
resulting in infarction 
 
Occlusion and stenosis of cerebral arteries 
not resulting in infarction 

    
435 Transient ischemic attack G45 Transient cerebral ischemic attacks and 

related syndromes (Not relevant death 
classification. Do not include in algorithm) 

    
436 Acute, ill-defined CVD n/a n/a 
    
437 Other ill-defined CVD I64 

 
 

I67 

Stroke, not specified as hemorrhage or 
infarction 
 
Other CVD 

    
438 Late effects of CVD I69 Sequel of CVD 
  
Important Notes: 
 

I63 includes occlusion and stenosis of cerebral and precerebral arteries resulting in infarction. 
 
I65 includes embolism and narrowing not resulting in infarction 
 
Excluded is ICD-10 code I68, cerebrovascular disease in diseases classified elsewhere 
(cerebral amyloidal angiopathy, cerebral arteritis in infectious and parasitic diseases) 

 
 Comparability ratio for ICD-9 cerebrovascular disease 430-434, 436-438 and ICD-10 I60-I69 

reported to be 1.04
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8.0 COHORT MORBIDITY AND MORTALITY FOR CONGESTIVE HEART FAILURE 
 
The CHF working group at the JHS has developed a definition for CHF and both inpatient 

and outpatient CHF criteria based on the modification of those used by Multiethnic Study of 
Atherosclerosis (MESA), Framingham and Cardiovascular Health Study (CHS) (patient symptoms, 
physician physical findings, and diagnostic procedures).  Inpatient CHF criteria will be included in the 
Hospital Record Abstraction (HRA) Form as an addendum, and outpatient CHF criteria will be 
developed for the Outpatient Record Abstraction Form. The current HRA form captures CHF 
discharge codes, but no further information is abstracted. The addendum HRA form will allow detailed 
HRA abstraction that will parallel that for CHD cases. The Cohort Eligibility form (form CEL) will be 
adjusted to accommodate abstraction of records that meet the CHF criteria and definition for both 
inpatient and outpatient cohort participants. 
 
The CHF working group also developed CHF questions that are being administered to cohort 
members during the AFU interview. Specific questions are available at (cite website & JHS forms 
manual here). The CHF questions are already part of the expanded informant interview form that is 
now completed for out-of-hospital deaths. 
 
The protocol for identifying and classifying heart failure events among cohort participants has been 
developed and will be re-evaluated after the first 6 months and modifications made as appropriate.  
The definition for CHF adopted by the JHS is:  

• a constellation of various symptoms and physical signs that occur in a participant whose 
cardiac output cannot match metabolic need despite adequate filling pressure as a result of 
various disease processes. 

CHF identification will follow the usual routines of reviewing the hospital discharge list and death 
certificate keywords and ICD9-10 codes suggestive of CHF. A summary of the preliminary approach 
to heart failure classification is provided below. 
 
8.1 Inpatient 
 
8.1.1. Introduction 
 
8.1.2. Identification of CHF Events 
 
Definition:  Congestive Heart Failure is defined as a constellation of various symptoms and physical 
signs that occur in a participant whose cardiac output cannot match metabolic need despite adequate 
filling pressure as a result of various disease processes. 
 
Hospitalizations. Trained and certified CHF abstractors review the Cohort Eligibility (CEL) forms and 
identify participants with (1) a discharge diagnosis of ICD9 code 428 and/or underlying cause of death 
I50, and (2) radiographic findings consistent with CHF or increased venous pressure >16, or dilated 
ventricle/left ventricular function <40% by echo/MUGA scan, or (3) autopsy finding of pulmonary 
edema / CHF.  
  
In- or Out-of-Hospital Deaths. Death certificates are reviewed for underlying secondary or tertiary or 
higher cause of death that is suggestive of CHF (ICD9 code 428 or ICD10 code I50).   
 
Review and Classification. Any CHF event that meets the above criteria is reviewed by a trained CHF 
abstractor who completes a CHF abstraction form. The abstracted data is transmitted to UNC-CSCC 
and run through a series of data check programs.  All CHF hospitalizations are automatically 
assigned a CHF diagnosis by the computerized CHF algorithm which depends on abstracted data on 
the CHF and the death form (DTH) if the event is a death.  The computerized CHF classifications 
include (1) Definite CHF, (2) Probable CHF, or (3) No CHF in accordance with inpatient or outpatient 
location using the following criteria: 

• Inpatient Definite CHF.  Criteria for Definite CHF in an inpatient setting include: (1) a 
discharge diagnosis of ICD9 code 428 and/or underlying cause of death I50, and (2) 
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radiographic findings consistent with CHF or increased venous pressure >16, or dilated 
ventricle/left ventricular ejection fraction < 40% by echo/MUGA/MRI scan, or (3) autopsy 
finding of pulmonary edema / CHF. 

• Inpatient Probable CHF.  Criteria for Probable CHF in the inpatient setting include: (1) a 
discharge diagnosis ICD9 code of 428 and/or underlying cause of death 150, and (2) any 
three findings from the CHF criteria list. 

 
8.1.33 Classification of CHF Events (Inpatient)   
 
CHF Criteria (Inpatient): 
 
Definite 
 
Discharge Diagnosis of 428 and/or underlying cause of death I50 
AND 
Radiographic findings consistent with CHF or increased venous pressure >16 or Dilated ventricle/left 
ventricular function<40% by echo/MUGA scan 
OR 
Autopsy finding of pulmonary edema/CHF 
 
Probable 
 
Discharge Diagnosis of 428 and/or underlying cause of death 150  
AND 
Any 3 findings from CHF criteria (list below) 
 
Paroxysmal nocturnal dyspnea 
Orthopnea 
Distended neck veins/jugular venous distention 
Dyspnea on exertion 
Shortness of breath (dyspnea at rest) 
Night Cough  
S3  
Rales 
Hepatojugular reflux 
Hepatomegaly 
Bilateral lower extremity edema 
Tachycardia (120+) 
Decrease in vital capacity by 1/3 
 
 
8.2 Outpatient 
 
8.2.1. Introduction 
 
8.2.2. Identification of CHF Events 
 
Definition: Congestive Heart Failure is defined as a constellation of various symptoms and physical 
signs that occur in a participant whose cardiac output cannot match metabolic need despite adequate 
filling pressure as a result of various disease processes. 
 
8.2.3 Classification of CHF Events 
 
Any JHS participant that routinely visits a health care provider on an outpatient basis with problems 
related to CHF will be identified during the usual AFU. The information which includes the location of 
outpatient clinics and treating provider’s name will be transmitted to the trained and certified CHF 
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medical record abstractors. The abstractor reviews the Cohort Eligibility (CEL) forms and identify 
participants with (1) a discharge diagnosis of ICD9 code 428 and/or underlying cause of death I50, 
and (2) radiographic findings consistent with CHF or increased venous pressure >16, or dilated 
ventricle/left ventricular ejection fraction < 40% by echo/MUGA/MRI scan, or (3) autopsy finding of 
pulmonary edema / CHF. 
 
Review and Classification.  Any CHF event that meets the above criteria is reviewed by trained CHF 
abstractor who completes a congestive heart failure abstraction form. The abstracted data is 
transmitted to UNC-CSCC and run through a series of data check programs.  All CHF hospitalizations 
are automatically assigned a CHF diagnosis by the computerized CHF algorithm which depends on 
abstracted data on the CHF and the death form (DTH) if the event is a death.  The computerized CHF 
classifications include (1) Definite CHF, (2) Probable CHF, or (3) No CHF using the following criteria: 

• Outpatient Definite CHF. Criteria for Definite CHF in an outpatient setting include: (1) 
outpatient diagnosis of ICD 428 and/or underlying cause of death I50 (out of hospital), and 
(2) outpatient diagnosis of ICD 428 and Chest X-Ray (CXR) findings consistent with pleural 
effusion/pulmonary edema/ cephalization of vessels/ cardiomegaly (1 and 2), or (3) 
outpatient diagnosis of ICD 428 and echo consistent with dilated ventricle/left ventricular 
ejection fraction < 40% (1 and 3), or (4) outpatient diagnosis of ICD 428 and any 3 findings 
from CHF criteria within two weeks of outpatient visit (1 and 4) 

• Outpatient Probable CHF. Criteria for Probable CHF in the outpatient setting include: (1) 
outpatient diagnosis of ICD 9 code 428 and/or underlying cause of death I50, or (2) ICD 9 
code 425.4 or 518.4 with one or two of the CHF symptoms, and (3) at least one but less 
than three findings from the CHF criteria 

 
For both Inpatient and Outpatient, the CHF Event summary forms (CHF-ESF) and all hospital 
materials for the CHF event are sent to one member of the CHF-Mortality and Morbidity Classification 
Committee (CHF-MMCC) for classification. The trained CHF-MMCC reviewer with medical expertise 
in CHF assigns a final diagnosis of CHF. The one CHF-MMCC reviewer and the computer algorithm 
determine final classification of CHF events. If there are discrepancies between these two sources, 
the final event classification is determined by a second reviewer (CHF adjudicator). 
 
Classification of CHF Events (Outpatient)   
 
CHF Criteria (Outpatient): 
 
Definite: 
 
(1)Outpatient diagnosis of ICD 428 and/or underlying cause of death 150 (out of hospital) 
AND 
(2) Outpatient diagnosis of ICD 428 and CXR findings consistent with pleural effusion/pulmonary 
edema/cephalization of vessels/cardiomegaly (1 and 2) 
OR 
(3) Outpatient diagnosis of ICD 428 and echo consistent with dilated ventricle/left ventricular function< 
40% (1 and 3) 
OR 
(4) Outpatient diagnosis of ICD 428 and any 3 findings from CHF criteria within 2 weeks of our patient 
visit (1 and 4) 
 
Paroxysmal nocturnal dyspnea 
Orthopnea 
Distended neck veins/jugular venous distention 
Dyspnea on exertion 
Shortness of breath (dyspnea at rest) 
Night Cough 
S3 
Rales 
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Hepatojugular reflux 
Hepatomegaly 
Bilateral lower edema 
Tachycardia (120+) 
Decrease in vital capacity by 1/3 
 
Probable 
 
Outpatient diagnosis of ICD 428 and/or underlying cause of death 150 
OR 
ICD 425.4 or ICD 518.4 with 1 or 2 of the symptoms listed below  
AND 
At least 1 but less than 3 findings from CHF criteria (list below): 
 
Paroxysmal nocturnal dyspnea 
Orthopnea 
Distended neck veins/jugular venous distention 
Dyspnea on exertion 
Shortness of breath (Dyspnea at rest) 
Night Cough 
S3 
Rales 
Hepatojugular reflux 
Hepatomegaly 
Bilateral lower extremity edema 
Tachycardia (120+) 
Decrease in vital capacity by /3 
 
Unvalidated (underlying cause of death fatal heart failure-out-of hospital) 
 
 
9.0 PROCEDURES FOR PREPARING MORBIDITY AND MORTALITY CLASSIFICATION 
      COMMITTEE (MMCC) 
 
  
9.1 CHD Reviews Specific to Cohort morbidity and mortality 
 

The JHSCC generates the MMCC Event Summary Forms (ESFs) in the Data Management 
Program (MGP) as well as AFUs.  The steps taken at JHS in processing MMCC materials are to:  

  
A. Separate and Organize ID Listings and Event Summary Forms (ESFs):  Job 20:  

Each Cohort AFU, usually one page, must be placed first when all the materials are 
collated with the ESFs of that event.  Job 16: Linked Non-Fatal Hospitalizations (NFH-L), 
In-Hospital Deaths (IHD), and Linked In-Hospital Deaths (IHD-L).  Job 17: Non-Linked 
Non-Fatal Hospitalizations (NFH).  Job 18: Out-of Hospital Deaths (OHD).  Job 19: 
Linked Out-of-Hospital Deaths (OHD-L).  The number of events in Jobs 16, 17, 18, and 
19 are recorded in a table, “Current Status of JHS Cohort morbidity and mortality 
Reviews”, for monitoring purposes. 

 
B. Collect All Needed ID Medical Records:  Procedures for obtaining materials are the 

same as for Community Events.  There will be no materials at the EC for Job 18. 
 
C. Collate and Copy Materials for Each Event for Review:  The pages of all events to 

be reviewed must have the AFU sheet(s) first with the EFSs next; linked events 
follow, in reverse chronological order.  Job 17 must be copied once.  Unless events 
go to special view, Jobs 16, 18, and 19 need to be copied twice.  The original set is 
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placed in the event folder behind the medical record. The medical records, received 
in duplicate from the EC, are copied once for Job 16, 18, and 19.  The AFUs and 
ESFs are stapled to the event for review and the linked events are stapled with the 
ESFs and record; OHD events have none, as will others, and are stapled together.  
Each event is clipped together with a prepared CDX Form on top. 

 
D. Prepare the Events for Reviewers:  The IDs to be sent to a reviewer are tracked by 

Batch Number from the MGP, Sequence Number for the Reviewer, and Dates for the 
steps in the process are recorded for Jobs 16, 17, 18, and 19. 

 
1. Non-fatal Hospitalizations (NFH):  (Job 17) The Cohort morbidity and mortality 

CDX Form is prepared for a single reviewer using the Sequence Number X1 and 
Parts A and B of the Form with the Type of Review in Question 1.b. as “O” and the 
Code Number of the intended reviewer.  (Prior to 1995 two reviewers diagnosed the 
non-linked NFH events.) 

 
2. Linked Non-fatal Hospitalizations (NFH-L) and In-hospital Deaths, Non-linked 

and Linked (IHD and IHD-L):  (Job 16) The CDX Form is usually prepared for two 
reviewers using Sequence Numbers X1 and X2 with the Type of Review in Question 
1.b. as “O” and the Code Numbers of the intended reviewers.  The events that are 
NFH-L require Parts A and B completed and IHD and IHD-L require Parts A, B, and 
C completed by both reviewers. 

 
3. Special Linked Non-fatal Hospitalizations (NFH-L) and In-hospital Deaths, 

Non-linked and Linked (IHD and IHD-L):  (Job 16) The Sequence Number is listed 
on the ESF for the event with X5, as spanning >28 days.  The CDX Form is 
prepared for a special reviewer with the Type of Review in Question 1.b. as “G” and 
the Code Number of the special reviewer.  The events that are NFH-L require Parts 
A and B completed and IHD and IHD-L require Parts A, B, and C completed. 

 
4. Non-linked Out-of-hospital Deaths (OHD):  (Job 18) Two CDX Forms are 

prepared. 
 

5. Linked Out-of-hospital Deaths (OHD-L):  (Job 19) The CDX Form is usually 
prepared for two reviewers using Sequence Numbers X1 and X2 with the Type of 
Review in Question 1.b. as “O” and the Code Numbers of the intended reviewers.  
These Cohort events require Parts A, B, and C to be completed by both reviewers.  
Rarely is there a special review generated for an event with Sequence X5, spanning 
>28 days; the CDX Form prepared for the special reviewer has the Type of Review 
in Question 1.b. as “G”. 

 
 
9.2 Adjudication of CHD Reviews 
  

In Cohort morbidity and mortality, adjudication is necessary when the preferred classification 
(CDX Questions 7B, 14B) or the algorithm classification (Questions 6, 13), if there is no preferred 
classification, disagrees between two reviewers.  For Non-fatal Hospitalizations in Job 17, if the 
one reviewer disagrees with the JHS algorithm (Question 7.a. is “No”), then adjudication is 
necessary for Question 7.b.  Special reviews (Sequences X4 and X5) do not require adjudication. 
Adjudication is required only for the most current data if there were data changes initiating a new 
review. 
 
Copy the completed CDX Forms that were returned by the original reviewers and the ESFs with 
the medical records that were sent to the original reviewers.  The CDX Forms are prepared for 
the adjudicator using Sequence Number X3, as “Adjudication”, with Type of Review marked in 
Question l.b. as “A”.  These events require the same Parts completed as the original review and 
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have the same IDs and Batch Number as the original reviews.  Clip the adjudicator’s new CDX 
Form on top of the packet of each event to adjudicate.  Community events for adjudication are 
tracked by Batch Number from the MGP, Sequence Number for the Reviewer, and Dates for the 
steps in the process are recorded.  Follow the same procedures for shipping the adjudications as 
those for original reviews. 
 

9.3 Monitoring Return of CDX Forms 
 
Reviewers who do not meet expected deadlines are reminded. If forms are found to be 
incomplete, they are returned to the reviewer prior to data entry.  The DES and MGP also check 
for incompleteness of forms with inconsistent answers; forms with these problems are returned to 
the original reviewers for resolution. 

 
9.4 Monitoring Consistencies of New Reviewers 

 
When new reviewers have been certified and are ready to begin reviewing cases, the number of 
CHD events is kept low; the type of reviews best suited to them are OHD, then IHD, and later 
linked events.  As original reviewers, they are paired with experienced reviewers.  Feedback to 
the new reviewers on the cases needing adjudication is helpful.  A new reviewer, still requiring 
training, can be given the same set of events to review as two original reviewers with Sequence 
Numbers 0X or 1X, which are checked by hand, until the accuracy on the CDX Forms is 
acceptable for events to be entered into the DES. 
 

9.5 Filing and Storing Completed CHD Reviews in Event_ID Labelled Folders 
 

Verified CDX Forms are placed in the front of the Event_ID folder and filed in numeric order in 
secured CSCC file cabinets; any linked IDs are filed independently in numeric order at the same 
time. 

 
Folders with CHD events over 5 years old, as determined from the MGP, can be removed from 
the secured JHS CHD file cabinets to secured off-site storage. 

 
9.6 Stroke Reviews Specific to Cohort morbidity and mortality 

 
All eligible Cohort events (those that have charts and neurological signs and symptoms) are 
reviewed for a stroke classification.  The Stroke Data Management Program (MGP) generates 
the MMCC Event Summary Forms (ESFs) and lists for both original reviews and required 
adjudications for the classification of stroke. 
 
The procedures taken at CSCC in processing Stroke MMCC reviews is similar, but less 
complicated than CHD reviews.  The steps are to: 
 
A. Organize ID Listings and Collect ID Medical Records:  Upon notification that the 

Stroke MGP is ready, print out the 3 listings of Job 06.  The stroke records are prepared 
and shipped by a special abstractor on a regular basis.  If an event has not yet been 
sent to CSCC when the Stroke MGP generates a case for review, then it must be 
requested.  ID-labeled file folders to contain the records sent must be prepared at 
CSCC; they are stored in file cabinets separately from the CHD records. 

 
B. Copy Medical Records and Sorted EFSs:  Both the original review and adjudication 

are sent to one reviewer; one set of materials is copied for each event.  The ESFs are 
stapled to the specific record.  The packets are prepared similarly to reviews for CHD 
events:  each SDX Form is clipped to the packet of the EFS sheet(s) stapled to the 
record of the event. 
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C. Prepare the Events for Reviewers:  Each 7-digit Event_ID is written in the set of boxes 
on the Stroke SDX Form.  The original review is prepared for a single reviewer using the 
Sequence Number X1, the Batch Number from the MGP, the Type of Review in 
Question 1.b. as “O”, and the Code Number of the intended reviewer.  The SDX Form 
for the adjudicator is prepared with Sequence Number X3, the Batch Number from the 
MGP, the Type of Review in Question 1.b. as “A” and the Code Number of the intended 
reviewer.  The IDs sent to a reviewer are tracked by Batch Number from the MGP, 
Sequence Number for the Reviewer, and Dates for the steps in the process are recorded 
for the reviews.  The packet shipped, usually by Federal Express, contains a memo 
describing the cases, a copy of the log sheet, and the sets of reviews in numerical order. 
 The memo states the date that the reviews are expected to be returned to CSCC, 
usually a period of 3 to 4 weeks, and requests that the reviewer notify CSCC if the 
reviewer will be unable to complete reviews for an extended time in the future. 

 
D. Adjudicate Stroke Events:  Adjudication is required if the original reviewer disagrees 

with the computer diagnosis (variable called “COMPDIAG”, listed on the sheet “Listing of 
ESF for Original Review).  When the original reviewer’s SDX Forms are returned and 
checked for completeness, the diagnosis should be compared with the “COMPDIAG”; if 
there is a disagreement, then the event can be sent for adjudication prior to the next 
stroke retrieval.  The event for adjudication is sent to the stroke adjudicator with 
sequence number X3. 

 
E. Monitor Return of Stroke Reviews:  As reviewers return their SDX Forms, they are 

checked for completeness and then entered into the data entry system (DES) and 
stamped “keyed”.  Each form is “verified” by a second individual entering the same 
data.  The number of stroke cases under original review and adjudication are 
recorded in a table, “Current Status of JHS Cohort morbidity and mortality Reviews”. 

 
F. File and Store Completed Stroke Reviews in Event-ID Labelled Folders:  Verified 

SDX Forms are placed in the front of the Event_ID folder and filed in numeric order in 
designated secure Stroke file cabinets at CSCC. 

 
9.7 Summary of the JHS MMCC Processing Procedures♣  
 

COHORT CHD: COMPLETION OF CDX FORM (Job 16-20) 
Type MGP 

Job 
#  

Seq 
# 

MI DXa 
(part B) 

Death 
DXa 
(part C) 

Reviewer Items to check for 
Adjudicationsb 

NHa, Unlinked, 
>=1995c 

17,20 *1♦ Yes No Anyone Q7a 

NHa, Linked 16,20 *1, *2 Yes No Anyone Q7b vs Q7b if both Q7b not 
blank 
Q7b vs Q6 if one Q7b is blank 
Q6 vs Q6 if both Q7b are 
blank 

IHDa,  
Linked & Unlinked 

16,20 *1, *2 Yes Yes Anyone MI: 
Q7b vs Q7b if both Q7b not 
blank 
Q7b vs Q6 if one Q7b is blank 
Q6 vs Q6 if both Q7b are 
blank 
Death: 
Q14b vs Q14b if both Q14b 
not blank 
Q14b vs Q13 if one Q14b is 
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blank 
Q13 vs Q13 if both Q14b are 
blank 

OHDa, Unlinked 18,20 *1, *2 No Yes Anyone Q14b vs Q14b if both Q14b 
not blank 
Q14b vs Q13 if one Q14b is 
blank 
Q13 vs Q13 if both Q14b are 
blank 

OHDa, Linked  19,20 *1, *2 Yes Yes Anyone MI: 
Q7b vs Q7b if both Q7b not 
blank 
Q7b vs Q6 if one Q7b is blank 
Q6 vs Q6 if both Q7b are 
blank 
Death: 
Q14b vs Q14b if both Q14b 
not blank 
Q14b vs Q13 if one Q14b is 
blank 
Q13 vs Q13 if both Q14b are 
blank 

Special Deaths 16 *5 Yes Yes Folsom  
Adjudication  *3 Same as  

Originals 
Same as 
Originals 

Conwill  

 
       
       
       
       
       
       
       
       
COHORT STROKE: COMPLETION OF SDX FORM 

Type MGP 
job # 

Seq 
# 

Stroke DXa 
(part B) 

Stroke CLa 
(part C) 

Review
er 

Items to check for 
Adjudications 

Original 06 01 Yes If Q5=C or 
G 

Shahar Computer DX 

Adjudication  03 Yes If Q5=C or 
G 

Cooper 
Folsom 

 

♣ Determination of possible linkages for events occurring > 28 days (from MGP Job 04) is not 
included in this summary table. 
 
♦ * =0, 1, 2, depending on the number of times that an event was reviewed. If an event is reviewed 
for the first time, *=0. If an event is reviewed for the second time due to data changes, *=1, etc. 
 
a) Abbreviations: 
CL = Classification                      DX    = Diagnosis 
NH = Non-fatal Hospitalizations         IHD   = In-Hospital Deaths 
OHD = Out-of-Hospital Deaths            L-IHD = Linked IHD 
 
 
b) Criteria for adjudication: 

• Cohort with 1 review: compare preferred DX with computer DX (if Q7a is ‘N’, need 
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adjudication). 
 
• Cohort with 2 reviews: compare preferred DX between reviewers. That is, compare 

Q7b vs Q7b if both Q7b are not blank, 
Q7b vs Q6 if one Q7b is blank, 
Q6 vs Q6 if both Q7b are blank, 
Similarly for Death Dx (Q13 & Q14b) 
 
NOTE: the comparison listed above is under the assumption that the CDX form is complete 
(no incomplete items), and Q6(determined by Q3-Q5. See Table 2 in the next page) and Q13 
(determined by Q8-12 of the CDX form) are answered correctly. If Q6 and/or Q13 are 
answered incorrectly, data checks will be generated and the review is considered incomplete. 
 

• Reviews with sequence numbers *3, *4 or *5 do not require adjudication. 
 

• Cases needing adjudication should be processed right after receiving the reviews from 
reviewers. 
MGP Job 05 (cohort morbidity and mortality) check the cases still needing adjudication. 
 

c) In ARIC before 1995, Unlinked Non-fatal Hospitalizations in cohort morbidity and mortality were 
reviewed by 2 reviewers with sequence number *1 & *2. 

 
d) MGP job 04.OUT is to be sent to Folsom for > 28 days linkage review. Feedback will be passed 

to the Statistician for the next MGP. 
 
e) MI diagnosis for unlinked Non-fatal Hospitalizations and linked out-of-hospital deaths are 

automatically classified by computers. 
 
f) Linked IHD cases: if MI is computer-classified, but not death, will require 2 reviewers (unless it’s 

>28 death event). If both MI & Death require a manual review, a special review with seq # *4 will 
be assigned. 

 
g) MI diagnosis for linked out-of-hospital deaths is mostly automatically classified by computers. 

However, a portion of events which linked to >=2 hospitalizations require 2 reviews. 
 
9.8 Procedures for Hospital Records Sent to the Coordinating Center 
 
For the following type of events, EC should deliver the duplicated material to the CC on a regular 
basis (without CC's request): 
• All hospitalized cohorts that are non-skip-outs 
• All who transferred with ICD-9 code 410 or 411 or ICD-10 code I20-24 
• All deaths in Cohort 
 
For each of these events, a manila right tab file folder is prepared with the event ID label affixed to the 
top with the added notation if the patient is a Cohort. Included in the file folder is one of the following, 
ranked in priority: 
• Discharge summary 
• Progress note of last physician and cardiac consultation 
• Progress note of last physician and history and physical 
 
Each page should have the ID label affixed (over the patient's name) and all caregivers' and patient's 
names blinded with a black china marker. These materials are duplicated and placed in the folder 
behind the completed "Checklist for Hospital Event Materials.” Note that death certificates are no 
longer sent because the DTH form has been entered into the data entry system. 
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When a significant number of medical records have been prepared, they are put in numeric order and 
shipped to CC with JHS SHIPPING FORM and a DUPLICATED MATERIALS FOR MMCC 
SHIPPING INVENTORY sheet (see Appendix V. Duplicate Materials Shipping Forms) with places to 
fix event ID labels. 
 
If CC requires hospital records for materials not sent for a particular patient's event, such as cases of 
hospitalizations to determine possible linkages, these are also prepared and sent in a similar fashion. 
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10.0 QUALITY CONTROL  
 
Each year, the CC generates a set of Cohort morbidity and mortality QC report. In addition, central 
training for abstractors and MMCC reviewers are held once every 1-3 years to assure data quality. 
 
10.1 Quality Control for Medical Record Abstractions 
 
In JHS Cohort morbidity and mortality, hospital medical records for cohort participants with discharge 
ICD-9 code 410 or 411 are re-abstracted; 12 per abstractor per calendar year and event year. Each 
year, items in the re-abstracted HRA were compared to their original abstraction to compute the 
percentage of disagreement.  
 
10.2 Quality Control for the Out-of-hospital Death Investigation 
 
For OHD events, information from informants, patient's physicians and coroner/medical examiner 
need to be abstracted. Up to 3 Informant interviews (IFI) and 2 physician questionnaires (PHQ) may 
be collected.  Each year, the percentage of completeness of the abstractions for OHD is computed. 
 
10.3 Quality Control for the MMCC Reviews 
 
Linked or fatal events require either 1 review by a special reviewer or 2 original reviews to determine 
their MI and/or fatal CHD classification. For events reviewed by 2 original reviewers, if their MI 
classification and/or death classification disagreed, that event was sent to an adjudicator for 
adjudication.  
 
10.4 Summary of the Annual Cohort morbidity and mortality QC Report 
 
Each year, the CC generates a QC report includes the following items: 
•  HRA QC  

- disagreement rates in repeat abstraction, by year and center; 
- % of missing data or unknown responses for HRA items, by year and center 
- % of missing charts, % of MI/death unclassifiable events, by year and center  

• Completeness of event investigation for OHD 
• MMCC QC 

- disagreement rates for MI/Death classification between 2 original reviewers, by year  
- % of original reviews disagreed with Adjudicators for MI classification, by reviewers  
- % of original reviews disagreed with Adjudicators for Death classification, by reviewers 
- % of dirty data (inconsistent answers among Q3-Q6) for MI classification, by year & reviewers 

% of dirty data (inconsistent answers among Q8-Q13) for Death classification, by year & 
reviewers  

 
10.5 Certification Procedures 
 
10.5.1 Certification for Medical Records Abstraction 
 
Medical record abstractors are re-certified every three years during a central  
(face to face) training session. Generally, these training sessions are conducted over a period of 2 
days. The agenda of the training sessions include detail discussions of changes or updates to the 
data entry systems, updates to question by question instructions for each data collection form, review 
of ongoing quality control reports.  A key feature of the training is the re-certification process.  As a 
part of that process, each abstractor receives a packet of 4 medical records.  Each abstractor 
completes a full hospital record abstraction (HRA) for each record and sends it in electronic form to 
the CC.  Answers from each abstractor for every item on the HRA form are compared and a printout 
generated. This is reviewed in detail during the training session, with discussion lead by the senior 
abstractor supervisor.  Discrepancies between reviewers on any items are discussed in detail.  Items 
with significant disagreement are identified and the appropriate sections of the question-by-question 
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instructions and protocols discussed.  In addition, each center prepares and presents four cases for 
review and discussion by the group.  An abstractor must successfully complete these exercises in 
order to be re-certified.  The senior abstractor supervisor in consultation with the Chair of the Events 
Monitoring Committee makes the decision of re-certification. 
 
10.5.2 Certification for Informants Interview 
 
Staffs responsible for conducting informant interviews are also re-certified every three years at the 
central training.  During the training session, the protocol and question-by-question instructions for 
completing the informant interview form (IFI) are reviewed in detail.  A main focus of the informant 
interview re-certification is review of the informant narrative.  Examples (n=40) of informant narratives 
from all EC are read out loud during the session and critiqued by the interviewers and the 
supervisors. Successful completion of these exercises is required to be re-certified as an informant 
interviewer. 
 
10.5.3 Certification for MMCC review 
 
On an approximate annual basis the MMCC meets either in person or by conference call to conduct 
its training sessions.  Topics for discussion during these training sessions include update on changes 
in ICD coding rules, innovations in diagnostic testing (e.g. incorporation of cardiac troponins), review 
of quality control data, update on form changes, group discussion of informant interviews and detailed 
discussion of changes to case law.  A main feature of the training session is the re-certification 
process.  As a part of recertification, a standard set of cases (a variety of types including linked and 
non-linked nonfatal hospitalizations, in-hospital deaths, out of hospital deaths) from cohort morbidity 
and mortality are distributed to all members prior to the meeting.  Committee members are asked to 
complete the appropriate CDX form as they normally would do and send them to the coordinating 
center.  The data from the CDX forms are summarized in table form and distributed for discussion 
during the re-certification process.  Each case is reviewed in detail with special discussion among the 
group on any disagreement in diagnosis.  This session is lead by the chair of the MMCC.  In addition, 
special cases selected by the chair of the MMCC are presented and discussed in detail. Successful 
completion of these exercises, as determined by the chair of the MMCC is required for individuals to 
be re-certified.  
 
11.0 CONFIDENTIALITY 
 
Several procedures are in place to protect the security of the personal identifying information obtained 
from medical records. Personal identifiers (name, social security number, date of birth, gender, and 
race) are abstracted from the medical record for the purpose of linkage to the National Death Index.  
The social security number is used to identify participants when confirming hospitalizations.  The 
participant is  notified of such use upon receipt and signing of the Examination Center Consent Form. 
This information is used to determine vital status of Cohort participants who are lost to follow-up.  For 
cohort morbidity and mortality cases, personal identifiers are used to determine long-term case-
fatality of validated myocardial infarction events by either linkage with death certificate data provided 
by the state health departments or with the National Death Index. Except for the purposes of this 
linkage, all personal identifiers are removed from distributed datasets. Raw data files residing at the 
CC are password protected.  Personal identifiers are “blacked out” on any paper copy of medical 
records sent to the CC and these copies are stored in locked secure rooms. Study personnel involved 
in medical record abstraction and handling of these data have been trained on the protection of 
human subjects in research.  
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Appendix I. ICD10 Codes for Identifying Cohort Morbidity and Mortality Events 
 
 
ICD10 Codes for the Identification of Fatal CHD  
(January 1, 1999 and beyond) 
 
Code   Title 
E10-14  Diabetes Mellitus 
I10   Essential Hypertension 
I11   Hypertensive Heart Disease 
I20   Unstable Angina, angina pectoris 
I21-23  Acute Myocardial Infarction 
I24   Other Acute IHD 
I25   Chronic IHD (including old MI) 
I46   Cardiac Arrest 
I47   Paroxysmal Tachycardia 
I48   Atrial Fibrillation 
I49   Other cardiac arrhythmias 
I50   Heart Failure 
I51    Ill-defined heart disease 
I70   Atherosclerosis 
I97(not I97.2) Post procedural disorder of circulatory system 
J81   Pulmonary Edema 
J96   Respiratory Failure 
R96   Other Sudden Death 
R98   Unattended Death 
R99   Other ill-defined cause 
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I.2 ICD9 Codes for the Identification of Hospitalized Myocardial Infarction 
 
Code   Title 
 
402   Hypertensive Heart Disease 
410   Acute Myocardial Infarction 
411   Other Acute and Sub-acute Ischemic Heart Disease 
412   Old Myocardial Infarction 
413   Angina Pectoris 
414   Other Chronic Ischemic Heart Disease 
427   Cardiac Dysrhythmias 
428   Heart Failure 
518.4   Acute Edema of Lung, Unspecified 
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Appendix II. Form Letters 
 
Format 1-A Sample Letter to Informant: Known Telephone Number 
 
 
DATE 
 
NAME 
ADDRESS 
 
Dear [Name, Next of Kin]: 
 
 
I am writing to ask for your help on behalf of the National Heart, Lung and Blood Institute’s 
ARIC/Jackson Heart Study. The study is designed to measure the rates of heart disease in the Hinds, 
Rankin and Madison counties. Your name is listed on the death certificate of [NAME, JHS 
DECEASED PARTICIPANT] who passed away on [DATE]. In a few days a member of my staff will be 
calling to explain further about the project and seek your permission to ask a few medical questions. 
Of course, your participation is entirely voluntary. 
 
The information we need will be used for statistical purposes only, and will remain strictly 
confidential. It will contribute to our efforts to better understand heart disease and prevent its 
occurrence in the future. Thank you very much in advance for your help in this important study. 
 
Sincerely, 
 
 
 
Herman A. Taylor Jr., M.D., MPH, FACC,   
Principal Investigator, Jackson Heart Study 
 
HAT/tdc 
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Appendix II. Form Letters 
 
Format 2: Sample Letter to Informant: Unknown Telephone Number 
 
DATE 
 
NAME 
ADDRESS 
 
 
Dear NAME: 
 
I am writing to ask for your help on behalf of the National Heart, Lung and Blood Institute’s Jackson 
Heart Study. This study is designed to measure the rates of heart disease in the Hinds, Rankin and 
Madison counties. Your name is listed on the death certificate of [MR / MRS NAME JHS DECEASED 
PARTICIPANT] who passed away on [DATE]. We would like to explain more about the project and to 
ask a few medical questions, but have been unable to find your telephone number. 
 
Could you take a few minutes to fill out and mail the enclosed form so we may get in touch with you? 
The information we will be calling about will be used for statistical purposes only and will remain 
strictly confidential. It will contribute to our efforts to better understand heart disease and prevent its 
occurrence in the future. Of course, your assistance in our research is entirely voluntary. 
 
If you have any questions or would like to give us this information over the telephone, please call us 
at (601)-368-4623. Thank you very much in advance for your cooperation and help in this important 
study.  
 
 
Sincerely, 

 
 
Herman A. Taylor Jr., M.D., MPH, FACC 
Jackson Heart Study Principal Investigator 
 
 
HAT/tdc 
Enclosure  
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Format 3: Sample letter Next of Kin 
 
DATE 
 
 
NAME, NEXT OF KIN 
ADDRESS 
 
 
Dear NAME, NEXT OF KIN 
 
 
I am writing in follow-up to the telephone interview regarding NAME OF DECEASED JHS 
PARTICIPANT. Thank you for your time. The information you provided has been extremely valuable 
to the Jackson Heart Study. 
 
As we discussed, you will find enclosed an information release form for NAME, HEALTH CARE 
PROVIDER. Please sign it and return it to us in the enclosed stamped envelope. Again, thank you 
very much for your time. 
 
 
 
 Sincerely, 
 
 
Tammy Coker 
Jackson Heart Study, Interviewer, Researcher 
 
 
Enclosure 
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Format 4: Reply Postcard From Informant With Telephone Number 
 
 
 
FORMS SHOULD BE RETURN-ADDRESSED TO JACKSON HEART STUDY AND STAMPED. 
 
 
Dear (Name of Cohort morbidity and mortality Supervisor): 
 
I will be able to help with the Jackson Heart Study. 
 
I do have a telephone number which is (     )               .  The best times to reach me are                 or   
             . 
 
An alternative telephone number is: (     )                .  The best times to reach me at this number are    
             or                . 
 
I do not have a telephone number, but I agree to be interviewed in person, and will be calling your 
staff to set up a time and a place for the interview. 
 

Sincerely, 
 
 
 

                              
Print Name of Informant 
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Format 5: Sample Letter to a Neighbor RE: Location of Informant 
 
 
DATE 
 
NAME, NEIGHBOR OF JHS PARTICIPANT 

ADDRESS 
 
Dear NAME: 
I am writing to ask for your help on behalf of the National Heart, Lung, and Blood Institute’s Jackson 
Heart Study. This important study is designed to measure the rates of heart disease in the Hinds, 
Rankin and Madison counties.  As you may know, [JHS DECEASED PARTICIPANT NAME], passed 
away on [DATE OF DEATH].  As part of the study, we are systematically attempting to contact a next-
of-kin or another person who lived with [MR / MRS NAME OF DECEASED JHS PARTICIPANT], in 
order to obtain some medical information that would help us to find out whether [he/she] died from a 
heart attack.  Since we have not been able to locate such a person and since you were [MR / MRS 
NAME OF DECEASED JHS PARTICIPANT] neighbor, we believe that you may be able to help us.  
 
 
Could you take a few moments to fill out and mail the enclosed form?  The information we wish to 
obtain from a next-of-kin or another person who lived with [MR / MRS NAME OF DECEASED JHS 
PARTICIPANT] will be used for research purposes only, and will remain strictly confidential.  It will 
contribute to our efforts to better understand heart disease and prevent its occurrence in the future.  
Of course, your assistance in our research is entirely voluntary. If you have any questions, please feel 
free to call me collect at (601) 368-4623 or our local Surveillance Supervisor, Michelle Richard, at 
(601) 815-5065.   
 
Thank you very much in advance for your help in this important study.   
 
Sincerely, 
 
 
 
 
Herman A. Taylor Jr., M.D., MPH, FACC 
Jackson Heart Study Principal Investigator 
 
HAT/tdc 
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Format 6: Sample Letter Death Certificate/Medical Examiner 
 
DATE 
 
 
NAME, CERTIFIER / MD DEATH CERTIFICATE SIGNATOR WHEN NO MEDICAL EXAMINER 
ADDRESS 
 
       RE: NAME (JHS PARTICIPANT) 
       Date of Birth: DOB 
 
 
Dear [NAME CERTIFIER / MD DEATH CERTIFICATE SIGNATOR WHEN NO MEDICAL 
EXAMINER]: 
 
I am writing on behalf of the Jackson Heart Study, a National Heart Lung and Blood Institute 
epidemiologic study conducted by the University of Mississippi Medical Center, Jackson State 
University and Tougaloo College. The study is assessing incidence of myocardial infarctions and 
coronary death in Hinds, Rankin and Madison counties. We need some information concerning 
[NAME OF DECEASED JHS PARTICIPANT] whose death certificate you signed on [DATE] this 
information is needed to supplement the death certificate in assigning a cause of death. Could you or 
a member of your staff take a few moments to provide the answers to the questions on the enclosed 
form from your records and return it in the self addressed, stamped envelope? 
 
This information will be used for statistical purposes only, and will remain strictly confidential. If you 
have any questions, please feel free to contact me at (601)-368-4623. Thank you very much in 
advance for your kind assistance and consideration of this request. 
 
 
Sincerely, 
 
 
 
Herman A. Taylor Jr., M.D., MPH, FACC 
Jackson Heart Study Principle Investigator 
 
HAT/tc 
 
Enclosure 
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Format 7: Reply Form on the Location of Informant 
 
 
 
POSTCARD SHOULD BE RETURN-ADDRESSED TO JACKSON HEART STUDY AND STAMPED. 
 
 
 
Dear (Name of Cohort morbidity and mortality Supervisor): 
 
The following individual(s) was (were) living with (name of decedent) at the time of his/her death: 
 
Name   Relationship  Present Address  Present  

to Deceased      Telephone Number 
 
                                                                                         
                    
                                                                                         
                    
                                                                                         
                    
                                                                                          
                    
 
I do not have any information on persons who were living with (name of the decedent) at the time of 
his/her death. 
 

Sincerely, 
 
 
 

________________________________________ 
(Print Name of Neighbor) 
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Format 8: Informant Release of Information Form: Nursing Home 
 
 
 
I hereby authorize and request                                    to furnish to the Jackson Heart Study the 
medical records on (name of the decedent).  These records will be reviewed only for research 
purposes and none of the information will be released to any individual other than the research team. 
 Any costs for reproduction of records will be covered by the study. 
 
Date:                          Signed: 
_______________________________________________________ 
 
 
 
(Relationship to the Deceased) 
 
________________________ 
 
 
________________________________________________________________________________
_ 
Witness:                             
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Format 9: Letter to Physician Signing Death Certificate 
 
 
DATE 
 
 
NAME, DEATH CERTIFIER/ MEDICAL EXAMINER / CORONER 
ADDRESS 
 
RE:      Name: [NAME JHS DECEASED PARTICIPANT] 
        

Date of Birth: [DOB] 
 
 
Dear NAME DEATH CERTIFIER / MEDICAL EXAMINER / CORONER: 
 
I am writing on behalf of the Jackson Heart Study, a National Heart Lung and Blood Institute 
epidemiologic study conducted by the University of Mississippi Medical Center, Jackson State 
University and Tougaloo College. The study is assessing incidence of myocardial infarctions and 
coronary death in Hinds, Rankin and Madison counties. We need some information concerning 
[NAME, JHS DECEASED PARTICIPANT] whose death certificate you signed on [DATE] this 
information is needed to supplement the death certificate in assigning a cause of death. Could you or 
a member of your staff take a few moments and enclose a copy of the Medical Examiners report from 
your records and return it in the self addressed stamped envelope. 
 
This information will be used for statistical purposes only, and will remain strictly confidential. If you 
have any questions, please feel free to contact me at (601)-368-4623. Thank you very much in 
advance for your kind assistance and consideration of this request. 
 
 
Sincerely, 
 
 
 
Herman A. Taylor Jr., M.D., MPH, FACC 
Jackson Heart Study 
 
HAT/tc 
Enclosure 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

M 4_Version 2.1. 03032006 .doc 
 

A-12 

 
Format 10: Informant Release of Information:  Physician 
 
Health Care Provider(s):  NAME 
     
   
 
The above named physician(s) have my permission to release medical information to the Jackson 
Heart Study. This information will be used for statistical purposes only and will remain strictly 
confidential. 
 
 
Decedent’s Name:   NAME OF JHS PARTICIPANT_                                               
                         
  
My Name:                 
                                                                                                                  
 
Address:                 
                                                                                                                                                                  
 
Relationship to Decedent:               
                                                                                                                                                      
 
Date:    Signed :             
                                                                                                                                              
  
Witness:                 
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Format 11: Informant Release of Information:  Out-of-Area Hospital 
 
 
 
TO:                                                                            
 (Name of Hospital) 
                                                                               
 
                                                                               
 
The above named hospital has my permission to release medical information to the Jackson Heart 
Study.  This information will be used for statistical purposes only, and will remain strictly confidential. 
 
Decedent's Name:                                                               
 
My Name:                                                                       
 
Address:                                                                       
 
Relationship to Decedent:                                                      
 
Date:                      Signed: ________________________________________________             
                            
 
 
 
Relationship to Decedent:                        
 
 
__________________________________________________ 
 
 
 
Witness:                                                                       
 
_______________________________________________________ 
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Appendix II.  ARIC/Jackson Heart Study Cohort 
 
 
Format 1-A Sample Letter to Informant: Known Telephone Number 
 
 
DATE 
 
NAME 
ADDRESS 
 
Dear [Name, Next of Kin]: 
 
 
 I am writing to ask for your help on behalf of the National Heart, Lung and Blood Institute’s 
ARIC/Jackson Heart Study. The study is designed to measure the rates of heart disease in the Hinds, 
Rankin and Madison counties. Your name is listed on the death certificate of [NAME, JHS 
DECEASED PARTICIPANT] who passed away on [DATE]. In a few days a member of my staff will be 
calling to explain further about the project and seek your permission to ask a few medical questions. 
Of course, your participation is entirely voluntary. 
 
The information we need will be used for statistical purposes only, and will remain strictly 
confidential. It will contribute to our efforts to better understand heart disease and prevent its 
occurrence in the future. Thank you very much in advance for your help in this important study. 
 
Sincerely, 
 
 
 
Herman A. Taylor Jr., M.D., MPH, FACC,    Thomas Mosley, Ph.D 
Principal Investigator, Jackson Heart Study  Atherosclerosis Risk in Community Study, 

Principal Investigator 
  
HAT/TM/tc 
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Appendix II       ARIC/Jackson Heart Study Cohort 
 
 
Format 2-A: Sample Letter to Informant: Unknown Telephone Number 
 
DATE 
 
NAME 
ADDRESS 
 
 
Dear NAME: 
 
I am writing to ask for your help on behalf of the National Heart, Lung and Blood Institute’s 
ARIC/Jackson Heart Study. This study is designed to measure the rates of heart disease in the 
Hinds, Rankin and Madison counties. Your name is listed on the death certificate of [MR / MRS 
NAME JHS DECEASED PARTICIPANT] who passed away on [DATE]. We would like to explain more 
about the project and to ask a few medical questions, but have been unable to find your telephone 
number. 
 
Could you take a few minutes to fill out and mail the enclosed form so we may get in touch with you? 
The information we will be calling about will be used for statistical purposes only and will remain 
strictly confidential. It will contribute to our efforts to better understand heart disease and prevent its 
occurrence in the future. Of course, your assistance in our research is entirely voluntary. 
 
If you have any questions or would like to give us this information over the telephone, please call us 
at (601)-368-4623. Thank you very much in advance for your cooperation and help in this important 
study.  
 
 
Sincerely, 
 
 
 
 
Herman A. Taylor Jr., M.D., MPH, FACC   Thomas Mosley, PhD 
Principal Investigator, Jackson Heart Study  Atherosclerosis Risk in Community, 
       Principal Investigator 
 
HAT/TM/tc 
Enclosure  
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Appendix II ARIC/Jackson Heart Study Cohort 
 
 
Format 5-A: Sample Letter to a Neighbor RE: Location of Informant 
 
 
DATE 
 
NAME, NEIGHBOR OF JHS PARTICIPANT 

ADDRESS 
 
Dear NAME: 
I am writing to ask for your help on behalf of the National Heart, Lung, and Blood Institute’s 
ARIC/Jackson Heart Study. This important study is designed to measure the rates of heart disease in 
the Hinds, Rankin and Madison counties.  As you may know, [JHS DECEASED PARTICIPANT 
NAME], passed away on [DATE OF DEATH].  As part of the study, we are systematically attempting 
to contact a next-of-kin or another person who lived with [MR / MRS NAME OF DECEASED JHS 
PARTICIPANT], in order to obtain some medical information that would help us to find out whether 
[he/she] died from a heart attack.  Since we have not been able to locate such a person and since 
you were [MR / MRS NAME OF DECEASED JHS PARTICIPANT] neighbor, we believe that you may 
be able to help us.  
 
 
Could you take a few moments to fill out and mail the enclosed form?  The information we wish to 
obtain from a next-of-kin or another person who lived with [MR / MRS NAME OF DECEASED JHS 
PARTICIPANT] will be used for research purposes only, and will remain strictly confidential.  It will 
contribute to our efforts to better understand heart disease and prevent its occurrence in the future.  
Of course, your assistance in our research is entirely voluntary. If you have any questions, please feel 
free to call me collect at (601) 368-4623 or our local Surveillance Supervisor, Michelle Richard, at 
(601) 815-5065.   
 
Thank you very much in advance for your help in this important study.   
 
Sincerely, 
 
 
 
 
Herman A. Taylor Jr., M.D., MPH, FACC   Thomas Mosley, PhD 
Principal Investigator, Jackson Heart Study   Atherosclerosis Rick in Community, 
       Principal Investigator 
 
 
 
 
Tom Mosley 
ARIC Principal Investigator 
 
HAT/TM/tc 
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Appendix II ARIC/Jackson Heart Study Cohort 
 
Format 6: Sample Letter Death Certificate/Medical Examiner 
 
DATE 
 
 
NAME, CERTIFIER / MD DEATH CERTIFICATE SIGNATOR WHEN NO MEDICAL EXAMINER 
ADDRESS 
 
       RE: NAME (JHS PARTICIPANT) 
       Date of Birth: DOB 
 
 
Dear [NAME CERTIFIER / MD DEATH CERTIFICATE SIGNATOR WHEN NO MEDICAL 
EXAMINER]: 
 
I am writing on behalf of the Jackson Heart Study and Atherosclerosis Rick in Community, a National 
Heart Lung and Blood Institute epidemiologic study conducted by the University of Mississippi 
Medical Center, Jackson State University and Tougaloo College. The study is assessing incidence of 
myocardial infarctions and coronary death in Hinds, Rankin and Madison counties. We need some 
information concerning [NAME OF DECEASED JHS PARTICIPANT] whose death certificate you 
signed on [DATE] this information is needed to supplement the death certificate in assigning a cause 
of death. Could you or a member of your staff take a few moments to provide the answers to the 
questions on the enclosed form from your records and return it in the self addressed, stamped 
envelope? 
 
This information will be used for statistical purposes only, and will remain strictly confidential. If you 
have any questions, please feel free to contact me at (601)-368-4623. Thank you very much in 
advance for your kind assistance and consideration of this request. 
 
 
Sincerely, 
 
 
 
Herman A. Taylor Jr., M.D., MPH, FACC   Thomas Mosley, PhD 
Principal Investigator, Jackson Heart Study  Atherosclerosis Risk in Community, 
       Principal Investigator 
 
HAT/TM/tc 
 
Enclosure 
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Appendix II ARIC/Jackson Heart Study Cohort 
 
 
Format 9-A: Letter to Physician Signing Death Certificate 
 
 
DATE 
 
 
NAME, DEATH CERTIFIER/ MEDICAL EXAMINER / CORONER 
ADDRESS 
 
RE:      Name: [NAME JHS DECEASED PARTICIPANT] 
        

Date of Birth: [DOB] 
 
 
Dear NAME DEATH CERTIFIER / MEDICAL EXAMINER / CORONER: 
 
I am writing on behalf of the Jackson Heart Study, and Atherosclerosis Risk in Community, a National 
Heart Lung and Blood Institute epidemiologic study conducted by the University of Mississippi 
Medical Center, Jackson State University and Tougaloo College. The study is assessing incidence of 
myocardial infarctions and coronary death in Hinds, Rankin and Madison counties. We need some 
information concerning [NAME, JHS DECEASED PARTICIPANT] whose death certificate you signed 
on [DATE] this information is needed to supplement the death certificate in assigning a cause of 
death. Could you or a member of your staff take a few moments and enclose a copy of the Medical 
Examiners report from your records and return it in the self addressed stamped envelope. 
 
This information will be used for statistical purposes only, and will remain strictly confidential. If you 
have any questions, please feel free to contact me at (601)-368-4623. Thank you very much in 
advance for your kind assistance and consideration of this request. 
 
 
Sincerely, 
 
 
 
Herman A. Taylor Jr., M.D., MPH, FACC   Thomas Mosley, PhD 
Principal Investigator, Jackson Heart Study  Atherosclerosis Risk in Community, 
       Principal Investigator 
 
HAT/TM/tc 
Enclosure 
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Appendix II ARIC/Jackson Heart Study Cohort 
 
Format 10: Informant Release of Information:  Physician 
 
Health Care Provider(s):  NAME 
     
   
 
The above named physician(s) have my permission to release medical information to the Jackson 
Heart Study. This information will be used for statistical purposes only and will remain strictly 
confidential. 
 
 
Decedent’s Name:   NAME OF ARIC/JHS PARTICIPANT_                                   
                                      
  
My Name:                 
                                                                                                                  
 
Address:                 
                                                                                                                                                                  
 
Relationship to Decedent:               
                                                                                                                                                      
 
Date:    Signed :             
                                                                                                                                              
  
Witness:                  
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Appendix III. Computerized Stroke Classification Algorithm 

 
 
I. Subarachnoid Hemorrhage (SAH) 
 
JHS Definition of Definite SAH:   
 
Evidence in the patient’s clinical record of sudden or rapid onset of neurologic symptoms lasting for 
more than 24 hours or leading to death, plus must meet the criteria specified under at least one of the 
four below: 
 

1. Meets criteria (a) and (b) below: 
a. Angiographic identification of a saccular aneurysm as the source of bleeding (e.g. 

demonstration of a clot adjacent to aneurysm or reduced caliber of otherwise normal 
vessels) AND 

b. Bloody (not traumatic) tap or xanthochromic spinal fluid, OR 
2. Demonstration by CT or MRI of a blood clot in Fissure of Sylvius, between the frontal lobes, 

in basal cisterns or within a ventricle with no associated intraparenchymal hematoma, OR 
3. Demonstration at surgery of bleeding saccular aneurysm, OR 
4. Demonstration at autopsy of recent bleeding of a saccular aneurysm 

 
JHS Definition of Probable SAH:  
 
Evidence in the patient’s clinical record of sudden or rapid onset of neurologic symptoms lasting for 
more than 24 hours or leading to death, plus must meet either criterion (1) or criteria (2) and (3) 
below: 
 

1. a. Angiographic identification of a saccular aneurysm as the source of bleeding (e.g. 
demonstration of a clot adjacent to aneurysm or reduced caliber of otherwise normal 
vessels) AND 

b. Spinal tap was either not done or was traumatic, or missing, OR 
2. One or more of the following symptoms or signs occurred within minutes or a few hours after 

onset: 
a. Severe headache at onset, or severe headache when first conscious after hospital 

admission; 
b. Depression of state of consciousness; 
c. Evidence of meningeal irritation; 
d. Retinal (subhyaloid) hemorrhages; AND 

3. Bloody (not traumatic) tap or xanthochromic spinal fluid. 
 
 
II.  Brain Hemorrhage (IPH) 
 
JHS Definition of Definite IPH:   
 
Evidence in the patient’s clinical record of sudden or rapid onset of neurologic symptoms lasting for 
more than 24 hours or leading to death, plus must meet the criteria specified under at least one of the 
three below: 
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1. Demonstration of definite intracerebral hematoma by CT or MRI, e.g. an area of increased 
density, such as seen with blood, OR 

2. Demonstration at autopsy or surgery of intracerebral hemorrhage, OR 
3. Evidence in the patient’s clinical record that meet criteria (a), (b), (c), and (d) below: 

a. One major or two minor neurological signs or symptoms from the following list that lasted 
at least 24 hours or until the patient died: 

Major:  
  - hemiparesis involving two or more body parts 

- homonymous hemianopia 
- aphasia 

Minor:  
  - diplopia 

- vertigo or gait disturbance 
- dysarthria or dysphagia or dysphonia 
- unilateral numbness involving two or more body parts, AND 
 

b. Bloody (not traumatic tap) or xanthochromic spinal fluid, AND 
c. Cerebral angiography demonstrates an avascular mass effect and no evidence of 

aneurysm or arteriovenous malformation, AND 
d. No CT / MRI was performed or the CT / MRI was technically inadequate. 

 
JHS Definition of Probable IPH:  Evidence in the patient’s clinical record of sudden or rapid onset of 
neurologic symptoms lasting for more than 24 hours or leading to death, plus must meet all the 
criteria below: 

1. One major or two minor neurological signs or symptoms listed above under definite #3 that 
lasted at least 24 hours or until the patient died, AND 

2. Decreased level of consciousness or coma that lasted at least 24 hours or until the patient 
died, AND 

3. Bloody (not traumatic tap) or xanthochromic spinal fluid, AND 
3. No CT / MRI was performed or the CT / MRI was technically inadequate. 
 
 
III.  Thrombotic Brain Infarction (TIB) 
 
JHS Definition of Definite TIB:   
 
Evidence in the patient’s clinical record of sudden or rapid onset of neurologic symptoms lasting for 
more than 24 hours or leading to death, plus must meet the criteria specified under at least one of the 
two below: 
 

1. Demonstration at autopsy of nonhemorrhagic infarct in brain, OR 
2. Evidence in the patient’s clinical record that meet criteria (a) and (b) below: 

a. One major or two minor neurological signs or symptoms from the following list that lasted 
at least 24 hours or until the patient died: 

Major:  
  - hemiparesis involving two or more body parts 

- homonymous hemianopia 
- aphasia 

Minor:  
  - diplopia 

- vertigo or gait disturbance 
- dysarthria or dysphagia or dysphonia 
- unilateral numbness involving two or more body parts, AND 
 

b. CT or MRI shows infarct or an area of decreased density which may indicate edema 
or ischemia, with no evidence of hemorrhage. 

 
JHS Definition of Probable TIB:   
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Evidence in the patient’s clinical record of sudden or rapid onset of neurologic symptoms lasting for 
more than 24 hours or leading to death, plus must meet all the criteria below: 
 

1. One major or two minor neurological signs or symptoms listed above under definite #2a that 
lasted at least 24 hours or until the patient died, AND 

2. Demonstration of negative or nonspecific findings and no evidence of hemorrhage by CT or 
MRI performed in the first 48 hours after the onset of symptoms or signs, AND 

3. A spinal tap was either not done, or was a traumatic tap, or yielded clear, colorless spinal 
fluid. 

  
 
IV.  Noncarotid Embolic Brain Infarction (EIB) 
 
JHS Definition of Definite EIB:   
 
Evidence in the patient’s clinical record of sudden or rapid onset of neurologic symptoms lasting for 
more than 24 hours or leading to death, plus must meet the criteria specified under at least one of the 
two below: 
 

1. Demonstration at autopsy of: 
a. An infarcted area (bland or hemorrhagic) in the brain, AND 
b. A source of emboli in a vessel of any organ, or an embolus in the brain, OR 

2. Evidence in the patient’s clinical record that meet criteria (a), (b), and (c) below: 
a. One major or two minor neurological signs or symptoms from the following list that lasted 

at least 24 hours or until the patient died: 
Major:  
  - hemiparesis involving two or more body parts 

- homonymous hemianopia 
- aphasia 

Minor:  
  - diplopia 

- vertigo or gait disturbance 
- dysarthria or dysphagia or dysphonia 
- unilateral numbness involving two or more body parts, AND 
 

b. Establishment of a likely source for cerebral embolus, e.g.:  valvular heart disease 
(including prosthetic heart valve), atrial fibrillation or flutter, MI, cardiac or arterial 
operation or procedure, cardiac myxoma, bacterial endocarditis, AND 

 
c. CT or MRI shows an area of decreased density which may indicate edema or ischemia, 

with no evidence of hemorrhage 
 
JHS Definition of Probable EIB:   
 
Evidence in the patient’s clinical record of sudden or rapid onset of neurologic symptoms lasting for 
more than 24 hours or leading to death, plus must meet all the criteria below: 
 

1. One major or two minor neurological signs or symptoms listed above under definite #2a that 
lasted at least 24 hours or until the patient died, AND 

2. An identifiable source for the cerebral embolus as specified in definite #2b, AND 
3. Demonstration of negative or nonspecific findings and no evidence of hemorrhage by CT or 

MRI performed in the first 48 hours after the onset of symptoms or signs, AND 
4. A spinal tap was either not done, or was a traumatic tap, or yielded clear, colorless spinal 

fluid. 
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V.  Possible Stroke of Undetermined Type 
 
JHS Definition:  
Evidence in the patient’s clinical record of sudden or rapid onset of neurologic symptoms lasting for 
more than 24 hours or leading to death, plus one major or two minor neurological signs listed below: 
 

Major:  
  - hemiparesis involving two or more body parts 

- homonymous hemianopia 
- aphasia 

Minor:  
  - diplopia 

- vertigo or gait disturbance    
- dysarthria or dysphagia or dysphonia 
- unilateral numbness involving two or more body parts 
- severe headache at onset or severe headache when first conscious after hospital admit 
- depression of state of consciousness 
- evidence of meningeal irritation 
- retinal (subhyaloid) hemorrhages 
- palsy of the iii cranial nerve, AND 
 

Clinical history, signs, symptoms, and findings from diagnostic tests and / or autopsy are not sufficient 
to meet the criteria for classifying the case as a “definite” or “probable” case of one of the four specific 
diagnostic categories of stroke. 
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Appendix IV. ECG Shipping Form 
 

JHS 
ECG Shipping Form 

 
To: Sean Thomas 
 ECG Coding Center 
 University of Minnesota 
 Division of Epidemiology 
 Suite 300 
 1300 South Second St 
 Minneapolis, MN  55454-1015 
 
From: 
JHS Examination Center  ___________     Date: _____________        Time: _________ 
 
JHS Batch Number   A R __ __ __ __ __ __ 
 
Reporting Period: 
 
 Starting Date: 
 
 Ending Date: 
 
Total Number of Specimens Enclosed: 
 
Number of Contents Pages Attached: 
 
Other remarks concerning shipment contents: 
________________________________________________________________________________
________________________________________________________________________________
___________________________________ 
                                                                                                          Initials __________ 

 
***************************************************************** 
Arrive at Laboratory                
 
Date: ____________        Time: ____________ 
 
Contents on condition of total shipment on arrival 
________________________________________________________________________________

________________________________________________________________________________

___________________________________ 

           

Initials __________ 
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Appendix V. Duplicate Materials Shipping Forms 
 
 
 

JHS SHIPPING FORM 
DUPLICATED MATERIALS FOR MMCC REVIEWERS 

 
TO:      Central Receiving 
      Climmon Walker 
 
FROM:  
 
 
 
 
 
DATE: 
 
BATCH NUMBER: 
 
REMARKS: _________________________________________________________________ 

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

____________________________________________________________________ 

 
INITIALS: 
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JHS COHORT MORBIDITY AND MORTALITY SHIPPING INVENTORY 
DUPLICATED MATERIALS FOR MMCC REVIEWERS 

 
CENTER ____    BATCH _____   DATE _________________  TYPE _______ 
 

Event ID # Event ID # 
 1. 
 

16. 

 2. 
 

17. 

 3. 
 

18. 

 4. 
 

19. 

 5. 
 

20. 

 6. 
 

21. 

 7. 
 

22. 

 8. 
 

23. 

 9. 
 

24. 

10. 
 

25. 

11. 
 

26. 

12. 
 

27. 

13. 
 

28. 

14. 
 

29. 

15. 
 

30. 

 
REMARKS: _______________________________________________________ 
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